## Contents

<table>
<thead>
<tr>
<th>Preface</th>
<th>9</th>
<th>Motion 3 Documentation and Resources</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>9</td>
<td>Onscreen Help</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>Apple Websites</td>
</tr>
</tbody>
</table>

**Chapter 1**

13 | Getting to Know Motion |
14 | About Motion Graphics  |
18 | About Motion           |
19 | About the Motion Workspace |
29 | Toolbar                |
38 | Canvas                 |
67 | Project Pane           |
84 | Timing Pane            |
110 | Utility Window         |
135 | HUD                    |
137 | Preferences            |
158 | Menus                  |

**Chapter 2**

179 | Creating and Managing Projects |
179 | Creating New Projects         |
191 | Managing Projects             |
197 | Editing Project Properties    |
198 | Browsing Media Files in Motion|
203 | File Types Supported by Motion|
213 | Adding Media to Your Project  |
219 | Managing Layers in Your Project |
223 | Deleting Objects from a Project |
223 | Exchanging Media in a Project  |
225 | Object Media Tab Parameters   |
228 | Using Media in the Library    |
233 | Organizing Groups and Layers in Motion |
250 | Customizing and Creating New Templates |

**Chapter 3**

257 | Basic Compositing |
259 | Group and Layer Order |
## Contents

1108  Using Masks to Aid Keying Effects  
1112  Manipulating Alpha Channels Using Filters

### Chapter 13  Working with Audio
1117  Audio Files in Motion Projects  
1126  Working with Audio Tracks  
1134  Keyframing Level and Pan Changes  
1139  Audio Behaviors  
1141  Audio Parameter Behavior  
1144  Using Soundtrack Pro with Motion  
1145  Exporting Audio

### Chapter 14  Exporting Motion Projects
1147  Exporting Motion Projects  
1148  Exporting Your Project  
1149  Using Export Presets  
1154  Setting Export Options  
1160  Export a Selection  
1160  Exporting with Compressor  
1164  Rendering a Project for iPod Playback  
1165  Exporting an Audio File

### Appendix A  Keyboard Shortcuts
1167  Keyboard Shortcuts  
1167  General Interface Commands  
1169  Motion Menu  
1169  File Menu  
1170  Edit Menu  
1171  Mark Menu  
1173  Object Menu  
1174  View Menu  
1176  Window Menu  
1177  Help Menu  
1177  Audio Editor  
1178  Audio Tab  
1178  Canvas  
1187  HUD  
1187  File Browser  
1188  Inspector  
1188  Keyframe Editor  
1189  Layers  
1190  Library  
1190  Media Tab  
1191  Timeline  
1193  Keyframing Commands
Motion 3 Documentation and Resources

You can use Motion to create sophisticated motion graphics content for broadcast and video. Discover all the resources you can use to help you learn this versatile application.

This preface provides information on the documentation available for Motion, as well as information about Motion resources on the web.

Onscreen Help
Onscreen Help (available in the Help menu) provides easy access to information while you’re working in Motion. The Motion 3 User Manual is available here, along with other documents in PDF and HTML format, including Motion Supplemental Documentation, which contains in-depth information about 3D compositing and Motion Tracking behaviors.

To access onscreen help:
- In Motion, choose an option from the Help menu.

User Manual
The Motion 3 User Manual contains detailed information about most features in the application.

To access the user manual:
- In Motion, choose Help > Motion User Manual.

When the user manual is opened, the Motion 3 User Manual access page appears. The Preview drawer on the side contains a list of links that allow you to locate specific information in the user manual. Click any bookmark in the drawer to begin exploring the user manual.

Links in the body of the access page provide an additional way to locate important help and other documentation tools to assist you in learning and using Motion. Most of these links are also available directly from the Help menu:
Supplemental Documentation
The Motion Supplemental Documentation PDF contains information about 3D compositing, including the 3D workspace, lights, cameras and camera behaviors, and rasterization. This document also discusses using the Motion Tracking behaviors.

To access the supplemental documentation, do one of the following:
- In Motion, choose Help > 3D and Tracking

Release Notes
The Release Notes contain information about issues with third-party hardware and software, and known bugs. It also contains information about any new features or changes to the software that occurred after the Motion 3 User Manual was completed.

To access Release Notes:
- In Motion, choose Help > Release Notes.

New Features
The New Features document briefly describes what’s new in the latest version of Motion, as well as where to find detailed information about those features in the user manual or Motion Supplemental Documentation.

To access the New Features document:
- In Motion, choose Help > New Features.

Apple Websites
There are a variety of discussion boards, forums, and educational resources related to Motion on the web.

Motion Websites
The following websites provide general information, updates, and support information about Motion, as well as the latest news, resources, and training materials.

For information about Motion, go to:

To get more information on third-party tools, resources, and user groups, go to:
- http://www.apple.com/finalcutstudio/resources

For information on the Apple Pro Training Program, go to:
To provide comments and feedback to Apple about Motion, go to:


**Apple Service and Support Website**
The Apple Service and Support website provides software updates and answers to the most frequently asked questions for all Apple products, including Motion. You’ll also have access to product specifications, reference documentation, and Apple and third-party product technical articles:

- http://www.apple.com/support
This chapter introduces you to the basic concepts of motion graphics and the Motion interface. It also describes how to work with all of the basic tools you need to get started.

Motion is a behavior-driven motion graphics application that allows you to create stunning imaging effects for a wide variety of projects, including title sequences, broadcast graphics, and sophisticated simulations.

Motion lets you create movement and other effects on the fly and in real time. Simply drag one of Motion’s built-in behaviors (such as Spin or Throw) or filters (such as Glow or Strobe) onto an object in the Canvas, and watch your composition spring to life—twirling, zipping across the screen, pulsing with luminescence, or any of hundreds of other effects.

You can also animate the traditional way, using keyframes, but Motion behaviors give you instant feedback, so you can sit with your clients, art directors, or friends and interactively design a motion graphics project on your desktop. You want a title to fade in, do a little shimmy, and then slide out of view? Simply click Play, then drag the Fade, Random Motion, and Gravity behaviors onto the title in the Canvas—no preview rendering time is necessary.
Motion can be used for commercials, documentaries, titles, broadcast or web graphics, corporate presentations, DVD menus, or your own personal video projects. Whether you need the precision of keyframed animation, the free-flow animated effects of behaviors, or a little of both—Motion has a flexible toolset to meet your motion graphics needs.

This chapter provides an introduction to motion graphics and the Motion workspace and how to navigate and use common tools and controls.

About Motion Graphics

Motion graphics is a type of visual effects work most commonly associated with title sequences and show openers, bumpers and interstitials, and interface design like DVD menus. It is also frequently used in technical settings for simulations of moving systems such as traffic patterns or scientific models.

Motion graphics usually incorporates multiple objects onscreen simultaneously and is typically governed by design considerations and a strong sense of visual impact. Sophisticated motion graphics artists often combine traditional layout and design techniques with tools borrowed from special effects work such as keying, masking, compositing, and particle systems to create dynamic moving designs. The tools commonly used for motion graphics fall into several categories.

Design Tools

Graphic designers have been using software to facilitate their work for many years. Motion has incorporated many of the most valuable tools commonly found in layout and design applications, including guides, alignment, and direct manipulation for positioning, transforming, and distorting layers. It also contains some of the most flexible and sophisticated tools for creating and handling text elements. This is especially important because text is such a critical component of motion graphics design.
Timing Tools
The principal difference between traditional design and motion graphics is that motion graphics is time based. This means that you are concerned with creating a well-composed and readable layout, and you must also manipulate that layout over the duration of the show. Motion provides a Timeline that contains tools usually found in a video editing application (such as trimming, markers, slipping, and snapping) to allow you to hone and compose the temporal aspects of your project.

Motion also supports audio files, including basic audio mixing, so you can create a soundtrack for your project and make timing decisions based upon the audio as well as visual components. You can animate layers, filters, behaviors, and other elements to create elegant and precise compositions. Furthermore, you can smoothly retime your footage using optical flow technology, or apply Retiming behaviors to clips for some funky effects such as stutter and flash frames.

2D and 3D Compositing
Any time you have more than one layer onscreen simultaneously, you must employ some version of compositing to combine the elements. This might mean moving the layers onscreen so they don’t overlap, adjusting the layers’ opacities so they are partly visible, or incorporating blend modes that mix the overlapping images in a variety of ways. Compositing is fundamental to motion graphics work. Fortunately, Motion makes it easier than ever before, allowing you to control layer and group order, lock and group layers, and apply more than 25 different blending options to create unique effects.

You can also mix 2D and 3D groups in a single project. This allows you to do basic compositing with some elements of your project and complex 3D animations with other elements.

Special Effects Tools
You can further enhance your motion graphics projects by employing many of the same tools used in movies to combine dinosaurs with live actors, sink luxury liners in the ocean, or create space battles. Motion provides many of these tools such as keying (to isolate an object shot against a solid-colored background), masking (to hide wires or other objects that should not be seen in the final image), and particle systems (to simulate natural phenomena such as smoke, fire, and water). In fact, Motion can be used to create special effects shots like these, but its real power is in integrating these tools with the design and editing tools described above.
Unique Tools
As the field of motion graphics design has evolved, the tool sets in the most common applications have grown, but Motion takes a completely fresh approach to the task. It incorporates the cutting edge of software design and takes advantage of the latest powerful Apple hardware. And while it does include the tools and techniques artists have grown accustomed to, it also incorporates a streamlined and new set of tools called *behaviors* that make previously complex (or near-impossible) procedures as simple as dragging and dropping. A tool called the *replicator* creates a customizable pattern from copies of a layer, quickly creating complex design effects that would take hours to build in other applications. Very flexible paint and shape tools allow you to add or create shapes that are drawn on the Canvas over time.

Behaviors
The Motion behaviors simplify the most common tasks such as scaling, fading, and moving elements. Behaviors also allow you to create complex 2D or 3D interactions such as Edge Collision (making elements bounce off of defined edges) or Attractor effects (giving one element a gravitational pull on surrounding elements). And because text is such a critical element of motion graphics work, Motion includes more than 100 behaviors specifically designed for text elements that treat individual letters uniquely while simultaneously affecting the entire text layer in which they reside.

Using Simulation behaviors, text, particles, replicator pattern elements, and paint stroke dabs can be pulled out of the X and Y planes and toward a layer that is offset in Z space.

The Heads-Up Display (HUD)
One of the things that can bog down an otherwise fluid motion graphics experience is having to stop and hunt for the location of a particular setting. Motion uses a special floating window called the *heads-up display*, referred to as the *HUD*, to provide at-your-fingertips access to your most frequently used parameters. The HUD changes dynamically, depending on what is selected. The HUD also provides access to unique visual controls for some of the behaviors.

The HUD also allows you to quickly add behaviors to specific parameters of an object. These Parameter behaviors allow you to affect a single aspect of an object (its position, scale, or opacity, for example) rather than the object as a whole. To add a Parameter behavior, Control-click a parameter in the HUD, then choose a Parameter behavior from the shortcut menu. For more information about Parameter behaviors, see “Applying Parameter Behaviors” on page 380.
Real-Time Feedback
With the right hardware configuration, nearly every effect and adjustment you make can be viewed in real time. This means that you can watch how the various elements of your composition interact as you modify them. Not only does this mean less waiting time while the computer converts your various clicks and drags into a viewable movie, it means that you can interact with your creation in a more fluid and engaging way. Rather than making a set of assumptions and then waiting to see how they turn out, you can immediately see how your ideas work, then make adjustments on the fly.

Real-time feedback turns the act of designing a motion graphics sequence into an act of exploration and discovery, which is the way most artists prefer to create. Motion provides not just a new set of brushes for the motion graphics artist, but a whole new type of work environment.

Mouse and Keyboard Shortcut Considerations
If you have a three-button mouse connected to your computer, you can right-click to access the same controls specified by the Control-click commands in the user documentation (for example, Control-click the Toolbar, then choose Customize Toolbar from the shortcut menu). If you are working on a PowerBook G4, MacBook, or MacBook Pro, keep in mind that some keyboard shortcuts require you to use the Function key (Fn—next to the Control key) in conjunction with the keys specified in the user documentation. For example, the F1–F10 keys and several letter keys require the Fn key to activate key commands such as plus (+), minus (−), and so on. For more information about keyboard shortcuts in Motion, see Appendix A, “Keyboard Shortcuts,” on page 1167.

Enabling Traditional Function Keys on Mobile Macintosh Systems
By default, on Powerbook, MacBook, and MacBook Pro computers, the F1–F12 keys are assigned to hardware controls, such as brightness, audio volume, numlock, and so on. This means that you have to press the Function (Fn) key along with the F-key when you want to invoke F-key commands in your software applications.

You can change your keyboard preferences so that the F-keys work in the traditional manner, without pressing the Fn key. When this setting is activated, you can press the Fn key along with the F-key to activate the hardware commands.

To enable traditional function keys:
- In the Keyboard tab of the Keyboard & Mouse preferences in System Preferences, select the “Use the F1-F12 keys to control software features” checkbox. Uncheck the box to return to the default setting.
About Motion

In Motion, you create 2D or 3D motion graphics and compositing projects with imported images (such as Adobe Photoshop or Illustrator files), image sequences, QuickTime movies, audio files, as well as objects created within Motion. These objects include text, masks, shapes, particles, paint strokes, and so on.

A Motion project is made up of groups that contain layers. All media imported into Motion, or elements created within a project, are referred to as layers. A layer must live within a group. The group acts as a “parent” to its layers. You can select multiple layers within a group to create a nested group. A group can be 2D or 3D.

Cameras and lights can be added to projects. When a camera is added to a project, you have the option to switch the project to 3D mode or to remain in 2D mode (unless the project is empty or completely 2D, in which case it is automatically switched to 3D mode). 2D groups can exist in a 3D project. A 2D group can be nested in a 3D group. A 3D group can be nested in a 2D group. Once a 3D group is nested in a 2D group, the group is flattened. This means that the nested 3D group acts like a flat card and ignores the camera. In addition, the flattened group does not intersect with layers of the 2D group or other groups in the project.

Any transforms, filters, or behaviors that are applied to a group are applied to the layers within the group. If you move or apply a filter or behavior to a group, all layers within that group are affected. You can also apply filters and behaviors to the individual layers within a group.

A filter is a process that changes the appearance of an image. For example, a blur filter takes an input image and outputs a blurred version of that image. A behavior is a process that applies a value range to an object’s parameters, creating an animation based on the affected parameters. For example, the Spin behavior rotates an object over time at a rate that you specify.

Groups and layers can be moved and animated by using behaviors or by setting keyframes. Filters can also be animated.

A project represents a single flow of image data built from the bottom up. In a composite with a single group, the layers within that group are stacked above one another. Filters and behaviors that are applied to a layer appear beneath the object in the Layers list. The group represents the image that results from its combined layers and their applied behaviors, filters, and composite modes (blend modes).
In a simple example, a group contains a single image with applied color correction and blur filters (in that order). The image provides the input data to the color correction filter. The output data of the color correction is the input data for the blur filter. The group represents the result of that image data flow. Groups and layers are also stacked one above the other in a project—the output of the lower layer is the input to the layer above it in the list.

When working in 3D mode, a layer that is below another layer in the Layers list can appear above that layer in the Canvas if its Z position is closer to the camera. You can force the layers to respect their order in the Layers list by turning on Layer Order in the Group tab of the Inspector.

**About the Motion Workspace**

When you open Motion, the workspace fills your entire monitor, but the interface is actually made up of several independent windows. The sizes and arrangements of these windows are flexible to allow for the varying needs of different projects. There are additional panes and windows that can be displayed along with the default set. In the following illustration, the Cinema layout is used.
Utility Window

When you open Motion, a utility window appears on the left side of the screen and contains the File Browser from which you can add files to your project. The utility window also has tabs to display the Library which contains all of the effects, templates, and other goodies that come with Motion, and the Inspector where you can manipulate individual settings for those effects.

Note: In Cinema layout, the Inspector tab appears in a separate utility window, on the right side of the workspace.

Canvas

The majority of your screen is occupied by your main work area, the Canvas. This is similar to the document window in many other applications. It is here that you arrange and lay out the layers that comprise your composite. Adding layers and effects to your project is as simple as dragging them from the utility window to the Canvas.
When you want to watch your project play back, the transport controls at the bottom of this window (below the Canvas) allow you to play your project at regular speed or frame by frame. The mini-Timeline lies just above the transport controls and below the main body of the window. This control provides a view of where selected layers in the Canvas begin and end in time.

Canvas Shortcut Menu
The Canvas has its own shortcut menu that allows you to access some tools you may need while working in the Canvas.

To use the Canvas shortcut menu:
- Control-click an empty area of the Canvas (in the gray area outside of the actual project) and choose an option from the list:
  - New Group: Adds a new group to the project above any existing groups in the Layers tab.
  - Import: Opens the Import dialog, which allows you to import files from the Finder.
  - Paste: Pastes any item that has been copied to the Clipboard into a new group in the project. The new group is added above any existing groups in the Layers tab.
• **Project Properties**: Opens the Project Properties dialog, which allows you to modify the project’s background color, aspect ratio, field rendering, motion blur, and so on. For more information on the Project Properties, see “Creating Blank Projects from Project Presets” on page 182.

The Canvas also contains two additional panes that are hidden in the default view.

**Project Pane**
The Project pane contains three tabs, each of which provides access to different aspects of your project. The Layers tab displays the hierarchy of objects (groups, layers, cameras, lights, behaviors, filters, and so on) in your project. The Media tab shows all the files imported into your project, with an option to show the media whether or not it appears in the Canvas. The Audio tab provides access to, and control of, any audio files in your project. All of these tabs are covered in more detail later in the chapter.

**Timing Pane**
The Timing pane also has three tabs, each to control a different aspect of your project. The Timeline tab is a broad overview of all the objects and how they are laid out over time. The Keyframe Editor tab displays the animation curves for animated parameters and effects, and the Audio Editor tab provides access to the level and pan controls for the audio components of your project.

All of these tabs are covered in more detail later in this chapter and throughout the manual.
Window Arrangements
Different workflows require different sets of windows to be visible, and in different sizes. For example, when designing a layout for your composition, the bigger the Canvas, the better. However, when tweaking or finessing an animated effect, you may want more room dedicated to the Timing pane and the Inspector. Fortunately, Motion allows you to switch between different layouts quickly and even to save your own custom layouts.

Preset Layouts
Motion provides three preset window arrangements, called layouts. These layouts distribute the application’s windows in varying ways to accommodate different workflows.

To choose a preset window layout:
- Choose Window > Layouts, then choose a layout from the submenu.

Standard layout: This layout displays the utility window on the left and the Canvas on the right.
Alternate layout: This layout displays two utility windows on the left, the top one containing the Inspector and the bottom one containing the File Browser and Library. The Canvas fills the remainder of the screen to the right.

Cinema layout: The Cinema layout also displays two utility windows. The window on the left side of the workspace contains the File Browser and Library. The window on the right side contains the Inspector. The Canvas is in the middle with both the Project pane and the Timing pane displayed. The minimum monitor width resolution is 1325 to use Cinema layout.
Basic Window Controls
In addition to choosing from the preset arrangements, you can manually arrange your windows, resize them, or minimize them to the Dock.

To move a window:
- Drag a window by the title bar to the new location.

To resize a window:
- Drag the resize control in the lower-right corner of the window to resize it to the desired size.

To simultaneously resize adjacent windows:
- Drag the boundary between the two windows (the black line along the edge of the window). The pointer changes its shape over the boundary, indicating you can drag from there.

To minimize a window to the Dock:
- Click the minimize button in the title bar. You can also double-click the title bar of the Canvas to minimize it to the Dock.

Note: The utility windows cannot be minimized.

To close a window, do one of the following:
- Click the close button.
- Press Command-W in an active window.
Tabs
Motion uses tabbed windows to provide convenient access to multiple windows at once. You can switch between windows simply by clicking the appropriate tab. In addition, you can drag any tab out of its docked position to show the tabbed window in its own separate window. You can also drag a tab into another window. This lets you view multiple tabbed windows from the same group at one time. For example, you can drag the Inspector tab to a new location so that you can view the Library and the Inspector windows simultaneously.

To detach a tab:
- Drag the tab out of its docked position to any new location. When you release the mouse button, the tab becomes its own window, and you can use all standard window controls, such as closing, minimizing, and resizing.

To reattach a tab:
- Drag the tab at the top of the window back to its original location. For example, drag the Inspector tab back to its original group of tabs, and release the mouse button. The tab is reattached.

To show or hide a tab:
- In the Window menu, choose the name of the tab you want to show or hide. For example, choose Window > Timeline to show or hide the Timeline tab. You can also choose Keyframe Editor or Audio Editor to show or hide those tabs.

If the tab is detached from the Timeline area, click the close button. This closes the window, and it does not reappear as a tab. To display the window again, use the Window menu, and choose the appropriate command to show the window you want.

To reorder tabs:
- Drag a tab left or right in the tab area to reorder the tabs.

Swapping the Project Pane and Canvas
Similar to changing tab order, you can also change whether the Project pane appears to the left of the Canvas (default), or to the right. This can be especially useful when working with multiple monitors. For example, if the Canvas occupies the entire left monitor and your utility windows are on the right monitor, moving the Project pane to the right side of the Canvas would make it closer to the utility windows.

To move the Project pane to the opposite side of the Canvas:
- Choose Window > Layouts > Swap Project Pane and Canvas.
Saving Custom Layouts

Once you have the windows arranged to your liking, you can save your screen layout with a relevant title so you can switch back to it later. This makes it easy to set up layouts that help you perform certain tasks. For example, you might set up one layout that is good for editing curves, while another layout has an expanded Timeline for editing keyframes. You can switch between layouts in the Layouts submenu, and you can delete and duplicate layouts in the Manage Layouts window.

When you save a layout, you save the following items:

- Window positions (size and location)
- Column orders (in the Project pane)
- Project pane position (left or right)

**Note:** Tab order, Timeline display options, and Canvas display options are not saved in the custom layout.

**To save a layout:**

1. Organize the windows on your screen the way you want.
2. Choose Window > Save Current Layout.
   
   The Create Window Layout dialog appears.
3. Type the name you want to use to save the layout, then click Save.

The layout is saved and now appears in the Layouts submenu.
You can also create a new custom layout (based on the current state) by clicking the Add button (+) in the Manage Layouts dialog.

To switch to a saved custom layout:
- Choose Windows > Layouts, then choose the custom layout from the submenu.

To delete a saved layout:
1. Choose Window > Manage Layouts.
   The Manage Layouts dialog opens.
2. Select the layout you want to delete.
3. Click the Delete button (−) to remove the item from the list.
4. Click the Done button.

To duplicate a layout:
1. Choose Window > Manage Layouts.
   The Manage Layouts dialog opens.
2. Select the layout you want to duplicate.
3. Click the Duplicate button.
   A duplicate of the layout is added to the list. The word “copy” is appended to the name.
4. Click Done.

To rename a layout in the list:
1. Choose Window > Manage Layouts.
   The Manage Layouts dialog opens.
2. Double-click the layout you want to rename in the list.
   The name changes to a value field.
3. Type the new name in the value field.
4. Click Done.
Full Screen Mode
Motion has an option to cover your entire monitor with the Canvas. This is helpful for watching playback of your project without the distraction of the software interface. In this mode, all of the tools and controls that affect the Canvas remain active, though you have to rely on keyboard shortcuts and shortcut menus (Control-click) to change from one tool or control to another. You can access the menu bar by positioning your pointer at the top of the screen where the menu normally is.

To switch into Full Screen mode, do one of the following:
- Choose View > Full Screen Mode.
- Press F8.

To return to normal view, do one of the following:
- Position your pointer over the menu, then choose View > Full Screen Mode again.
- Press F8 again.

Toolbar
Motion’s Toolbar is located at the top of the main window. The default set of controls provides access to all of the tools you need for manipulating objects in the Canvas and elsewhere in the application. There are tools that create new text layers, shape layers, and masks. There are also icons to apply filters and behaviors, and to create particle systems and replicators. Finally, there are icons to show and hide the various windows and panes of the Motion interface such as the Timeline, HUD, and others.

Tool Groups
Tools are grouped in different ways. Several tools have multiple modes or options, such as Shape tools that can be set to rectangle, circle, or line mode. The Circle and Line tools are hidden until you click the Shape tool and hold down the mouse button. Tools with additional states are indicated with a tiny downward arrow in the lower-right corner of the tool.
Tools are also grouped into categories of use. The first set are called the View tools because they deal with changing the view and manipulation method in the Canvas. The second set are called Create tools, because they add new content to the project, such as text and shapes. The Mask set contains tools that add a mask to an existing layer or group.

On the top-right side of the Toolbar is a series of icons that adjust the Motion interface. These controls hide and show the various panes, tabs, and windows that comprise the Motion interface.

The following tables itemize each of the tools in the default tool set, by group. The first group is the View set. Once you have selected a tool and an object in the Canvas, you can switch between tools by pressing the Tab key. Press Shift-Tab to cycle through the tools in the reverse order.

**View Tools**

The View tools enable you to adjust and manipulate objects in the Canvas. The first button in this group activates eight subtools. Click this button and hold down the mouse button to see a pop-up list of all the subtools.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool name</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="arrow" alt="Select/Transform tool" /></td>
<td>Select/Transform tool</td>
<td>S (Press Tab to cycle through tools. An object must be selected in order to tab through the tools.)</td>
<td>Select/Transform tool is the default. This tool selects and moves objects in the Canvas. You can scale objects by dragging their corner points or rotate an object by dragging its center point. <strong>Note:</strong> If you have another tool selected, such as a mask tool, pressing the S key selects the previous tool option selected in the Select/Transform tools. If you are using the Adjust 3D Transform tool, press Shift-S to choose the Select/Transform tool.</td>
</tr>
<tr>
<td><img src="arrow" alt="Adjust Anchor Point tool" /></td>
<td>Adjust Anchor Point tool</td>
<td>S (Press Tab to cycle through tools.)</td>
<td>Changes the point around which an object scales or rotates. To use it, drag the current anchor point to a new position.</td>
</tr>
<tr>
<td><img src="arrow" alt="Adjust Shear tool" /></td>
<td>Adjust Shear tool</td>
<td>S (Press Tab to cycle through tools.)</td>
<td>Distorts an object by moving two adjacent corners at the same time, leaving the other two corners locked into place.</td>
</tr>
<tr>
<td><img src="arrow" alt="Adjust Drop Shadow tool" /></td>
<td>Adjust Drop Shadow tool</td>
<td>S (Press Tab to cycle through tools.)</td>
<td>Changes the direction and offset of an object’s drop shadow. This tool never moves the object itself.</td>
</tr>
<tr>
<td><img src="arrow" alt="Adjust Four Corner tool" /></td>
<td>Adjust Four Corner tool</td>
<td>S (Press Tab to cycle through tools.)</td>
<td>Allows you to distort an object by moving one of the corner points, leaving the other three corners locked into place. The image is stretched and distorted to fit the shape you create.</td>
</tr>
<tr>
<td>Button</td>
<td>Tool name</td>
<td>Keyboard shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Adjust Crop tool</td>
<td>S (Press Tab to cycle through tools.)</td>
<td>Allows you to hide portions of an object (except shapes) by dragging the edge or corner of the object.</td>
</tr>
<tr>
<td></td>
<td>Adjust Control Points tool</td>
<td>S (Press Tab to cycle through tools.)</td>
<td>Allows you to modify points and Bezier handles for masks, shapes, and motion paths.</td>
</tr>
<tr>
<td></td>
<td>Adjust Item tool</td>
<td>S (Press Tab to cycle through tools.)</td>
<td>A contextual tool that allows you to modify special controls such as the center point of a Circle Blur, or the shape of a particle emitter or replicator, or the start and end points of a gradient.</td>
</tr>
<tr>
<td></td>
<td>Adjust 3D Transform tool</td>
<td>Q</td>
<td>Allows you to manipulate objects in 3D space using 3D transform and rotation manipulators. To return to 2D controls, click the Select/Transform tool. To display rotational controls in the Canvas, press the Command key.</td>
</tr>
<tr>
<td></td>
<td>Pan tool</td>
<td>H</td>
<td>Allows you to drag your view of the Canvas in different directions. The Pan tool never moves individual objects. To reset the pan, double-click the Pan tool. To pan the Canvas without selecting the Pan tool, press the Space bar and drag in the Canvas.</td>
</tr>
<tr>
<td></td>
<td>Zoom tool</td>
<td>Z</td>
<td>Allows you to zoom in and out on the Canvas. Click the point in the Canvas that you want to zoom toward or away from and drag to the right to zoom in or drag left to zoom out. To reset the zoom, double-click the Zoom tool. To zoom into a specific area of the Canvas, press Command-Space bar (in that order) and drag an area of the Canvas. While still pressing the keys, click to zoom in to the Canvas in 50 percent increments of the current zoom level. Press Space bar-Command-Option (in that order) and click in the Canvas to zoom out in 50 percent increments.</td>
</tr>
<tr>
<td></td>
<td>Walk Camera tool</td>
<td>none</td>
<td>Allows you to navigate through your scene as if you are walking with the camera. Click the Walk Camera icon, then use the Up, Down, Right, and Left Arrow keys to navigate.</td>
</tr>
</tbody>
</table>
Create Tools
The Create tools generate new layers. You can modify the attributes for the newly created layers in the Inspector.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool name</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Rectangle tool" /></td>
<td>Rectangle tool</td>
<td>R</td>
<td>Creates a new rectangle shape in the Canvas and adds a shape layer to the Layers list. Click at the position where you want one corner to appear and drag to the position of the opposite corner. Pressing Shift while you drag constrains the layer to a square.</td>
</tr>
<tr>
<td><img src="image" alt="Circle tool" /></td>
<td>Circle tool</td>
<td>C</td>
<td>Creates a new circle shape in the Canvas and adds a shape layer to the Layers list. Click at the position where one edge of the circle should begin and drag toward the opposite edge. Pressing Shift while you drag constrains the shape to a circle.</td>
</tr>
<tr>
<td><img src="image" alt="Line tool" /></td>
<td>Line tool</td>
<td>none</td>
<td>Creates a new line shape in the Canvas and adds a shape layer to the Layers list. Click at the position where one end of the line should begin and drag toward the opposite end. Pressing the Shift key while you drag constrains the line to specific angles.</td>
</tr>
<tr>
<td><img src="image" alt="Bezier tool" /></td>
<td>Bezier tool</td>
<td>B</td>
<td>Creates a new freeform shape with Bezier point vertices. To create a shape, click repeatedly in the Canvas to add points to your shape. To close the shape, click the first point of the shape or press the C key. To create an open-ended shape, double-click the last point.</td>
</tr>
<tr>
<td><img src="image" alt="B-Spline tool" /></td>
<td>B-Spline tool</td>
<td>B</td>
<td>Creates a new freeform shape with B-Spline vertices. To create a shape, click repeatedly in the Canvas to add points to your shape. To close the shape, click the first point of the shape or press the C key. To create an open-ended shape, double-click the last point.</td>
</tr>
<tr>
<td><img src="image" alt="Paint Stroke tool" /></td>
<td>Paint Stroke tool</td>
<td>P</td>
<td>Creates shape-based paint strokes. Click where you want to start the stroke, then drag to create the stroke. Command-drag to adjust the size of the brush stroke before you create the stroke.</td>
</tr>
<tr>
<td><img src="image" alt="Text tool" /></td>
<td>Text tool</td>
<td>T</td>
<td>Creates new text and lets you edit the text of existing text layers. To create a text layer, click the tool in the Canvas at the position where you want the text to appear, then begin typing. Choose the Select/Transform tool (or press Esc) to grab or move the new text layer. To change the text of an existing text layer, select the Text tool, then click the text. The text becomes editable.</td>
</tr>
</tbody>
</table>
**Mask Tools**

The Mask tools can only be accessed when a layer (a visible object in the Canvas, such as an image or replicator) or 2D group is selected. Using a Mask tool creates a new mask that hides portions of the selected layer. By default, the area inside the mask remains visible. Masks have their own set of controls available in the Inspector.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool name</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Rectangle Mask tool" /></td>
<td>Rectangle Mask tool</td>
<td>Option-R</td>
<td>Creates a new rectangular mask in the Canvas. Click at the position where you want one corner to appear and drag to the position of the opposite corner. Pressing the Shift key while you drag constrains the mask to a square.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Circle Mask tool" /></td>
<td>Circle Mask tool</td>
<td>Option-C</td>
<td>Creates a new circular mask in the Canvas. Click at the position where one edge of the mask should begin and drag toward the opposite edge. Pressing the Shift key while dragging constrains the mask to a circle.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Freehand Mask tool" /></td>
<td>Freehand Mask tool</td>
<td>none</td>
<td>Creates a freeform mask in the shape that you draw. Drag to create the freeform shape. The shape automatically closes the mask between the first and last points.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Bezier Mask tool" /></td>
<td>Bezier Mask tool</td>
<td>Option-B</td>
<td>Creates a new freeform mask with Bezier point vertices. To create a mask, click repeatedly in the Canvas to add points to your mask. To close the mask, click the first point of the mask or press C. To create an open-ended mask, double-click the last point.</td>
</tr>
<tr>
<td><img src="image5.png" alt="B-Spline Mask tool" /></td>
<td>B-Spline Mask tool</td>
<td>Option-B</td>
<td>Creates a new freeform mask with B-Spline vertices. To create a mask, click repeatedly in the Canvas to add points to your mask. To close the mask, click the first point of the shape or press C. To create an open-ended shape, double-click the last point.</td>
</tr>
</tbody>
</table>
Camera and Effects Icons

The first icon on the right side of the Toolbar adds a new camera to a project. The next four icons make up the effects controls. These are special controls providing instant access to the most common effects. Because these controls apply effects to existing objects, they are not available unless an object is selected.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Icon name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="New Camera Icon" /></td>
<td>New Camera</td>
<td>Adds a new camera to the workspace. When you add a camera to a 2D project, a dialog appears asking if you want to convert your 2D groups to 3D groups. Although a camera can be added to a 2D project, the camera has no effect on a 2D group.</td>
</tr>
<tr>
<td><img src="image2" alt="Add Behavior Icon" /></td>
<td>Add Behavior</td>
<td>Activates a pop-up menu of behaviors. Choosing an item from the menu applies that behavior to the selected object(s). Objects to which behaviors can be applied include layers (images, particle emitters, and so on), groups, cameras, and lights. Generally, a subset of the controls for the behavior appear in the HUD; all of the controls appear in the Inspector. When the Adjust Item tool is selected, onscreen controls (if any) become available for the behavior.</td>
</tr>
<tr>
<td><img src="image3" alt="Add Filter Icon" /></td>
<td>Add Filter</td>
<td>Activates a pop-up menu of filters. Choosing an item from the menu applies that filter to the selected object. Filters can only be applied to layers (images, text, shapes, particle emitters, masks, replicators, generators, and so on). Filters cannot be applied to cameras or lights. Most of the controls for the filter appear in the HUD; all of the controls appear in the Inspector. When the Adjust Item tool is selected, onscreen controls (if any) become available for the filter.</td>
</tr>
<tr>
<td><img src="image4" alt="Make Particles Icon" /></td>
<td>Make Particles</td>
<td>Uses the selected layer (shape, text, image, and so on) as the source for a particle cell. The originally selected layer is disabled. A subset of the controls for the particle system appear in the HUD; all of the controls appear in the Inspector. When the Adjust Item tool is selected, onscreen controls become available for the particle emitter (except when Point is selected from the emitter Shape pop-up menu).</td>
</tr>
<tr>
<td><img src="image5" alt="Replicate Icon" /></td>
<td>Replicate</td>
<td>Uses the selected layer (shape, text, image, and so on) as a source cell for the replicator. The originally selected layer is disabled. A subset of the controls for the replicator appear in the HUD; all of the controls appear in the Inspector. When the Adjust Item tool is selected, the replicator onscreen controls become available.</td>
</tr>
</tbody>
</table>
Interface Icons
The interface icons on the far right of the Toolbar provide access to the main elements of the Motion interface. Click any of these icons to show or hide the corresponding window, tab, or pane.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Icon name</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![HUD icon]</td>
<td>HUD</td>
<td>F7, D</td>
<td>F7 toggles display of the HUD. If the HUD is not displayed, press D. Once the HUD is displayed, pressing D cycles through the HUDs for the selected object.</td>
</tr>
<tr>
<td>![File Browser icon]</td>
<td>File Browser</td>
<td>Command-1</td>
<td>Shows/hides the File Browser. Hides and shows the utility window if the File Browser is the only open tab.</td>
</tr>
<tr>
<td>![Library icon]</td>
<td>Library</td>
<td>Command-2</td>
<td>Shows/hides the Library. Hides and shows the utility window if the Library is the only open tab.</td>
</tr>
<tr>
<td>![Inspector icon]</td>
<td>Inspector</td>
<td>Command-3</td>
<td>Shows/hides the Inspector. Hides and shows the utility window if the Inspector is the only open tab.</td>
</tr>
<tr>
<td>![Project Pane icon]</td>
<td>Project Pane</td>
<td>F5</td>
<td>Shows/hides the Project pane.</td>
</tr>
<tr>
<td>![Timing Pane icon]</td>
<td>Timing Pane</td>
<td>F6</td>
<td>Shows/hides the Timing pane.</td>
</tr>
</tbody>
</table>

Customizing the Toolbar
You have many options for personalizing the Toolbar. You can change which controls appear on the Toolbar as well as the order in which they appear. You can put spaces and separators between the tools to group them to your liking. You can view all of the controls as icons, icons with a text description, or just as text.

To add controls to the Toolbar:
1 Do one of the following to display the Customize Toolbar dialog:
   • Choose View > Customize Toolbar.
   • Control-click the Toolbar, then choose Customize Toolbar from the shortcut menu.
2 Drag the buttons or icons you want to add to the position of your choice in the Toolbar.
3 Click the Done button to close the dialog.

To remove an item from the Toolbar:
• Control-click the button or icon you want to remove, then choose Remove Item from the shortcut menu.

Note: You can also remove items from the Toolbar when the Customize Toolbar dialog is open by dragging the items away from the Toolbar and releasing the mouse button. A "poof" appears to indicate that the button has been removed.
Spaces and Separators
In addition to adding and arranging controls in the Toolbar, you can add spaces, flexible spaces, and separators to arrange and group the contents of your Toolbar.

Separator: A separator adds a dotted vertical line between two controls. The separator has no function other than as an organizational tool. The default layout uses a separator between the effects icons and the interface icons.

Space: A space adds a single icon’s width of space between other controls.

Flexible Space: A flexible space distributes controls evenly across the Toolbar, taking up as much or as little space as needed to fill the empty parts of the bar. The default layout has a flexible space between the Mask tools and the effects icons.

Additional Buttons and Icons
The Customize Toolbar dialog provides access to additional icons that are not present in the default set.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Customize.png" alt="Customize" /></td>
<td>Customize</td>
<td>Opens the Customize Toolbar dialog.</td>
</tr>
<tr>
<td><img src="Colors.png" alt="Colors" /></td>
<td>Colors</td>
<td>Opens the Colors window.</td>
</tr>
<tr>
<td><img src="Fonts.png" alt="Fonts" /></td>
<td>Fonts</td>
<td>Opens the Mac OS X Font panel. You can also browse fonts within the Motion Library. For more information, see Appendix, “Using the Library Font Preview,” on page 576.</td>
</tr>
<tr>
<td>![New Light](New Light.png)</td>
<td>New Light</td>
<td>Adds a new light to the project, visible in the 3D workspace.</td>
</tr>
<tr>
<td><img src="Layers.png" alt="Layers" /></td>
<td>Layers</td>
<td>Shows or hides the Layers tab in the Project pane.</td>
</tr>
<tr>
<td><img src="Media.png" alt="Media" /></td>
<td>Media</td>
<td>Shows or hides the Media tab in the Project pane.</td>
</tr>
</tbody>
</table>
For more information on using the Template Browser, see “Creating New Projects from Templates” on page 181.

**External Video:** When you have an additional monitor connected to your system, clicking this icon automatically sends output to the external monitor. Clicking it again turns off output to the additional monitor. Without using this icon, you must choose Motion > Preferences (or press Command-comma) and change the Output settings. This button has two states, depending on whether External Video is turned on or off.

### Changing the Icon View

The Toolbar controls can be viewed as icons, text, or both. By default, both names and icons are displayed. Once you get familiar with the icons, you can choose to hide the names to save desktop space. Alternately, go with just the names to save the most space.

**To change the view in the Toolbar, do one of the following:**

- Control-click the Toolbar, then choose an option from the shortcut menu.

### Table: Toolbar Controls

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Audio" /></td>
<td>Audio</td>
<td>Shows or hides the Audio tab in the Project pane.</td>
</tr>
<tr>
<td><img src="image" alt="Timeline" /></td>
<td>Timeline</td>
<td>Shows or hides the Timeline in the Timing pane.</td>
</tr>
<tr>
<td><img src="image" alt="Keyframe Editor" /></td>
<td>Keyframe Editor</td>
<td>Shows or hides the Keyframe Editor in the Timing pane.</td>
</tr>
<tr>
<td><img src="image" alt="Audio Editor" /></td>
<td>Audio Editor</td>
<td>Shows or hides the Audio Editor in the Timing pane.</td>
</tr>
<tr>
<td><img src="image" alt="Template Browser" /></td>
<td>Template Browser</td>
<td>Opens the Template Browser.</td>
</tr>
</tbody>
</table>
Choose an option from the Show pop-up menu in the lower-left corner of the Customize Toolbar dialog.

- Click the Toolbar button in the upper-right corner of the main window.
- Choose View > Hide Toolbar.
- Press Command-Option-T.

If the Toolbar is currently hidden, these same controls all show the Toolbar instead of hiding it.

**Canvas**

The centerpiece of the Motion workspace is the Canvas. Whatever you see in the Canvas reflects exactly what you get when you export or output your project. However, this window is not just a place to view the results of your work; this is where you modify and arrange the elements of your project.
You can directly manipulate the items in the Canvas to modify physical attributes such as position, scale, and rotation, or use familiar drag-and-drop techniques to apply behaviors or filters directly to the items in the Canvas. See Chapter 5, “Using Behaviors,” on page 369, and Chapter 10, “Using Filters,” on page 841, to learn more about how to use these features.

**Status Bar**

A Status Bar appears at the top of the Canvas below the Toolbar and provides information about your project. There are three types of information that can be displayed here: color, coordinates, and frame rate.
**Color**

Some motion graphics projects may require you to match or align different colors in your project. The Status Bar can provide visual and numerical information on the color of the pixel currently under the pointer, as well as the value of the alpha channel. No clicking is necessary—as you move the pointer, the Status Bar updates.

![Status Bar with pixel color information](image)

**To display the current pixel color in the Status Bar:**
- Control-click the Status Bar, choose Color from the shortcut menu, then position the pointer over the Canvas.

This procedure allows you to see the exact color and alpha values of the examined pixel. You can view the color numerically in one of three formats:

- **RGBA:** The red, green, blue, and alpha components of the color are represented in values from 0–255.
- **RGBA (percent):** The red, green, blue, and alpha components of the color are represented in values from 1–100.
- **HSV:** The hue is represented from 1–360, and the saturation and value (luminance) are represented in values from 1–100.

**To choose between viewing color in RGB, RGB (percent), and HSV:**
- Control-click the Status Bar, then choose the color space option you want from the shortcut menu.

*Note:* Color must be enabled in the Status Bar to choose a color space.

**Coordinates**

For precision placement of objects in the Canvas, it may be helpful to know the exact pixel position of the pointer at any given time. The Status Bar can display this information in an X and Y coordinate system (Cartesian). The center point of the Canvas is 0,0.

**To display the current pointer position in the Status Bar:**
- Control-click the Status Bar, then choose Coordinates from the shortcut menu.
Frame Rate
Part of the way Motion plays back your project in real time is by lowering the frame rate when the sequence is too complex to render at full speed. You can monitor the current frame rate in the Status Bar. It is measured in frames per second (fps).

Note: This number only appears while the project is playing.

To monitor the project’s playback frame rate:
- Control-click the Status Bar, then choose Frame Rate from the shortcut menu.

You can also turn the Status Bar items on and off in the Appearance Preferences pane. To display Motion Preferences, choose Motion > Preferences.

Canvas View Options
The Canvas is a versatile workspace with many options to optimize the workflow for different types of projects. For example, there are rulers, grids, and guides to help with alignment and arrangement of objects.

There are also a number of controls for viewing a single color channel in the Canvas. You can use these to examine layers’ alpha channels, or to manipulate effects that affect only a single color channel.

You can also set options to speed up playback by reducing image quality so you can watch complex projects at high frame rates while you’re constructing the projects. This allows you to rough out your composition quickly. Certain effects that severely impact rendering time, such as motion blur and field rendering, can also be turned off temporarily.

In addition, you can view the Canvas in 2D mode or in 3D mode, which lets you place layers and groups in 3D space. For more information on using the Canvas in 3D mode, see “Canvas in 3D Mode” on page 54.
There are five pop-up menus at the right side of the Status Bar that provide access to these settings: Zoom Level, Resolution, Channels, View and Overlay Options, and 3D View Options.

**Zoom Level**
You can zoom in on the Canvas to allow precision alignment and placement of objects, and you can zoom out to get a sense of the big picture or to see the path of a moving object. The Zoom Level pop-up menu offers several different default zoom levels. You can also use the dynamic zoom modes to quickly zoom in or out of the Canvas, or to zoom specific areas of the Canvas.

Zooming the Canvas does not actually change the size of the images in your project. It merely changes the current view of the entire window.

**To zoom in or out on the Canvas:**
- Choose a zoom level from the Zoom Level pop-up menu.

In the following image, 50% is chosen from the Zoom Level pop-up menu.

**To use the dynamic zoom mode:**
- Press Command-Space bar, then drag diagonally in the Canvas. The zoom occurs around the spot clicked in the Canvas.
To zoom in and out of a specific area of the Canvas:
- Press Space bar-Command (in that order), then drag the area of the Canvas you want to zoom. While still pressing the keys, click the mouse button to zoom in 50 percent increments of the current zoom level. Press Space bar-Command-Option (in that order), and click to zoom out in 50 percent increments of the current zoom level.

*Note:* To pan the Canvas without selecting the Pan tool, press the Space bar and drag in the Canvas.

To reset the Canvas Zoom level, do one of the following:
- Choose 100% from the Zoom Level pop-up menu.
- In the Toolbar, double-click the Zoom tool (located between the Pan and Walk Camera tools).

To reset the Canvas Pan:
- In the Toolbar, double-click the Pan tool.

To zoom the Canvas so that the entire viewable area of the project fills the window:
- Choose Fit In Window from the Zoom Level pop-up menu.

**Resolution**

If you have a complex project that is causing your computer to play at a very low frame rate, you can lower the resolution of the Canvas to reduce the strain on the processor. This frees you from waiting for the image to be rendered at full resolution each time you make an adjustment. The lower the resolution, the smaller the texture that is sent to your graphics card.

The Resolution pop-up menu contains the following options:

**Full:** Displays the Canvas at full resolution.

**Half:** Displays the Canvas at half resolution.

**Third:** Displays the Canvas at one-third resolution.

**Quarter:** Displays the Canvas at one-quarter resolution.

To change the Canvas resolution:
- Choose the amount of image reduction you want from the Resolution pop-up menu.

*Note:* There is a separate Render Quality control in the View and Overlay menu that handles the post-process render quality of images, text, or particles rather than of the Canvas as a whole. For more information, see “View and Overlay” on page 44.
**Channels**

The Channels pop-up menu controls which color channels are displayed in the Canvas. This menu displays the following options:

**Color:** Shows the image just as it would appear on a video monitor. Visible layers appear in natural color and transparent areas reveal the background color as set in the Project Properties dialog. This is black by default. To change the project background color, choose Edit > Project Properties (or press Command-J) and click or Control-click the Background Color well.

**Note:** The Background pop-up menu in the General tab of the Project Properties dialog must be set to Solid in order to export the background color with the project. This option creates a solid alpha channel on export (when exporting using a codec that supports alpha channels). When the Background pop-up menu is set to Transparent, the color is visible in the Canvas, but does not render as part of the alpha channel.

**Transparent:** Shows the background area of the Canvas as transparent. A checkerboard pattern appears by default where no images block the background.

**Alpha Overlay:** Displays the image in normal color, but adds a red highlight over transparent areas of the image.

**RGB Only:** Displays the normal mix of red, green, and blue channels but displays transparent areas (including semi-transparent areas) as opaque.

**Red:** Displays only the red channel as a range of black to white.

**Green:** Displays only the green channel as a range of black to white.

**Blue:** Displays only the blue channel as a range of black to white.

**Alpha:** Displays the alpha (transparency) channel of the layers in the Canvas.

**Inverted Alpha:** This setting displays an inverted view of the alpha (transparency) channel.

**View and Overlay**

The View and Overlay pop-up menu provides access to the various types of guides and controls that can be viewed in the Canvas. It also has controls to globally turn off some render-intensive functions, such as motion blur, to accelerate Canvas playback. When an option is active, a checkmark appears beside the menu item.

**Note:** These options are also available in the View pull-down menu.

**Show Overlays:** Toggles the display of all overlays on and off in the Canvas. This setting must be on in order to view any of the other overlay items (grids, guides, and so on). To turn the camera overlays on or off, use Show 3D Overlays.

**Note:** You can also press Command-/.
**Rulers:** Toggles display of the rulers along the edge of the Canvas on and off. You can specify where the rulers appear in the Canvas section of Motion Preferences. For more information on using rulers, see “Using the Canvas Rulers” on page 52.

*Note:* You can also press Command-Shift-R.

**Grid:** Turns a grid display on and off over the Canvas. You can set the spacing and color of the grid in the Canvas section of Motion Preferences.

*Note:* You can also press Command-apostrophe (’).

**Guides:** Turns display of manually created guides on and off. Guides can only be created if rulers are also displayed. You can change the color of the guides in the Canvas section of Motion Preferences.

*Note:* You can also press Command-semicolon (;).

**Dynamic Guides:** Turns display of automatic dynamic guides on and off. These guides appear when dragging a layer past edges of other layers. You can change the color of the dynamic guides in the Canvas section of Motion Preferences.

*Note:* You can also press Command-Shift-semicolon (;).

**Safe Zones:** Turns display of the title safe and action safe guides on and off. By default, these guides are set at 80% and 90%. You can change these settings and the color of the guides in the Canvas section of Motion Preferences.

*Note:* You can also press apostrophe (’).

**Film Zone:** Turns display of the film aspect ratio guides on and off. This can be helpful if you are creating a project for videotape that is to be transferred to film. You can change the size of the guides as well as their color in the Canvas section of Motion Preferences.

*Note:* You can also press Shift-apostrophe (’).

**Handles:** Turns display of object handles in the Canvas on and off. Viewing object handles is necessary to perform certain onscreen transformations, such as resizing. Handles only appear on selected objects.

**Lines:** Turns display of the lines that outline an object on and off.

**Animation Path:** Turns animation paths on and off. These editable paths indicate the route along which animated objects travel. If the selected object is not positionally animated, this command does not appear to have any effect. If handles are not displayed, the path curves cannot be adjusted in the Canvas. Animation paths created by behaviors, with the exception of the Motion Path behavior, are for display only and are not editable.
Show 3D Overlays: Turns all 3D overlays off, including Camera overlays, 3D View Tools, Compass, Inset View, 3D Grid, and 3D Scene Icons.

Note: You can also press Command-Option-/.

3D View Tools: Turns the Camera menu and 3D View tools on and off.

Compass: Turns the 3D Compass on and off. Using red, green, and blue axes, the compass shows your current orientation in 3D space. The red axis is X (horizontal), the green axis is Y (vertical), and the blue axis is Z (depth).

When you hold the pointer over the 3D Compass, it changes to a 3D View Selector. Click any of the colored view icons, such as Front, Left, Right, Perspective, and so on to switch to that view. The Canvas animates as it changes to the new view. For more information on working with the Compass and the different views, see “3D Compositing” in the Motion Supplemental Documentation PDF.

Inset View: Turns the Inset view on and off. When enabled, a temporary window appears in the lower-right corner of the Canvas displaying an Active Camera or Perspective view of your project that helps you stay oriented as you move objects in 3D space. You can change the size of the Inset view, as well as control whether the Inset view appears on transform changes, on all changes, or manually.
The Inset view displays the Perspective or Active Camera view. The Perspective view dynamically changes to fit the objects in the Inset view (even if objects are no longer visible in the main window). This view is triggered when you are already looking through the camera. The Active view is triggered when you are using a camera view other than the active camera (such as Front). For more information on the Inset view, see “3D” on page 149.

**Note:** Because project elements are 2D (flat) objects, the elements are not visible when you use orthogonal camera views (Left, Right, Top, and Bottom) unless the elements are rotated in 3D (or text, particles, or the replicator are using the Face Camera parameter in their respective Inspectors). This is because orthogonal views are at right angles (perpendicular) to the elements. When an object is selected, a thin gray line represents the object in the Canvas. For more information on using cameras, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.

The heart particles are visible in the Inset view, which is a perspective view of the project, because Face Camera is turned on in the Particle Emitter Inspector.
3D Grid: Turns the grid on and off in 3D views. The 3D grid helps you stay oriented and can be used to guide the placement of objects in your project. The 3D grid only appears when you are in a 3D workspace.

3D Scene Icons: Toggles the display of the cameras and lights. The scene icons appear in the Canvas as yellow wireframe icons. Lights appear with red (X), green (Y), and blue (Z) adjust 3D handles that let you transform and rotate the light object. The handles are still displayed when 3D Scene Icons is turned off. For more information on the 3D Scene Icons, see “3D Compositing” in the Motion Supplemental Documentation PDF.

Correct for Aspect Ratio: Applies an artificial distortion of the Canvas in projects with nonsquare pixels. When the setting is on, the computer monitor simulates what a TV monitor displays. When the setting is off, projects with nonsquare pixels appear stretched. This is because computer monitors have square pixels. This setting does not modify the actual output of the project.
Show Full View Area: When enabled, this setting lets you see the portion of a layer that extends beyond the edge of the Canvas. This setting is disabled by default, as it slows your project’s interactivity.

Render Quality: Sets the display mode for objects in the Canvas, such as text and images, to Draft, Normal, or Best.

- **Draft**: Renders objects in the Canvas at a lower quality to allow optimal project interactivity.
- **Normal**: The default setting, renders objects in the Canvas at a medium quality.
- **Best**: Renders objects in the Canvas at Best quality. This option slows down project interactivity.

  **Note**: 10-bit YUV files render at 8-bit in the Canvas unless Render Quality is set to Best.

**Tip**: When exporting a project using the “Movie - current project and canvas settings” option (from the Use pop-up menu in the Export dialog), set Render Quality to Best prior to exporting.

Lighting: Turns the effect of lights in a project on or off. It does not turn off lights in the Layers list or light scene icons, but it disables light effects in the Canvas.

When this setting is turned on and you are using a default export preset (such as DV NTSC Movie), your project is exported with lighting. This is because export presets are exported with the “Use current project and canvas settings” option turned on by default (in the Output tab of the Export Options dialog). When this checkbox is turned on, whatever is enabled in the View pop-up menu is also exported.

To override the current project settings for lighting on export:
1. Choose File > Export.
2. Optional: Select a name and location for the saved file.
3. In the Export dialog, click the Options button next to the Export pop-up menu.
In the Output tab of the Export Options dialog, turn off “Use current project and canvas settings.”

The options in the Output tab become available, including Resolution, Color, Frame Rate, Camera, Lighting, Render Quality, Field Rendering, Motion Blur, and Frame Blending settings.

When the Lighting checkbox is turned on in the Output tab, the project is exported with lighting regardless of the Lighting status in the View pop-up menu.

**Field Rendering:** Turning this setting off disables field rendering, which is required for smooth motion playback on a TV monitor. Field rendering nearly doubles rendering time, so disabling this item may result in a dramatic performance improvement.

When Field Rendering is turned on in the View menu and you are using the default export preset (“Movie - current project and canvas settings”), your project is exported with field rendering. (The default codec used is Animation, 8-bit, Color + Alpha.) When this default setting is used, any options chosen in the View pop-up menu (or the View pull-down menu), as well as settings in the Project Properties dialog, are exported.

However, if you choose another preset, field rendering is enabled based on the selected preset itself (whether that particular codec requires fields). For example, if you choose DV NTSC Movie, field rendering is enabled because fields are expected. If you choose DVCPro HD 720p24 Movie, field rendering is disabled because it is a progressive-scan (no fields) movie format.

**Note:** When opening a Motion project in another application such as Final Cut Pro or DVD Studio Pro, the Field Rendering setting in the View pop-up menu does not control whether field rendering is applied or not. This is controlled in the Project Properties dialog (press Command-J). When Field Order is set to anything other than None, field rendering is used in the other application, regardless of the Field Rendering status in the View pop-up menu.

**To override the current project settings for field rendering on export:**

1. Choose File > Export.
2. Optional: Select a name and location for the saved file.
3. In the Export dialog, click the Options button next to the Export pop-up menu.
4. In the Output tab of the Export Options dialog, turn off “Use current project and canvas settings.”

**Note:** If you have already chosen another export preset from the Use pop-up menu in the Export dialog, “Use current project and canvas settings” is turned off.

The options in the Output tab become available, including Resolution, Color, Frame Rate, Camera, Lighting, Render Quality, Field Rendering, Motion Blur, and Frame Blending settings.
When the Field Rendering checkbox is on in the Output tab, the project is exported with field rendering regardless of the Field Rendering status in the View pop-up menu.

**Motion Blur:** Turning this setting off disables the preview of motion blur in the Canvas. This may result in a dramatic performance improvement. When using a default export preset, this setting does not affect the actual output of your project. None of the default export presets are set to use motion blur.

When Motion Blur is turned on in the View menu and you are using the default export preset (“Movie - current project and canvas settings”), your project is exported with motion blur. (The default codec used is Animation, 8-bit, Color + Alpha.) When this default setting is used, any options chosen in the View pop-up menu (or the View pull-down menu), as well as settings in the Project Properties dialog, are exported.

However, if you choose any another preset, motion blur is disabled and must be manually enabled in the selected preset. For example, if you choose DV NTSC Movie, motion blur is disabled. You can override a preset’s settings, as described below.

**Note:** When opening a Motion project in another application such as Final Cut Pro, Motion Blur in the View pop-up menu controls whether or not motion blur is applied.

**To override the current project settings for motion blur on export:**

1. Choose File > Export.
2. Optional: Select a name and location for the saved file.
3. In the Export dialog, click the Options button next to the Export pop-up menu.
4. In the Output tab of the Export Options dialog, turn off “Use current project and canvas settings.”

**Note:** If you have already chosen another export preset from the Use pop-up menu in the Export dialog, “Use current project and canvas settings” is turned off.

The options in the Output tab become available, including Resolution, Color, Frame Rate, Camera, Lighting, Render Quality, Field Rendering, Motion Blur, and Frame Blending settings.

When the Motion Blur checkbox is turned on in the Output tab, the project is exported with motion blur regardless of the Motion Blur status in the View pop-up menu.

**Frame Blending:** Turning this setting off disables frame blending in the Canvas. Frame blending can smooth the appearance of video frames by interpolating the pixels between two adjacent frames to create a smoother transition.
When this setting is turned on in the View menu and you are using the default export preset (“Movie - current project and canvas settings”), your project is exported with frame blending. (The default codec used is Animation, 8-bit, Color + Alpha.) When this default setting is used, any options chosen in the View pop-up menu (or the View pull-down menu), as well as settings in the Project Properties dialog, are exported.

However, if you choose any another preset, frame blending is enabled based on the selected preset. For example, if you choose DV NTSC Movie, frame blending is enabled. You can override a preset’s settings, as described below.

**To override the current project settings for frame blending on export:**

1. Choose File > Export.
2. Optional:  Select a name and location for the saved file.
3. In the Export dialog, click the Options button next to the Export pop-up menu.
4. In the Output tab of the Export Options dialog, turn off “Use current project and canvas settings.”

**Note:** If you have already chosen another export preset from the Use pop-up menu in the Export dialog, “Use current project and canvas settings” is turned off.

The options in the Output tab become available, including Resolution, Color, Frame Rate, Camera, Lighting, Render Quality, Field Rendering, Motion Blur, and Frame Blending settings.

When the Frame Blending checkbox is turned on in the Output tab, the project is exported with frame blending regardless of the Frame Blending status in the View pop-up menu.

**Preview for Float Bit Depth:** When working in float space, turning this setting off drops the preview in the Canvas to 8-bit. Because working in float space drastically increases processing time, turn this setting off to speed your workflow. This setting does not modify the actual output of the project.

**Note:** For more information on float space, see “About Bit Depth” on page 185.

**Using the Canvas Rulers**

Using rulers in the Canvas can help you compose or align the elements of your project, as well as snap objects to the rulers.

**To turn on rulers:**

- In the View pop-up menu, enable Rulers (or press Command-Shift-R). When enabled, a checkmark appears next to the item in the pop-up menu.

By default, rulers appear along the left and top sides of the Canvas. You can change the location of the rulers in the Canvas pane of Motion Preferences.
To add a horizontal or vertical guide to the Canvas:
1. In the Toolbar, click the Select/Transform tool (or press S).
2. Click in the gray area of the horizontal or vertical ruler, and drag into the Canvas. As you drag, the value of the guide is displayed in the Canvas.

Note: Guides must be enabled in the View menu (press Command-semicolon) to display the guides.

The ruler units are in pixels, with the 0,0 point in the center of the Canvas.
3. When the guide is in the location you want, release the mouse button.

To simultaneously add a horizontal and vertical ruler to the Canvas:
1. In the Toolbar, click the Select/Transform tool (or press S).
2. Drag from the corner in which the rulers meet into the Canvas.
3. When the guides are in the location you want, release the mouse button.

To remove a guide from the Canvas:
- In the Toolbar, click the Select/Transform tool (or press S), then drag the guide off the Canvas.

To change the location of the rulers:
1. Choose Motion > Preferences.
2. In the Canvas pane, choose a ruler layout from the Ruler Location pop-up menu.
To change the color of the guides:

1. Choose Motion > Preferences.
2. In the Canvas pane, click or Control-click the Guide Color well, then select a color.

**3D View**

This pop-up menu lets you specify how you want to view your project in the Canvas. You can view the Canvas as a single workspace, or choose from the available window arrangements in the menu. The following examples show two of the available window arrangements.

*Note:* Although the different workspace views are available for 2D projects, they are most useful when working in 3D space.

![Two top windows; one lower window arrangement](image1.png) ![Four windows arrangement](image2.png)

**Canvas in 3D Mode**

In addition to the traditional 2D project workspace, Motion provides a 3D workspace in which to arrange and animate objects, including groups, layers, cameras, and lights. When you switch to 3D mode, additional controls become available in the Canvas that reflect the new environment. A small set of 3D View tools appears in the upper-right corner of the Canvas window, and a 3D Compass appears in the lower-left corner. The upper-left corner of the Canvas contains the Camera menu, where you can choose which camera to use to view your project in 3D space.

*Note:* You must add at least one camera to your project to create a 3D workspace.

**To add a camera to your project:**

1. Click the New Camera icon in the Toolbar.
   
   A dialog appears that prompts you to switch your 2D groups to 3D groups.

2. Click Switch to 3D to add a camera and create a 3D project.

*Note:* If you click Keep as 2D, a camera is added to your project and all groups remain 2D groups.
Manipulating the 3D View
The 3D workspace provides tools for manually changing your view or viewing your scene from a particular camera view, such as Front, Back, Top, Bottom, and so on. You can also choose to view the scene through any of the cameras added to your project.

Note: The Left, Right, Top, and Bottom camera views are orthogonal views. You cannot animate or export these views.

To set the current view:
- Click the Camera menu in the upper-left corner of the Canvas and choose a camera from the menu. Motion animates your view change as it moves to the new view.

If you have modified the view, an asterisk appears next to the name of the camera view.

Note: If you isolate a layer or group (choose Object > Isolate), the Camera menu shows the name of the isolated object as the current view. For more information on the Isolate feature, see “Layers Tab” on page 68.

To use the 3D View tools:
- Drag the Pan, Orbit, or Dolly tool in the 3D View tools.

Like a camera move, the view moves, rotates, or zooms.

Important: The gray camera icon is a reminder that when you use the 3D View tools, you are moving the active camera.

To reset your camera, do one of the following:
- Double-click the Pan, Orbit, or Dolly tool.
- Click the Camera menu (in the upper-left corner of the Canvas) and choose Reset View.
In the Properties tab of the Inspector, click the Transform parameters reset button.

Manipulating Objects in 3D Space
The 3D workspace provides tools for manipulating objects in 3D space. These tools include the 3D onscreen controls that directly manipulate the object, the 3D transform controls in the HUD, and the parameters in the Properties tab for the selected object.

To transform an object in 3D space:
1 Select the object that you want to transform and select the Adjust 3D Transform tool in the Toolbar.

Scale handles appear around the edge of the object, and three colored 3D axis handles appear at the anchor point of the object. Each arrow-shaped handle corresponds to an axis along which you can move the object.

2 Drag the appropriate transform handle, and the object moves along the selected axis. The red axis is X (horizontal), the green axis is Y (vertical), and the blue axis is Z (depth).

To rotate an object in 3D space:
1 Select the object that you want to transform and select the Adjust 3D Transform tool in the Toolbar.

Scale handles appear around the edge of the object, and three colored 3D axis handles appear at the anchor point of the object. The three small circles near the axis handles are 3D rotation handles. Each rotation handle corresponds to an axis around which you can rotate the object.
2 Position the pointer over one of the three rotation handles on either side or above the colored arrows.

- The red ring indicates rotation around the X axis.
- The green ring indicates rotation around the Y axis.
- The blue ring indicates rotation around the Z axis.

3 Once the 3D rotation handle is active, drag left or right in the Canvas to rotate the object around the selected axis.

To reset a transformed object:

1 Select the object you want to reset.

In the Properties tab of the Inspector, click the Transform parameters reset button.

For more information on working in 3D and using the 3D transform tools in the HUD, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.
Playing Your Project

Use the transport controls at the bottom of the Canvas to play your project and see how it looks over time. You can set playback to loop as well as set playback to begin and end on certain frames in your project. You can also turn audio on and off.

**Play/Pause:** Starts and stops playback. The keyboard shortcut is the Space bar.

**Loop playback:** Controls whether playback loops indefinitely, or whether playback stops when the end of the play range is reached. The keyboard shortcut is Shift-L. For more information on setting a project play range, see “Defining the Play Range” on page 359.

**Play from start:** Plays from the play range In point to the play range Out point. This allows you to watch just a portion of the entire project. To learn how to define the In and Out points, see “Defining the Play Range” on page 359.

**Go to start of project:** This button automatically returns your playhead to the beginning of the project. The keyboard shortcut is Home.

**Go to end of project:** Automatically moves the playhead to the end of the project. The keyboard shortcut is End.

**Go to previous frame:** Moves the playhead backward by one frame. Clicking the button (or holding down the shortcut key) rewinds the project one frame at a time. The keyboard shortcut is the Left Arrow (or Page Up) key.

**Go to next frame:** Advances the playhead by one frame. Clicking the button (or holding down the shortcut key) advances the project one frame at a time. The keyboard shortcut is the Right Arrow (or Page Down) key.

**Play/Mute audio:** Turns audio playback on or off.

**Note:** Turning audio off may improve your playback performance.
Record: Enables or disables animation recording. When recording is enabled, the value sliders for all animateable parameters appear with a pink tint in the Inspector. This is to inform you that any change you make to a parameter (such as moving an object in the Canvas or adjusting a slider) creates a keyframe.

Note: When “Record keyframes on animated parameters only” is turned on in the Recording Options dialog, keyframes are added only to parameters that are already animated. For more information, see “Recording Keyframes on Animated Parameters Only” on page 562.

RAM Preview
When you play your project, Motion performs complex calculations to represent the objects and effects that appear in each frame. This is called rendering. The project plays back as quickly as possible up to the frame rate specified in the Project Properties dialog. With a very complex project, the frame rate may be significantly reduced, making it difficult to see how the project looks when it is played at full frame rate.

You can render parts of your project and store the frames in RAM. This lets you play back your project and see it play at full frame rate. This is called RAM Preview. You can choose to render the play range, a selection, or the entire project (All). As the frames are rendered, a progress dialog appears and shows which frame is being rendered, how many more frames remain, and an approximation of the time remaining.

You can interrupt the RAM Preview by clicking the Stop button. The section that has already been rendered is stored in RAM.

Note: Because different sections of the project can be of differing complexities, the Time remaining value may be somewhat inaccurate.

To RAM Preview your entire project:
- Choose Mark > RAM Preview > All.

The RAM Preview dialog appears, and displays a progress bar. When the RAM Preview is completed, the dialog closes.
When a section of your project is currently stored in RAM, the Timeline and the mini-
Timeline turn green to indicate which frames are stored.

**RAM Previewing Regions**

Previewing large sections of your project using RAM Preview requires large quantities
of RAM to store the frames. You may not have enough RAM to store all of the frames
you want to preview. You can restrict which frames are rendered either by choosing to
preview the play range or a selection. Using RAM Preview on a selection renders all
visible layers in the project from the first frame of the selection until the last.

**To RAM Preview the play range:**

- Choose Mark > RAM Preview > Play Range.

  The RAM Preview dialog appears, and displays a progress bar. When the RAM Preview is
  completed, the dialog closes.

**To RAM Preview a selection:**

1. In the Timeline, Command-Option-drag the region you want to preview.

   A light blue band appears over the selected frames.

   For more information on regions, see “Working with Regions” on page 359.

2. Choose Mark > RAM Preview > Selection.

   The RAM Preview dialog appears. When the RAM Preview is completed, the dialog
closes.

   **Note:** Working in float has no effect on your RAM Preview. Although the project is
   rendered in float, the preview is down-converted to 8-bit for display on your monitor.
Clearing the RAM Preview
You can manually delete the RAM Preview to make room for a new RAM Preview or to free up RAM for other operations.

To clear the RAM Preview:
- Choose Mark > RAM Preview > Clear RAM Preview.

Mini-Timeline
The mini-Timeline lies just above the transport controls and below the Canvas. This control provides an at-a-glance look at where selected objects fit into your overall project. The mini-Timeline also has a playhead to indicate which frame you are viewing as well as In and Out markers to identify the play range. The length of the mini-Timeline represents the entire duration of the project.

You can drag the playhead through the mini-Timeline to scrub your project, or to jump quickly to a particular point in time. You can also change the play range or layer In and Out points by dragging the In and Out markers. When you drag an In or Out point, the playhead temporarily moves along with the pointer. This allows you to see the frame where your In or Out point will be set. When you release the mouse button, the playhead snaps back to its previous position.

Project markers set in the Timeline are indicated in the mini-Timeline by a thin, green line. For more information on project markers and object markers, see “Adding Markers” on page 362.

Note: Object markers do not appear in the mini-Timeline.

Editing in the Mini-Timeline
You can perform many nonlinear editing functions in the mini-Timeline. You can drag objects (such as clips or images, or items that have been saved to the Library, such as shapes, text, cameras, lights, and so on) from the utility window directly to the mini-Timeline. You can also move, trim, and slip objects to change which portion of the object appears at which point in time. For more information on editing functions such as Move, Trim, and Slip, see “Editing Objects in the Timeline” on page 341.
To add an object to the mini-Timeline:
1 Drag the object from the File Browser to the mini-Timeline.
   As you drag, a tooltip appears to indicate the frame where your edit will take place.
2 When you reach the desired frame, release the mouse button.
   The object is added to the project beginning at that frame.

You can also add multiple objects to the mini-Timeline at once. You can choose to add
the objects sequentially (one after another) or as a composite (all at the same point in
time).

Tip: If the Timeline contains project markers, you can snap the imported object to a
marker. Drag the layer over the mini-Timeline, and release the mouse button when a
black bar appears at the snap point. The layer’s In point is the project marker.

To add multiple objects to the mini-Timeline:
1 Drag the objects from the File Browser to the mini-Timeline.
   As you drag, a tooltip appears to indicate the frame where your edit will take place.
2 Continuing to hold down the mouse button, drag to the desired frame.
   A drop menu appears.
3 Choose the desired edit type from the drop menu, then release the mouse button.
   Depending on the item that is dragged to the Timeline, up to four different drop
options are available. For more information on the Timeline drop menu, see “Adding
Objects to the Timeline” on page 331.

To move an object in time:
1 In the Layers list, Timeline layers list, or Canvas, select the object you want to move.
   The object appears in the mini-Timeline.
2 In the mini-Timeline, drag the object to the left or right to reposition it in time.
A tooltip appears to indicate the new In and Out point of the object, as well as the amount of change from the previous position.

3 When you reach the position you want, release the mouse button.

**To shorten or lengthen an object:**
1 Select the object to display it in the mini-Timeline.
2 Position the pointer over the beginning or ending edge of the object.
   The pointer changes to a trim pointer.

3 Drag the edge of the object to change its duration.
   A tooltip appears to indicate the new In or Out point and the amount of change that your edit is causing.

*Note:* You cannot trim an object to be longer than the amount of frames available in the corresponding media file unless its End Condition is set to Hold, Loop, or Ping Pong in the Timing controls of the Properties tab of the Inspector.

**To slip an object in the mini-Timeline:**
1 Select the object you want to modify.
2 Position the pointer over the body of the object in the mini-Timeline and press the Option key.
   The pointer changes to a slip pointer.
3 Drag the clip to the left or right to use a later or earlier part of the clip.
A tooltip appears to indicate the new In and Out points.

**Note:** You cannot slip a clip unless it has been trimmed first. For more information, see “Slipping Clips” on page 345.

**To snap the playhead to a project marker in the mini-Timeline:**
- Press Shift and drag the playhead in the mini-Timeline.

**Timecode and Current Frame Fields**
There are two timecode fields at the bottom of the Canvas, to the left and right of the transport controls. The field to the left is the current frame field which shows the frame or timecode number where the playhead is positioned. You can change the playhead position by changing the number in the current frame field.

The field to the right is the project duration field. This field indicates the length of your current project. You can modify the duration of the project by changing the number in this field. When a semicolon appears between the seconds and frames values, it indicates that frames are being dropped.

Both fields can be modified in multiple ways and can be displayed either as incremental frame numbers or as eight-digit timecode numbers.

**To change the current frame or duration:**
- Click the field, type a new number into the field, and then press Tab or Return to confirm your entry.
To increase or decrease the current frame or duration one frame at a time:
- Click the left or right arrow for the field you want to change.

Note: You can also move the playhead forward and backward one frame at a time by pressing the Left Arrow key (or Page Up key) to decrease, and the Right Arrow key (or Page Down key) to increase.

To change the duration in seconds, minutes, or hours, type the following in the project duration field:
- To set the duration in seconds, type the number of seconds followed by a period. For example, to create a 10-second project, type 10. in the field, then press Return.
- To set the duration in minutes, type the number of minutes followed by two periods. For example, to create a 10-minute project, type 10.. in the field, then press Return.
- To set the duration in hours, type the number of hours followed by three periods. For example, to create a 1-hour project, type 1... in the field, then press Return.

This procedure works in timecode as well as frames.

To move ahead or back in seconds, minutes, or hours, type the following in the current frame field:
- To move forward in seconds, type a plus sign (+), then type the number of seconds you want to move forward, and then type a period. For example, to move 2 seconds ahead, type +2. in the field, then press Return. To move ahead in minutes, type two periods after the number, and to move ahead in hours, type three periods after the number.
- To move backward in seconds, type a minus sign (–), then type the number of seconds you want to move backward, and then type a period. For example, to move 2 seconds backward, type –2. in the field, then press Return. To move backward in minutes, type two periods after the number, and to move backward in hours, type three periods after the number.

To move the playhead to a specific frame:
- With the Canvas or Project pane active, type the desired timecode or frame number into the current frame field. Press Return to confirm your entry.

To move forward a specific number of frames:
- Type a plus sign (+) followed by the number of frames you want to move forward.

To move backward a specific number of frames:
- Type a minus sign (–) followed by the number of frames you want to move backward.
To modify the current frame or duration dynamically:

- Click the center area of the field (where the numbers are), then drag to the left to increase the value, or to the right to decrease the value.

Dragging the current frame field in this way is equivalent to dragging the playhead through the mini-Timeline.

To switch between timecode and frame numbers, do one of the following:

- Click the current frame icon directly to the left of the current frame field.

Clicking either icon switches between frame and timecode view for all controls in all open projects.

**Counting Time**

Motion offers two different ways of looking at the frame numbers for your project. You can view the time as incremental frames, starting at 1 or 0 and continuing indefinitely. Or, you can view the time in the video-standard, eight-digit timecode system, which runs like a clock from 00:00:00:00 to 23:59:59:29. The first two digits represent the hours; the second two, the minutes; the third two, the seconds; and the final two, the frames, as in HH:MM:SS:FF.

Some formats of timecode also skip numbers in order to accommodate the inexact frame rates of certain video formats.

Both frames and timecode have advantages, depending mainly on the format with which you are originating and finishing. For example, if you are designing a title sequence for a 35mm film that must be exactly 720 frames, it is easier to set your counters to frames.

If you are building a television spot that is going to be laid onto a videotape or broadcast, you would probably benefit from setting your counters to timecode, so that the frame numbers correspond with the numbers on the videotape.
Project Pane
Once you begin building more complex projects, you can view the components of your project in a list. You can view and modify the hierarchy of objects, including grouping layers and changing group order. You can turn certain objects and effects on and off to temporarily simplify your composition. You can view and modify the media files associated with the layers in your project. You can also modify certain attributes of the layers and groups, such as opacity, blend mode, and audio levels.

All of this can be accomplished in the Project pane, which is ordinarily to the left of the Canvas.

To display the Project pane, do one of the following:

- Click the Project icon in the Toolbar.
- Press F5.
- Drag the divider on the left edge of the Canvas.

You can also switch the arrangement of the windows so the Project pane appears on the right side of the Canvas.

To switch the sides of the Canvas and Project panes:

- Choose Window > Layouts > Swap Project Pane and Canvas.

The Project pane contains three tabs: Layers, Media, and Audio. Each of these tabs allows you to view the elements of your project in a list view.
Layers Tab
The Layers tab of the Project pane provides an overview of all the layers, effects, and masks currently used in your project. The hierarchy of items in the list illustrates which objects are above or below other objects in the Canvas. All objects, with the exception of cameras and lights, must reside within groups. Masks, behaviors, and effects can be applied to groups or to individual layers. Applied masks, behaviors, and effects are listed beneath the group or layer to which they are applied. The masks, behaviors, and effects appear indented in the list.

The Name and Status columns in the Layers list display several icons that indicate linked audio, 2D/3D status, or lock status. By default, applied masks, behaviors, and filters also appear in the Layers list. You can turn the display of these objects on or off in the Layers tab.

To display the Layers tab, do one of the following:
- Click the Project icon in the Toolbar.
- Choose Window > Layers.
- Press Command-4.
- If the Project pane is already visible, click the Layers tab at the top of the pane.
The information is displayed in a column view and there are many controls to let you customize the view while you are working. You can resize or rearrange the columns and you can hide certain columns and display others that are not visible in the default set.

The Layers tab contains the following columns:

**On:** Contains an activation checkbox to turn the visibility of the object on or off. When the object visibility is turned off, you can still modify the object’s parameters and manipulate its onscreen controls.

**Preview:** Contains a thumbnail of the object. The group thumbnail represents the cumulative result of the composite up to that point in the project.

**Name:** Identifies the object by name. To edit the name, double-click the text area of a selected object, type a new name, then press Return. In projects that contain a camera, the Isolate button appears in the Name column.

**Isolate button:** The Isolate button only appears in projects that contain a camera. Once a camera is added to the project, all groups are converted to 3D (if you choose Switch to 3D in the New Camera dialog). If you choose Keep as 2D in the New Camera dialog, the camera is added to the project, but the groups remain 2D groups. Once a camera is added to the project, the Isolate button appears for any selected group, layer, or camera.

The button has an active and inactive state. Clicking the Isolate button for a layer or group sets that object to its original face-forward orientation (so you can apply a mask, for example). Clicking the button again returns to the previous view. Clicking the Isolate button for a camera takes you to that camera’s view.

*Note:* When a group or layer is isolated, the name of the item replaces the current camera listing in the Camera menu (in the upper-left corner of the Canvas).
**Status:** Contains a number of several possible icons to indicate the status of the object. The lock icon lets you lock an object to prevent any changes from affecting that object. Locking a group prevents changes to all layers and effects within that group. This column may also include a link icon when a layer has a corresponding audio element, such as a multi-channel QuickTime file.

The Status column also contains a 2D/3D icon to toggle a group between 2D or 3D mode. The same icon appears immediately to the left of the group name and indicates the 2D/3D status of the group. Individual layers cannot be 2D or 3D—they are always 2D elements within a 2D or 3D group.

To display additional columns, click the right angle bracket at the right of the column headers. A pop-up menu appears containing three items: Preview, Opacity, and Blend. Checkmarks in the pop-up menu identify which columns are currently displayed. By default, only the Preview column is checked. Choose the other items to add them to the Layers tab. Choosing a checked item hides it from view.

**Opacity:** Displays the current opacity (transparency) of the group or layer. You can adjust the slider to change the item’s opacity.

**Note:** Opacity can also be adjusted in a HUD or in the Properties tab of the Inspector.

**Blend Mode:** Displays the current blend mode of the layer or group. Click the pop-up menu to choose a new blend mode. For more on blend modes, see “Using Blend Modes” on page 290.

**Note:** Blend mode can also be changed by Control-clicking the item in the Layers list (or Timeline layers list), in the HUD, or in the Properties tab of the Inspector.
**Editing Columns**
Any window that contains columns of data can be reorganized to suit your needs. You can change the order in which columns appear as well as the size of the cells. For example, in the Layers tab, you may want the Preview column to appear to the right of the Name column instead of to its left. You can also sort the items in the column by type of file.

**To reorder columns:**
- Drag the column header left or right to a new position.

Columns can be resized in several ways. You can adjust the width of a column, or you can change the height of all cells in the columns at once, including any icons and text inside the cells.

**To adjust column width:**
- In the header row, drag a column border to resize the width.

**To adjust cell height:**
- Position the pointer over any horizontal line and drag up or down to decrease or increase the height of all cells.

Icons and thumbnails resize themselves as you make the adjustment.

You can also drag the scale slider at the bottom of the window. Drag left to decrease the height of the rows and drag right to increase their height.

**Adding and Removing Groups**
The Layers tab has controls to add new groups and to remove existing objects from the project.

**To create a new group in the Layers list, do one of the following:**
- Click the Add button (+) in the upper-left corner of the tab.
- Choose Object > New Group (or press Shift-Command-N).

A new empty group is added at the top of the list.

**Note:** You can also create new groups when dragging files to the Layers tab from the File Browser or Library. For more information, see “Adding Files to Your Project” on page 215.
To remove an object from the Layers list, do one of the following:

- Select the object you want to remove, then click the Delete button (–) in the upper-left corner of the tab.
- Control-click the file you want to remove, then choose Delete from the shortcut menu.
- Select the file you want to remove, then choose Edit > Delete (or press Delete). The object is removed. This action removes the object from the Canvas as well.

**Note:** If you delete a media file (an imported image, image sequence, audio file, or QuickTime movie) from the project, the file is also removed from the Media tab unless “Automatically manage unused media” is turned off in the General pane of Motion Preferences (press Command-comma). When this setting is turned off, media files are deleted from the Layers tab (and Canvas), but remain in the project in the Media tab. Drag an item from the Media tab into the Canvas to add it to the Layers tab.

**Filtering the Layers List View**
As your project becomes more complex, you may want to temporarily hide certain objects from view. This allows you to focus on one or more objects without the distraction of all the other objects in your list. You can perform this sort of filtering by using the Search field in the upper-right corner of the tab.

Once you begin typing in the Search field, the Layers list hides any objects that do not contain the text you type. Hidden objects continue to appear in the Canvas.

**To filter the Layers list:**

- Type the name of the object or objects you want to view in the Search field. All other objects are temporarily hidden.

To stop filtering and return to the complete list:

- Click the Clear button inside the Search field.

The Search field is cleared and the Layers list returns to the unfiltered view.

**Hiding and Showing Effects**
Masks, behaviors, and filters can be turned on and off in the Layers list by using the buttons at the bottom-right corner of the Layers tab.
Note: Hiding the effect in the Layers list does not disable it from view in the Canvas nor prevent you from modifying the effect’s parameters or manipulating its onscreen controls.

To toggle the display of masks in the Layers tab:
- Click the Show Masks button.

To toggle the display of behaviors in the Layers tab:
- Click the Show Behaviors button.

To toggle the display of filters in the Layers tab:
- Click the Show Filters button.

Turning Effects On and Off
When certain effects are applied to a layer or group, icons appear in the Name column for that item. This lets you know that such an effect is applied, especially if you have the effects hidden. There are icons for masks, filters, and behaviors. Additionally, these icons let you toggle the effects on and off in the Canvas.

Note: You can also Control-click the icons in the Layers tab or Timeline layers list to display a list of the applied effects.

To turn masks off for a layer or group:
- Click the Mask icon.
A red slash appears over the icon and the effect is temporarily turned off.
To turn behaviors off for a layer or group:
- Click the Behavior icon.
  A red slash appears over the icon and the effect is temporarily turned off.

To turn filters off for a layer or group:
- Click the Filter icon.
  A red slash appears over the icon and the effect is temporarily turned off.

For each of these controls, clicking the icon again turns the effect back on.

Additional Options in the Layers Tab
Quite a few additional features are available in the Layers tab and Timeline layers list, which you can find in the shortcut menu that appears when you Control-click layers in the list. These operations apply to the selected item.

Cut: Removes the layer and places it on the Clipboard.
Copy: Copies the layer to the Clipboard.
Paste: Places the contents of the Clipboard in the current location.
Duplicate: Creates a new layer identical to the selection.
Delete: Removes the selected layer.
Group: Places the selected layers into a group. (For more information on working with groups, see “Grouping and Ungrouping Layers” on page 241.)
Ungroup: Restores the components to their ungrouped state if the selection contains a group.
Active: Turns the layer on or off. This is equivalent to clicking the activation checkbox in the On column.
Solo: Soloing a layer hides all other layers in the project. When the selected item is soloed, checkboxes for other layers and groups are dimmed. You can solo multiple layers and groups at a time.
Isolate: Available when a project contains a camera, this option isolates the selected layer, group, or camera. For a layer or group, choosing Isolate changes the item back to its original face-forward orientation to allow the application of a mask, for example. Clicking a camera’s Isolate button activates that camera’s view. This is the same as clicking the Isolate icon in the Name column.
3D Group: Toggles the group between a 2D and a 3D group.
Blend Mode: Sets the blend mode for the selected layer. This is equivalent to setting a value in the Blend column.
Add Image to Mask: Adds an image mask to the selected layer. An image mask creates transparency in another object by deriving an alpha channel from another layer, such as a shape, text, movie, or still image. For more information, see “Applying Image Masks to a Layer” on page 1104.

Make Clone Layer: Clones the selected layer. Like the Duplicate command, Make Clone Layer lets you make copies of a selected layer. However, copies created by the Make Clone Layer command are automatically modified to match certain changes you make to the original layer. For more information on cloning layers, see “Making Clone Layers” on page 283.

Reveal Source Media: Opens the Media tab and highlights the media file associated with the selected clip.

Media Tab
The second tab in the Project pane contains a complete list of media in your project. “Media” includes imported audio, image, image sequence, and QuickTime movie files. Unlike the Layers tab, the Media tab may contain items that are not actively used in your project. Also, if you’ve used a single layer repeatedly, the Media tab may only show one version of that layer. Effects (such as filters or masks) and other layers created within Motion (such as masks, shapes, or text) do not appear in the Media tab.

To display the Media tab, do one of the following:

- Choose Window > Media.
- Press Command-5.
- If the Project pane is already visible, click the Media tab at the top of the pane.
- To display the additional columns in the Media tab, drag the divider between the Project pane and the Canvas (the vertical bar on the right side of the window).

The Media tab provides a great deal of technical information about the media files in your project. This data is displayed in the following columns for each file:

Preview: Shows a thumbnail of the media file. The thumbnail for an audio file (with no associated image) appears as a speaker icon.

Name: Contains the name of the media. Media names are not editable because they refer to the actual names of the files on disk.
Kind: Identifies the type of media, including QuickTime movie, still image, QuickTime audio, or PDF. See Appendix B, “Video and File Formats,” on page 1203 for a list of supported codecs and file types.

In Use: When checked, this field indicates that the media is currently being used in your project. When unchecked, it is not used. If “Automatically manage unused media” is turned on in the General tab of Motion Preferences (press Command-comma), Motion removes unused media from the Media tab automatically. Disable this setting if you prefer to manage the contents of the Media tab manually.

Duration: Displays the duration of the media in either frames or timecode.

Frame Size: Displays the native size of the image in pixels. The numbers represent width and height. This column remains blank for audio-only files.

Compressor: Displays the type of compression used in the clip, if any. This is also sometimes referred to as a codec.

Depth: Displays the number of colors (bit depth) of the file. Any item listed as Millions of Colors+ indicates that the media contains an alpha channel in addition to the RGB data.

Vid Rate: Displays the original frames per second of the media. Sequences are listed at the current project frame rate and still images display no Vid Rate.

Data Rate: Displays the number of bytes per second at which the media file plays.

Aud Rate: Displays the sample rate in the audio track, measured in kilohertz (kHz).

Aud Format: Displays the bits per sample (usually 8, 16, or 24) and the number of channels (usually mono, stereo, or multi-channel) of the audio track.

File Size: Displays the overall file size of the media on disk.

File Created: Displays the creation date of the media.

File Modified: Displays the last date on which the media was modified.
**Hiding Columns**

You can choose which of the columns are displayed by clicking the right angle bracket at the right of the column headers.

Items in the list with a checkmark are currently displayed in the Media tab. Items with no checkmark are currently hidden.

**To hide a column:**
- Click the right angle bracket at the right of the column headers, then choose the item you want to hide from the pop-up menu.

**To show a column:**
- Click the right angle bracket at the right of the column headers, then choose the item you want to show from the pop-up menu.

The item is added to the far right of the columns.

Any window that contains columns of data can be reorganized. You can change the order in which columns appear, as well as the size of the cells. For example, in the Media tab, you may want the Frame Size column to appear before the Name column. For specific instructions on how to edit columns, see “Editing Columns” on page 71.

**Adding and Removing Media**

The Media tab has controls to add new files and to remove existing files from the project.

**To add a file to the Media tab, do one of the following:**
- Click the Add button (+) in the upper-left corner of the tab. In the Import Files dialog, navigate to the file you want to add to your project, select the file, then click Import.

  **Note:** To import an image sequence, turn on the Image Sequence checkbox. If this checkbox is turned off, only the individual files selected in the Import dialog are imported. To select multiple files, Shift-click the files; to select noncontiguous files, Command-click the files.
With the Media tab active, choose File > Import (or press Command-I). In the Import Files dialog, navigate to the file you want to add to your project, select the file, then click Import.

The file is added to the Media tab.

**Important:** Files added directly to the Media tab are not added to the Canvas. To add a file to the Canvas, drag the file from the Media tab to the Canvas.

To remove a file from the Media tab, do one of the following:

- Select the file you want to remove and click the Delete button (–) in the upper-left corner of the tab.
- Control-click the file, then choose Delete from the shortcut menu.
- Select the file you want to remove, then choose Edit > Delete (or press Delete).

The media is removed. If the media is used in the Canvas, an alert appears asking you to confirm that you want to remove the files.

**Filtering the Media Tab**

As your project becomes more complex, you may want to temporarily hide certain files from view. This allows you to focus on one or more files without the distraction of all the other files in your list. You can perform this sort of filtering by using the Search field in the upper-right corner of the tab. For instructions on how to filter the Media tab, see “Filtering the Layers List View” on page 72.

**Additional Options in the Media Tab**

Quite a few additional features are available in the Media tab, which you can find in the shortcut menu that appears when you Control-click files in the list. The actions in this menu apply to the selected file or files.

**Open in Viewer:** Opens the selected item in the viewer window. This is equivalent to double-clicking a file in the File Browser.

**Open in QuickTime Player:** Opens the selected item in the QuickTime Player application.

**Reveal in Finder:** Switches out of Motion, and opens a Finder window where the Media file resides on disk.

**Reconnect Media:** Opens the Reconnect Media dialog where you can assign a new source file on disk to correspond to the Media file in Motion.

**Cut:** Removes the file and places it on the Clipboard.

**Copy:** Copies the file to the Clipboard.

**Paste:** Places the contents of the Clipboard in the current location.

**Duplicate:** Creates a new file identical to the selected file.
Delete: Removes the selected file.

When no items are selected in the tab, the shortcut menu provides a different set of commands:

Import Media: Imports media into the Media tab, but does not place the media into the Canvas.

Reconnect Missing Media: When a media file is moved from where it was stored when it was added to your project, you need to reconnect the media to your project. This command displays a dialog that lets you navigate to the new location of the file.

Remove Unused Media: If any media is in your project but is not used, you can choose this command to quickly removed the unused objects from the Media tab.

Paste: Pastes any media files on the Clipboard into the Media tab, but does not place the media into the Canvas.

Project Properties: Opens the Project Properties dialog, where you can set basic project information such as project width and height, bit depth, aspect ratio, background color, render settings, and much more. For more information on the Project Properties dialog, see "Creating Blank Projects from Project Presets" on page 182.

To sort the items in a column by type of file in the Media tab:

- Click the column header.

Note: Sorting does not work in the Layers tab or Timeline layers list.
The layers are sorted in the column and a small arrow appears indicating the direction of the sort.

To reverse the direction of the sort:
- Click the header of the column that contains the small arrow.

The arrow points in the opposite direction, and the data is sorted in reverse order.

**Audio Tab**

The Audio tab lists all of the audio files and files that contain audio (such as a multi-track QuickTime movie) in your project. You can modify the levels of the individual files or modify the overall audio level of the project. For more information on working with audio in Motion, see Chapter 13, "Working with Audio," on page 1117.
To display the Audio tab, do one of the following:

- Choose Window > Audio.
- Press Command-6.
- If the Project pane is already visible, click the Audio tab at the top of the pane.

The Audio tab contains a number of columns with both display and editable information about the audio components of your project:

**On:** Contains an activation checkbox to turn the audio on or off.

**Name:** Identifies the file by name. To edit the name, double-click the text area of a selected file, type a new name, then press Return. This column also contains a slider and value field to control the level (volume) of the file. Numbers in the value field are measured in decibels (dB).

**Pan:** Displays the left-right balance of the sound. You can modify the Pan parameter by dragging the slider to the right or left or by entering a numerical pan value. Negative numbers move panning to the left, positive numbers move panning to the right.

**Status:** Contains Mute and Solo buttons to control audio playback for the file. When the Mute button is active, all sound from that file is removed from the mix. When the button is inactive, audio from the file plays back based on the level slider in the Name column.

When the Solo button is active, other nonsoloed audio elements do not play. This allows you to temporarily play a single item without hearing the other files in the mix. You can solo more than one file. This allows you to hear just the soloed files rather than the entire mix.

**Output:** Specifies audio output channels such as stereo, left, right, center, and so on. Click the field, then choose the output channel you want for the audio track.

**Lock:** Allows you to lock an audio file to prevent any changes from affecting that file. This column also may include a link icon when a file has a corresponding video element.
Editing Columns in the Audio Tab
You can control which columns are displayed by clicking the right angle bracket to the right of the column headers. Doing so opens a pop-up menu with a list of columns. Items in the list with a checkmark are displayed in the window. Items without a checkmark are hidden. You can also edit the arrangement and size of the columns. For more on how to hide and show columns, see “Hiding Columns” on page 77. For instructions on how to edit columns, “Editing Columns” on page 71.

Adding and Removing Audio Files
The Audio tab has controls to add new files and to remove existing files from the project.

To add an audio file to the project, do one of the following:
- Click the Add button (+) in the upper-left corner of the tab. In the Import Files dialog, navigate to the file you want to import, select the file, then click OK.
- With the Audio tab active, choose File > Import (or press Command-I). In the Import Files dialog, navigate to the file you want to add to your project, select the file, then click Import.

Note: When importing a QuickTime movie that contains multiple audio tracks, select Mix to Stereo in the Import Files dialog to import the file with a single audio track. Select Import All Tracks to import the file with individual tracks.

The file is added to the project (the Audio and Media tabs).

To remove a file from the Audio tab, do one of the following:
- Select the file you want to remove, then click the Delete button (–) in the upper-left corner of the tab.
- Control-click the file, then choose Delete from the shortcut menu.
- Select the file you want to remove, then choose Edit > Delete (or press Delete).

The file is removed.

Note: This action removes the file from the project (from the Audio and Media tabs).

Filtering the Audio Tab
As your project becomes more complex, you may want to temporarily hide certain audio files from view. This allows you to focus on one or more files without the distraction of all the other files in your list. You can perform this sort of filtering by using the Search field in the upper-right corner of the tab. For instructions on how to filter your view, see “Filtering the Layers List View” on page 72.
Additional Options in the Audio Tab

Quite a few additional features are available in the Audio tab, accessible through the shortcut menu that appears when you Control-click files in the list:

**Cut:** Removes the file and places it on the Clipboard.

**Copy:** Copies the file to the Clipboard.

**Paste:** Places the contents of the Clipboard in the current location.

**Duplicate:** Creates a new file identical to the original file.

**Delete:** Removes the selected file.

**Send to Soundtrack Pro:** Launches Soundtrack Pro and opens the selected audio clip in Soundtrack Pro for editing.

**Active:** Turns the file on and off. This is equivalent to clicking the activation checkbox in the On column.

**Mute:** Sets the selected item to be muted. This is equivalent to clicking the Mute button in the Status column.

**Solo:** Sets the selected item to Solo. This is equivalent to clicking the Solo button in the Status column.

**Reveal Source Media:** Opens the Media tab and highlights the media file associated with the selected clip.

When no files are selected in the Audio tab, the shortcut menu provides a different set of commands.

**Import Audio:** Opens the Import Files dialog, which you can use to navigate to the audio file you want to import.

**Paste:** Pastes any audio data that is currently in the Clipboard into the Audio tab and Media tab.

**Project Properties:** Opens the Project Properties dialog, where you can set basic project information such as project width and height, bit depth, aspect ratio, background color, render settings, and much more. For more information on the Project Properties dialog, see “Creating Blank Projects from Project Presets” on page 182.
Timing Pane
At some point in most projects, you want to view the contents of your composition represented as a graph over time. This may be to compare when two objects appear or disappear, or when an effect begins or changes. You may want to add or remove objects in your project at a particular point in time to observe or modify how different parameters of different effects occur. You may also want to view your audio waveforms to allow visual events to synchronize with your soundtrack.

All of this can be accomplished in the Timing pane, which appears at the bottom of the Canvas.

To display the Timing pane, do one of the following:
- Drag the divider on the bottom edge of the Canvas.
- Click the Timing icon in the upper-right corner of the Canvas.
- Choose Window > Timeline (or press Command-7).
- Press F6.
- Choose Window > Layouts > Cinema (or press Control-Option-U).
The Timing pane contains three tabs: Timeline, Keyframe Editor, and Audio Editor. Each of these allows you to view the elements of your project stretched out over time.

**Timeline**
The Timeline is the most general of the Timing tabs. It can display not only the visual elements in your project (the layers), but also audio tracks, cameras, lights, keyframes, and effects such as masks, behaviors, and filters. For more information on using the Timeline, see “Using the Timeline” on page 321.

To display the Timeline tab, do one of the following:
- Choose Window > Timeline (or press Command-7).
- If the Timing pane is already visible, click the Timeline tab at the top of the pane.

**Timeline Layers List**
The left side of the Timeline—the Timeline layers list—is nearly identical to the Layers tab in the Project pane. Objects appear in the project hierarchy categorized into layers and groups. The three columns are identical to the columns in the Layers list.
On (not labeled): This column (identical to the On column in the Layers tab) contains an activation checkbox to the left of each object that turns the visibility of the object on and off. When the object visibility is turned off, you can still modify the object’s parameters and manipulate its onscreen controls.

Name (not labeled): Identifies the object by name. (This column is identical to the Name column in the Layers tab.) To edit the name, double-click the text area of a selected object, type a new name, then press Return. In projects that contain a camera, the Isolate button also appears in this column.

Isolate: The Isolate button only appears in projects that contain a camera. Once a camera is added to the project, all groups are converted to 3D (if you choose Switch to 3D in the New Camera dialog). If you choose Keep as 2D in the New Camera dialog, the camera is added to the project, but the groups remain 2D groups. Once a camera is added to the project, the Isolate button appears for any selected group, layer, or camera.

The button has an active and inactive state. Clicking the Isolate button for a layer or group sets that object to its original face-forward orientation (so you can apply a mask, for example). Clicking the button again returns to the previous view. Clicking the Isolate button for a camera takes you to that camera’s view.

Status (not labeled): Contains a number of several possible icons to indicate the status of the object. (This column is identical to the Status column in the Layers tab.) The lock icon lets you lock an object to prevent any changes from affecting that object. Locking a group prevents changes to all layers and effects within that group. This column may also include a link icon when a layer has a corresponding audio element, such as a multi-channel QuickTime file.

The Status column also contains a 2D/3D icon to toggle a group between 2D or 3D. The same icon appears immediately to the left of the group name and indicates the 2D/3D status of the group. Individual layers cannot be 2D or 3D—they are always 2D elements within a 2D or 3D group.

Note: Changes made in the Timeline layers list also change the Layers list in the Project pane and vice-versa.
Timeline Layers List Effects Controls
When certain effects are applied to an object, icons appear next to the name of that item. There is an icon for masks, filters, and behaviors. These icons control the visibility of those effects in the Canvas.

To turn masks off for a layer or group:
- Click the Masks icon in the Timeline layers list.
  A red slash appears over the icon and the effect is temporarily turned off.

To turn behaviors off for an object:
- Click the Behaviors icon in the Timeline layers list.
  A red slash appears over the icon and the effect is temporarily turned off.

To turn filters off for a layer or group:
- Click the Filters icon in the Timeline layers list.
  A red slash appears over the icon and the effect is temporarily turned off.
  For all three of these controls, clicking the icon again turns the effect back on.

Timeline Layers List Display Options
As with the Layers tab, you can choose to show or hide effects such as masks, filters, and behaviors. Additionally, the Timeline lets you display keyframes. You can also choose to display audio tracks and, if audio tracks are displayed, you can hide groups and layers. All of these display options are controlled by the row of buttons in the lower-left corner of the Timeline.
Masks, behaviors, and filters can be displayed as layers in the Timeline, just as they are displayed in the Layers tab. Showing or hiding effects in the list does not control whether the effect appears in the Canvas.

**To toggle the display of masks in the Timeline:**
- Click the Show/Hide Masks button.

**To toggle the display of behaviors in the Timeline:**
- Click the Show/Hide Behaviors button.

**To toggle the display of filters in the Timeline:**
- Click the Show/Hide Filters button.

When keyframes are shown, each track becomes a little taller, and the bottom section is used to show any keyframes that exist for the layer.

**To toggle the display of keyframes in the Timeline:**
- Click the Show/Hide Keyframes button.
Audio files appear in a separate section from other objects. You can move the divider between the audio and video sections of the Timeline to show more or less of each section.

To toggle the display of audio files:
- Click the Show/Hide Audio button in the lower-left corner of the Timeline tab.

To toggle the display of layers and groups:
- Click the Show/Hide Layers button in the lower-left corner of the Timeline tab.
  
  **Note:** You cannot hide layers and groups unless audio files are currently visible. This is to prevent the Timeline from becoming completely empty.

To move the divider between audio and video tracks:
- Position the pointer over the divider, then drag up or down to expand or contract the track section.

You can adjust the height of the tracks in the Timeline to provide more or less vertical space. You can also expand the size of the Layers list.

To adjust track height, do one of the following:
- Position the pointer over any horizontal line and drag up or down to decrease or increase the height of all tracks.

- Click one of the “Set timeline row size” buttons at the bottom of the tab.
To change the width of the Timeline layers list:
1 Position the pointer over the rightmost edge of the Timeline layers list.
2 When the pointer changes to the column adjust pointer, drag left or right.

**Adding and Removing Groups**
The Timeline has controls to add new groups and to remove existing layers from the project.

To create a new group in the Timeline layers list, do one of the following:
- Click the Add button (+) in the upper-left corner of the tab.
- Choose Object > New Group (or press Shift-Command-N).
  A new empty group is added at the top of the list.
You can also create new groups when dragging files to the Timeline layers list from the File Browser or Library. For more information, see “Adding Files to Your Project” on page 215.

To remove an object from the Timeline layers list, do one of the following:
- Select the object you want to remove, then click the Delete button (–) in the upper-left corner of the tab.
- Control-click the file you want to remove, then choose Delete from the shortcut menu.
- Select the file you want to remove, then choose Edit > Delete (or press Delete).
  The object is removed. This action removes the object from the Canvas as well.

**Using the Current Frame Field**
Next to the Add button (+) and the Delete button (–), the Timeline also contains a current frame field that can be used to navigate your project.

To move the playhead to a new time, do one of the following:
- Click the current frame field, then type a frame number.
- Drag the current frame value slider to the left or right to advance or rewind.
  *Note:* To advance or rewind more rapidly, press Shift while dragging in the current frame value slider.
- With the Timeline active, type the timecode or frame number where you want to move the playhead. Press Return to jump to that frame.

To move forward a specific number of frames:
- Type a plus sign (+) and then the number of frames you want to move forward.
To move backward a specific number of frames:

- Type a minus sign (–) and then the number of frames you want to move backward.

**Track Area**

The main part of the Timeline, to the right of the Timeline layers list, is called the *track area*. Objects in your project are each represented by a colored bar. Different colors represent different types of objects. For example, behaviors and filters are purple and audio layers are green. For a complete table of colors, see “Getting Familiar with the Timeline” on page 322.

Group tracks differ from individual object tracks in two ways. First, when an object that resides in a group is selected, a thinner group bar appears above the layers within the group. Second, when the group itself is selected, the group track displays a special indicator that identifies how many objects reside within that group. Layers, cameras, and lights are counted in that total; effects such as masks, behaviors, and filters are not counted in that total.

You can collapse a group track so the tracks for the individual objects within the group are temporarily hidden.
To collapse or expand a group or layer:
- Click the disclosure triangle to the left of the group or layer name in the Timeline layers list.

![Disclosure triangle](image)

A variety of editing tasks can be done in the Timeline, including moving, trimming, and slipping. For more information on how to perform editing in the Timeline, see “Editing Objects in the Timeline” on page 341.

**Timeline Ruler**
At the top of the track area is the ruler that provides a gauge for the positions and durations of the objects in your project.

![Timeline Ruler](image)

The ruler can contain indicators to help mark important frames or sections of the project such as the playhead, play range indicators (also called In and Out points), and markers. The ruler can be viewed in frames or timecode.

**To change the ruler view format:**
- Control-click the ruler, then choose Display Frames or Display Timecode from the shortcut menu.

**Note:** You can also click the current frame icon directly to the left of the current frame field (to the left of the transport controls) or click the duration icon directly to the left of the project duration field (to the right of the transport controls) to toggle the project between frames and timecode.
The playhead tracks the frame currently visible in the Canvas. You can drag the playhead or reposition it using the transport controls described in “Playing Your Project” on page 58. The playhead in the Timeline and the playhead in the mini-Timeline are linked. Moving one automatically moves the other.

The play range indicators limit the area of the project to be played. For more on setting and using the play range, see “Defining the Play Range” on page 359.

Markers can be added to your project to identify an important frame or range of frames. For more on creating and using markers, see “Adding Markers” on page 362.

**Zooming in the Timeline**
As you get familiar with using the Timeline, you will find yourself wanting to focus on an individual edit point one second, and the next, you’ll want to see the overview of your whole project. Fortunately, you can quickly zoom in and out on the Timeline using a variety of different tools.

The bottom of the Timeline contains a zoom slider and a scroller.

![Zoom slider and scroller](image)

To zoom the Timeline using the zoom slider:
- Drag the zoom slider left to zoom in and right to zoom out.

The Timeline updates as you drag.

To zoom the Timeline using the scroller:
- Click the handle of the scroller and drag it away from the center to zoom out and toward the center to zoom in.

The Timeline updates as you drag.

You can also automatically zoom the Timeline to include the entire duration of your project or just the play range as defined by the play range indicators (In and Out points).

To zoom the Timeline to fit the entire project, do one of the following:
- Double-click the Zoom Time View button to the right of the ruler.
Choose View > Zoom Time View > To Project.

*Note:* An object must be selected in the Timeline layers list in order to access the Zoom Time View items in the View menu.

Control-click the ruler, then choose Zoom to Project from the shortcut menu.

To zoom the Timeline to fit the play range, do one of the following:

- Click the Zoom Time View button to the right of the ruler.
- Choose View > Zoom Time View > To Play Range.

*Note:* An object must be selected in the Timeline layers list in order to access the Zoom Time View options in the View menu.

Control-click the ruler, then choose Zoom to Play Range from the shortcut menu.

The Zoom Time View button toggles between the Zoom to Play Range and Zoom to Project settings. If no play range is established, choosing Zoom to Play Range performs a Zoom to Project.

### Changing the Track Display

The tracks in Motion can be displayed in a variety of ways to satisfy different working styles. You can set your tracks to be viewed as Name Only, Name Plus Thumbnail, and Filmstrip.

To change the Timeline track display:

1. Choose Motion > Preferences (or press Command-comma) to open Motion Preferences.
2. Click the Appearance icon to open the Appearance pane.
3 In the Timeline section, choose an item from the Timebar Display pop-up menu:

- **Name**: Displays only the name of the object on the track.
- **Name Plus Thumbnail**: Displays the name of the object and a single thumbnail on the track.
- **Filmstrip**: Displays frames of the object over the track.

Regardless of the Timebar Display setting, tracks for cameras, lights, behaviors, and filters are always labeled with names only.

**Note**: When the Timebar Display is set to Filmstrip, your processing time is increased.

**Keyframe Editor**

The Keyframe Editor is where you can view and modify the individual attributes of filters, behaviors, and other effects over time. Each parameter can be displayed as a curve showing how the parameter's value changes over time. You can manipulate the points within that curve (called *keyframes*) to create a variety of powerful effects. For more information on using the Keyframe Editor, see Chapter 6, “Keyframes and Curves,” on page 503.

To display the Keyframe Editor, do one of the following:

- Drag the divider on the bottom edge of the Canvas, then click the Keyframe Editor tab at the top of the pane.
- Click the Timing icon in the upper-right corner of the Canvas, then click the Keyframe Editor tab at the top of the pane.
- Choose Window > Keyframe Editor (or press Command-8).
- Press F6, then click the Keyframe Editor tab at the top of the pane.
- Choose Window > Layouts > Cinema (or press Control-Option-U), then click the Keyframe Editor tab at the top of the pane.
If the Timing pane is already visible, click the Keyframe Editor tab at the top of the pane.

**Keyframe Basics**

You animate an object by creating at least two keyframes for a parameter, such as Opacity, at different points in time in a project. A keyframe is a point in time that records any change in the value of a parameter. For example, to create an animation in which an object is completely transparent at frame 1 and becomes completely opaque at frame 120, you create two keyframes: an Opacity keyframe set to a value of 0% at frame 1, and an Opacity keyframe set to a value of 100% at frame 120. The image fades in from 0% to 100% over the 120 frames. The smooth, fade-in transition between the two keyframed values is called interpolation.

All keyframes for a specific parameter (such as Opacity or Rotation) are positioned on a line over time. Different values for the keyframes change the shape of that line and create what is called an animation curve. The type of curve from keyframe to keyframe (interpolation) can be changed to create different animation effects. For example, keyframes set to Bezier create smooth transitions in values. Keyframes set to Linear create straight lines between the keyframes, for sharper changes in value. You can modify keyframes and their animation curves in the Keyframe Editor, located in the Timing pane. For more information, see “Keyframes and Curves” on page 503.

**Keyframe Editor Parameter List**

The left side of the Keyframe Editor contains a list of parameters. You can choose which parameters are displayed in the list and set keyframing functions in the Animation menu. You can also create custom sets of parameters. This allows you to focus on certain parameters at a time. For more information on creating and viewing parameter sets, see “Custom Parameter Sets” on page 533.

**Show Pop-Up Menu**

Use the Show pop-up menu to select what is displayed in the Keyframe Editor. The Show options include:

- **All**: This option displays all parameters for the currently selected object, whether or not the parameters are animated.

- **Animated**: This option displays only the animated parameters and curves for the currently selected object. This includes animation curves created by keyframing as well as behaviors. This is the default setting. With the Keyframe Editor active, you can also press the U key to choose Animated from the Show pop-up menu.
When the selected object is not animated, nothing appears in the Keyframe Editor.

**Modified:** This option displays only the curves that have been modified for the currently selected object. This includes modifications that are not animated. For example, if you change the color of a shape (without animating the color change), the parameter appears in the Modified list because the color was changed from the default color. Animated parameters also appear in the list. With the Keyframe Editor active, you can also press the Y key to choose Modified from the Show pop-up menu.

**Active:** This option shows only the parameters currently being modified. When this option is selected, nothing appears in the Keyframe Editor unless you are actively modifying an object (in the Canvas, Inspector, or HUD). For example, when Active is selected and you are moving an object around in the Canvas, the X and Y Position parameters and curves are displayed.

**Position:** Displays only the Position parameters for the selected object. With the Keyframe Editor active, you can also press the P key to choose Position from the Show pop-up menu.

**Rotation:** Displays only the Rotation parameters for the selected object. With the Keyframe Editor active, you can also press R to choose Rotation from the Show pop-up menu.

**Scale:** Displays only the Scale parameters for the selected object. With the Keyframe Editor active, you can also press S to choose Scale from the Show pop-up menu.

**Shear:** Displays only the Shear parameters for the selected object. With the Keyframe Editor active, you can also press H to choose Shear from the Show pop-up menu.

**Anchor Point:** Displays only the Anchor Point parameters for the selected object. With the Keyframe Editor active, you can also press A to choose Anchor Point from the Show pop-up menu.
**Opacity:** Displays only the Opacity parameters for the selected object. With the Keyframe Editor active, you can also press O to choose Opacity from the Show pop-up menu.

**New Curve Set:** Allows you to create a custom curve set.

**Manage Curve Sets:** Allows you to manage (delete, duplicate, and so on) your custom curve sets.

**Note:** For more information on using curve sets, see “Custom Parameter Sets” on page 533.

**Parameters List Organization**
The parameters list is divided into four columns.

**On (not labeled):** This column contains activation checkboxes to toggle the display of parameters on and off in the keyframe graph. Activating the checkbox next to the object name turns all of the parameters for that object on or off for display purposes only (the animation of the object is not affected).

**Name (not labeled):** Lists the name of the selected object and its parameters.

**Value (not labeled):** Displays the value for the current playhead position for that parameter. You can drag in the value field to set new keyframe values, or double-click in the field and type a new value. For more information, see “Modifying Keyframes” on page 538.

**Animation menu (not labeled):** The last column contains a pop-up menu to control animation and keyframing attributes for that parameter. The menu contains the following items:

- **Enable/Disable Animation:** Remains unavailable until keyframing is applied to the channel, either by using the Record button or by directly adding a keyframe. Once the channel is animated, the menu item is automatically renamed to Disable Animation. Activating it at that point hides the keyframes you have set, restoring the parameter to its default value. However, the keyframes are not thrown away. Choosing Enable Animation restores the channel to its last keyframed state.

- **Reset Parameter:** Removes all keyframes and settings for this parameter. The parameter value is restored to its default value.

- **Add Keyframe:** Adds a keyframe at the current frame. If your playhead is positioned on a frame where a keyframe has already been added, this menu item is unavailable.

  **Note:** To add a keyframe, you can also Option-click the Animation menu. A keyframe is automatically added to the last modified parameter of the object (regardless of the status of the Record button) at the current playhead position.
• **Delete Keyframe**: Deletes the current keyframe. The Delete Keyframe command is only available if the playhead is positioned on a frame where a keyframe already exists.

  *Note*: You can also Control-click a keyframe and choose Delete from the shortcut menu, or select the keyframe and press Delete to delete a keyframe.

• **Previous Keyframe**: Moves the playhead to the previous keyframe for this parameter. The Previous Keyframe command is only available if a keyframe exists earlier in the project.

  *Note*: You can also press Option-K to advance to the next keyframe.

• **Next Keyframe**: Moves the playhead to the next keyframe for this parameter. The Next Keyframe command is only available if a keyframe exists later in the project.

  *Note*: You can also press Shift-K to advance to the next keyframe.

• **Interpolation**: Sets the type of curve for the parameter. See the table in “Modifying Curves” on page 545 for examples of the different interpolation methods.

• **Before First Keyframe**: Defines the animation before the first keyframe of a parameter. This is called *extrapolation*.

• **After Last Keyframe**: Defines the animation after the last keyframe of a parameter. This is called extrapolation.

  *Note*: For examples of the different extrapolation methods, see “Extrapolation” on page 550.

• **Lock/Unlock Parameter**: Locks the parameter to prevent changes. When a parameter is locked, neither keyframes nor curves are adjustable.

• **Reduce Keyframes**: Applies a “thinning” algorithm to the keyframes for the selected parameter. This reduces the number of keyframes in a parameter while attempting to maintain a similar curve shape. For more information on keyframe thinning, see “Keyframe Thinning” on page 559.

• **Set to Curve Snapshot**: If “Take/Show curve snapshot” is turned on, this option reverts any keyframe changes made in the currently selected curve back to the most recent snapshot. For more information, see “Curve Snapshots” on page 538.
**Animation Menu States**
Depending on the current condition of the parameter for the selected object, the Animation menu displays a different icon. The following table shows the Animation menu icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>No Keyframes</td>
<td>The parameter has no associated keyframes.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Keyframing Active</td>
<td>Keyframing is active on this parameter but the playhead is not currently positioned on a keyframe.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Current Keyframe</td>
<td>The playhead is currently positioned on a keyframe for this parameter.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Behavior Applied</td>
<td>This parameter is being controlled by a behavior, as opposed to a keyframe. When a behavior is applied to a layer or group, the name of the behavior also appears in the Animation menu.</td>
</tr>
</tbody>
</table>

**Current Frame Field**
The current frame field appears between the Show pop-up menu and the keyframe editing tools.

![Current frame field]

For more information, see “Timecode and Current Frame Fields” on page 64.

**Keyframe Editing Tools**
There are three different tools available to assist in editing keyframes and curves in the Keyframe Editor. For more information about using these tools, see “Modifying Keyframes” on page 538.

- **Edit**: Select and edit keyframes.
- **Sketch**: Draw curves with keyframes. You must have a parameter active (checkbox enabled) and selected in the list to be able to sketch a curve.
Box: Drag a selection box to enclose and manipulate keyframes.

Keyframe Editor Control Buttons
In the lower-left corner of the Keyframe Editor, five buttons provide additional control over the Keyframe Editor window: Snapping, “Show audio waveform,” “Fit curves,” “Clear curve list,” and “Take/Show curve snapshot.”

- **Snapping:** When snapping is turned on, keyframes snap to other keyframes, markers, grid points, and other snappable items.
- **Show audio waveform:** Turns on the display of audio waveforms for the selected object.

When “Show audio waveform” is turned on and the project contains at least one audio file, a pop-up menu at the bottom of the Keyframe Editor allows you to view the waveform of the master audio track, or any individual audio track in the project.

- **Fit visible curves in window:** Automatically scales the graph both vertically and horizontally (in time) to include all of the keyframes of your active parameters.
- **Clear curve list:** Empties the parameters list. This control is only active for custom curve sets.
Take/Show curve snapshots: When this setting is enabled, as you move keyframes in the Keyframe Editor, the original curve—as it appeared when you took the snapshot—appears as a lighter color. As long as you remain in the Keyframe Editor editing the current set of curves, the snapshot curve remains available.

Auto-scale vertically to fit curves: Turn on “Auto-scale vertically to fit curves” to continuously stretch the graph vertically to fit all of the curves in view.

To toggle automatic scaling on and off:
- Click the “Auto-scale vertically to fit curves” button just below the right edge of the ruler.

Keyframe Graph
The remainder of the Keyframe Editor tab contains the keyframe graph. This area displays all of the curves and keyframes for the selected parameters. Parameters are represented by different colors. Keyframes appear as diamonds and curves appear as solid lines. Areas before the first keyframe and after the last keyframe are represented by dotted lines. Selected parameters and keyframes appear white.

You can manipulate keyframes directly by dragging them in the graph. Moving keyframes left and right changes their position in time, while dragging them up and down changes their values. You can also double-click a keyframe, type a number into the pop-up value field, and then press Return to change its value.

Control-click a keyframe to access shortcut menu options as well as an Interpolation submenu, which allows you to change curve types. For more information on manipulating keyframes and curves in the graph, see “Modifying Keyframes” on page 538 and “Modifying Curves” on page 545.
Ruler
At the top of the keyframe graph is a ruler that provides a visual gauge for the positions and durations of the keyframes and curves. The ruler is identical to the Timeline ruler. For more information on working with the ruler, see “Timeline Ruler” on page 92.

Zooming in the Keyframe Editor
As you become familiar with the Keyframe Editor, you may want to switch between focusing on an individual keyframe or curve and seeing an overview of your whole project. Fortunately, you can quickly zoom in and out on the Keyframe Editor using a variety of different tools.

The bottom of the Keyframe Editor contains a zoom slider and a scroller.

To zoom the Keyframe Editor using the zoom slider:
- Drag the zoom slider left to zoom in or right to zoom out.
  The Keyframe Editor updates as you drag.

To zoom the Keyframe Editor using the scroller:
- Drag the handle of the scroller away from the center to zoom out and toward the center to zoom in.
  The Keyframe Editor updates as you drag.
Audio Editor
The Audio Editor provides a view of your audio elements over time. You can view and modify the level and pan information for the audio files in your project. You can also view the audio waveforms of your layers. In many ways, the Audio Editor is simply a specialized Keyframe Editor just for audio. For more on using the Audio Editor, see “Working with Audio” on page 1117.

To display the Audio Editor, do one of the following:
- Choose Window > Audio Editor (or Press Command-9).
- Drag the divider on the bottom edge of the Canvas, then click the Audio Editor tab at the top of the pane.
- If the Timing pane is already visible, click the Audio Editor tab at the top of the pane.
- Click the Timing icon in the upper-right corner of the Canvas, then click the Audio Editor tab at the top of the pane.
- Press F6, then click the Audio Editor tab at the top of the pane.
- Choose Window > Layouts > Cinema (or press Control-Option-U), then click the Audio Editor tab at the top of the pane.
Audio Editor Controls
The left side of the Audio Editor contains four rows of controls for the audio track currently in view. The top row controls playback; the second row controls the In and Out points of the audio track; the third row controls the selected track’s level; and the fourth row controls the selected track’s pan settings.

Audio Playback Controls
The playback controls in the Audio Editor do not control playback in the Canvas. Rather, they allow you to listen to the audio component of your project without being distracted by (or slowed down by) the visual component.

There are four playback controls:

- **Jump to start**: Moves the playhead to the beginning of the audio clip or to the beginning of the marked region (if the “Use marked region” button is turned on).
- **Play/Pause**: Starts and stops playback in the Audio Editor.
- **Use marked region**: Restricts playback to the play range (the In and Out points) for the selected audio track. For more information, see “Audio Play Range Controls” on page 106.
- **Current frame field**: Indicates the current playhead position in the Audio Editor. You can also use this field to change the current frame.
To change the playhead position, do one of the following:
- Drag the center of the current frame field. Dragging to the right advances and dragging to the left rewinds.
- Click the arrows on either side of the current frame field to move forward or backward by one frame.
- Click the current frame field, then type a new number into the value field.

Audio Play Range Controls
The second row provides two controls to set the In and Out points for the audio file. Changing a file's In or Out point in the Audio Editor is reflected in the Timeline as well. The area of the track between the In and Out points is the region used when “Use marked region” is turned on in the playback controls.

Note: The In and Out points of the master track cannot be modified.

To change the audio track’s start time using the In value slider, do one of the following:
- Drag the center of the In value slider. Dragging to the right advances the audio, and dragging to the left rewinds.
- Click the arrows on either side of the In value slider to move forward or backward by one frame.
- Click in the field and type a new number.

To change the layer end time, do one of the following:
- Drag the center of the Out value slider. Dragging to the right advances the audio, and dragging to the left rewinds.
- Click the right or left arrow at the side of the Out value slider to move forward or backward by one frame.
- Click in the field and type a new number.

Alternatively, you can change the start and end time using the audio track bar to set new start and end times.

To change the start and end time using the audio track bar:
- Select the track in the Audio tab, then drag either end of the audio track green bar (located above the waveform in the Audio Editor).

Note: You cannot create marked regions for the master audio track.

Level Control
The third row contains controls to adjust and keyframe the level of the selected audio track.
Activation checkbox: This checkbox at the left of the row turns the display of the level animation curve on and off. It does not disable existing level settings or prevent you from making new settings.

Level: A slider and value slider that control the level (volume) of the track. If the playhead is currently positioned on a keyframe, the slider controls the level of that keyframe. If the playhead is not on a keyframe, the slider adjusts the entire curve.

Pan Control
The fourth row contains controls to adjust and keyframe the pan (left-right balance) of the selected audio track.

Activation checkbox: This checkbox at the left of the row turns the display of the pan animation curve on and off. It does not disable existing pan settings or prevent you from making new settings.

Pan: A slider and value slider that control the left-right balance of the track. If the playhead is currently positioned on a keyframe, the slider controls the pan setting of that keyframe. If the playhead is not on a keyframe, the slider adjusts the entire pan curve. Negative numbers move panning to the left, while positive numbers move panning to the right. When the value is zero, the balance is split evenly between left and right. You can use the value slider for more precise control.

Animation menu: Appears to the right of the Level and Pan value sliders and is similar to the Animation menu found in the Keyframe Editor. The menu is represented by different icons depending on the current state of the parameter. For a table describing the different icons, see “Animation Menu States” on page 100. The commands within the Animation menu are listed below:

• Enable/Disable Animation: Turns keyframing on and off for this parameter. Once keyframes are added, choosing Disable Animation does not delete the keyframes, it just globally hides their effect.
• Reset Parameter: Removes any keyframes and restores the parameter to its default value.
• Add Keyframe: Adds a new keyframe at the current playhead position.

  Note: To add a keyframe, you can also Option-click the Animation menu.
• Delete Keyframe: Deletes a keyframe at the current playhead position.
• Previous Keyframe: Moves the playhead to the first keyframe to the left of the current playhead position.
• Next Keyframe: Moves the playhead to the first keyframe to the right of the current playhead position.
• Show in Keyframe Editor: Displays the audio parameters in the Keyframe Editor and brings that tab to the front.
Level Meters
Audio level meters appear at the right side of the Audio Editor controls. There are two vertical bars that show the level at the current playhead position. The left bar shows the levels for the left audio channel and the right bar shows the levels for the right audio channel. As you play, the meters change to indicate the changing audio level.

Peak indicators appear at the top of the meters. These small lights illuminate red when the volume exceeds acceptable levels (called peaking). They remain red for a short time after the peak occurs.

Audio Editor Keyframe Graph
The remainder of the window contains the keyframe graph. This area contains the curves and keyframes for the level and pan of the selected track. Keyframes appear as diamonds, and curves appear as solid lines. Areas before the first keyframe and after the last keyframe are represented with dotted lines. The waveform of the selected track is displayed behind the curves.
At the top of the graph a green bar shows the duration of the audio file. As you change the file’s In and Out points, the bar shrinks or expands to show the new duration.

As in the Keyframe Editor, you can manipulate keyframes here also by dragging them in the graph. Moving a keyframe left or right changes its position in time, while dragging it up or down changes its value. Because audio keyframes work exactly the same as keyframes for other parameters, you can learn more about working with audio keyframes in "Modifying Keyframes" on page 538 and "Modifying Curves" on page 545.

Ruler
At the top of the Audio Editor Keyframe graph is a ruler that provides a visual gauge for the positions and durations of the level and pan keyframes and curves. The ruler in the Audio Editor shows different time than the rulers in the Timeline and Keyframe Editor. This ruler shows the time for the selected audio file rather than for the whole project.

The ruler can contain indicators to help mark important frames or sections of the project such as the playhead, play range indicators (also called In and Out points), and markers. The ruler can be viewed in either frames or timecode.

To change the ruler view format:
- Control-click the ruler, then choose Display Frames or Display Timecode from the shortcut menu.

Markers can be added to your project to identify an important frame or range of frames. For more information on creating and using markers, see “Adding Markers” on page 362.

Note: The playhead in the Audio Editor is not the same as the playhead in the Timeline and the Canvas. The Audio Editor playhead shows the current time within the selected audio track rather than the current time within the entire project.

Zooming in the Audio Editor
You can zoom in or out in the Audio Editor just as you can in the Timeline or Keyframe Editor.

The bottom of the Audio Editor contains a zoom slider and a scroller.

To zoom the Audio Editor using the zoom slider:
- Drag the zoom slider left to zoom in and right to zoom out.
  The Audio Editor updates as you drag.

To zoom the Audio Editor using the scroller:
- Click the handle of the scroller and drag it away from the center to zoom out and toward the center to zoom in.
  The Audio Editor updates as you drag.
Audio Scrubbing
You can choose whether or not you want to hear the audio play when you drag the playhead through the ruler in the Audio Editor. This is called audio scrubbing. To turn audio scrubbing on or off, click the button in the lower-left corner of the Audio Editor.

Utility Window
The utility window is where you locate, organize, and modify the media, effects, and parameters that go along with your project. This includes sorting through the media on your disk, browsing all of the effects, presets, and other content, and viewing and manipulating all of the parameters that control how your objects and effects behave.

The utility window has three tabs: The File Browser, the Library, and the Inspector. In the default window layout, all three of these tabs reside in a utility window on the left side of the Canvas. If you choose the Cinema layout, two utility windows are displayed, one on the left of the Canvas, containing the File Browser and Library, and one on the right side of the Canvas, containing the Inspector.

File Browser
The File Browser displays all of the files on your computer. Navigating the File Browser is similar to navigating a window in the Finder. You can drag items directly from the File Browser into your project.

Preview Area
The top area of the File Browser contains a preview of the selected layer. The Preview area contains both a visual preview, complete with a Play button to show the multiple frames of moving footage, and text information about the file: filename, media type, file size, and frame rate. The Preview area also contains an audio mute button. This button lets you turn off audio associated with a file selected in the browser.

Note: When displayed in the Preview area, audio files contain a text description but no image preview.
To play a preview of a file on disk:

- Select the file in the File Browser.

The preview starts playing.

**Note:** If you do not want items to play automatically in the Preview area when you click them (in the File Browser or Library), you can turn off the “Play items automatically on a single click” checkbox in the General pane of Motion Preferences.

To import a file displayed in the preview area:

1. Select the file in the File Browser.
2. Click the Import button in the Preview area.

The file is added to the project (to the Canvas, Layers tab, Timeline layers list, and Media tab).

**Note:** For a larger preview, you can double-click any file listed in the File Browser. This opens the viewer window where you can preview the file at its native size. You can also Control-click a file and choose Open in QuickTime Player from the shortcut menu.

**Sidebar**

The middle section of the File Browser contains navigational controls as well as a list of servers, drives, and folders available on your computer.

- Forward and Back buttons: Step backward and forward through the folders most recently viewed. This works similarly to the Forward and Back buttons in the Finder.

Clicking a drive or folder in the sidebar displays its contents in the file stack below. Above the list of drive and folder icons in the sidebar are several controls to navigate and sort the contents of the window.
Path pop-up menu: Displays the file system hierarchy (folders inside of folders) for the currently viewed folder.

Icon View and List View buttons: Controls the view of the file stack. Click the left button to set the display to icon view. Click the right button to set the view to list view.

Search field: Filters the contents of the file stack to include only files whose names contain the text you type into the Search field.

Note: Folders are not filtered out.

To clear the Search field:
- Click the Clear button at the right side of the Search field.

File Browser Stack
The bottom section of the File Browser shows the contents of the folder selected in the sidebar or the contents of a subfolder.

You can Control-click a file in the File Browser stack to display a shortcut menu. For most items, the following options are available in the menu:

Open in Viewer: This option opens the file in a viewer window.

Open in QuickTime Player: This option opens the file in a QuickTime window.

Reveal in Finder: This option displays the location of the file in the Finder.

Rename: This option turns the name of the file into an active text field so you can rename the file.

Move to Trash: This option moves the file into the Trash.

To view the contents of a folder displayed in the file stack, do one of the following:
- Double-click the folder.
- Select the folder, then press Return.
  The contents of the folder replace the current file stack view.

To return to a previously viewed folder, do one of the following:
- Click the Back button directly beneath the Preview area (to the left of the Path pop-up menu).
- Choose a new folder from the Path pop-up menu directly beneath the Preview area.
- Press Command-Up Arrow.
To rename a folder or file, do one of the following:

- Control-click the file or folder, then choose Rename from the shortcut menu. When the text field becomes active, type the new name, then press Return.
- In the stack, click the name of the folder or file once to select it, then click it again to activate the text field. Type the new name, then press Return.

**Warning:** Renaming folders or files from within the File Browser renames the item on your hard disk or network. If projects are using files from the originally named folder, Motion may list the footage as missing.

To delete a folder or file, do one of the following:

- In the stack, Control-click the file, then choose Move to Trash from the shortcut menu.
- Drag the file from the stack to the Trash icon in the Dock.

**Warning:** Deleting folders or files from within the Motion File Browser removes the files from your hard drive or network and places the files in your Trash.

**Organizing Your Files**

You can organize the files and folders displayed in the File Browser just as you manipulate files in the Finder. You can move files in and out of folders and create new folders. All of the changes you make to your file structure from within Motion are reflected in the Finder.

**To create a new folder:**

- Click the New Folder button at the bottom of the window.

**To move a file into a folder:**

- Drag the file to the folder icon.

The file is moved inside that folder.
Icon View and List View
The file stack can be displayed in icon view or list view. Each view is useful for different situations. There are certain options that only affect the icon view (such as icon size) and certain options that only affect list view (such as sorting by columns).

To view the File Browser in icon view:
- Click the Icon View button to the right of the Path pop-up menu above the sidebar.

To view the File Browser in list view:
- Click the List View button to the right of the Path pop-up menu above the sidebar.

In icon view, you can control the size of the icons using the size slider at the bottom of the window.

To change the icon size:
- Drag the icon size slider to the right to make the icons larger and drag to the left to make them smaller.

In list view, the contents of the selected folder are displayed as a series of columns. The columns are Name, Date, Size, Duration, and Kind.

You may need to expand the width of the utility window, or use the scroller at the bottom on the window, to see all of the columns.

Sorting Columns
You can sort the list by any of the columns. This can be helpful if you are looking for a particular file and you know the approximate size or modification date.
To sort the File Browser list:

- Click the header for the column you want to sort.

The column header darkens and the contents of the window are sorted by that column.

**Collapsing Animations**

Frequently, animated sequences may be delivered as a series of sequentially numbered still images. Motion can save you time by allowing you to import these sequences as a single object where each image becomes a sequential frame in a movie.

To import a series of numbered still images as a single object:

1. Click the “Show image sequences as collapsed” button.

   The File Browser displays multiple items collapsed into a single object.

2. Drag the object from the File Browser to the Canvas, Layers tab, Timeline, or Media tab.

   *Note:* Images from digital cameras are often numbered sequentially but are not part of an animation sequence. You may want to turn off this option to import a single still image from a digital camera.

**Library**

The second tab in the utility window is called the Library. This is similar to the File Browser but rather than showing the files on your disk, it shows all of the effects, content, presets, fonts, music, photos, and so on available from within Motion.
Library content can be expanded by adding certain plug-ins, fonts, music, or photos, as well as by saving content that you create within Motion and modified versions of existing effects (such as customized behaviors or camera animations).

The Library is divided into three sections. The top section is the Preview area, the middle section is the sidebar, and the bottom section is the file stack where the actual effects and other objects are displayed.

**Library Preview**
The Preview area contains a visual preview and a Play button to show the multiple frames of moving footage, previews of filters, behaviors, generators, particle emitters, replicators, and so on. The Preview area also contains text information for the selected object, such as a description of the behavior, filter, or generator. The Library preview is almost identical to the File Browser preview, but instead of an Import button, it has an Apply button.

*Note:* When certain particle emitters are selected in the stack, an animated preview of the selected particle emitter plays in the Preview area. While it is playing, you can drag the pointer around in the Preview area to see how the particle looks when moving.

**To play a preview of an element such as a replicator:**
- In the Library, click the Replicators category, click a replicator subcategory, then click the replicator you want to preview from the stack.

The preview starts playing.

**Adding Library Elements to a Project**
Elements can be added to a project from the Library in two ways. You can drag an object directly into your project or select an element in the Library stack and then click the Apply button in the Preview area.
Note: To add behaviors and filters, a third option is available. You can select an object or objects in the project and use the Add Behavior or Add Filter button in the Toolbar. You can also create custom particles and replicators (using an existing layer in your project) using the Make Particles and Replicator buttons in the Toolbar. For more information on making custom particles, see “Creating a Simple Custom Particle System” on page 692. For more information on making custom replicators, see “Creating a Simple Custom Replicator Pattern” on page 762.

To apply an element to a group, layer, or object:
1. Select the object (in the Canvas, Layers tab, or Timeline layers list) to which you want to apply the effect.
2. Select the effect in the Library.
   For example, click the Filters category, click a filter subcategory, then click the filter you want to apply from the stack.
3. Click the Apply button in the Preview area.
   The effect is added to the object.
   You can also drag the effect from the Library directly to the object in the Layers tab, Canvas, or Timeline.

To add an element to a project:
1. Select the group (in the Layers tab or Timeline layers list) to which you want to add the effect.
2. Select the effect in the Library.
   For example, click the Particle Emitters category, click a subcategory, then click the emitter you want to apply from the stack.
3. Click the Apply button in the Preview area.
   The effect is added to the object.
   You can also drag the effect from the Library directly to the Layers tab, Canvas, or Timeline. For more information about placing and reordering objects in a project, see “Organizing Groups and Layers in Motion” on page 233.
Sidebar
The middle section of the Library contains navigational controls as well as a list of folders of effect types available in Motion.

Clicking a folder in the sidebar displays its contents in the file stack below. Above the Library categories in the sidebar are several controls to navigate and sort the contents of the window.

Forward and Back buttons: Step backward and forward through the folders most recently viewed. These work similarly to the Forward and Back buttons in a web browser.

Path pop-up menu: Displays the file system hierarchy (folders inside of folders) for the currently viewed folder.

Icon View/List View buttons: Controls the view of the file stack. Click the left button to set the display to icon view. Click the right button to set the view to list view.

Theme pop-up menu: Allows you to sort and organize Library content by theme. You can choose an existing theme or create a custom theme and add content to the custom theme. Items that can be added to a theme include the following:

• Replicators
• Emitters
• Shapes
• Gradients
• Text styles
• Shape styles
• Layers or groups
**Note:** Behaviors, filters, fonts, LiveFonts, images, image sequences, and movies cannot be added to a theme. However, layers and groups that contain these types of items may be added to a theme.

**To create a new custom theme:**
1. Choose New Theme from the Theme pop-up menu.
2. In the Create New Theme dialog, type a theme name, then click OK.
   
   A new theme is added. New themes appear in the Theme pop-up menu.

   Custom themes are saved in your /Users/username/Library/Application Support/Final Cut Studio/Motion/Library folder in the “themes” file.

**To add content to a theme:**
- Control-click an item in the Library, choose Theme from the shortcut menu, then choose the theme in which you want to save the content.

**Note:** An item must be saved in the Library in order to add it to a theme. For more information on saving items to the Library, see “Saving and Sharing Custom Library Elements” on page 123.

**To sort using the Theme pop-up menu, do one of the following:**
- Select a category in the Library, then choose a theme from the Theme pop-up menu.
- To sort using the default themes, select the Content category, then choose the Folio, Traditions, or Learning theme from the Theme pop-up menu.

   Default themes are stored in your /Library/Application Support/Final Cut Studio/Motion/Library folder in the “themes” file.

**To remove a theme:**
1. Choose the theme you want to remove from the Theme pop-up menu.
   
   The Remove Theme item becomes available in the Theme pop-up menu.
2. Choose Remove Theme from the Theme pop-up menu.
   
   The theme is removed from the list.

**Note:** You can only remove custom themes.

**Search field:** Filters the contents of the file stack to include only those objects whose names contain the text you type into the Search field.

**Note:** Folders containing no matches are filtered out.

**To clear the Search field:**
- Click the Clear button at the right of the Search field.
Library Content
The Library contains all of the effects, presets, fonts, and other content available within Motion. These are grouped into categories that are listed on the left of the sidebar. Choose any of these items to display a list of subcategories on the right. The Library also contains two additional categories—Music and Photos—which provide quick access to your iTunes and iPhoto libraries.

For information on adding Library content to your project, see “Adding Library Elements to a Project” on page 116.

The Library contains the following categories:

 behaviours: Contains the Audio, Basic Motion, Camera, Motion Tracking, Parameter, Particles, Replicator, Retiming, Shape, Simulations, Text Animation, and Text Sequence behaviors. Different kinds of behaviors can only be applied to specific types of objects. For example, Text Animation and Text Sequence behaviors can only be applied to text. For more information on how to apply behaviors, see “Applying and Removing Behaviors” on page 374.

 Filters: Contains all of the built-in filter effects divided into individual subcategories. Most filters can be applied to any layer (text, images, shapes, footage, particles, and so on) or mask in your project.

 3rd Party Filters: Contains all of the filters that work within Motion but are manufactured by third-party vendors.

 Image Units (Filters): Contains all of the processing plug-ins based on core image processing that are installed on your computer.

 Generators: Contains a selection of checkerboards, noise patterns, color rays, and other computer-generated elements for use in your projects.

 Image Units (Generators): Contains all of the generators based on core image processing that are installed on your computer.

 Particle Emitters: Contains a selection of preset particle systems organized into subcategories.

 Replicators: Contains a selection of preset replicators organized into subcategories.

 Shapes: Contains a collection of preset shapes. Shapes are added to a project like other objects.

 Gradients: Contains a selection of preset gradients that can be applied to shapes or text. You can drag the gradient directly to a shape or text, or select the shape or text in the project first, select the gradient in the Library, then click Apply.
Fonts: Contains all of the fonts available on your system. It includes both TrueType and Type 1 fonts. You can drag the font directly to text in the project, or select the text in the project first, select the font in the Library, then click Apply. For more information on changing fonts in this browser, see “Changing Fonts” on page 578.

LiveFonts: Contains all of the LiveFonts currently installed on your computer. LiveFonts can only be applied to text. For more information, see “Using LiveFonts” on page 681.

Text Styles: Contains a collection of preset type styles that can be applied to text. You can drag the text style directly to text in the project, or select the text in the project first, select the text style in the Library, then click Apply. Text styles also appear in the Text Inspector. For more information, see “Using and Creating Text Styles” on page 622.

Shape Styles: Contains a collection of preset shape styles that can be applied to shapes. You can drag the shape style directly to shape in the project, or select the shape in the project first, select the shape style in the Library, then click Apply. Shape styles also appear in the Paint Stroke Tool HUD and the Shape Inspector. For more information, see “Using Shapes and Masks” on page 997.

Music: This Library category allows you to browse for and import audio files directly from your iTunes library. The Music subcategories include the library and any playlists created in iTunes. The contents of each playlist appear in the file stack. When displayed in list view, the Music category shows the Name, Artist, Album, Duration, and Size information created in iTunes.

Note: Rights-protected AAC files cannot be imported into Motion and do not appear in the file stack. This includes all music purchased from the iTunes Store. Any video content from iTunes cannot be imported to a Motion project.

Photos: This Library category allows you to browse for and import image files directly from your iPhoto library. The Photos subcategories include the library and any albums created in iPhoto. The contents of each album appear in the file stack.

Note: When importing a large-scale image into Motion, you have the option to import the file as is, to scale the image to the size of the Canvas, or to change the resolution of the image to fit the Canvas. For more information, see “Using High-Resolution Still Images” on page 205.

Content: Contains individual elements used in the templates and other presets. These can be used to create your own custom elements, such as particles and replicators, which can be saved to the Library for later use.

Favorites: As you make custom versions of any type of effect, including particle systems, customized filters, animation curves, cameras, groups, or layers, you can store them in the Favorites folder. You can also add shortcuts to frequently used items. By default, this folder is empty.
Note: The Preview area does not display descriptions of built-in presets copied to the Favorites category. Control-click the favorite, then choose Edit Description from the shortcut menu to add a description that appears in the Preview area of the Library.

Favorites Menu: This is another category of favorites. Items stored in this folder appear in the Favorites menu in the menu bar.

File Stack
The bottom section of the Library shows the contents of the folder selected in the sidebar or the contents of a subfolder.

To view the contents of a folder displayed in the file stack, do one of the following:
- Double-click the folder.
- Select the folder, then press Return.
The contents of the folder replace the current file stack view.

To return to a previously viewed folder, do one of the following:
- Click the Back button directly beneath the Preview area.
- Choose a new folder from the Path pop-up menu directly beneath the Preview area.
- Press Command–Up Arrow.

Organizing Your Effects
You can organize the effects, objects, and folders displayed in the Library just as you manipulate files in the Finder. You can move effects and objects in and out of folders, create new folders, and even delete some files or folders.

Note: You cannot modify the objects and folders that are built into Motion.

To create a new folder:
- Click the New Folder button at the bottom of the window.

A new folder is added to the current Library subcategory.

For more information on organizing custom folders and content, see “Adding Your Own Content to the Library” on page 232.
**Icon View and List View**
The file stack can be displayed in icon view or list view.

**To view the Library in icon view:**
- Click the Icon View button to the right of the Path pop-up menu above the sidebar.

**To view the Library in list view:**
- Click the List View button to the right of the Path pop-up menu above the sidebar.

In icon view, you can control the size of the icons using the size slider at the bottom of the window.

**To change the icon size:**
- Drag the icon size slider to the right to make the icons larger and to the left to make them smaller.

**Saving and Sharing Custom Library Elements**
You can save nearly any object in Motion to the Library. These include animated cameras and lights, customized behaviors, filters, particle systems, or replicators, shapes and text, as well as layers and groups. To save an object for future use, you can drag it to an existing or new folder in the Library. Once an object is placed in the Library, it can be added to a project like any other object in the Library.

You can save multiple objects to the Library as one file or multiple files. For example, if you create an effect using multiple filters and you want to save the cumulative effect of those filters to apply to other objects, you can save all of the filters as one item in the Library.
Although you can save custom objects into their namesake folders, it is generally recommended that you save customized objects that you use frequently in the Favorites category. This is because some Motion Library categories contain so many items that utilizing the Favorites or Favorites Menu categories may save you search time. Within the Favorites category, you can create additional folders to assist you in better arranging your custom items.

Note: You can create new folders in the built-in categories, such as the Color Correction filters subcategory; however, those folders only appear in the Library stack and not the sidebar. Folders added to the Favorites category appear in the Library sidebar.

To save an object to the Library:

1. Open the Library and select the Favorites, Favorites Menu, or other category.
2. Drag the customized object you want to save from the Layers tab, Timeline, or Inspector into the stack at the bottom of the Library.

Objects that are saved to the Favorites Menu category can be quickly applied to objects using the Favorites menu.

When you save a customized object, it’s saved in the /Users/User name/Library/Application Support/Final Cut Studio/Motion/Library folder.

Note: Items dragged to the wrong category are automatically placed into their namesake categories. For example, if a custom behavior is dragged to the Filters category, it is automatically placed in the Behaviors category and the Behaviors category becomes active.

To save multiple objects to the Library:

1. Open the Library and select the Favorites, Favorites Menu, or another category.
2. In the Layers tab, select all of the objects you want to save, drag them to the stack, and hold down the mouse button.
3. When the drop menu appears, choose “All in one file” or “Multiple files.”
   “All in one file” saves all the objects together and they are listed as one item in the Library. “Multiple files” saves the objects as individual objects in the Library.
4. To name the file or files, do one of the following:
   - Control-click the icon in the Library stack, choose Rename from the shortcut menu, then type a descriptive name.
   - Select the icon, click “Untitled,” then type a descriptive name.

When you Control-click the icon, the Edit Description option becomes available. This is a handy tool that allows you to enter custom notes about an item saved in the Library. Once you choose Edit Description, enter your notes in the text field and click OK.
**Inspector**

Every effect in Motion, from behaviors to particle systems to gradients, is controlled by a collection of parameters that modify the various attributes for that effect. For example, a Blur filter has an amount slider that controls how much blur is applied.

Some parameters are controlled with sliders, some with dials or pop-up menus. In fact, there are thousands of parameters using many types of controls. All of them are accessed in the Inspector.

**Important:** The Inspector is *contextual*—what appears in the Inspector is based on the selected object. An object must be selected for parameters to appear in the Inspector.

Even objects without applied effects have many parameters that you can modify to alter the nature of the object and how it behaves in your project. These include an object’s scale, opacity, and position onscreen, as well as more obscure attributes such as a clip’s pixel aspect ratio or field order.

The Inspector contains four tabs, each of which contains a set of parameters for the selected object. The first three tabs, Properties, Behaviors, and Filters, are present for any selected object. The fourth tab, generically called the Object tab, changes its name and contents depending on the type of object selected.

**Types of Controls**

There are many different types of controls that may appear in the Inspector. Each one provides you the opportunity to change the value of a parameter in a special way.
Because different types of objects and effects require different parameters, varied sets of controls appear in the Inspector depending on what is selected. The following table describes the various types of controls and their usage.

<table>
<thead>
<tr>
<th>Control</th>
<th>Control type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Slider" /></td>
<td>Slider</td>
<td>Dragging the slider changes the value of the parameter. Typically, dragging to the right increases the value and dragging to the left decreases the value. An example of a parameter that uses a slider is <em>Scale</em>. You can Option-click to the left or right of the slider marker to decrease or increase by a value of 1. Many sliders contain a disclosure triangle that you can click to display individual subparameters.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Value slider" /></td>
<td>Value slider</td>
<td>A special type of slider that includes the numerical value of the parameter in the control. Dragging the middle area (where the number is) works just like an ordinary slider; dragging to the right increases the value and dragging to the left decreases the value. Some parameters allow you to increase or decrease the value indefinitely. Additionally, you can click the right or left arrow to change the value one step at a time. Option-clicking the arrows increases or decreases by .01. You can double-click the number itself to convert the slider into a value field so you can type a specific number directly into the control. An example of a parameter that uses a value slider is <em>Position</em>. Many sliders contain a disclosure triangle that you can click to display individual subparameters. <strong>Note:</strong> When a value slider or value field is active (highlighted), press Tab to move to the next field.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Dial" /></td>
<td>Dial</td>
<td>This control is used for values based on angles or degrees. Rotate the dial by dragging it in a clockwise or counter-clockwise motion. A parameter that uses a dial is <em>Rotation</em>.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Value field" /></td>
<td>Value field</td>
<td>This control allows direct entry of text to set the value of the parameter. An example of a parameter that uses a value field is the <em>Text Entry</em> field.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Pop-up menu" /></td>
<td>Pop-up menu</td>
<td>A menu with preset values. Click the menu and choose the value you want. An example of a pop-up menu is the Throw behavior’s <em>Increment</em> parameter.</td>
</tr>
</tbody>
</table>
### Control Types and Descriptions

<table>
<thead>
<tr>
<th>Control</th>
<th>Control type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Value list" /></td>
<td>Value list</td>
<td>Another type of pop-up menu. You can click the arrow to the right of the field to display preset values or you can type a value directly into the value field. An example of a value list is <em>Typeface</em>.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Activation checkbox" /></td>
<td>Activation checkbox</td>
<td>An on/off toggle for a parameter. An example of an activation checkbox is <em>Preserve Opacity</em>.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Color well" /></td>
<td>Color well</td>
<td>The box you click to open the Colors window. You can also Control-click to pick a color from the pop-up color palette (pictured), or click the disclosure triangle to manipulate the individual R, G, B, and A sliders. An example of a color well is a shape’s <em>Fill Color</em> parameter.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Gradient editor" /></td>
<td>Gradient editor</td>
<td>Allows you to select a preset gradient style or create a new gradient. When collapsed, you can choose only from the preset pop-up menu to choose an existing preset. Alternatively, click the disclosure triangle to reveal additional controls to set the gradient’s opacity as well as its color values. An example of a gradient control appears in the Text Style pane when the Face “Fill with” parameter is set to Gradient.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image well" /></td>
<td>Image well</td>
<td>Allows you to drag an object (usually a clip, still image, or shape) to provide input data for a type of effect. For example, a bump map filter needs an image to provide the bumps, or a Repel From behavior needs to know what object from which to move away. An example of an Image well is the Attracted To behavior’s <em>Object</em> parameter.</td>
</tr>
</tbody>
</table>
In addition to the common parameter control types listed above, there are several other controls that are widely used within the Inspector tab.

**Reset button:** Automatically restores the parameter value (or in some cases, an entire set of parameters) back to its default value.

**Preset pop-up menu:** The Library contains style presets that can be applied to text and shapes. The Style Preset pop-up menu allows you to apply a preset style to the selected text. The Shape Style pop-up menu lets you apply a style to the selected shape (including paint strokes). Through this menu, you can also save custom text and shape presets to the Library.

For example, the Style Preset pop-up menu in the Text Style pane allows you to save text style, format, or all (the parameters set in the Format pane and the parameters set in the Style pane).

For more information on using text styles, see “Saving a Custom Text Style” on page 625.
To save a preset:
1. Set the parameter values to the settings that you want to save.
2. Choose Save from the Style Preset pop-up menu. A dialog appears.
3. Type a name for the preset you want to save, then click Save.

The preset is now stored in the Library in the appropriate category. It appears when you click the Style Preset pop-up menu in this and future projects until you manually delete it in the Finder.

To apply an existing preset:
- Choose the preset you want from the Style Preset pop-up menu.

The current parameter settings are replaced by the settings in the preset.

**Animation menu:** Most parameters can be animated. This means that you can assign specific values to certain frames (keyframes) so the parameter value changes over time. Any parameter that can be animated has an Animation menu to the right of the parameter settings.

```
Parameter | Value
---|---
Position | < -91 > < 22.59 >
```

Depending on the current condition of the parameter, the Animation menu displays a different icon. For a table indicating the possible states, see "Animation Menu States" on page 100.

Click the Animation menu to display a pop-up menu filled with animation options.
Enable/Disable Animation: Remains unavailable until keyframing is applied to the parameter, either by using the Record button or by adding a keyframe. Once the parameter is animated, the menu item is automatically renamed Disable Animation. Activating it at that point effectively hides the keyframes you have set, restoring the parameter to its default value. However, the keyframes are not thrown away. Choosing Enable Animation restores the channel to its last keyframed state.

Reset Parameter: Removes all keyframes and settings for this parameter. The parameter value is reset to its default value.

Add Keyframe: Adds a keyframe at the current frame. If the playhead is positioned on a frame where a keyframe has already been added, this menu item is unavailable. You can also Option-click the animation menu to add a keyframe.

Note: You can use a keyboard shortcut to quickly add a keyframe by pressing Control-K. A keyframe is automatically added to the last modified parameter of the layer.

Delete Keyframe: Deletes the current keyframe. The Delete Keyframe command is only available if the playhead is positioned on a frame where a keyframe already exists.

Previous Keyframe: Moves the playhead to the previous keyframe for this parameter. The Previous Keyframe command is only available if a keyframe exists earlier in the project.

Next Keyframe: Moves the playhead to the next keyframe for this parameter. The Next Keyframe command is only available if a keyframe exists later in the project.

Show in Keyframe Editor: Opens the Keyframe Editor if it is not displayed and displays the graph for the parameter you are modifying.

Rasterization Indicator
In the Properties tab of the Inspector, a small “LED” icon appears when a group is rasterized. This is called the rasterization indicator. This is not a control, but rather an indicator to alert you that a group has been rasterized.

Some operations, as well the application of certain filters or a mask, cause a group to be rasterized. When a group is rasterized, it is converted into a bitmap image. Rasterization affects 2D and 3D groups in different ways. When a 2D group is rasterized, the blend modes on objects within the group no longer interact with objects outside of the group. In addition, when a 3D group is rasterized, the group as a whole can no longer intersect with objects outside of the group. The rasterized 3D group is treated as a single object and uses layer order, rather than depth order when being composited in the project.
Once an operation triggers a rasterization on a group, the rasterization indicator appears next to the parameter in the Properties tab.

Additionally, a small frame appears around the 2D or 3D group icon (to the left of the group name) in the Layers tab and Timeline layers list.

For more information on rasterization, see “3D Compositing” in the Motion Supplemental Documentation PDF.

**Inspector Tabs**
The parameters in the Inspector are grouped into four categories.

**Properties:** This tab contains basic attributes for the selected object, such as Transform (position, scale, rotation, and so on), Blending (opacity, blend mode, and so on), Drop Shadow controls, Four Corner controls, Crop controls, and the object’s In and Out points.

**Note:** Different parameters are available in the Properties tab depending on the type of object that is selected. For example, when a 3D group is selected, the Lighting parameter appears in the tab and the Crop, Drop Shadow, and Four Corner parameters do not.

**Behaviors:** When behaviors are applied to an object, the parameters associated with the behaviors appear in the Behaviors tab when that object is selected. Multiple behaviors are grouped by the behavior name.

**Filters:** Whenever a filter is applied to a layer (or mask), the parameters associated with that filter appear in the Filters tab. Multiple filters are grouped by the filter name.

**Object:** The Object tab changes its contents and title depending on what type of object is selected. The different types of objects are described below:

- **Object:** Appears when there is no currently selected object. There are no parameters in the Object tab of the Inspector.
- **Image**: Appears when an image, image sequence, or movie is selected. This tab contains the Drop Zone checkbox, the state of which determines whether the image selected is a drop zone target. The Fit parameter determines how a dropped layer is sized within the drop zone, and the Clear button removes the reference layer from the drop zone. For more information, see “Drop Zones” on page 251.

- **Group**: Appears when a group is the selected object. The tab contains the Type parameter, which allows you to toggle a group between 2D and 3D. A 2D group has different available parameters than a 3D group.

  When set to 3D, the Flatten and Layer Order parameters become available. When the Flatten checkbox is turned on, all of the elements in the 3D group are flattened like a “card” or “billboard.” When the Layer Order checkbox is turned on, the project elements are sorted by their order in the Layers list rather than their order in Z space. For more information, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.

  When set to 2D, the Fixed Resolution parameters become available, which allow you to manually define the size of a group. By default, Fixed Resolution is disabled and the size of the group is determined by the layers within that group. For more information, see “Fixing the Size of a Group” on page 244.

  **Note**: When turned on, Fixed Resolution crops the group to the size specified in the Fixed Width and Fixed Height parameters around the anchor point of the group.

- **Camera**: Appears when a camera is selected and contains controls specific to a scene camera, including the type of camera, its angle of view, and plane and fade parameters. For more information on working with cameras, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.

  **Note**: A scene camera is a camera that is added to a project, as opposed to a default camera view that you choose in the upper-left corner of the Canvas, such as Top, Right, or Perspective.

- **Light**: Appears when a light is selected and contains controls that allow you to change the light type, color, intensity, and so on.

- **Media**: Appears when an item is selected in the Media tab. These parameters deal mostly with attributes of the file on disk or how the file is interpreted by Motion. Because multiple project objects can reference a single media file, the tab contains a list of linked objects including the name of the group where they exist. Making changes in this tab affects all objects that refer to the selected media file. For more information on working with media parameters, see “Object Media Tab Parameters” on page 225.

- **Text**: Appears when a text layer is selected and contains all of the controls that affect the text. It is divided into three panes: Format, Style, and Layout.
• **Format**: Contains standard type controls such as font, size, tracking, kerning, and so on. It also contains a large text entry box called the Text editor where you can edit the contents of the text (in addition to onscreen editing).

• **Style**: Controls the color, texture, and similar attributes for the typeface, outline, glow, and drop shadow. Each of these sections is grouped and can be turned on or off by clicking the activation checkbox next to the category name.

• **Layout**: Contains paragraph style controls such as justification, alignment, and line spacing (leading). This pane also contains controls to create a type-on effect or to modify text path options. For more information on working with text parameters, see “Using Text” on page 565.

• **Mask**: Appears when a mask is selected and contains the Feather (softness) parameter. It also contains controls to change the mask’s shape type and how multiple masks interact (by setting the Mask Blend mode), an Invert Mask checkbox, and position value sliders for the mask control points. For more information on working with mask attributes, see “Mask Parameters” on page 1092.

• **Shape**: Appears when a shape layer is selected and contains all of the controls that affect the shape. It is divided into four panes: Style, Stroke, Advanced, and Geometry.

  • **Style**: Contains controls to modify the fill and outline of a shape, including changing the brush type for an outline or paint stroke.

  • **Stroke**: Once a paint stroke has been created using the Paint Stroke tool, or the Brush Type for a shape outline is set to Airbrush or Image, the Stroke pane becomes available. Use these controls to set the Stroke Color mode and Brush Scale, to adjust the Opacity, Spacing, Width, and Angle Over Stroke, and more.

  • **Advanced**: Contains controls that allow the dabs of a paint stroke to be animated like particles.

  • **Geometry**: Contains controls that allow you to change the shape type, to close or open a shape, and to individually adjust the position of a shape’s control points using value sliders.

  For more information on working with shapes, see “Using Shapes and Masks” on page 997.

• **Emitter**: Appears when a particle emitter is selected. The parameters in this tab control all aspects of the emitter, such as the emitter shape, space (2D or 3D), angle, and range. This tab also provides access to cell controls. For emitters with multiple cells, these controls affect all cells. For more information on using particles, see “Working with Particles” on page 685.

• **Particle Cell**: Appears when a particle cell is selected. Particle cells can only be selected in the Layers tab or Timeline layers list. This tab contains attributes such as birth rate, speed, angle, and color.
• **Replicator**: Appears when a replicator is selected. Replicators can only be selected in the Layers tab or Timeline layers list. This tab contains attributes such as replicator shape, space (2D or 3D), pattern, size, and cell controls. For more information on using the replicator, see “Using the Replicator” on page 753.

• **Replicator Cell**: Appears when a replicator cell is selected. Replicator cells can only be selected in the Layers tab or Timeline layers list.

• **Generators**: Displays the parameters and attributes of the selected generator, such as the Center, Size, and Intensity parameters of a Lens Flare generator. The specific parameters listed depend on the selected generator. For more information on generators, see “Working with Generators” on page 965.

**Locking the Inspector**

The Inspector typically changes dynamically based on the object that is selected. However, sometimes you want to select another object while you continue looking at the parameters for the current object. When you lock the Inspector, it does not change based on your selection.

**To lock the Inspector, do one of the following:**

- Click the lock icon in the upper-right corner of the Preview area of the Inspector.

- Choose Window > Create Locked Inspector.

**To unlock the Inspector, do one of the following:**

- Click the unlocked lock icon in the upper-right corner of the Preview area of the Inspector.

- Choose Window > Create Locked Inspector.
HUD

The HUD is one of the most versatile and handy tools in the Motion interface. It is a dynamically updating floating window that puts the most common controls for any selected object within easy reach.

The HUD also contains special controls for certain types of effects such as Basic Motion behaviors and particle systems. These unique controls allow you to set multiple parameters simultaneously and in an intuitive way.

For example, the 2D Particle Emitter HUD contains a single control that provides a visual way to manipulate three different particle system parameters—Emission Range, Emission Angle, and Speed. You can read more about specific HUD controls in their namesake chapters.

*Note:* It is easier to enter a specific value for a slider parameter in the Inspector’s value sliders. You can Option-click to the left or right of an Inspector’s slider to decrease or increase by a value of 1. Option-click the arrow on either side of the value slider to increase or decrease by a value of 0.01.
Displaying HUDs
When multiple effects are applied to an object, you can quickly cycle through the different effects’ HUDs. A small downward-facing arrow next to the HUD name indicates additional effects are applied to the selected object.

Click the arrow to display a pop-up menu that lists all of the possible HUDs that can be displayed for the selected object.

Note: Also, pressing D cycles through all HUDs for the selected object.

When multiple objects of the same type are selected, a combined HUD appears, and “Multiple Selection” appears in its title bar.

To switch between HUDs of a selected object, do one of the following:
- Click the downward arrow in the HUD title bar, then choose the HUD you want to view from the pop-up menu.
- Press D to cycle through all HUDs for the selected object. To cycle the HUDs in reverse, press Shift-D.

The HUDs are cycled in the order in which the effects are applied.

Most of the time, the HUD displays a subset of the parameters visible in the Inspector for the selected object. If you are working in the HUD, you can quickly jump to the Inspector to access the remainder of the controls for that object.

To jump to the Inspector from the HUD:
- Click the Inspector icon (the “i”) in the upper-right corner of the HUD.

The Inspector appears and the tab corresponding to the HUD controls is brought to the front.
Preferences

Motion Preferences allow you to customize your workspace, tailor the interface for different types of projects, and define the presets for new projects and for exporting finished movies. There are seven different sets of controls that group the various settings into categories. To open Motion Preferences, choose Motion > Preferences (or press Command-comma).

General

The General Preferences pane contains settings that apply globally to all aspects of Motion.

Startup

This section allows you to define what Motion does when first opened. Choose an item from the pop-up menu.

Open Last Project(s): Any projects that were open when the program was last quit are reopened. This allows a continuity of work across sessions.

Create New Project: This command opens a new empty project. If a default preset has not been chosen, the Select Project Preset selection dialog appears on startup.

Show Welcome Screen: This is the default setting. Upon startup, you are presented with four options: To View the Quick Tours (a link to web-based QuickTime tours of the application), Begin with an Online Tutorial (a link to web-based tutorials of the application), Start with a Template (opens the Template Browser), or Start with a New Project.

Note: To skip the initial screen, change the Motion Preferences (or turn off the “Show the Welcome Screen at startup” checkbox in the welcome screen).
Browse Templates: This option takes you directly to the Template Browser. For more information on working with templates, see “Creating New Projects from Templates” on page 181.

Interface
This section of the General pane allows you to set some general options for the interface.

Drop Menu Delay: This setting determines how long you must wait before the drop menu appears when dragging to the Timeline, mini-Timeline, Layers tab, or Canvas. The drop menu provides additional choices for editing and importing objects into the project.

Show Tooltips: This checkbox turns tooltips on and off across the application. Tooltips provide explanatory information such as names and basic usage techniques. They appear when you pause the pointer over tools and controls.

File Browser & Library
These settings affect how the utility window displays the contents of the File Browser and Library.

Display Folders: This setting lets you choose between listing folders alphabetically within the list, or grouped together at the end of the list after all nonfolder items.

Show preview icons: This checkbox turns preview icons on and off in the utility window. For example, when turned on, the first frame of a QuickTime movie is displayed. When turned off, the Finder QuickTime icon is displayed.

Note: The screen shots in the Motion User Manual were taken with the “Show preview icons” checkbox turned off in Motion Preferences.

Play items automatically on a single click: This checkbox controls whether the Preview area automatically plays the contents of the item selected in the file stack.
**Content Library & Templates**
When installing, Motion allows you to install its content library, templates, and sample media in a location other than where the application is installed. This setting allows you to point to a folder on your system or network that contains the Motion content library, templates, and tutorial media. This also allows multiple users on a network to share a single, centralized folder.

**To set the Motion content path:**
1. Click Choose (next to Library Path).
2. In the dialog that appears, navigate to the content’s location, then click Choose.
3. Restart Motion.

**To reset the Motion content path:**
- Click reset (next to the Choose button).

**3rd Party Plug-ins**
Motion can read third-party After Effects-compatible plug-ins. This setting allows you to point to a folder where such plug-ins are located on your disk.

*Note:* FxPlug filters must be universal binary versions to work on Intel-based Macintosh systems.

**To set the plug-in path:**
1. Click Choose (next to Search Path).
2. In the dialog that appears, navigate to the location of the plug-ins, then click Choose.
3. Restart Motion.

**To clear the plug-in path:**
- Click Clear (next to the Choose button).

**Media**
When the “Automatically remove unused media” checkbox is enabled, Motion removes any media that is not currently being used from your project when you delete any media object from the project (from the Canvas, Layers tab, or Timeline layers list). The media no longer appears in the Media tab.

**Keyframe Editor**
When the Lock Keyframes in Time checkbox is turned on, you can change the values of keyframes in the Keyframe Editor, but you cannot move the keyframes forward or back in time. This helps prevent changing your animation timing as you adjust values.
**Appearance**
This pane contains settings that control visual elements of the Motion interface.

**HUD**
The HUD is a semi-transparent window that floats above the other windows on your screen. Use the Window Opacity slider to set the opacity (transparency) of the HUD.

**Thumbnail Preview**
The thumbnails that appear in the Layers tab can provide helpful information about the items selected in that window. For items that are partially transparent (contain an alpha channel), you can set the background that appears behind the image. Choose from either Checkerboard or Color.

- **Checkerboard**: This is the default setting. It displays a checkerboard pattern where transparent pixels appear.
- **Color**: This setting displays a solid color where transparent pixels appear.

**To change the thumbnail background color:**
1. Choose Color from the Background pop-up menu.
2. Click or Control-click the color well next to the pop-up menu, then choose a color from the Colors window or pop-up color palette.
   The selected color becomes the background color for the thumbnail previews.

**Timeline**
This setting lets you choose how to display the bars that appear in the Timeline to represent your objects. You can choose from Name, Name Plus Thumbnail, and Filmstrip.

- **Name**: The bars in the Timeline display the object name only.
- **Name Plus Thumbnail**: This setting is the default. Bars in the Timeline display an icon representing the first frame of the object followed by the name of the object.
**Filmstrip:** Bars in the Timeline are displayed as a continuous strip of frames. The name text does not appear. For an example of the different states, see “Specifying the Track Display” on page 330.

**Note:** Only layers (shapes, images, image sequences, text, and so on) display a thumbnail or a continuous strip of frames. Objects such as cameras, lights, and behaviors do not display a thumbnail.

**Status Bar**
The Status Bar is the area above the Canvas and below the Toolbar. You can choose to display three different types of information in this area: Color, Coordinates, and Frame Rate. You can also choose from three different methods of representing the color data.

**Color:** This setting displays the color value of the pixel currently under the pointer. Colors are displayed in the format chosen in the Display Color As setting.

**Coordinates:** This setting displays the X and Y coordinates of the current pointer position.

**Frame rate:** This setting displays the frame rate of the project during playback. Nothing is displayed unless the project is playing.

**Display Color As:** Choose among three styles for displaying the color data.

- **RGB:** This setting displays the red, green, blue, and alpha values of each pixel in ranges of 0–255. The Alpha value is also displayed.
- **RGB (percent):** This setting displays the red, green, blue, and alpha values of each pixel in ranges of 1–100.
- **HSV:** This setting displays the color as hue, saturation, and value (brightness) where hue is a value from 1–360, and saturation and value are ranged from 1–100. Alpha is also displayed ranged from 1–100.
Project
The Project Preferences pane contains settings such as timing, display, and playback options.

Default Settings
These controls determine default values for newly created projects. To change these settings for a specific project, modify similar settings in the Project Properties dialog (choose Edit > Project Properties or press Command-J).

Note: These settings only take effect in projects created after the preferences are set. Any currently-opened projects are not affected.

Project Duration: Sets the default duration for new projects. You can type a number into the value field and choose Frames or Seconds from the pop-up menu.

Background Color: Sets the color of the background for any new projects that are created after the color has been changed. This does not change the background color of the current project. To change the background color for a current project, choose Edit > Project Properties (or press Command-J) and use the Background Color controls.

Note: To render a new background color into your final output, you must choose Solid from the Background pop-up menu in the General tab of the Project Properties dialog (press Command-J).

To change the background color:
- Click or Control-click the color well, then use the Colors window or pop-up color palette to select a new color.

The selected color becomes the background color for subsequent projects.
**Time Display**

These settings control how the time counters across the application are displayed.

**Display Time As:** You can make one of two choices:
- **Frames:** Displays all counters as incrementing frame numbers.
- **Timecode:** Displays all counters as eight-digit timecode numbers.

**Frame Numbering:** This lets you choose whether frame counts begin at zero or one.

**Still Images & Layers**

These settings control the default duration, placement, and size of still images and imported layers, as well as layers created in Motion, such as text, shapes, and masks.

**Default Layer Duration:** You can specify the duration of still images, generators, and other layers that lack an inherent duration in one of two ways:
- **Use project duration:** All layers are the same duration as the project.
- **Use custom duration:** Layers are the duration defined in this value field.

You can set the time in frames or in seconds.

**Create Layers At:** When you drag layers to the Canvas, the Layers tab, or the Timeline layers list, they can either be added to the project at the current playhead position or they can be added at the first frame of the project. This setting also applies to layers created within Motion, such as text or shapes.

**Large Stills:** When importing large still images, set this preference to instruct Motion to import the file at its original size, to change the resolution of the image to fit the Canvas size, or to scale the image down to fit the Canvas size.
- **Do Nothing:** Imports the image at its original size.
- **Scale to Canvas Size:** Imports and scales the image to fit the project size while maintaining its aspect ratio.
- **Down-Res to Canvas Size:** This setting changes the resolution of the imported image so that the image fits the project size while maintaining its aspect ratio.

**Note:** For more information on the differences between the Large Still options, see “Using High-Resolution Still Images” on page 205.

**Playback Control**

These settings control how Motion plays back your project.

**Time View Updating:** When the Timing pane is visible, you can set the view to automatically move along with your project’s playback. Make one of the following choices from the pop-up menu:
- **Don’t update:** The Timing pane does not change as you play (improves performance).
• **Jump by pages:** As the playhead reaches the end of the current view, the window jumps forward. The playhead crosses the screen again, and so on.

• **Scroll continuously:** The playhead remains static and the Timing pane scrolls by behind it.

**If Audio Sync Is Lost:** Motion always attempts to keep audio and video playback locked in sync, but if the project is too complex to play both audio and video smoothly, one or the other must be compromised. You can choose to either Skip video frames or Pause audio playback.

**Limit playback speed to project frame rate:** Motion plays back your project as fast as possible based on the complexity of the effects and the strength of your computer. When this box is turned on, playback rate never exceeds the frame rate of your project. This means you can watch your project play back at the same frame rate as your exported movie. When the box is turned off, playback rate is only limited by your processor power and may play much faster than the project frame rate.

**Loop audio while scrubbing:** When this checkbox is on, the audio for the frames where you drag the playhead repeats. When the checkbox is turned off, the audio for those frames plays only once.

**Cache**

This pane contains settings to control the cache for the project, autosaving, LiveFont cache, and optical flow retiming.

**Memory & Cache**

This setting lets you specify how much memory is allocated to the project cache.

**Project Cache:** Lets you specify the percentage of your total memory that you want to use for the project cache. The larger the number, the more memory available to Motion to cache frames, resulting in a higher likelihood of consistently smooth playback.
Autosave
These settings control how frequently projects are automatically saved, as well as the location of the saved files. Saved projects are time and date stamped.

Use Autosave Vault: When this checkbox is turned on, Motion stores auto-saved projects to the location specified by the Autosave Vault Folder path.

Save a copy every: Specifies how often, in minutes, a project is saved.

Keep at most: Specifies how many versions of the autosaved project to store in the vault.

Maximum of: Specifies the maximum number of different auto-saved projects to store in the vault.

Autosave Vault Folder: The Choose button allows you to set where the Autosave files are kept. The reset button sets the Autosave location back to its default. By default, the Autosave Vault folder is located in a folder called Motion Documents in your Documents folder in your home directory.

To store auto-saved projects in a specific location:
1 Choose Motion > Preferences (or press Command-comma).
2 Click Cache.
3 In the Autosave group, turn on Use Autosave Vault.
   By default, the Autosave Vault folder is located in a folder called Motion Documents in the Documents folder in your home directory.

To set a new location for the Autosave vault:
- Click Choose, set a new location in the dialog, then click Choose.

To revert to an auto-saved project:
1 Choose File > Restore from Autosave.

The Restore Project dialog appears.
2 Choose a saved project from the pop-up menu.

Note: A project must be saved before the Revert commands are available in the File menu.
**LiveFonts**
These settings determine how LiveFonts are cached (stored) by Motion.

**Cache intermediate LiveFont sizes:** This checkbox turns on or off caching of LiveFont data. This option is on by default, as it improves performance if you frequently use LiveFonts.

**Cache Path:** Click Choose to define a custom location to cache your LiveFont data. Because this cache can grow quite large, it is advised that you set this to a drive other than your primary system drive.

**Delete LiveFont Cache:** Over time, this cache can grow to take up many gigabytes of disk space. To recover this space, you can delete the cache by clicking this button.

To set a new location for the LiveFont cache:
- Click Choose, set a new location in the dialog, then click Choose.

To clear the LiveFont cache:
1. Click Delete LiveFont Cache.
   A dialog appears and asks you to confirm the deletion.
2. Click Delete and the cache is deleted.

**Optical Flow Retiming**
When you retime footage, Motion needs to store the retiming files. This setting specifies where the retiming files are stored. You can choose to store the files in the same location as the source footage, or specify your own location.

**In folder with source media:** Click this button to save the retiming files in the same location as the source footage.

**In this folder:** Click the Choose button to specify where the optical flow retiming files are stored. By default, the Optical Flow folder is located in the /Users/username/Documents/Motion Documents/Retiming Cache Files folder.

To set a new location for the optical flow files:
- Click Choose, set a new location in the dialog, then click Choose.
Canvas
This pane contains settings to customize your Canvas view. Changes made in this pane take immediate effect in your current project.

Background
This setting allows you to choose a color for the background of your Canvas—the color outside of the project boundaries. This color is not exported with your project, but only acts as a guide for helping identify transparent and colored layers.

To change the background color of the Canvas:
- Click or Control-click the Canvas color well, then choose a color from the Colors window or from the pop-up color palette.

The selected color becomes the background color for the Canvas.

Full View Opacity: If Show Full View Area is enabled in the View menu, this setting controls the opacity of the part of a layer that extends beyond the edge of the Canvas into the background. When set to 100%, the layer is transparent. When set to 0%, the layer is fully opaque.

Alignment
These settings control the color and display of the optional grid, rulers, and guides that appear in the Canvas. Grids, guides, and rulers can be turned on and off in the View menu or in the View pop-up menu at the upper-right corner of the main window.

Grid Spacing: This slider sets the width for the grid in pixels.

Grid Color: This color well sets the color of the grid lines.

Guide Color: This color well sets the color of guides.
Dynamic Guide Color: This color well sets the color for dynamic guides.

Ruler Location: This pop-up menu sets the position of the ruler in the Canvas. Choose from Top Left, Bottom Left, Top Right, or Bottom Right.

Safe Zones
Safe zones are special guides to help you avoid putting layers in areas of the screen that might not appear correctly on consumer television sets. Layers that appear outside the action safe region may be cut off. The area outside the title safe region may have distortions that make text hard to read. The safe zone guides can be turned on and off in the View menu, or in the View pop-up menu at the upper-right corner of the main window (above the Canvas).

Action Safe Region: Sets the percentage of the Canvas where the action safe guides appear.

Title Safe Region: Sets the percentage of the Canvas where the title safe guides appear.

Safe Zone Color: Sets the color of the safe zone guides.

Film Zone
When producing output to be used for both television and film, it may be helpful to see the area of the TV frame that will be cut off when it is converted to film. The film zone settings allow you to display a guide that identifies the aspect ratio of the film gauge you are working in. Film zone guides can be turned on and off in the View menu or in the View pop-up menu at the upper-right corner of the main window.

Aspect Ratio: This pop-up menu sets the guide size to match one of the standard aspect ratios or lets you enter a custom value.

To choose an existing aspect ratio:
- Choose a setting from the Aspect Ratio pop-up menu.

To create a custom aspect ratio:
- Type a number representing the screen width (based on a height of 1) into the value field to the right of the pop-up menu, then press Return.

Film Zone Color: Sets the color of the film zone guides.

Snapping
Objects in the Canvas automatically snap to other objects when you drag them around. This setting determines whether the objects snap to objects’ center points, edges, or both centers and edges. Snapping can be turned on and off in the View menu or by pressing N when the Canvas is active.
3D
The 3D Preferences pane lets you control various aspects of working in the Motion 3D workspace.

General
This area lets you control the Inset view and choose whether new groups default to 2D or 3D mode.

Display Inset View: Lets you control whether the Inset view appears on transform changes, on all changes, or manually. Inset view must be enabled in the View menu or View pop-up menu for the Inset view to appear.

- **On Transform Changes**: The Inset view appears when adjusting an object’s transform parameters such as position, rotation, or scale.
- **On All Changes**: The Inset view appears when making adjustments specific to an object, such as adjusting the parameters of a replicator, in the HUD or Inspector.
- **Manually**: When this option is selected, the Inset view is displayed all the time.

Inset View Size: Use the slider to adjust the size of the Inset view.

Default New Group Type: Use this menu to specify whether new groups are created as 2D or 3D groups. When set to Automatic, Motion determines the type of group that is created based on the project. For example, when Automatic is selected and you are working in a 3D project, new groups are 3D. If you are working in a 2D project (no camera), new groups are 2D.
3D Grid
This area lets you modify settings for the grid that appears in the Motion 3D workspace.

3D Grid Spacing: Specifies the spacing between grid lines, in pixels.

3D Grid Size: Adjusts the size of the visible grid. Larger numbers make the grid extend further into space.

Primary Grid Color: Lets you set the color of the main grid lines. The main grid lines appear slightly heavier than the secondary grid lines.

Secondary Grid Color: Lets you set the color of the secondary grid lines (the lines that appear within the main grid lines).

To change the primary or secondary 3D grid color:
- Click or Control-click the Grid color well, then choose a color from the Colors window or the pop-up color palette.

The selected color becomes the color for the grid lines.

Output
The Output Preferences pane tells Motion to render the contents of the Canvas out to a video deck or monitor connected to your computer via FireWire or another port.

External Video
These settings control how Motion plays your project directly to a video deck or monitor connected to your computer.

Video Output: Set this pop-up menu to match the type of device connected to the monitor. When this is set to anything other than None, Motion outputs a new frame to the externally connected video monitor every time you release the mouse button (if the Canvas has changed). If no deck or video monitor is connected, the menu is set to None.
If you have two computer displays, one can be used to view the Motion interface and the Finder while the other can be used as a dedicated video monitor using a cinema display as an external monitor. The following external video monitoring choices are available:

- **Digital Cinema Desktop Preview**: The video is not scaled unless it is too large to fit on the display. If the video signal is larger than the display, it is scaled to fit on the display.
  - **Pros**: The video always maintains proper aspect ratio and does not exhibit scaling artifacts due to magnification.
  - **Cons**: Some formats, especially SD formats, may look very small when displayed on large computer displays.

- **Digital Cinema Desktop Preview – Full Screen**: The video is scaled to fit the display in at least one dimension. If the aspect ratio of the video signal and the computer display do not match, the video on the display is letterboxed (black on top and bottom) or pillarboxed (black on sides) as necessary.
  - **Pros**: This format gives you the biggest picture possible and maintains the proper aspect ratio.
  - **Cons**: Scaling artifacts may be noticeable when viewed up close.

- **Digital Cinema Desktop Preview – Main**: Uses your main monitor as the Digital Cinema Desktop display. The video is scaled to fit the display in at least one dimension.
  - **Pros**: This format gives you the biggest picture possible and maintains the proper aspect ratio.
  - **Cons**: Scaling artifacts may be noticeable when viewed up close.

- **Digital Cinema Desktop Preview – Raw**: This mode shows the video data with as little processing as possible. This can be useful for engineering evaluations of the image. No scaling is done whatsoever.
  - **Pros**: More accurate assessments of video quality can be made.
  - **Cons**: Not useful for general viewing. No scaling or pixel aspect ratio adjustments are made, even when the video is larger than the display.

*Note:* For example, a 720p frame (1280 x 720) showing in raw mode on an 800 x 600 display only shows 800 x 600 of the image.

**To view Motion video output on a computer display connected to your computer:**

1. Choose Motion > Preferences.
2. In the Output pane, choose one of the display options from the Video Output pop-up menu.
**Options**: When a Video Output module is turned on, the Options button becomes active. For monitors connected via FireWire, there is no need to adjust the options. For monitors connected via third-party hardware, the options may have applicable settings.

**Update during playback**: Plays the project out to the external video monitor while the project plays back in the Canvas. This option severely degrades performance.

**Update dynamically on parameter change**: Sends a new video frame out to the external video as you adjust parameters (instead of only after releasing the mouse button). This option may severely degrade performance.

---

**Video Output in Motion**

If you’re creating work that is intended to be viewed on a TV monitor (such as broadcast design or DVD menus), it’s imperative that you see your design on such a monitor before finalizing your Motion project. While you can do a great deal of layout and color adjustments on your computer screen, you might be surprised how different things may look when they appear on a TV screen.

First, whether you’re working in NTSC (the American and Japanese TV standard) or PAL/SECAM (the European TV standard), colors are going to look quite different from the way they look on your computer monitor. (NTSC has been affectionately referred to as “Never Twice the Same Color.”)

Furthermore, TV signals are **interlaced**, meaning that the vertical resolution is cut in half and displayed at twice the rate. This can mean that thin horizontal lines in your design (such as font serifs) may buzz or flicker when played back on a TV screen.

Fortunately, Motion allows you to view the contents of your Canvas directly on a TV monitor that is connected to your computer. You can connect a monitor to your computer using a FireWire device such as a DV camcorder or deck, or by using a third party video capture card. For accurate results, you should use a professional grade monitor with calibration controls.
Presets
The Presets Preferences pane contains presets for both project settings and export settings. In this pane, you can choose defaults, as well as create, modify, and delete settings. The default project preset determines the settings assigned when you create a new project. You can change any of these settings while you are working by opening the Project Properties window (choose Edit > Project Properties or press Command-J).

Show: This pop-up menu lets you choose between modifying presets for new projects or modifying presets for exporting.

Preset list: Below the Show menu, the current list of presets appears. The checkbox to the left of each name identifies the default preset. Check a different box to select a new preset. The column on the right shows which presets are locked. Locked presets cannot be modified. You can duplicate a locked preset and edit the copy.

Summary box: To the right of the Preset list, the Summary box displays details of the currently selected preset.

Create new documents using default: When this checkbox is turned on, creating a new project automatically uses the default project preset. When this checkbox is turned off, creating a new project displays the Select Project Preset dialog so you can choose a preset for the new project.

Add New Preset: Click the Add button (+) to display the Project Preset Editor dialog and create a new preset.

Remove Preset: To remove a preset, select the preset you want to remove and click the Delete button (−).

Duplicate: To duplicate a preset, select the preset you want to duplicate, then click Duplicate.
Editing Presets
To make changes to a preset, click the Edit button to open the Project Preset Editor and enter the changes in that window. Locked presets cannot be edited. If you attempt to edit a locked preset, an alert dialog appears, a duplicate copy is made, and your edits are applied to the duplicate.

To open the Project Preset Editor, do one of the following:
- Double-click an unlocked preset in the Preset list.
- Select a nonlocked item in the Preset list and click the Edit button.
- Select an item in the Preset list, click Duplicate, select the copied preset, then click the Edit button.

Project Preset Editor
The Project Preset Editor dialog is where you edit the contents of project presets.

![Project Preset Editor dialog]

**Note:** When you double-click a default preset, an alert dialog appears stating that the selected preset cannot be modified. Click OK to create an editable copy of the preset.

**Name:** Contains the name for the preset.

**Description:** This field contains descriptive text to identify the preset. This text appears in the Summary box in the Preset Preferences pane. You can enter your own descriptive text in this field.

**Width and Height:** These fields set the frame size for the preset.

**Pixel Aspect Ratio:** Sets the pixel aspect ratio for the preset. This should match the type of media with which you are working.

**Field Order:** Sets the field order for your project. DV projects typically use the Lower First setting.

**Frame Rate:** Sets the frame rate for your preset. Click the list arrow to display common rates or type your own custom value.
Export Options Dialog
To make changes to an export preset, choose Export Presets from the Show pop-up menu, click the Edit button to open the Export Options dialog, and enter the changes in that window. Locked presets cannot be edited. If you attempt to edit a locked preset, an alert dialog appears, a duplicate copy is made, and your edits are applied to the duplicate.

To open the Export Options dialog, do one of the following:
- Double-click an unlocked preset in the Preset list.
- Select a nonlocked item in the Preset list and click the Edit button.
- Select an item in the Preset list, click Duplicate, select the copied preset, then click the Edit button.

Name: This editable field contains the name for the preset.

Description: Contains descriptive text to identify the preset. This text appears in the Summary box in the Preset Preferences pane. You can enter your own descriptive text in this field.

The Video/Audio and Output tabs appear beneath the Name and Description fields. To the right of the tabs, a summary box displays the details of settings from the two tabs.
**Video/Audio Tab**
The Video/Audio tab contains two groups of controls: Video and Audio.

**Video controls**
This group of controls allows you to set your video output options.

**Kind:** Choose from QuickTime Movie, Still Image, or Image Sequence.

**Note:** Audio options are only available for QuickTime movies.

**Compressor:** Depending on the Kind setting, different compressor types are available.

**Quality:** For some compressors, you can set a quality setting. If the control is dimmed, that compressor type does not offer variable quality.

**Start number:** For image sequences, you can set a starting frame number. Each file generated in the image sequence has an incrementing number.

**Add spaces:** When generating image sequences, clicking the Add Spaces checkbox causes extra spaces to be added to the filenames to ensure that the sequence of files is read in proper order by some other applications.

**Advanced:** The Advanced button is only active for QuickTime movies. Clicking this button opens the standard compression settings dialog. In most cases, you should not need to make any changes in this dialog.

**Audio controls**
This group of controls allows you to set your audio output options.

**Sample rate:** Sets the audio sample rate for your exported movie. For best results, set this to be the same sample rate as the source audio in your project.

**Mix:** Sets the audio output mix for your project. Use the default Stereo setting or choose 5.1 Surround.

**Advanced:** The Advanced button opens the standard Sound Settings dialog. In most cases, you should not need to make any changes in this dialog.

**Output Tab**
The Output tab contains the following controls:

**Use current project and canvas settings:** When this is checked, this setting overrides the contents of this dialog with the current settings in your project. This allows one export preset to be used with multiple project presets. When this setting is turned off, you can create specific settings for the export preset.
**Resolution:** You can specify the output size to be relative to the project’s frame size (Full, Half, Third, or Quarter), to be a preset, or you can choose Custom and type a specific number into the width and height value fields. Lower resolutions should be used only for draft versions.

**Color:** Choose whether the exported items include the color data only, color data plus alpha channel (transparency), or just the alpha channel data.

*Important:* Some compressor types do not support alpha channels.

**Premultiply alpha:** When this checkbox is turned on, semi-transparent pixels in your output are mixed with black.

**Frame Rate:** Controls whether projects are output at the project frame rate, or at another frame rate that you specify.

**Camera:** Sets which camera view is used when you output a 3D project. Use the default Active Camera setting or choose another scene camera.

*Note:* A scene camera is a camera that you add to a project, as opposed to a default camera view that you choose in the upper-left corner of the Canvas (Top, Right, Perspective, and so on). You can only export a project using a scene camera.

**Lighting:** When this checkbox is turned on, the lighting effects are rendered with the project. When this checkbox is turned off, no lighting effects appear in your final output.

**Render Quality:** Allows you to choose Draft, Normal, or Best quality for your final output. The better the quality, the longer the render time.

**Field Rendering:** When this checkbox is turned on, the output always renders individual fields regardless of the setting in the Canvas View menu. When not turned on, frames are rendered whole, regardless of the setting in the Canvas View menu.

**Motion Blur:** When this checkbox is turned on, motion blur is applied to moving layers regardless of the setting in the Canvas View menu. When turned off, no motion blur is applied.

**Frame Blending:** When this checkbox is turned on, frame blending is applied to moving footage in the rendered output. The result can be smoother looking playback, but this option can increase rendering time.

**Use Float Bit Depth:** When working in float space, turning this setting off drops the rendered output to 8-bit. Because working in float space drastically increases processing time, turn this setting off to speed your rendering time. This setting does not affect the use of float bit depth in the Canvas.

*Chapter 1  Getting to Know Motion*
Gestures
The Gestures Preferences pane contains settings pertaining to using a graphics tablet to control Motion.

You cannot turn on gestures in Motion unless you have a tablet attached to your computer and the Handwriting Recognition is turned on in the Ink preferences in System Preferences. For convenience, you can open Ink Preferences directly from the Gestures Preferences pane by clicking the Open Ink Preferences button.

For more information on using gestures, see Appendix D, “Using Gestures,” on page 1231.

Input
These settings control how Motion knows when your pen movements should be interpreted as gestures.

Input Method: Lets you choose between observing the settings in your Mac OS Preferences and your Wacom Preferences or using gestures only when a trigger is enabled.

When you set the input to require a trigger, your pen and tablet act as a mouse until you press one of the buttons on the pen or press a modifier key. This indicates that you are entering a gesture. Releasing the button or key returns the pen to normal mouse state.

Trigger: Sets which trigger method to be used: Pen Button 1, Pen Button 2, or the Control key on your keyboard.

Allow gestures in the air: Lets you trigger gestures without pressing the tip of the pen on the tablet. This option is only available when a trigger is used to activate gestures.

Menus
The Motion menu bar provides access to nearly every control in the application. Many menu items are context sensitive, so they are dimmed when the command cannot be performed based on the current state of the program or what is selected. This section serves as a reference guide for all menus.
Many of these commands have shortcut keys that perform the same command from the keyboard. These shortcuts are listed in parentheses after the description.

**Application Menu**
The first menu contains general functions to control the application, modify the preferences, and access the Apple website. It also provides access to system level services.

**About Motion:** Opens the About Motion window where you can find the version of Motion you are running, the registration information, and other trademark information.

**Preferences:** Opens Motion Preferences. See “Preferences” on page 137 for a detailed description of the settings in that window (Command-comma).

**Commands:** Provides access to controls for customizing your keyboard command keys.

- **Customize:** Opens the Command Editor.
- **Import:** Opens a dialog that allows you to import a customized key command set.
- **Export:** Opens a dialog that allows you to export a customized key command set.
- **Command Sets:** Allows you to load a customized key command set.
- **Standard Sets:** Sets the active keyboard to the default key command layout.

*Note:* For information on customizing your shortcut keys, see “Customizing Keyboard Shortcuts” on page 1201.

**Provide Motion Feedback:** Opens a web page where you can send comments to Apple about Motion.

**Register Motion:** Connects you to the Apple website where you can register your copy of Motion. Registered users receive information about updates and other useful information.

**Services:** This is a system menu item that provides access to commands that work across different applications. See Mac OS X Help for more information about this submenu.

**Hide Motion:** Hides all Motion windows. The application is still running in the background. You can bring it back to the front by clicking the Motion icon in the Dock (Command-H).

**Hide Others:** Hides windows from all applications other than Motion (Option-Command-H).

**Show All:** Shows all windows from all applications currently running.

**Quit Motion:** Stops the application from running. You are prompted to save any open documents (Command-Q).
File Menu
This menu contains functions and commands that deal with files on your disk that are associated with Motion.

**New:** Creates a new Motion document (Command-N).

**Open:** Opens a dialog from which you can choose a Motion project to open (Command-O).

**Open Template:** Displays the Template Browser, from which you can choose one of the built-in templates (Shift-Command-O).

**Open Recent:** This submenu lists the ten most recently opened files. This allows you quick access to the projects you have been working on recently. You can clear the list by choosing Clear Menu from the bottom of the submenu.

**Close:** Closes the currently selected window. If the Canvas is the currently selected window, and the project has not been saved, Motion asks you to save the project before closing the window (Command-W). Press Option-Command-W to close all windows.

**Save:** Stores the current state of the selected project to disk (Command-S). Press Option-Command-S to save all open projects.

**Save As:** Saves the current state of the selected project with a new name (Shift-Command-S).

**Save As Template:** Saves the current project as a template. For more information on working with templates, see “Creating New Projects from Templates” on page 181.

**Revert:** Restores the selected project to the last saved state. All of the work done since the last save is lost. Use caution; you cannot undo this operation.

**Restore from Autosave:** Displays a dialog from which you can choose a project saved to the Autosave Vault.

**Import:** Opens the Import Files dialog and lets you choose a file from disk to import into your project (Command-I).

**Import as Project:** Displays the Import File as Project dialog. The file you choose is automatically placed into the Canvas of a newly created project. If multiple items are selected, they are all placed in the same project (Shift-Command-I).

**Export:** Displays the Export dialog so you can output your current project to a file on disk (Command-E). For more information on the various Export settings, see Chapter 14, “Exporting Motion Projects,” on page 1147.
Export Selection: Displays the Export dialog so you can output only your currently selected object to a file on disk (Command-E). Objects that are not selected are not exported. For more information on the various Export settings, see Chapter 14, “Exporting Motion Projects,” on page 1147.

Export using Compressor: Outputs your current project to a file on disk using Compressor to make MPEG 2, MPEG 4, or other files for web, DVD, or other computer-based delivery (Shift-Command-E).

Reconnect Media: When a layer in your project refers to a file on disk that has been moved or modified, this command allows you to reestablish that link. This menu item is not active unless a layer that has lost its reference file is selected.

Remove Unused Media: When a media item is imported into the Media tab (and not into the project), this command allows you to remove it from your project. This menu item is not active unless an item that has lost its reference file is selected.

Page Setup: Displays the standard system Page Setup dialog where you can set paper size and orientation for printing (Shift-Command-P).

Print: Displays the standard system Print dialog, from which you can print the contents of the Canvas (Command-P).

Edit Menu
This menu contains familiar commands such as Undo, Cut, Copy, and Paste and also contains commands to select and delete objects, modify project properties, and control the Motion spelling checker.

Undo: This command is usually followed by the name of the last command performed such as Undo Move or Undo Rotation Change. Choosing this menu item restores the project to the state before that action was taken. You can undo up to 99 actions. If the menu item is dimmed, you cannot undo (Command-Z).

Redo: This command is usually followed by the name of the last command performed such as Redo Move or Redo Rotation Change. It is only active if one or more actions have been undone. Choosing this menu item performs the exact action that was just undone (Shift-Command-Z).

Cut: Removes the selection and stores it on the Clipboard so it can be pasted later (Command-X).

Copy: Copies the selection and stores it on the Clipboard so it can be pasted later (Command-C).
**Paste:** Adds the current Clipboard selection to the project based on the current selection. This command is not available if nothing is on the Clipboard or if the contents of the Clipboard cannot be pasted to the current selection. (For example, text cannot be pasted onto a keyframe.) (Command-V)

**Paste Special:** Gives you the choice to paste the contents of the Clipboard into the active Timeline by inserting (pushing existing objects out of the way) or exchanging the contents with the selected object (Option-Command-V). Additional options are available. For more information, see “Paste Special” on page 347.

**Duplicate:** Makes a copy of the current selection, and immediately adds it to the project (Command-D).

**Delete:** Removes the current selected object. In the Timeline, Delete leaves a gap where the object was (Delete).

**Ripple Delete:** Removes the selected object and closes the gap left behind (in the Timeline) (Shift-Delete).

**Insert Time:** Adds blank space into the Timeline. You can only use Insert Time after selecting a time range in the Timeline ruler. For more information on time ranges, see “Defining the Play Range” on page 359.

**Split:** Breaks an object into two objects, each on its own Timeline track. The split occurs at the current playhead position. If no object is selected, or the playhead is not positioned over a selected object, this menu item is dimmed.

**Select All:** Selects all objects in the project (Command-A).

**Deselect All:** Releases any selection (Shift-Command-A).

**Send Audio to Soundtrack Pro:** Lets you specify where to save an audio file, then opens it in Soundtrack Pro (Command-U).

**Project Properties:** Opens the Project Properties dialog where you can change the settings for the current project (Command-J). For details of the Project Properties dialog, see “General Tab of the Project Properties Dialog” on page 184.

**Spelling Submenu**
This submenu contains the spell checking controls. These commands are only active when a body of text is selected. For more information on using the spelling checker, see “Adding Text with the Text Editor” on page 582.

**Spelling:** Opens the Spelling dialog where you can search through the selected text layer for spelling errors (Command-colon).

**Check Spelling:** Turns the spelling checker on for the currently selected text (Commandsemicolon).
Check Spelling As You Type: This command turns automatic spelling checking on and off. When active, a checkmark appears next to the menu item. This command only functions on text in the Text editor, not the Canvas.

Special Characters: This command is part of Mac OS X. It opens the Character Palette which provides access to nontypical text characters like bullets, arrows, and currency icons. It can only be used in Motion when typing in a text layer.

Mark Menu
This menu contains commands to set the beginning and end points of your objects, add markers to the Timeline, navigate through your project, and control animation of effects.

Mark In: This command does two different things. If no object is selected, it sets the beginning frame of the play range to the current playhead position. If an object is selected, it trims the In point for that object to the current playhead frame (I).

Mark Out: This command does two different things. If no object is selected, it sets the ending frame of the play range to the current playhead position. If an object is selected, it trims the Out point for that object to the current playhead position (O).

Move Selected In Point: This command moves the selected object or objects so the In point aligns with the current playhead position (I).

Move Selected Out Point: This command moves the selected object or objects so the Out point aligns with the current playhead position (I).

Markers Submenu
This submenu contains all of the controls for creating, modifying, and deleting markers. For more information on using markers, see “Adding Markers” on page 362.

Add Marker: Adds a marker at the current playhead frame. If an object is selected, an object marker is added. If no object is selected, a project marker is added (M or the tilde key to add an object marker; Shift-M to add a global marker).

Edit Marker: Opens the Edit Marker dialog where you can set a marker’s name, color, duration, and comment. A marker must be selected for this menu item to be active (Option-Command-M).

Delete Marker: Removes the selected marker from the project.

Delete All Markers: Removes all markers from the selected object. If no object is selected, it deletes all project markers.

Mark Play Range In: Sets the play range In point to the location of the playhead (Option-Command-I).
Mark Play Range Out: Sets the play range Out point to the location of the playhead (Option-Command-O).

Reset Play Range: Moves the play range In and Out points to the first and last frame of the project (Option-X).

Play: Starts playback of the project (Space bar).

Loop Playback: Turns looping on and off. When looping is enabled, playback automatically repeats from the beginning of the play range after the end is reached (Shift-L).

Record Animation: Turns keyframe recording on and off. For more information on recording animation, see “Animating in the Canvas” on page 506.

Recording Options: Opens the Recording Options dialog where you can set the granularity of keyframe recording.

Go to Submenu
This submenu contains all of the different commands to navigate to a particular frame within your project. All of these commands move your playhead to a new location.

Project Start: Moves the playhead to the first frame of the project (Home).

Project End: Moves the playhead to the last frame of the project (End).

Play Range Start: Moves the playhead to the project In point (Shift-Home).

Play Range End: Moves the playhead to the project Out point (Shift-End).

Previous Frame: Moves the playhead backward by one frame (Left Arrow).

Next Frame: Moves the playhead forward by one frame (Right Arrow).

10 Frames Back: Moves the playhead backward ten frames (Shift–Left Arrow).

10 Frames Forward: Moves the playhead forward ten frames (Shift–Right Arrow).

Previous Keyframe: Moves the playhead to the previous keyframe in the project (Option-K).

Next Keyframe: Moves the playhead to the next keyframe in the project (Shift-K).

Previous Marker: Moves the playhead to the closest marker earlier in time (Option–Command–Left Arrow).

Next Marker: Moves the playhead to the closest marker later in time (Option–Command–Right Arrow).
Selection In Point: Moves the playhead to the first frame of the selected object (Shift-I).

Selection Out Point: Moves the playhead to the last frame of the selected object (Shift-O).

RAM Preview Submenu
This submenu contains commands to play back your project in real time, by temporarily storing the frames in a RAM buffer. For more information on how and when to use the RAM Preview functions, see "RAM Preview" on page 59.

Play Range: Renders the area between the project In and Out points and stores the frames in RAM. Once the frames are stored, the region plays back at full speed (Command-R).

Selection: Renders the range of time occupied by the selected objects and stores the frames in RAM. Once the frames are stored, the region plays back at full speed (Option-Command-R).

All: Renders the entire project and stores the frames in RAM. Once the frames are stored, the region plays back at full speed (Shift-Option-Command-R).

Clear RAM Preview: Clears the RAM cache.

Object Menu
This menu contains all of the commands for manipulating objects within Motion. This includes their placement in the layer hierarchy and physical alignment in the Canvas.

New Group: Adds a new empty group to the project (Shift-Command-N).

New Camera: Adds a new camera to the project, and lets you specify whether to use 2D or 3D mode (Option-Command-C).

New Light: Adds a new light to the project, and lets you specify whether to use 2D or 3D mode (Shift-Command-L).

New Drop Zone: Adds a new drop zone to your project. Drop zones allow you to quickly replace footage in a project by dropping clips directly onto the Canvas. A drop zone appears as a rectangle with a gradient circle in its center. The drop zone’s layer name appears in the center of the drop zone. Any media item dragged and dropped into the region defined by the drop zone object automatically replaces the drop zone placeholder graphic. When media is dragged over the drop zone, a highlight appears around the drop zone area (Shift-Command-D).

Bring to Front: Moves the selected object to the top of the layers within a group (Command-}).
**Send to Back:** Moves the selected object to the bottom of the layers within a group (Command-\`).

**Bring Forward:** Moves the selected object upward in the Layers tab by one object (Command-\`).

**Send Backward:** Moves the selected object downward in the Layers tab by one object (Command-\`).

### Alignment Submenu

This menu contains all of the commands for aligning and distributing multiple objects within the Canvas. For more information on arranging objects within the Canvas, see “Using Object Alignment Commands” on page 268.

**Align Right Edges:** Moves the selected objects so that their right edges line up with the rightmost edge in the selection.

**Align Top Edges:** Moves the selected objects so that their top edges line up with the topmost edge in the selection.

**Align Bottom Edges:** Moves the selected objects so that their bottom edges line up with the bottommost edge in the selection.

**Align Far Edges:** In 3D mode, aligns the farthest edges of each object along the Z (depth) axis.

**Align Near Edges:** In 3D mode, aligns the nearest edges of each object along the Z (depth) axis.

**Align Horizontal Centers:** Lines up the selected objects on their horizontal center points.

**Align Vertical Centers:** Lines up the selected objects on their vertical center points.

**Align Depth Centers:** Lines up the selected objects on their Z (depth) center points.

**Distribute Lefts:** Spreads the selected objects evenly between the leftmost and rightmost objects based on their left edges.

**Distribute Rights:** Spreads the selected objects evenly between the leftmost and rightmost objects based on their right edges.

**Distribute Tops:** Spreads the selected objects evenly between the topmost and bottommost objects based on their top edges.

**Distribute Bottoms:** Spreads the selected objects evenly between the topmost and bottommost objects based on their bottom edges.
Distribute Far: Spreads the selected objects evenly between each object’s nearest point.

Distribute Near: Spreads the selected layers evenly between each object’s farthest point.

Distribute Horizontal Centers: Spreads the selected objects evenly between the leftmost and rightmost objects based on their horizontal center points.

Distribute Vertical Centers: Spreads the selected objects evenly between the topmost and bottommost objects based on their vertical center points.

Distribute Depth Centers: Spreads the selected objects evenly between the nearest and farthest objects, based on their Z (depth) center points.

Group: Combines the selected objects into a group (Shift-Command-G).

Ungroup: Removes the grouping so you can manipulate the objects individually (Option-Command-G).

Active: Toggles whether or not an object is active. When an object is not active, it doesn’t appear in the Canvas and doesn’t appear in the final output. When the selected item is active, the menu item has a checkmark beside it (Control-T).

Solo: Soloing an object hides all other objects in the project. When the selected item is soloed, the menu item has a checkmark beside it (Control-S). You cannot solo a camera or light.

Note: You can also Control-click an object in the Layers tab and choose Solo from the shortcut menu.

Isolate: Isolating an object sets the object back to its original orientation. For example, if you want to apply a mask to or rotoscope a layer that has been transformed in 3D space, you can isolate the layer so that it is displayed in its original orientation (2D, facing the front of the project).

Isolate is only available in projects that contain a camera. When an object can be isolated, a small Isolate button appears in the Layer tab. Click the button to isolate the object. When you isolate an object, the object name appears in the Camera menu in the Canvas as the name of your current view. Isolating a camera activates that camera’s view.

Lock: Locking an object prevents any changes from affecting that object. When the selected item is locked, the menu item has a checkmark beside it (Control-L).
Unsolo Submenu
This submenu lets you turn a soloed object back to its normal state. There are three choices: Video Only (Control-Shift-S), Audio Only, or Video and Audio. This menu item is only available when a currently soloed object is selected.

3D Group: Changes the selected group to a 3D group. Deselecting the menu option changes the group back to a 2D group (Control-D).

Blend Mode Submenu
This submenu sets the blend mode for the selected layer. A layer can only have one blend mode set at a time. The current setting is indicated with a checkmark beside the menu item. For examples of the various blend modes, see “Using Blend Modes” on page 290.

Add Image Mask: Adds a mask to the selected layer (Shift-Command-M).

Add Keyframes: Adds a keyframe to the currently selected object. The menu changes to reflect the type of keyframe you are adding, such as Add Position Keyframe, Add Scale Keyframe, and so on (Control-K).

Convert to Keyframes: This command can only be chosen when the selected object or objects have behaviors applied. All behaviors are reproduced as keyframes on the parameters that they affect (Command-K).

Make Particles: Uses the selected layer as a cell source for a new particle emitter (E).

Replicate: Replicates the selected layer (L).

Make Clone Layer: Creates a clone of the selected layer or group. In a motion graphics project, sometimes it is necessary to reuse a complex object in other parts of the project multiple times. Although you can duplicate or cut and paste any object, if you update the original, none of the changes you make are applied to the copies. It can become a tedious and difficult management task. Making clone layers instead of duplicates lets you control all the copies by modifying the original and also improves project playback and rendering performance.

Each cloned item is copied and named “Clone Layer,” “Clone Layer 1,” and so on. When you clone a layer, the cloned layer is placed in its original group. When you clone a group, a new group is created that contains the clone. Cloned items are identified in the Layers list with an icon for a cloned layer and an icon for a cloned group.

For more information, see “Making Clone Layers” on page 283.
Reveal Source Media: Opens the Media tab and highlights the item that corresponds with the selected item in the Canvas or Timeline. The Inspector is also updated to reveal the properties of the source media (Shift-F).

Favorites Menu
The Favorites menu remains empty until you create your own favorite effects. Once you have created favorites and stored them in the Favorites Menu folder in the Library tab, they appear in the Favorites menu, grouped by type.

Show Favorites Menu Items: Opens the Library and displays the Favorites Menu folder.

View Menu
The View menu contains commands for controlling the Motion interface. Most of these items affect the Canvas, but some also apply to the Timeline and other panes.

Zoom In: Zooms into the Canvas (Command-equal sign).

Zoom Out: Zooms out of the Canvas (Command-hyphen).

Zoom Level Submenu
This submenu lets you set a particular zoom level, or automatically zooms your Canvas in or out to fit the entire width of the Canvas window (Shift-Z).

Zoom Time View Submenu
This submenu allows you to automatically zoom the contents of the Timeline.

To Project: Zooms your Timeline so the entire duration of the project fills the window.

To Play Range: Zooms your Timeline so the area between the project In and Out points fills the window.

Full Screen Mode: Fills your entire monitor with the Canvas (with the Timing and Project panes hidden). In this mode, you can do all normal Canvas operations including playback. To leave Full Screen mode, choose the menu item again (F8).

External Video: Sends output to an external video monitor (Command-F1 or F12).

Correct for Aspect Ratio: Adjusts the display of the Canvas to simulate the nonsquare pixels that appear on a TV monitor.

Show Full View Area: Toggles the display of layers that are completely off or partially off the edges of the Canvas. Areas that are off the edges of the Canvas appear semi-transparent by default.
3D View Submenu
This submenu sets the view to a scene camera or default camera view in a 3D project. A scene camera is a camera that you add to a project. A default camera view is a built-in camera view, such as Perspective, Right, or Top. This menu is identical to using the Camera menu in the upper-left corner of the Canvas. For more information on cameras and views, see “3D Compositing” in the Motion Supplemental Documentation PDF.

Note: Because project elements are 2D (flat) objects, the elements are not visible when you use the orthogonal camera views unless the elements are rotated in 3D space (or text, particles, or the replicator are using the Face Camera parameter in their respective inspectors). This is because orthogonal views are at right angles (perpendicular) to the elements. When an object is selected, a thin gray line represents the object in the Canvas.

Active: Shows the view from the active camera.

Perspective: Shows the perspective camera view. The perspective view defaults to a view from the front center. Use the 3D View tools to pan, orbit, or dolly the camera.

Front: Shows the front camera view. Use the 3D View tools to pan, orbit, or dolly the camera.

Back: Shows the back camera view (the view from the back of the scene). Use the 3D View tools to pan, orbit, or dolly the camera.

Left: Shows the left camera view (the view from the left of the scene). Use the 3D View tools to pan, orbit, or dolly the camera.

Right: Shows the right camera view (the view from the right of the scene). Use the 3D View tools to pan, orbit, or dolly the camera.

Top: Shows the top camera view (the view from the top of the scene). Use the 3D View tools to pan, orbit, or dolly the camera.

Bottom: Shows the bottom camera view (the view from the bottom of the scene). Use the 3D View tools to pan, orbit, or dolly the camera.

Next Camera: When the Canvas is active, changes your view to the next scene camera based on camera order in the Layers tab (Option-C).

Reset Camera View: Resets the camera view to its default orientation (Option-R).

Channels Submenu
This submenu sets the Canvas to display individual color or transparency channels. Current settings are indicated with a checkmark beside the item in the menu. This menu is identical (with the exception of a toggle option) to the Color menu in the Status Bar.
**Color:** Shows the image just as it would appear on a video monitor. Visible layers appear in natural color and transparent areas reveal the background color as set in the Project Properties (Command-J). This is black by default.

**Transparent:** Shows the background area of the Canvas as transparent. A checkerboard pattern appears by default where no images block the background.

**Alpha Overlay:** Displays the image in normal color, but adds a red highlight over transparent areas of the image.

**RGB Only:** Displays the normal mix of red green and blue channels but transparent areas (including semi-transparent areas) are treated as opaque.

**Red:** Sets the Canvas to display only the red channel as a range of black to white (Shift-R).

**Green:** Sets the Canvas to display only the green channel as a range of black to white (Shift-G).

**Blue:** Sets the Canvas to display only the blue channel as a range of black to white (Shift-B).

**Alpha:** Sets the Canvas to display the alpha (transparency) channel of the layers in the Canvas (Shift-A).

**Inverted Alpha:** Sets the Canvas to display an inverted view of the alpha (transparency) channel (Option-Shift-A).

**Toggle Current & Alpha:** Switches back and forth between viewing the current state and just the alpha channel (V).

**Resolution Submenu**
This submenu sets the quality level of the Canvas. Reducing the resolution improves playback performance. Choose from Full, Half, Third, and Quarter resolution. Each lower setting further degrades the image. The current setting is indicated with a checkmark beside the menu item.

**Render Quality:** Sets the display mode for objects in the Canvas, such as text and images, to Draft, Normal, or Best.

- **Draft:** Renders objects in the Canvas at a lower quality to allow optimal project interactivity.
- **Normal:** The default setting, renders objects in the Canvas at a medium quality.
- **Best:** Renders objects in the Canvas at Best quality. This option slows down project interactivity.

**Note:** 10-bit YUV files render at 8-bit in the Canvas unless Render Quality is set to Best.
Tip: When exporting a project using the “Movie - current project and Canvas settings” option (from the Use pop-up menu in the Export dialog), set Render Quality to Best prior to exporting.

Lighting: Turns off lighting to improve performance. When lighting is enabled, a checkmark appears beside the menu item (Option-L).

Field Rendering: Turns off field rendering to improve performance. When field rendering is enabled, a checkmark appears beside the menu item (Option-F).

Motion Blur: Turns off motion blur rendering to improve performance. When motion blur rendering is enabled, a checkmark appears beside the menu item (Option-M).

Frame Blending: Turns off frame blending to improve performance. When frame blending is enabled, a checkmark appears beside the menu item (Control-Option-B).

Preview Float Bit Depth: When working in float space, turning this setting off drops the preview in the Canvas to 8-bit. Because working in float space drastically increases processing time, turn this setting off to speed your workflow. This setting does not modify the actual output of the project.

Note: 10-bit YUV files render at 8-bit in the Canvas unless Render Quality is set to Best.

Show Overlays: Turns the display of all overlays on and off in the Canvas. This setting must be on in order to view any of the other overlay items (grids, guides, and so on). When Show Overlays is active, a checkmark appears beside the menu item (Command-/).

Show Rulers: Turns display of rulers in the Canvas on and off. When rulers are visible, a checkmark appears beside the menu item (Shift-Command-R).

Overlays Submenu
This submenu turns the various indicators, guides, and grids in the Canvas on and off.

Grid: Turns the display of a grid on and off. You can customize the grid in the Canvas pane of Motion Preferences. When the grid is displayed, a checkmark appears beside the menu item (Command-apostrophe).

Guides: Turns the display of guides on and off. When guides are visible, a checkmark appears beside the menu item (Commandsemicolon).

Dynamic Guides: Turns dynamic guides on and off. Dynamic guides are the lines that appear when you drag one item into alignment with another layer. When dynamic guides are enabled, a checkmark appears beside the menu item (Shift-Commandsemicolon).

Note: To quickly turn dynamic guides off and on, press N.
**Safe Zones:** Turns the display of title safe and action safe guides on and off. You can customize the safe zones in the Canvas pane of Motion Preferences. When safe zones are displayed, a checkmark appears beside the menu item (apostrophe).

**Film Zones:** Turns display of film-based aspect ratio guides on and off. You can customize the film zones in the Canvas pane of Motion Preferences. When film zones are displayed, a checkmark appears beside the menu item (Shift-apostrophe).

**Handles:** Turns the display of object handles in the Canvas on and off. The handles are the corner points that let you manipulate an object. When handles are displayed, a checkmark appears beside the menu item.

**Lines:** Turns the display of object border lines on and off. When lines are displayed, a checkmark appears beside the menu item.

**Animation Path:** Turns display of keyframe animation paths on and off. Animation paths are the lines that show where an object moves in the Canvas. When animation paths are displayed, a checkmark appears beside the menu item.

**Guides Submenu**
This submenu lets you control the guides in the Canvas.

**Lock Guides:** Causes all guides to be fixed in their current position. This prevents you from accidentally moving a guide instead of moving an object (Option-Command-semicolon).

**Unlock Guides:** Releases guides to be manually manipulated.

**Clear Guides:** Removes all guides from the Canvas.

**Add Vertical Guide:** Adds a vertical guide to the Canvas.

**Add Horizontal Guide:** Adds a horizontal guide to the Canvas.

**Snap:** Turns object snapping on and off in the Canvas. Snapping automatically aligns objects as you drag them. When snap is enabled, a checkmark appears beside the menu item (N).

**Show 3D Overlays:** Turns all 3D overlays off, including the 3D View tools, 3D Compass, Inset view, 3D grid, and 3D scene icons.

**3D Overlays Submenu**

**3D View Tools:** Turns the Camera menu and 3D View tools on and off.

**Compass:** Turns the 3D Compass on and off. The compass shows your current orientation in 3D space. The red axis is X (horizontal), the green axis is Y (vertical), and the blue axis is Z (depth).
When you pause the pointer over the compass, it changes to a 3D View Selector. Click over any of the colored view icons, such as front, left, right, perspective, and so on to switch to that view. The Canvas animates the view change as it changes to the new view.

**Inset View:** Turns the Inset view on and off. When enabled, a temporary window appears in the lower-right corner of the Canvas and displays a perspective or active camera view of your project that helps you stay oriented as you move objects in 3D space. You can change the size of the Inset view, as well as control whether the Inset view appears on transform changes, on all changes, or manually.

**3D Grid:** Turns the 3D grid on and off. The 3D grid helps you stay oriented while working in 3D space and can be used to guide the placement of objects in your project. The 3D grid only appears when you are in 3D mode.

**3D Scene Icons:** Turns all 3D scene icons on and off, such as lights and cameras. The scene icons appear in the Canvas as wireframe icons, and each includes red, green, and blue handles that let you transform and rotate the camera or light.

**Show/Hide Fonts:** Displays (or hides) the Font dialog for selecting fonts and font attributes (Command-T).

**Show/Hide Colors:** Displays (or hides) the Colors window for selecting colors (Shift-Command-C).

**Show/Hide Toolbar:** Toggles display of the Toolbar. This is equivalent to clicking the Toolbar button at the upper-right corner of the Canvas (Option-Command-T).

**Customize Toolbar:** Opens the Customize Toolbar dialog.

**Window Menu**
This menu contains controls to show and hide all of the windows, panes, and tabs in the Motion interface. You can also choose and manage window layout sets.

**Minimize:** Shrinks the active window to the Dock. This is equivalent to clicking the Minimize button at the upper left of the window (Command-M).

**Zoom:** Resizes the active window to maximize desktop real estate. Toggles between full screen and the previously saved non-full screen state.

**Save Current Layout:** Stores the current window arrangement. Choosing this option requires you to name the layout you want to save. The new layout appears in the Layouts submenu.

**Manage Layouts:** Opens the Manage Layouts dialog where you can add, delete, duplicate, and modify custom window layouts.
**Layouts Submenu**
This submenu is where you can choose from existing window layouts. Choose one of the layouts from the submenu to rearrange your windows to that pre-saved state. For more on managing window layouts, see “Window Arrangements” on page 23.

**Create Locked Inspector:** Creates a new Inspector window that doesn’t update based on the selection. To unlock the Inspector, click the lock in the Preview area of the Inspector.

**Show Inspector Submenu**
This submenu provides direct access to any of the four tabs in the Inspector window: Properties (F1), Behaviors (F2), Filters (F3), and Object (F4). The Object tab changes depending on what type of object is selected.

**Show/Hide Project Pane:** Toggles the display of the Project pane (F5).

**Show/Hide Timing Pane:** Toggles the display of the Timing pane (F6).

**Show/Hide HUD:** Toggles the display of the HUD (F7).

**Show/Hide Task List:** The Background Task List displays any background processing when Motion performs optical flow retiming.

**File Browser:** Toggles the display of the File Browser. If the utility window is not present, one is created. If the File Browser is the only tab in the utility window, this command closes the window (Command-1).

**Library:** Toggles the display of the Library. If the utility window is not present, one is created. If the Library is the only tab in the utility window, this command closes the window (Command-2).

**Inspector:** Toggles the display of the Inspector. If no utility window is present, one is created. If the Inspector is the only tab in the utility window, this command closes the window (Command-3).

**Layers:** Toggles the display of the Layers tab. If the Project pane is not visible, this command causes it to appear. If Layers is the only tab in the Project pane, this command closes the pane (Command-4).
Media: Toggles the display of the Media tab. If the Project pane is not visible, this command causes it to appear. If Media is the only tab in the Project pane, this command closes the pane (Command-5).

Audio: Toggles the display of the Audio tab. If the Project pane is not visible, this command causes it to appear. If Audio is the only tab in the Project pane, this command closes the pane (Command-6).

Timeline: Toggles the display of the Timeline. If the Timing pane is not visible, this command causes it to appear. If the Timeline is the only tab in the Timing pane, this command closes the pane (Command-7).

Keyframe Editor: Toggles the display of the Keyframe Editor. If the Timing pane is not visible, this command causes it to appear. If the Keyframe Editor is the only tab in the Timing pane, this command closes the pane (Command-8).

Audio Editor: Toggles the display of the Audio Editor. If the Timing pane is not visible, this command causes it to appear. If the Audio Editor is the only tab in the Timing pane, this command closes the pane (Command-9).

Bring All to Front: If any Motion windows are hidden behind windows from other applications, this command moves the windows to the front.

Open Project List: All open projects appear at the bottom of the Window menu. Choosing an item from this list brings that project’s Canvas to the front.

Help Menu
The Help menu provides access to resources for learning more about Motion.

Motion User Manual: Opens the Motion User Manual in PDF format.

Release Notes: Opens a webpage with a file containing last-minute release information about Motion, as well as changes to the documentation that may affect your use of the software.

New Features: Opens the New Features document in PDF format.

Motion Support: Opens a webpage that contains up-to-date technical support information about Motion.

Motion on the Web: Opens a web link to the Apple Motion online community. This site contains additional tutorials, training resources, information about product updates, and other information.

Apple Training Centers: Opens a link to the Apple Training Centers webpage, where you can find information about Apple-authorized training in your area.
Feedback: This link takes you directly to the Motion feedback page, where you can provide Apple with your valuable insights, suggestions, and feedback about your experience with working in Motion.

Create Support Profile: Generates a special file describing the technical details about your workstation such as processor speed, video card specifications, and so on. This file is used only by authorized Apple technical support technicians.
Creating and Managing Projects

Learn how to create, save, and manage project files. In addition, learn how different kinds of objects are put together inside a project to create a composition.

A project file consists of a single composition that you are working on. Project files contain objects, which are linked references to source media files on disk, but they contain no media themselves. Project files simply house information about how a composition is assembled, what media files on disk are used, and what effects from the Library have been applied. They also contain any shapes, masks, and text objects that you create.

Creating New Projects

Before you can do anything in Motion, you first need to create a new project. Depending on the type of project you are working on, there are three ways to do this. You can base your composition on one of the supplied templates, you can create a new blank project using one of the available project presets, or you can create a new project using your own custom settings if you need an unusual frame size or frame rate.

Motion is resolution independent, meaning that it supports projects using a wide range of frame sizes and frame rates. Using Motion, you can create small movies for streaming on the web, standard- and high-definition movies for broadcast, or even film resolution files for film output. Regardless of the resolution at which you’re working, Motion works exactly the same, although high-resolution projects using large media files may have higher memory and graphics card requirements than projects with smaller resolutions.

Important: Motion is hardware dependent. This means that the type of graphics card installed on your system dictates performance and the maximum file size that you can import into Motion. For most recommended cards, the file size limit is 2 K. For more information, visit the Motion website at http://www.apple.com/finalcutstudio/motion.
Each project has a single group of project properties that define the duration of the project, the size of the Canvas, the frame rate of playback, and other details that affect how your composition is formatted. Later, when you have finished your project and you’re ready to export it, the project properties you select define the media file that is created. Although you can change these settings at any time, it’s best to choose the settings that match your final planned output format.

Regardless of your project settings, Motion still allows you to add nearly any kind of media file supported by QuickTime to your project. Furthermore, you’re free to mix media files with different properties in the same project. For example, you can combine video clips of different frame sizes with graphics files. In the end, the file you output uses the frame size and frame rate specified by the project properties.

**When Motion First Opens**

The first time you open Motion, a Welcome Screen presents you with two ways to create a new project. You can click Start with a Template to open the Template Browser, or you can click Start with a New Project to create a new blank project file.

By default, this screen always appears when you open Motion. If you don’t want to see this screen at startup, you can uncheck the “Show the Welcome Screen at startup” checkbox at the bottom, or you can choose a different startup option from the At Startup pop-up menu in the General pane of Motion Preferences. You can choose from the following options:

**Open Last Project(s):** Automatically opens the last project(s) you worked on, whenever Motion is opened.

**Create New Project:** Opens the Select Project Preset dialog, allowing you to pick a preset to use to create a new, blank project file. If a default project preset is set, this dialog does not appear.

**Show Welcome Screen:** Shows the Welcome Screen every time Motion is opened.
Browse Templates: Opens the Template Browser, allowing you to pick a template to use.

For more information about options available in Motion Preferences, see “Preferences” on page 137.

Creating New Projects from Templates
The easiest way to create a new project in Motion is to open one of the existing templates and customize it for your own purposes. Motion templates are simply pre-made projects, available from the Template Browser, that are set up for easy customization. Motion comes with a variety of royalty-free templates that you can use and customize. Each template contains pre-made graphics, text objects, and backgrounds that you can use as is, or exchange with your own custom objects to make the design your own.

Eventually, you can extend this collection by creating your own templates of frequently used layouts. For example, if you regularly create titles and graphics sequences for a television series, you can create a group of templates for the show that contains layouts for every motion graphics shot you need. For future shows, you can then open these existing templates and customize them with updated text and graphics, without needing to recreate each layout from scratch.

The templates that come with Motion are available in NTSC, PAL, and HD resolutions. All templates are organized by themes.

To create a new project from a template:
1. To open the Template Browser, do one of the following:
   • When the Motion Welcome Screen opens, click Start with a Template.
   • If Motion is already open, choose File > Open Template (or press Shift-Command-O).
2. When the Template Browser appears, use the Show pop-up menu to see templates that have been optimized for a specific video format, including NTSC, PAL, or HD.
You can also choose to show All formats or Other formats.

The Theme list shows all templates of the selected type.

3 Click a template theme to display its contents at the right.

4 Click an individual template to see a preview of it in the preview area, along with additional information including its resolution, duration, and frame rate.

5 To create a new project from the selected template, click Open Template.

A new project is created using the objects contained in that template. You can then customize the project by editing the text objects or exchanging the graphic elements it uses with your own. The changes you make to projects created using templates are not saved back to the source template file.

For more information about using, modifying, and creating templates, see “Customizing and Creating New Templates” on page 250.

**Creating Blank Projects from Project Presets**

If you're creating a new project from scratch, but the final result is going to conform to one of the common standards for web delivery, broadcast, or film output, you can use one of the project presets that ships with Motion. Unlike a template, choosing a preset only defines the essential properties of the project, such as the frame size and frame rate. The resulting project is completely empty, ready for you to add your own objects.
Because you can have as many open project files in Motion as the amount of RAM in your computer supports, you can create a new project at any time without having to close projects that are already open.

**To create a new project:**


2. Choose a preset from the pop-up menu, then click OK.

A new project window is created. It is not saved to disk until you choose a save command from the File menu. For more information on saving project files, see *“Saving Projects”* on page 191.

**Note:** If you have already set a default preset, Motion will open a new project window at that resolution, bypassing the Select Project Preset dialog.

### Creating Blank Projects with Custom Settings

If none of the available presets meets your needs, you can create a new project with custom project settings from the same window.

**To create a new project with custom project settings:**


   **Note:** If you have already set a default preset, hold down the Option key and choose File > New From Preset (or press Option-Command-N).

2. Choose Custom from the bottom of the Preset pop-up menu, then click OK.

   The Project Properties dialog appears.
Choose the appropriate settings in the General and Render Settings tabs, then click OK. A new project window is created using the settings you specified.

**General Tab of the Project Properties Dialog**
The General tab allows you to define the most essential properties of the project you're creating. By choosing different parameters, you can accommodate nearly any video or film format you need to output to. These properties are the default settings used when you export your project to create the final output file.

The General tab contains the following settings:

**Preset:** The Preset pop-up menu appears at the top of the General tab. You can choose an existing preset to base your new preset on, changing any necessary parameters to better suit your needs.

**Width and Height:** Define both the size of the Canvas and the default output resolution of your project. Frame size is usually defined by the video format you plan on outputting to. For example, NTSC DV format video is 720 x 480, whereas PAL DV format video has a frame size of 720 x 576.

**Bit Depth:** Sets the bit depth of the project to one of the following:
- 8-bit (Integer)
- 16-bit Float
- 32-bit Float

*Note:* When working in float space, you can quickly change the preview in the Canvas to 8-bit to speed your workflow by turning off Preview Float Bit Depth in the View pop-up menu. The View pop-up menu is located in the upper-right corner of the main window (below the Timing icon). This setting does not modify the actual output of the project.
About Bit Depth

When working with images, an increase in bits per pixel for those images means more color information becomes available. A one-bit-per-pixel bitmap image is comprised of purely black or white image pixels (no shades of gray).

A grayscale image comprises image pixels with 256 levels of gray. Each pixel requires 8 bits to represent the 256 shades of gray. Therefore, the bit depth of a grayscale image is 8 \(2^8 = 256\).

An RGB image can comprise image pixels with 256 shades of each of the primary colors—red, green, and blue. In this case, there are \(2^8\) (256) shades of each color component. This creates more than 16.7 million possible colors \((256 \times 256 \times 256 > 16.7\) million). The bit depth of an RGB image can be 24 (8 bits for each color), and the bit depth of an RGBA image (red, green, blue, and an alpha channel) can be 32 (8 bits for each color + alpha channel). The bit depth of an alpha channel describes the transparency of each pixel. Although these images are 24- and 32-bit, such color images are often referred to as 8-bit (because of the 8 bits per channel).

*Note:* An RGB image does not necessarily imply 8 bits per pixel.

Motion’s bit depth setting is bits-per-channel. In an 8-bit Motion project, the 256 levels of color are represented on an integer scale of 0–255 (where 0 represents black and 255 represents white). All of your operations are clamped within that 0–255 range. There is a one-to-one ratio between each number and its represented color. In 8-bit mode, 16.7 million colors can be represented—equalling the number of possible combinations of 256 different color values from each Red, Green, and Blue channel. Although that is a large number of colors, it is often helpful to have finer gradations of colors available. Using floating point calculations, color shades can be subdivided into an enormous amount of intermediate colors, providing orders of magnitude more colors available to your project palette. Incredibly small increments of color can be represented in 16-bit float, and even finer increments in 32-bit float.

The bit depth of your source footage will often determine the bit depth of your project. Even if your source footage is 8-bit, you may want to work in a project with a higher bit depth to achieve better results. When you increase the bit depth of your project, you are not introducing any new color information to the original images. However, operations such as keying, color correction, applying blur or other filters with high parameter values, or creating graphics that require very smooth color gradients can benefit from the new number of possible color levels.

*Important:* There is a price for working in higher bit depths, however. And that price is paid in processing time. Remember also that because Motion is hardware dependent, most systems have a limitation on the size of imported files. For more information on the required hardware, visit the Motion website at [http://www.apple.com/finalcutstudio/motion](http://www.apple.com/finalcutstudio/motion).
When exporting a 16-bit or 32-bit float project, keep in mind that most file formats available for export do not support float—including QuickTime (8-bit only). OpenEXR is float format. TIFF, PNG, and Adobe Photoshop files support the 16-bit integer format.

Note: Depending on your project, dithering can be useful or problematic. For example, enabling dithering in a project in which banding is present may reduce the appearance of the banding. In a float project, dithering may cause excessive noise in the project’s output. For this reason, a checkbox has been added to the Project Properties dialog (choose Edit > Project Properties or press Command-J) that allows you to turn dithering on or off. This setting applies to the display and export of a project.

Pixel Aspect Ratio: Defines whether the project is created using square or nonsquare pixels. Computer displays, film, and high-definition video use square pixels, while standard-definition video uses nonsquare pixels. Choose Square for projects intended for the web, high-definition projects, and film, or one of the nonsquare pixel ratios corresponding to each international standard-definition broadcast standard. A field to the right of this pop-up menu displays the numerical aspect ratio, in case you need to manually change it.

Field Order: When working with interlaced video, choose the field order you plan on using for eventual output from this pop-up menu. This should match the field order of the device being used to output the resulting QuickTime file to video. When working with progressive-scan video or film, choose None.

Frame Rate: Choose a frame rate (in frames per second) that matches the format you’ll eventually be outputting to. For example, film is 24 fps, PAL video is 25 fps, and NTSC video is 29.97 fps. Additional frame rates are available for different video formats.

Duration: Allows you to enter the total duration available in your project’s Timeline. A pop-up menu allows you to define the duration with either a timecode value based on the currently selected frame rate, a frame count, or in seconds. The default value is 900 frames, or 30 seconds.

Start Timecode: This value sets the start timecode for display while working in the project.

Background Color: A color well that defines the color that appears in the Canvas if no other graphic or QuickTime object is present.

Background: A pop-up menu that defines whether the Background Color is rendered as part of the alpha channel. If set to Solid, the background color creates a solid alpha channel. If set to Transparent, the background color does not render as part of the alpha channel. In either case, the Background Color is visible in the Canvas.
Project Description: A field into which you can enter a brief description of the project. It may also be useful to call out significant characteristics of that particular preset such as frame size or frame rate.

For more information about commonly used frame sizes, frame rates, interlacing, and other project setting information, see “Video and File Formats” on page 1203.

Render Settings Tab of the Project Properties Dialog
The Render Settings tab contains parameters that affect how Motion renders the objects and animation in your project. These settings can affect how your project looks when exported.

Motion Blur: Simulates the effect a camera’s mechanical shutter has on a frame of film or video when either the camera or its subject is moving. In Motion, motion blur affects objects in your project that are animated using behaviors or keyframes. This allows you to create more natural-looking motion in your project, even though the animation is artificially created. As with a camera, faster objects have more blur, whereas slower objects have less.

Important: Unlike Final Cut Express HD or Final Cut Pro, blur created by these parameters does not affect motion that occurs within a QuickTime movie file or an image sequence. It only affects animated objects.
The motion blur section has two parameters:

- **Samples**: The number of sub-frames rendered per frame, where 1 frame is 360 degrees. Higher Samples values result in a higher-quality motion blur effect, but are more processor intensive. The default Samples value is 8. The maximum possible value is 256.

The following image shows a shape that has been keyframed to move quickly across the Canvas horizontally.

In the next image, Motion Blur is enabled and Samples is set to the default value of 8.

*Note*: When using larger Shutter Angle values, it may be necessary to increase the Samples value to eliminate unwanted artifacts.

- **Shutter Angle**: Defines the size of the motion blur that appears for animated objects. Increasing the shutter angle increases the number of frames over which the shutter is open.

In the above image, the Shutter Angle is set to the default of 360 degrees, which represents 1 frame. In the following image, Shutter Angle is set to 600 degrees.
Creating, Editing, and Deleting Presets

If you commonly create projects using custom settings that don’t match any of the available presets, you can create a new preset with these settings for future use. Presets are created, modified, and deleted in the Presets pane of Motion Preferences.

To create a new custom preset:

1. Choose Motion > Preferences (or press Command-comma).
2. In the Presets pane, choose Project Presets from the Show pop-up menu.
3. Click the Add button (+) beneath the presets list.
   
   The Project Preset Editor dialog appears.

4. In the Project Preset Editor dialog, do the following:
   - In the Name field, type a descriptive name for the preset.
   - Enter a brief description of what that preset is for. It may also be useful to call out significant characteristics of that particular preset, such as frame size and frame rate.
   - Enter a frame size into the Width and Height fields.
   - Choose a Pixel Aspect Ratio, Field Order, and Frame Rate from the corresponding pop-up menus.

5. Click OK.
If you’re done creating new project presets, close the Motion Preferences window.

*Note:* For more information on industry-standard frame sizes, pixel aspect ratios, field order, and frame rates, see “Video and File Formats” on page 1203.

**To choose a custom preset to be the new default,** do one of the following:
- In the Presets pane of Motion Preferences, click the checkbox to the left of the preset you want to be the default for all newly created projects.
- Choose File > New to display the Select Project Preset dialog. Choose a project preset from the Preset pop-up menu, then click Set as Default.

You can also edit existing presets. This allows you to update a preset you’ve already created, or to make a new preset by customizing an existing one with similar settings.

**To duplicate an existing preset prior to editing it:**
1. In Motion Preferences, select a preset in the Presets pane.
2. Click Duplicate.
   
   The duplicated preset appears underneath the original preset.

**To edit an existing preset:**
1. In Motion Preferences, select a preset in the Presets pane.
2. Click Edit.
3. When the Project Preset Editor dialog appears, make any necessary changes, then click OK.

   *Note:* You cannot edit or delete locked project presets.

**To delete a custom preset:**
1. In Motion Preferences, select a preset in the Presets pane.
2. Click the Delete button (–) underneath the presets list.

   *Note:* You cannot unlock a preset that is built into Motion. When the preset is double-clicked, an alert appears stating that the selected preset cannot be modified. To create a copy of the preset that you can customize, click OK.

**Moving Presets Between Computers**
Each preset you create is saved as a separate file. If you’ve created one or more custom presets that you rely on, you may want to move them to other computers you use that have Motion installed. All user-created presets are stored in the `/Users/username/Library/Application Support/Final Cut Studio/Motion/Presets/Project` folder.

**To copy a project preset to another computer:**
- Copy your custom preset files to that computer’s `/Users/username/Library/Application Support/Final Cut Studio/Motion/Presets/Project` folder.
Managing Projects
When you work on a project in Motion, it’s important to be organized. This includes keeping careful track of your project files, saving often, and maintaining regular backups. The idea is to make sure that nothing gets accidentally misplaced or deleted, and that you don’t lose work by losing your valuable digital resources. Motion also autosaves projects that can be retrieved at any time.

Saving Projects
As with any application, it’s a wise practice to save early and often as you work on your project. This way, you don’t lose work due to unforeseen circumstances such as a blackout occurring just as you were about to finish your latest animated masterpiece.

Besides preserving your work for future use, Motion’s save commands can be used in other ways to manage the development of your project. For example, if you’re happy with your current composition, but you want to create a variation of what you’ve done, you can use the Save As command to save a copy of the current project. You can then freely alter this duplicate, leaving your original project alone in case you don’t like your changes.

You can also use the Save As command as an archival tool, saving individually named copies of your project periodically over the course of its creation. This serves two purposes. First, it ensures that you have duplicates of your project file, protecting you from inadvertently misplacing your only copy and losing days of work. Second, it also gives you a way to go back to previous versions of your composition, in the event that you or your client want to make a change based on an earlier point in that project’s development.

To save a project:
1 Choose File > Save (or press Command-S).
   If the project has not already been saved, the Save As dialog appears.

2 Type a name into the Save As field, choose a location on your hard drive to save the file, then click Save.
   Note: If the project has already been saved, the project file is simply updated.
To save a duplicate of a project:
1 Choose File > Save As (or press Shift-Command-S).
   The Save As dialog appears.
2 Type a new name into the Save As field, choose a location on your hard drive, then click Save.

   Important: When using the Save As command, it’s important to use a name that is different from the name of any previously saved versions of the same project. Otherwise, you run the risk of overwriting a previous version of this project file that you want to keep. You’ll be warned if this happens.

To save all open projects:
1 Press Option, then choose File > Save All (or press Command-Option-S).
2 If all open project files have already been saved, the Save All command simply updates them. If any open project has not been saved, enter a name in its Save As field, then click Save.

   Note: The Save All command only appears when you press Option while opening the File menu.

Collect Media
When saving a project, Motion gives you the option to automatically gather together the media used in your project. The media is collected in a folder of your designation. The advantage to collecting your media is that it makes portability and backup easier, as well as organizing all your project media in a single place. By default, Collect Media is turned off.

To use the Collect Media save function:
1 Choose File > Save As (or press Command-Shift-S).
   The Save As dialog appears.

2 Choose Copy to Folder from the Collect Media pop-up menu.
   Choosing the Copy to Folder option creates a folder with the name specified in the Save As field. A Motion project file of the same name is created within that folder, as well as a folder named “Media,” which contains all the media used in the project.
   If the Collect Media option is used, you have the option to specify whether unused media are collected as well.
Using Autosave
Motion automatically saves backups of your project in a folder on your hard drive. In the Project pane of Motion Preferences, you can specify how frequently projects are automatically saved, as well as the location of the saved files. Saved projects are time- and date-stamped.

Use Autosave Vault: Instructs Motion to store autosaved projects to the location specified in the Autosave Vault Folder parameter.

Save a copy every: Specifies how often, in minutes, a project is saved.

Keep at most: Tells Motion how many versions of the autosaved project to store in the vault.

Maximum of: Tells Motion the maximum number of different autosaved projects to store in the vault.

To store autosaved projects in a specific location:
1 Choose Motion > Preferences (or press Command-comma).
2 Click Project.
3 In the Autosave group, turn on Use Autosave Vault.
   By default, the Autosave Vault folder is located in a folder called Motion Projects in your Documents folder in your home directory.

To set a new location for the Autosave vault:
- Click Choose and select a new location in the dialog.

To revert to an autosaved project:
1 Choose File > Restore From Autosave.
   The Restore Project dialog appears.
2 Choose a saved project from the pop-up menu.

Reverting Projects
The Revert command discards all changes you’ve made to a project since the last time you saved it. The Revert command is especially useful as a tool for trying out numerous changes in your project. You can save your project in the state you like it, then make all the changes you want. If you don’t like the result, use the Revert command to immediately go back to the way it was before.

Note: You can also use Motion’s unlimited undo feature to achieve the same purpose in incremental steps. For more information on the Undo command, see “Edit Menu” on page 161.

To revert a project to the last saved version:
- Choose File > Revert.
Opening and Closing Projects
You can open one or more previously saved project files either in the Finder or from within Motion. You can have as many projects open at the same time as the amount of RAM in your computer can support. Your computer’s RAM is divided up among the operating system, any other applications that are currently open, and all currently open documents. If, at any point, you notice a decrease in performance because you’ve run out of RAM, simply quit one or more other applications, or close one or more open projects to free up RAM for the remaining open projects.

To open one or more project files in the Finder, do one of the following:
- Double-click a Motion project file. Motion automatically opens with that project.
- Select one or more Motion project files, then drag them onto the Motion application icon either in the Applications folder or in the Dock, if you’ve placed one there.
- Select one or more Motion project files, then choose File > Open (or press Command-O) in the Finder.
- Select one or more Motion project files, Control-click one of them, then choose Open from the shortcut menu.

Motion automatically starts and opens all selected projects.

To open a project file from within Motion using the Open command:
1. Choose File > Open (or press Command-O).
   The Open dialog appears.
2. In the Open dialog, navigate to the project file you want, then click Open.

To open a project file from within the Motion File Browser:
1. In the File Browser, navigate to the project file you want and then select the file.
2. Do one of the following:
   - Double-click the project file.
   - In the Preview area, click the Import button.
   The project opens in a new Canvas.

Opening Recent Projects
Every project you open in Motion is automatically added to the Open Recent submenu in the File menu. You can choose a project from a list of projects that you’ve worked on recently from this submenu. Motion keeps the names of the previous projects you’ve worked on in the Open Recent submenu.

To open a recent project:
- From the File menu, choose a project’s filename from the Open Recent submenu.
  If the Open Recent submenu becomes too crowded, you can clear it out.
To clear the Open Recent submenu:
- Choose File > Open Recent > Clear Menu.

Managing Multiple Open Projects
Each open project is self-contained in its own window, and each has its own Layers, Media, Audio, Timeline, Keyframe, and Audio Editor tabs.

You can use the Exposé All Windows command (in Mac OS X v10.4 and later) to see all open project windows at once. For more information on how to use Exposé, see Mac Help, available in the Finder Help menu.

Closing Projects
You can close projects either one at a time, or all at once. You close projects by closing their project window (the window containing the Canvas).

To close a single project, do one of the following:
- Press Control-W to close the currently selected window.
- Click the Canvas window’s close button.

To close all open projects, do one of the following:
- Press Command-Option-W.
- Option-click the close button.

Note: Depending on the version, Option-clicking the close button to close all open projects may not work on your current operating system.

Moving and Archiving Motion Project Files
If you want to move a Motion project file to another computer, you must also move all the media that the project uses along with it, including all QuickTime, still image, and audio files. In addition, if your project uses any third-party Motion plug-ins or nonstandard fonts or LiveFonts, you need to make sure that those are also installed on the computer you’re moving the project to, or they’ll be unavailable to your project.

Similarly, when you’re finished with a project and you want to archive it, it’s a good idea to archive not just the project file, but also all media used (especially media that wasn’t captured from a device-controllable video or audio source), graphics, fonts, custom behaviors, filters, or third-party add-ons used by that project. In the event you want to restore the project for later revisions, you’ll have everything you need to get started quickly. If you have a recordable CD or DVD drive, backing up your media is easy. For more information on copying files to a recordable CD or DVD disc, see Mac Help in the Finder Help menu.

The easiest way to collect all the media used in your project is to use the Collect Media feature. See “Collect Media” on page 192.
**Note:** If you move a project to another computer without collecting, its media may go offline even though you've moved its media files along with it. For more information on how to relink media files to your project, see “Online Versus Offline Media” on page 220.

**Archiving QuickTime Video**

If you use QuickTime video clips in a Motion project that you want to archive for long-term storage, whether or not you also archive the video clips themselves depends on how they were captured. For example, if you captured your video using a device-controllable camcorder or deck with Final Cut Express HD or Final Cut Pro, archiving the video clips you used may be unnecessary. This is because you can always recapture them from the original source tapes using the Final Cut project file you logged them with. In this case, it's a good idea to back up the Final Cut Express HD or Final Cut Pro project file along with your Motion project file.

If you captured your video without device control, or if the video was captured by someone else and you no longer have the ability to recapture the clips exactly as they appear in your project, it's probably a good idea to back up these clips along with the rest of the graphics files, audio files, and fonts you used in your project.

**Unused Media**

By default, media used by objects added to your project are managed automatically by Motion. If you delete an object from the Canvas or Layers list, the source media is removed automatically from the Media tab. You can turn off this feature in the General pane of Motion Preferences.

**Searching for Projects Using the Finder**

Spotlight indexes certain properties of your Motion projects, allowing you to perform advanced searches. Use Spotlight in the Finder to take advantage of this feature. The following properties of Motion projects are indexed by Spotlight and can be searched for:

<table>
<thead>
<tr>
<th>Project property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Project width, in pixels</td>
</tr>
<tr>
<td>Height</td>
<td>Project height, in pixels</td>
</tr>
<tr>
<td>Duration</td>
<td>Project duration, in seconds</td>
</tr>
<tr>
<td>Layer name</td>
<td>The name of any layer in your project</td>
</tr>
<tr>
<td>Media name</td>
<td>The name of any media object in your project</td>
</tr>
<tr>
<td>Pathname</td>
<td>The path to any media object in your project</td>
</tr>
<tr>
<td>Text</td>
<td>The content of any text object in your project</td>
</tr>
<tr>
<td>Description</td>
<td>The text in the Project Description field in Project Properties</td>
</tr>
<tr>
<td>Marker name</td>
<td>The name of any marker in the Timeline of your project</td>
</tr>
<tr>
<td>Marker comment</td>
<td>The text of any marker comment in your project</td>
</tr>
</tbody>
</table>
Editing Project Properties
Even though every project starts out with a preset group of project properties, you can change them at any time, even after you've added objects.

To edit the properties of an existing project:
2. In the Project Properties dialog, change any necessary parameters, then click OK.

For more information on the parameters available in the Project Properties dialog, see “General Tab of the Project Properties Dialog” on page 184 and “Render Settings Tab of the Project Properties Dialog” on page 187.

Most changes made to a project's properties are fairly transparent and have no visual effect on the project itself. The main exception is a change made to the project's frame size.

Changing the Frame Size of a Project
When you change the frame size of a project (in Project Properties) that already has objects within it, you essentially change the size of the Canvas. This adds to, or reduces, the amount of room available to lay out the objects in your project.

It's important to understand that changing the size of the Canvas in no way changes the size or position of any objects already placed within it. Furthermore, since the coordinate system used by Motion uses 0, 0 as the center of the frame, all objects remain arranged in their current positions relative to the center of the frame as the edge of the frame shrinks toward the center. This may result in objects being cut off as the frame shrinks past their edges. In the following example, a project with a frame size of 720 x 480 is reduced to 320 x 240.

Original frame size (720 x 480)  Reduced frame size (320 x 240)
Because Motion is resolution independent, it’s not usually necessary to change your project’s frame size. You can output your projects at any size, regardless of the current frame size, by changing the options in Motion's export dialogs. For example, if you’re building a project with a frame size for standard-definition broadcast, you can still export a half-resolution version of your project to post on the web simply by exporting to the necessary size.

**Browsing Media Files in Motion**

This section describes how to browse the media files you want to use in your Motion project. As with project files, it’s important to make sure that the source media you’re using is organized in a way that makes sense and is easy to keep track of. Centralizing source media that’s only used in one project can be helpful, as is carefully organizing media that is shared by more than one project.

You use the File Browser to navigate every volume connected to your computer for media files to add to your Motion project. While similar to a Finder window, the File Browser has many custom controls specific to Motion that allow you to quickly locate and preview files you might want to use.

**Note:** You can also browse for and import files directly from your iTunes and iPhoto libraries from within the Motion Library. For more information, see “Adding iTunes and iPhoto Files from the Library” on page 218.
Navigation Controls in the File Browser

File Browser sidebar: This area of the File Browser displays all the hard disks and removable media currently connected to your computer. You can also access networked volumes. Additional icons allow you to access commonly used folders in your home folder such as the Desktop, Documents, Movies, Music, and Pictures folders.

File stack: Located beneath the File Browser sidebar, the file stack displays all the files and folders within the currently selected disk in the sidebar. Clicking a folder opens its contents into the file stack, replacing the previously displayed contents. You can navigate up and down the current folder hierarchy using the Back and Forward buttons and the Path pop-up menu. The file stack can be toggled between list view and icon view.
Preview area: Displays a preview of the currently selected file in the file stack. If a movie is selected, the Play button allows you to play through the clip. Information about the clip being previewed appears to the right of the thumbnail preview.

Back and Forward buttons: These buttons allow you to navigate your browsing history. Clicking the left arrow moves you to the last item browsed. Repeatedly clicking the left arrow eventually moves you up to the first item you selected, such as the Desktop, a partition, or your home folder. Once you have reached the beginning of your browsing history, the left arrow is dimmed. Clicking the right arrow takes you forward in your browsing history. If you have never opened any folders within the currently open folder in the file stack, the right arrow is dimmed.

Path pop-up menu: Displays the current folder hierarchy as a list, with the currently open folder at the top, and each enclosing folder appearing underneath. “Computer” appears at the bottom, which is the topmost directory of all disks connected to your computer.

Search field: The Search field filters the file stack for the search terms you’ve entered.

Controls for Customizing the File Browser

File Browser divider: Dragging this divider up and down allows you to reallocate space between the File Browser sidebar and the file stack. Shrinking the sidebar also shrinks each displayed icon, down to a certain point.

Icon View button: Sets the file stack to display each file and folder as an icon. Image and movie files are represented by a thumbnail image, while folders are represented by a folder icon. All icons in the stack are arranged into a grid, the size of which is defined by the Scale slider at the bottom of the File Browser.

List View button: Sets the file stack to display each file and folder as a hierarchical list. A thumbnail of each file and folder appears to the left of each file and folder name within the Name column. To the right, several additional columns display information for the date, size, duration, and kind of each file. The contents of the file stack can be sorted by any single column by clicking that column’s header. Clicking the same header twice reverses the sort order, from ascending to descending, or vice versa.
Folders in this list can be opened hierarchically, using the disclosure triangle to the left of each folder’s icon, or they can be double-clicked to replace the current contents of the file stack with the contents of that folder.

**Scale slider:** When in icon view, this slider enlarges or reduces the size of all icons displayed in the file stack. The current scale size affects how many icons can be simultaneously viewed within the current area of the file stack. The file stack can be enlarged with the File Browser divider.

**Show Collapsed Image Sequences button:** Image sequences are movie clips that have been saved as individual image files, one for each frame of film or video. Clicking this button allows you to view properly named image sequence files as a single image sequence file. In the event that you’re viewing image files that have numbered filenames that aren’t actually an image sequence (such as images captured with a digital camera that you’ve imported from an iPhoto directory), you can turn this control off to see each individual image file separately.

**New Folder button:** Allows you to create a new folder within the currently displayed location in the file stack. These new folders are created in the Finder and allow you to reorganize media files on disk from within Motion.

**Note:** To delete a folder from the File Browser, select the folder, then press Command-Delete.
Different Methods of Browsing, Searching, and Previewing Files

This section contains procedures you can use to look for and preview files using the controls in the File Browser.

To browse the contents of a disk, do one of the following:

- Click the disk's icon in the File Browser sidebar.
- Press the Up and Down Arrow keys to move up and down the sidebar list.

To browse the file stack in icon view, do one of the following:

- Double-click a folder in the file stack to open its contents into the file stack.
- Click an icon in the file stack, then press the arrow keys to change the selected folder. To open the currently selected folder, press Return.

To browse the file stack in list view, do one of the following:

- Double-click a folder in the file stack to open its contents into the file stack.
- Click the disclosure triangle to the left of a folder’s icon to open its contents into a hierarchical list.
- Click a list item, then press the Up and Down Arrow keys to navigate the list.
- Press the Right Arrow key to open the selected folder into hierarchical view—this has the same effect as clicking a folder’s disclosure triangle. Press the Left Arrow key to close a folder that’s been opened hierarchically.
- Press the Return key to open a folder’s contents into the file stack.

To navigate the current file path hierarchy, do one of the following:

- Click the Forward button to move to the previously opened folder.
- Click the Back button to move to the last previously opened folder down the current folder hierarchy.
- Choose a folder in the current hierarchy from the Path pop-up menu.

To sort the file stack in list view:

- Click the header of any information column to sort by that category. Click the same column a second time to reverse the sort order, from ascending to descending, or vice versa.

To search for a file:

- Type a search term in the Search field. The file stack immediately updates with files that contain the search term anywhere within their filenames. Only disks or folders currently displayed in the file stack are searched. Character case is ignored.

For example, typing “flag” in the Search field might result in the following filenames appearing in the file stack: “Dutch Flag.tif, flagAnimation.mov, flagellum.tif, Iron Flag.m4a.”
To clear the search results:
- Click the Clear button at the far right of the Search field to restore the contents of the file stack to the previously selected file path.

To preview a file:
- Select any supported media file in the file stack. The Preview area updates with a thumbnail and additional text information about that file. If “Play items automatically on a single click” is turned on in the General pane of Motion Preferences, an animated preview of movie clips and image sequences begins playing.

To preview a file at full size:
- Double-click a file in the file stack to open it into its own viewer window, complete with playback controls.

About Networked Disks and Removable Media
You should be careful when adding media files from a remote server to your project. Although the File Browser sidebar allows you to easily access the contents of disks on other computers on your network, doing so only places a link to that file in your project. The actual media file remains on the remote disk where you found it. As a result, whenever that remote disk becomes unavailable, the corresponding object in your project goes offline. Furthermore, depending on the speed of your network, you may experience performance issues when using media files on other computers. Ideally, you should copy all media files you want to use in your project onto a disk that’s physically connected to your computer, both to ensure the file’s future availability, and to guarantee playback performance. If you do use media from a networked hard drive, make sure it’s one that is always mounted on your system, and that you have a high-performance network.

This is especially true for media from removable disks, such as CD-ROM, DVD-ROM, and removable hard drives that are frequently disconnected from your computer. Always copy media files from such media to your local hard drive so that the media doesn’t become unavailable when the media is ejected or disconnected.

File Types Supported by Motion
Motion can use the most popular multimedia file formats supported by QuickTime. These formats can be broken down into the following categories:
- QuickTime movies
- Image sequences
- Still image files
- Layered Photoshop files
- PDF files
- Audio files
QuickTime Movies
Motion supports QuickTime movies using any codec currently installed on your computer. Examples of QuickTime movies you can import include clips captured with Final Cut Express HD or Final Cut Pro, stock footage from a CD-ROM or DVD collection, or computer-generated animation from a 3D animation package.

While you can import movies that use nearly any codec, it’s inadvisable to use highly compressed clips in your projects if you can avoid it. Clips that are excessively compressed may display undesirable visual artifacts. Fortunately, QuickTime comes with many codecs that are ideal for moving uncompressed or minimally compressed video files between applications, including but not limited to: Uncompressed 8- and 10-bit 4:2:2, Pixlet, None, Animation, Apple M-JPEG A and B, Apple DVCPRO-50, Apple DV/DVCPRO, and Apple ProRes 422.

Some of these codecs support alpha channels, which define areas of transparency within the clip. If a particular QuickTime clip has an alpha channel, Motion automatically uses it in your project.

Mixing Different Kinds of QuickTime Files
You can freely combine clips that are compressed with different codecs in the same project. Furthermore, you can also combine clips that have different frame sizes, pixel aspect ratios, and interlacing. To learn more about alpha channels, interlacing, pixel aspect ratio, frame rates, and frame sizes, see “Video and File Formats” on page 1203.

Warning: Mixing clips with different frame rates may result in undesirable motion artifacts.

Importing Movies from Final Cut Express HD or Final Cut Pro
Unlike Final Cut Express HD or Final Cut Pro, Motion processes video in RGB color space. Video clips that have been captured in YCrCb color space are treated as RGB clips when imported into a Motion project.

Still Images
You can import still image files using virtually every popular still image format in use, including but not limited to: SGI, Photoshop, BMP, PICT, JPEG, TIFF, TGA, and JPEG-2. Like video clips, you can mix still image files with differing frame sizes and pixel aspect ratios. When you create or modify an image in a graphics editor such as Photoshop, it’s a good idea to keep in mind the frame size and pixel aspect ratio of your project to ensure that the graphics you create are appropriate for your project. For more information, see “Video and File Formats” on page 1203.
Using High-Resolution Still Images

A common and effective use of still images in motion graphics work is the animation of high-resolution files. The DPI of image files as defined in programs like Photoshop does not apply to video, as the dimensions of each imported still image are defined simply by the number of pixels. If the current dimensions of an image are larger than the frame size of your project, the image appears to be much larger, and by default it appears to be “zoomed in” to its maximum size. You can change the scale of the image to shrink it down to fit within the project’s frame size, but you can also animate the scale to zoom into or out of the image, or animate the image’s position to pan around within it, creating all kinds of motion-control effects.

Because Motion is graphics-card dependent, you may have different file-size import limitations. When you import an image that is too large, an alert dialog appears that states “This media is too large to render at full resolution, and will be shown at a lower quality.” Click OK to import the image at a lower quality. For more information, visit the Motion website at http://www.apple.com/finalcutstudio/Motion.

When importing large still images, you can set a preference that tells Motion to import the file at its original size, to change the resolution of the image to fit the Canvas size, or to scale the image down to fit the Canvas size.

To set the large still image import preference:

1. Choose Motion > Preferences (or press Command-comma).
2. In the Still Images & Objects group of Motion Project Preferences, choose a setting from the Large Stills pop-up menu.

There are three options: Do Nothing, Scale to Canvas Size, and Down-Res to Canvas Size.

Do Nothing: Imports the image at its original size.
In the following example, an 1146 x 756 image is imported into an NTSC D1 project (720 x 486) with Do Nothing selected in the Preferences. The image is much larger than the Canvas.

**Scale to Canvas Size**: Imports and scales the image to fit the project size while maintaining its aspect ratio.

In the following example, a 760 x 1150 JPEG image is imported into an NTSC D1 project with Scale to Canvas Size selected in Preferences.
The image is scaled—the equivalent of using the Transform tool to scale down the image in the Canvas while pressing Shift. To observe that the image is merely transformed and has not changed resolution, select the image file in the Media tab of the Project pane, and then display the Media tab Inspector. The Fixed Width and Fixed Height parameters display the resolution of the original file.

The image is scaled to fit the largest X or Y value of the image to that of the Canvas.

**Down-Res to Canvas Size:** This setting changes the resolution of the imported image so that the image fits the project size while maintaining its aspect ratio.

*Note:* The Down-Res to Canvas Size option is the best choice for optimizing your process time. When you use Scale to Canvas Size, Motion must calculate the scale at each frame.

In the following example, a 1309 x 2020 JPEG image is imported into an NTSC Broadcast SD project with Down-Res to Canvas Size selected in Preferences.
The image looks identical to an image that is scaled on import. However, its resolution has been changed so that the image fits the Canvas. To observe that the resolution of the image has changed, select the image file in the Media tab of the Project pane, and then display the Media tab Inspector. The Fixed Width and Fixed Height parameters display the new resolution of the imported image.

Still Image Duration
When you first import a still image into your project, the image assumes a duration equal to the current duration of your project. Increasing the duration of your project does not automatically increase the duration of an image that’s already been imported. Still images have infinite duration in Motion, so you can stretch them out in the Timeline to be as long as you need. For more information about working with objects in the Timeline, see “Using the Timeline” on page 321.

Image Sequences
Numbered image sequences store video clips as individual still image files. Each image file has a number in the filename that indicates where it fits into the sequence. In a film clip that’s been digitally scanned, each file represents a single frame. In a video clip that’s been converted to an image sequence, each file contains both fields of a single video frame, with the upper and lower lines of the image saved together. Image sequences use the same variety of file formats as still image files. Some of the most popular formats for saving image sequences are: SGI, BMP, JPEG, TIFF, and TGA. Like still image formats, many of these support alpha channels, which are automatically used by Motion.
Because image sequences have been around for so long (before QuickTime, they were the only way to store video on a computer), they remain the lowest-common-denominator file format for exchanging video across many different editing and compositing applications. While QuickTime is increasingly used to exchange video clips between platforms, image sequences are still in common use, especially in film compositing.

As with QuickTime video clips, you can mix image sequences of different formats, using different frame sizes, pixel aspect ratios, frame rates, and interlacing. For more information, see “Video and File Formats” on page 1203.

**Important:** Any imported image sequence must contain three or more digits of padding, for example, imagename.0001.tif.

**Collapsing Image Sequences**
The Show Collapsed Image Sequences button at the bottom of the File Browser allows you to display image sequences as a single object, rather than as the collection of individual files that exist on your disk. Image sequences that you import into your project in this way are treated as single objects everywhere they appear in your project.

**Note:** You can turn this feature off in case you have numbered image files that aren’t supposed to be used as an image sequence. For example, pictures taken with digital cameras often have numbered filenames that can be mistaken for an image sequence.

**Layered Photoshop Files**
You can also import layered Photoshop files. Many motion graphics professionals create layouts in Photoshop, where they paint and manipulate all the graphical elements they’ll use to create a static composition. Once that’s done, the resulting layered file can be imported into Motion to be animated, along with other imported and Motion-generated objects, to create the final project.

When importing Photoshop files, you can choose to import:

- All the layers merged together as a single object
- All layers as individual objects, nested together within a group
- An individual layer as a single object
When you import all layers as individual objects, Motion creates a new group in the Layers tab and Timeline, and nests each layer of the Photoshop file as an individual object within that Motion group. Each resulting object retains the position, opacity, and blend mode of the original Photoshop layer. Furthermore, Photoshop text layers are imported, but appear in Motion as noneditable bitmap graphics.

**Incompatible Effects**
The following Photoshop effects are not currently imported into Motion:
- Layer effects
- Layer masks
- Adjustment layers
- Paths
- Shapes

*Note:* Motion does not support Photoshop layer sets.

For more information on how to import layered Photoshop files, see “Adding Layered Photoshop Files to a Project” on page 216.

**PDF Files**
The PDF file format is a PostScript-based document format that accommodates PostScript-based graphics and text, as well as bitmap graphics. Areas of transparency within a PDF file are also transparent within Motion.

PDF files are capable of storing PostScript-based illustrations. Unlike graphics file formats such as TIFF and JPEG, which save images as a collection of pixels at a given resolution that are divided into Red, Green, and Blue channels, PostScript-based illustrations are saved as mathematical descriptions of how the artwork is drawn. As a result, PDF files using PostScript-based artwork and text have infinite resolution.

The practical difference between bitmap files and PostScript-based files is that scaling a bitmap beyond 100 percent results in the image progressively softening the more you increase its size. PostScript-based illustrations remain sharp and clear no matter how large or how small you scale them.

When importing a PDF file, its size is relative to the original page size of the file. As a result, even small graphics may have a large frame size, with a lot of empty space surrounding the graphic. When exporting a graphic as a PDF file for use in Motion, you may want to scale the graphic up to fit more closely within the page, or reduce the page size in the source application’s Page Preferences to more closely fit around the graphic.
Fixing the Resolution of a PDF Object
Although PDF files have unlimited resolution, large PDF objects can consume a lot of video memory, which could potentially limit Motion's performance. To avoid this, you have the option of limiting the resolution of each PDF image used in your project in order to save video memory. By using the fixed resolution parameters, the files only need to be rendered once. This allows for faster performance.

If you decide to fix the resolution of a PDF file, the width and height values you assign should be equal to the largest scale at which you plan on using that object in your project. For example, you might add a PDF of a map to your project with the intent to scale it up to zoom into a particular country. To conserve video memory, you can set the Fixed Width and Fixed Height parameters to the maximum size of the zoomed in image. If at first you don’t assign enough resolution, the Fixed Width and Fixed Height parameters can be changed at any time.

The fixed resolution parameters for PDF objects can be adjusted in the Media tab of the Inspector. Select the PDF object in the Media tab of the Project pane to activate the Media tab of the Inspector.

Fixed Resolution: A checkbox that fixes the resolution of a PDF object in the Media tab to the size specified in the Fixed Width and Fixed Height parameters.

Fixed Width: A slider that sets the maximum horizontal resolution to which a PDF object can be smoothly scaled.

Fixed Height: A slider that sets the maximum vertical resolution to which a PDF object can be smoothly scaled.

Mixed Content Within PDF Files
Although PDF files can simultaneously contain PostScript-based art, PostScript text, and bitmapped graphics, all of these types of image data do not scale the same. PostScript-based art and text scale smoothly, but bitmapped graphics that are embedded in a PDF file are subject to the same scaling issues as any other bitmapped graphics format. As a result, they may soften if scaled larger than their original size.

Note: Form objects, buttons, and JavaScript objects that are present in an imported PDF file do not appear in Motion.

Multi-Page PDF Files
You can import multi-page PDF files. When you do, an additional parameter called Page Number appears in the Properties tab when the PDF object is selected. A slider appears and allows you to set which page is displayed in the Canvas. This parameter can be animated to display different pages over time.
Important: Multi-layered PDF files are not currently supported. To import a multi-layered illustration, export each layer as a separate PDF file, and import these as a nested group of objects in Motion.

More About Alpha Channels
Ordinary video clips and image files have three channels of information, one each for the red, green, and blue channels. Many video and image file formats also support an alpha channel, which contains additional information that defines areas of transparency. An alpha channel is a grayscale channel where white represents areas of 100 percent opacity (solid), gray regions represent partially opaque areas, and black represents 0 percent opacity (transparent).

When you import a QuickTime movie or an image file into your project, its alpha channel is immediately recognized by Motion. The alpha channel is then used to composite that object against any other objects that are behind it.

There are two different ways of embedding alpha channel information into files, and Motion attempts to automatically determine which type of alpha channel a particular object uses:

- **Straight:** Straight alpha channels are kept completely separate from the red, green, and blue channels of an image. Media files using straight alpha channels appear perfectly fine when used in a composition, but they may look odd when viewed in another application. Translucent effects such as volumetric lighting, or lens flares in a computer generated image, may appear distorted until the clip is used in a composition.

- **Premultiplied:** This type of alpha channel is multiplied with the clip’s red, green, and blue channels. As a result, objects with premultiplied alpha channels always look correct, even with translucent lighting effects, because the entire image is precomposited against a solid color. Most commonly, premultiplied alpha channels are multiplied against black or white, but Motion can also resolve alpha channels that have been premultiplied against other colors.

The only time it really matters which kind of alpha channel an object has is when Motion doesn’t correctly determine it. If an object’s alpha channel has been set to Straight in the Media tab when it’s really premultiplied, it may appear fringed with the premultiplied color around its edges. If this happens, you can select the problematic clip in the Media tab of the Project pane, and change its Alpha Type parameter in the Media tab of the Inspector.
Audio Files
You can import different audio file formats into your project, including but not limited to: WAV, AIFF, .cdda, MP3, and AAC. Although Motion is not necessarily intended to be a full-featured audio editing and mixing environment such as GarageBand, Soundtrack Pro, or Logic, you can import music clips, dialogue, and sound effects to use in your projects. If you import a QuickTime file with mono or stereo tracks of audio, the video appears in the Timeline, while the audio appears in the Audio Editor.

From within Motion, you can select an audio file and open Soundtrack Pro to modify the audio file. Once saved in Soundtrack Pro, the file is automatically updated in Motion. For more information, see “Using Soundtrack Pro with Motion” on page 1144.

You can freely import audio clips with different sample rates and bit depths. When you do, Motion resamples any audio tracks that need it to the sample rate and bit depth currently in use by your computer. The default is 16-bit, 44.1 kHz float for the built-in audio interface. If you use a third-party audio interface, audio is remixed to the sample rate and bit depth used by that device.

You can import audio files with sample rates up to 192 kHz, and with bit depths up to 32 bits. Mono and stereo files are supported. Multi-channel audio files are also supported.

Motion supports as many layers of audio as you want to use in the Audio Editor, although mixing many audio tracks together may affect playback performance. In the Audio Editor, you use the same tools and commands to edit audio objects as you use in the Timeline layers list. Each audio layer also has individual settings for level and pan, so that you can mix a group of tracks together for stereo output.

For more information about file formats supported by Motion, see “Video and File Formats” on page 1203. For more information on using audio in Motion, see “Working with Audio” on page 1117.

A seamless way to browse for and import music from your iTunes library is to use the Music category in the Motion Library. For more information, see “Adding iTunes and iPhoto Files from the Library” on page 218.

Note: You cannot import rights-managed AAC files, such as those purchased from the iTunes Store.

Adding Media to Your Project
Once you’ve created a new project, the next step is to add media files to your composition. All media types—movie clips, still images, audio files, or other objects appearing in the Motion Library—are added to your project using the same methods.
Note: Layered Photoshop files have additional import options available from the drop menu. For more information, see “Adding Layered Photoshop Files to a Project” on page 216.

The Link Between Motion Layers and Media Files
Prior to learning how to add media to your Motion project, it’s important to understand the correspondence between layers and source media. Every time you add a file to your project, you create a link between the layer you see in the Canvas and its corresponding media file on disk.

Unlike applications such as iMovie HD, where sections you remove from clips are also deleted from disk, Motion is a nondestructive application. This means that any changes you make to media objects in a Motion project aren’t actually applied to the media files to which they’re linked.

Because of this link, whenever you add a file to your project, you need to make sure it remains available on your hard disk for as long as you’re working on that project. If you move, delete, or rename media files that correspond to layers in a Motion project, those objects become “offline.” Offline layers appear as checkered rectangles that occupy the entire bounding box of the object.

If this happens, it’s easy to reconnect the offline layers in your project with new copies of the media you lost, assuming those files are still available. For more information, see “Online Versus Offline Media” on page 220.

Selecting Files in the File Browser
You can add files to a project using either the File Browser or the Import command in the File menu. In most cases, the File Browser is more convenient, and gives you more control over how the resulting objects appear in your project.

Prior to adding files, you must first select them in the File Browser. You can add files to a project either individually or in groups.
To select files in the File Browser:

1. Open the File Browser.
2. Select one or more files by doing one of the following:
   - Click a single file.
   - While holding down the Shift or Command key, click each file you want to select.
   - While holding down the Shift or Command key, click any selected file to deselect it.
   - In list view, click to the left of any file’s thumbnail, then drag up or down to select multiple consecutive files.
   - In list view, press Shift and use the Up and Down Arrow keys to add files to the current selection.

Adding Files to Your Project

The following procedures apply to adding every file type compatible with Motion.

*Note:* Although iTunes and iPhoto files can be added using the File Browser as described below, it is recommended that you use the Music and Photo categories within the Motion Library. Using the Library allows you to browse for files using the playlist or photo album features available within iTunes and iPhoto. For more information, see “Adding iTunes and iPhoto Files from the Library” on page 218.

To add one or more files to a project in a new group:

1. If the Create Layers At setting in the Project pane of Motion Preferences is set to “Current frame,” move the playhead to the frame in the Timeline where you want the first frame of the file to start.

   *Note:* If the Create Layers At setting is set to “Start of project,” this step is unnecessary as imported files are always placed at frame 1.

2. Select one or more objects in the File Browser.

3. Do one of the following:
   - Drag the selected files into the Canvas, placing them at any position.
   - Click the Import button to add the selected files to the center of the Canvas.
   - Drag the selected files into the blank bottom area of the Layers tab.
   - Drag the selected files into the blank bottom area of the Timeline.
   - Choose File > Import (or press Command-I), select one or more files in the Import Files dialog, then click Open.

   A new group is created at the top of the Layers tab, and all files appear as layers nested within it. Each new layer’s start time in the Timeline is set to the position of the playhead in step 1.
To add one or more files to an existing group:

1. If the Create Layers At setting in the Project pane of Motion Preferences is set to “Current frame,” move the playhead to the frame in the Timeline where you want the first frame of the file to start.

   Note: If the Create Layers At setting is set to “Start of project,” this step is unnecessary as imported files are always placed at frame 1.

2. Open the File Browser and Layers tab.

3. Select one or more files in the File Browser.

4. To nest the selected files underneath an existing group, do one of the following:
   - Drag the selected files on top of any group in the Layers tab. The objects appear nested at the top of the group of objects.
   - Drag the selected files between any objects in a group. A position indicator shows the new position that the objects occupy when you release the mouse button.
   - Drag the selected files into the Timeline, placing them between any objects that are already nested underneath an existing group.

   Note: For more information on editing objects into the Timeline, see “Using the Timeline” on page 321.

Once a file has been added to a project, it appears as a layer in the Canvas, Timeline, Layers tab, and Media tab. Each new layer’s start time in the Timeline is set to the position of the playhead in step 1.

You can also add files to your project without having them appear in the composition by dragging a file directly into the Media tab. This allows you to add media objects you might want to use in the future without actually placing them in your composition.

To add one or more files to a project without using them in the composition:

1. Open the Media tab.

2. Drag one or more files from the File Browser into the Media tab. The resulting media objects don’t appear in the Canvas, Layers tab, or Timeline.

Adding Layered Photoshop Files to a Project

You can add a layered Photoshop file to your project by dragging it to the Canvas, Layers tab, or Timeline, by using the Import button, or by using the Import command. Using the Import button (in the Preview area) results in all layers of the Photoshop file being collapsed into a single layer, by default. To maintain the layers of the imported file separately, you need to use the drop menu or the File > Import command.
To control how a layered Photoshop file is added to your project using the drop menu:

1. Drag a layered Photoshop file from the File Browser into the Canvas, Layers tab, or Timeline.

2. Before releasing the mouse button, pause until the Canvas drop menu appears. This menu presents different commands for importing the layered file.

3. Drag the file over the command you want in the drop menu, and when the menu item is highlighted, release the mouse button.

The layers of the Photoshop file are added using the command you choose.

- **Import Merged Layers:** All layers of the Photoshop file are collapsed into a single layer.

- **Import All Layers:** A new group is created and nested within the currently selected group. Each layer of the Photoshop file appears as an individual layer nested within this group.

You can also import individual layers from the Photoshop file. Each layer in the selected Photoshop file appears as a separate item in the drop menu. Selecting an individual layer adds only that particular layer to your project, where it appears as a single layer.

**Note:** When a Photoshop file contains more layers than can be displayed in the drop menu, the Choose Layer option appears in the drop menu. Once Choose Layer is chosen, use the Pick Layer to Import dialog to select which layer to import.

To control how a layered Photoshop file is added to your project using the Import command:

1. Choose File > Import.

2. Select the file you want to import, then click Import. The Pick Layer to Import dialog appears.

3. Choose a command from the Layer Name pop-up menu:

   - **Merged Layers:** All layers of the Photoshop file are collapsed into a single layer.
   
   - **All Layers:** A new group is created and nested within the currently selected group. Each layer of the Photoshop file appears as an individual object nested within this group.
   
   - **Individual layers:** Each layer in the selected Photoshop file appears as a separate item in the drop menu. Selecting an individual layer adds only that particular layer to your project, where it appears as a single object.

To choose a different Photoshop layer than was originally selected on import, select the Photoshop file in the Layers list, then choose a layer from the Layer pop-up menu in the Properties tab of the Inspector.
Adding iTunes and iPhoto Files from the Library

You can add files from your iTunes and iPhoto libraries to a project via the Motion Library. This is very convenient, as the iTunes library and playlists and iPhoto albums appear in the Library subcategories.

*Note:* Although a connected iPod appears in the File Browser as a hard disk, you can only browse for and import iPod files that are stored as data. Music transferred to the iPod via iTunes cannot be imported into Motion.

**To add an audio file from iTunes:**

1. In the Library, select the Music category.
   
   The iTunes library and playlists appear. By default, All is selected (the iTunes library).

2. With All selected or by selecting a playlist, select an audio file from the stack.

   *Note:* When displayed in list view, the Music category shows information created in iTunes, such as the Name, Artist, Album, Duration, and Size of the file.

3. Do one of the following:
   - In the Preview area, click Apply.
   - Drag the audio file to the Canvas, Project pane, or audio area of the Timeline (not the Audio Editor).

   *Note:* Rights-protected AAC files cannot be imported into Motion and do not appear in the file stack. This includes all music purchased from the iTunes Store.

For more information on working with audio files, see “Working with Audio” on page 1117.

**To add a file from iPhoto:**

1. In the Library, select the Photos category.
   
   The iPhoto albums appear. By default, All is selected (the iPhoto library).

2. With All selected or by selecting an album, select a file from the stack.

   *Note:* When displayed in list view, the Photos category shows information created in iPhoto, such as the Name and Size of the file.

3. Do one of the following:
   - In the Preview area, click Apply.
   - Drag the file to the Canvas, Layers tab, or Timeline.

   *Note:* When importing large-scale images into Motion, you have the option to import the files as is, to scale the images to the size of the Canvas, or to change the resolution of the image to fit the Canvas. For more information, see “Using High-Resolution Still Images” on page 205.
Managing Layers in Your Project
When you add a file to your project, a corresponding layer appears in the Canvas, Layers tab, and Timeline. Once added, you can duplicate any layer in the Canvas, Layers tab, and Timeline to create as many copies as you need. Each copy you create has individual parameters in the Inspector, which gives you the freedom to individually modify and animate each duplicate layer as necessary.

The Relationship Between Objects in the Layers and Media Tabs
Every file you add to your project creates a new corresponding object in the Media tab, even if it's identical to other files you have already added. This means that if you drag the same file into your project five times from the File Browser, five corresponding objects are created in the Media tab.

On the other hand, if you duplicate a layer that's already in your project, a relationship is maintained between that instance of the object and the previously existing object in the Media tab. No new layer is created in the Media tab.

By default, objects added to your project are managed automatically by Motion. If you delete a layer from the Canvas or Layers list, the media object is removed automatically from the Media tab. You can turn off this feature in the General pane of Motion Preferences.

Duplicating Files
If you need more copies of an object in your project, either duplicate them directly in the Canvas using the Duplicate command, or drag an object from the Media tab to the Canvas or Timeline to create a new corresponding instance of that object. Another way to duplicate an object is to use the Make Clone Layer command. For more information on the Make Clone Layer command, see “Making Clone Layers” on page 283.

It is easier to manage all duplicated layers using the media object’s Media tab parameters in the Inspector. These parameters define the media object’s essential properties, including the frame rate, pixel aspect ratio, interlacing, and alpha channel parameters. There are also additional parameters that allow you to define each media object’s end condition, reversal, cropping, and timing. Each media object’s parameters affect all layers in the project that have a relationship to the corresponding media object in the Media tab, so changing the media object’s parameters simultaneously updates every layer in your project to which it is related.

For more information on a media object’s Media tab parameters, see “Object Media Tab Parameters” on page 225.
Seeing the Relationships Between Objects
There are two object parameters where you can see the relationship between objects in the Layers tab and objects in the Media tab.

- The Media parameter appears in the Properties tab of the Inspector whenever you select an object in the Layers tab. The Media parameter is an image well that displays the source media in the Media tab to which the currently selected object corresponds.

- The Linked Objects list appears in the Media tab of the Inspector whenever you select an object in the Media tab. This list displays all objects in the Layers tab that correspond to the selected source media. Changing an object’s name in the Layers tab automatically updates the name that appears in the Linked Objects list.

Using the Reveal Source Media Command
A fast way to find any layer’s source media in the Media tab is to use the Reveal Source Media command.

To reveal a layer’s source media in the Media tab, do one of the following:

- Control-click a layer in the Canvas, Layers tab, or Timeline, then choose Reveal Source Media from the shortcut menu.

- Select the layer, then choose Object > Reveal Source Media (or press Shift-F).

  The Inspector opens and displays the Media tab. At the same time, the Media tab in the Project pane opens. The source media is selected, and its Media tab parameters are exposed in the Inspector.

Online Versus Offline Media
As mentioned earlier, adding a layer to a Motion project creates a link between the layer in your project and its corresponding media file on disk. When you delete, move, or rename files on disk that are linked to layers in Motion, those files go offline, meaning that they’re temporarily unavailable to your project. This can also happen if you give someone a project file without also providing them with the source media it uses.
When you first open a project file with media that is unavailable, a dialog appears listing all the media files that can’t be found. Assuming the media has been moved to another folder or disk instead of being deleted, you have the option to search every disk connected to your computer to find them. If you know the location of the missing media, you can display a manual reconnection dialog to navigate directly to the files without having to search.

To reconnect the media files in this list using Search:

1. Click Search.

   Motion attempts to automatically find the first missing file in the list. If it is found, a dialog appears with the missing media file selected. If it is not found, a manual reconnection dialog appears, giving you the option to navigate to the file manually.

2. In the manual reconnection dialog, click Open to reconnect the media.

   If a file has been renamed, you’ll have to find it manually.

3. To find a file manually, navigate to the renamed file’s location, select it, then click Open.

   If more than one of the missing media files appears in the same folder, all files are automatically reconnected.

To cancel an active search:

1. Click Cancel.

   The manual reconnection dialog appears.

2. In the dialog, navigate to the file’s location, then click Open.
To reconnect the media files in this list using Reconnect:

1. Click Reconnect.

2. In the manual reconnection dialog, navigate to the file's location, then click Open.

If a layer in your project file is offline and you do not immediately reconnect it upon opening the project, it appears as a checkered rectangle that occupies the entire bounding box of the layer.

If you do not immediately reconnect an offline layer, you can still save changes to the project and even close it again, and reconnect the offline layers later. You can reconnect these offline layers at any time.

To reconnect a layer in a project with its source media on disk:

1. Open the Media tab in the Project pane.
2. Select the offline layer you want to reconnect.
3. Open the Media tab in the Inspector.
4. Click the Replace Media File button that appears underneath the Linked Objects parameter.

Motion attempts to automatically find the first missing file in the list. If it is found, a file dialog appears with the missing media file selected.
5. Click Open to reconnect it.

Note: You can also use the File > Reconnect Media command.

The offline layer comes online, and the original graphic appears. If more than one missing media file appears in the same folder, all files are automatically reconnected.
Deleting Objects from a Project
There are two ways you can delete an object in Motion. You can delete a single instance of an object from the composition by deleting it in the Layers tab, Timeline, or Canvas. By default, this removes the object from use and removes its source media in the Media tab, if it is no longer used by the project. If other instances of that object appear in your project, those are left alone.

You can also delete the object that appears in the Media tab. Doing this also removes all corresponding instances of that object in your project.

To delete one or more objects from a project:
1 Select one or more objects by doing one of the following:
   • To delete a single object, select it in the Layers tab, the Timeline, or the Canvas.
   • To delete multiple objects, Shift-click the objects.

   Note: In the Layers tab or Timeline, you can Command-click to select noncontiguous objects.

2 To delete the selected objects, do one of the following:
   • Choose Edit > Delete.
   • Press Delete.

   The objects are deleted from your project, but their corresponding source media files on disk remain untouched.

To delete all objects that correspond to a single object in the Media tab:
1 Open the Media tab, then select the source media you want to delete.
2 Do one of the following:
   • Choose Edit > Delete.
   • Press the Delete key.

   A dialog appears and prompts you to confirm the deletion.
3 Click Delete.

Exchanging Media in a Project
You can exchange any layer in your project with a different object in the File Browser or Library. This breaks that layer’s original source file link and creates a new link to the file you’re exchanging. When you exchange a layer’s source media, the object in your project retains all of its Property tab parameter values (including the Position, Scale, and Opacity parameters), selected blend mode, nested filters and behaviors, masks, and keyframes.
The exchange operation allows you to replace layers in your project even after you’ve modified and animated them. If you’re unhappy with a particular element of your composition, exchange it with a new one.

**Important:** You can only exchange layers that are linked to media files on disk. You cannot exchange Motion-generated objects such as particle systems, generators, or text objects.

This operation allows you to use temporary layers in your project until the finished layer is available. For example, if you’re expecting artwork from another artist that’s not yet available, you can use a temporary graphic with the same dimensions, and then exchange it when the final artwork becomes available.

This operation is extremely useful for customizing projects created using templates. For more information, see “Customizing Projects Created with Templates” on page 250.

**Note:** You can only exchange individual layers in the Layers tab. It is not possible to exchange objects in the Media tab.

To exchange a layer in your project in the Layers tab:
1. Drag a file from the File Browser onto a layer in the Layers tab.
2. When a curved pointer appears, release the mouse button.
   The original layer in the Layers tab is replaced by the new object.

To replace a layer in the Media tab:
1. Select the object you want to replace in the Media tab.
2. In the Inspector, open the Media tab.
3. Click Replace Media File.
   A dialog appears.
4. Navigate to the file you want to use to replace the current source media.
5. Click Open.
   The new media object replaces the current object in the Media tab along with all layers or objects linked to the media object in your project.
Object Media Tab Parameters
When you select an object in the Media tab of the Project pane, the Inspector displays a Media tab that contains the properties defining how the object appears in Motion. This includes parameters such as the type of alpha channel used, pixel aspect ratio, field order, and so on. All of these parameters can be edited, which changes the way that object is displayed and composited in your project.

While Motion makes an effort to correctly interpret how objects you add to your project should appear, sometimes it isn’t possible to correctly identify how a source media file should be treated. Make sure that each object you add to your project has the correct settings in its Media tab so you can successfully mix and match objects with different pixel aspect ratios, alpha channel types, and frame rates.

Because Motion is a nondestructive application, changes made to these parameters are not applied to the source media files on disk. They simply affect how objects are drawn within Motion.

Object Parameters in the Media Tab
The following parameters let you control the objects in the Media tab, which also affects all the instances of the object in the project.

Alpha Type: An object’s alpha channel contains information that defines areas of transparency in the image or movie. When you import a QuickTime movie or an image file, its alpha channel is immediately recognized by Motion. There are six different ways to embed alpha channel information into files, which correspond to the four options in this pop-up menu. Motion automatically assigns one of these options based on an analysis of the object when it is imported, but you can override this if necessary.

The six commands in this pop-up menu are:

- **None/Ignore:** The default setting for objects with no alpha channel. This option also allows you to ignore an object’s existing alpha channel, so that the entire object is solid.
- **Straight:** Straight alpha channels are kept completely separate from the red, green, and blue channels of an image. Media files using straight alpha channels appear perfectly fine when used in a composition, but they may look odd when viewed in another application. Translucent effects such as volumetric lighting or lens flares in a computer-generated image may appear distorted until the clip is used in a composition. If Straight is chosen, but you see a black, white, or colored fringe around the object, this parameter is incorrectly set and should be changed to one of the Premultiplied options, depending on the color of the fringe.
• **Premultiplied-Black:** This type of alpha channel is multiplied with the clip’s red, green, and blue channels. As a result, objects with premultiplied alpha channels always look correct, even with translucent lighting effects, because the entire image is pre composited against a solid color. This option interprets alpha channels that have been pre composited against black.

• **Premultiplied-White:** This option interprets alpha channels that have been pre composited against white.

• **Premultiplied-Color:** This option interprets files that have been pre composited against another color.

• **Guess Alpha Type:** This option forces Motion to analyze the file in an attempt to automatically figure out what kind of alpha channel it uses. If you’re unsure, use this setting.

  **Note:** PDF files with transparent backgrounds do not have the Alpha Type or Invert Alpha parameters.

  **Note:** Separate layers in a Photoshop file do not use these settings. They are only used when a PSD file is imported and used as “Merged.”

**Invert Alpha:** Ordinarily, an alpha channel is a grayscale channel, where white represents areas of 100 percent opacity (solid), gray regions represent partially opaque areas, and black represents 0 percent opacity (transparent). If an alpha channel has been incorrectly generated in reverse, this checkbox inverts it.

**Pixel Aspect Ratio:** Defines whether the object was created using square or nonsquare pixels. In general, objects created for computer display, film, and high-definition video use square pixels, while objects created for standard-definition video formats use nonsquare pixels. A text field to the right of this pop-up menu displays the numeric aspect ratio, in case you need to manually change the ratio. By correctly identifying each object you add to your project, you can mix and match both kinds of media.

**Field Order:** When importing interlaced video, choose the field order with which the clips were captured. This should match the field order of the device used for capture. The interlacing is either Upper (Odd) or Lower (Even). If you choose incorrectly, you’ll notice immediately upon playback that the video appears to “stutter,” because the order of fields is accidentally reversed. When this happens, simply choose the opposite field order setting in this pop-up menu. Clips that were shot using a progressive scan video camera or on film have no interlacing, and should be set to None. By correctly identifying each object in your project, you can freely mix and match clips with a different field order.
Frame Rate: Choose a frame rate in frames per second that matches the clip’s native rate. For example, film is 24 fps, PAL video is 25 fps, and NTSC video is 29.97 fps. Additional frame rates are available for different video formats. If the frame rate you require is not listed, you can type a number in the text field to the right of the pop-up menu.

Note: Project frame rates are determined by the project preset. To edit a preset or to create a new preset, choose Motion > Preferences and use the options in the Presets pane.

If you change a QuickTime file’s frame rate, you can choose “From file” at the bottom of the Frame Rate pop-up menu to change this parameter to the QuickTime file’s original frame rate.

Note: While you can freely mix clips using different frame rates, clips playing at a frame rate different from that of the project may not play smoothly.

Crop: A multidimensional parameter that defines a number of pixels to be cropped from each of an object’s four sides, relative to the outer edge of the bounding box that surrounds that object. Cropping an object in the Media tab also crops all instances of that object that appear in your project. A similar Crop parameter appearing for objects in the Layers tab allows you to individually crop each instance of that object. For more information, see “Parameters in the Properties Tab” on page 280.

Timing: These parameters control the start, end, and duration of each media object.

• In: Sets the In point of the object, in both constant and variable speed modes. Adjusting this parameter always moves the object In point to the specified frame without affecting the duration of the object.

• Out: Sets the Out point of the object, in both constant and variable speed modes. Adjusting this parameter always moves the object Out point to the specified frame without affecting the duration of the object.

• Duration: Sets the total duration of the object. If Time Remap is set to Constant Speed, adjusting Duration will also affect the Speed and the Out point. If Time Remap is set to Variable Speed, adjusting Duration will not affect variable speed playback.

Linked Objects: This list displays all objects that appear in the Layers tab that have a relationship to that object. Two columns display the name of each layer containing an instance of the source media, along with the object’s name. Changing an object’s name in the Layers tab automatically updates the name that appears in the corresponding object’s Linked Objects list.
Replace Media File button: This button allows you to relink a media object in your project to another source file on disk. This feature is primarily useful for relinking offline objects, but it can also be used to substitute the media used by an object in your project with other media. It also lets you replace one object with another, along with all instances of that object in your project.

Summary: A separate pane that lists the properties of the media file on disk that's linked to the selected object.

Using Media in the Library
Motion ships with a collection of media and effects objects that you can use in your projects. The Library shares many controls and window panes with the File Browser. Both tabs are designed for the navigation of media that you want to add to your project. In general, all the controls work identically to those found in the File Browser, but the organization of listed media is different.

The Library sidebar is replaced by a two-column pane. The left column displays all the categories of media and effects that are available in the Library. When you select a category, subcategories appear in the right column. Selecting a subcategory displays all the media or effects objects within the subcategory in the Library stack below.

The next sections describe the available categories in the Library.

Behaviors and Filters
Behaviors and filters are applied directly to objects that have already been added to your project. They do not exist on their own. Instead, they must be attached to an object or layer to have an effect. Both behaviors and filters can be customized after they’ve been added to a project, and customized versions can be stored in the Library for future use.
For more information about behaviors, see “Using Behaviors” on page 369. For more information about filters, see “Using Filters” on page 841.

**Third-Party Filters**
If you’ve installed third-party filters on your computer, they appear in this category, ready for use.

**Image Units (Filters)**
The Image Units category appears in the Motion Library if you are running Mac OS X 10.4 or later. Motion supports the operating system’s Core Image Units (filters).

**Generators**
Generators are user-customizable computer-generated objects that can be used to create a variety of graphic elements. When you add a generator to your project, it automatically adapt to the frame size and frame rate of the project. Generators also have infinite duration, so they can play as long as necessary.

Generators have all the property parameters belonging to other objects. Properties specific to each generator also appear in the Generator tab of the Inspector whenever a generator is selected. You can also save customized versions of generators in the Library for future use.

For more information about the generators available in Motion, see “Working with Generators” on page 965.

**Image Units (Generators)**
The Image Units category appears in the Motion Library if you are running Mac OS X 10.4 or later. Motion supports the operating system’s Core Image Units (generators).

**Particle Emitters**
Several categories of pre-made particle emitters let you quickly add effects ranging from simulations of smoke, fire, and explosives, to animated abstract textures that you can use in different ways. All of Motion’s pre-made particle systems can be customized once you add them to your project.

For more information about using particle systems, see “Working with Particles” on page 685.

**Replicators**
Several categories of pre-made replicators let you quickly add background, transitional, or other types of animated patterns. All of Motion’s pre-made replicators can be customized once you add them to your project.

For more information about using the replicator, see “Using the Replicator” on page 753.
Shapes
This category contains pre-made shapes that you can use either as visual elements or as image masks. Each shape is a Bezier shape and can be further customized using Motion’s shape editing tools. For more information about editing shapes and masks, see “Using Shapes and Masks” on page 997.

Gradients
The Gradients category contains gradient presets that you can use in the gradient editor found in particle system emitters and cells, as well as in text objects and shapes. Motion comes with a collection of gradient presets, but you can also save your own custom gradients created with any gradient editor.

Fonts and LiveFonts
Fonts and LiveFonts that are installed on your computer appear in these categories. Fonts are organized into subcategories based on the categories of fonts you define in the Font Book application. For more information about Font Book, see Mac Help in the Finder Help menu.

You can use the font categories to preview the fonts that are available on your computer. You can also drag fonts and LiveFonts onto text objects to change the typeface they use. For more information about using fonts with text objects, see “Using the Library Font Preview” on page 576.

Text Styles
Text styles are presets that can be applied to text objects in your project to instantly change their style parameters. These style parameters include face, outline, glow, and drop shadow parameters. Dragging a text style onto a text object instantly applies that style to the text.

For more information on text styles, see “Editing Text Style” on page 590.

Shape Styles
Shape styles are presets that can be applied to shapes and paint strokes to instantly change their style parameters. Dragging a shape style onto a shape instantly applies that style to the shape.

For more information on shape styles, see “Saving Shapes and Shape Styles” on page 1082.

Music and Photos
These categories allow you to browse for and import audio files directly from your iTunes library and image files directly from your iPhoto library. The Music subcategories that appear in the Motion Library are playlists created in iTunes. The Photos subcategories are albums created in iPhoto. The contents of each library, album, or playlist appear in the file stack.
For more information on importing iPhoto or iTunes files, see “Adding iTunes and iPhoto Files from the Library” on page 218.

Content
Motion ships with a collection of pre-made graphics and Motion-generated objects that appear in the Content category. Any of these objects can be dragged into the Canvas and used as design elements for your own project. Some of the subcategories contain objects used to make the templates included with Motion. The one exception is the Particle Images subcategory, which comprises particle cell sources used to generate the particle emitter presets included with Motion.

By default, the content files that ship with Motion are stored in the /Library/Application Support/Final Cut Studio/Motion folder when you install Motion. During installation, you can select an alternate location to install the Motion content. Custom Motion-generated objects that you place into the Library are saved in the /Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Content folder.

Note: Dragging a media object into the Content category leaves its corresponding file on disk in its original location. For this reason, it’s recommended you centralize all media you plan on importing into the Library for future use into a dedicated and predictable location on disk, to prevent accidentally moving, renaming, or deleting those files.

Favorites and the Favorites Menu
It’s easy to customize the behaviors, filters, particle systems, gradients, and generators used in Motion to create your own effects. These customized objects are saved into their corresponding categories. The Favorites category provides a place to put objects—built-in or custom-made—that you frequently use. You can also place frequently used media files into the Favorites, such as PDF or TIFF files. Objects you put in the Favorites category are available to every project you create in Motion.

Objects you place in the Favorites Menu folder appear in the Favorites menu, for even faster access. When you choose an item from the Favorites menu, that item is placed into the currently selected layer, positioned at the center of the Canvas. Objects you put in the Favorites Menu are available to every project in Motion.

Objects that are dragged into the Favorites and Favorites Menu categories are saved into the /Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Favorites and /Favorites Menu directories, respectively.

Note: Objects placed into subcategories that correspond to a folder in the /Library/Application Support/Final Cut Studio/Motion/Favorites folder are shared among all user accounts on that computer.
Adding Your Own Content to the Library
You can add your own customized versions of generators, filters, behaviors, and gradients to categories in the Library. Furthermore, if you work on one or more programs that frequently recycle the same graphics elements, or if you have a library of graphics that you use regularly, you can add these media files to the Favorites category. It is recommended that you add custom content to the Favorites category. Content you put into the Library is available to every project in Motion.

**To add Motion-generated objects to a Content category:**
- Drag an object to the Favorites folder in the Library Category list or subcategory list, or directly into the Library stack.

**Important:** Each category except the Content, Favorites, and Favorites Menu is filtered by the type of object it represents. For example, you can place a user-customized filter in the Filters category, but you cannot put a filter into the Behaviors category.

You can also place media from disk into the Content, Favorites, or Favorites Menu categories.

---

### Using Custom Objects from the Library
When you drag a custom object from the Library to the Canvas, the center of the object is dropped at the location in which you release the mouse button. If you use the Apply button in the Preview area to add the object, the object is added at the center of the Canvas.

When you drag objects to the Canvas that were saved with the “All in one file” drop menu option, the objects are dropped at the location in which you release the mouse button and are positioned according to their arrangement when originally saved to the Library. If you use the Apply button in the Preview area to add the object, the objects are added at the center of the Canvas.

**Note:** When you drag a custom mask from the Library into a project, the mask retains the position with which it was saved (relative to the image or footage on which it is dropped).

---

**To add a media object to the Favorites category:**
- Drag a media object from the Layers tab or Media tab, or from the File Browser, into the Favorites folder in the Library.

When adding your own content, you can create additional folders to add subcategories that appear in the subcategory column.

**To create a new subcategory within any category:**
1. Open the Library and select a category.
2. Click the New Folder button (+) at the bottom of the Library.
3 Rename the new folder to suit your needs.

This new folder appears in the subcategory column whenever that category is selected.

To remove objects or folders from a Content category:

- Select an object or folder in the Library stack, then do one of the following:
  - Choose Edit > Delete.
  - Press Command-Delete.

When Library Media Becomes Unavailable

As with any other object used in a Motion project, Library media used by a project must be present and installed on the current computer for those objects to appear correctly in Motion. If someone gives you a project file and you don’t have the same filters, fonts, or LiveFonts that they do, a warning appears when you open the project that lists the items that are unavailable.

You can either close the project and install the necessary files on your computer, or go ahead and open the file. The following list outlines what happens when you open a project file without having the necessary media:

- **Missing Content**: Missing content is treated like any other missing media object. The objects go offline, and you have the option to reconnect them at any time.

- **Missing Filters**: When one or more filters are missing, objects in your project that use those filters appear with a placeholder that shows which filter is missing. This gives you the opportunity to reinstall the filter at a later point.

- **Missing Fonts**: When fonts are missing, the text objects that use those fonts default to Geneva as a temporary substitute. Missing international fonts substitute the default system font for that language.

- **Missing LiveFonts**: When LiveFonts are missing, the previously used LiveFont is replaced by another LiveFont installed on your computer.

Organizing Groups and Layers in Motion

Whenever you drag a media file from the Library or File Browser into the Canvas, Layers tab or Timeline, or generate an image from within Motion, the resulting element is represented as a layer. Think of layers as a series of clear overlays stacked one on top of the other. These layers combine to create the composite that you see in the Canvas.

Motion provides a graphical representation of this layer hierarchy in the Layers tab of the Project pane and also in the Timeline layers list. You can rearrange the stacking order of the layers in your composition by dragging them to a new location in either of these lists.
Layers, in turn, are nested within containers known as *groups*. Whenever you create a new layer, that layer is placed within a group. You can drag a layer from one group and place it inside another group, but layers cannot exist on their own, outside of a group. Layers nested inside groups appear indented in the Layers tab and the Timeline layers list.

A group can also contain other groups nested inside it. In this way, you can construct complex hierarchies of nested groups, with each nested group subordinate to the group that contains it, up to the topmost group.

One of the goals of organizing the layers in a project is to group layers that you want to work together as a unit. Doing so ensures that animation and effects that are applied to the enclosing group also affect all layers nested within that group. By nesting related layers that you want to animate inside a group, you can save time by animating just the enclosing group, instead of animating each layer individually.
For example, when you select a group that has three layers nested within it, the entire group is selected as a single unit.

Moving a selection in the Canvas moves all three layers simultaneously.

Regardless of how they’re nested, individual layers can always be animated independently. Subordinate groups can also be animated independently, although such animation and effects also affect all groups or layers that are nested underneath.
The following example shows how you might create a hierarchy of groups to prepare for the animation of a human figure. Each component of the figure is a separate layer. For example, the arm is made up of hand, forearm, and upper arm layers. Each related layer is in a group that’s nested inside a parent group. For the arm, the hand is nested inside the forearm’s group, which is nested inside the upper arm’s group.

![Diagram of human figure with layers and groups]

**Note:** In this example, each object’s anchor point has been moved to the appropriate axis of rotation for that object. For more information about changing an object’s anchor point, see “Changing an Object’s Anchor Point” on page 273.
Both arms and both legs are also made up of a hierarchy of nested body parts. It then follows that these nested groups of layers, which connect to the torso, are themselves nested inside the Mannequin group. When you collapse the arm and leg hierarchies, you can see the following simplified hierarchy.

![Layer hierarchy diagram]

Nesting groups to simplify a project

With all of these objects organized this way, animating the figure becomes easy. For example, if you want to move the entire arm at once, you need only select the Left Arm group, regardless of how many layers are nested within it.

![Layer hierarchy diagram with Left Arm selected]

Selecting the Left Arm group selects all objects within it.
When you rotate the selection in the Canvas, every object nested within that group rotates as a single item.

Another example of how you might make use of the group hierarchy can be seen through the application of filters and behaviors. If you apply a filter to a single layer within a group, the filter affects only that layer. All other layers within the group remain unaffected.
However, if you apply the same filter directly to the group, all layers nested within that group are affected by the filter, as if they were a single layer.

Background of Your Project
Two parameters in the Project Properties dialog (choose Edit > Project Properties) affect the background color of your project and how your composition will appear when it's exported out of Motion:

**Background Color:** A color well that defines the color that appears in the Canvas if no other object obscures the background.

**Note:** If you intend to export your project with a premultiplied alpha channel, be aware that Motion always renders against black.

**Background:** A pop-up menu that defines whether the background color is rendered as part of the alpha channel. If set to Solid, the background color creates a solid alpha channel. If set to Transparent, the background color does not render as part of the alpha channel. In either case, the background color is visible in the Canvas.

Selecting Layers and Groups in the Layers Tab
In order to reorganize layers and groups in a project, you must first select which ones you want to move. This section covers the many methods you can use to select layers in the Layers tab.

To select a single layer or group:
- Click a layer or group in the Layers tab.
  
  Doing so deselects all other selected objects.

**Note:** Selecting a group does not also select the layers nested underneath it. However, operations performed on a selected group also affect layers nested within it.
To select multiple contiguous layers or groups, do one of the following:
- Shift-click any two layers in the Layers list.
  Doing so selects both layers, and also all layers in between.
- Click to the left of any layer’s thumbnail icon and drag up or down to select multiple layers.

To select or deselect multiple noncontiguous layers or groups, do one of the following:
- Command-click any unselected layer or group to add it to the selection.
- Command-click any selected layer or group to deselect it.

To select all layers or groups in the Layers tab, do one of the following:
- Choose Edit > Select All (or press Command-A).
- Click the first group or layer in the list, then Shift-click the last group or layer in the list.

To deselect all objects or groups in the Layers tab:
- Choose Edit > Deselect All (or press Shift-Command-A).

**Reorganizing in the Layers Tab**
The order in which layers and groups appear in the Layers tab helps to determine the layout of your entire project. The order of layers and groups determines which objects appear to be in front of other objects in the Canvas. You can change the ordering of one or more objects in the Canvas or in the Layers tab.

To move a layer or group up or down in the Layers tab:
- Drag a layer or group up or down in the Layers list.
  A position indicator appears to show the new position the selection occupies when you release the mouse button.

*Note:* You can also use the Bring and Send commands in the Object menu to move layers up and down in the nested hierarchy within any group. This is especially useful when working with selected objects directly in the Canvas. For more information, see “Arrangement Commands in the Object Menu” on page 259.

If you want to organize the objects in your project into multiple groups, you can create new, empty groups at any time.

To create a new, empty group, do one of the following:
- Click the Add button (+) at the top of the Layers tab.
- Choose Object > New Group (or press Shift-Command-N).

New groups always appear at the top of the Layers tab, and are numbered incrementally based on the number of groups you’ve created so far.
When you have more than one group, you can move layers back and forth between them, changing their nested relationship in your project.

**To move a layer from one group to another:**
1. Select one or more layers.
2. Do one of the following:
   - Drag the selected layers to a new position underneath another group. A position indicator appears to show the new position the selection occupies when you release the mouse button. If you drag the selected layers within a nested group, the length of the position indicator shows which position the selection occupies within the group hierarchy.
   - Select one or more layers, choose Edit > Cut (or press Command-X), then select the group you want to paste into, and choose Edit > Paste (or press Command-V).

You can also copy a layer from one group to another.

**To copy a layer from one group to another, do one of the following:**
- Option-drag one or more selected layers from one group to another.
- Select one or more layers, choose Edit > Copy (or press Command-C), then select the group you want to paste into, and choose Edit > Paste (or press Command-V).

**Nesting Groups Inside Other Groups**

In addition to nesting layers inside groups, you can also nest groups inside other groups. You might do this if you’re creating a layer hierarchy to control the relationship of one group of layers to another, or if you’re grouping layers to which you want to apply a single set of behaviors and filters.

Nesting a group works the same way as nesting a layer.

**To move a group inside another group:**
1. Select one or more groups.
2. Do one of the following:
   - Drag the selected group onto another group.
   - Drag the selected group to a new position underneath another group.
   - Select one or more groups, choose Edit > Cut (or press Command-X), then select the group into which you want to paste, and choose Edit > Paste (or press Command-V).

**Grouping and Ungrouping Layers**

You can also nest layers together within a new group using the Group command. You can group layers that appear within the same group, or you can group groups that are all nested at the same level relative to the hierarchy of your project. You cannot group groups that appear at different levels.
To group selected layers together, nesting them in a new group:

1. Select all the layers or groups that you want to group together.
2. Choose Object > Group (or press Shift-Command-G).

A new group is created, and is numbered incrementally based on the number of groups you've created so far. The layers or groups you selected are nested within the new group.

Groups of nested layers or groups can also be ungrouped, which deletes the containing group and moves all objects and layers within it up the group hierarchy.

To ungroup nested layers:

1. Select the group containing the nested layers or groups you want to ungroup.
2. Choose Object > Ungroup (or press Option-Command-G).

Note: You cannot ungroup groups that are already at the top of the Layers list hierarchy.

Showing and Hiding Groups and Layers

Layers and groups appearing in the Layers tab can be hidden in order to make them invisible in the Canvas without removing them from your composition. For example, if you've placed a large object into your project and it's in the way of some other objects you want to move or rotate in the Canvas, you can simply hide the offending object. You can also hide objects you're not sure you want to keep in your project, while preserving their placement in case you want to use them later.

If you hide a group, you also hide all layers and groups that are nested within it. Hidden layers and groups are not rendered when your project is exported.
To show or hide one or more selected layers, do one of the following:

- Click the checkbox to the left of a single object or group in the Layers tab or Timeline.

- Choose Object > Active (or press Control-T) to toggle the layers on or off.

- Control-click a layer or group, then choose Active from the shortcut menu.

*Note:* If you hide one or more layers within a group, the enclosing group’s Activation checkbox shows a dash, instead of a checkmark, to show that its layers are only partially visible.

You can “solo” a layer or group in order to hide all other layers in the project. This technique can be useful when you want to isolate a single object in the Canvas to animate or manipulate without interfering with other objects in your composition.

**To solo a layer:**

1. Select one or more layers or groups to solo.
2. Choose Object > Solo (or press Control-S).

*Note:* You can also Control-click an object in the Layers tab, then choose Solo from the shortcut menu.

All other layers or groups are deactivated, and only the soloed object is visible in the Canvas. When the selected item is soloed, the solo menu item displays a checkmark.
Fixing the Size of a Group

By default, the size of a group is determined by the layers within that group. Because animated objects often grow in size, the active height and width of a group (its resolution) can become quite large. You can constrain the resolution of a group to a specific width and height in the Group tab of the Inspector.

The project shown in the following image contains a particle system. Notice that the animated particles, although not visible once they move off the Canvas, make the group containing them very large.

You can crop the size of a group that contains growing objects using the Fixed Resolution checkbox in the Group tab of the Inspector.

If your project contains animated objects that move or expand beyond the edges of the Canvas and you don't activate the Fixed Resolution checkbox, your computer processing time may increase.

Note: The Group tab of the Inspector (which contains the Fixed Resolution parameter) is only accessible when a group is selected in the project.
When Fixed Resolution is turned on, objects that are in the group but outside of the Canvas are cropped to the size of the group defined in the parameter.

When enabled, the Fixed Resolution parameter crops the group to the size specified in the Fixed Width and Fixed Height parameters. This means that if the group's anchor point is offset, the cropping may not occur around the edges of the Canvas, and objects may become cut off.

To fix the resolution of a group:
1. In the Layers tab (or the Timeline layers list), select the group.
2. In the Inspector, click the Group tab.
3 Turn on the Fixed Resolution checkbox.

By default, the group's resolution is set to the project size.

4 To define a resolution other than that of the project, adjust the Fixed Width and Fixed Height sliders.

**Note:** When a layer within a fixed resolution group is selected, the bounding box around the layer appears at its original size, unaffected by the containing group's resolution.

**Locking Groups and Layers**
Once you've finished making adjustments to a particular layer or group, you can lock it to prevent accidental modification. Locked layers cannot be moved, and their parameters cannot be altered or animated. Animation and behaviors that were applied to the layer prior to being locked still play. Locking a group also locks all layers and groups nested within it.

**To lock layers or groups, do one of the following:**
- Click the layer's lock icon in the Layers tab.
Select one or more layers or groups, then choose Object > Lock (or press Control-L). The locked layer’s bounding box in the Canvas turns red to indicate that it is locked.

Collapsing and Uncollapsing Group Hierarchies
Groups and layers in the Layers tab appear in a hierarchy that shows which layers are nested inside which groups. Nested layers and groups appear underneath and indented to the right of the group they’re nested within.

To make the Layers list easier to manage, you can collapse all layers that appear nested within a single group using that group’s disclosure triangle. Collapsed groups appear as a single line in the list, and can be moved or nested like any other layer. Each group’s thumbnail displays a preview of the entire composite within, making it easy to see what’s nested inside.

To open or collapse a single group, do one of the following:
- Click the disclosure triangle to the left of that group’s name and icon.
- Press the Up and Down Arrow keys to navigate up and down the Layers list, then press the Right Arrow key to open a group, or the Left Arrow key to collapse it.

Renaming Groups
You can rename the groups and layers that appear in the Layers tab to further organize your media and make each group’s and object’s purpose easier to identify. When you rename a layer, the original name of the source media file on disk remains unchanged. Also, changing a layer’s name in the Layers tab does not change the name of its corresponding object in the Media tab. You cannot change the name of an object in the Media tab.

To rename a group or layer:
1. Double-click the name of the group or layer you want to rename.
2. When the name is highlighted, type a new name.
When you're finished, press Return to accept the new name.

The new name is also automatically accepted when you click another layer or group.

**Note:** Once you change a layer’s name in Motion, there is no automatic way to change it back to what it was originally except for the Undo command.

**Searching for Groups and Layers**

If it’s difficult to find a single group or layer in a large project, you can use the Search field at the top of the Layers, Media, and Audio tabs. It is similar to the Search field in the File Browser, and allows you to search for all layers or groups with a name containing the search term you enter.

**To find a group or layer by name in the Layers tab:**

- Type a search term in the Search field.

  As soon as you begin typing, all groups and layers with names that don't contain the search term anywhere within them are hidden from view, leaving only a list of groups and layers that match.

**To clear the search results:**

- Click the Clear button at the far right of the Search field to restore the full contents of the Layers, Media, or Audio tab.

**Note:** Groups and layers that are hidden as the result of a search operation are not disabled in the Canvas, and they are not prevented from rendering during export.

In addition to searching for layers by name, you can find any object’s source media in the Media tab using the Reveal Source Media command.

**To reveal an object’s source media in the Media tab, do one of the following:**

- Control-click an object in the Canvas or a layer in the Layers tab or Timeline, then choose Reveal Source Media from the shortcut menu.

- Select the object in the Canvas or layer in the Layers tab or Timeline, then choose Object > Reveal Source Media (or press Shift-F).

The Media tab and Inspector both open. The “master” object is selected, and its Media tab parameters are exposed in the Inspector.
Sorting Objects in the Media Tab
The Media tab contains 13 columns that provide information about each object in your project.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Displays a thumbnail of the media object.</td>
</tr>
<tr>
<td>Name</td>
<td>Lists the filename of the source media on disk to which the object is linked. If you change the name of corresponding linked objects in the Layers tab, this name doesn't change.</td>
</tr>
<tr>
<td>Kind</td>
<td>Lists the type of file, whether it's a still image, QuickTime movie, image sequence, or audio file.</td>
</tr>
<tr>
<td>In Use</td>
<td>Indicates whether or not the media is in use in the project.</td>
</tr>
<tr>
<td>Duration</td>
<td>Displays the total duration of the object, in frames or timecode, depending on which is displayed in the Timeline.</td>
</tr>
<tr>
<td>Frame Size</td>
<td>Displays the frame size of the object, in pixels.</td>
</tr>
<tr>
<td>Compressor</td>
<td>For QuickTime movies, displays the codec used. For still images, displays the method of compression that's applied based on the file type.</td>
</tr>
<tr>
<td>Depth</td>
<td>Specifies the color depth of the image.</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>Displays the frame rate of the object, in frames per second.</td>
</tr>
<tr>
<td>Data Rate</td>
<td>Displays the data rate at which a QuickTime movie is compressed.</td>
</tr>
<tr>
<td>Audio Rate</td>
<td>For audio files and QuickTime movies, displays the sample rate of the audio.</td>
</tr>
<tr>
<td>Audio Format</td>
<td>For audio files and QuickTime movies, specifies the bit depth of the audio.</td>
</tr>
<tr>
<td>File Size</td>
<td>Shows the size of the source media file on disk.</td>
</tr>
<tr>
<td>File Created</td>
<td>Shows the file creation date of the source media file on disk.</td>
</tr>
<tr>
<td>File Modified</td>
<td>Shows the file modification date of the source media file on disk. This is a useful parameter to use for file management.</td>
</tr>
</tbody>
</table>

You can customize the Media tab to show, hide, or rearrange any of these columns to suit your needs. You can also resize the thumbnails displayed for each object.
To show or hide a column:
- Click the right angle bracket (>) at the right of the column headers, then check or uncheck the columns you want to show or hide in the pop-up menu.

To move a column to the right or left:
- Drag any column header to the right or left to move it.

To increase or decrease the size of each object’s thumbnail, do one of the following:
- Use the scale slider at the bottom of the Media tab.
- Drag the separator between the rows of objects.

Customizing and Creating New Templates
Motion comes with a collection of templates that are ready for you to customize for your own use. In addition, it’s also easy to create your own templates.

Customizing Projects Created with Templates
When you first create a new project file from a template, it’s an exact duplicate of the original template. There’s nothing special about template-based projects, and they can be edited and modified just like any other project. There are a few specific methods you’ll probably use to customize template-based projects.

Keep in mind that most templates, especially ones you create yourself, are intended to simplify the process of creating titles and graphics for recurring projects. Examples include titles and lower thirds for news and interview programs, graphics for magazine shows, and any repeating program that requires titles with a consistent look that must be updated from show to show. Well-designed templates allow you to simply exchange key graphics objects and edit the text to update them for the next show in the series.

Changes you make to new projects created from templates have no effect on the original templates.
Exchanging Objects
The easiest way to customize a template-based project is to exchange the objects used in the template with your own objects, either from the File Browser or the Library. When you exchange an object, the new object appears in your project with the same parameter values used by the previous object. In addition, any filters, masks, behaviors, or keyframed parameters that were applied to the original object remain applied to the exchanged object.

Although there are several groups named “Drop Zone” in various templates, the objects within the groups should be replaced—not the layers themselves.

Note: To quickly find all objects to be replaced in a template, type “Drop Zone” in the Layers tab Search field and press Return. The “Drop Zone” objects are displayed in the Layers tab.

For more information about exchanging objects, see “Exchanging Media in a Project” on page 223.

Drop Zones
Drop zones allow you to quickly replace footage in a project by dropping clips directly onto the Canvas. A drop zone appears as a rectangle with a downward arrow in its center. The drop zone’s layer name appears in the center of the drop zone. Any media item dragged and dropped into the region defined by the drop zone object automatically replaces the drop zone placeholder graphic. When media is dragged over the drop zone, a highlight appears around the drop zone area.

Note: If there are multiple overlapping drop zones in the Canvas, the topmost one has priority when something is dragged onto the drop zone.

For more information about drop zones, see “Using Drop Zones” on page 253.
Customizing Text Objects
Text objects can be easily updated using the Text tool. Editing a text object does nothing to change the format, style, or layout of the text. Furthermore, simple edits made to text objects have no effect on filters, masks, behaviors, or keyframed parameters that are applied to that object.

For more information on editing text objects, see “Working with Text” on page 569.

Modifying Behaviors and Keyframes
Objects in template-based projects are animated using a combination of behaviors and keyframed parameters. These can be edited at any time to customize the motion of the objects. For more information on modifying behaviors, see “Modifying Behaviors” on page 387. For more information on modifying keyframes, see “Modifying Keyframes” on page 538.

Using Objects, Behaviors, and Keyframes from Templates
Occasionally, you may find that you want to use a keyframed parameter or behavior from a template in a project of your own. You can always create a new template-based project, select the keyframes or behaviors you want to use, copy them, and paste them into your own project.

All the graphics objects used by the templates also appear in the Content category of the Library, within the Template Media subcategory. If there’s a particular graphic you want to use, you can find it in the Library.

Creating New Templates
In addition to using and customizing the templates that ship with Motion, you can also build your own templates from scratch. Template files contain everything that ordinary projects do, including media objects, text objects, shapes, generators, behaviors, and filters, in any combination.

You can create custom templates for commonly used shots that you regularly create. For example, if you make titles for a news program, you can create templates for the opening title, interstitial graphics, bumpers, and whatever other repetitious shots you regularly create. Once saved as a template, you can quickly load the necessary template and, instead of having to create a new title from scratch, simply customize it with new dates, title text, and exchanged graphics and movies to reflect the requirements of each new program.
Templates are simply Motion files that are saved in a special way. To create a new template, create the layout you need just like with any other Motion project. In preparation for using the layout as a template, you should keep the following things in mind:

**Naming Objects in the Layers List**
The names you give to the groups and layers in your template should indicate each object’s function. For example, you might name the text objects in a titling template “Main Title,” “Starring,” “Guest Star,” and so on. If you use visual elements in the template’s composition, describe their purpose, such as “Background Texture,” “Divider,” “Main Title Background,” and so on. This way, when someone else wants to customize your template, it’s easy to see what they’re supposed to do with it.

**Using Drop Zones**
Drop zones provide a way for template users to intuitively and quickly replace footage in a template. There are two ways to create drop zones. The first creates a drop zone from scratch, and the second converts an existing object into a drop zone.

To create a new drop zone, do one of the following:
- Choose Object > New Drop Zone (or press Command-Shift-D).
- Select an existing object in the Canvas, then turn on the Drop Zone checkbox in the Image tab of the Inspector.

The Image tab of the Inspector contains controls to adjust the drop zone:

- **Drop Zone**: A checkbox that toggles whether an object is a drop zone.
- **Fit**: A pop-up menu where you can choose between three different methods of object placement within the drop zone. Values can be selected from Fit, Center, and Stretch. Fit automatically modifies the Scale parameter so the new media is scaled proportionally to fit the dimensions of the drop zone. Center does not modify the object in any way, merely centering it in the drop zone. If media of a different resolution than the project is used, the new resolution is used without any changes to the Scale parameter. If Stretch is selected, the dropped object is scaled and stretched to fit the dimensions of the drop zone.
- **Clear**: A button that clears the image from the drop zone, replacing it with the default generic placeholder graphic.

**Creating Multiple Projects for Each Resolution You Require**
If you regularly create projects for a variety of formats, it saves time to create a version of your project for each resolution you need in advance. When you save the project as a template, you can specify its format to help you browse for it later.
Consolidating Media

Unless you selected an alternate installation location when you installed Motion, the built-in templates are stored in the /Library/Application Support/Final Cut Studio/Motion/Templates folder. Customized templates are saved into the /Users/username/Library/Application Support/Final Cut Studio/Motion/Templates folder, but any media used by that template remains in its original location on disk. If you move, rename, or delete any media file used by a template, that object goes offline in all projects created with that template.

To avoid this, it is recommended that you move all media files you plan on using to a central folder on disk prior to importing them into the project file you’ll be saving as a template. This helps to ensure that those media files are not lost. Alternatively, you can use the File > Save As command, and use the Collect Media option. For more information, see “Collect Media” on page 192.

Tip: If you plan to share custom templates with other users, it is recommended that you copy your custom templates folder to that computer’s /Users/username/Library/Application Support/Final Cut Studio/Motion/Templates folder.

Note: In the General section of Motion Preferences (press Command-comma), you can direct Motion to the folder on your system or network that contains the content and templates. This also allows multiple users on a network to share a single, centralized folder.

To save a project as a template:

1. Choose File > Save as Template.
   
The Save dialog appears.

   ![Save dialog screenshot]

   Note: It is recommended that you create a new custom theme in which to save your own templates.

2. If you want to create a new theme to add your new template to, click New Theme, type a name in the New Theme dialog, then click Create.

3. In the Save dialog, type a name for the template.

4. In the Theme pop-up menu, choose a theme in which to store your template.
5 Choose the format that your template conforms to from the Format pop-up menu.

6 If you want your template to play a preview when it appears in the Template Browser, turn on Create QuickTime Preview.

7 Click Save.

Your new template is saved into the theme you selected. Customized templates are saved into /Users/username/Library/Application Support/Final Cut Studio/Motion/Templates, in a folder that corresponds to the name of the theme you’ve selected.

**Organizing Templates in the Template Browser**

You can use the Template Browser to select and organize your templates, if necessary. All templates are organized into categories. You can add, delete, and rename categories directly in the Template Browser.

**To add a category in the Template Browser:**

1 Choose File > Open Template.

   The Template Browser opens.

2 Click New Theme.

3 Enter a name for the theme into the dialog at the top of the Template Browser.

4 Click Create.

   The new category appears in the Theme column at the left.

**To delete a category in the Template Browser:**

1 Choose File > Open Template.

   The Template Browser opens.

2 Select a category in the Theme column.

3 Press Delete.

   An alert dialog prompts you to confirm the deletion.

4 Click the Delete button.

   The directory on your disk corresponding to that category is placed in the Trash, but not deleted. Any template files in that category’s directory are also placed in the Trash.

**To delete individual templates from the Template Browser:**

1 Choose File > Open Template.

   The Template Browser opens.

2 Select a template.

3 Press Delete.

   An alert dialog prompts you to confirm the deletion.

4 Click the Delete button.
Basic Compositing

The most fundamental part of 2D compositing involves arranging the visual elements in your composition by moving, rotating, scaling, and adjusting the transparency of each object in your project.

Compositing is the process of combining at least two images to produce an integrated final result. The process can be as simple as placing text over an image, or as complex as combining live actors with drooling space aliens that shoot laser beams from their eyes. Motion graphics artists move multiple objects simultaneously onscreen using a strong sense of visual design. Motion graphics artists typically use techniques such as changing group and object order, transforming the physical properties of objects (such as scale), adjusting object opacity and blend mode settings, applying filters to objects, and creating text and shapes. Motion graphics projects often combine layout and design techniques with techniques borrowed from special effects work such as keying, masking, color correction, and creation of particle systems.

Once you import the objects you need for your project, the first step is to arrange the objects within the Canvas to come up with the general design of your piece. Even before you animate anything, you should decide what size each object should be, where everything should be positioned, if any objects need to be rotated to fit where they need to be, and so on. You can also make more extreme manipulations to create other effects. For example, you could crop out unwanted parts of a particular object.
You can use different transform tools, each of which allow you to perform basic compositing tasks such as selecting, moving, rotating, scaling, shearing, corner-pinning, cropping, changing an object’s anchor point, and manipulating drop shadows. The transform tools are available in the View section of the Toolbar. When you switch among the transform tools, different onscreen controls appear in the Canvas. Drag these controls to perform the selected transform action.

![Drag a corner handle of an object in transform mode to resize it.](image)

Additional controls in the HUD let you change each selected object’s opacity, blend mode, and drop shadow settings.

![Additional controls in the HUD](image)

The onscreen controls and the HUD controls all correspond to parameters that appear in the Properties tab of the Inspector. Each parameter corresponds to a different Canvas control, and adjustments made in the Canvas are simultaneously updated in the Inspector. For example, if you’re using the Select/Transform tool and you change an object’s scale by dragging its corner handles in the Canvas, the object’s Scale parameter is updated in the Properties tab of the Inspector.
When you begin to lay out a composition, it’s a good idea to start by creating a static layout of your project that represents how it looks at the beginning, end, or at a particular moment in time. In addition to manipulating the geometry of objects in your project, you can also alter their opacity. This gives you additional control over how overlapping elements of your layout merge together. Blend modes provide further control over the appearance of overlapping objects, accentuating or stylizing the colors of the topmost objects based on the objects underneath.

After you create an initial layout, you can animate any of the objects you’ve added to set your project in motion. For more information about animating objects and their properties, see “Animation in Motion” on page 504.

Group and Layer Order
As discussed in Chapter 2, “Creating and Managing Projects,” in a purely 2D project, the order in which layers and groups appear in the Layers tab and Timeline (the layer order) determines which layers appear in front of others in the Canvas. Before you use any of the tools described in this chapter, you should first arrange the layers and groups in your project so that they appear in the proper order.

Arrangement Commands in the Object Menu
In addition to rearranging object order in the Layers tab, you can also move objects in front of or behind other objects using commands in the Object menu. This is useful when you want to quickly move an object to the front while you’re working in the Canvas. Rather than open the Layers tab, you can simply use one of the commands in the Object menu.

The arrangement commands can be used with either objects, groups, or groups that are nested within another group. Reordering a group reorders all objects that are nested within that group.

Note: You cannot use the reorder commands to move objects out of the group they’re nested within.

There are four arrangement commands in the Object menu:
**Bring to Front:** Places the selected object in front of all other objects within the same group by moving it to the top of the nested group in the Layers tab and Canvas.

![Comparison Image](image1)

Before | After
--- | ---

**Send to Back:** Places the selected object behind all other objects within the same group by moving it to the bottom of the nested group in the Layers tab and Canvas.

![Comparison Image](image2)

Before | After
--- | ---

**Bring Forward:** Moves the selected object up one level in the hierarchy of objects nested within the same group in the Layers tab and Canvas, moving it closer to the front in the Canvas.

**Send Backward:** Moves the selected object down one level in the hierarchy of objects nested within that group in the Layers tab and Canvas, moving it closer to the back in the Canvas.
Reordering Nonconsecutive Selections
When you apply an arrangement command on nonconsecutive selected layers, the layers move up or down the object hierarchy together, and any space between them collapses.

Object and Layer Transforms in the Canvas
Transforms are operations that you perform on objects—such as moving, resizing, or rotating. Object transforms can be performed either directly using onscreen controls (transform handles), or by changing the object’s parameters in the Properties tab of the Inspector. In general, the controls in the Canvas give you a more hands-on method of working, while the individual parameter controls in the Properties tab are better suited for subtle adjustments requiring greater numerical precision. For some operations, you can even use the keyboard.

Selecting Objects to Transform
Before you can transform objects and groups, you must first select what you want to transform in the Canvas, Layers tab, or Timeline. Selecting a group or object in one place also selects it in the others.

When an object is selected in the Canvas, it is surrounded by a bounding box with transform handles corresponding to the currently selected transform mode. These handles allow you to transform each selected object.

To select a single object in the Canvas:
- Click any object in the Canvas.

To select multiple objects in the Canvas, or to add objects to a selection, do one of the following:
- Drag a selection box over all the objects you want to select.
- Press Shift and click all the objects you want to select.
- To add objects to a selection, press Shift, then drag a selection box over objects you want to add to the selection.
To deselect one of multiple selected objects in the Canvas, do one of the following:

- Shift-click an object you want to deselect.
  All other selected objects remain selected.
- Press Shift or Command, then drag a selection box over one or more objects you want to deselect.

To select all objects in the Canvas, do one of the following:

- Choose Edit > Select All.
- Press Command-A.

To deselect all objects in the Canvas, do one of the following:

- Choose Edit > Deselect All.
- Press Shift-Command-A.

From time to time, an object may become hidden behind another object. The best way to select a hidden object is to select it in the Layers tab or Timeline. When you do so, the object’s bounding box and transform controls appear in the Canvas, even if the object is completely obscured.

Note: When an inactive object is selected, you also see only the bounding box for that object.

For more information on how to select objects and groups in the Layers tab, see “Selecting Layers and Groups in the Layers Tab” on page 239.
**Rules for Transforming Selected Objects and Groups**

The way you transform selected objects depends on how many objects are selected.

**Transforming a Single Object**

If you select a single object, the changes you make only affect that one object. All unselected objects remain unaffected. For example, if you select a single object, transform handles appear around that one object.

![Before scaling](image1)

![After scaling](image2)

**Transforming Multiple Objects**

If you select multiple objects in the Canvas, changes made to one object are simultaneously made to all others. Each transform occurs around each object’s own anchor point, so the effect is the same as if you made the same transform to each object’s handles, one object after another.

![Before scaling](image3)

![After scaling](image4)
Transforming a Group
If you select an entire group, all objects and groups that are nested within it are treated as a single object. One set of transform handles appears on a bounding box that encompasses every object within that group. All object transforms occur around a single anchor point belonging to the group.

Using 2D Transforms
Transforms allow you to arrange and manipulate objects spatially within the Canvas. Transforms are so named because they allow you to transform objects and groups in your project by moving, scaling, rotating, shearing, corner-pinning, and cropping them. Each of these operations can be performed in one of two ways—using graphical handles in the Canvas, or using each object’s parameter controls in the Inspector.

This section describes the use of the graphical controls in the Canvas. These onscreen controls provide the most intuitive and hands-on method of arranging the objects in your project. For more information about each transform’s corresponding parameter and its numerical values, see “Object Geometry Controls in the Inspector” on page 279.
Switching Among Transform Tools
Before you transform an object, you should make sure that the pointer is set to the correct transform tool. These tools can be selected from the Toolbar.

The six main 2D transform tools are:

Select/Transform: Scales and rotates selected objects.

Adjust Anchor Point: Offsets the anchor point used for all object transforms.

Adjust Shear: Tilts objects, either horizontally or vertically.

Adjust Drop Shadow: Manipulates object drop shadows directly in the Canvas.

Adjust Four Corner: Stretches an object into different polygonal shapes.

Adjust Crop: Cuts off pixels from any of the object’s four edges.

Note: Each transform tool also allows you to select and reposition objects in the Canvas.

The Adjust Control Points tool becomes available when a shape or mask is selected and is used to adjust a Bezier or B-Spline control points. The Adjust Item tool becomes available when the selected item has additional onscreen controls, such as a filter or a gradient generator.

To switch among transform tools, do one of the following:

- Click the Select/Transform tool in the Toolbar, then, while holding down the mouse button, choose a transform tool from the pop-up menu.
- With an object in the Canvas selected, press Tab. Pressing Tab repeatedly cycles the Canvas through each of the transform modes in order.

Note: Press Shift-Tab to cycle through the transform modes in reverse.
Control-click any object in the Canvas, then choose a transform mode from the shortcut menu.

For more information about 3D transform tools, see “3D Compositing” in the Motion Supplemental Documentation PDF.

Using Canvas Compositional Aids
When you’re arranging objects directly in the Canvas, take advantage of various compositional aids to help you. For example, if you are working on a piece for broadcast or film, turn on the safe zones in the Canvas to avoid putting objects past the title- or action-safe boundaries. A grid and rulers can also be enabled to provide a useful reference, and Dynamic Guides can be turned on to help you align objects with more precision than by simply looking at them.

Furthermore, snapping can be toggled on and off to help you position objects relative to the center and edges of the Canvas, either with or without the other guides enabled.

Note: Press Command while you manipulate an object to temporarily disable snapping, allowing the object to move freely.

For more information about enabling various Canvas options to help you lay out your composition, see “View and Overlay” on page 44.
Moving Objects in the Canvas
The simplest thing you can do to start arranging the objects in your project is to move them around. With the exception of the Adjust Drop Shadow tool, all transform tools let you reposition objects, so this is the one operation you can perform regardless of the currently selected transform tool.

The easiest way to reposition an object is to drag it around within the Canvas. If you want to make more precise adjustments to an object’s position, you can also change the numerical values of an object’s X and Y Position parameters in the Properties tab of the Inspector. For more information on object properties, see “Parameters in the Properties Tab” on page 280.

You can move objects anywhere within the frame defined by the Canvas, but you can also drag objects past the edge of the frame. By default, when you move an object past the edge of the frame, it becomes invisible, although you can still manipulate it using its bounding box.

Note: The bounding box that indicates the position of objects located offscreen only appears when those objects are selected.

One example of when it’s necessary to move an object past the edge of the frame is when you plan on animating an object so that it flies onscreen. Prior to animating it, you need to move it to a position offscreen to achieve this effect.

Note: To make an object completely visible that is partially or totally outside of the Canvas, turn on Show Full View Area in the View pop-up menu (directly above the right side of the Canvas).

To move one or more objects in the Canvas:
1 Select one or more objects.
2 Do one of the following:
   • Drag an object to another location. If more than one object is selected, dragging one of the currently selected objects moves all of them.
   • Press Command, then press the Right Arrow, Left Arrow, Up Arrow, or Down Arrow key to reposition the selected objects one pixel at a time.
   • Press Command-Shift, then press the Right Arrow key or the Left Arrow key to reposition the selection ten pixels at a time.
Note: When repositioning very small objects, it may be necessary to zoom into the Canvas to get a better view.

Note: If you press the Up Arrow key or the Down Arrow key while working in the Canvas, the selection is applied to the next object up or down in the Layers tab.

To duplicate an object, do one of the following:
- Select the object you want to duplicate, then Option-drag the object.
- Option-click the object, then choose Duplicate from the shortcut menu.

**Using Object Alignment Commands**
Several commands in the Object menu let you reposition any number of simultaneously selected objects to align with one another in various ways. These commands make it easy to quickly organize a jumble of objects into an even layout without having to manually line up each individual object.

In each operation, the left, right, top, and bottom of the selected objects are defined by the bounding box that surrounds each individual object. The position of the anchor point is ignored.

Each of these commands affects the Position parameter of each object.

**Align Left Edges**: Objects are moved horizontally so that their left edges line up with the leftmost object in the selection.

**Align Right Edges**: Objects are moved horizontally so that their right edges line up with the rightmost object in the selection.

**Align Top Edges**: Objects are moved vertically so that their tops line up with the topmost object in the selection.

**Align Bottom Edges**: Objects are moved vertically so that their bottoms line up with the bottommost object in the selection.
**Align Far Edges:** Objects are moved in Z space so that their far edges line up with the furthest object in the selection.

**Align Near Edges:** Objects are moved in Z space so that their near edges line up with the closest object in the selection.

**Align Horizontal Centers:** Objects are moved horizontally so that their centers line up along the center point between the leftmost and rightmost objects in the selection.

**Align Vertical Centers:** Objects are moved vertically so that their centers line up along the center point between the topmost and bottommost objects in the selection.

**Distribute Lefts:** Objects are moved horizontally so that the left sides of all objects are evenly distributed, from right to left, between the leftmost and rightmost objects in the selection.

**Distribute Rights:** Objects are moved horizontally so that the right sides of all objects are evenly distributed, from right to left, between the leftmost and rightmost objects in the selection.

**Distribute Tops:** Objects are moved vertically so that the tops of all objects are evenly distributed, from top to bottom, between the topmost and bottommost objects in the selection.

**Distribute Bottoms:** Objects are moved vertically so that the bottoms of all objects are evenly distributed, from top to bottom, between the topmost and bottommost objects in the selection.

**Distribute Far:** Objects are moved in Z space so that the far edges of all objects are evenly distributed along the Z axis, from closest to furthest, between the closest and furthest objects in the selection.

**Distribute Near:** Objects are moved in Z space so that the near edges of all objects are evenly distributed along the Z axis, from closest to furthest, between the closest and furthest objects in the selection.

**Distribute Horizontal Centers:** Objects are moved horizontally so that the centers of all objects are evenly distributed, from left to right, between the leftmost and rightmost objects in the selection.

**Distribute Vertical Centers:** Objects are moved vertically so that the centers of all objects are evenly distributed, from top to bottom, between the topmost and bottommost objects in the selection.

**Distribute Depth Centers:** Objects are moved in Z space so that the centers of all objects are evenly distributed, from closest to furthest, between the closest and furthest objects in the selection.
**Transform Tools**
The transform controls do double duty, allowing you to both resize (scale) and rotate an object within a single mode.

**Scaling**
When you select an object, eight scale handles appear around the edge of the object’s bounding box. Drag the handles to resize the object. By default, the width and height of an object are not locked together when you adjust scale handles. This means that the aspect ratio of an object can be freely changed. (The aspect ratio of an object is the ratio of its width to its height.) To preserve an object’s aspect ratio, press Shift while dragging a scale handle. Changes made to the scale of an object are applied to the Scale parameter in the Properties tab of the Inspector.

To resize the height and width of an object in the Canvas independently:
1. Click to select the object in the Canvas.

   If you have another tool selected, such as the Mask tool, pressing the S key returns you to the transform tools.

   A bounding box appears around the selected object.

   **Note:** You can also Control-click the object in the Canvas, then choose Transform from the shortcut menu.
2. Do one of the following:

- Drag one of the corner handles to resize the object’s width and height at the same time. By default, you can resize the width and height independently, by any amount.

- Press Shift, then drag any of the corner handles to resize the object while locking its width and height together, maintaining the object’s current aspect ratio.

- Drag the top or bottom scale handle to limit scale changes to the object’s height, or drag the left or right scale handle to limit scale changes to the object’s width.
Press Option while dragging any scale handle to resize an object around its anchor point, rather than unilaterally.

As you drag the scale handles, an info window appears and shows you the new width and height percentages and the amount by which the object is changing. This amount is represented by a delta symbol.

Note: Scaling the width or height of an object by a negative value reverses the image, flipping its direction.

Rotating
Another transform handle allows you to rotate the image around its anchor point. For animation purposes, Motion keeps track of the number of times you’ve rotated the object and stores this value in that object’s Rotation parameter in the Properties tab of the Inspector.

To rotate an object in the Canvas:
1 Click to select the object in the Canvas.
   Note: The Select/Transform mode is the default mode when Motion opens.
2 Do one of the following:
   • Drag the rotation handle to rotate the object.
   • Press Shift while you drag the rotation handle to constrain the angle of the selected object to 45 degree increments.
As you drag the rotation handle, the original angle of the object is indicated by a small circle that appears on a larger circle surrounding the object’s anchor point. Additionally, an info window appears, showing you the new angle of rotation and the delta of change between the object’s former angle and the angle to which you’ve dragged it.

Changing an Object’s Anchor Point
You can move any object’s anchor point, changing the way in which different geometric transforms are performed. Objects rotate around the anchor point, but the anchor point also affects shearing and resizing operations.

For example, the default anchor point for any object is the center of the bounding box that defines its edges. If you rotate an object, it spins around this central anchor point.
If you move an anchor point, however, the object no longer rotates around its own center, but instead rotates around the new anchor point.

This not only affects the rotation of an object, but any moving and scaling operations performed upon that object as well. Changes made to an object’s anchor point are stored in the Anchor Point parameter of the Properties tab in the Inspector.

**To change the anchor point of an object in the Canvas:**

1. Click and hold the Select/Transform tool, then choose the Adjust Anchor Point tool from the pop-up menu.

   In the Canvas, the object’s anchor point appears as a round target surrounded with three colored arrows representing the X, Y, and Z coordinate axes. For more information on coordinate axes, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.

2. Do one of the following:
   - Drag the white circle to move the anchor point vertically or horizontally.
   - Drag one of the arrows to move the anchor point along the corresponding axis.

   As you drag the anchor point, a line stretches from the default position of the anchor point to its new position. Additionally, an info window appears and shows you the anchor point’s new coordinates on top and the delta (amount of change) between the anchor point’s new and old positions.

   **Note:** If the anchor point is close to the center or edges of the object, and Dynamic Guides are turned on, the anchor point snaps to that location.
Shearing Objects
The shear handles can be used to slant an object, either horizontally or vertically. This is an isometric operation, so it doesn't necessarily provide a realistic perspective effect. When you shear an object, this change is stored in that object's Shear parameter, which can be seen in the Properties tab of the Inspector.

To shear an object in the Canvas:
1. Click and hold the Select/Transform tool, then choose the Adjust Shear tool from the pop-up menu.
2. In the Canvas, drag one of the four shear handles to slant the object. The top and bottom controls angle the object horizontally, while the left and right controls angle the object vertically.
Adjusting the Drop Shadow of an Object

Once an object's drop shadow is enabled, the onscreen drop shadow handles can be used to change the blur, angle, and distance of an object's drop shadow.

**To adjust the drop shadow of an object in the Canvas:**

1. Click and hold the Select/Transform tool, then choose the Adjust Drop Shadow tool from the pop-up menu.

2. In the Canvas, drag one of the four corner handles to adjust the blur of the drop shadow.

   Drag within the shadow's bounding box to adjust the distance and angle of the drop shadow.

   For more information on working with drop shadows, see "Drop Shadows" on page 309.
**Corner-Pinning Objects**

You can stretch an object into different polygonal shapes using the Four Corner controls, which allow you to create false perspective effects and simulate 3D effects and placement within your composition.

To corner-pin an object in the Canvas:

1. Click and hold the Select/Transform tool, then choose the Adjust Four Corner tool from the pop-up menu.

2. In the Canvas, drag each of the four corner handles to stretch the object into the shape you want.

   *Note:* Just as you can with the Scale handles, you can reverse the corner handles to flip the image. However, changing the angle of any one corner more than 180 degrees can produce unexpected results.

After you have corner-pinned an object, you can quickly revert back to the object’s original shape by turning off the object’s Four Corner checkbox in the Properties tab of the Inspector. Doing so resets the shape of the object without resetting the corner-pinning shape you defined in the Four Corner parameter of the Properties tab.
**Cropping Objects**

Cropping allows you to chop off each of the four edges of an object to eliminate parts you don’t want to see in your composition. Common examples of objects you'd want to crop are video clips with a black line along the right or left edge because of the video format or with vignetting around the edges because of a wide-angle lens. You can use the crop operation to cut these undesirable artifacts out when using them in your composition. You could also crop an object to isolate a single element of the image, so long as that element can be adequately cut out with a simple rectangular shape.

![Before cropping](image1.png) ![After cropping](image2.png)

**Cropping in the Inspector Versus Cropping in the Media Tab**

When you crop an imported image using the onscreen transform tool (which is the same as using the Crop controls in the object’s Properties tab), only the instance of that file is cropped. The source image in the Media tab is not cropped. To crop the source image, you must select the object in the Media tab of the Project pane, then use the Crop tools in the Media tab of the Inspector. For more information, see "Object Parameters in the Media Tab" on page 225.

*Note:* If you need to isolate a more irregularly shaped object, or you want to create a border of a particular shape, see "Using Shapes and Masks" on page 997 for more information.

**To crop an object in the Canvas:**

1. Click and hold the Select/Transform tool, then choose the Adjust Crop tool from the pop-up menu.
2 In the Canvas, drag one of the eight handles around the edge of the object to crop it:
   - Drag the top, left, right, or bottom handle to only crop that side.
   - Drag one of the four corner handles to crop both corresponding sides simultaneously.
   - Press Shift while you drag to constrain corner edge cropping to the aspect ratio of the object.

*Note:* If an object is corner-pinned, you can no longer enable the Crop mode in the Canvas (onscreen controls). You can still crop a corner-pinned object by adjusting its Crop parameter settings in the Properties tab of the Inspector.

Additionally, the crop area and the image can be manipulated separately.

**To move the crop area while keeping the underlying image in place:**
- Press Command and Option while you drag inside the crop area.

**To move the image while keeping the crop area in place:**
- Press Command while you drag inside the crop area.

**Adjusting Control Points**
You can modify a shape or mask directly in the Canvas.

**To modify a shape's control points in the Canvas:**
1 Once the shape or mask is created, click and hold the Select/Transform tool, then choose the Adjust Control Points tool from the pop-up menu.

*Note:* You can also double-click the shape, or Control-click the object, then choose Edit Points from the shortcut menu to enter the Adjust Control Points mode.

The object’s control points become active.

2 In the Canvas, drag the points to modify the shape of the object.

For more information on working with shapes and masks, see "Using Shapes and Masks" on page 997.

**Object Geometry Controls in the Inspector**
Groups and objects have the same geometric parameters in the Properties tab of the Inspector. Manipulating a Canvas transform control also changes the corresponding parameter in the Properties tab of the Inspector. If you want to transform an object more precisely than the onscreen controls allow, you can change that parameter’s value directly.
When you select a single object and open the Properties tab of the Inspector, the object's parameters are displayed. Making changes to the values in the Properties tab affects the selected object. If more than one object is selected in the Canvas, Timeline, or Layers tab, the parameter values displayed in the Properties tab of the Inspector become inaccessible. However, you can still adjust the onscreen controls. Manipulating any of the onscreen transform handles affects every selected object equally.

To modify parameter values in the Properties tab of the Inspector, do one of the following:

- Select a parameter value field, type a new number, then press Return.
- If the parameter has a graphical control, such as a slider or dial, adjust the control.
- To reset a parameter to its default state, either click its reset button, or choose Reset Parameter from the parameter’s Animation menu.

For more information on how to use the parameter controls, see “Types of Controls” on page 125.

Parameters in the Properties Tab

The Properties tab displays the following parameters for most objects and groups:

Position: Defines the X (horizontal), Y (vertical), and Z (depth) position of each object.

The coordinate system used by Motion specifies the center of the Canvas as 0, 0, 0 regardless of the frame size of the project. Moving an object to the left subtracts from the X value, while moving to the right adds to the X value. Moving an object up adds to the Y value, and moving an object down subtracts from the Y value. Moving an object closer adds to the Z value, while moving further away subtracts from the Z value.

Note: This is identical to the coordinate system used by Final Cut Pro and Final Cut Express HD, but different from that used by Shake, in which 0,0 defines the upper-left corner of the compositional area.
Each object’s position is centered on its anchor point. Offsetting the anchor point also offsets the position of the object relative to the X, Y, and Z position values you have set.

**Rotation:** Controls a one-dimensional value representing the number of degrees of rotation. A positive value rotates the object counter-clockwise. A negative value rotates the object clockwise.

Rotating an object beyond 360 degrees results in multiple rotations when the Rotation parameter is animated.

Click the disclosure triangle next to the Rotation parameter to reveal additional subparameters:

- **Animate:** This pop-up menu allows you to set the interpolation for animated 3D rotation channels to one of two options:
  
  **Note:** The Rotation parameter must be keyframed for the Animate parameter options to have any effect.

  - **Use Rotation:** The default interpolation method. Pattern elements rotate from their start rotation to their final rotation. Depending on the animation, the elements may twist this way and that before reaching their final orientation (the last keyframed value). For example, if the X, Y, and Z Angle parameters are animated from 0 degrees to 180 degrees in a project, the elements rotate on all axes before reaching their final orientation.
  
  - **Use Orientation:** This alternate interpolation method provides for smoother interpolation but does not allow multiple revolutions. It interpolates between the pattern elements’ start orientation (first keyframe) to their end orientation (second keyframe).

**Scale:** Controls the percentage representing the object’s scale, relative to its original size. By default, the horizontal and vertical scale of an object is locked together at the object’s original aspect ratio—all of which is represented by a single percentage. Click the disclosure triangle to display independent percentages for the X, Y, and Z scales of the object.

**Note:** Setting an object’s scale to a negative value flips the object.

**Shear:** Defines the X and Y shear of the object. An object with no shear has X and Y shear values of 0. Positive values shear in one direction, while negative values shear in the other.

**Anchor Point:** Defines the X, Y, and Z position of the anchor point relative to the center of the object. Coordinates of 0, 0, 0 center the anchor point in the bounding box defining the outer edge of the object.

**Opacity:** Defines the transparency of the object. For more information, see “Editing Opacity and Blending” on page 285.
Blend Mode: Sets the Blend Mode of the object. For more information, see “Editing Opacity and Blending” on page 285.

Preserve Opacity: When this checkbox is turned on, the object appears only where another object is visible behind it in the composite. The front object uses the opacity value of the object behind it. For more information, see “Preserve Opacity Option” on page 289.

Drop Shadow: Turns the drop shadow of an object on and off. For more information about working with drop shadows, see “Drop Shadows” on page 309.

Four Corner: Turns corner-pinning on and off. If an object has been corner-pinned and this checkbox is turned off, the object resumes its original shape, although the corner-pinning coordinates are maintained. Turning the checkbox back on re-enables the corner-pinning effect specified by the Four Corner coordinate parameters.

Crop: Turns cropping on and off. If an object has been cropped and this checkbox is turned off, the object resumes its original size, although the cropping values are maintained. Turning the checkbox back on re-enables the cropping effect specified by the crop parameters.
Click the disclosure triangle to display four crop parameters. Each defines the number of pixels to be cropped from each of the object’s four sides, relative to the outer edge of the bounding box that surrounds it. These parameters are similar to the crop parameters that appear when an object is selected in the Media tab, except that cropping an object in the Layers tab only crops the currently selected instance of that object in your project. Duplicates of that object remain untouched. If you want to crop all instances of the object simultaneously, use the Crop parameter on the object in the Media tab. For more information, see “Object Parameters in the Media Tab” on page 225.

**Timing:** These parameters control all aspects of clip retiming. For more information, see “Retiming” on page 312.

### Making Clone Layers

In a motion graphics project, sometimes it is necessary to reuse a complex object in other parts of the project multiple times. Although you can duplicate or cut and paste any object, if you update the original, none of the changes you make are applied to the copies. It can become a tedious and difficult management task. If you find yourself applying the same filters and masks to more than one copy of an object, you should take advantage of the Make Clone Layer command. Making clone layers has the additional benefit of improving project playback and rendering performance.

**To create a clone layer, do one of the following:**

- Select the object from which you wish to make a clone layer, then choose Object > Make Clone Layer.
- Control-click an object in the Canvas, then choose Make Clone Layer from the shortcut menu.
- Control-click an object in the Layers tab or Timeline layers list, then choose Make Clone Layer from the shortcut menu.

A clone layer is created and appears in the center of the Canvas. In the Layers list, the clone layer appears with the default name “Clone Layer.” A Clone Layer icon appears next to the name.

![Layers tab with Clone Layer](image)

**Note:** If your source object is located in the center of the Canvas, the two objects overlap.
The clone layer inherits the following properties from its source object at the time of its creation: Rotation, Scale, Opacity, Blend Mode, and Drop Shadow. Adjustments made to any of these properties of the source object after clone layer creation do not propagate to any clone layers made from the same source object. The clone layers only inherit changes made to filters and masks in the source object.

**Important:** Changes to behaviors don’t propagate to clone layers, unless the behavior affects a filter or mask in the source object.

Clone layer objects can be manipulated in the Canvas and Timeline in exactly the same way as the source object.

**Important:** A clone layer created from retimed objects cannot have its Frame Blending parameter changed from that of the source object.

You can make clone layers out of layers, groups, particle systems, text, shapes, and Replicators.

**Clone Layers and Rasterization**

Some operations, as well as the application of certain filters or a mask, cause a clone layer to be rasterized. When a clone layer is rasterized, it is converted into a bitmap image. The blend mode of a clone layer does not interact with objects outside of the group that contains the clone layer. In addition, a 3D clone layer is treated as a single object and uses layer order (in the Layers tab), rather than depth order when composited in the project.

For more information on rasterization and 3D Clone Layers, see “3D Compositing” in the Motion Supplemental Documentation PDF.

**Note:** Cameras and lights in the project interact with Clone Layers.

For more information on rasterization in groups, see “About Rasterization” on page 288.
Editing Opacity and Blending
The opacity and blending controls for each object appear both in the Properties tab of the Inspector, and in the default HUD for any selected object.

Opacity
By layering together objects with varying opacities, you can merge them together in ways not otherwise possible. For example, if you have two full-screen background images that you want to use together, you can set the opacity of the object in front to 50%, allowing the object in back to show through.

You can overlap as many objects as you want, and by varying their opacities, selectively reveal objects in the back.

To change an object’s opacity, do one of the following:
- Adjust the opacity slider or value slider in the Properties tab.
- Adjust the opacity slider in the HUD.

Blend Modes
While the Opacity parameter simply defines a uniform level of transparency for an object, the blend modes allow you many more creative options to control how the overlapping images interact, based on the colors in each object. By default, each object’s blend mode is set to Normal, so that changes to an object’s opacity uniformly affect every part of the image equally.
Blend modes can create transparency in an object regardless of the setting of its opacity parameter. This is because the pixels of an image with a selected blend mode are combined with the pixels of any objects lying immediately below it in the Canvas. For example, if you overlapped two objects, then turned the blend mode of the top one to Screen, the darker areas of the screened image become transparent, while the lighter areas remain more solid, resulting in the following image:

![Image](image.jpg)

**Important:** The transparency created by most of the available blend modes only affects how an object combines with overlapping objects underneath. These blend modes do nothing to affect an object’s alpha channel. For information about blend modes that do affect an object’s alpha channel, see “Blend Modes That Manipulate Alpha Channels” on page 307.

Each blend mode combines objects in different ways. For example, setting the top object’s blend mode to Multiply yields a result opposite to that of the Screen blend mode, as the darker areas of the image remain solid, and the lighter areas become transparent.

![Image](image2.jpg)
Blend modes only affect the combination of an object with the objects below it. Any objects appearing above have no effect on this interaction, even if the object is transparent. In the following example, the text objects on the top level have no effect on the blended images below.

For overlapping layers with different blend modes, the bottommost pair of objects is combined first, and that combination then interacts with the next object up, and so on until all overlapping objects have been combined for the final image. In this case, each object with a specified blend mode only interacts with the image below it, whether that image is a single object or a pair of objects that have been blended together.

Each of Motion's blend modes works in conjunction with the Opacity parameter to alter the interaction between the foreground and background objects. Adjusting an object's opacity lessens the blending effect that is assigned to it, even as it reduces that object's visibility. This allows you to customize any blend mode to better suit your needs.

Blend modes only affect overlapping objects, and have no interaction with your project's background color. If you specify a blend mode for an object that doesn't overlap anything, that object remains as it was before.

**To change a selected object's blend mode, do one of the following:**

- Choose an option from the Blend Mode pop-up menu in the HUD.
- Choose an option from the Blend Mode pop-up menu in the Properties tab.
- Choose Object > Blend Mode, then choose an option from the submenu.
- Display the Blend Mode column in the Layers tab, then choose an option from an object's Blend Mode pop-up menu.
- Control-click an object in the Canvas, then choose an option from the Blend Mode submenu in the shortcut menu.
- Control-click an object in the Layers tab or Timeline layers list, then choose an option from the Blend Mode submenu in the shortcut menu.
About Rasterization
Some operations, as well as the application of certain filters or a mask, cause a group to be rasterized. When a group is rasterized, it is converted into a bitmap image. Rasterization affects 2D and 3D groups in different ways. When a 2D group is rasterized, the blend modes on objects within the group no longer interact with objects outside of the group. In addition, when a 3D group is rasterized, the group as a whole can no longer intersect with objects outside of the group. The rasterized 3D group is treated as a single object and uses layer order (in the Layers tab), rather than depth order when composited in the project.

Note: When a 3D group is rasterized, cameras and lights in the project still interact with objects within the rasterized group.

For more information on rasterization and 3D groups, see “3D Compositing” in the Motion Supplemental Documentation PDF.

Important: Lighting in a 2D group does not pass beyond the boundaries of that 2D group, whether it is rasterized or not.

Changes to the following parameters trigger rasterization of a group:

2D Groups
• Making Blending changes (Opacity, Blend Mode, Preserve Opacity)
• Turning on Drop Shadow
• Turning on Four Corner
• Turning on Crop
• The application of any filter
• Adding a mask
• Adding a light

3D Groups
• Blending changes
• The application of certain filters
• Adding a light to a 3D group with the Flatten parameter turned on (in the Group tab of the Inspector)

Once an operation triggers rasterization of a group, the following occurs:
• A rasterization indicator (resembling an LED) appears next to the parameter in the Properties tab.
• A small outline appears around the 2D or 3D group icon (to the left of the group name) in the Layers tab and Timeline layers list.
**Preserve Opacity Option**
The Preserve Opacity checkbox allows you to limit an object’s visibility to areas of the Canvas where the object overlaps nontransparent regions of other objects. For example, you might place two overlapping objects into your project, as shown below:

If you turn on Preserve Opacity for the Dolphin object in front, the result is this:

The only area of the Dolphin object that is visible is the area that overlaps the sea life picture object behind it. At first, this may not appear to be very exciting, but the Preserve Opacity checkbox can be used in combination with the opacity and blend mode to create some very interesting effects.

*Note:* The object with the enabled Preserve Opacity parameter takes the opacity value of the object beneath it in the composite stack.
Preserve Opacity is an easy way to selectively reveal part of an object. In this example, by setting the blend mode of the top color wash layer to Exclusion, you get the resulting image:

![Resulting Image](image1)

By turning on Preserve Opacity for the color wash layer on top, only the overlapping parts are displayed, and the superimposed image only affects the Dolphin layer.

![Preserve Opacity](image2)

**To turn on Preserve Opacity:**
- Turn on an object’s Preserve Opacity checkbox in the Properties tab.

**Using Blend Modes**
Each of the available blend modes presents a different method for combining two or more images together. Blend modes work in addition to an object’s alpha channel and opacity parameter.

**How Blend Modes Affect Images**
To understand the descriptions of each blend mode in this section, it’s important to understand that blend modes mix colors from overlapping images together based on the brightness values within each color channel in an image. Every image consists of red, green, blue, and alpha channels. Each individual channel contains a range of brightness values that define the intensity of each pixel in the image that uses some of the channel’s color.
The effect that each blend mode has on overlapping objects depends on the range of color values within each object. The red, green, and blue channels within each overlapping pixel are mathematically combined to yield the final image.

These value ranges can be described as blacks, midrange values, or whites. These regions are loosely illustrated by the chart below.

<table>
<thead>
<tr>
<th>Blacks</th>
<th>Midrange color values</th>
<th>Whites</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For example, the Multiply blend mode renders color values that fall into the white areas of an image transparent, while the black areas of the image are left alone. All midrange color values become translucent, with colors falling into the lighter end of the scale becoming more transparent than the colors that fall into the darker end of the scale.

**Group Blend Modes**
Blend modes work differently depending on whether they're used with groups or layers. In particular, the Pass Through blend mode is only available for groups.

**Pass Through**
When a group is set to Pass Through, each object is individually blended with all objects and groups that appear underneath it in the Layers tab. In this example, the Swirls object is set to Stencil Luma, and the Fishes object is set to Add.
With the enclosing group set to Pass Through, the Swirls object stencils all other objects underneath it, including the Gradient object in the bottom group. The result is that all objects are stenciled against the background color. The Fishes object is likewise added to the combined stack of objects.

![Image](image.jpg)

**Normal**

When a group is set to Normal, the layers nested within that group can only be blended with one another. Objects nested within that group do not blend with objects in other groups beneath it in the Layers list.

In this example, the Fishes and Swirls objects in the topmost group are only blended with themselves when the topmost group is set to Normal.
The Gradient object in the bottom group is left unaffected, although the transparency in the top group caused by the combination of the Add and Stencil Luma blend modes reveals it in the background.

Other Blend Modes
When you set a group to any of the other available blend modes, each layer nested within that group is blended according to its blend mode. The resulting image is then blended with the groups underneath, according to the selected blend mode for that group. In this example, the topmost group is set to Multiply.

As a result, the combination of the Added Fishes and the Stenciled Swirls objects is multiplied with the Gradient object in the bottommost group.
Object Blend Modes
The following section describes how blend modes affect individual objects. All blend modes are presented in the order in which they appear in the Blend Mode pop-up menu.

About the Examples in This Section
Most of the examples in this section are created using the following two reference images. The resulting "Mondrian Monkey" illustrates how differently the color values from each image interact when using each blend mode. When examining the results, pay particular attention to the white and black areas of the colored squares, as well as the highlights and shadows in the monkey. These show you how each blend mode treats the whites and blacks in an image.

The other brighter and darker colors serve to illustrate each blend mode's handling of overlapping midrange color values. The yellow, gray, orange, and blue squares, in particular, all have very different color and luminance values that contrast sharply from example to example.

Important: Depending on the blend mode, layer and group ordering may or may not be important. Certain blend modes behave differently depending on which image is on top.

Normal
The default for objects. The only transparency in an object set to Normal is caused by its Opacity parameter or by an alpha channel that is assigned to it.

Subtract
Subtract darkens all overlapping colors. Whites in the foreground image go black, while whites in the background image invert overlapping color values in the foreground image, creating a negative effect.

Blacks in the foreground image become transparent, while blacks in the background image are preserved.
Overlapping midrange color values are darkened based on the color of the background image. In areas where the background is lighter than the foreground, the background image is darkened. In areas where the background is darker than the foreground, the colors are inverted.

The order of two objects affected by the Subtract blend mode is important.

**Darken**

Darken emphasizes the darkest parts of each overlapping image. Whites in either image allow the overlapping image to show through completely. Lighter midrange color values become increasingly translucent in favor of the overlapping image, while darker midrange color values below that threshold remain solid, retaining more detail.

The order of two objects affected by the Darken blend mode does not matter.
**Suggested uses:** The Darken blend mode is useful for using one image to texturize another selectively, based on its darker areas. You can also use Screen, Color Burn, and Linear Burn for variations on this effect.

**Multiply**

Like Darken, Multiply emphasizes the darkest parts of each overlapping image, except that midrange color values from both images are mixed together more evenly. Progressively lighter regions of overlapping images become increasingly translucent, allowing whichever image is darker to show through. Whites in either image allow the overlapping image to show through completely. Blacks from both images are preserved in the resulting image.

The order of objects affected by the Multiply blend mode does not matter.

**Suggested uses:** The Multiply blend mode is particularly useful in situations where you want to knock out the white areas of a foreground image and blend the rest of the image with the colors in the background. For example, if you superimpose a scanned sheet of handwritten text over a background image using the Multiply blend mode, the resulting image becomes textured with the darker parts of the foreground.
Color Burn
Color Burn intensifies the dark areas in each image. Whites in the background image replace the foreground image, while whites in the foreground image become transparent. Midrange color values in the background image allow midrange color values in the foreground image to show through.

Lighter midrange color values in the background image allow more of the foreground image to show through. Darker midrange values in all visible overlapping areas are then mixed together, resulting in intensified color effects.

The order of two objects affected by the Color Burn blend mode is important.

![Boxes object on top](image1)

![Monkey object on top](image2)

Linear Burn
Similar to Multiply, except that darker overlapping midrange color values are intensified, like Color Burn. Progressively lighter color values in overlapping images become increasingly translucent, allowing darker colors to show through. Whites in either image allow the overlapping image to show through completely.

The order of two objects affected by the Linear Burn blend mode does not matter.
Add
Add emphasizes the whites in each overlapping image and lightens all other overlapping colors. The color values in every overlapping pixel are added together. The result is that all overlapping midrange color values are lightened. Blacks from either image are transparent, while whites in either image are preserved.

The order of two objects affected by the Add blend mode does not matter.

*Suggested uses:* The Add blend mode is useful for using one image to selectively texturize another, based on its lighter areas such as highlights. You can also use Lighten, Screen, Color Dodge, and Linear Dodge to create variations of this effect.

Lighten
Lighten emphasizes the lightest parts of each overlapping image. Every pixel in each image is compared, and the lightest pixel from either image is preserved, so that the final image consists of a dithered combination of the lightest pixels from each image. Whites in both images show through in the resulting image.
The order of two objects affected by the Lighten blend mode does not matter.

**Screen**

Like Lighten, Screen also emphasizes the lightest parts of each overlapping image, except that the midrange color values of both images are mixed together more evenly.

Blacks in either image allow the overlapping image to show through completely. Darker midrange values underneath a certain threshold allow more of the overlapping image to show. Whites from both images show through in the resulting image.

The order of two objects affected by the Screen blend mode does not matter.
**Suggested uses:** The Screen blend mode is especially useful for knocking out the blacks behind a foreground subject, instead of using a Luma Key. It’s mainly useful when you want the rest of the foreground subject to be mixed with the background image as well, based on its brightness. It’s good for glow and lighting effects and for simulating reflections. You can also use the Add, Lighten, and Color Dodge blend modes to create variations of this effect.

![Top object](image1) ![Bottom object](image2) ![Screen composite](image3)

**Color Dodge**
Whites in either the foreground or background image are preserved in the final image. Blacks in the background image replace the foreground image, while blacks in the foreground image become transparent.

Midrange color values in the background image allow midrange color values in the foreground image to show through. Darker values in the background image allow more of the foreground image to show through. All overlapping midrange color values are mixed together, resulting in interesting color mixes.

Reversing the two overlapping images results in subtle differences in how the overlapping midrange color values are mixed together.

![Boxes object on top](image4) ![Monkey object on top](image5)

**Linear Dodge**
Similar to Screen, except that lighter midrange color values in overlapping regions become intensified. Blacks in either image allow the overlapping image to show through completely. Whites from both images show through in the resulting image.
The order of two objects affected by the Linear Dodge blend mode does not matter.

**Overlay**

Whites and blacks in the foreground image become translucent and interact with the color values of the background image causing intensified contrast. Whites and blacks in the background image, on the other hand, replace the foreground image.

Overlapping midrange values are mixed together differently depending on the brightness of the background color values. Lighter background midrange values are mixed by screening. Darker background midrange values, on the other hand, are mixed together by multiplying.

The visible result is that darker color values in the background image intensify the foreground image, while lighter color values in the background image wash out overlapping areas in the foreground image.

The order of two objects affected by the Overlay blend mode is important.
**Suggested uses:** The Overlay blend mode is particularly useful for combining areas of vivid color in two images.

![Overlay blend mode example](image)

**Soft Light**
Soft Light is similar to the Overlay blend mode. Whites and blacks in the foreground image become translucent, but interact with the color values of the background image. Whites and blacks in the background image, on the other hand, replace the foreground image. All overlapping midrange color values are mixed together, creating a more even tinting effect than the Overlay blend mode.

The order of two objects affected by the Soft Light blend mode is important.

![Soft Light blend mode examples](image)

**Suggested uses:** The Soft Light blend mode is useful for softly tinting a background image by mixing it with the colors in a foreground image.

![Soft Light blend mode examples](image)

**Hard Light**
Whites and blacks in the foreground image block the background image. Whites and blacks in the background image, on the other hand, interact with overlapping midrange color values in the foreground image.
Overlapping midrange color values are mixed together differently depending on the brightness of the background color values. Lighter background midrange values are mixed by screening. Darker background midrange values, on the other hand, are mixed together by multiplying.

The visible result is that darker color values in the background image intensify the foreground image, while lighter color values in the background image wash out overlapping areas in the foreground image.

The order of two objects affected by the Hard Light blend mode is important.

**Vivid Light**

Vivid Light is similar to the Hard Light blend mode, with two exceptions. The first is that midrange color values are mixed together more intensely. The second is that whites and blacks from either overlapping image are preserved in the end result.

*Note:* Some dithering may result in overlapping areas of solid white and solid black.

Overlapping midrange color values are mixed together differently depending on the brightness of the background color values. Lighter midrange values become washed out, while the contrast of darker midrange color values is increased. The overall effect is more pronounced than with the Hard Light blend mode.
Reversing the two overlapping images results in subtle differences in how the overlapping midrange color values are mixed together.

**Linear Light**
Linear Light is similar to the Hard Light blend mode, except that overlapping midrange color values are mixed together with higher contrast. Whites and blacks in the foreground image block the background image. Whites and blacks in the background image, on the other hand, interact with overlapping midrange color values in the foreground image.

Overlapping midrange color values are mixed together. Lighter background colors brighten the foreground image, while darker colors darken it.

The order of two objects affected by the Linear Light blend mode is important.

**Pin Light**
Pin Light is similar to the Hard Light blend mode, except that overlapping midrange color values are mixed together differently based on their color value. Whites and blacks in the foreground image block the background image. Whites and blacks in the background image, on the other hand, interact with overlapping midrange color values in the foreground image.
The methods used by the Pin Light blend mode to mix two images are somewhat complex. Overlapping midrange color values are treated differently depending on which of the four regions of the luminance chart they fall into.

- Lighter and darker areas of the foreground image falling close to the whites and blacks are preserved.
- Areas of the foreground image falling near the center of the midrange are tinted by the background color.
- Darker areas of the foreground image in between the blacks and center of the midrange are lightened.
- Lighter areas of the foreground image in between the whites and the center of the midrange are darkened.

The end result may appear alternately tinted or solarized, depending on the lightness or darkness of the overlapping values. This blend mode lends itself to more abstract effects.

The order of two objects affected by the Pin Light blend mode is important.

**Hard Mix**

Hard Mix is similar to the Hard Light blend mode, except that the saturation of overlapping midrange color values is intensified, resulting in extremely high-contrast images. Whites and blacks are preserved.
While the order of two objects doesn’t affect the overall look of two images blended using the Hard Mix blend mode, there may be subtle differences.

**Difference**
Similar to the Subtract blend mode, except that areas of the image that would be severely darkened by the Subtract blend mode are colorized differently.

The order of two objects affected by the Difference blend mode does not matter.

**Exclusion**
Similar to the Difference blend mode, except that the resulting image is lighter overall. Overlapping areas with lighter color values are lightened, while darker overlapping color values become transparent.
The order of two objects affected by the Exclusion blend mode does not matter.

Blend Modes That Manipulate Alpha Channels
The Stencil and Silhouette blend modes let you use a single object’s alpha channel or luma values to isolate regions of background objects and groups.

Note: Similar effects can be accomplished using shape and image masks. In addition, masks may provide you with a greater degree of control, depending on your needs. For more information, see “Using Shapes and Masks” on page 997.

Stencil modes crop out all nonoverlapping parts of objects underneath the object used as the stencil. Silhouette modes do the opposite, punching holes in overlapping objects underneath in the shape of the object used as the silhouette.

Stencil Alpha
The Stencil Alpha blend mode uses the alpha channel of the affected object to crop out all nonoverlapping parts of objects and groups underneath it in the Layers list.

Stencil Luma
The Stencil Luma blend mode does the same thing as the Stencil Alpha blend mode, but uses the affected object’s luma value to define transparency. Stencil Luma is useful if the object you want to use for cropping has no alpha channel of its own.
Silhouette Alpha
Silhouette Alpha is the reverse of the Stencil Alpha blend mode and is useful for cutting holes in objects underneath.

Object used for silhouette  Object underneath  End result

Silhouette Luma
Silhouette Luma is the reverse of Stencil Luma.

Limiting the Effect of Stencil and Silhouette Blend Modes
Whenever you use the Stencil or Silhouette blend modes in a group that is set to the Pass Through blend mode, the resulting effect carries down through every object in every group that lies underneath it in the Layers list, unless the group that contains it is rasterized. This is a powerful, but not always desired effect, because it prevents you from placing a background group to fill the transparent area.

You can limit the Stencil or Silhouette blend mode to affect only those objects that are within the same enclosing group by setting the group’s blend mode to anything other than Pass Through.

For example, if you set the enclosing group of the two objects in the Silhouette Alpha example to Normal, then add a group underneath containing additional objects, those objects show through the transparent areas created by the silhouetted group.
Behind
The Behind blend mode forces the object to appear behind all other objects and groups, regardless of its position in the Layers tab and Timeline.

If multiple objects or groups are set to Behind, they appear behind all other groups that are not set to Behind, in the order in which they appear in the Layers tab.

Alpha Add
The Alpha Add blend mode works similarly to the Add blend mode, but instead of adding the color channels of overlapping objects, it adds their alpha channels together. Try using this blend mode instead of Motion's default method of alpha channel compositing for a different treatment of overlapping areas of translucency.

Premultiplied Mix
The Premultiplied Mix blend mode is intended for compositing images that are premultiplied, such as those generated by 3D modeling and rendering software. (A premultiplied image's red, green, and blue channels are multiplied by the image's alpha channel.) Premultiplied Mix is useful for images with translucent lighting effects such as lens flares, volumetric lighting, fog and haze effects, and so on.

The Premultiplied Mix blend mode performs an unpremultiply composite—the foreground image is assumed to be premultiplied. Artifacts may appear as a result of unpremultiplying pixels whose RGB and alpha values are very small (resulting in pixels with values of 255). In some cases, the hardware performs bilinear filtering and then the blend mode unpremultiplies the alpha.

Drop Shadows
A drop shadow, by default, is a dark, translucent, offset shape that falls behind an object, as if a light was shining on the object. Drop shadows are the same size as the object to which they're applied, although blurring a drop shadow may enlarge it somewhat.
They create the illusion of depth, with the result that the foreground object seems to pop out at the viewer. For this reason, drop shadows are frequently used to create the impression of space between two overlapping objects.

Drop shadows also darken overlapping regions of background objects. A good example of when to use this is when you place text over a background that might obscure it. By adding a drop shadow, you can make a foreground text object easier to read.

It’s easy to add a drop shadow to any object, since each object has individual drop shadow parameters in the Inspector and HUD. Once activated, drop shadows can also be manipulated directly in the Canvas.

*Important:* Text objects have additional drop shadow parameters, located in the Style pane of the Text tab. For more information about text object drop shadows, see “Adding a Drop Shadow” on page 621.
Adjusting Drop Shadows in the Canvas
You can interactively modify an object’s drop shadow using the HUD or the onscreen controls.

Drop Shadow Controls in the HUD
Whenever you select an object in the Canvas, the HUD displays three drop shadow parameters:

- **Drop Shadow**: A checkbox that lets you toggle any object’s drop shadow on or off.
- **Opacity**: Lets you set how transparent the drop shadow is.
- **Blur**: Lets you adjust how soft the drop shadow is.

*Note*: When you select a text object, these parameters are not displayed in the HUD.

The Adjust Drop Shadow Transform Tool
Selecting the Adjust Drop Shadow transform tool in the Toolbar provides additional onscreen controls for selected objects with active drop shadows.

Four handles at each corner allow you to increase or decrease the blur of the drop shadow. Dragging anywhere within the drop shadow’s bounding box allows you to simultaneously change the shadow’s angle and distance.
To increase or decrease a drop shadow’s blur:
1. Click and hold the Select/Transform tool, then choose the Adjust Drop Shadow tool from the pop-up menu.
2. In the Canvas, drag one of the four corner handles in to decrease a shadow’s blur or out to increase it.

To move an object’s drop shadow:
1. Click and hold the Select/Transform tool, then choose the Adjust Drop Shadow tool from the pop-up menu.
2. Drag anywhere within the shadow’s bounding box to move it around.

**Drop Shadow Parameters in the Properties Tab**
In addition to the Canvas and HUD drop shadow controls, each object has individual drop shadow parameters in the Properties tab.

Use the checkbox to toggle any object’s drop shadow on or off.

**Color:** Sets the drop shadow’s color. This color is black, by default.

**Opacity:** Sets the drop shadow’s transparency.

**Blur:** Specifies how soft the drop shadow is.

**Distance:** Sets how close or far an object’s drop shadow is to the object. The farther away a drop shadow is, the more distance there appears to be between the object and anything behind it in the composition.

**Angle:** Lets you change the direction the drop shadow falls along. Changing the Angle of the drop shadow changes the apparent direction of the light casting the shadow.

**Retiming**
Your motion graphics projects may require you to perform special timing tricks on media: speeding a clip up, slowing it down, or playing it back at a variety of speeds.

**Using Retiming Behaviors**
The Retiming category of behaviors offers various ways to quickly execute the most commonly applied retiming tasks. A hold frame or strobe is easily accomplished with a retiming behavior. Take some time to look over the behaviors in the Retiming category before spending a lot of time in the Inspector creating your own custom retiming from scratch. For more information on Retiming behaviors, see “Retiming Behaviors” on page 453.
Timing Controls in the Inspector
Each media object has individual timing parameters in the Properties tab:

**Time Remap:** Sets how time is remapped in the clip. Use this pop-up menu to set Constant Speed or Variable Speed. Constant Speed retimes the entire clip using the same value, and Variable Speed allows you to animate the speed of the clip over time.

**Speed:** Sets the speed of the clip as a percentage. The default is 100%. Values lower than 100 play back the clip more slowly than its original speed and also extend the duration of the clip. Values higher than 100 play back the clip faster than its original speed and shorten the duration of the clip. This parameter only appears when Time Remap is set to Constant Speed.

**Retime Value:** Displays the time value of the clip at a given frame. This parameter only appears when Time Remap is set to Variable Speed. When you set Time Remap to Variable Speed, two keyframes are automatically generated at the first and last frame of the clip. The two default keyframes represent 100% constant speed. Adding keyframes to this parameter and assigning them different Retime Values makes the speed of the clip ramp from one speed to another.

**In:** Sets the In point of the object, in both constant and variable speed modes. Adjusting this parameter always moves the object In point to the specified frame without affecting the duration of the object.

**Out:** Sets the Out point of the object, in both constant and variable speed modes. Adjusting this parameter always moves the object Out point to the specified frame without affecting the duration of the object.

**Duration:** Sets the total duration of the object. If Time Remap is set to Constant Speed, adjusting Duration will also affect the Speed and the Out point. If Time Remap is set to Variable Speed, adjusting Duration will not affect variable speed playback.

**Reverse:** This checkbox toggles whether the clip is played back in reverse.

**Frame Blending:** Sets the method used to determine how the image is blended during each frame of playback. The Frame Blending pop-up menu contains the following items:

- **None:** Displays the frame from the original clip nearest the source frame.
- **Blending:** The default setting. Displays a blend of the individual pixels of adjacent frames.
- **Motion-Blur Blending:** Applies a motion blur algorithm to the blended frames.
- **Optical Flow:** Uses an optical flow algorithm to blend the two frames surrounding the desired frame. Using this method affects playback performance most significantly. In order to display frames properly, Motion analyzes the clip to determine the directional movement of pixels.
When selecting Optical flow, an analysis indicator appears to the left of the transport controls underneath the Canvas to show that the clip is being analyzed.

If you play back the project before the analysis is complete, the clip will appear as if Frame Blending is set to None. Once the analysis is complete, the indicator disappears, and the clip will play back properly. If you wish, you may view more detailed information about the clip analysis and stop the process before it is finished.

**Important:** When importing interlaced footage and using the Optical Flow method for frame blending, if Field Dominance is not set to the correct value, artifacts may appear in the retimed object.

To display more information about ongoing clip analysis, do one of the following:
- During active clip analysis, click the analysis indicator.
- Choose Window > Show Task List.

The Background Task List appears.

The Background Task List shows all processes Motion is working on in the background. Each task is labeled, has a progress bar, and displays text describing how far along the task is. You may cancel current and pending operations by pressing the stop button next to the progress bar.

**End Condition:** A pop-up menu that lets you set how playback continues when the end of the clip is reached. There are four options:
- **None:** The default setting. The object’s duration in your project is equal to the duration of its source media file.
- **Loop:** When the last frame of the clip is reached, the clip loops back to the first frame and plays again. This can cause a jump in the clip's apparent playback unless the clip was designed to be looped seamlessly.
• **Ping-Pong:** When the last frame of the clip is reached, the next iteration of clip playback is reversed. If you set a clip of a ball rolling on the floor to loop with the Ping-Pong option, it would appear to roll forward, then backward, then forward again for the duration of the object. This allows you to extend the duration of certain video clips more smoothly than with the Loop setting.

• **Hold:** This freezes the last frame of the clip for the amount set in the End Duration slider.

  **Note:** When using the Hold option with interlaced footage, ensure that field order is properly set in the Media Inspector. To modify a clip’s field order, select the clip in the Media tab of the Project pane, then choose an option from the Field Order pop-up menu in the Media Inspector.

**End Duration:** A slider that lets you set the number of frames by which the clip is extended at the end of its duration. This value may be adjusted only if End Condition is set to a value other than None.

---

**Retiming in the Timeline**

You can also manipulate clip timing in the Timeline with the help of modifier keys. Indicators in the Timeline help you visualize loops and other retiming conditions. For more information on Retiming in the Timeline, see “Retiming in the Timeline” on page 350.

**Exporting a Selection**

After you adjust project elements to your taste, you might want to reuse them in another project. You can export elements as rendered files to minimize their effect on playback performance in another complex project. This is a process known as *baking*.

**To bake selected elements for export:**

1. Select the layers in your project that you wish to bake.
2. Choose File > Export Selection.
3. Choose the options you prefer in the Export Selection dialog, then click Export.
Options in the Export Selection Dialog
The Export Selection dialog contains options for filenaming, type of file you wish to create, which elements to include in the export, and options for events that take place when the export operation is completed. The Export Selection dialog contains the following items:

Save As: Type the name of the file you wish to export.

Where: Choose a location to save the exported file.

Export: Choose a file type from the pop-up menu. An Options button allows you to set Output options. For more information on export options, see Chapter 14, “Exporting Motion Projects,” on page 1147.

The Export pop-up menu contains the following items:

- **QuickTime Movie:** When this option is chosen, a QuickTime movie is created.
- **Image Sequence:** When this option is chosen, a series of numbered image files is exported. Each image file represents a single frame in the sequence.
- **Current Frame:** When this option is chosen, only the frame at the current play head is exported.

Use: Allows you to choose from a menu of export presets. For more information on export options, see Chapter 14, “Exporting Motion Projects,” on page 1147. Depending on the option you choose in the Export pop-up menu, one of three default presets appears in the Use pop-up menu:

- **Movie - current project and canvas settings:** This option, the default when Export is set to QuickTime Movie, uses the current project and Canvas movie settings when rendering the selection for export.
- **Sequence - current project and canvas settings:** This option, the default when Export is set to Image Sequence, uses the current project and Canvas image settings when rendering the selection for export.
- **Image - current project and canvas settings:** This option, the default when Export is set to Current Frame, uses the current project and Canvas image settings when rendering the selection for export.

Include: A pop-up menu that sets which audio and video elements to include in the export. There are three options:

- **Video and Audio:** This option exports video and audio.
- **Video only:** This option exports video only.
- **Audio only:** This option exports audio only.
After Export: A pop-up menu that sets which additional actions to take with the result file after the export is complete. There are four options:

- **Do nothing:** When this option is selected, no additional action is taken after export is complete.
- **Open in viewer window:** The default behavior, this option opens the exported element in a viewer.
- **Add to Media:** This option adds the exported element to the Media tab of the current project.
  
  **Note:** This element does not appear in the Canvas.
- **Import into project:** This option imports the element into the project after exporting. By default, the movie is imported into the Canvas and appears in the Layers list hierarchy just above the elements used to create it.

Expose Commands

Motion’s expose key commands provide a way of viewing multiple windows at once, exploding and rescaling them without having to move them around manually.

The expose commands allow you to visually access all the layers in a project directly in the Canvas, quickly selecting items without having to drill down into the Layers list or Timeline. Expose commands also let you select inactive layers at the playhead’s current position or jump automatically to a selected layer’s In point.

There are two expose commands: the first displays all layers in a project, and the second displays only those layers active at the current position of the playhead in the Timeline.

**Exposing All Layers**

Using the Expose All Layers key command, you can get a visual sense of all the elements in your project and quickly select a particular element you wish to manipulate.

**To expose all layers in your project:**

1. Click anywhere in the Canvas.
2. Press Shift-X.
All the layers in the project temporarily scale down and spread out over the Canvas. Each layer in the project is represented by a white frame in the Canvas. Moving the pointer over a frame shows the layer’s name.

3 Select the layer you want to work on.

The layers move and rescale back to their original positions, the element is selected in the Canvas, and the playhead moves to the first frame of the selected layer.

**Exposing Active Layers**
The Expose Active Layers command lets you view the layers that are active at the position of the playhead in the Timeline.

To expose objects that are active at the playhead position:
1 Click anywhere in the Canvas.
2 Press X.

All the layers active at the current position of the playhead temporarily scale down and spread out over the Canvas. Each active layer is represented by a white frame in the Canvas. Moving the pointer over a frame reveals the layer’s name.

3 Select the object you want to work on.

The elements move and rescale back to their original positions, the element is selected in the Canvas, and the playhead moves to the first frame of the selected object.

**Exposing Drop Zones**
Motion templates often contain drop zones where you can drag and drop your own image objects. In addition, you can create your own drop zones in any project. You can use Motion’s expose feature while dragging items from the File Browser or Library into the Canvas and be automatically presented with an exploded view of the valid drop zones in the project.
To expose all drop zones in a project:
1 Use the Library or File Browser to locate an object you wish to import into the project.
2 While holding down the Command key, drag the object onto the Canvas. The object you are dragging to the Canvas is displayed as a thumbnail, and a curved arrow replaces the pointer until you drop the object. Active objects explode and rescale in the Canvas so that you can see them all at once. Moving the pointer over an object reveals its Layers list name.
3 Drop the object onto its target. The object replaces its target, everything moves and rescales back to their original positions, and the playhead moves to the first frame of the dropped object.
Using the Timeline

Arrange and edit the assets in your project with flexibility and ease in the Timeline. View your objects spread out over layers and tracks.

The Timeline shows all of the objects in your project and provides a “big picture” look at how your project is arranged over time. You can organize your objects to begin and end on the frames you choose. You can also align multiple effects so that they occur simultaneously. You can control objects’ durations and even perform common trim operations to edit the objects as you would in a video editing program.

Additional controls let you manipulate masks, filters, behaviors, keyframes, and audio elements along with your visual footage. The Timeline ruler provides an exact reference for managing timing and synchronizing effects. You can lock tracks to prevent changes, temporarily hide an object from view, and manage links between audio and video.

Although you can perform many types of effects without ever using the Timeline, it is an essential tool when you want to manipulate the timing of the contents of your project. Motion integrates many of the features ordinarily reserved for nonlinear editing software into the compositing workflow.
The Timeline is not displayed by default in the Standard layout. It can be viewed by displaying the Timing pane.

**To display the Timing pane, do one of the following:**

- Click the Timing icon (in the upper-right corner of the Toolbar).
- Drag the divider beneath the Play button in the transport controls upward.
- Choose Window > Layouts > Cinema.
- Press F6.

Cinema Layout moves the Inspector to the right side of the interface and displays the Timing pane.

*Note:* To change interface layouts, choose Window > Layouts, then choose Standard, Alternate, or Cinema. You can also create and save your own layout arrangements. See “Window Arrangements” on page 23 for more information on layouts.

If the Timing pane is already displayed, you may need to click the Timeline tab to bring it to the front.

**Getting Familiar with the Timeline**

The Timeline consists of the Timeline layers list on the left and a track area on the right. Each object in your project appears as a colored bar, on its own horizontal track, arranged in a hierarchy identical to the Layers list in the Project pane. This allows you to quickly see each object’s place in time, as well as its relative position and duration.

You can determine the type of each object in the Timeline layers list based on its appearance.
When you select an object, the color changes to a darker shade and the name of the object turns white. When the Timeline is in Filmstrip mode, the filmstrip frames are highlighted with a white border. See “Specifying the Track Display” on page 330 for more information on how to set different Timeline view modes.

<table>
<thead>
<tr>
<th>Item</th>
<th>How it appears</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td><img src="image" alt="Group" /></td>
<td>A double blue bar. The lower bar displays three lines and a value indicating the number of objects in the group.</td>
</tr>
<tr>
<td>Layers</td>
<td><img src="image" alt="Layers" /></td>
<td>A blue bar</td>
</tr>
<tr>
<td>Masks</td>
<td><img src="image" alt="Masks" /></td>
<td>A gray bar</td>
</tr>
<tr>
<td>Behaviors and Filters</td>
<td><img src="image" alt="Behaviors and Filters" /></td>
<td>A thin purple bar</td>
</tr>
<tr>
<td>Camera</td>
<td><img src="image" alt="Camera" /></td>
<td>A blue bar</td>
</tr>
<tr>
<td>Light</td>
<td><img src="image" alt="Light" /></td>
<td>A blue bar</td>
</tr>
<tr>
<td>Keyframes</td>
<td><img src="image" alt="Keyframes" /></td>
<td>Blue diamonds in a thin bar beneath the object that is keyframed. Selected keyframes appear white.</td>
</tr>
<tr>
<td>Audio</td>
<td><img src="image" alt="Audio" /></td>
<td>A green bar displaying the audio waveform. If the audio file has an applied Audio behavior, the purple bar appears underneath the audio track.</td>
</tr>
</tbody>
</table>
**Timeline Layers List**

The Timeline layers list mirrors the Layers tab in the Project pane and displays your project objects (groups, layers, filters, behaviors, and so on) and their stacking order. Behaviors, filters, masks, and keyframes applied to an object can also be displayed. In the Timeline layers list, you can reorder objects. This change is immediately reflected in the Layers list in the Project pane. You can also lock tracks to prevent further editing on those tracks and disable entire tracks to omit them from view in the Canvas.

![Timeline Layers List](image)

**Object Names**

You can rename any object in Motion. This can be helpful if you are using more than one version of an asset, using multiple cameras, or if you want to categorize things into named groups. Masks, shapes, particles, and other content you generate within Motion are created with generic names. Renaming them allows you to better manage and keep track of them while you work.

**To rename an object:**

1. In the Timeline layers list, double-click the name of the object.
2. Type a new name in the editable text field.
3. Press Return or Tab.

Although Motion allows you to rename objects you import from your disk, changing the object's name in the Timeline layers list does not modify the name of the file on disk. This allows you to use one source clip multiple times and name each instance uniquely inside Motion.
Enabling Timeline Tracks
To the left of each track in the Timeline layers list is an activation checkbox that turns that track on and off. When a track is turned off (disabled), it is ignored in the Canvas. Not only can you turn video or audio on and off, but you can also disable or enable effects such as masks, filters, and behaviors.

To turn visibility for an object on or off:
- Click the checkbox at the left edge of the track you want to control.

When the box is checked, visibility is on, and when the box is unchecked, visibility is off. Additionally, when a track is disabled, the entire track is dimmed in the Timeline.

Managing the Timeline Layers List
Motion allows you to collapse and expand different parts of the Timeline layers list to show more or less data to accommodate different working styles. Layers with applied masks, filters, and other objects can be collapsed to hide those effects bars. Furthermore, whole groups can be collapsed to hide all of the objects contained within them.

When a layer or group is collapsed in this manner, it still appears in the Canvas window. Unlike enabling or disabling tracks, collapsing and expanding the Timeline layers list is only an organizational tool to help manage the view of the Timeline.
To collapse or expand a layer or group in the Timeline:
- Click the disclosure triangle to the left of the layer or group name. If no disclosure triangle is present, that object cannot be collapsed or expanded any further.

**Adding and Deleting Groups**
Motion allows you to add and delete groups directly in the Timeline layers list. If nothing is selected in the list when a new group is added, the new group appears at the top of the list. If an object is selected, the new group is added directly above the selected object.

**To add a group:**
- Click the Add button (+).

You can also add a group by dragging a new item into your project.

**To delete a group:**
1. Select the group you want to delete.
2. Click the Delete button (-).

You can also click the Delete button to remove any object (camera, layer, group, filter, and so on) in the Timeline layers list. You can also Control-click a track, then choose Delete from the shortcut menu.

**Locking Tracks**
Occasionally, you may want to prevent changes to a particular item. The lock icon at the right edge of the Timeline layers list allows you to lock an object and prevent any changes from affecting that object. An object that is locked in the Timeline also appears locked in the Layers list in the Project pane.

When an item is locked, the bounding box in the Canvas turns from white to red and the colored bar appears with a cross-hatched pattern.
Locked tracks still appear in the Canvas and are included in your final output. Although you cannot make changes to a locked object, you can still copy or duplicate that object or change the object’s layer order.

**To lock a track:**
- Click the lock icon at the right edge of the Timeline layers list.

### Audio-Video Links
Ordinarily, objects that contain both audio and video are linked together so that they always remain in sync. This link is represented by an icon in the Timeline layers list.

**Note:** To display audio in the Timeline, click the Show Audio button.

Objects that are linked are always edited together in the Timeline. Operations such as cut, copy, paste, and split also affect both audio and video. However, if you ever want to break that relationship so that you can move or edit the audio or video without the other tagging along, you can disable that link and move either object freely. Beware that this may result in your audio and video playing out of sync.

**To manipulate audio and video elements separately:**
1. Click the link icon to the right of the object name for either the video or audio element.
   - The link icon changes to a broken link.

2. Move, trim, or slip the audio or video bar.

   ![Before and After comparison of audio and video manipulation](image)

   Before | After

   The link icon also appears in the Layers list in the Project pane.
Timeline View Options
The lower-left corner of the Timeline contains several controls to customize what elements appear in the Timeline.

Audio tracks are displayed in a separate partition in the Timeline. You can resize the partitions by dragging the divider for each partition.

<table>
<thead>
<tr>
<th>Button</th>
<th>Button name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Show/Hide Layers</td>
<td>Displays all groups, layers, and objects. Audio tracks must be displayed for this switch to have any effect.</td>
</tr>
</tbody>
</table>
| ![Icon] | Show/Hide Audio          | Displays audio tracks. The waveforms appear on the audio tracks. If the audio file has an applied Audio behavior, the purple bar appears underneath the audio track.  
  **Note:** When an audio file with an applied Audio behavior is displayed in the Timeline, the Audio behavior appears below the audio track that it modifies. |
| ![Icon] | Show/Hide Keyframes      | Displays keyframes for all tracks. Keyframes appear as blue diamonds (white when selected). |
| ![Icon] | Show/Hide Masks          | Displays mask tracks for objects that have masks applied. |
| ![Icon] | Show/Hide Behaviors      | Displays behavior tracks for objects that have behaviors applied. |
| ![Icon] | Show/Hide Filters        | Displays filter tracks for objects that have filters applied. |
| ![Icon] | Set Timeline Row Size    | Click one of the “Set timeline row size” buttons to select a track size.  
  To manually resize tracks, position the pointer over a row separator line and drag up or down. |

Zooming in the Timeline
You can zoom in and out in the Timeline using either the Zoom/Scroll control or the zoom slider. Each lets you zoom in and out of the Timeline horizontally, showing more or less time in the Timeline window. As you zoom in, you can see greater detail, which lets you place objects with greater precision. As you move the zoom slider, the Timeline remains centered on your current frame.
The Zoom/Scroll control appears at the bottom of the Timeline window and lets you scroll through your project when you drag the scroller left or right. It also lets you zoom in and out in your Timeline. It can help you navigate your project more quickly because it provides an overview of your Timeline at a glance. The width of the control represents the entire duration of your project, and the width of the scroller identifies the currently viewed segment.

If you drag either handle of the scroller inward, the scroller gets shorter and zooms in on the Timeline. Dragging either handle outward lengthens the scroller and zooms out of the Timeline. The Timeline playhead is always visible to provide a reference point for which segment of your Timeline is currently being viewed.

**To zoom in or out of the Timeline:**
- Drag the handle at either end of the scroller. Drag toward the center of the Timeline to zoom in. Drag away from the center to zoom out.
- If you press Shift while dragging a handle, the opposite end remains locked in position and allows you to zoom in or out on the edge of the current view.

**Adjusting the Height of the Timeline Tracks**
In addition to zooming in and out in the Timeline, you can adjust the height of the tracks. Audio and object tracks may be resized separately. Some tracks, such as filters or behaviors, do not resize at all.

**To adjust the height of the tracks, do one of the following:**
- Drag the row separator between two layers in the Timeline layers list. When the pointer changes to an adjust pointer, drag up or down to modify the vertical size of the tracks.
- Click one of the “Set timeline row size” buttons.
Specifying the Track Display
You can choose several different ways to display the objects within the tracks in the Timeline. You can display just the name of the object in the track, which makes the track thin, and is the easiest way to see many tracks at a time. You can choose to show the name and a thumbnail image of the object, which provides quick visual feedback and lets you identify exactly what each object is. You can also display tracks as a filmstrip, which shows a series of thumbnails, and lets you see where changes occur in a movie object. When you modify the track display setting, it changes the display for image and mask tracks in the Timeline.

To specify the track display:
1. Choose Motion > Preferences to display the Preferences window.
2. Click the Appearance icon.
3. In the Timeline section, choose an item from the Timebar Display pop-up menu.
4. Click the close box to close the Preferences window.
   The bars are displayed according to your choice.

Note: When the Timebar Display is set to Filmstrip, your processing time is increased. When a filter is applied to a layer or group, the result of the filter is displayed in the filmstrip.

Working in the Timeline
The Timeline is one of the most flexible and valuable elements of the Motion interface. This is where you can control all of the timing aspects of your project. Whether you want to line up multiple layers to begin or end together, change which portion of a clip is used, or lengthen or shorten a particular object, the Timeline provides the tools you need.

You can add images and clips to your project using the Timeline just as you add files to the Layers list or the Canvas. You can drag objects into the Timeline layers list, or drag them directly into the Timeline tracks. Dragging files into the Timeline tracks provides additional editing options such as compositing, inserting, overwriting, and replacing clips.

This section describes all of these functions, as well as how to add, delete, and reorder layers.
Adding Objects to the Timeline
When you drag a new object to the Timeline, a drop menu appears and lets you choose how it should be incorporated into the project. Once an object is added to a project using the Timeline, it appears in the layers lists and becomes a Timeline track. You have the option to composite the new object over the existing objects (above the existing tracks), insert the new object into an existing track, overwrite an existing object, or exchange the media of an existing object.

Note: You can also drag cameras and lights to the Timeline that have been saved to the Library.

Depending on where in the Timeline you drop the object, you see different options. If you drag to a group or object track, you can choose Composite, Insert, or Overwrite. The additional Exchange option becomes available when you drag the same type of media to a track. For example, Exchange appears when you drag a QuickTime movie to a QuickTime movie's track. The new object can appear above or below an existing object; where you release the mouse button determines placement of the new object.

Note: You can only use the Exchange option to exchange the same type of media (such as a QuickTime movie, an image sequence, or an image file). For example, the Exchange option is not available when you drag a generator or shape from the Library onto an image sequence.

If you are dropping multiple objects, you can choose Composite or Sequential from the drop menu. Sequential imports objects one after the other.
**Note:** If you release the mouse button before the drop menu appears, the default choice of Composite is applied. This means that the new layer appears on top of other objects in the Canvas.

**Composite**
When you choose Composite, the new object is added to a new track within the active group and all layers remain onscreen simultaneously.

**Insert**
When you choose Insert, Motion leaves the existing object in the track, but pushes it forward in time to make room for the new item. For example, if you insert a five-frame movie into a group containing an existing object, the new movie is added to the Timeline at whichever frame you drop it, pushing the remaining frames of the original movie out five frames.

If you insert an object midway through an existing object, the existing object is split into two objects, each on its own track.
**Overwrite**
The Overwrite option deletes the existing object, overwriting it with your new object.

If the new object is shorter than the one currently in the group, the Overwrite option splits the duration of the existing object and deletes only the frames where the new object appears.

**Exchange**
Exchange is a variant of the Overwrite option, but instead of dropping the entire duration of the new object into the project, the duration of the existing object is used.

For example, if you drag a 30-second clip over a 5-second clip, choosing Exchange swaps the existing 5 seconds with the first 5 seconds of the longer clip.

Similarly, if you try to exchange a 10-second clip with one that lasts only 5 seconds, the first 5 seconds are replaced, and the remaining 5 seconds would remain. The Exchange option transfers any filters, behaviors, and keyframes from the original object onto the new object.

*Note:* You cannot use Exchange with audio files.
Sequential
This drop menu option is only available when you are dropping multiple objects into the Timeline. Sequential drops objects one after another in the Timeline. For more information, see “Adding Multiple Clips to the Timeline” on page 335.

To composite an object:
1 Drag an object from the Library or Media tab into the Timeline tracks area.
   As you drag, a tooltip appears at the pointer to tell you the frame number at which you are located.
2 When you reach the frame where you want the new layer to start, position the pointer over the layer you want as the background, and hold down the mouse button until the drop menu appears.
3 Choose Composite from the drop menu.
   The new layer is composited into the project.

To insert an object:
1 Drag an object from the Library or Media tab into the Timeline track area.
   As you drag, a tooltip appears at the pointer to tell you the frame number at which you are located.
2 When you reach the frame where you want the new object to start, keep the mouse button pressed until the drop menu appears.
3 Choose Insert from the drop menu.
   The new object is inserted into the track, breaking the original bar into two, and pushing the frames after the insertion further out in time.

To overwrite an object:
1 Drag an object from the Library or Media tab into the Timeline track area.
   As you drag, a tooltip appears to tell you the frame number at which you are located.
2 When you reach the frame where you want the new object to start, hold down the mouse button until the drop menu appears.
3 Choose Overwrite from the drop menu.
   The frames of the new object replace the frames of the original object. If the original object contained more frames than the new one, the old object is split into two objects and the additional frames remain.

To exchange an object:
1 Drag an object from the Library or Media tab into the Timeline track area.
   As you drag, a tooltip appears to tell you the frame number at which you are located.
2 When you reach the object you want to exchange, hold down the mouse button until the drop menu appears.
Choose Exchange from the drop menu.
The old object is replaced by the new object.

Adding Multiple Clips to the Timeline
When you drag more than one item to the Timeline, the new objects appear in their own tracks above any existing objects. This is equivalent to performing a composite edit with a single object. A drop menu lets you choose whether the additional objects should be stacked up as a composite, or whether they should appear one after another (sequentially).

To add multiple objects as a composite:
1. Shift-select the files you want in the Library or Media tab, then drag them to the Timeline track area.
2. When you reach the frame where you want the new objects to start, hold down the mouse button until the drop menu appears.
3. Choose Composite from the drop menu.
The multiple objects are all edited into the project at the same point in time, each on its own track.

Alternatively, you can drop the multiple objects into the Timeline layers list. Doing so always results in a composite edit. Also, if you release the mouse button before the drop menu appears, a composite edit is applied.

To add multiple objects sequentially:
1. Command-select the files you want in the File Browser, Library, or Media tab, then drag them to the Timeline track area.
2. When you reach the frame where you want the new objects to start, hold down the mouse button until the drop menu appears.
3. Choose Sequential from the drop menu.
The multiple objects are edited into the project, one after another, each on its own track.
**Setting Drag and Drop Preferences**
You can set preferences that specify where an item is dropped when you add it to the Timeline layers list. You can choose between dropping items at the start of the project or at the current playhead position. You can also set the delay time before the drop menu appears.

**To specify where new objects appear in the Timeline:**
1. Choose Motion > Preferences.
   The Preferences window appears.
2. Click the Project icon.
   The Project preferences appear in the window.
3. In the Still Images & Layers section, click the appropriate button to create layers at “Current frame” or “Start of project.”

   **Note:** The Create Layers At preference only applies when you drag items to the Timeline layers list, the Layers list of the Project pane, or directly into the Canvas. Clips dropped on a specific frame within the Timeline always appear at that exact location.

**To set the drop menu delay preference:**
1. Choose Motion > Preferences.
   The Preferences window appears.
2. Click the General icon to view General preferences.
3. In the Interface section, adjust the Drop Menu Delay slider to set the delay pause for the drop menu.

**Adding to the Timeline Layers List**
You can drag an image from the File Browser or Media tab into the Timeline layers list, which lets you add the new object to an existing group, replace an existing object, or create a new object.

**To add an object to an existing group:**
1. Drag an object from the File Browser, Library, or Media tab, and position the pointer over the Timeline layers list.
   - If you position the pointer over a group, the track is highlighted with a black border.
   - If you position the pointer between object tracks within a group, the position indicator appears.
2. Release the mouse button to add the layer to the group.
   The new layer is placed on top of other existing objects in the group, or in between the objects where you dragged it.
To replace an object in an existing group:
1 Drag an object from the File Browser, Library, or Media tab, and position the pointer over the object that you want to replace.

A black highlight box appears around the object.

Note: The replace command can be used only for image, image sequence, and QuickTime movie files.

2 Release the mouse button.

The new object replaces the old one.

To create a new group on top of existing groups:
1 Drag an object from the File Browser, Library, or Media tab into the Timeline layers list, at the upper edge of the top object.

2 When the position indicator appears, release the mouse button.

A new group is created on top of other existing groups in the hierarchy or “stack” of groups and layers.

To create a new group below existing groups:
1 Drag an object from the File Browser, Library, or Media tab into the Timeline layers list, below the lower edge of the bottom object.

Note: There are two different position indicators: The shorter indicator places the object in the existing group. While holding down the mouse button, move slightly to the left until a longer indicator appears. This indicator creates a new group.

2 Release the mouse button.

A new group is created below other existing groups in the hierarchy or “stack” of groups and objects.

Managing Track Order
The Timeline layers list provides you with the tools to control object order. In Motion, the topmost track in the list appears on top of other layers in the Canvas. This means you may need to rearrange the order of objects in your project to get the effects you want.
To rearrange objects within a group:
1 Click the icon in the Timeline layers list for the object you want to move.
2 Drag it to the position you want between the other tracks.
3 When the position indicator appears in the location you want, release the mouse button.

The tracks are reordered.

To move an object from one group to another existing group:
1 Drag the object icon in the Timeline layers list over another group.

A black border highlights the group.
2 Release the mouse button.
The object moves into the selected group and is placed above any existing objects within that group.

You can also drag an object to a specific place in the new group by dragging it in between existing tracks in the new group. Motion’s groups and layers are “spring-loaded,” which means that when they are collapsed, dragging an object onto them causes them to temporarily expand, just like folders in the Finder.

To drop an object inside a collapsed group:
1. Drag the object onto the collapsed group in the Timeline layers list.
2. Position the pointer over the name of the group until the group springs open.
3. Drag the object to the desired location within the group, then release the mouse button.

Nesting Groups and Layers
To help organize large groups of objects or to create certain kinds of special effects, you can place one group inside of another. This gives you the flexibility to create a group containing multiple objects, and then treat that entire group as a single object within another group. You could go further and take that “parent” group, combine it with some other groups, and treat that group as a single element, and so on. This is called nesting or grouping.

There are many reasons why you might choose to nest your layers or groups. It allows you to simplify your composite, grouping objects and layers into fewer containers. It also allows you to manipulate a group of objects as one. For example, you could take the individual letters of your title (each animated on its own) and use nesting to animate the group of them across the screen. You can also use grouping to create complex particle systems. You can nest several objects into a layer, and use the entire layer as the emitter cell. For more on particle systems, see “Working with Particles” on page 685.

Note: You cannot use the Group command with objects that are in different groups.
To place one group inside another:
1 Drag the group icon in the Timeline layers list onto the group inside of which you want to nest it.
   A black border highlights the destination group.
2 Release the mouse button.
   The first group is now nested inside the second group.
You can also select the objects you want and choose Object > Group (or press Command-Shift-G).

Note: There is no limit to the number of groups you can nest.

To return a nested group to its original state:
- Select the nested group, then choose Object > Ungroup (or press Command-Option-G).
   The nested group is restored into individual objects. Any group within another group can be ungrouped.

To remove a group from within a nest:
1 Click the group icon in the Timeline layers list.
2 Drag the group out of the existing parent group to the area above the highest track.
   The position indicator appears.
3 Release the mouse button.
   The group is restored to primary group status.

To delete a group or object track:
1 Select the group or object in the Timeline layers list.
2 Press Delete.
   You can also Control-click an object, then choose Delete from the shortcut menu.

All of the operations just described can also be performed with multiple tracks. For example, rather than just moving one object from Group 1 to Group 3, you can select two or three objects within Group 1 and move them all at once.

To select more than one object or group track:
- Command-click each of the tracks in the Layers list that you want to include in your selection.
**Splitting Tracks**
Occasionally you may want to divide a single object into multiple objects, each in its own Timeline track. You might do this if you want an effect to apply to one portion of a clip but not to another part. Or you might want an object to change layer order midway through, to create the effect that objects are moving in 3D space. When working in 3D, you can split camera tracks as well. Splitting tracks allows you to turn one object into multiple pieces and then manipulate each segment of the object on its own track.

**To split an object track:**
1. Select the object in the track area of the Timeline layers list for the object you want to split.
2. Place the playhead on the frame where you want the split to occur.
3. Choose Edit > Split.
   
   The object is broken into two pieces, each positioned on its own track.

**Editing Objects in the Timeline**
During the process of designing and implementing a motion graphics project, you place objects in the Timeline and Canvas, move them forward or backward in time, and trim them to match the timing of other objects in your project.

Motion has several features that help you modify the objects in the Timeline. You can arrange your objects to begin and end at designated frames. You can also use powerful alignment and timing tools, such as snapping and markers. You can also modify keyframes in the Timeline. This section describes the various ways you can perform these actions.

Motion uses the terms *move*, *trim*, and *slip* to describe the different ways of editing Timeline objects.

**Move:** Changes the location of an object without affecting its content or duration.

**Trim:** Changes the duration of an object without affecting its location or content.

**Slip:** Changes the content of an object without affecting its location or duration.
Moving Objects
Move an object when you want it to begin and end at a different point in the project.

To move an object:
- In the track area, click an object bar and drag left or right to move it in time.

A tooltip appears that identifies the new In and Out points of the clip, so you can drag the clip to the frame you want. The Delta symbol (the small triangle) indicates the number of frames you are moving.

To move an object and snap it to neighboring items:
- Press Shift as you drag the item in the Timeline.

Snap-to lines appear and the edges of the clip automatically line up precisely with these lines.

Moving Objects to the Playhead
You can move an object to a new location in the Timeline by using the Move Selected In (or Out) Point command. This command automatically shifts the position of the selected object to the current playhead position and can be used to move and align multiple objects in one operation.

To move an object to the playhead:
1 Select the object you want to move.
2 Place the playhead at the point in the Timeline where you want to move the object.
3 Choose Mark > Move Selected In Point (or press Shift–left bracket) to align the object’s beginning to the playhead or choose Mark > Move Selected Out Point (or press Shift–right bracket) to align the end of the object to the playhead position.
Trim an object when you want to shorten or lengthen its duration in the Timeline. You can shorten or lengthen either the beginning or end of the object by dragging from the left or right edge of the object bar in the Timeline (the In and Out points).

You can also trim a clip by using the menu items and corresponding keyboard shortcuts to change an object’s In and Out point. This allows you to trim multiple objects simultaneously as well as make trimming changes on the fly while your project is playing back.

You can only lengthen a footage layer if there are existing unused frames in the source media. If you need to extend an object and the source material doesn’t have enough frames, you can change its End Condition to Loop, Ping Pong, or Hold. The End Condition parameter is located in the Properties tab of the Inspector. You can extend the length of other objects, such as cameras, text, and shapes without restriction.

**Note:** For more information on the Timing controls, see “Retiming” on page 312.

When you resize a clip, unused frames temporarily appear beyond the boundaries of the object in a lighter color. If there is no room outside of the currently used portion of the clip, no unused frames appear and you cannot lengthen the clip.

To trim a clip:

1. Move the pointer to one end of the clip you want to trim.

   The pointer changes to a trim pointer.
2 Drag the end of the bar until it reaches the frame where you want the clip to start or end.

As you drag, a tooltip shows the new In or Out point, and the new duration of the clip.

To trim an object and snap to neighboring items:
- Press Shift as you drag the edge of the item in the Timeline.
  Snap-to lines appear, and the edge of the clip you are dragging automatically lines up precisely with these lines.

To change an object’s In or Out point:
1 Select the object you want to trim.
2 Place the playhead on the frame where you want the new In or Out point.

3 Choose Mark > Mark In (or press I) to set a new In point or choose Mark > Mark Out (or press O) to change the Out point.

To trim multiple objects at the same time:
1 Select the objects you want to trim.
2 Place the playhead at the In or Out position you want.
3 Choose Mark > Mark In (or press I) or Mark > Mark Out (or press O) to set a new In or Out point.
  All selected objects are trimmed to the new point.

Note: If one of the objects doesn’t have enough media to complete the trim, it moves as far as it can toward the desired point.
**Slipping Clips**
Slip a clip when you want to use a different section of your clip, but you don’t want to change the layer’s duration or where it appears in the Timeline. Slipping is only possible after you have trimmed a clip.

For example, if you have a shot of a door opening that is 3 seconds long and you want to trim it down to only 1 second, you can use the Slip function to select which second section to use: the first second as the door leaves the jamb, the next second where it is flying open, or the last second where it bangs against the wall.

*Note:* You can only slip a clip as far as the existing unused frames in the source media.

**To slip a clip:**
1. With the pointer over the clip, press and hold down the Option key.
   The pointer turns into the slip pointer.

2. Drag the middle part of the colored bar left or right.
   Dragging to the right replaces the frames with a section from later in the source material, while dragging to the left uses frames from earlier in the clip.

**Deleting Objects**
Removing objects from your project can be just as important as adding them. Motion provides three ways to remove an object from the Timeline.
Delete: Removes the object, leaving a gap in the Timeline.

Before After

Ripple Delete: Removes the object and closes up the gap left behind. If the objects are within a group, the group is split into two objects.

Before After

Cut: Deletes the object, leaving a gap in the Timeline, and copies the object to the Clipboard for later pasting.

To delete an object:
1 Select the object you want to delete.
2 Choose Edit > Delete (or press Delete).
   You can also Control-click the object, then choose Delete from the shortcut menu.

To ripple delete an object:
1 Select the object you want to delete.
2 Choose Edit > Ripple Delete (or press Shift-Delete).

To cut an object:
1 Select an object you want to delete.
2 Choose Edit > Cut from the menu bar (or press Command-X).
   You can also Control-click the object, then choose Cut from the shortcut menu.
Copy and Paste
As in other applications, you can copy an object. Copying leaves the object in place and copies it to the Clipboard for later pasting.

When you paste an object, it is placed at the position of the playhead.

If a track is selected, the object is pasted into that track above all other objects. If no track is selected, a new track is created for the pasted object (as illustrated above).

Change the active track by clicking the Timeline layers list. Pasting multiple objects retains the relative object and layer order of the Clipboard contents. New tracks can be added to accommodate the paste operation.

Objects with filters behaviors, keyframes, and other effects retain those effects when cut, copied, and pasted.

To copy an object to the Clipboard:
1 In the Timeline layers list or File Browser, select the object or objects you want to copy.
2 Choose Edit > Copy (or press Command-C).

To paste an object:
1 In the Timeline layers list, select the layer where you want the object pasted.
2 Position the playhead at the desired time position.
3 Choose Edit > Paste (or press Command-V).

Paste Special
In addition to ordinary pasting, Motion lets you paste as an insert, overwrite, or exchange edit. These three commands appear in the Paste Special dialog. Paste special can also be used with regions to perform a special type of paste. For more information, see “Paste Into” on page 361.

Insert: Pastes the Clipboard contents into the project, pushing existing objects farther down in time.
**Overwrite:** Pastes the Clipboard contents into the project, deleting any existing objects at the same point in time.

**Exchange:** Replaces the selected object in the project with the Clipboard contents.

**To paste an object as an insert:**
1. Select the track where you want the object pasted.
2. Position the playhead at the desired time position.
3. Choose Edit > Paste Special (or press Option-Command-V).
   The Paste Special dialog appears.
4. Select “Insert into time region.”
5. Click OK to confirm your edit.

**To paste an object as an Overwrite:**
1. Select the track where you want the object pasted.
2. Position the playhead at the desired time position.
3. Choose Edit > Paste Special (or press Option-Command-V).
   The Paste Special dialog appears.
4. Select “Overwrite into time region.”
5. Click OK to confirm your edit.

**To paste an object as an Exchange:**
1. Select the track where you want the object pasted.
2. Position the playhead at the desired time position.
3. Choose Edit > Paste Special (or press Option-Command-V).
   The Paste Special dialog appears.
4. Select “Exchange media with existing object.”
5. Click OK to confirm your edit.

**Note:** The “Exchange media with existing object” option is only available for an item copied from the File Browser. To copy an image element from the File Browser, select the image and choose Edit > Copy (or press Command-C).

**Displaying and Modifying Keyframes in the Timeline**
You can move or delete keyframes that are displayed in the Timeline. You can also display in the Timeline the animation curve for a selected keyframe in the Keyframe Editor.
To display keyframes in the Timeline:

- At the bottom of the Timeline layers list, click the Show/Hide Keyframes button.

When the button appears dark gray, it is enabled. The keyframes appear below the object tracks. In the following image, the “5-sided star” object has three keyframes. The keyframes appear in the track below the object.

To move a keyframe’s position in time:

- Drag the keyframe to the left or right. When selected, the keyframe appears white.

Moving the keyframe in the Timeline only modifies its position in time. To directly modify the value of a keyframe, do one of the following:

  - Control-click the keyframe, choose the property you want to adjust from the shortcut menu, enter a new value, and press Return.
  
  - Use the Keyframe Editor. This allows you to change the value and interpolation of the keyframe. For more information on the Keyframe Editor, see “Keyframes and Curves” on page 503.

To delete a keyframe or group of selected keyframes:

- Select the keyframe or keyframes that you want to delete, and do one of the following:

  - Press Delete.
  
  - Control-click one of the selected keyframes, then choose Delete Keyframes from the shortcut menu.

To delete all keyframes:

- Control-click a keyframe, then choose Delete All Keyframes from the shortcut menu.

To display an animation curve in the Keyframe Editor:

- Control-click a keyframe on the track, then choose Show in Keyframe Editor from the shortcut menu.

The Keyframe Editor is displayed, the animation curve appears, and a new, untitled curve set is created. For more information on curve sets, see “Filtering Controls” on page 531.
Retiming in the Timeline

By default, a 60-frame clip played back at 30 frames per second takes two seconds to display its 60 frames. If its In point is frame 1, its Out point is frame 60. Speed and duration are interactive; that is, if you increase the speed at which the clip plays back, its duration automatically decreases. Playing back the same clip at 15 frames per second would take twice as long. The clip’s In point remains the same, but its Out point is now 120.

For more detailed information about retiming, see “Retiming” on page 312. For more information on using the Retiming behaviors, see “Retiming Behaviors” on page 453.

Adjusting a Clip’s Speed

Motion allows you to easily change the timing of clips in the Timeline.

To speed up a clip:

- With the pointer over the start or end of the clip, press and hold down the Option key. The pointer turns into the retime pointer.

To shorten the clip’s duration and speed up its playback speed, do one of the following:
  - Drag the In point of the clip’s bar to the right.
  - Drag the Out point of the clip’s bar to the left.
As you drag, the tooltip displays the clip’s duration and speed.

To slow down a clip:

- With the pointer over the start or end of the clip, press and hold down the Option key. The pointer turns into the retime pointer.

To lengthen the clip’s duration and slow down its playback speed, do one of the following:
  - Drag the In point of the clip’s bar to the left.
  - Drag the Out point of the clip’s bar to the right.
As you drag, the tooltip displays the clip’s Duration and Speed.

Looping a Clip

When a looped clip reaches its last frame, it starts playing again from its first frame. Another way of extending a clip’s duration is by looping it. You can easily loop a clip by adjusting it in the Timeline.
To loop a clip:
1. With the pointer over the end of the clip, press and hold Option-Shift. The pointer turns into the loop pointer.
2. Drag the Out point of the layer’s bar to the left.

As you drag, the tooltip displays the clip’s In and Out points, Duration, and Loop Duration. A looped clip has barriers to indicate where loops begin and end in the Timeline.

The first loop barrier in a clip’s bar is interactive. Moving the barrier changes the point at which the clip loops.

To change the loop point of a clip:
- Drag the first loop barrier left or right.
  The end point of the clip’s loop moves as you drag.

Editing in the Group Track
In addition to the ability to edit individual objects within groups, Motion allows you to do a variety of editing tasks directly in the object track, even if that track is collapsed. This allows you to collapse your tracks and do many of the functions typically limited to a dedicated nonlinear editor such as Final Cut Pro.
Ordinarily the group bar indicates the name of the object if there is only one object and the number of composited items for areas where more than one object overlap.

**Moving Objects in the Group Track**

Motion lets you move objects within a group depending on where you click. You can move all of the objects within the group as a single object by clicking the thin blue group bar at the top of the group track. If you click an area where only one clip exists, you move just that item. If you click an area where multiple objects overlap, dragging moves all of the overlapping items.

**To move an entire group as a single object:**

1. Click the thin blue group bar at the top of the group track.
   
   The layer can be collapsed or expanded.

2. Drag to the right or left to move the entire layer in time.

**To move a single object within a group:**

1. Click the area of the group track where the one clip is visible.
   
   That clip is highlighted in the group track.
2 Drag the section left or right to move the object within the group forward or backward in time.

Moving Objects Shortcut
In the Timeline, you can quickly move an object forward or backward a specific number of frames, or to a specific frame.

To move an object to a specific frame:
1 In the Timeline, select the object you want to move, then type the number of the frame (or timecode) where you want to move the object.
   A value field appears that displays the number you typed.
2 Press Return.
   The object’s In point moves to the specified frame number.

To move an object a specific number of frames, do one of the following:
- To move the object forward a specific number of frames, select the object, type a plus sign (+) followed by the number of the frames you want to move, and then press Return.
- To move the object backward a specific number of frames, select the object, type a minus sign (−) followed by the number of the frames you want to move, and then press Return.

To move overlapping objects within a group:
1 Click the area of the group track where the overlap is indicated.
   The selected area may exceed the overlapping region if an object extends beyond the overlap.
2 Drag the section to move all of the objects at once.

You can also use the shortcut menu to select any one of the overlapping objects in order to edit that object directly. This is one way that you can manipulate individual objects within a group without having to expand the group.

To edit one item in an overlapping area of a group:

1 Control-click the overlapping area of the group, then choose the object you want to manipulate from the shortcut menu.

The boundaries of that one object are highlighted in the group track.

2 Move, trim, or slip the object independently from the other objects in the group.
**Trimming Objects in the Group Track**

Trimming the edges of the group bar automatically trims the edges of the objects within the group. If there is only one object, trimming the group bar simply trims that object. If there is more than one object lined up with the edge of the group, trimming the group automatically trims all of those objects.

You cannot trim the individual object tracks within the body of the group track.

**Disconnecting the Group Track from Its Contents**

You can modify the group bar to be longer or shorter than the contents of the group. For example, you might shorten a group bar to hide a section of the objects within it. Objects that extend beyond the boundaries of the group bar (the thin blue bar at the top of the group track) are not displayed in the Canvas.

To change the length of the group independently from the objects within it:

- Press Command, then drag the edge of the group track.

Only the thin blue layer bar is trimmed.

*Note:* Once you manually change the length of the group bar, it is no longer automatically updated as you add or modify the objects within it. To restore automatic updating, realign the group bar with the right edge of the last clip in the group.
You can use this same technique to trim an object without automatically changing the duration of masks, filters, or other applied effects.

**To trim an object without changing applied effects:**
- Press Command while you drag the edge of the object.

---

**Slipping Objects in the Group Track**
In addition to moving and trimming, you can slip certain objects directly in the group bar. Any portion of the group that contains only one object can be slipped. Areas where more than one object overlap cannot be slipped without expanding the group and directly manipulating the individual objects.

**To slip an object in the group track:**
1. Option-click an area of the group where the object is located.
2. Drag to the right or left to use an earlier or later portion of the media without moving the position or duration of the object.

You can only slip an object if there are unused frames in the source media associated with that clip. For more information on slipping, see “Slipping Clips” on page 345.

---

**Working in the Ruler**
You can perform several types of functions using the ruler area of the Timeline. You can move the playhead to a specific frame to view the project at a specific time. You can also set In and Out points so that playback occurs only within the specified frames. In addition, you can select a range of frames, so that you can delete, cut, or paste into the selected frames.
Navigating in the Timeline

Motion provides many different controls for navigating the Timeline. You can directly drag the playhead to “scrub” through your project as quickly or slowly as you want, or you can jump to a specific frame. Additionally, you can automatically jump to object boundaries, markers, and other important indicators in the Timeline.

To move the playhead to a new point in time, do one of the following:

- Double-click the current frame field, type a frame number, then press Return.
- Drag the current frame value slider to the left or right to advance or rewind.
- Drag the playhead to the frame you want.
- Click the ruler at the frame number where you want to move the playhead.
- With the Canvas or Project pane active, type the timecode or frame number where you want to move the playhead. The new frame number appears in the current frame field in the Canvas. Press Return to jump to that frame.
- With the Timeline active, type the timecode or frame number where you want to move the playhead. The new frame number appears in the Timeline's current frame field. Press Return to jump to that frame.

To move forward a specific number of frames:

- Type a plus sign (+) and then the number of frames you want to move forward.

To move backward a specific number of frames:

- Type a minus sign (–) and then the number of frames you want to move backward.

To move ahead or back in seconds, minutes, or hours, type the following in the current frame field:

- To move forward in seconds, type a plus sign (+), then type the number of seconds you want to move forward, and then type a period. For example, to move 2 seconds ahead, type +2. in the field, then press Return. To move ahead in minutes, type two periods after the number, and to move ahead in hours, type three periods after the number.

- To move backward in seconds, type a minus sign (–), then type the number of seconds you want to move backward, and then type a period. For example, to move 2 seconds backward, type –2. in the field, then press Return. To move backward in minutes, type two periods after the number, and to move backward in hours, type three periods after the number.

To play back your project:

- Press the Space bar.
To move forward or backward one frame at a time, do one of the following:
- Click the “Go to next frame” or “Go to previous frame” button in the transport controls (left of the Play/Mute Audio button).
- Choose Mark > Go to > Previous Frame or Next Frame.
- Press the Left Arrow key to move backward or the Right Arrow key to move forward.

To move forward or backward ten frames at a time, do one of the following:
- Choose Mark > Go to > 10 Frames Back or 10 Frames Forward.
- Press the Shift key, then press Left or Right Arrow key.

To jump directly to the beginning of the project, do one of the following:
- Click the “Go to start of project” button in the transport controls (to the right of the Record button).
- Choose Mark > Go to > Project Start.
- Press Home.

To jump directly to the end of your project, do one of the following:
- Click the “Go to end of project” button in the transport controls.
- Choose Mark > Go to > Project End.
- Press End.

To jump to the next keyframe, do one of the following:
- With the animated object selected, press Shift-K.
- Choose Mark > Go to > Next Keyframe.

To jump to the previous keyframe, do one of the following:
- With the animated object selected, press Option-K.
- Choose Mark > Go to > Previous Keyframe.

For information on displaying keyframes in the Timeline, see “Timeline View Options” on page 328.

In addition to simply moving to new positions in the ruler, you can navigate directly to objects within the Timeline, such as objects, markers, and keyframes. For more information on markers, see “Adding Markers” on page 362. For more information on keyframes, see “Keyframes and Curves” on page 503.

To jump directly to the beginning or end of an object in the Timeline:
1. Select the object you want to navigate to.
2. Do one of the following:
   - Choose Mark > Go to > Selection In Point or Selection Out Point.
   - Press Shift-I (for the In point) or Shift-O (for the Out point).
Defining the Play Range
Ordinarily, clicking the Play button plays your project from the first frame until the last. However, you can change the area of your project Motion plays by modifying the In and Out points in the Timeline ruler. You might do this to focus on a particular section as you fine-tune your project or make other changes to it. Once you’re done focusing on that section, you can reset the In and Out points to the beginning and end of your project.

To customize the playback In point, do one of the following:
- In the ruler, drag the In point marker from the left edge of the ruler to the frame where you want to set the In point. As you drag, the playhead also moves with your pointer. When you release the mouse button, the playhead snaps back to its previous position.
- Choose Mark > Mark Play Range In.
- Press Command-Option-I.

To customize the playback Out point, do one of the following:
- In the ruler, drag the Out point marker from the right edge of the ruler to the frame where you want to set the Out point.
- Choose Mark > Mark Play Range Out.
- Press Command-Option-O.

To reset playback In and Out points, do one of the following:
- Choose Mark > Reset Play Range.
- Press Option-X.
  The In and Out points reset themselves to the beginning and end of the project.

To navigate to playback In and Out points, do one of the following:
- Choose Mark > Go to > Play Range Start or Play Range End.
- Press Shift-Home (In point) or Shift-End (Out point).

Working with Regions
Sometimes you may want to make changes to a range of frames, known as a region. You might do this to cut or copy a section of time to remove it or move it to a new position in your project. Regions do not have to align with object edges in the Timeline. You can create a region that begins midway through an object or one that includes empty frames beyond the edges of objects.
To select a range of frames:

- Command-Option-drag in the Timeline.

A light blue band appears over the selected frames.

To expand or contract a region:

- Position the pointer at either edge of a region to modify its end point. Click to the right to make it longer or to the left to make it shorter.

Selected regions ordinarily apply to all tracks in your Timeline. However, sometimes you only want to select one or more tracks. This allows you to make complex selections across multiple layers and tracks.

To move a region:

- Position the pointer over the region, then drag to move the region.

To deselect tracks from a selection range:

- Command-click the track you want to deselect.
Once you have defined your selection range, you can delete the section or ripple delete the section (to delete it and close the resulting gap). You can cut or copy the section to move it to the Clipboard so you can paste it somewhere else.

*Note:* Pasting a region does not paste at the current playhead location. To quickly move the pasted region to the playhead location, press the Shift key while you drag the pasted object. As you approach the current playhead location, the object snaps into place.

You can also paste into a region, which fills the existing region with the contents of the Clipboard.

**Paste Into**
Regions are also useful for performing a special type of paste command called *paste into*. You can define a region and paste objects into that region. You have three choices for how the paste into is performed. You can insert, pushing the existing region down in time, overwrite the existing contents of the region, or exchange the existing objects with the Clipboard contents. In all of these cases, the pasted objects never exceed the duration of the region they are pasted into.

**To paste into a region:**
1. Select the object that you want to copy to the Clipboard to be pasted.
2. Press Command-C to copy or Command-X to cut your selection.
3. Press Command-Option-drag to select a region of the Timeline.
   The Paste Special dialog appears.
5. Select either Insert, Overwrite, or Exchange.
6. Click OK to close the dialog.

   The Clipboard contents are pasted into the region using the method you specified. For more information on the different editing types, see “Adding Objects to the Timeline” on page 331.

**Inserting Time**
You can select a region in order to add blank playback time into your project. For example, you might want to add some black frames between two objects, or put some frames in as a placeholder for a clip you don't yet have. This is called *inserting time*.

**To insert time into a project:**
1. Command-Option-drag in the ruler. Drag as wide an area as you want to insert.
2. Choose Edit > Insert Time.
The number of frames in the region is added to the project, beginning at the end of the selected region and pushing any existing objects further out in time.

**Project Duration**

Motion projects default to ten seconds in length. You can change this duration to match the needs of your project. To learn how to change the default project duration, see “General Tab of the Project Properties Dialog” on page 184.

To change the project duration, do one of the following:
- Drag in the project duration field in the lower-right corner of the Canvas. Dragging to the right extends the length and dragging to the left shortens it.
- Click the project duration field and type a number into the value field.
- Choose Edit > Project Properties (Command-J) and change the value of the project duration field in the dialog.

**Note:** You can click the stopwatch button to switch between viewing the project duration field in frames or timecode.

**Adding Markers**

A marker is a visual reference point in the Timeline that identifies a specific frame. You can add as many markers as you want in the Timeline ruler while playing the project, or when the playhead is stopped.

Use markers to:
- Add a visual reference to a track
- Add a visual reference to a project marker in the mini-Timeline
- Align other tracks, objects, or keyframes to an important point in time
- Add notes about a particular area in your project
You can assign different colors to different types or markers and create marker groups. For example, use green to label all audio markers or gold to identify all temporary object markers.

You can add two types of markers: project markers and object markers. Project markers are fixed to a specific timecode value in the ruler. Object markers are attached to an object and move around as you move the object. Object markers appear only in the Timeline. Project markers appear in the Timeline, Keyframe Editor, and Audio Editor.

Note: Project markers are indicated in the mini-Timeline by a fine green line. For more information on the mini-Timeline, see “Mini-Timeline” on page 61.

To add a project marker:
1 Place the playhead on the exact frame where you want the marker to appear.
2 Check that no objects are selected, then do one of the following:
   • Choose Mark > Markers > Add Marker.
   • Press M.
   • Control-click the gray marker bar above the ruler in the Timeline, then choose Add Marker from the shortcut menu.
A green marker is added in the gray bar above the Timeline ruler.

![Image of green marker](image)

*Note:* You can also press Shift-M to add a project marker at the playhead position, whether or not an object is selected.

**To add an object marker:**
1. Place the playhead on the exact frame where you want the marker to appear.
2. Select the object where you want to add the marker, then do one of the following:
   - Choose Edit > Markers > Add Marker.
   - Press M.

A red marker is added to the group bar.

![Image of red marker](image)

In this way, you can add markers while playing your project. The markers appear at the frame where the playhead is at the time you press the M key.

**To move a marker:**
- Drag the marker left or right to a new location.

**To delete a marker, do one of the following:**
- Drag the marker vertically out of the area where it resides, then release the mouse button.

  The marker disappears with a “poof.”
- Double-click the marker, then click the Delete marker in the Edit Marker dialog.
- Position the playhead over the marker, select the group or object (for group or object markers), then choose Mark > Markers > Delete.
- Control-click the marker, then choose Delete Marker from the shortcut menu.

**Deleting All Markers**

In addition to deleting one individual marker, you can delete all markers from your project in one step. This deletes either project markers or all markers in a selected layer or object.
To delete all project markers only:
1 Choose Edit > Deselect All (or press Command-Shift-A).
2 Choose Mark > Markers > Delete All Markers.

To delete all object markers, do one of the following:
- Select the group or layer containing the markers you want to delete, then choose Mark > Markers > Delete All Markers.
- Control-click the gray marker bar above the ruler in the Timeline, then choose Delete All Markers from the shortcut menu.

**Editing Marker Information**
You can edit the information for a marker, including its name, starting frame, duration, and color. You can also add comments to the marker. Comments show up as a tooltip when the pointer is paused over the marker.

**To edit marker information:**
1 Open the Edit Marker dialog by doing one of the following:
   - Double-click a marker to display the Edit Marker dialog.
   - Choose Edit > Markers > Edit.
   - Control-click the Marker, then choose Edit Markers from the shortcut menu.

![](image)

Notes added in the Comments field appear as tooltips when the pointer is over the marker.

2 Type a name in Name field.
3 Type a number in the Start field.
   The marker moves to the frame number you enter.
4 Type a value in the Duration field to specify the range of frames for the marker.
5 Type text in the Comment field.
   This comment appears as a tooltip when you pause the pointer over project markers.

6 Click the Color pop-up menu to display a list of eight possible colors, then choose the
   color you want for the marker.

7 Click the Type pop-up menu to choose a marker type:
   • Standard: The default marker for use in Motion
   • DVD Menu Loop: When you are using a Motion project as a menu background in
     DVD Studio Pro, the DVD menu normally plays through the entire Motion project,
     then starts over at the beginning of the project. When a loop point marker is defined,
     the DVD menu plays the Motion project to the end the first time through, then starts
     over at the loop point marker for subsequent loops.
   • DVD Alpha Transition: When you are using a Motion project as an alpha transition in
     DVD Studio Pro, this marker sets the point where the alpha value of the transition
     (the Motion project) becomes 0. When a Motion project is used as a transition, only
     its alpha channel is used when blending two pieces of video in DVD Studio Pro.

8 Click OK to accept your changes.

Navigating with Markers
You can jump from your current playhead position to a nearby project marker either
forward or backward.

To jump to the next marker:
• Control-click the gray marker bar above the ruler in the Timeline, then choose Next
  Marker from the shortcut menu.

The playhead automatically jumps to the position of the next project marker.
You can also choose Mark > Go To > Next Marker or press Command–Option–Right
Arrow.

To jump to the previous marker:
• Control-click the gray marker bar above the ruler in the Timeline, then choose Previous
  Marker from the shortcut menu.

The playhead automatically jumps to the position of the previous project marker.
You can also choose Mark > Go To > Previous Marker or press Command–Option–Left
Arrow.
You can also navigate to adjacent markers from within the Edit Marker dialog. In that case, the dialog remains open and the contents are replaced with the information for the next marker.
Using Behaviors

You can use behaviors to animate objects using simple graphical controls. With behaviors, you can easily create basic motion effects or complex simulated interactions between multiple objects.

You can add behaviors to objects (cameras, lights, layers, or groups) or properties in a project to create animated effects without needing to create or adjust keyframes. Drag a behavior onto an object, and the object is automatically animated based on the type of behavior you applied. You can customize behavior parameters in the HUD or in the Behaviors tab of the Inspector to change a behavior’s effect.

Behaviors are designed to be flexible and can be combined with one another to create all kinds of effects. Using behaviors, motion graphics design becomes interactive, allowing you to create complex motion effects and simulated object interactions very quickly.

Behaviors can also be used to animate the parameters of nearly any particle system emitter, shape, mask, replicator, filter, generator, camera, or light. This allows you to quickly create animated backgrounds, dynamic filter effects, interesting camera and lighting effects, and incredibly complex particle systems, all using a few simple controls.

Motion Tracking behaviors serve a different purpose than other behaviors. Rather than immediately creating animation on the object to which it is applied, a tracking behavior analyzes an object’s motion, or the motion in a clip. This analyzed motion can be used to stabilize a shaky clip, match the movement of an object to the movement in the analyzed clip, track a layer onto a clip (such as a logo or text onto a moving car), and so on. For more information on using the Motion Tracking behaviors, see “Motion Tracking” in the Motion Supplemental Documentation PDF.
There are 11 different kinds of behaviors in Motion.

- **Audio behaviors** are applied to audio files to create simple audio effects, such as fade-ins and fade-outs, pans, and fly-bys. There is also a separate Audio Parameter behavior that can be applied to the parameters of nearly any object. For more information on Audio behaviors, see “Audio Behaviors” on page 1139.

- **Basic Motion behaviors** are among the simplest behaviors. They animate specific parameters of the object to which they are applied. Some affect position while others affect scale or rotation. Examples include Fade In/Fade Out, Spin, and Throw. All of the Basic Motion behaviors can be applied to images and clips, particle emitters, shapes, text, and so on. Most of the Basic Motion behaviors can be applied to cameras and lights.

- **Camera behaviors** are specifically designed to be applied to a camera in a 3D project and create basic camera moves such as dolly moves, panning, and zooming. For more information on using Camera behaviors, see “3D Compositing” in the Motion Supplemental Documentation PDF.

- **Motion Tracking behaviors** perform multiple tasks. While all tracking behaviors analyze the motion present in a clip, the application of that data varies depending on the specific behavior. For example, the Stabilize behavior stabilizes movement in a clip that may have been created by camera shake. The Match Move behavior analyzes the motion in an object (such as a clip) and applies that motion to another object to integrate it with the tracking source. For more information on using the Motion Tracking behaviors, see “Motion Tracking” in the Motion Supplemental Documentation PDF.

- **Parameter behaviors** can be applied to the parameters of any object (including filters and behaviors) and their effects are limited to just that parameter. The same Parameter behavior can be added to different parameters, resulting in completely different effects. For example, you can apply the Oscillate behavior to the opacity of text to make it fade in and out, or you can apply it to the rotation of a shape to make it rock back and forth. You can also apply Parameter behaviors to filter parameters, generator parameters, the parameters of particle systems and replicators, or even the parameters of other behaviors. Examples include Oscillate, Randomize, and Reverse. Most Parameter behaviors can be applied to cameras and lights.

- **Particles behaviors** are specifically designed to be applied to a particle emitter or cells within particle systems. These behaviors affect how individual particles are animated over the duration of their life. For more information on using particle behaviors, see “Using Particles Behaviors” on page 738.
• **Retiming behaviors** are applied directly to footage and cloned layers (or groups) in order to create hold frames, reverse the footage, change its speed, create strobe frames or stutter, or to scrub the footage. These behaviors are applied to the footage objects in the Layers list, not in the Media tab. For more information on using retiming behaviors, see “Retiming Behaviors” on page 453.

• **Shape behaviors** are specifically designed to be applied to a shape or mask. Shape behaviors affect the individual vertices of a shape or mask. For example, applying the Randomize behavior randomly animates the control points (or tangents, or both) on the shape. For more information on using the Shape behaviors, see “Using the Shape Behaviors” on page 1064.

• **Simulation behaviors** perform one of two tasks. Some Simulation behaviors, such as Gravity, animate the parameters of an object in a way that simulates a real-world phenomenon. Other Simulation behaviors, such as Attractor and Repel, affect the parameters of one or more objects surrounding the object to which they’re applied. These behaviors allow you to create some very sophisticated interactions among multiple objects in your project with a minimum of adjustments. As with the Basic Motion behaviors, Simulation behaviors also affect specific object parameters. Examples include Attractor, Gravity, and Repel. Simulation behaviors can be applied to cameras and lights.

• **Text behaviors** animate text parameters to create various animated effects. Examples include Scroll Up, which causes text to move vertically for scrolling titles or credits, and Type On, which reveals text letter by letter. For more information on how to use text behaviors, see “Text Animation Behaviors” on page 649 and “Text Sequence Behaviors” on page 668.

For an introduction to how to use behaviors, see “Applying and Removing Behaviors” on page 374. For information on applying behaviors, see “Applying and Removing Behaviors” on page 377. For more detailed information on how to manipulate behaviors in a project, see “Working with Behaviors” on page 389. For detailed information on all the behaviors available in Motion, see “Behavior Descriptions” on page 408.

**Note:** Audio, Motion Tracking, Shape, Particles, Replicator, and Camera behaviors are discussed in their respective chapters.
For step-through examples of using behaviors, see “Behavior Examples” on page 483.

**Behaviors Versus Keyframes**

It’s important to understand that behaviors do not add keyframes to the objects or parameters to which they’re applied. Instead, behaviors automatically generate a range of values that are then applied to an object’s parameters, animating it over the duration of that behavior. Changing the parameters of a behavior alters the range of values that behavior generates.

Keyframes, on the other hand, apply specific values directly to a parameter. When you create two or more keyframes with different values, you animate that parameter from the first keyframed value to the last.

By design, behaviors are most useful for creating generalized, ongoing motion effects. They’re also extremely useful for creating animated effects that might be too complex or time-consuming to keyframe manually. Keyframing, in turn, may be more useful for creating specific animated effects where the parameter you’re adjusting is required to hit a specific value at a specific time. For more information on using keyframes, see “Keyframes and Curves” on page 503.

The animation created by behaviors can be converted into keyframes. For more information, see “Converting Behaviors to Keyframes” on page 404.
Browsing for Behaviors
All available behaviors appear in the Library tab. Selecting the Behaviors category in the category pane of the sidebar reveals the behavior subcategories (text behaviors have two categories). Selecting a subcategory reveals all behaviors of that type in the Library stack.

When you select a behavior in the Library stack, a short description and preview of the behavior appear in the Preview area.
**Note:** To help you understand how each behavior works, the animated behavior previews provide hints in the form of animation paths and color coding. While most previews are self-explanatory, the Parameter previews show before/after examples of the behavior’s effect on an animated object, with the gear graphic turning red to show the object after the behavior takes effect. For Simulation behaviors, the red gear graphic identifies the object in a group with the applied selected behavior.

### Applying and Removing Behaviors

Behaviors are applied directly to objects in one of the following ways:

- **Dragging a behavior directly to an object in the Canvas, Layers tab, or Timeline.**
  
  To apply a behavior to an object in the Timeline, drag the behavior to the object in the Timeline layers list or the Timeline track area.
  
  **Note:** It is usually easier to drag a behavior to a camera or light in the Layers tab or Timeline than directly to the object in the Canvas.

- **Selecting an object, selecting a behavior in the Library, and then clicking the Apply button in the Preview area of the Inspector.**

- **Selecting an object, and then selecting a behavior from the Add Behavior button in the Toolbar.**

- **Control-clicking a parameter of an object (including the parameters of other behaviors), and choosing a Parameter behavior from the shortcut menu.**

Behaviors are removed by selecting the behavior in the Canvas, Layers tab, Timeline, or Inspector and pressing Delete.
Where Behaviors Appear
When you apply a behavior to an object, it appears nested underneath that object in the Layers tab and the Timeline.

New behaviors you apply to an object appear above other behaviors that were applied previously.
A Behaviors icon also appears to the right of the object name in the Layers tab and Timeline. Clicking this icon enables and disables all behaviors that have been applied to that object.

**Note:** Behaviors can be hidden from view in the Layers tab using the Show Behaviors button in the lower right of the Layers tab. For more information, see “Hiding and Showing Effects” on page 72.

When any behavior is applied to an object in your project, a Behaviors icon (a gear) appears in the Animation menu to the right of the affected parameter in the Properties, Behaviors, or Filters tab where it’s applied. This shows you that a behavior is influencing that parameter.

A Behaviors icon also appears in the Animation menu of each affected parameter in the Keyframe Editor.

**Animation Paths**
When certain behaviors are applied to an object, an animation path appears and displays the projected path of the object over time. Consider this path a “preview” of the animation created by the behavior. Unlike animation paths created using keyframes or the path created by the Motion Path behavior, animation paths for behaviors cannot be edited. To show or hide all types of paths, use the View pop-up menu in the Status Bar.
Behavior Effects in the Keyframe Editor
If you open the Keyframe Editor and look at a parameter that is affected by one or more behaviors, you see a noneditable curve that represents the behavior’s effect on that parameter. The noneditable curve appears in addition to that parameter’s editable curve, which can be used to keyframe that parameter.

Note: Use the Show pop-up menu in the Keyframe Editor to select what parameters are displayed and to create curve sets. For more information on curve sets, see “Custom Parameter Sets” on page 533.

For more information on combining behaviors and keyframes, see “Combining Behaviors with Keyframes” on page 398.

Applying and Removing Behaviors
You can apply behaviors directly to objects in the Canvas, Layers tab, or Timeline. Some behaviors automatically animate specific parameters of the layer to which they’re applied. For example, the Throw behavior affects only an object’s Position parameter, and the Grow/Shrink behavior affects only an object’s Scale parameter. Other behaviors animate the parameters of layers that surround the layer to which the behavior is applied. For example, the Attractor behavior causes other layers to move toward the affected layer by animating their Position parameter.

Important: Text, Particles, Replicator, Audio, Shape, and Camera behaviors should only be applied to their namesake objects. The Grow/Shrink and Fade In/Fade Out behaviors cannot be applied to cameras and lights.

Note: With the exception of the Custom behavior, Parameter behaviors can also be applied to a parameter of an object (such as position) in addition to the object itself. For more information, see “Applying Parameter Behaviors” on page 380.

To apply a behavior to an object, do one of the following:
- Drag a behavior from the Library to an appropriate object in the Canvas, Layers tab, or Timeline.
- To apply a behavior to an object in the Timeline, drag the behavior to the object in the Timeline layers list or the Timeline track area.
**Note:** It is usually easier to drag a behavior to a camera or light in the Layers tab or Timeline than directly to the object in the Canvas.

An advantage to applying behaviors from the Library is the ability to preview the animation created by the behavior in the Library Preview area.

- Select an object in the Canvas, Layers tab, or Timeline, then select a behavior from the Library stack and click Apply in the Preview area.

- Select an object in the Canvas, Layers tab, or Timeline, then click the Add Behavior icon in the Toolbar and choose the behavior you want.

**To apply a behavior to multiple objects:**

1. Select all of the objects to which you want to apply the behavior.

   In the Layers tab, Canvas, or Timeline, Shift-click to select a contiguous set of objects, or Command-click to select individual, noncontiguous objects.

2. Do one of the following:
   - In the Toolbar, click the Add Behavior icon, then choose a behavior from one of the submenus.
   - Select a behavior in the Library, then click Apply in the Preview area.

3. Play the project to see the animated effect in action.

**Important:** Not all behaviors automatically create motion on an object. Some behaviors, such as Throw, require you to set the throw velocity (in the HUD or in the Inspector) before the object is “thrown.” Other behaviors, such as Orbit Around, require a source object to act as the central object for other objects to move around.
When a behavior is applied to an object, the object parameters affected by that behavior are automatically animated based on the behavior’s default settings. For example, if you apply the Gravity behavior to an object in the Canvas, that object’s position is animated and it moves down, according to the Gravity behavior’s default setting.

**Default Behavior Duration**

In most cases, a behavior’s duration is the Timeline duration of the object to which it is applied. For example, if you apply a Spin behavior to an object that begins at frame 20 and ends at frame 300, the Spin behavior’s duration is also frame 20 to frame 300. For information on trimming the duration of a behavior, see “Trimming Behaviors” on page 395.

**Note:** The Create Layers At preference (in the Project pane of Motion Preferences), which allows you to specify whether layers are created at frame 1, or at the current playhead position, applies only to layers that are created or imported, such as text, shapes, or a QuickTime movie file.

**Note:** You can also apply behaviors directly to groups in the Layers tab or Timeline. Depending on the applied behavior, all objects nested within that group are either affected as if they were a single object or as individual elements. You can often change this result by adjusting the Affect or Affect Subobjects parameter in the Behaviors tab of the Inspector.

**Tip:** If you do not see the expected result when applying behaviors to objects, try turning the Affect Subobjects parameter on or off, or choosing a different option from the Affect pop-up menu. These parameters determine whether the entire group or its components (such as the child objects nested within that group) are affected by the behavior and how an object interacts with surrounding objects, respectively.

**Note:** The Affect Subobjects checkbox only appears in the Inspector when the Throw and Spin behaviors, or the Simulation behaviors, are applied to a group or object that contains multiple objects, such as a particle emitter or text.

**Removing Behaviors**

Because behaviors don’t add keyframes, removing a behavior instantly eliminates its animated effect. All types of behaviors are removed in the same way.
To remove a behavior from an object:

1. Select a behavior in the Layers tab, Timeline, Behaviors tab, or pop-up menu in the title bar of the HUD.

2. Do one of the following:
   - Choose Edit > Delete.
   - Control-click the behavior in the Layers tab or Timeline, then choose Delete from the shortcut menu.
   - Press Delete.

**Applying Parameter Behaviors**

Parameter behaviors function differently than other behaviors. All behaviors affect specific parameters of an object—when a Spin behavior is applied to an image, the Rotation parameter for that image is automatically affected; when a Fade In/Fade Out behavior is applied to a clip, the Opacity parameter for that clip is automatically affected, and so on. Parameter behaviors are applied to individual parameters of an object, camera, filter, behavior, and so on, rather than to the object itself.

This includes the parameters of filters, emitters and cells in particle systems, shapes, text, and so on. You can also apply Parameter behaviors to the parameters of other behaviors that have been applied to an object.

In a simple comparison, a Throw behavior is applied to a text layer and the text travels across the Canvas. The Throw behavior affects the Position parameter of the text layer. If an Oscillate Parameter behavior is applied directly to the Position parameter of a shape, that shape moves back and forth across the Canvas.
A Parameter behavior’s effect on an object depends on the parameter to which it is applied. For example, if you apply the Randomize parameter behavior to a particle emitter’s Position parameter, the emitter drifts around the screen when the project plays. Applying the Randomize parameter behavior to a shape’s Scale parameter makes the shape randomly grow and shrink.

**Important:** Although you can apply a Parameter behavior to an object using Library behavior or the Add Behavior icon in the Toolbar, the applied behavior will not affect the object until you select a parameter to which you want to apply the Parameter behavior. A more direct way to apply a Parameter behavior is by using the shortcut menu in the Inspector.

**To apply a Parameter behavior to an object’s specific parameter:**
1. Select the object to which you want to apply the Parameter behavior.
2. Do one of the following:
   - Control-click a parameter in the Inspector, then choose a Parameter behavior from the shortcut menu.

![In this example, the Oscillate parameter behavior is applied to the Rotation parameter of a shape.](image)

---

Chapter 5  Using Behaviors  381
• Control-click a parameter in the HUD, then choose a Parameter behavior from the shortcut menu.

![Image of HUD with parameter list]

In this example, the Randomize parameter behavior is applied to the Feather parameter of a shape.

• Control-click a parameter in the Keyframe Editor, then choose a Parameter behavior from the shortcut menu.

*Note:* Use the Show pop-up menu to choose the parameters you want displayed in the Keyframe Editor. For more information, see “Filtering Controls” on page 531.

Once a Parameter behavior is applied to a parameter, the Inspector automatically switches to the Behaviors tab.

**To apply a Parameter behavior to an object:**

1. Do one of the following:
   - Drag a Parameter behavior from the Library to an appropriate object in the Canvas, Layers tab, or Timeline.
   - Select an object in the Canvas, Layers tab, or Timeline, then click the Add Behavior icon in the Toolbar and choose the Parameter behavior you want.

   *Note:* It is usually easier to drag a behavior to a camera or light in the Layers tab or Timeline than directly to the object in the Canvas.

   The behavior is applied to the object, but no parameter is assigned to the behavior.

2. To assign a specific parameter to the Parameter behavior, do one of the following:
• Select the Parameter behavior, then choose a parameter from the Apply To ("Go") pop-up menu in the HUD.

![Image](image.png)

In this example, the Randomize parameter behavior is applied to the Opacity parameter of a shape.

• Select the Parameter behavior, then choose a Parameter behavior from the Apply To ("Go") pop-up menu in the Behaviors tab of the Inspector.

Once assigned, the parameter to which the behavior is applied appears in the Apply To text field.

**Note:** If you save a Parameter behavior as a favorite, its parameter assignment is saved along with the rest of that behavior’s settings. As a result, it can be applied like any other behavior and that new object’s parameter is automatically affected.

**Applying Parameter Behaviors to 3D Animation Parameters**

When parameter behaviors are applied to parameters that include 3D channels, such as Position and Rotation, a default parameter is affected. The default is based on the most commonly used effect. For example, when Oscillate is applied to the Rotation parameter (in the Properties tab) of an object, the behavior is assigned to the Z parameter by default.

![Image](image.png)

By default, the Oscillate behavior is applied to the Z Rotation parameter.
This creates an animation in which the image rocks back and forth on the Z axis.

To select another parameter for the behavior to affect, use the Apply To parameter in the parameter behavior's HUD or Inspector.

**To change the parameter behavior assignment:**
- In the behavior’s HUD or Inspector, choose another parameter in the Apply To (“Go”) pop-up menu. In this Oscillate example, the oscillation is applied to the X and Y axes of the affected object.

This creates an animation in which the image rocks back and forth on the X and Y axes.
For more information on reassigning parameter behaviors, see “Reassigning a Parameter Behavior to Another Parameter” on page 386.

**Where Parameter Behaviors Appear**
Like other behaviors, Parameter behaviors appear nested underneath the objects to which they’re applied in the Layers tab and the Timeline, along with any other behaviors that have been applied to that object.

*Note:* Although a Parameter behaviors appear nested under objects in the Layers list, keep in mind that each Parameter behavior is applied to a single parameter of an object, and not the object itself.

Notice that the Parameter behavior icon includes an image similar to a funnel. The funnel represents the “channeling” of individual parameters.
Opening a parameter’s Animation menu in the Inspector displays the names of all the behaviors currently applied to that parameter. Choosing one automatically opens that item’s Behaviors tab.

Like all other behaviors, when a Parameter behavior is applied to an object in your project, a Behaviors icon appears in the Animation menu of the affected parameter in the Properties, Behaviors, or Filters tab where it is applied, as well as in the Animation menu of each affected parameter in the Keyframe Editor.

**Reassigning a Parameter Behavior to Another Parameter**

Once you apply a Parameter behavior, it remains assigned to that parameter unless you reassign it. This is possible using the Apply To (“Go”) pop-up menu, located at the bottom of the Parameter behavior controls in the HUD or Behaviors tab.

The Apply To (“Go”) pop-up menu displays all of the properties available for the object to which the behavior is applied. If an object has other behaviors or filters applied to it, those parameters also appear within submenus of the Apply To (“Go”) pop-up menu.

**To reassign a Parameter behavior to another parameter in the HUD:**

1. In the Layers tab, Timeline, or Behaviors tab of the Inspector, select the Parameter behavior you want to reassign.

2. In the HUD, choose a new parameter from the Apply To (“Go”) pop-up menu.

   The Parameter behavior is applied to the newly chosen parameter and the Apply To field is updated to reflect the new assignment. In the Inspector, the Behaviors icon now appears next to the new parameter.

**To reassign a Parameter behavior to another parameter in the Inspector:**

1. Select the object containing the Parameter behavior you want to reassign.
2 In the Behaviors tab in the Inspector, choose a new parameter from the Apply To (“Go”) pop-up menu.

The Track Parameter Behavior
The Track Parameter behavior allows you to track a parameter of an effect, such as the center of a lens flare, to a reference point on a clip. For example, you can make a light ray emit from a moving object in a clip by tracking the clip and then applying the Track Parameter behavior to the Center parameter of the Light Rays filter. For more information about using the Track Parameter behavior, see “Motion Tracking” in the Motion Supplemental Documentation PDF.

Modifying Behaviors
Each behavior has a subset (or sometimes a complete set) of parameters that appear in the HUD. In addition, all behavior parameters appear in the Behaviors tab of the Inspector. Both the HUD and the Behaviors tab reference the same parameters, so changing a parameter in one automatically changes the same parameter in the other.
Modifying Parameters in the HUD

In general, the parameters that appear in the HUD are the most essential for modifying that behavior’s effect. Frequently, the controls available in a behavior’s HUD are also more descriptive and easier to use than those in the Behaviors tab, although the Behaviors tab may contain more controls. For example, compare the controls for the Fade In/Fade Out behavior in the Behaviors tab to those available in the HUD:

As you can see, the controls in the HUD consolidate two of the parameters available in the Behaviors tab into a single, graphical control. There are times, however, when it may be more desirable to use a behavior’s individual parameters to finesse the effect you’re trying to achieve with greater detail, including the ability to enter specific parameter values.

To display the HUD for a behavior:

1. Select an object with an applied behavior.
2. Do one of the following:
   • Select the behavior you want to modify in the Layers tab, Timeline, or Behaviors tab of the Inspector.
   • Control-click an object in the Canvas, then choose a behavior from the Behaviors submenu in the shortcut menu.

   Note: If the HUD doesn’t appear, you may need to choose Window > Show HUD (or press F7 or D).
3. Make adjustments to the behavior using the controls in the HUD.
To cycle through the HUDs of an object, do one of the following:

- Click the disclosure triangle in the title bar of the HUD (to the right of the title) to open a pop-up menu that displays all of the behaviors and filters that are applied to that object. Choose an item from this list to display its HUD.

- Select an object in the Canvas, then press D to cycle forward through all available HUDs for that object. To cycle in reverse, press Shift-D.

**Customizing Parameters in the Behaviors Tab of the Inspector**

The Behaviors tab of the Inspector displays every behavior that’s applied to the selected object. A disclosure triangle to the left of each behavior’s name reveals all of that behavior’s parameters. Unlike the HUD, the Behaviors tab displays every parameter for a behavior.

**To display the Behaviors tab:**

1. Select an object with an applied behavior.
2. Open the Inspector, then click the Behaviors tab.
   All of the applied behaviors appear in the tab.

**Working with Behaviors**

This section describes how to enable, rename, lock, duplicate, move, and reorganize behaviors in your project. These procedures apply to every type of behavior.

**Enabling, Renaming, and Locking Behaviors**

When you apply a behavior to an object, it appears in three different places—the Layers tab, the Timeline, and the Behaviors tab of the Inspector.

While the Behaviors tab in the Inspector contains all of the editable parameters for a behavior that’s been applied to an object, the Layers tab and Timeline have several controls for each behavior:
Activation checkbox: Turns each individual behavior on or off. Behaviors that are turned off have no effect on the object to which they’re applied.

Name: Double-click this field to rename the behavior.

Lock: Click the lock icon to lock or unlock a behavior. You cannot modify the parameters of a locked behavior.

Enable/disable behaviors: A Behaviors icon (a gear) appears to the right of the name of each object with one or more behaviors applied to it. Clicking this icon toggles all behaviors applied to that object on and off.

Note: Control-clicking the Behaviors icon opens a shortcut menu that displays all the behaviors that are applied to that object. Choose a behavior from this menu to display it in the Inspector.
**Show Behaviors button:** Appears at the bottom of the Layers tab and Timeline, and lets you show or hide all behaviors. This button neither enables nor disables behaviors that have been applied to objects in your project; it only controls their visibility.

![Show Behaviors button is enabled.](image)

**Copying, Pasting, and Moving Behaviors**

After you have added behaviors to an object, there are a number of ways you can copy and move them among the other items in the Timeline or Layers tab.

Behaviors can be cut, copied, and pasted like any other item in Motion. When you cut or copy a behavior in the Timeline or Layers tab, you also copy the current state of all that behavior's parameters.

**To cut or copy a behavior:**

1. Select a behavior.
2. Do one of the following:
   - Choose Edit > Cut (or press Command-X) to remove the behavior and place it on the Clipboard.
   - Choose Edit > Copy (or press Command-C) to leave the behavior there and copy it to the Clipboard.

**To paste a behavior:**

1. Select an object onto which you want to paste the behavior.
2. Choose Edit > Paste (or press Command-V).

   The cut or copied behavior is applied to the selected object, with all its parameter settings intact.

   You can also move a behavior from one object to another in the Layers tab or Timeline layers list by simply dragging it to a new position.

**To transfer a behavior from one object to another:**

- In the Layers tab or Timeline layers list, drag a behavior from one object and drop it on top of another.
**Note:** If you move a Parameter behavior to another object, it is applied to the same parameter it affected in the previous object—as long as the corresponding parameter exists. If the parameter does not exist, the parameter assignment (Apply To field) is set to none.

You can also duplicate a behavior in place.

**To duplicate a behavior:**
1. Select the behavior you want to duplicate.
2. Do one of the following:
   - Choose Edit > Duplicate (or press Command-D).
   - Control-click the behavior you want to duplicate, then choose Duplicate from the shortcut menu.

You can also duplicate a behavior and apply the duplicate to another object in the Layers list or Timeline layers list.

**To drag a duplicate of a behavior to another object:**
- Option-drag the behavior to the object to which you want to apply the duplicated behavior.

The duplicated behavior is applied to the second object, and the original behavior is left in its original location.

When you duplicate an object, you also duplicate all behaviors that have been applied to it. This way, if you’re creating a project with a number of objects that all need to use the same behavior, you can simply apply that behavior to the first instance of that object, and then duplicate that object as many times as necessary.
Applying Multiple Behaviors to an Object
There is no limit to the number of behaviors you can add to an object. When multiple behaviors are applied to a single object, they all work together to create a final animated effect.

Because each behavior applies a value to a specific parameter, the values generated by all behaviors that affect the same parameters are combined to create the end result. For example, applying the Throw, Spin, and Gravity behaviors to a single object results in the combined result of the Throw and Gravity behaviors affecting the position of the object, and the Spin behavior affecting its rotation.

Reordering Behaviors
When you apply a number of behaviors to a single object, they all appear nested beneath that object in the Timeline and Layers tab. You can change the order in which they are applied. While the effects of most behaviors on a parameter are additive, this is useful more as an organizational tool than as a way to change the animated effect created by the behaviors. One notable exception to this is the Stop behavior. It suspends the activity of all behaviors appearing beneath it that affect the same parameter, while not affecting any behaviors above it in the Layers list.

To reorder a behavior:
1 Drag the behavior you want to reorder up or down in the list of nested behaviors applied to the same object. A position indicator shows where the behavior appears when you release the mouse button.

2 When the position indicator is in the correct position, release the mouse button.
Changing the Timing of Behaviors

You can change a behavior’s timing to control when it starts, how long it lasts, and when it stops. There are several ways to do this. You can use the Stop Parameter behavior to suspend one or more behavior’s effects on a single parameter. You can also trim each behavior in the Timeline. Finally, you can change some behaviors’ Start Offset parameter to delay their beginning and their End Offset to end the behaviors prior to the end of the object duration to which they are applied. These behaviors include Fade In/Fade Out, Grow/Shrink, and Snap Alignment to Motion.

Using the Stop Parameter Behavior

The easiest way to control behavior timing is to use the Stop Parameter behavior. The Stop behavior halts the animation occurring in any one parameter, whether the animation is due to keyframes in the Keyframe Editor or behaviors that have been applied to that object.

As explained in “Applying Parameter Behaviors” on page 380, all Parameter behaviors can be applied directly to a parameter of an object (such as opacity or position) or directly to an object (such as text or an image). If the behavior is applied directly to an object, a parameter must be explicitly assigned to the behavior (in the Behaviors tab of the Inspector).

To stop a parameter from animating:

1. Move the playhead to the frame where you want animation to stop.
2. Select the affected object, then open the Properties tab in the Inspector.
3. Control-click the parameter you want to stop, then choose Stop from the shortcut menu.

The parameter is animated until the frame at which the Stop behavior begins.

Note: When a Stop behavior is applied in this manner, the Stop behavior is applied at the current frame (regardless of the Create Layers At Preference setting).

4. To assign the Stop behavior to a different parameter, choose a new parameter from the Apply To (“Go”) pop-up menu.

The Stop behavior halts the animation of all behaviors that affect the selected parameter of that object. For example, if the Gravity, Edge Collision, and Rotate behaviors are applied to a shape and you apply the Stop parameter to the shape layer’s Position parameter, the shape stops moving but continues rotating.

To control when animation affecting that parameter is stopped, trim the Stop behavior in the Timeline. For more information on trimming behaviors, see the next section on page 395.
For more information about applying Parameter behaviors, see “Applying Parameter Behaviors” on page 380.

**Trimming Behaviors**

When you apply a behavior to an object, the duration of the behavior in the Timeline defaults to the duration of the object to which it’s applied.

A behavior can be modified to limit the duration of its effect. For example, if you apply the Spin behavior to a replicator layer, by default that replicator spins around for its entire duration. If you trim the Out point of the Spin behavior, the spinning stops at the new position of the Out point.

To change the duration of a behavior in the Timeline:

1. Move the pointer to the In or Out point of any behavior in the Timeline.
2. When the pointer changes to the trim pointer, do one of the following:
   - Drag the In point to delay the beginning of the behavior’s effect.
   - Drag the Out point to end the behavior’s effect prior to the end of the object.

   **Note:** When you drag the In or Out point of a behavior, a tooltip appears and displays the new location and duration of the In or Out point.

Trimming the Out point of a behavior often sets the object to its original state beyond the Out point behavior. For many behaviors, using the Stop behavior to pause the object’s animation is a more efficient method than trimming its Out point. Another way to stop a behavior’s effect and leave the affected object in the transformed state is to adjust a behavior’s Start and End Offset parameters. See “Changing the Offset of Parameter Behaviors” on page 397 for more information.
Note: The Simulation behaviors do not leave the object at the transformed state after the last frame of the trimmed behavior. For more information, see “Controlling Simulation Behaviors” on page 396.

Controlling Simulation Behaviors
Keep in mind that the ideal use for behaviors (with the exception of the Motion Tracking behaviors) is creating fluid motion graphics that do not require specific timing. This is especially true with the Simulation behavior group, which allows you to create some very sophisticated interactions among multiple objects in your project with minimal editing.

Unlike Basic Motion behaviors, you cannot stop or change the motion of a Simulation behavior in the Timeline. However, you can affect the rate of a Simulation behavior by modifying its duration in the Timeline. You can also change the starting frame of the behavior.

But because the Simulation behaviors simulate natural effects, such as Gravity, the laws of inertia apply—an external force set the object in motion, and that object stays in motion even once the active force is no longer present. Changing the duration of a Timeline bar for a Simulation behavior does stop the “active” force on the object, but does not stop the motion of the object. You can, of course, control Simulation behaviors by modifying their parameters.

In the following image, the Orbit Around (Simulation) behavior is applied to the large circle. The center text is assigned as the object that the circle moves around. The red animation path represents the motion the circle travels over its duration. The Orbit Around behavior is the same duration (300 frames) as the large circle to which it is applied.

The Orbit Around behavior, applied to the large circle, is the same duration as the object to which it is applied. The red animation path shows the motion of the circle over its duration.
In the next image, the Orbit Around behavior is trimmed in the Timeline to a shorter duration (190 frames) than the object to which it is applied. Notice the change in the shape of the animation path: At frame 190, where the Orbit Around behavior ends, the object (the circle shape) stops moving around its target and continues moving off the Canvas. The Orbit Around behavior—the active force—is no longer present, but the motion of the circle does not stop.

---

**Moving Behaviors in Time**

In addition to changing a behavior's duration, you can also move its position in the Timeline relative to the object under which it's nested. This lets you set the frame at which that behavior begins to take effect.

**To move a behavior in the Timeline:**

1. Click anywhere within the middle of a behavior's bar in the Timeline.
2. Drag the behavior to the left or right to move it to another position in the Timeline.

As you move the bar, a tooltip appears and displays the new In and Out points for the behavior. It also displays the delta value, which shows the number of frames you have moved the bar.

---

**Changing the Offset of Parameter Behaviors**

Certain Parameter behaviors have two additional parameters, Start Offset and End Offset, which are used to change the frame where a parameter behavior's effect begins and ends.
The Start Offset parameter has a slider that lets you delay the beginning of the behavior’s effect, relative to the first frame of its position in the Timeline. You can adjust this parameter to make the parameter behavior start later.

The End Offset parameter lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, lets you freeze the behavior’s effect on the object for its remaining duration.

The following example illustrates how to use the Start Offset and End Offset parameters with the Ramp parameter behavior.

To use the Start Offset and End Offset parameters:
1. Select an object, such as a shape.
2. In the Properties tab of the Inspector, Control-click the Scale parameter, then choose Ramp from the shortcut menu.
   The Ramp parameter behavior is applied to the Scale parameter of the object, and the Behaviors tab is displayed. The Ramp behavior lets you create a gradual transition in any animateable parameter.
3. Set the Start Value to 0 and the End Value to 200, then play the project.
   The object scales from its original scale to twice its original size over the duration of the object.
4. Set the Start Offset to 90 and the End Offset to 90.
   The object does not begin scaling until frame 90, and stops scaling 90 frames from its last frame in the Timeline.

Combining Behaviors with Keyframes
Any object can have both behaviors and keyframes applied to it simultaneously. When this happens, the values generated by the behavior and the keyframed values that are applied to the parameter itself are combined to yield the final value for that parameter. This lets you combine the automatic convenience of behaviors with the direct control of keyframing to achieve your final result.
For example, if you apply the Random Motion behavior to a shape, that shape might weave around onscreen with a completely random animation path similar to the following:

If you turn the Random Motion behavior off temporarily and create an animation path using keyframes, you can create a completely predictable and smooth movement.

You can combine the two by turning the Random Motion behavior back on, with the end result being an animation path that follows the general direction you want, but that has enough random variation in it to make it interesting.

While this example shows how you can combine behaviors and keyframes to create animation paths, you can combine behaviors and keyframes for any parameter.
Combining Behaviors and Keyframes in the Keyframe Editor

When you display a parameter that’s affected by a behavior in the Keyframe Editor, two curves appear for that parameter. An uneditable curve in the background displays the parameter as it is affected by the behavior. There are no keyframes over this first curve. Superimposed over the curve displaying the behavior’s effect is the parameter’s editable curve.

You can keyframe a parameter either before or after applying a behavior to the object that affects it. When you keyframe a parameter that is already affected by a behavior, the value of the keyframed curve is combined with the value generated by the behavior at each frame, which either raises or lowers the resulting value displayed by the background curve. The background curve doesn’t just display the behavior’s animated values, it displays the sum of all values affecting that parameter.
Raising or lowering a keyframe in the Keyframe Editor also raises or lowers the background curve, since it’s modifying the values generated by the behavior.

**Important:** The value displayed in the Inspector for the affected parameter reflects the final combined result of both keyframes and behaviors that are applied to that parameter. Editing a parameter’s values directly in the Inspector only results in changes made to the underlying parameter value, whether keyframed or not. This parameter value is then combined with the behavior’s effect, yielding a final value that may differ from the value you entered.

For more information on how to use keyframes in the Keyframe Editor, see Chapter 6, “Keyframes and Curves,” on page 503.

**Important:** When you combine keyframes with multiple behaviors, the results can appear to be unpredictable, depending on the combination of behaviors that are applied.
You can convert the behaviors that are applied to all parameters of an object into keyframes. Converting behaviors that have already been combined with keyframes turns the sum of all behaviors and keyframes affecting that parameter into a thinned series of keyframes (a curve with less keyframes). This results in a final animation curve that closely replicates the shape of the background curve that appeared in the Keyframe Editor. These keyframes can then be edited directly in the Keyframe Editor.

For more information on converting behaviors into keyframes, see “Converting Behaviors to Keyframes” on page 404.

**Animating Behavior Parameters**

You can animate most behavior parameters in order to change the parameter’s effect over time. You can animate behavior parameters using parameter behaviors, or by keyframing them in the Keyframe Editor.
Applying Parameter Behaviors to a Behavior
You can animate a behavior’s parameter by applying a Parameter behavior. For example, you can apply the Oscillate Parameter behavior to the Drag parameter of the Orbit Around behavior, then adjust the Start and End values to increase from 0 to 8 over time. This results in the orbit of the object slowly decaying, causing the object to fall toward the center of the orbit.

For more information about adding Parameter behaviors, see “Applying Parameter Behaviors” on page 380.

Keyframing Behaviors
If you need more control when animating a behavior’s parameters, you can use keyframes. For example, you can keyframe the Drag parameter of the Orbit Around behavior to grow and shrink the object’s orbit many times, creating a much more complex animation path. Keyframing this animation path manually would be very difficult, but by keyframing a single parameter within a single behavior, you can create this effect with ease.
For more information about keyframing parameters, see “Animating Behaviors” on page 514.

**Converting Behaviors to Keyframes**

Behaviors are best suited for fluid effects in which precise timing is not a requirement. However, there may be projects in which you want finite control over the animated effects created with behaviors. If necessary, several of the behaviors can be baked into keyframes. This means that the animation curves created by the behaviors (that have no keyframes) can be converted into keyframed animation curves. You can then modify the keyframes in the Keyframe Editor to meet more precise timing requirements.

Because many (though not all) behaviors affect shared object parameters, when you convert an object or a behavior to keyframes, all behaviors applied to that object are also converted into keyframes. The keyframes are applied to the individual parameters the behaviors originally affected. For example, the Gravity and Throw behaviors affect Position, so you could not convert the Gravity behavior to keyframes without affecting the Throw behavior. When behaviors that are applied to other objects affect the object being converted (for example, the Attractor or Repel behavior), their effect is baked into the object’s resulting keyframes value. The original behaviors remain applied to the other objects, but the resulting effect is not doubled up as a result of the keyframes combining with the behavior.

**Note:** You cannot convert many of the Simulation, Replicator, Particle, or Text behaviors into keyframes. Simulation behaviors such as Vortex can affect the parameters of all objects within a project, and baking such a behavior would create an overwhelming amount of keyframes. Remember, the beauty of such behaviors is that they automatically create very complex motion that would be too time-consuming to keyframe manually.

If a behavior (or an object with applied behaviors) can be baked, the Convert to Keyframes command appears in the Object menu when the behavior or object is selected. If the Convert to Keyframes command is dimmed, keyframes cannot be generated from the behavior.

**To convert behaviors to keyframes:**

1. Do one of the following:
   - Select an object that has behaviors you want to convert.
   - In the Inspector, select a behavior you want to convert.
2. Choose Object > Convert to Keyframes (or press Command-K).
   A dialog prompts you to confirm the conversion to keyframes.
3. Click Convert.
All behaviors are converted into keyframes, which appear in the Keyframe Editor. The entire animation of the object is converted into keyframes, even if some of the behaviors fall outside of the object’s time range.

**Note:** You cannot selectively convert individual behaviors. The Convert to Keyframes command converts all behaviors that are applied to an object at once.

**Saving and Sharing Custom Behaviors**

You can save any object in Motion to the Library, including cameras, lights, customized filters and behaviors, groups, and layers (customized particle systems, replicators, shapes, and text). Objects animated with behaviors or keyframes can also be saved to the Library and retain their animation when applied to another project.

Customized behaviors can be saved in an existing folder in the Library, such as the Favorites category, or you can create a new folder within an existing category. Once a behavior is placed into the Library, it can be added to a project like any other object in the Library. Behaviors saved in the Library appear with a custom icon.

**Note:** Items that are saved to the Library appear in the Finder with a .molo extension ("Motion Library object"). These items cannot be opened from the Finder.

You can save multiple objects to the Library as one file or multiple files. For example, if you create an animation that uses multiple behaviors and you want to save the cumulative effect of those behaviors, you can save all of the behaviors as one item in the Library.

Although you can save custom behaviors into the Behaviors category, it is generally recommended that you save items that you use frequently in the Favorites category; some Motion Library categories contain so many items that utilizing the Favorites or Favorites Menu category may save you search time. Within the Favorites category, you can create additional folders to assist you in better arranging your custom items.

Behaviors that are saved to the Favorites Menu category can be quickly applied to objects using the Favorites menu.

You can also create new folders in existing categories. You can create a new folder in the Favorites or Behaviors category. Folders created in the Behaviors category appear in the Library sidebar. Folders created in the subcategories, such as the Basic Motion subcategory, appear in the Library stack and not the sidebar.

**To save a behavior to the Library:**

1. Open the Library and select the Favorites, Favorites Menu, or Behaviors category.
2. Drag the customized behavior you want to save from the Layers tab, Timeline, or Inspector into the stack at the bottom of the Library.
When you save a customized behavior, it is saved in the /Users/username/Library/Application Support/Final Cut Studio/Motion/Library folder.

**Note:** If a custom behavior is dragged to another subcategory, such as the Glow (Filters) subcategory, it is automatically placed in the Behaviors category and the Behaviors category becomes active.

**To save multiple behaviors to the Library:**
1. Open the Library and select the Favorites, Favorites Menu, or Behaviors category.
2. In the Layers tab, select all of the behaviors you want to save, drag them to the stack, holding down the mouse button until a drop menu appears.
3. Choose “All in one file” or “Multiple files” from the drop menu, then release the mouse button.
   “All in one file” saves all the behaviors together. They are listed as one item in the Library. “Multiple files” saves the behaviors as individual objects in the Library.
4. To name the file or files, do one of the following:
   - Control-click the icon, choose Rename from the shortcut menu, then type a descriptive name.
   - Select the icon, click “Untitled,” then type a descriptive name.

**Note:** When you Control-click the icon, the Edit Description option becomes available. This is a handy tool that allows you to enter custom notes about an item saved in the Library. Once you choose Edit Description, enter your notes in the text field and click OK.

**To create a new folder in the Behaviors, Favorites, or Favorites Menu category:**
1. Open the Library and select the Behaviors, Favorites, or Favorites Menu category.
2. Do one of the following:
   - Click the New Folder button at the bottom of the window.
   - Control-click an empty area of the Library stack (the lower section of the Library), then choose New Folder from the shortcut menu.

**Note:** You may have to expand your stack window or use icon view to access an empty area.

An untitled folder appears in the subcategories list in the Library sidebar.
3. With the new folder selected, click the name, type a new name, then press Return.
To create a new folder in a Behaviors subcategory:
1 Open the Library and select a Behaviors subcategory, such as Basic Motion.
2 Do one of the following:
   - Click the New Folder button at the bottom of the window.
   - Control-click an empty area of the Library stack (the lower section of the Library), then choose New Folder from the shortcut menu.
The new untitled folder appears in the Library stack. The new folder does not appear in the Library sidebar.
3 With the new folder selected, click the name, type a new name, then press Return.

To move a behavior to a custom folder in the Behaviors category:
- Drag the behavior to the new folder in the Library sidebar.
  The custom preset is added to the new folder and to the All subcategory.

To move a behavior to a custom folder in a Behaviors subcategory:
- Drag the behavior to the new folder in the Behaviors subcategory in the Library stack.
  The custom preset is added to the new folder and to the All subcategory.

To delete a custom behavior:
- In the Library stack, Control-click the custom behavior, then choose Move to Trash from the shortcut menu.

To delete a custom folder from a subcategory in the Library stack:
- Control-click the folder in the Library stack, then choose Move to Trash from the shortcut menu.

*Note:* You can also delete the folder from the Finder. The folder is stored in the
/Users/username/Library/Application Support/Final Cut Studio/Motion/Library folder.

*Important:* Deleting a custom object or folder cannot be undone.

To delete a custom folder from a category in the Library sidebar:
- In the Finder, navigate to the /Users/username/Library/Application Support/Final Cut Studio/Motion/Library folder, Control-click the folder, then choose Move to Trash from the shortcut menu.
Moving Behaviors Among Different Computers

Each customized behavior you drag into the Library is saved as a separate file in the /Final Cut Studio/Motion folder of the Application Support directory. For example, a saved custom behavior named My Motion Path in the Favorites folder of the Library appears in the /Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Favorites folder.

![My Motion Path](image)

Items that are saved to the Library appear in the Finder with a .molo extension ("Motion Library object"). These items cannot be opened from the Finder.

If you’ve created one or more custom behaviors that you rely upon, you may want to move them to other computers that have Motion installed.

To copy a custom behavior to another computer:

1. Quit Motion.
2. Copy one or more Motion custom preset files to that computer’s /Users/username/Library/Application Support/Final Cut Studio/Motion/Library folder.
3. Restart Motion.

Behavior Descriptions

This section explains the parameters that are available for each behavior in Motion, presented by category.

**Note:** Audio, Motion Tracking, Shape, Particles, Replicator, and Camera behaviors are discussed in their respective chapters.

Basic Motion Behaviors

Basic Motion behaviors animate specific parameters of the object to which they are applied. Some affect position, while others affect scale, rotation, or opacity.

Examples of Using Basic Motion Behaviors

To view examples of working with some of the different Basic Motion behaviors, see “Behavior Examples” on page 483.
**Fade In/Fade Out**

Lets you dissolve into and out of any object. The Fade In/Fade Out behavior affects the opacity of the object to which it is applied, fading from 0 percent opacity to 100 percent opacity at the beginning of the object, and then back to 0 percent opacity at the end. You can eliminate the fade-in or fade-out by setting the duration of either to 0 frames.

*Note:* This behavior is multiplicative. This means that the Fade In and Fade Out parameters are multiplied by the object’s current opacity to produce the resulting level of transparency.

The Fade In/Fade Out behavior is useful for introducing and removing elements you’re animating in a project. For example, you could apply the Fade In/Fade Out behavior to text that moves across the screen to make it fade into existence, and then fade away at the end of its duration.

*Note:* Fade In/Fade Out behavior cannot be applied to a camera or light.

**HUD Control**

The HUD lets you control the Fade In and Fade Out durations, equivalent to the Fade In Time and Fade Out Time parameters in the Behaviors tab of the Inspector. Drag anywhere within the shaded area of the Fade In or the Fade Out ramp to adjust their durations.

*Note:* Continue dragging beyond the limits of the graphical HUD control to extend the durations of the Fade In or Fade Out.

**Parameters in the Inspector**

**Fade In Time:** A slider defining the duration, in frames, over which the object fades in from 0 to 100 percent opacity from the first frame of the object. A duration of 0 frames results in a straight cut into the object, making it appear instantly.

**Fade Out Time:** A slider defining the duration, in frames, over which the object fades out from 100 to 0 percent opacity from the last frame of the object. A duration of 0 frames results in a straight cutaway from the object, making it disappear instantly.

**Start Offset:** A slider that lets you delay the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter value is measured in frames.
End Offset: A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Use this slider to offset the end of the Fade Out effect from the end of the object.

Grow/Shrink
Use the Grow/Shrink behavior to animate the scale of an object, enlarging or reducing its size over time at a speed defined by either the Scale Rate or Scale To parameter. The Grow/Shrink effect always begins at the object’s original size at the first frame of the behavior.

Note: The Grow Shrink behavior cannot be applied to cameras or lights.

Tip: To scale particles over their lifetime, use the Scale Over Life particle behavior. For more information, see “Using Particles Behaviors” on page 738.

Note: The vertical and horizontal growth rates can be set to independent values, for asymmetrical effects.

The Grow/Shrink behavior is a good one to use with high-resolution graphics to zoom into an image, such as a map or photograph. You can also combine this behavior with the Throw or Wind behavior to pan across the image while zooming into it.

The Grow/Shrink behavior can also be used to emphasize or de-emphasize images in your project. You can enlarge objects to make them the center of attention, or shrink an object while introducing another to move the viewer’s eye to the new element.

HUD Control
The Grow/Shrink HUD consists of two rectangular regions. The first, a rectangle with a dotted line, represents the original size of the object. The second is a solid rectangle that represents the relative growth rate, and can be resized by dragging any of the borders. Enlarge the box to grow the target object, or reduce the box to shrink it. A slider to the right lets you adjust the scale of the HUD controls, increasing or decreasing the effect the controls have over the object.
Parameters in the Inspector

**Increment:** This pop-up menu lets you choose how the behavior’s effect progresses over its duration in the Timeline. There are three options:

- **Continuous Rate:** This option uses the Scale Rate parameter to grow or shrink the object by a steady number of pixels per second.
- **Ramp to Final Value:** This option grows or shrinks the object from its original size to the specified percentage plus the original scale in the Scale To parameter. If the behavior is shortened in the Timeline, the Grow/Shrink effect goes faster.
- **Natural Scale:** Enabled by default, this option uses an exponential curve to allow the animation to progress slowly when the scale values are small and speed up when the values are large. This creates the illusion that the scaling is occurring at a constant speed.

**Scale Rate/Scale To:** Depending on the command chosen in the Increment pop-up menu, the Scale Rate or Scale To parameter defines the speed and magnitude of the effect. This parameter can be opened into X and Y subparameters by clicking the disclosure triangle to the left. This lets you adjust the horizontal or vertical scale independently.

**Curvature:** This parameter lets you adjust the acceleration with which this behavior transitions from the original to the final size. Higher Curvature values result in an easing into and out of the effect, where the object slowly starts to change size, and this change gradually speeds up as the behavior continues. Curvature does not affect the overall duration of the effect since that is defined by the length of the behavior in the Timeline, minus the End Offset.

**Note:** The Curvature parameter is not available when the Increment parameter is set to Natural Scale.

**End Offset:** A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Use this slider to offset the end of the Grow/Shrink effect from the end of the object.

**Motion Path**
The Motion Path behavior lets you create a 2D or 3D motion path for an object to follow. When you first apply the Motion Path behavior, it defaults to an open spline—a straight line defined by two points at the beginning and end of the motion path. You can also choose from preset path shapes, such as a closed spline, loop, rectangle, or wave, or use a shape to define a path. A shape used as the source for a motion path can be animated.
You can modify the motion path in 3D space so that an object travels on the path along the path's X, Y, and Z axes. For more information, see “Adjusting a Motion Path in 3D Space” on page 420.

The first point on the path is the position of the object in the Canvas at the first frame of the behavior. Option-click anywhere on the path to add Bezier points, which allow you to reshape the motion path by creating curves.

**Note:** To toggle the display of the motion path, choose Show Overlays from the View pop-up menu in the Status Bar. (The Animation Path option is for the preview motion path of other behaviors.)

When you play the project, the object moves along the assigned path. The speed at which the target object travels is defined by the duration of the behavior. Speed is also affected by the Speed parameter, which lets you modify the object’s velocity—adding acceleration and deceleration at the beginning and end of the behavior, for example. You can also create a custom preset defining how the object travels along the path.

**Note:** When you switch between the different Path Shape options, the Inspector and the HUD display parameters specific to the selected option. For information about shape-specific parameters, see “Parameters in the Inspector” on page 413. For information about all other parameters, see “Persistent Parameters in the Inspector” on page 418.

The Motion Path behavior is an easy way to create predictable motion without having to use the Keyframe Editor. It’s also a great way to create reusable motion paths that you can save in the Library for future use.

**HUD Control**

In the HUD, the following controls are always available: Path Shape, Shape Type, Direction, Speed, Apply Speed (sets the number of times the object travels the path over the object’s duration), and End Condition. Other parameters become available depending on what is selected from the Path Shape parameter.
Additional Onscreen Controls
When the Motion Path behavior is added to an object, the Adjust Item tool is automatically selected, allowing you to modify the default path in the Canvas by adding points and using the Bezier (or B-Spline) controls attached to each point to adjust each curve. You can also move and resize preset motion path shapes, such as a rectangle or wave, in the Canvas.

Distancing the Object from the Motion Path
By default, the object is locked to the motion path by its anchor point.

To distance the object from the path, select the Anchor Point tool from the Toolbar and move the anchor point in the Canvas. For more information on using the Anchor Point tool, see “Changing an Object’s Anchor Point” on page 273.

Note: A separate Offset parameter allows you to offset the starting location of the object on the motion path (it does not offset the object from the path itself). For more information on the Offset parameter, see “Parameters in the Inspector,” below.

Moving the Object and its Motion Path
To move the object and its motion path, select the object (not the Motion Path behavior), and move the object in the Canvas.

Parameters in the Inspector
This section discusses the Motion Path behavior controls that are available based on what is selected from the Path Shape pop-up menu. The section immediately following, “Persistent Parameters in the Inspector” on page 418, discusses the controls that are always available (regardless of what is selected from the Path Shape pop-up menu).

Path Shape: A pop-up menu that lets you define the shape of the path on which the object travels.

Note: The Path Shape parameters work similarly to text on a path. For more information about working with text on a path, see “Working with Text on a Path” on page 634.
Open Spline: The default shape, a straight path defined by two points at the beginning and end of the path. You can choose to work with Bezier or B-Spline control points. Option-click (or double-click) anywhere on the path to add points.

Closed Spline: A closed path in which the last point is in the same location as the first point. You can choose to work with Bezier or B-Spline control points. Option-click (or double-click) anywhere on the path to add points.

Shape Type: When Path Shape is set to Open Spline or Closed Spline, this pop-up menu allows you to choose one of two ways to manipulate the shape of the path: Bezier or B-Spline.

- Bezier: Lets you manipulate the keyframe curve manually by dragging the handles.

  Note: For more information about creating and adjusting Bezier curves, see “Editing Bezier Control Points” on page 1023.

- B-Spline: B-Splines are manipulated using only points—there are no tangent handles. The points themselves do not lie on the surface of the shape. Instead, each B-Spline control point is offset from the shape's surface, pulling that section of the shape towards itself as if it was a magnet, in order to create a curve. B-Splines are extremely smooth—by default, there are no sharp angles in B-Spline shapes, although you can create sharper curves, if necessary.

  Note: For more information about working with B-Spline curves, see “Editing B-Spline Control Points” on page 1025.

Circle: A simplified version of Closed Spline, in which the X radius or Y radius can be adjusted to create a circle or an ellipse.

- Radius: When Circle is the defined path shape, this slider allows you to change the size of the circular path. Click the disclosure triangle to individually adjust the X radius and Y radius.

  Note: When the Motion Path behavior is selected, you can also use the onscreen control points to resize the circle. Press Shift to resize the X and Y radii uniformly.

Rectangle: A closed path in which the width and the height can be adjusted to create a square or a rectangle.

Use the outer control points to resize the circle or rectangle motion path shape.
• **Size:** When Rectangle is the defined path shape, this slider allows you to change the size of the rectangular path. Click the disclosure triangle to individually adjust the X scale and Y scale.

  **Note:** When the Motion Path behavior is selected, you can also use the onscreen control points to resize the rectangle. Press Shift to resize the X and Y scales uniformly.

• **Offset:** When Circle, Rectangle, or Geometry is the defined path shape, this slider lets you specify where the object starts moving on the path.

• **Wave:** A wavy path (a sine wave) defined by two points at the beginning and end of the path, and controlled by the End Point, Amplitude, Frequency, Phase, and Damping parameters.

  • **End Points:** Sets the location of two default points on the wave’s path. The end points can also be adjusted using the wave’s onscreen controls (active by default when the Motion Path behavior is selected). Moving the left end point moves the entire path; moving the right end point lengthens, shortens, or angles the path.

  • **Amplitude:** Defines half the distance from the highest point to the lowest point in the wave. Higher values result in more extreme waves.

  • **Frequency:** The number of waves. Higher values result in more waves.

  • **Phase:** A dial that defines the degrees of the offset of the waves from the start and end points of the path. When set to 0 degrees (default), the wave begins and ends at half the distance from the highest point to the lowest point in the wave. When set to 90 degrees, the wave begins and ends at the highest point in the wave. When set to –90 degrees, the wave begins at the lowest point in the wave. When set to 180 degrees, the waves are the same as 0 degrees, but inverted.
- **Damping**: A slider that progressively diminishes the oscillation of the wave. Positive damping values diminish the wave forward (from left to right); negative values diminish the wave backward (from right to left).

  ![Damping value set to 0](image1)
  ![Damping value set to 3](image2)
  ![Damping value set to -3](image3)

- **Geometry**: The object travels along the edge of a shape or mask that is used as the source for the path.

  ![The motion path defined in the Shape Source image well](image4)
  ![Shape layer used as the Shape Source](image5)
- **Attach to Shape**: When enabled, the motion path follows the source shape at its original location. When disabled, the motion path can exist in a location other than its source shape.

*Note*: When Attach to Shape is enabled, you cannot move the object to another location.

To align the rotation of an object to match all changes made to its position along an animation path, apply the Snap Alignment to Motion behavior. For more information, see “Snap Alignment to Motion” on page 425.

- **Shape Source**: An image well that defines the object (shape or mask) to use as the motion path source.

- **To**: This pop-up menu displays a list of all objects in the current project that can be used as a shape source for the motion path.

**Using Geometry for a Motion Path Shape**

The following section describes how to use geometry as the source for a motion path shape. You can use a shape that is animated with behaviors or keyframes as the source for a motion path. This includes animated transforms (a shape changing its location in the Canvas) and animated control points (a shape changing its shape due to keyframed control points).

**To use geometry for a motion path shape:**
1. Import (or draw) the shape you want to use as the path source.
2. Choose Geometry from the Path Shape pop-up menu.
   - The Shape Source well appears in the Inspector and HUD.
3. From the Layers tab, drag the shape to the Shape Source well.
4. When the pointer becomes a curved arrow, release the mouse button.
   - A thumbnail of the shape appears in the well and the shape is used as the source shape for the motion path.
Note: You may want to disable the source shape in the Layers tab so it is not visible in your project.

To select another geometry source for a motion path shape:

1. Choose the object you want to use as the motion path’s shape source from the To pop-up menu (located next to the Shape Source image well).

Note: To align the rotation of the object to the shape of its motion path, you can apply the Snap Alignment to Motion behavior (in the Basic Motion behaviors subcategory).

Persistent Parameters in the Inspector

The following Motion Path behavior parameters are available for all path shapes.

Direction: A pop-up menu that defines the object’s direction over the path. There are two options:

- **Forward**: The object moves in a forward direction along the path (from the start point to the end point, depending upon the Offset parameter).
- **Reverse**: The object moves in a backward direction along the path (from the end point to the start point, depending upon the Offset parameter).

Note: The Offset parameter is available when Path Shape is set to Circle or Rectangle.

Speed: A pop-up menu that defines the object’s velocity from the first to the last point in the motion path. There are eight choices:

- **Constant**: The object moves at a steady speed from the first to the last point on the motion path.
- **Ease In**: The object starts at a slow speed, then reaches and maintains a steady speed through the last point on the motion path.
- **Ease Out**: The object starts at a steady speed, then slows down as it gradually decelerates to a stop at the last point of the motion path.
- **Ease Both**: The object slowly accelerates from the first point on the motion path, and then slows down as it gradually decelerates to a stop at the last point of the motion path.
- **Accelerate**: The object moves along the path with increasing speed.
- **Decelerate**: The object moves along the path with decreasing speed.
• **Natural**: The speed in which the object moves over the path is determined by the shape of the path. For example, if the path is a U-shape curve, the object moves faster as it moves toward the low point of the U and slower as it moves up the edges.

• **Custom**: Custom allows you to define the movement of the object along its path by setting keyframes for the object's speed from 0 to 100 percent. In other words, you determine the position of the object along the path in time.

• **Custom Speed**: This parameter becomes available when Speed is set to Custom. You can modify the Custom Speed velocity curve in the Keyframe Editor. You can keyframe custom values to make an object, for example, travel forward to a specific percentage of the path, then backward, then forward, and so on before it reaches the end of the animation.

**Apply Speed**: When Loop is set to a value greater than 1, determines how the Speed parameter (velocity) is applied over the duration of the behavior.

**Note**: Loop must be set to a value greater than 1 for the Apply Speed parameter to have any effect.

• **Once Per Loop**: The velocity, as defined by the Speed parameter, is applied to each cycle. For example, if Loop is set to 3 and Speed is set to Accelerate, the object accelerates each time it travels over the path. The speed is applied to the entire duration, ignoring the Loops setting.

• **Over Entire Duration**: The velocity, as defined by the Speed parameter, is applied one time over the duration of the behavior. For example, if Loop is set to 3 and Speed is set to Accelerate, the object accelerates the first time it travels over the path, but not the second and third time.

**Loops**: Determines the number of times the object travels the motion path over the duration of the behavior. For an object to travel its path more than once, or to “ping pong,” Loops must be set to a value greater than 1.

**End Condition**: A pop-up menu that defines the behavior of the object once it reaches the end of its motion path.

• **Repeat**: The object travels the motion path the number of times defined by the Loop parameter.

• **Ping-Pong**: The object moves along the path until it reaches the last point on the path, then it moves backward to the first point on the path. The number of “ping pongs” is defined by the Loops parameter.

**Control Points**: Click the disclosure triangle to display the Position parameters for the motion path control points. The first value field is X, the second value field is Y, and the third value field is Z.

**Note**: You cannot apply Parameter behaviors to the control points.
To use the Custom Speed parameter:
1 In the Inspector or HUD, choose Custom from the Speed pop-up menu.
The Custom Speed parameter becomes available. By default, a keyframe is set at the
first and last points of the behavior to create an animation of 0 percent to 100 percent,
where at 0 the object is at the beginning of the path, and at 100 the object is at the
end of the path. This is the same velocity used with the Constant preset.
2 Enable Record (press A).

*Note:* When Record is enabled, all keyframeable parameter value fields are tinted. This
is to remind you that any value change entered in this state creates a keyframe.
3 Move the playhead to the position you want to create a keyframe, then enter a value in
the Custom Speed field.
For example, a value of 90 moves the object 90 percent of the way through the motion
path.
4 Continue moving the playhead and adding keyframes to obtain the result you want.

*Note:* If you change the Speed parameter to a preset (such as Constant) after creating a
custom speed, the custom velocity channel is ignored but remains intact.

Related Behaviors
“Gravity,” “Random Motion,” “Throw,” “Wind”

Adjusting a Motion Path in 3D Space
You can adjust a motion path in 3D space. The easiest way to modify a motion path in
3D space is to add a camera to your project and manipulate the path in a modified
camera view.

To adjust a motion path in 3D space:
1 If there is no camera in your project, add a camera by doing one of the following:
   • Click New Camera in the Toolbar.
   • Choose Object > New Camera (or press Option-Command-C).

*Note:* If none of your project groups are set to 3D, a dialog appears asking you if you
want to switch your 2D groups to 3D groups. Click Switch to 3D to allow the camera to
affect the groups.
2 Do one of the following:
   • Choose a camera view from the Camera menu in the upper-left corner of the Canvas
     (the default option is Active Camera). This example uses the Top view.
   • With the Active Camera (or other) view selected, use the Orbit tool (the center tool in
     3D View tools in the upper-right corner of the Canvas) to rotate the camera.

*Note:* If you use the 3D View tools with any camera selected, you are moving the
camera, not just changing the camera view.
Depending on the camera view, the object on the path may no longer be visible. For example, if the object has not been rotated in X or Y space and you are working in Top view, the camera is looking down perpendicularly (on the Y axis) on the object. The motion path and its points are still visible (as long as the Motion Path behavior is selected).

3 Drag a control point up or down to adjust the object in Z space.

4 To reset the camera view, do one of the following:

**Note:** The motion path onscreen controls are available for all camera views.

To enter specific values for the control point locations, click the Control Points disclosure triangle in the Motion Path behavior parameters. The first value field is X, the second value field is Y, and the third value field is Z.
• Double-click the 3D View tool that you previously adjusted. For example, if you dragged the Orbit tool to rotate the current camera, double-click the Orbit tool to reset the camera.

• If you chose (and/or modified) a default camera view (such as Top, Right, Left, and so on), choose Active Camera from the Camera menu, or choose View > 3D View > Active Camera.

• With the camera selected, click the reset button in the Properties tab of the Inspector.

**Move**

The Move behavior places a point in the Canvas that creates a specific location for an object or group to move toward or away from.

In the following illustration, the center fish image has an applied Vortex behavior, causing the outer turtle image to circle around the fish image.

In the next illustrations, the turtle image has an applied Move behavior. The Move target (null object) is positioned in the center of the fish image. While the turtle image circles about the fish image, it is also drawn to the center of the fish image.

**Tip:** The Move behavior is an ideal tool when working in 3D mode, as it allows you to simulate camera movements without using a camera. For example, when applied to a group that contains objects that are offset in Z space, you can create a dolly-like move.
HUD Control
The HUD has a slider that sets the influence amount (Strength), a Direction pop-up menu that defines whether the object moves toward the null point or away from the point, and a Speed pop-up menu that allows you to define the object’s velocity.

Parameters in the Inspector

**Position:** Value fields that allow you to define the X, Y, and Z position of the target point. The target (null object) is added to the center of the Canvas by default.

**Note:** The Move behavior and the Adjust Item tool in the Toolbar must be selected to move the target. Use the Select/Transform tool to move the object.

**Strength:** A slider defining the speed at which the object moves toward the target. With a value of 0, the object doesn’t move at all. The higher the value, the faster the object moves.

**Direction:** A pop-up menu that sets whether the object moves toward the target point or away from the point.

**Speed:** A pop-up menu that defines the object’s velocity from its position in the Canvas to the position of the target. There are six choices:

- **Constant:** The object moves at a steady speed from its position toward the target.
- **Ease In:** The object starts at a slow speed, then reaches and maintains a steady speed toward the target.
- **Ease Out:** The object starts at a steady speed, then slows down as it gradually decelerates to a stop when it reaches the target.
- **Ease Both:** The object slowly accelerates and then slows down as it gradually decelerates to a stop when it reaches the target.
- **Accelerate:** The object moves toward the target with increasing speed.
- **Decelerate:** The object moves toward the target with decreasing speed.

**Note:** To move the object more slowly toward its target, extend the duration of the Move To behavior in the Timeline or mini-Timeline. To move the object faster, shorten the duration of the behavior.

Point At
When the Point At behavior is applied to an object or group, you can specify a target point for the affected object to turn toward.

**Tip:** Use the Point To behavior with the Move To behavior to created animated objects that not only move toward a point (or each other), but that turn in the direction of the target.
**HUD Control**

The HUD has an object well, a Transition slider, a Speed pop-up menu that allows you to define the object's velocity, an Axis pop-up menu to choose which axis should point at the target once the movement is complete, and an Invert Axis checkbox.

**Parameters in the Inspector**

**Object:** A well that defines the target object. To set the target object, drag the object from the Layers tab to the Object well in the Point At HUD or Inspector. You can also drag the target object from the Layers tab onto the Point At behavior.

**Transition:** This slider determines how long it takes for the object to go from its starting orientation to pointing at the center of the target object. This parameter is useful when the object is pointing at a moving target object.

If Transition is set to 50% in a 300-frame project, and the target object is not moving, the point-at object takes 150 frames to point at (or orient to) the center of the target object and then stops moving for the duration of the behavior. If Transition is set to 100%, the point-at object takes the full 300 frames to point at the target object. If the Point At behavior's duration is 100 frames, and Transition is set to 50%, the point-at object takes 50 frames to orient to the target object.

If Transition is set to 50% in a 300-frame project, and the target object is animated, the point-at object takes 150 frames to point at (or orient to) the center of the target object and then continues following the animated target object for the duration of the behavior. If Transition is set to 100%, the point-at object takes the full 300 frames to point at the target object.

**Speed:** A pop-up menu that defines the object’s velocity from its position in the Canvas to the position of the target. There are six choices:

- **Constant:** The object moves at a steady speed from its position toward the target.
- **Ease In:** The object starts at a slow speed, then reaches and maintains a steady speed toward the target.
- **Ease Out:** The object starts at a steady speed, then slows down as it gradually decelerates to a stop when it reaches the target.
- **Ease Both:** The object slowly accelerates and then slows down as it gradually decelerates to a stop when it reaches the target.
- **Accelerate:** The object moves toward the target with increasing speed.
- **Decelerate:** The object moves toward the target with decreasing speed.

**Axis:** A pop-up menu that lets you align the rotation of the object to the X, Y, or Z axis. The default axis is Z. This parameter specifies which axis points at the target once the movement is complete.
Invert Axis: If the object is aligning on the correct axis, but appears backwards, this checkbox flips the object so that it faces the proper direction.

**Snap Alignment to Motion**
This behavior aligns the rotation of an object to match all changes made to its position along an animation path. This behavior is meant to be combined with behaviors that animate the position of an object, or with a keyframed animation path you create yourself.

For example, if you have a graphic of a fish to which you’ve applied the Motion Path behavior, you can add the Snap Alignment to Motion behavior to make the fish point in the direction it is moving.

**HUD Control**
The HUD has a pop-up menu to control the axis around which the object is rotated, a pop-up menu to control the axis used to adjust the object’s alignment, and a checkbox to let you invert the axis.

**Parameters in the Inspector**

**Rotation Axis:** A pop-up menu that lets you rotate the object around the X, Y, or Z axis. You can also choose All to rotate the object around all three axes. The default rotation axis is Z. All uses the acceleration direction as “up,” like a roller coaster.

**Axis:** A pop-up menu that lets you specify whether the object aligns itself on its horizontal or vertical axis.

**Invert Axis:** If the object is aligning on the correct axis, but appears backwards, this checkbox flips the object so that it faces the proper direction.
End Offset: A slider that allows you to offset the end of the behavior's effect relative to the last frame of its position in the Timeline, in frames. For example, if End Offset is set to 60, the object actively snaps to the direction of the path until 60 frames before the end of behavior in the Timeline.

Related Behaviors
“Align To Motion”

Spin
Apply the Spin behavior to animate the rotation of an object, spinning it around a single axis. Using the Custom axis controls, the rotation does not have to occur on a principle axis (X, Y, or Z). If you trim the end of the Spin behavior to be shorter than the duration of the object to which it’s applied, it remains at the angle of the last frame of the behavior, as long as there are no other behaviors or keyframes affecting that object’s Rotation parameter.

Uses for Spin are fairly obvious, but another way to use the Spin behavior is with objects that have an off-center anchor point. Because objects rotate around the anchor point, if you change an object’s anchor point before you apply a Spin behavior to it, you can quickly change the look of the motion you create. For more information on changing an object’s anchor point, see “Changing an Object’s Anchor Point” on page 273.

HUD Control
The Spin behavior’s HUD controls include an outer ring and an inner control. Drag along the edge of the outer ring to manipulate an arrow that indicates the direction and speed the object spins. Adjust the length of the arrow to change the speed at which the spinning occurs—drag around multiple times to increase the rate of the spin.

The inner arrow controls the axis about which the object or group spins. When you drag the inner controls, a globe control becomes available that allows you to adjust the object’s spin in degrees longitude and latitude.

Note: You can spin the arrow around the ring multiple times to rotate the object more quickly.
Parameters in the Inspector

**Affect Subobjects:** This parameter appears when Spin is applied to an object that contains multiple objects, such as a group, particle emitter, or text. When this checkbox is turned on, each object within the layer or group rotates as an individual object. When this checkbox is turned off, the entire layer or group spins.

**Increment:** This pop-up menu lets you choose how the behavior’s effect progresses over its duration in the Timeline. There are two choices:

- **Continuous Rate:** This command uses the Spin Rate parameter to spin the object by a steady number of degrees per second.
- **Ramp to Final Value:** This command spins the object for the number of degrees specified in the Spin To parameter over the behavior’s duration in the Timeline.

**Spin Rate/Spin To:** A dial controlling the speed at which the object spins. When Increment is set to Continuous Rate, the Spin Rate defines a continuous rate of spin in degrees per second. When Increment is set to Ramp to Final Value, Spin To defines a number of degrees to spin over that object’s duration. Negative values result in clockwise motion, while positive values result in counterclockwise motion.

**Axis:** A pop-up menu that allows you to choose whether the object spins about the X, Y, or Z axis. You can also choose Custom, which yields additional Longitude and Latitude parameters.
When Axis is set to Custom, additional Longitude and Latitude parameters become available. These parameters allow the object to spin at an angle (not locked to the X, Y, or Z axes).

The following image illustrates longitude and latitude.

**Latitude/Longitude:** Available when Axis is set to Custom (or by dragging the center control of the Spin HUD), these parameters allow you to specify the axis of rotation.

**Throw**
The Throw behavior is the simplest way of setting an object in motion. Controls let you adjust the speed and direction of a single force that’s exerted on the object at the first frame of the behavior. After this initial force is applied, the object continues drifting in a straight line at the same speed, for the duration of the Throw behavior.

A simple example of using the Throw behavior is to send a series of offscreen objects moving across the screen. When used in conjunction with other behaviors such as Grow/Shrink and Fade In/Fade Out, you can create sophisticated moving elements without keyframing a single parameter.
The Throw behavior is also useful when you’re moving an object through a simulation. For example, you might move the object past other objects that have Attractor or Repel behaviors applied to them. Because the Throw behavior only applies a single force to move the target object at the initial frame of the behavior, any other behaviors that interact with the target object have potentially greater influence over its motion.

**Important:** The Throw behavior does not apply a continuous force, nor can you create changes in direction or speed, since this behavior cannot be keyframed. If you need to create keyframed changes in direction or speed, use the Wind behavior. If you need to create a more complex animation path, use the Motion Path behavior.

**HUD Control**
The 2D HUD lets you specify the direction and speed of the Throw behavior by dragging an arrow within a circular region. The direction of the arrow defines the direction of movement in X and Y space, and the length of the arrow defines speed (velocity). A slider to the right lets you adjust the scale of the HUD control, increasing or decreasing the effect the direction/speed control has over the object.

When you click the 3D button, additional 3D controls become available. The center arrow now defines the direction the object is thrown in 3D space (X, Y, and Z axes). The Speed slider (on the left side of the HUD) lets you increase or decrease the velocity of the thrown object.
In the 2D and 3D Throw HUDs, press the Shift key while dragging the arrow to constrain it to 45 degree angles. In the 2D HUD, press the Command key to change the arrow’s direction without affecting its length.

**Note:** The maximum speed you can define with the HUD is not the maximum possible speed. Higher values can be entered into the Increment parameter in the Behaviors tab of the Inspector.

**Parameters in the Inspector**

**Affect Subobjects:** This parameter appears when Throw is applied to an object that contains multiple objects, such as a group, particle emitter, or text. When this checkbox is turned on, each object within the parent object moves as an individual object. When this checkbox is turned off, the entire layer or group moves as a whole.

**Increment:** This pop-up menu lets you choose how the behavior’s effect progresses over its duration in the Timeline. There are two choices:

- **Continuous Rate:** This command sets the speed of the object at a steady number of pixels per second, specified in the Throw Velocity parameter.
  
  **Note:** If the Canvas is displaying a nonsquare pixel image, the vertical rate is in pixels per second, and the horizontal rate is the perceptual equivalent.

- **Ramp to Final Value:** This command moves the object from its original position to the specified distance (in pixels) in the Throw Distance parameter.

**Throw Velocity/Throw Distance:** When the Increment pop-up menu is set to Continuous Rate, the Throw Velocity parameter appears, which lets you set a continuous speed for the object to move in X, Y, or Z space. When the Increment pop-up menu is set to Ramp to Final Value, the Throw Distance parameter appears, which sets a total distance (in pixels) for the object to travel in X, Y, and Z space over its duration. The slider is limited to 100 pixels. Use the value field to enter values greater than 100.

**Related Behaviors**

“Motion Path,” “Gravity,” “Random Motion,” “Wind”

**Parameter Behaviors**

These behaviors can be applied to any object parameter that can be animated, and their effects are limited to just that parameter. The same parameter behavior can be added to different parameters, resulting in completely different effects. For example, you can apply the Oscillate behavior to the opacity of an object to make it fade in and out, or you can apply it to the rotation of an object to make it rock back and forth. You can also apply parameter behaviors to filter parameters, generator parameters, the parameters of particle systems, or even the parameters of other behaviors. Examples include Oscillate, Randomize, and Reverse.
For more information on applying Parameter behaviors, see “Applying Parameter Behaviors” on page 380.

Examples of Using Parameter Behaviors
To view examples of working with some of the different Parameter behaviors, see “Behavior Examples” on page 483.

Audio
This behavior allows you to animate nearly any parameter based on properties of an audio file, such as bass frequency. For example, the Audio parameter behavior can be applied to the Scale parameter of an object so that it scales up and down based on the amplitude of the bass, or to the Opacity parameter so that it fades in and out to the beat. For more information on using the Audio parameter behavior, see “Audio Parameter Behavior” on page 1141.

Average
This behavior smooths the transition from one value to another caused by keyframes and behaviors that are applied to a parameter. Use the Average behavior to smooth out animated effects. Averaged motion moves more fluidly, while averaged changes to parameters such as Opacity and to filter parameters appear to happen more gradually. Use the Window Size parameter to adjust the amount by which to smooth the affected parameter.

Tip: The Average behavior can be used to smooth out the sequence of values generated by a Randomize behavior.

HUD Control
The HUD lets you adjust the Window Size parameter and change the parameter assignment.

Parameters in the Inspector

Window Size: A slider lets you adjust the amount of smoothing to apply to the affected parameter by specifying the number of adjacent frames to average together. Higher values apply more smoothing by averaging a wider range of values, resulting in more fluid animation. Lower values average a narrower range of values and apply less smoothing with values that are closer to the original.

Apply To: The Apply To (“Go”) pop-up menu shows the parameter being affected and can be used to reassign the behavior to another parameter.

Related Behaviors
“Negate,” “Reverse”
**Clamp**
This behavior allows you to define a minimum and maximum value for an animated parameter. In the following illustration, the center image has an applied Vortex behavior. The outer images circle around the center image, as indicated by the red animation path.

![Clamp Behavior](image)

The red lines indicate the animation paths of the outer image.

In the next illustration, a Clamp behavior is applied to the X Position parameter of the upper image. The Max value is set to 230 and the Min value is set to 0.

![Clamp Behavior](image)

The animation path of the upper image shows that the image travels 230 pixels to the right but does not move left past the 0 point. This creates a half-circle animation.

Notice that the circle motion path is essentially cut in half. If a negative value is entered in the Min value field, the image moves past the 0 point.

**HUD Control**
The HUD lets you set the clamp to Min, Max, or Min and Max values, and also to change the parameter assignment.
Parameters in the Inspector

**Clamp At:** A pop-up menu in which you choose the option to clamp parameter values at only the minimum, only the maximum, or both the minimum and maximum.

**Min:** A value slider that lets you define the minimum amount of change for an animated parameter.

**Max:** A value slider that lets you define the maximum amount of change for an animated parameter.

The value is represented as a percentage, in pixels, or in degrees, depending on the parameter assignment. For example, if Clamp is applied to the Rotation parameter, the Min and Max values are degrees. If Clamp is applied to the X Position parameter, the values are in pixels.

**Apply To:** The Apply To (“Go”) pop-up menu shows the parameter being affected and can be used to reassign the behavior to another parameter.

Related Behaviors

“Quantize”

**Custom**

The Custom behavior allows you to make your own behaviors by creating a set of parameters, then keyframing them to create the type of animation you want to apply to an object. By saving custom behaviors you create in the Library, you can create your own collection of behaviors to suit your needs.

Prior to creating a Custom behavior, you must first add the Custom behavior to an object in the Canvas. The Custom behavior is added to an object like all other non-Parameter behaviors in Motion.

**Note:** Although the Custom behavior is a Parameter behavior, it does not appear in the list when you Control-click a parameter.

To add a Custom behavior to an object, do one of the following:

- Select the object to which you want to add a Custom behavior, click the Add Behavior icon in the Toolbar, then choose Parameter > Custom from the pop-up menu.

- In the Library, select the Behaviors category, select the Parameter subcategory, then drag the Custom icon to the object in the Canvas, Layers tab, or Timeline.

The Custom behavior is applied to the object. The behavior has no effect until you add a parameter to the behavior.
To add a parameter you want to animate in a Custom behavior:

- Choose a parameter you want to add to the Custom parameter list from the Add Parameter pop-up menu. This menu contains every animateable parameter.

The parameter appears in the Behaviors tab below the Custom behavior.

Once you’ve added all the parameters you want to animate in your Custom behavior, you can keyframe them in the Keyframe Editor to create whatever animated effect you require. For more information on keyframing parameters to create animation, see “Animating Behaviors” on page 514.

To remove a parameter from the Custom parameter list:

- Choose the parameter you want to remove from the Remove Parameter list.

That parameter no longer appears in the Custom parameter list. Any keyframes that were applied to that parameter are deleted.

Once you have animated all the parameters you added, you can save the Custom behavior into the Library for future use. For more information about saving Custom behaviors to the Library, see “Saving and Sharing Custom Behaviors” on page 405.
When you apply a Custom behavior that you've saved in the Library to an object in a project, its keyframed animation is scaled to the duration of the object to which it is applied. This means that no matter how long the original Custom behavior was, you can apply it to any object, and the animated effect speeds up or slows down to accommodate the new object's duration.

**HUD Control**
There are no HUD controls for this behavior.

**Parameters in the Inspector**
Unlike other behaviors, the Custom behavior doesn’t start out with any parameters in the Behaviors tab. Instead, a pair of pop-up menus allows you to add and remove any parameters you want to use.

![Custom behavior parameters](image)

**Add Parameter:** The Add Parameter pop-up menu allows you to add parameters that you want to keyframe to create custom animation. Choose a parameter from this menu to add it to the Custom parameter list for keyframing.

**Remove Parameter:** The Remove Parameter pop-up menu lists all the parameters you've added to the current Custom behavior. Choose a parameter from this menu to remove it from the Custom parameter list, along with any keyframes that are applied to that parameter.

**Exponential**
The Exponential parameter behavior creates more natural animations when scaling objects, especially when using high values. For example, when an object scales from very small to very large, the animation appears to slow down as the object reaches its upper scale values. The Exponential parameter behavior works like the Ramp behavior, but applies a mathematical function to create an exponential curve (rather than linear) between the two values. This allows the animation to progress slowly when the scale values are small and speed up when the scale values are large.

**Tip:** When applied to parameters other than Scale, the Exponential parameter behavior creates more organic animations than other interpolation modes.

You can also change the interpolation modes of keyframes to Exponential. For more information, see “Modifying Curves” on page 545

**HUD Control**
The HUD lets you set the start and end values and change the parameter assignment.
Parameters in the Inspector

**Start Value:** The value that’s added to the parameter at the first frame of the Exponential behavior.

**End Value:** The value the Exponential behavior reaches at the last frame of the behavior. Over the life of the behavior, the parameter the Exponential behavior is applied to makes a transition from the Start Value to the End Value plus the original value.

**Start Offset:** A slider that lets you delay the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is in frames.

**End Offset:** A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the behavior resets the object to its original parameter.

**Apply To:** The Apply To (“Go”) pop-up menu shows the parameter being affected and can be used to reassign the behavior to another parameter.

**Related Behaviors**

“Logarithmic,” “Ramp”

**Logarithmic**

The Logarithmic parameter behavior is the inverse of the Exponential behavior. Like the Exponential behavior, it creates more natural animations when scaling objects, especially when using high values. The Logarithmic parameter behavior applies a mathematical function to create a logarithmic curve (rather than linear) between the two values—the effect ramps up quickly, and then the effect slows down. This allows the animation to progress slowly when the scale values are small and speed up when the scale values are large.

The Logarithmic behavior can be applied to parameters that have been animated with behaviors or keyframes; however, it does not affect the parameter unless the Start Values or End Values are nonzero.

**Tip:** When applied to parameters other than Scale, the Logarithmic parameter behavior creates more organic animations than other interpolation modes.

**Note:** You can also change the interpolation modes of keyframes to Logarithmic. For more information, see “Modifying Curves” on page 545.
HUD Control
The HUD lets you set the start and end values and change the parameter assignment.

Parameters in the Inspector

Start Value: The value that’s added to the parameter at the first frame of the Logarithmic behavior.

End Value: The value the Logarithmic behavior reaches at the last frame of the behavior. Over the life of the behavior, the parameter the Logarithmic behavior is applied to makes a transition from the Start Value to the End Value plus the original value.

Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is in frames.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the behavior resets the object to its original parameter.

Apply To: The Apply To (“Go”) pop-up menu shows the parameter being affected and can be used to reassign the behavior to another parameter.

Related Behaviors
“Exponential,” “Ramp”

MIDI
The MIDI behavior allows you to edit and animate object parameters using standard MIDI devices, such as a synthesizer. For the true motion graphics mixmaster.

HUD control
The HUD controls allow you to adjust the Control Type, ID, Value, and Scale parameters, as well as change the parameter assignment.

Parameters in the Inspector

Control Type: Specifies the mode of the MIDI controller. The three available control types are:

• Note: This mode is displayed when the control is a keyboard key on the MIDI device.
• Controller: This mode is displayed when the control is a knob, dial, key, slider, or foot pedal on the MIDI device.
• **Learning:** This mode is used to “teach” Motion which control (such as a knob, dial, or key) you want to use on the MIDI device to manipulate the parameter to which the MIDI behavior is applied. When in Learning mode, the first knob, dial, or key that you adjust on the MIDI device is set as the control.

  **Note:** When the MIDI behavior is first applied, Learning is the default control type.

**ID:** Displays the identification number of the MIDI control (such as a knob, dial, or key) that you are manipulating.

**Value:** When you are manipulating the control, displays the standard MIDI value between 0 and 1.

**Scale:** Increasing the Scale value multiplies the Value parameter in the MIDI behavior. This means that when Scale is increased, the MIDI control has a larger range of value and a greater effect on the parameter it’s controlling. For example, when you are using a knob to adjust an object’s rotation, the default rotation value range (when Scale is set to 1) for a full turn of the knob may only be 30 percent. When the Scale value is increased to 13, the rotation value of a full turn of the knob is increased to 370 degrees.

**Apply To:** The Apply To (“Go”) pop-up menu (parameter assignment control) shows the parameter being affected and can be used to reassign the behavior to another parameter.

The MIDI behavior is applied in the same way as all other Parameter behaviors. In the following examples, the MIDI parameter behavior is used to adjust an object’s opacity and rotation.

**Note:** This behavior can only be used if you have a MIDI device correctly connected to your computer.

**To use the MIDI parameter behavior to adjust an object’s opacity:**

1. Select an object, then select the Opacity parameter in the Properties tab of the Inspector.
2. Control-click the parameter, then choose MIDI from the shortcut menu.

The MIDI parameters are displayed in the Behaviors tab. By default, Control Type is set to Learning.
Like all other Parameter behaviors, the Apply To field displays the parameter to which the behavior is applied.

3 On your MIDI device, tweak the control (such as the knob, dial, or key) that you want to use as the controller for the Opacity parameter.

**Note:** When in Learning mode, the first control adjusted on the MIDI device is set as the control. To reset the selected controller, choose Learning from the Control Type pop-up menu, and adjust another control on the MIDI device.

The identification number of the MIDI control is displayed in the ID field. The value range of the control is 0 to 127, the default MIDI control value.

Because an object’s opacity can only fall between 0 (completely transparent) to 100 (completely opaque), the default MIDI values are sufficient to adjust the parameter.

**To use the MIDI parameter behavior to adjust an object’s rotation:**

1 Select an object, then select the Rotation parameter in the Properties tab of the Inspector.

2 Control-click the parameter, then choose MIDI from the shortcut menu.

3 On your MIDI device, tweak the control (knob, dial, key, and so on) that you want to use as the controller for the Rotation parameter.

As mentioned above, the default Value range is 0 to 1. Because the Rotation value of an object can be much larger, you can use the Scale parameter to multiply the Value range.

4 To give the control more sensitivity, increase the Scale value.

**Negate**

Inverts the value of each keyframe and behavior effect in the parameter to which it’s applied by multiplying the parameter by –1. The Negate behavior basically flips each parameter value to its opposite. Animation paths are flipped, rotation is reversed, and any effect’s parameter is changed to its opposite.
For example, applying the Negate behavior to the Position parameter of an object with an animation path applied results in the animation path moving to the opposite quadrant of the Canvas.

*Note:* If you want to reverse the motion taking place on an animation path, rather than flipping the shape of the animation path itself, use the Reverse parameter behavior.

**HUD Control**
The HUD control allows you to change the parameter assignment.

**Parameters in the Inspector**
- **Apply To:** The Apply To (“Go”) pop-up menu shows the parameter being affected and can be used to reassign the behavior to another parameter.

**Related Behaviors**
- “Average,” “Reverse”

**Oscillate**
The Oscillate behavior animates a parameter by cycling it between two different values. You can customize how wide apart the high and low values are as well as the number of oscillations per minute. The Oscillate behavior can create all kinds of cyclical effects. For example, if you apply the Oscillate behavior to the rotation property of an object, it will begin to rock back and forth. This happens because the rotation property cycles back and forth between the original rotation value plus and minus the Amplitude value that’s set in the Oscillate behavior.

Applying the Oscillate behavior to the X value of the Scale parameter instead causes the width of the object to cycle, and it repeatedly stretches and compresses for the duration of the behavior.

The Oscillate behavior is additive, meaning that the value generated by this behavior is added to the original value of the parameter to which it’s applied.
HUD control
The HUD lets you adjust the Phase, Amplitude, Speed, and Half Range parameters as well as change the parameter assignment of the Oscillate behavior.

Parameters in the Inspector

Wave Shape: A pop-up menu that lets you choose the shape of the oscillation's wave. The choices are Sine (default), Square, Sawtooth, and Triangle.

- **Sine**: The default wave shape, the sine wave creates a smooth animation between values. For example, if Oscillate is applied to an object’s Opacity parameter, and the Wave Shape is set to Sine, the object gracefully fades in and out.

- **Square**: The square wave creates abrupt changes in values. For example, when Oscillate is applied to an object’s Opacity parameter, and the Wave Shape is set to Square, the object flashes on and off (like turning a light switch on and off).
• **Sawtooth**: The Sawtooth wave ramps upward over time and then drops sharply. For example, when Oscillate is applied to an object’s Opacity parameter, and the Wave Shape is set to Sawtooth, the object fades in slowly and fades out abruptly (like using a light dimmer to fade up a light, and then flicking the power switch off).

• **Triangle**: Similar to the sine wave, a triangle wave creates a smooth animation between values but with sharper changes at the transitions. For example, when Oscillate is applied to an object’s Opacity parameter, and the Wave Shape is set to Triangle, the object fades in and out more acutely than the sine wave.

**Phase**: A slider that lets you adjust the point of the specified oscillation the behavior starts at. This parameter allows you to put multiple objects with identical Oscillate behaviors out of phase with one another so that they don’t all look the same.

**Amplitude**: A slider that lets you adjust the maximum values that the parameter oscillates between. The parameter swings between the amplitude value and the negative of the amplitude value. Higher values result in more extreme swings from the beginning to the ending of each oscillation.

**Speed**: A slider that lets you adjust the speed at which the oscillation occurs, in oscillations per minute. Higher values result in faster oscillations.
**Half Range:** When this checkbox is turned on, the sine (or other wave shape) wave is essentially cut in half and does not cross over the value of 0. For example, when Amplitude is set to 100, the parameter oscillates between 100 and –100. When Half Range is turned on, however, the parameter oscillates between 100 and 0. When Amplitude is set to –100, the parameter oscillates between –100 and 0.

*Tip:* When you are oscillating position parameters, set Wave Shape to Sine and enable Half Range to create a bouncing effect.

**Start Offset:** A slider that lets you delay the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is in frames.

**End Offset:** A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the behavior resets the object to its original parameters.

**Apply To:** The Apply To (“Go”) pop-up menu shows the parameter being affected and can be used to reassign the behavior to another parameter.
Related Behaviors
“Ramp,” “Rate”

Creating a Decaying Oscillation
When you are oscillating an object’s rotation or position, a common effect is to “decay” or “dampen” the animation over time. This means that the animation gradually slows or comes to a stop. You can achieve this effect using keyframes to slow the amplitude of the oscillation.

To decay an oscillating rotation using keyframes:
1 Go to the frame where you want the animation to begin, then enable Record (press A).
2 Set the Amplitude value to the maximum value you want to use in your project.
   
   Note: When Record is enabled, any value change to a parameter using the Inspector, HUD, or Canvas creates a keyframe.
3 Go to the frame where you want the animation to come to a stop and set the Amplitude value to 0.
   
   When the object is selected, you can see the dampening of the animation—caused by the keyframed Amplitude parameter—in the Keyframe Editor (when Animated is chosen from the Show pop-up menu).
When the Oscillate behavior is selected, you can see the keyframed Amplitude value in the Keyframe Editor (when Animated is chosen from the Show pop-up menu).

Quantize
The Quantize behavior lets you create an incremental animation in any keyframed or behavior-influenced parameter. For example, if opacity is animated so that an object gradually fades in over time, you can add the Quantize behavior to make the object become opaque in steps.

Note: The Quantize behavior only works with animated parameters.

HUD Control
The HUD lets you define the step size, offset, and parameter assignment.

Parameters in the Inspector

Step Size: A value slider that defines the size of the steps, based on the units of the parameter to which it is applied. For example, when Quantize is applied to rotation, the steps are in degrees (even though it is not a dial control). When applied to position, the steps are in pixels.
**Offset:** A slider that offsets the steps. For example, when Quantize is applied to a Position parameter and Step Size is set to 100, an object “steps” in increments restricted to 100 pixels; thus, the step offset is 100, 200, 300 and so on. If Offset is set to 50, the step offset is restricted to 50, 150, 250, and so on.

**Apply To:** The Apply To (“Go”) pop-up menu shows the parameter being affected, and can be used to reassign the behavior to another parameter.

**Ramp**

The Ramp behavior lets you create a gradual transition in any parameter that can be animated, from the Start Value to the End Value. The speed of the transition is defined by the length of the Ramp behavior in the Timeline, and by the behavior’s end value. Additional parameters allow you to define how the transition occurs, whether it’s at a single continuous speed, or whether it accelerates over time.

Ramp is a versatile behavior. If you apply it to the Scale property, it works like the Grow/Shrink behavior. If you apply it to the Opacity property, you can fade an object in or out in different ways. Although you can use the Ramp behavior to mimic other Motion behaviors, it can be applied to any parameter you want.

**Note:** This behavior is additive, meaning that the value it generates is added to the original value of the parameter to which it’s applied.

For example, suppose you’re animating different segments of a bar graph, and each segment needs to grow until it reaches a specific length. (Hint—this can be done by assigning a subtracting mask to each bar object, and animating the position of each bar’s mask to slowly reveal each bar over time.)

Once you’ve arranged the different bars with their masks in the Canvas, you can apply Ramp behaviors to the X values of each mask to easily move each mask off to the side, giving the illusion that each bar is growing. Set the End Value parameter of each Ramp behavior to the length you want each bar to reach, and you’re done!
HUD control
The HUD lets you adjust the Ramp's Start Value, End Value, and Curvature parameters, as well as change the parameter assignment.

Parameters in the Inspector

Start Value: The value that's added to the parameter at the first frame of the Ramp behavior.

End Value: The value the Ramp behavior reaches at the last frame of the behavior. Over the life of the behavior, the parameter the Ramp behavior is applied to makes a transition from the Start Value to the End Value plus the original value.

Curvature: This parameter lets you ease the acceleration with which the Ramp behavior transitions from the Start Value to the End Value. Higher Curvature values result in an ease in/ease out effect, where the value slowly begins the transition, gradually speeds up as the behavior continues, then gradually slows down to a stop as it reaches the end. Curvature does not affect the overall duration of the effect, since that is defined by the length of the behavior in the Timeline.

Start Offset: A slider that lets you delay the beginning of the behavior's effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is in frames.

End Offset: A slider that lets you offset the end of the behavior's effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the behavior resets the object to its original parameter.

Apply To: The Apply To (“Go”) pop-up menu shows the parameter being affected and can be used to reassign the behavior to another parameter.

Related Behaviors
“Oscillate,” “Rate”

Randomize
Creates a continuous sequence of randomly increasing and decreasing values, based on the parameters defining the range and type of values that are generated.

Although the values created with this behavior are random, they're actually predetermined by the parameter settings you've chosen. As long as you don't change the parameters, the frame-by-frame values created by this behavior remain the same. If you don't like the values that were randomly generated, click the Generate button in the Behaviors tab in the Inspector to pick a new random seed number. This number is used to generate a new sequence of values.
The Apply Mode parameter determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides you with different ways of using a Randomize behavior to modify a parameter’s preexisting values.

The Randomize behavior is useful for creating jittery effects, such as twitchy rotation, flickering opacity, and other effects requiring rapid and varied changes over time that would be time-consuming to keyframe. The Randomize behavior can be modified with other behaviors, such as Average and Negate, to exercise further control over the values being generated.

**HUD Control**

The HUD lets you adjust the Amount, Multiplier, Frequency, Noisiness, Link (for multidimensional parameters), Start Offset, and End Offset parameters, as well as parameter assignment.

**Parameters in the Inspector**

**Amount/Multiplier:** This parameter is set to Amount when the Apply Mode is set to Add, Subtract, or Add and Subtract, and is set to Multiplier when the Apply Mode is set to Multiply. This parameter defines the maximum value the Randomize behavior will generate.

**Apply Mode:** A pop-up menu that determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides you with different ways of using a Randomize behavior to modify a parameter’s preexisting values. The options are Add, Subtract, Multiply, or Add and Subtract.

**Frequency:** A slider that lets you adjust the amount of random variation per second. Higher values will generate faster variations, whereas lower values will generate slower variations.

**Noisiness:** Adds an additional overlay of random variance to the Frequency you’ve set. Higher Noisiness values result in more erratic variations in the affected parameter.

**Link:** This parameter appears when you apply this behavior to a two-dimensional (such as Scale) or three-dimensional parameter (such as Position) that consists of X, Y, and/or Z values. Turn this checkbox on to keep the behavior’s effect on each value proportional.

**Affect Subobjects:** This parameter only appears when the Randomize behavior is applied to a parameter of the Sequence Replicator behavior. When Affect Subobjects is turned on, each object has a different random behavior. When turned off, each object undergoes the same animation.
Random Seed: A button that lets you pick a new random seed number. This number is used to randomly generate new sequences of values, based on the other parameters of this behavior.

Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is in frames.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the last random value generated by this behavior for the remaining duration of the object. Trimming the end of the behavior resets the parameter to its original value.

Related Behaviors
“Random Motion,” “Wriggle”

Rate
This behavior increases a parameter’s value over time, with the rate of increase determined by the Rate slider. Unlike the Ramp behavior, this behavior has no end value; it simply continues to increase or decrease the parameter it’s applied to until the end of the parameter.

Note: To decrease a parameter over time, enter a negative value into the Rate parameter.

HUD Control
The HUD has controls for Rate, Curvature, and parameter assignment.

Parameters in the Inspector
Rate: A value slider that lets you set a rate of increase over time for the affected parameter. Measured in percentage increase per second.

Curvature: This parameter lets you ease the acceleration with which the Rate behavior transitions from the Start Value to the End Value. Higher Curvature values result in an ease in/ease out effect, where the value slowly begins the transition, gradually speeds up as the behavior continues, then gradually slows down to a stop as it reaches the end. Curvature does not affect the overall duration of the effect, since that is defined by the length of the behavior in the Timeline.
End Offset: A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the last random value generated by this behavior for the remaining duration of the object. Trimming the end of the behavior resets the parameter to its original value.

Apply To: The Apply To (“Go”) pop-up menu shows the parameter being affected and can be used to reassign the behavior to another parameter.

Related Behaviors
“Oscillate,” “Ramp”

Reverse
Unlike the Negate behavior, which inverts the value of the parameter to which it’s applied, the Reverse behavior reverses the direction of any animation that affects a parameter, whether it’s caused by behaviors or keyframes. For example, when you apply the Reverse behavior to path animation that begins at the left and moves to the right, the animation path won’t move, but the object instead begins at the right and moves to the left. The Reverse behavior basically switches the beginning and ending points of animated objects.

HUD Control
The HUD control allows you to change the parameter assignment.

Parameters in the Inspector

Apply To: The Apply To (“Go”) pop-up menu shows the parameter being affected and can be used to reassign the behavior to another parameter.

Related Behaviors
“Average,” “Negate”

Stop
The Stop behavior suspends parameter animation (created by keyframes or applied behaviors) of an object. For example, if you assign the Stop Parameter behavior to the Position parameter of an object that is moving across the screen and rotating, the object ceases to move across the screen but continues to rotate.

Each behavior’s effect on the object is frozen at the first frame of the Stop behavior in the Timeline. Keyframes that are applied to that parameter cease to have any effect for the duration of the Stop behavior in the Timeline.

If the Stop behavior is shorter than the object to which it’s applied, all keyframes and behaviors affecting that channel immediately take effect after the last frame of the Stop behavior. For more information on using the Stop behavior, see “Using the Stop Parameter Behavior” on page 394.
HUD Control
The HUD control allows you to change the parameter assignment.

Parameters in the Inspector

Apply To: The Apply To (“Go”) pop-up menu shows the parameter being stopped and can be used to reassign the Stop behavior to another parameter.

Track
This behavior allows you to apply tracking data to a parameter of an effect, such as the center point of the Light Rays filter. For more information on using the Track behavior, see “Motion Tracking” in the Motion Supplemental Documentation PDF.

Wriggle
This behavior works similarly to the Randomize behavior, but with a slower effect.

HUD Control
The HUD lets you adjust the Amount, Multiplier, Frequency, Wriggle Offset, Noisiness, Link (for multidimensional parameters), Start Offset, and End Offset parameters, as well as change the parameter assignment.

Parameters in the Inspector

Amount/Multiplier: This parameter is set to Amount when the Apply Mode is set to Add, Subtract, or Add and Subtract. This parameter is set to Multiplier when the Apply Mode is set to Multiply. This parameter defines the maximum value that the Wriggle behavior generates.

Apply Mode: A pop-up menu that determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides you with different ways of using a Wriggle behavior to modify a parameter’s preexisting values. The options are Add, Subtract, Multiply, or Add and Subtract.

Frequency: A slider that lets you adjust the amount of random variation per second. Higher values generate faster variations, whereas lower values generate slower variations.

Wriggle Offset: A slider that allows you to offset the sequence of random values when you want to apply the same Wriggle behavior to multiple objects. By offsetting each object’s version of the Wriggle behavior, you can prevent objects from moving in sync.

Noisiness: This slider adds an additional overlay of random variance to the Frequency you’ve set. Higher Noisiness values result in more erratic variations in the affected parameter.
**Link:** This parameter appears when you apply the Wriggle behavior to a two-dimensional parameter (such as Scale) or three-dimensional parameter (such as Position) that consists of X, Y, and/or Z values. Turn this checkbox on to keep the behavior’s effect on each value proportional.

**Affect Subobjects:** This parameter only appears when the Wriggle behavior is applied to a parameter of the Sequence Replicator behavior. When Affect Subobjects is turned on, each object has a different wriggle behavior. When turned off, each object undergoes the same animation.

**Random Seed:** A button that lets you pick a new random seed number. This number is used to randomly generate new sequences of values, based on the other parameters of this behavior.

**Start Offset:** A slider that lets you delay the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is measured in frames.

**End Offset:** A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the last random value generated by this behavior for the remaining duration of the object. Trimming the end of the behavior resets the parameter to its original value.

**Note:** A Wriggle behavior applied to an Opacity parameter set to 100% does not have much effect. This is because there isn’t much room to “wriggle.” For a better result, set the Opacity to 0, or change the Apply Mode to Subtract.

**Related Behaviors**
“Random Motion,” “Randomize”

**Audio, Camera, Motion Tracking, Particles, Replicator, Shape, and Text Behaviors**
Audio, Camera, Particles, Replicator, Shape, and Text behaviors are designed specifically to be applied to their respective objects: Audio files, cameras, particle emitters or cells, replicators or replicator cells, shapes, and text.

- For more information about Audio behaviors, see Chapter 13, “Working with Audio,” on page 1117.
- For more information about Camera behaviors, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.
- For more information about Particles behaviors, see “Using Particles Behaviors” on page 738.
- For more information about Replicator behaviors, see “Using the Sequence Replicator Behavior” on page 821.
• For more information about Shape behaviors, see "Using the Shape Behaviors" on page 1064.
• For more information about Text behaviors, see “Using Text Animation and Text Sequence Behaviors” on page 648.

For more information about the Motion Tracking behaviors, including the Track Parameter behavior, see “Motion Tracking” in the Motion Supplemental Documentation PDF.

Retiming Behaviors
Retiming behaviors are applied to image sequences, QuickTime movies, and clone layers in order to change their timing. Retiming effects include creating hold frames, changing playback rate, reversing a clip, creating stutter or strobe effects, and so on.

Important: Retiming behaviors can only be applied to QuickTime movies, image sequences, or clone layers. In other words, a Retiming behavior cannot be applied to a particle emitter, but it can be applied to an instance of the particle emitter. For more information on cloning layers, see “Making Clone Layers” on page 283.

Retiming Behaviors Versus Timing Controls in the Inspector
When a clip is selected, a group of Timing parameters appears in the Properties tab of the Inspector. These controls allow you to do some of the same effects as the Retiming behaviors, such as slow or speed, loop, or reverse a clip; however, they affect the entire clip. The beauty of the Retiming behaviors is that you can define which portion of the clip is affected by the behavior.

Any timing changes made to a clip using the Inspector’s Timing controls are respected by the Retiming behaviors. For example, if you changed the speed of the clip to 50% in the Timing parameters, a Retiming behavior uses that half-speed clip as its source. For more information on Timing controls in the Inspector, see “Retiming” on page 312.

Flash Frame
This behavior randomly inserts a user-defined range of frames (adjacent to the current frame) into the playback of a clip.

HUD Control
The HUD contains the Random Frames, Frame Range, Duration, and Random Seed parameters.

Parameters in the Inspector
Random Frames: A slider that sets the probability that a frame within the duration of the behavior is replaced with a random frame. When this value is set to 0, no random frames are inserted. When set to 100, every frame is random. The default value is 10%.
Frame Range: A slider that defines the range from which the random frames are chosen, based around the current frame. The default value is 10 frames.

Duration: A slider that sets the duration of the sequence of random frames. The default value is 1, which means 1 random frame is inserted at a time. When Duration is set to 30, for example, 30-frame sequences (chosen from the Frame Range) are randomly inserted. The Duration value overrides the Random Frame count (so that a new random frame does not interrupt the sequence).

Random Seed: A button that lets you pick a new random seed number. This number is used to randomly generate new values, based on the other parameters of this behavior.

Hold Frame
The Hold Frame behavior holds the frame at the behavior’s In point for the duration of the behavior. The clip continues playing normally after the behavior’s Out point. For example, if the Hold Frame behavior begins at frame 60 and ends at frame 300, the clip plays normally until frame 59, frame 60 is held for 240 frames, and then normal playback resumes—frame 61 of the clip—at frame 301.

The Hold behavior is always applied at the current frame, rather than at the start of the object.

HUD Control
The HUD contains the Offset parameter.

Parameters in the Inspector

Offset: A slider that sets the offset for the hold frame. When set to 0 (the default), the frame at the start of the behavior is the hold frame. When set to 60, however, the frame at the start of the behavior (the hold frame) is frame 60 plus the start frame. This parameter is measured in frames.

Tip: Flickering may occur if the Hold Frame behavior is applied to interlaced footage. To avoid this, ensure that Field Order is properly set in the Inspector. To change field order, select the footage in the Media tab of the Project pane, show the Media tab in the Inspector, then choose a field order option from the Field Order pop-up menu.

Loop
This behavior loops a segment of the clip within the duration of the behavior. The loop’s starting frame is derived from the start frame of the behavior. For example, if the behavior is applied at the start of a clip, and Loop Duration is set to 30, the first 30 frames of the clip loop repeatedly until the end of the behavior. At the end of the behavior, normal playback resumes from the frame at the end of the loop duration.

HUD Control
The HUD contains the Loop Duration parameter.
Parameters in the Inspector

Loop Duration: A slider that sets the duration of the looped frames. The default value is 30 frames.

Ping Pong
This behavior "ping-pongs" a segment of the clip within the duration of the behavior. The ping-pong’s starting frame is derived from the start frame of the behavior. For example, if the behavior is applied at the start of a clip, and Duration is set to 30, the first 30 frames of the clip play forward, then play in reverse, then forward, and so on until the end of the behavior. At the end of the behavior, normal playback resumes.

HUD Control
The HUD contains the Loop Duration parameter.

Parameters in the Inspector

Duration: A slider that sets the duration of the ping-pong frames. The default value is 30 frames.

Replay
The Replay behavior resets the playhead at the beginning of the behavior to a specific frame, and then plays the clip normally from that frame. The clip plays back normally after the end of the behavior. This allows you to trigger playback of the clip at different times, without requiring multiple copies of the movie object.

HUD Control
The HUD contains the Start From and Start Time parameters.

Parameters in the Inspector

Start From: A pop-up menu that determines whether the replay starts from an absolute frame number or an offset from the frame at the start of the behavior.

   Absolute Frame: Sets the replay to start at the frame specified in the Start Time parameter. For example, if the behavior starts at frame 60 of the clip and Start Frame is set to 30, when playback reaches frame 60, the clip starts playback over from frame 30.

   Offset Frame: Allows you to offset the start frame of the replay. For example, if the behavior starts at frame 60 of the clip, and Start Frame is set to 30, when playback reaches frame 60, the clip starts playback at frame 90. If Start Frame is set to –30, the clip starts playback over from frame 30.

Start Time: A slider that sets the start frame from which to replay the clip. The default is frame 1.
**Reverse**
This behavior plays the clip or image sequence in reverse.

**HUD Control**
There are no parameters for this behavior.

**Parameters in the Inspector**
There are no parameters for this behavior.

**Reverse Loop**
This behavior loops a segment of the clip in reverse within the duration of the behavior. If Loop Duration is set to 30 and the behavior begins at frame 1, frames 1-30 are played in reverse, then frames 31-60 are played in reverse, frames 61-90 are played in reverse, and so on.

**Tip:** To achieve a nice stutter effect, set Loop Duration to 2.

**HUD Control**
The HUD contains the Loop Duration parameter.

**Parameters in the Inspector**

**Loop Duration:** A slider that sets the duration of the looped frames to be played in reverse. The default value is 30 frames.

**Scrub**
Like the Scrub filter, the Scrub behavior moves a virtual playhead around a clip, allowing you to change the timing of the clip without moving it in the Timeline. Additionally, the Scrub behavior allows you to animate the offset parameter using keyframes or parameter behaviors, often with interesting results. Try applying the Oscillate behavior to the Frame offset, with the Offset From parameter set to Current Frame.

**Note:** You can also apply parameter behaviors to the Retime Value parameter in the Timing controls for the image itself. The Timing controls are located in the Properties tab. Time Remap must be set to Variable Speed in order to access the Retime Value parameter.

**HUD Control**
The HUD contains the Frame Offset and Offset From parameters.

**Parameters in the Inspector**

**Frame Offset:** Sets the offset of the virtual playhead.

**Offset From:** Sets the position from which the virtual playhead is offset. Values can be selected from First Frame or Current Frame.
**Important:** Scrub does not affect clip audio.

**Set Speed**
This behavior allows you to change the speed (playback rate) of a clip. The speed specified in the behavior begins at the behavior’s In point and exists for the duration of the behavior. The clip continues playing at its default speed after the behavior’s Out point. For example, if the Set Speed behavior begins at frame 60 and ends at frame 300, the clip plays normally until frame 59, plays back at the rate specified in the behavior from frame 60 to frame 300, and then resumes its default playback speed at frame 301. You can apply an “ease-in” or “ease-out” effect to the speed change.

**HUD Control**
The HUD contains the Speed, Ease In Time, Ease In Curve, Ease Out Time, and Ease Out Curve parameters.

**Parameters in the Inspector**

**Speed:** A slider that sets the speed of the clip as a percentage. The default is 100% (the clip’s normal speed). A Speed setting of 50% plays the clip at half speed.

**Note:** The Speed parameter can be keyframed to create variable playback rate changes.

**Ease In Time:** A slider that sets the number of frames over which the ease in to the speed change occurs (from the start of the behavior). The default value is 20 frames.

**Ease In Curve:** A slider that defines the curvature of the ramp when easing into the speed change. A value of 0 creates a sharp transition to the new speed; a value of 100 creates the smoothest ease in to the new speed. The default is 50%.

**Ease Out Time:** A slider that sets the number of frames over which the ease out of the speed change occurs (from the end of the behavior). The default value is 20 frames.

**Ease Out Curve:** A slider that defines the curvature of the ramp when easing out of the speed change. A value of 0 creates a sharp transition from the new speed to the original speed; a value of 100 creates the smoothest ease out. The default is 50%.

**Strobe**
The Strobe behavior simulates the look of a strobe light or lower frame rate video by holding a number of frames as defined by the Strobe Duration parameter over the playback of the clip. For example, when Strobe Duration is set to 10, frame 1 is held for 10 frames, frame 11 for 10 frames, frame 21 for 10 frames, and so on. The frames in between (2–10, 12–20, 22–30, and so on) do not appear.

**HUD Control**
The HUD contains the Strobe Duration parameter.
Parameters in the Inspector

Strobe Duration: A slider that sets the number of frames to hold. A value of 1 plays the clip at normal speed. The default value is 5 frames.

Stutter
This behavior randomly inserts hold frames, of random durations, into the playback of a clip. The effect is similar to a tape that sticks during play in a videocassette recorder.

HUD Control
The HUD contains the Stutter Amount, Duration Range, and Random Seed parameters.

Parameters in the Inspector

Stutter Amount: A slider that sets the probability that a hold frame is generated at the given frame. When set to 0%, no hold frames are created; when set to 100%, every frame is a hold frame. Values in between 0 and 100 indicate the probability of frames (within the duration of the behavior) that are replaced by hold frames. The default value is 10%.

Duration Range: A slider that sets the maximum duration of hold frames. A value of 1 inserts single-frame hold frames at a frequency determined by the Stutter Amount parameter. Increasing the Duration Range increases the range of hold frames. For example, a value of 30 creates random hold frames with a minimum of 1 frame and a maximum of 30 frames. The default value is 3 frames.

Random Seed: A button that lets you pick a new random seed number. This number is used to randomly generate new values, based on the other parameters of this behavior.

Simulation Behaviors
These behaviors perform one of two tasks. Some Simulation behaviors, such as Gravity, animate the parameters of an object in a way that simulates a real-world phenomenon. Other Simulation behaviors, such as Attractor and Repel, affect the parameters of one or more objects surrounding the object to which they’re applied. These behaviors allow you to create some very sophisticated interactions among multiple objects in your project with a minimum of adjustments. Like the Basic Motion behaviors, Simulation behaviors also affect specific object parameters. Examples include Attractor, Gravity, and Repel.

Examples of Using Simulation Behaviors
To view examples of working with the different Simulation behaviors, see “Behavior Examples” on page 483.
Important: Several Simulation behavior parameters contain object wells into which target objects used as attractors, repellers, orbiters, and so on, are dragged. Dragging an object to a well may be tricky—be sure to click the object name in the Layers tab and immediately drag the object to the object well (without releasing the mouse button). The behavior must remain active even though you are dragging another object in the Layers tab. If you click the object in the Layers tab and release the mouse button, that object becomes selected, and the behavior’s parameters are no longer displayed. This behavior is true of all wells, including mask source and image wells.

Align To Motion
The Align To Motion behavior changes the rotation of an object to match changes made to its direction along an animation path. This behavior is meant to be combined with Simulation behaviors that animate the position of an object or with a keyframed animation path you create yourself.

Note: The Align to Motion behavior does not work on objects animated using the Motion Path behavior. Instead, use the Snap Alignment to Motion behavior (in the Basic Motion subcategory).

Unlike the Snap Alignment to Motion behavior, which produces absolute changes in rotation that precisely match changes in direction, Align To Motion has a springy reaction and creates a more lively effect.

In the above example, the fish travels along the keyframed animation path, but it isn’t aligned to the animation path (notice the rotation handle). Using the Align To Motion behavior, its angle of rotation moves so that it points in the direction of the animation path. By adjusting the Drag parameter, you can make it careen wildly about its anchor point as it goes around curves in the animation path.

HUD Control
The HUD has controls for the Rotation Axis, Axis, Invert Axis, Spring Tension, and Drag parameters. When applied to a group or layer that contains multiple objects (such as particles, text, or a replicator), the Affect Subobjects checkbox also appears in the HUD.
Parameters in the Inspector

**Affect Subobjects:** This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

**Rotation Axis:** A pop-up menu that lets you rotate the object around the X, Y, or Z axis. You can also select All to rotate the object around all three axes. The default rotation axis is Z.

**Axis:** A pop-up menu that lets you specify whether the object aligns itself on its horizontal or vertical axis.

**Invert Axis:** A checkbox that flips the orientation with which the object aligns itself to the motion.

**Spring Tension:** A slider that adjusts how quickly the object’s rotation changes to match a change in the object’s direction. Lower values create a delay between a change to an object’s position and its subsequent change in rotation. Higher values create more responsive changes in rotation.

**Drag:** A slider that adjusts whether or not the change in rotation made by this behavior overshoots the new direction of the object. Low drag values result in springy changes in rotation, where the object rotates back and forth as it overshoots changes in direction. High drag values dampen this effect, making the object’s rotation stick more closely to the changes made in rotation. Higher values also cause the object’s rotation to lag behind the object’s change in position.

**Related Behaviors**

“Snap Alignment to Motion”

**Attracted To**

This behavior is part of a group of Simulation behaviors that let you create complex animated relationships between two or more objects. These behaviors are extremely powerful and allow complicated effects to be created with a minimum of steps.
An object with the Attracted To behavior moves toward a single specified target, the object of attraction. Additional parameters allow you to adjust the area of influence that defines how close an object needs to be to move toward the object of attraction, and how strongly it is attracted.

The Drag parameter lets you define whether attracted objects overshoot and bounce about the attracting object, or whether they eventually slow down and stop at the position of the target object.

You can apply two or more Attracted To behaviors to a single object, each with a different object of attraction, to create tug-of-war situations where the object bounces among all the objects it’s attracted to.

**HUD Control**

The HUD has an object well you can use to assign an object of attraction, as well as Strength, Falloff Type, Falloff Rate, Influence, Drag, and axis assignment parameters. When applied to an object that contains multiple objects (such as a group, particles, text, or the replicator), the Affect Subobjects checkbox also appears in the HUD.

**Parameters in the Inspector**

**Affect Subobjects**: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

**Object**: A well that defines the object of attraction. To set the defined target object, drag the object from the Layers tab to the object well in the Attracted To HUD or Inspector. In the Layers tab, you can also drag the target object onto the Attracted To behavior.

**Strength**: A slider defining the speed at which the object moves toward the object of attraction. With a value of 0, the object doesn't move at all. The higher the value, the faster the object moves.
**Falloff Type:** A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.

- **Linear:** Object attraction falls off in proportion to the object’s distance.
- **Exponential:** The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

**Falloff Rate:** This value determines how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

**Influence:** A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain in place.

**Drag:** A slider that can be used to reduce the distance attracted objects overshoot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

**Include X, Y, and Z:** Buttons that allow you to specify the axes on which the affected object (or objects) moves around the object to which it is attracted. When Z is enabled, the object moves about its attractor object in Z space.

**Related Behaviors**
“Attractor,” “Drift Attracted To,” “Drift Attractor,” “Orbit Around,” “Spring,” “Vortex”

**Attractor**
If you apply an Attractor behavior to an object, other objects that lie within the area of influence move toward it. You can manipulate the strength with which other objects are attracted, as well as the distance required for attraction to begin.

![Start of Attractor effect](image1.png) ![End of Attractor effect](image2.png)
By default, objects overshoot the object of attraction and bounce around, never coming to rest. The Drag parameter lets you adjust this behavior, changing whether attracted objects overshoot and bounce around, or whether they eventually slow down and stop at the position of the target object.

The Attractor behavior can affect all objects in the Canvas that fall within the area of attraction, or you can limit its effect to a specific list of objects by using the Affect parameter.

The Attractor behavior can also be applied to objects in motion. If you animate the position of the target object to which you’ve applied the Attractor behavior, all other objects in the Canvas continue to be attracted to its new position.

**HUD Control**
The HUD lets you adjust the Affect, Strength, Falloff Type, Falloff Rate, Influence, Drag, and axis assignment parameters.

**Parameters in the Inspector**

**Affect:** A pop-up menu that limits which objects in your project are affected by the Attractor behavior. There are three options:

- **All Objects:** All objects in the Canvas are affected by the Attractor behavior.
- **Related Objects:** The default setting. Only other objects that are within the same group as the object of attraction are affected.
- **Specific Objects:** Only objects appearing in the Affected Objects list are affected by the Attractor behavior.
- **Affected Objects:** A list that appears when Specific Objects is chosen in the Affect pop-up menu. Drag objects from the Layers tab into this list to be affected by the Attractor behavior when the Specific Objects option is selected in the Affect pop-up menu. To remove an item from the list, select the item and click Remove.

**Strength:** A slider defining the speed with which attracted objects move toward the target object. With a value of 0, attracted objects don't move at all. The higher the value, the faster attracted objects move.

**Falloff Type:** A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.

- **Linear:** Object attraction falls off in proportion to the object’s distance.
- **Exponential:** The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.
Falloff Rate: This value determines how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of influence in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain in place.

Drag: A slider that can be used to reduce the distance attracted objects overshoot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

Include X, Y, and Z: Buttons that allow you to specify the space in which the object (or objects) moves toward the target object. For example, when X and Y are enabled, the object moves in the XY plane; when Y and Z are enabled, the object moves in the YZ plane.

Related Behaviors
“Attracted To,” “Drift Attracted To,” “Drift Attractor,” “Orbit Around,” “Spring,” “Vortex”

Drag
This behavior lets you simulate the force of friction on a moving object, slowing it down over time. Applying the Drag behavior is an easy way to decelerate objects with multiple behaviors that create complex motion.

HUD Control
The HUD lets you adjust the amount of drag and axis assignment. When applied to an object that contains multiple objects, such as a group, particles, text, or the replicator, the Affect Subobjects checkbox also appears in the HUD.

Parameters in the Inspector

Affect Subobjects: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

Amount: Sliders that can be used to slow down an object over time, causing it to eventually come to a stop. Higher Drag values result in the object coming to rest sooner. Click the Amount disclosure triangle to adjust the drag applied to the X, Y, and Z values separately. An example of this is to create a situation where an object’s vertical speed slows down faster than its horizontal speed.
Include X, Y, and Z: Buttons that allow you to specify the space in which drag is in effect. For example, when X and Y are enabled, the object drags in the XY plane; when Y and Z are enabled, the object drags in the YZ plane.

Related Behaviors
“Rotational Drag”

Drift Attracted To
Similar to the Attracted To behavior, but by default an object moves toward the object of attraction and comes to rest, rather than overshooting the object of attraction and bouncing around.

HUD Control
The HUD has an object well you can use to assign an object of attraction, sliders for strength and drag, and axis assignment. When applied to an object that contains multiple objects (such as a group, particles, text, or the replicator), the Affect Subobjects checkbox also appears in the HUD.

Parameters in the Inspector

Affect Subobjects: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

Object: A well that defines the object of attraction. To set the defined target object, drag the object from the Layers tab to the object well in the Drift Attracted To HUD or Inspector. In the Layers tab, you can also drag the target object onto the Drift Attracted To behavior.

Strength: A slider defining the speed at which the object moves toward the object of attraction. With a value of 0, the object doesn't move at all. The higher the value, the faster the object moves.

Falloff Type: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.

- Linear: Object attraction falls off in proportion to the object's distance.
- Exponential: The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

Falloff Rate: This value determines how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.
Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain in place.

Drag: A slider that can be used to reduce the distance attracted objects overshoot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

Include X, Y, and Z: Buttons that allow you to specify the space in which the affected object (or objects) drifts toward the object to which it is attracted. For example, when X and Y are enabled, the object drifts in the XY plane; when Y and Z are enabled, the object drifts in the YZ plane.

Related Behaviors
“Attracted To,” “Attractor,” “Drift Attractor,” “Orbit Around,” “Spring,” “Vortex”

Drift Attractor
Similar to the Attractor behavior, but by default objects within the area of influence move toward the object of attraction and come to rest, rather than overshooting the object of attraction and bouncing around.

HUD Control
The HUD has controls for Affect, Strength, Drag, and axis assignment.

Parameters in the Inspector

Affect: A pop-up menu that limits which objects in your project are affected by the Drift Attractor behavior. There are three options:
• All Objects: All objects in the Canvas are affected by the Drift Attractor behavior.
• Related Objects: The default setting. Only other objects that are within the same group as the object of attraction are affected.
• Specific Objects: Only objects appearing in the Affected Objects list are affected by the Drift Attractor behavior.
  • Affected Objects: A list that appears when Specific Objects is chosen in the Affect pop-up menu. Drag objects or groups from the Layers tab into this list to be affected by the Drift Attractor behavior. To remove an item from the list, select the item and click Remove.

Strength: A slider defining the speed with which attracted objects move toward the target object. With a value of 0, attracted objects don’t move at all. The higher the value, the faster attracted objects move.

Falloff Type: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.
• **Linear**: Object attraction falls off in proportion to the object’s distance.

• **Exponential**: The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

**Falloff Rate**: This value determines how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When Falloff Type is set to Exponential, the attraction falls off more quickly than when set to Linear.

**Influence**: A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain in place.

**Drag**: A slider that can be used to reduce the distance attracted objects overshoot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

**Include X, Y, and Z**: Buttons that allow you to specify the space in which the object (or objects) drift toward the target object. For example, when X and Y are enabled, the object drifts in the XY plane; when Y and Z are enabled, the object drifts in the YZ plane.

**Related Behaviors**
“Attracted To,” “Attractor,” “Drift Attracted To,” “Orbit Around,” “Spring,” “Vortex”

**Edge Collision**
This is a good behavior to use if you’re setting up complex motion simulations and you don’t want your objects exiting the Canvas. Objects with the Edge Collision behavior applied either come to a stop or bounce off after colliding with the edge of the Canvas frame. For example, if you apply the Throw behavior to an object and set the velocity to send the object toward the edge of the frame, then apply Edge Collision, the object will bounce off the edge of the frame according to the Bounce Strength parameter.
The angle at which the object bounces depends on the angle at which it hits the edge of the frame; the speed it travels after bouncing is set by the Bounce Strength parameter.

**Note:** Edge Collision has no effect on objects that are larger than the Canvas.

**Important:** By default, the Edge Collision behavior uses the size of the project and the bounding box to determine how the object collides with the edge of the Canvas. For example, in an NTSC Broadcast SD project (720 x 486 pixels), an object bounces off the right and left edges of the project at its bounding box. With groups (particles, text, and objects), only the object’s center is used. You can make the object travel further off the Canvas before it bounces by adjusting the Width and Height parameters. If you’re using this behavior with an object that has an alpha channel that’s smaller than its bounding box, adjust the Crop parameter in the object’s Properties tab to fit the bounding box as closely as possible to the edge of the image.

**HUD Control**

The HUD has controls for Bounce Strength and Width, Height, and Depth. When applied to an object that contains multiple objects (such as a group, particles, text, or the replicator), the Affect Subobjects checkbox also appears in the HUD.

**Parameters in the Inspector**

**Affect Subobjects:** This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

**Bounce Strength:** The speed at which objects travel after colliding with an edge. A value of 0 causes objects to come to a complete stop when colliding with an edge that’s perpendicular to the direction of motion. Higher values cause an object to move faster after bouncing. This parameter only slows the object in the direction perpendicular to the bounced edge.

**Active Edges:** Six checkboxes define which collision box edges are detected by the Edge Collision behavior. You can turn edges on and off in any combination.

- **Left Face:** Defines the left edge for the collision.
- **Right Face:** Defines the right edge for the collision.
- **Top Face:** Defines the top edge for the collision.
- **Bottom Face:** Defines the bottom edge for the collision.
- **Back Face:** Defines the back edge (in Z space) for the collision.
- **Front Face:** Defines the front edge (in Z space) for the collision.
**Width:** A slider that allows you to define a width (the right and left edges of the Canvas) other than the size of project. By default, Width is set to the project size.

**Height:** A slider that allows you to define a height (the top and bottom edges) other than the size of project. By default, Height is set to the project size.

**Depth:** A slider that allows you to define a depth (the back and front faces, in Z space) for the edge collision. By default, Depth is set to 100 pixels.

**Gravity**
This behavior causes an object, or the objects within a group (when Affect Subobjects is turned on), to fall over time. The gravitational acceleration can be increased or decreased, resulting in a change to the rate of fall. Objects affected by the Gravity behavior continue to fall past the bottom edge of the Canvas (unless the Edge Collision behavior has been applied).

The Gravity behavior can be used in conjunction with other behaviors that animate the position of objects to create natural-looking arcs and animation paths that simulate thrown objects falling to the ground. For example, apply the Throw behavior to an object to send it flying through the air, and then apply the Gravity behavior to it to make the object arc up and then fall down past the bottom of the Canvas.

You can also set the Acceleration parameter to a negative value, effectively applying “anti-gravity” to the object and making it fly up.

**HUD Control**
The HUD lets you adjust the Acceleration parameter. When applied to an object containing multiple objects (such as a group, particles text, or a replicator), the Affect Subobjects checkbox also appears in the HUD.
Parameters in the Inspector

**Affect Subobjects**: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

**Acceleration**: A slider defining the strength of gravity affecting the target object. The higher this value, the faster the target object falls.

**Related Behaviors**
“Motion Path,” “Random Motion,” “Throw,” “Wind”

**Orbit Around**
Similar to the Attracted To behavior, the Orbit Around behavior’s default parameter settings give the object sufficient initial velocity to orbit around another object in a perfect circle.

**Note**: Behaviors such as Attractor and Repel applied to nearby objects may disrupt an object with the Orbit Around behavior applied to it.
HUD Control
The HUD has an object well you can use to assign an object of attraction, as well as controls for Strength, Falloff Type, Falloff Rate, Influence, Drag, axis and Pole Axis assignment, and Direction. When applied to an object that contains multiple objects (such as a group, particles, text, or the replicator), the Affect Subobjects checkbox also appears in the HUD.

Parameters in the Inspector

Affect Subobjects: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

Object: A well that defines the object to orbit around. To set the defined target object, drag the object from the Layers tab to the Object well in the Orbit Around HUD or Inspector. In the Layers tab, you can also drag the target object onto the Orbit Around behavior.

Strength: A slider defining the speed at which the object moves.

Falloff Type: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially. The default is Linear.
- Linear: Object attraction falls off in proportion to the object’s distance.
- Exponential: The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

Falloff Rate: This value determines how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.
**Influence**: A slider that defines the radius of the circle of influence in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain in place.

**Drag**: The default value for Orbit Around is 0, which results in a stable orbit. Any other value causes the orbit to decay and the object to spiral into the object of attraction.

**Include X, Y, and Z**: Buttons that allow you to specify the space in which the orbit occurs. For example, when X and Y are enabled, the object orbits in the XY plane. In the illustration below, X and Y are turned on in the Include parameter. The yellow motion paths represent the motion of the white stars around the target object (the orange outlined star). The light gray box represents the boundary of the group.

In the illustration below, Y and Z are turned on in the Include parameter. The white stars move around the target object in the YZ plane.

**Pole Axis**: This parameter becomes available when the X, Y, and Z axes are enabled in the Include parameter. Because all points are at a fixed distance from the target or attractor object (the Pole Axis), the object can be visualized on a sphere of all possible orbits, with the target object at the center of the sphere. The Pole Axis defines the two points on the sphere that the orbit must pass through.
• **X:** The following image illustrates Pole Axis set to X. The light gray box represents the boundary of the group.

![Image of Pole Axis set to X]

• **Y:** The following image illustrates Pole Axis set to Y.

![Image of Pole Axis set to Y]

• **Z:** The following image illustrates Pole Axis set to Z.

![Image of Pole Axis set to Z]
• **Random:** When Random is selected, the axes shift to a different random position.

**Direction:** A pop-up menu that lets you set whether objects move around in a clockwise or counterclockwise direction.

**Related Behaviors**
“Attracted To,” “Attractor,” “Drift Attracted To,” “Drift Attractor,” “Spring,” “Vortex”

**Random Motion**
The Random Motion behavior animates the position of an object and makes that object move around the Canvas along a random path.

Although the motion created with this behavior appears to be random, it's actually predetermined by the particular group of parameters you've chosen. As long as you don't change the parameters, the animation path created by this behavior remains the same. If you don't like the path that was randomly generated, click the Generate button in either the HUD or the Behaviors tab in the Inspector to pick a new random seed number. This number is used to generate a new path.

The Random Motion behavior is useful for quickly creating varied animation paths for large numbers of objects you want to move at the same time. For example, you can create an arrangement of ten objects in the Canvas and apply the Random Motion behavior to all of them.
You can also use the Random Motion behavior to add variation to the animation paths created by other behaviors that affect an object’s position. For example, adding Random Motion to an object with the Orbit Around behavior results in a more erratic animation path, although it still orbits as before.

![Shape with Orbit Around behavior](image1.png) ![Orbit Around behavior modified by Random Motion](image2.png)

**HUD Control**

The HUD has controls for the Amount, Frequency, Noisiness, Drag, axis assignment, and Random Seed parameters. When applied to an object that contains multiple objects (such as a group, particles, text, or a replicator), the Affect Subobjects checkbox also appears in the HUD.

**Parameters in the Inspector**

**Affect Subobjects**: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

**Amount**: A slider that determines the speed the object moves by changing the length of the animation path. Higher values result in faster motion and longer animation paths.

**Frequency**: A slider that determines the number of twists and turns in the animation path, which can be seen by the crookedness of the resulting animation path. Higher values create more turns in the animation path. Lower values result in straighter animation paths.

**Noisiness**: A slider that determines an additional level of jaggedness along the animation path shape defined by the Amount parameter. Higher values result in a more jagged-looking animation path.
Drag: A slider that controls the speed the object moves along the animation path. While the Amount parameter controls the length of the animation path, the Drag parameter shrinks or enlarges the animation path as a whole.

Include X, Y, and Z: Buttons that allow you to specify the space in which random motion is in effect. For example, when X and Y are enabled, the motion occurs in the XY plane; when Y and Z are enabled, the motion occurs in the YZ plane.

Random Seed: A button that lets you pick a new random seed number. This number is used to randomly generate new animation paths, based on the values you’ve picked in the other parameters of this behavior.

Related Behaviors
“Motion Path,” “Gravity,” “Throw,” “Wind”

Repel
If you apply the Repel behavior to an object, that object pushes away all other objects within the area of influence in the Canvas. The strength with which objects are pushed away can be increased or decreased, as can the distance repelled objects travel.

You can also specify which objects are affected by this behavior, creating an effect where only specific objects are moved, while others remain still.

The Repel behavior is the opposite of the Attractor behavior, and is part of a group of simulation behaviors that create complex animated relationships between two or more objects.

HUD Control
The HUD has controls for which objects are affected, as well as for Strength, Falloff Type, Falloff Rate, Influence, axis assignment, and Drag.
Parameters in the Inspector

Affect: A pop-up menu that limits which objects in your project are affected by the Repel behavior. There are three options:

- **All Objects**: All objects in the Canvas are affected by the Repel behavior.
- **Related Objects**: The default setting. Only other objects that are within the same group as the repelling object are affected.
- **Specific Objects**: Only objects appearing in the Affected Objects list are affected by the Repel behavior.

- **Affected Objects**: A list that appears when Specific Objects is chosen in the Affect pop-up menu. Drag object or groups from the Layers tab into this list to be affected by the Repel behavior. To remove an item from the list, select the item and click Remove.

Strength: A slider defining the speed with which repelled objects move away from the object. With a value of 0, repelled objects don’t move at all. The higher the value, the faster repelled objects move.

Falloff Type: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.

- **Linear**: Repulsion between objects falls off in proportion to the object’s distance.
- **Exponential**: The closer an object is within the area of influence, the more strongly it is repelled, and the faster it moves away from the object doing the repelling.

Falloff Rate: This value determines how quickly the force of repulsion between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move away from the object of repulsion. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of influence in pixels. Objects that fall within the area of influence move away from the object of repulsion. Objects that are outside of the area of influence remain in place.

Drag: A slider that can be used to reduce the distance repelled objects travel away from the repelling object.

Include X, Y, and Z: Buttons that allow you to specify the space in which the objects move away from the object with the applied Repel behavior. For example, when X and Y are enabled, the object moves away in the XY plane; when Y and Z are enabled, the object moves away in the YZ plane.

Related Behaviors

“Repel From”
**Repel From**
While the Repel behavior pushes other objects away, the Repel From behavior has the converse effect, making the object it's applied to move away from a selected object in the Canvas.

**HUD Control**
The HUD has an image well you can use to assign an object to move away from, as well as controls for Strength, Falloff Type, Falloff Rate, Influence, axis assignment, and Drag. When applied to an object that contains multiple objects (such as a group, particles, text, or the replicator), the Affect Subobjects checkbox also appears in the HUD.

**Parameters in the Inspector**

**Affect Subobjects**: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

**Object**: A well that defines the object to be repelled from.

**Strength**: A slider defining the speed at which the object is repelled. With a value of 0, the object is not repelled at all. The higher the value, the faster the object is repelled.

**Falloff Type**: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.

- **Linear**: Repulsion between objects falls off in proportion to the object's distance.
- **Exponential**: The closer an object is within the area of influence, the more strongly it is repelled, and the faster it moves away from the object doing the repelling.

**Falloff Rate**: This value determines how quickly the force of repulsion between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move away from the object of repulsion. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

**Influence**: A slider that defines the radius of the circle of influence in pixels. Objects that fall within the area of influence move away from the object of repulsion. Objects that are outside of the area of influence remain in place.

**Drag**: A slider that can be used to reduce the distance the object or objects travel away from the repelling object.
Include X, Y, and Z: Buttons that allow you to specify the space in which the object moves away from the selected object. For example, when X and Y are enabled, the object moves in the XY plane; when Y and Z are enabled, the object moves in the YZ plane.

Related Behaviors
“Repel”

Rotational Drag
This behavior is similar to the Drag behavior, except that it affects Rotation instead of position. Rotational Drag simulates friction affecting objects that are spinning due to keyframed or behavior-driven changes to the Rotation parameter. By setting higher Drag values, you can slow rotational changes to an eventual stop.

HUD Control
The HUD lets you control the amount of drag. When applied to an object that contains multiple objects (such as a group, particles, text, or the replicator), the Affect Subobjects checkbox also appears in the HUD.

Parameters in the Inspector

Affect Subobjects: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

Amount: A slider that can be used to slow down an object’s rotation over time, causing it to eventually come to a stop. Higher Amount values result in the rotation ending sooner.

Related Behaviors
“Drag”

Spring
The Spring behavior creates a relationship between two objects, so that an object with the Spring behavior applied to it moves back and forth around a second object. The Attract To parameter defines the object that serves as the target and center of the Spring behavior. Additional parameters let you adjust the speed of the behavior (Spring Tension) and the acceleration of the object at each change in direction (Relaxed Length).

If the Attract To object is at rest, the resulting motion is fairly simple and the springing object moves back and forth in a straight line. If the Attract To object is in motion, the springing object’s motion will be much more complex, changing direction according to the velocity of the Attract To object.
HUD Control
An image well in the HUD lets you set the Attract To object. You can also control the Spring Tension and Relaxed Length parameters and axis assignment. A checkbox lets you turn on the Repel parameter. When this behavior is applied to an object that contains multiple objects (such as a group, particles, text, or the replicator), the Affect Subobjects checkbox also appears in the HUD.

Parameters in the Inspector

**Affect Subobjects:** This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

**Attract To:** An image well that defines the object of attraction. To set the defined target object, drag the object from the Layers tab to the Attract To well in the Spring HUD or Inspector. In the Layers tab, you can also drag the target object onto the Spring behavior.

**Spring Tension:** A slider that determines how fast the object is pulled toward the object of attraction.

**Relaxed Length:** The distance from the target object at which object attraction diminishes to zero. As the springing object’s distance increases past this point, the force of attraction increases proportionally, to bring it back toward the target object.

**Repel:** With this checkbox turned on, when the object gets closer to the object of attraction than the Relaxed Length value, the objects are pushed apart. When this checkbox is turned off, no repelling force is applied.

**Include X, Y, and Z:** Buttons that allow you to specify the space in which the affected object moves back and forth around the assigned object. For example, when X and Y are enabled, the object moves back and forth in the XY plane; when Y and Z are enabled, the object moves back and forth in the YZ plane.

**Related Behaviors**
“Attracted To,” “Attractor,” “Drift Attracted To,” “Drift Attractor,” “Orbit Around,” “Vortex

**Vortex**
The opposite of the Orbit Around behavior. While the Orbit Around behavior causes one object to orbit around another target object, the Vortex behavior exerts a force on all objects surrounding the object to which the Vortex behavior is applied.
HUD Control

The HUD has a pop-up menu that lets you limit the objects affected by this behavior, as well as controls for Strength, Falloff Type, Falloff Rate, Influence, Drag, axis assignment, and Direction.

Parameters in the Inspector

**Affect:** A pop-up menu that limits which objects in your project are affected by the Vortex behavior. There are three options:

- **All Objects:** All objects in the Canvas are affected by the Vortex behavior.
- **Related Objects:** The default setting. Only other objects that are within the same object as the object of attraction are affected.
- **Specific Objects:** Only objects appearing in the Affected Objects list are affected by the Vortex behavior.

**Affected Objects:** A list that appears when Specific Objects is chosen in the Affect pop-up menu. Drag objects from the Layers tab into this list to be affected by the Vortex behavior when the Specific Objects option is chosen in the Affect pop-up menu. To remove an item from the list, select the item and click Remove.

**Strength:** A slider defining the speed at which the affected objects move about the object of attraction.

**Falloff Type:** A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially. The default is Linear.

- **Linear:** Object attraction falls off in proportion to the object’s distance.
- **Exponential:** The closer an object is within the area of influence, the more strongly it is attracted, and the faster it moves toward the object of attraction.

**Falloff Rate:** This value determines how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly. When set to Exponential, the attraction falls off more quickly than when set to Linear.

**Influence:** A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain in place.

**Drag:** The default value for Vortex is 0, which results in a stable vortex. Any other value causes the vortex to decay and the object to spiral into the object of attraction.

**Include X, Y, and Z:** Buttons that allow you to specify the space in which the objects vortex around the target object. For example, when X and Y are enabled, the object circles around in the XY plane; when Y and Z are enabled, the object circles around in the YZ plane.
**Pole Axis:** This parameter becomes available when the X, Y, and Z axes are enabled in the Include parameter. Because all points are at a fixed distance from the target or attractor object (the Pole Axis), the object can be visualized on a sphere of all possible orbits, with the target object at the center of the sphere. The Pole Axis defines the two points on the sphere that the orbit must pass through. For more information, see this parameter’s discussion in “Orbit Around” on page 470.

**Direction:** A pop-up menu that lets you set whether objects move around in a clockwise or counterclockwise direction.

**Related Behaviors**
“Attracted To,” “Attractor,” “Drift Attracted To,” “Drift Attractor,” “Orbit Around,” “Spring”

**Wind**
Apply the Wind behavior to an object to animate its position and move it in a specified direction. Unlike the Throw behavior, the velocity specified by the Wind behavior is a continuous force, and its parameters can be keyframed to achieve gradual changes in speed and direction.

The Wind behavior is better than the Throw behavior when you want to vary the speed of the object being animated. You can either apply another behavior (such as Randomize or Ramp) or keyframe the Velocity parameter of the Wind behavior to vary the speed and direction of the object. You cannot make gradual changes in either speed or direction with the Throw behavior.

**HUD Control**

**Note:** The HUD lets you specify the direction and speed of the Wind behavior by dragging an arrow within a circular region. The direction of the arrow defines the direction of movement in X and Y space, and the length of the arrow defines speed (velocity). A slider to the right lets you adjust the scale of the HUD control, increasing or decreasing the effect the control has over the object.

Press the Shift key while dragging the arrow to constrain it to 45 degree angles. Press the Command key to change the arrow’s direction without affecting its length.
When you click the 3D button, the HUD allows you to use the center arrow control to define the direction the object is “blown” by the wind in 3D. The Speed slider (on the left side of the HUD) lets you increase or decrease the velocity of the blown object.

*Note:* The maximum speed you can define with the HUD is not the maximum speed possible. Higher values can be entered into the Velocity parameter in the Behaviors tab of the Inspector.

**Parameters in the Inspector**

**Affect Subobjects:** This parameter appears when this behavior is applied to an object that contains multiple objects, such as a group, a particle emitter, a replicator, or a text layer. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the parent object are affected by the behavior together, as if they were a single object.

**Air Thickness:** A slider and value slider that adjusts how fast the object accelerates on the X, Y, or Z axis when the speed is changed. Lower values (simulating thinner air) have less effect when pushing the object, so it takes longer to get up to speed. Higher values (thicker air) have more effect and push the object up to speed more quickly.

**Velocity:** A slider and value slider that adjust the speed on the X, Y, or Z axis at which the simulated air is blowing the object. Higher values result in faster motion.

**Related Behaviors**

“Motion Path,” “Gravity,” “Random Motion,” “Throw”

**Behavior Examples**

The following examples illustrate different ways that groups of behaviors can be combined to create different effects.
Example 1: Creating an Animated Title

In this example, multiple Basic Motion behaviors are used to create elements of a title sequence. The background clip fades in, and graphic objects fade in, spin, grow, and move across the screen.

To create animated elements of a title sequence:

1. Arrange the first two graphics layers to determine their position in your composition.

   If you'd like to follow along, this example uses the “dolphin full.mov” file from the /Library/Application Support/Final Cut Studio/Motion/Sample Media/National Geographic folder, and the “circleText.psd” file from the /Library/Application Support/Final Cut Studio/Motion/Sample Media/Graphics folder. The “circleText” layer should be positioned above the dolphin clip in the Layers list.

   ![Image of dolphin and text]

   Note: If you are using the dolphin clip, move the playhead to frame 150 and press Command-Option-O to mark the play range out. The project loops from the end of clip.

2. While playing back the project (press Command–Space bar), select the two layers in the Layers list, click the Add Behavior icon in the Toolbar, and choose Basic Motion from the pop-up menu and Fade In/Fade Out from the submenu to apply this behavior to both layers at the same time.

   When more than one object is selected, the HUD is labeled “Multiple Selection.”

3. Command-click the two behaviors in the Layers list, and drag the left shaded ramp of the Fade In/Fade Out control in the HUD to the right to lengthen the fade-in effect.
The HUD title bar reads "Multiple Selection" to indicate you are adjusting two behaviors at the same time.

4 Drag the right shaded ramp all the way to the right, until it's a nonshaded, vertical edge.

This eliminates the fade-out part of the effect, so that the layers remain onscreen for the remainder of their duration.

5 Select the "circleText" layer, click the Add Behavior icon in the Toolbar, then choose Basic Motion from the pop-up menu and Spin from the submenu.

6 In the Spin HUD, click the top of the circle and drag in a counterclockwise direction to set the rate and direction of the spin.

7 With the "circleText" layer selected, press Command-D to duplicate the layer and its behaviors.
8 Reposition the duplicated layer in the Canvas, press Shift and drag one of the corner handles to uniformly scale down the layer.

9 With the duplicated layer selected, click the Add Behavior icon in the Toolbar, then choose Basic Motion from the pop-up menu and Motion Path from the submenu.

The layer moves from its original position toward the right and off the Canvas. Use the Motion Path’s Direction parameter to change the direction in which the layer travels over the motion path. The Direction parameter is only available in the Inspector.

10 Open the Inspector, and click the Behaviors tab. Choose Reverse from the Direction pop-up menu.

The layer now travels from right to left.

11 In the mini-Timeline (immediately below the Canvas), drag the end of the Motion Path behavior toward the left until its duration is 200 frames.

The layer moves faster along its path.
You can also shorten the path by moving its starting point closer to the Canvas.

*Note:* You can change the shape of the motion path by adding points or by selecting a preset shape, such as an ellipse or a rectangle. For more information, see “Motion Path” on page 411.

12 With the duplicated layer selected, click the Add Behavior icon in the Toolbar, then choose Basic Motion from the pop-up menu and Grow/Shrink from the submenu.

13 In the Behaviors tab, choose Ramp to Final Value from the Grow/Shrink behavior’s Increment pop-up menu and set Scale To to 125%.

The layer now scales to 125% of its original size, rather than growing indefinitely.

**Example 2: Using the Gravity and Edge Collision Simulation Behaviors**

Gravity makes an object fall over time at a rate specified in the Acceleration parameter. Unless other behaviors such as Edge Collision are also applied, the object falls off of the bottom of the Canvas (or moves beyond the top edge of the Canvas if a negative Acceleration value is used). In this example, a group comprised of four layers (circles) is used to illustrate the Gravity and Edge Collision behaviors.

*Note:* Although you can apply the Simulation behaviors to single objects, their strength is in using groups of objects. Some Simulation behaviors, such as Vortex, require the existence of another object in a project to have any effect. For example, an object with an applied Vortex behavior needs another object to circle around it; an object with an applied Orbit Around behavior needs an object to orbit around.

This example uses content available in Motion, so, if you want, you can follow along. In this case, Gravity is applied to a group (“circles 1”) that contains four layers (semi-transparent, colored circles).

**To use the Gravity behavior:**

1 Drag the “orangeCircles.psd” file from /Library/Application Support/Final Cut Studio/Motion/Sample Media/Graphics to the Canvas, holding down the mouse button until the drop menu appears.

2 Choose Import All Layers from the drop menu.

The imported Photoshop file consists of a single group of four layers, each layer a semi-transparent, colored circle. Because the Import All Layers command is used on import, the layers are imported as separate layers within a group.

3 Double-click the “orangeCircles” layer, type “circles1,” then press Return.

The layer is renamed.
4 Apply the Gravity behavior to the “circles 1” group.

The motion path created by the Gravity behavior appears in the Canvas, and the group of circles falls when you play the project. Because the behavior is applied to the group, all layers in the group fall at the same rate.

5 To increase the rate of the falling layer, drag the Acceleration slider in the Gravity HUD or Inspector toward the right (this example uses an Acceleration value of 100).

Note: You can enter a negative number in the Acceleration value field in the Inspector to make the layer float upward rather than fall.

To use the Edge Collision behavior:
1 Apply the Edge Collision behavior to the “circles1” group.
2 In the Edge Collision HUD (or Inspector), turn off Affect Subobjects.
When the Edge Collision behavior is applied to a group, and the Affect Subobjects parameter is turned off, the entire group is “bounced” off the bottom of the screen at the anchor point of the group.

3 In the Edge Collision HUD (or Inspector), turn on Affect Subobjects.

**Note:** The Edge Collision behavior Inspector parameters also include Active Edges controls for turning on and off the edge of the screen (or Z space) against which an object collides. By default, an object is deflected from all edges of the screen.

When the bottom edge of each circle hits the lower edge of the screen, the circles are deflected and bounce upward.

As the project plays, each circle bounces up and down.
Other Simulation behaviors that also use the Affect Subobjects parameter include Align To Motion, Drag, Gravity, Random Motion, and Rotational Drag.

**Example 3: Using the Orbit Around and Vortex Behaviors**

The Orbit Around behavior makes an object orbit around another object in a perfect circle. The parameters of the Orbit Around behavior can be modified to create a more interesting animation. The Vortex behavior is the opposite of the Orbit Around behavior—Orbit Around causes one object to orbit around another target object, whereas Vortex exerts a force on all objects surrounding the object to which the Vortex behavior is applied. The following examples use the same group of layers (circles) used in "Example 2: Using the Gravity and Edge Collision Simulation Behaviors" on page 487; however, the layers are repositioned in the Canvas.

**Using the Orbit Around Behavior**

You create animation using the Orbit Around behavior by specifying a target object that other objects circle around. You set the target object by dragging the object to the Object well in the Orbit Around Behaviors tab.

**To use the Orbit Around behavior:**

1. In the Layers list, click the Add button (+) to create a new group.
2. Option-drag the "sm circle" to the new group.
   A copy of the layer is added to the group.
3. Rename the "sm circle" to “center circle” and position the layer in the center of the Canvas.
4. Apply the Orbit Around behavior to the “circles 1” group.
The Orbit Around behavior is applied to the group of circles ("circles 1") in the project. The center circle in the center of the Canvas is in a separate group from the rest of the layers.

When the Orbit Around behavior is first applied, no animation occurs. This is because you must specify the layer that the group will orbit around.

5 Drag an object, in this case the "center circle" layer, from the Layers tab and drop it in the Object well of the Orbit Around HUD or Inspector. This object becomes the target object around which the other objects orbit.

You can alternately drag an object in the Layers tab onto the Orbit Around behavior.
Important: Dragging an object to a well may be tricky—be sure to click the object name in the Layers tab and immediately drag the layer to the Object well (without releasing the mouse button). The behavior must remain active even though you are clicking another object in the Layers tab. If you click the object you want to drag to the Object well and then release the mouse button, that object becomes selected, and the behavior’s parameters are no longer displayed. This is true of all wells, including Mask Source and Image wells. To show the Orbit Around behavior parameters again, select the Orbit Around behavior.

In the Orbit Around HUD (or the Inspector), make sure Affect Subobjects is turned on. When Affect Subobjects is turned on, all objects within the group move around the target object.

Other Simulation behaviors that also use a target object include Attracted To, Drift Attractor To, Repel From, and Spring.

Using the Vortex Simulation Behavior
Animation is created using the Vortex behavior by exerting a force on all objects surrounding the object to which the Vortex behavior is applied. You can specify whether All Objects, Related Objects, or Specific Objects are affected by the Vortex. The following example uses the project created in the previous example.
To use the Vortex behavior:
1 Using the result of the previous example, delete the Orbit Around behavior from the project.
2 Option-drag the “center circle” layer to the “orangeCircles” group in the Layers list.
   Note: If you want, rename the copied “center circle” layer. In this example, both layers (original and copied) are named “center circle.”
3 Apply the Vortex behavior to the “center circle” layer in the group above the group of circles.

By default, Related Objects is selected in the Vortex Affect parameter. When Related Objects is selected, all objects that exist in the same group as the object to which the behavior is applied move around that object. Because the circle is the only object in the group, nothing happens.
4 In the Vortex HUD, choose All Objects from the Affect pop-up menu.
When All Objects is chosen, all objects in the project—regardless of the group in which they exist—are affected and move around the object to which the Vortex behavior is applied.

Using the Vortex behavior, there are two ways to create an animation in which only certain objects (not every object in the project) swirl around the object with the applied Vortex behavior:

- Set the Affect parameter to Specific Objects and select each layer that you want to swirl around the target layer.
- Move the object with the applied Vortex behavior into the same group as the circle layers, and set the Affect parameter to Related Objects.

To affect only Specific Objects:
1. In the HUD or Inspector, set the Vortex Affect parameter to Specific Objects (without moving any layers).
2. If it is not displayed, show the Behaviors tab in the Inspector. In the Vortex parameters, an Affected Objects list appears.
3. To apply the vortex to specific objects, drag the objects from the Layers tab to the Affected Objects list. Like the Object wells, you can drop the object when the curved arrow appears above the list.

As layers are added, the names of the objects as well as the group in which they exist appear in the list. When a group is dragged to the Affected Objects list, all layers within that group are added to the list.

*Note:* Objects from any group in a project can be dragged to the Affected Objects list. To remove an object, select the object in the list and click Remove.
Any layers that are added to the Affected Objects list swirl around the layer to which the Vortex behavior is applied.

To affect only Related Objects:

1. In the Layers tab, move the object with the applied Vortex behavior into the group that contains the objects you want to affect. In this case, drag the “center circle” object from Group 1 into the “circles 1” group.

2. In the HUD or Inspector, set the Vortex Affect parameter to Related Objects. The objects in the group circle around the target object.

Note: Other Simulation behaviors that also use the Affect parameter include Attractor, Repel, and Drift Attractor.

Example 4: Creating a Clock Animation

In this example, two parameter behaviors are used to create an animated clock. By arranging the layers and their anchor points properly, each part’s motion can be created quickly and easily using the Rate and Oscillate behaviors.

Note: The source files for this example are not included in the Sample Media folder.
To create a clock animation:

1. Place the graphics layers constituting the hands, face, and pendulum into the Canvas, arranging them to create the clock.

   The hands are on top, the face in the middle, and the pendulum should be in the back.

   ![Clock Composition](image)

   By default, the anchor point is located at the center of each object. Prior to adding behaviors to animate these layers, you need to move the anchor points so that the layers move the way they’re supposed to. In this example, the hands should spin about the center of the clock face, not the center of the hand itself, and the pendulum should swing from its top.

2. Choose the Adjust Anchor Point tool, and move the anchor points of both hand layers and the pendulum layer to the center of the clock face.

   ![Adjusted Anchor Points](image)

   Now that the composition is set up to be animated, the only remaining thing to do is to assign behaviors to each of the layers.

3. Select the minute hand layer, open the Properties tab in the Inspector, Control-click the Rotation parameter, then choose Rate from the shortcut menu.

   ![Rate Selection](image)
The Rate Parameter behavior is applied to the Rotation parameter.

4 In the Behaviors tab, set the Rate parameter to –49.
This rotates the minute hand clockwise at a continuous rate.

5 Select the hour hand layer, Control-click its Rotation parameter in the Properties tab, then choose Rate from the shortcut menu.

6 In the Behaviors tab, set the Rate parameter to –4.
When you play the project at this point, you can see that the hour hand and minute hand rotate clockwise at rates replicating the relative movement of real clock hands.

**Tip:** To make the hands of the clock appear to “tick,” you can apply the Quantize Parameter behavior to the Rotation parameter of the hands and adjust the Step Size to accommodate your animation.

Now it’s time to make the pendulum swing. You should have already adjusted its anchor point to be at the top. This way, the bottom pendulum layer will swing properly.

7 Select the pendulum layer, Control-click the Rotation parameter in the Behaviors tab, then choose Oscillate from the shortcut menu.

8 In the Behaviors tab, set the Oscillate behavior’s amplitude to 20. The pendulum layer doesn’t swing so widely.

9 Increase the speed to 50.
This keeps with the overall fast-forward motion of the clock. You're done!
Whether you want to send clips flying around the screen or animate individual filter settings on the fly, keyframes allow you to modify any parameter over time with extreme precision.

This chapter discusses how to create and edit keyframes in Motion. Although behaviors are ideal for instantly adding complex motion or effects to an object, keyframes provide additional precision and flexibility. Keyframes ensure that a particular event happens on the exact frame you choose.

Most common effects utilize some keyframing. Whenever a movement or effect is timed to match a musical beat or a particular word in the soundtrack, a keyframe is the best tool for the job. Furthermore, any effect where multiple objects are affected in a coordinated way is usually the result of keyframing.

What Is Keyframing?
Keyframing is the process of assigning a specific parameter value to an object at a specific point in time. For example, you might want a clip to be scaled to fill the screen exactly five seconds into your project. When you set more than one keyframe, Motion generates the in-between frames, resulting in a smooth change of that parameter over time. This is called interpolation. For example, if you want a title to change from green to blue over time, you would set two keyframes at two different points in time. The first one would define the text’s color as green, and the second keyframe would set the color to blue. Motion automatically makes the frames between those points change smoothly from green to blue.

Motion lets you keyframe parameters such as color values, position, rotation, opacity, and almost every other parameter in the application.
Animation in Motion

There are several different places in Motion where you can create and edit keyframes and the values between them, which are represented by animation curves. For example, you can animate basic properties such as scale, rotation, and screen position by simply manipulating the object directly in the Canvas when the Record button is enabled.

When Record is enabled, a keyframe is created for any parameter that is adjusted. This includes parameters adjusted in the Canvas, Inspector, or HUD. In the Recording Options dialog (or press Option-A), you can enable the “Record keyframes on animated parameters only” option, which adds keyframes only to parameters that are already animated (keyframed)—even when Record is enabled. For more information, see “Recording Keyframes on Animated Parameters Only” on page 562.
You can also use the HUD and the Inspector to set and modify values for nearly every option in the application. Any time you adjust a slider or other control, you have the option of locking that change to the current frame, thereby setting a keyframe. From that point on, no matter what else you do, that parameter always finds its way to that specific value when playback reaches that frame.

You can also view and modify keyframes in the Timeline by clicking the Show/Hide Keyframes button. Keyframes appear as small blue (or white, when selected) diamonds beneath their parent object.
In the Keyframe Editor, you can see and manipulate a graph for every parameter in the application. Again, keyframes appear as diamonds, and the lines (or curves) connecting the keyframes indicate the values for the interpolated frames.

You can filter the parameter list to show only the channels and keyframes that you are interested in.

**Animating in the Canvas**

The easiest way to perform basic keyframing is to modify objects directly in the Canvas. The most common effects that you can create with keyframes are changes to Scale, Rotation, and Position. Additional parameters that can be keyframed in the Canvas include Shear, Pivot, Drop Shadow, Crop, and Four Corner. While many of these techniques can also be performed using behaviors, keyframing gives you the added flexibility to set specific values on precise frames.

Ordinarily, when you make transformations to an object in the Canvas, the object remains in the new position or shape for its entire duration. In order to create change in an object over time, you must create keyframes. There are several ways to create keyframes while working in the Canvas.

**Using the Record Button**

One of the simplest ways to create keyframes is to use the Record button. When Record is enabled, a keyframe is created for any parameter that is adjusted.

*Note:* When Record is enabled, keyframes are created whether you adjust the object onscreen, in the HUD, or in the Inspector.
When keyframing (Record) is enabled, the changes that you apply to the object are applied at the current playhead position (viewable in the mini-Timeline at the bottom of the Canvas). A keyframe is automatically added (though no indicator appears). If you move the playhead to a new position and change the shape or position of the object, you create a new keyframe. Motion automatically figures out the shape and position of the object during the frames between the two keyframes you set.

**Important:** When Record is enabled, a red keyframe appears in the center of the selected object. When moving the object in the Canvas, do not click the keyframe in the center of the object as you are actually selecting and repositioning that keyframe instead of the object's current position.

To scale an object over time using the Record button:

1. Click the Record button (or press A) to turn on keyframe recording. You can also choose Mark > Record Animation.
2. Select an object in the Canvas.
3. Move the playhead to a new time position.
4. Resize the object by dragging a scale handle.
5. Click the Record button (or press A again) to turn off keyframe recording.

The object is scaled over the interval you set. In this same way, you can keyframe any of the transformation parameters for your object.
You can also Control-click the object to display a shortcut menu with options for modifying the Pivot, Shear, Drop Shadow, Four Corner, and Crop parameters. For example, choose Transform from the shortcut menu to activate scale and rotation handles in the Canvas. For more information on object transformations in the Canvas, see “Object and Layer Transforms in the Canvas” on page 261.

When the Record button is on, each time you move the playhead to a new frame any change you make to an object automatically generates new keyframes. When animating an object’s position, an animation path is created.
**Note:** To view the animation paths of keyframed objects, ensure that Animation Path is selected in the View pop-up menu (in the upper-right corner of the main window, above the Canvas).

When the Record button is off, changes you make modify the entire animation globally. For example, if an object is keyframed to fly from the lower left to the center of the screen, dragging the object to the right when the Record button is off moves the entire path to the right.

**Note:** If you are positioned on a previously set keyframe, any changes you make modify that individual keyframe rather than the entire curve, regardless of whether the Record button is on or off.

**Applying Movement to a Clip**
Because moving objects onscreen is so fundamental to motion graphics, Motion makes it especially easy.

**To move an object across the screen:**
1. Click the Record button (or press A) to turn on keyframe recording.
2. Place the playhead at the starting frame.
3. Place the object in a starting position.

4. Move the playhead forward.
5. Drag the object to the ending position you want.

6. Click the Record button (or press A) to turn off keyframe recording.

If you play back your project, the object flies from position one to position two over the interval you set. You can see the path the object travels by turning on the Animation Path setting in the View pop-up menu above the Canvas.

**Important:** When Record is enabled, you can choose to only add keyframes to an object’s parameters that are already animated. This option is available in the Recording Options dialog. For more information, see “Recording Keyframes on Animated Parameters Only” on page 562.
Manipulating Animation Paths
When the animation path is displayed, you can directly manipulate the keyframes to reposition them and change the path that the object follows.

When dragging a keyframe in the Canvas, the control point number, as well as the X, Y, and Z position values, are displayed in an info window at the pointer position.

To add keyframes to an animation path:
1 Option-click the path.
   A new keyframe point is added.
2 Drag the keyframe point to the new position.
   You can convert a linear keyframe point into a Bezier keyframe point to create a curved path. This can be done either as you create the keyframe, or after the keyframe has been created.

To add a Bezier keyframe to an animation path:
- Option-click the path, then immediately drag away from the point.
   A point is added and a Bezier handle appears.

To change an existing keyframe into a Bezier point:
- Command-click the keyframe and drag away from the point.
   Handles are added to the keyframe.

Animation path control points are modified in the same manner as shape or mask Bezier points. For more information on manipulating Bezier splines, see “Drawing Masks and Shapes Using Bezier Splines” on page 1000.

Animating with the HUD
To keyframe the parameters that appear in the HUD, you follow the same procedure as keyframing directly in the Canvas. For example, when an object is selected in the Canvas, the HUD gives quick access to the object’s opacity. If you want to make a custom effect such as a temporary dip to black, you would keyframe the opacity parameter.
To animate a clip's opacity:
1. Click the Record button (or press A) to turn on keyframe recording.
2. Place the playhead at the frame where you want to begin the fade.
3. Click the Opacity slider handle in the HUD.

Even if you don't change the slider's value, clicking it sets a keyframe at that point in time. This way the object remains at its previous opacity from the beginning of the clip until that new keyframe, then begins the interpolation toward the next keyframe.

4. Move the playhead forward to a new time.
5. Change the Opacity value.
6. Move the playhead forward again.
7. Change the Opacity slider again.
8. Click the Record button (or press A) to turn off keyframe recording.

Keyframes at the Beginning and End of the Curve
When you begin adding keyframes, you instruct Motion to automatically modify the in-between frames to interpolate the effect. But what values are used for the frames before the first keyframe and after the last one?

By default, when you add your first keyframe, that same value is extended forward and backward to the beginning and end of the clip (just the same as if you hadn't added a keyframe at all).

Once you add a second keyframe, the effect begins to change over time. But the frames before that first keyframe remain at the value of that first keyframe. Similarly, the frames after the last keyframe hold at that last defined value.

You can override this default behavior to create loops and other patterns by using the Before First Keyframe and After Last Keyframe submenus as described in the “Extrapolation” section later in this chapter.
Animating Filters
In addition to making changes to a clip's basic attributes, keyframing can be used to modify nearly every parameter in the application. When the Record button is activated, any parameter displayed on the HUD becomes keyframeable. For example, as you apply filters to objects, the most important parameters are displayed on the HUD. Using keyframes, you can animate those parameters. In this way, you can create a shot that grows more blurry over time, or animate the width of a bevel effect.

To animate a filter:
1 Select an object that you want to modify.
2 Apply a filter to the object.
   The HUD changes to display the parameters for the filter. For more information on how to apply filters, see “Working with Filters” on page 842.
3 Click the Record button (or press A) to turn on keyframe recording.
4 Place the playhead where you want the effect to begin changing.
5 In the HUD, set the parameter slider you want to animate to a beginning value.
6 Move the playhead to the frame where you want the effect to stop changing.
7 Set the slider to a new value.
Click the Record button (or press A) to turn off keyframe recording.

The filter now changes over time to reflect your settings. This same technique can be applied to any parameter in any filter that appears in the HUD.

**Animating Behaviors**

In addition to animating filter parameters, you can also animate behaviors. Animating behaviors might appear complicated at first because most of the behaviors are already changing, but combining these features is a powerful way to greatly enhance behaviors’ usefulness. For example, you might want to animate a Random Motion behavior to begin as a subtle random motion and then become increasingly severe as the effect progresses. Or you might want to apply a Gravity behavior, but you don’t want the object to start falling toward the ground until five seconds into the clip. Keyframes allow you to manipulate the specific parameters of each behavior.

*Note:* In Motion, you can bake all the behaviors that have been applied to an object into keyframes using the Convert to Keyframes command in the Object menu. For more information, see “Converting Behaviors to Keyframes” on page 404.

**To animate a behavior:**

1. Select an object in the Canvas.
2. Apply a behavior.
3. Click the Record button (or press A) to turn on keyframe recording.
4. Place the playhead at the frame where you want the effect to begin changing.
5. Using the HUD, adjust the behavior’s settings.
6. Move the playhead to a new time position.
7. Adjust the behavior settings again.
8. Click the Record button (or press A) to turn off keyframe recording.
Combining Behaviors and Keyframes

Because it is possible to add keyframes to an object that may already have a behavior (or many behaviors) applied, it is possible that these two methods could conflict. For example, you might apply a Throw behavior toward the upper left, and at the same time add keyframes that instruct the object to move to the right. Now what?

![Behavior motion path](image1.png) ![Keyframe motion path](image2.png)

The way Motion handles this sort of conflict is that the instructions are added together, giving you a combination of the two sets of instructions. In the above example, the object would move toward the upper left, but it won’t get as far, because the keyframes are pushing it in an opposing direction.

![Combined motion path](image3.png)

The larger the Throw velocity rate, the more it overpowers the keyframes, and vice versa.
Once you get the hang of how it works, you can use this method to enhance and control the effects of behaviors. For example, you could apply a Gravity behavior which causes an object to fall toward the bottom of the frame, but keyframe the object’s position to move across the screen from left to right. In this way, you can create the effect of the object falling as it moves. Or you might apply a Fade In/Fade Out behavior, but use keyframes on the object’s Opacity parameter to limit the maximum opacity to 80%. The clip would still fade in and out and you could continue to modify the behavior’s attributes, but the object would never exceed the opacity value set by the keyframes.

One method for handling behaviors and keyframes is to convert behaviors to keyframes. For more information on converting behaviors to keyframes, see “Converting Behaviors to Keyframes” on page 404.

**Animating Using the Inspector**

Although you can animate many attributes using the HUD, many other parameters are only accessible in the Inspector. All of the Inspector’s tabs contain keyframeable parameters. In this way, you can animate the position and shape of a mask, the color and styles of a text object, or the various options within the generators. The parameters that are keyframeable depend on which object is selected and which effects have been applied to that object.

You can animate parameters in the Inspector using the Record button and the mini-Timeline playhead just like you would animate parameters in the Canvas or HUD.

**To animate parameters in the Inspector:**

1. Select the object you want to keyframe in the Canvas.
2. Click the Record button (or press A) to turn on keyframe recording.
3. Place the playhead on the frame where you want the effect to begin.
4. Display the Inspector by clicking the tab or rearranging the screen layout to one that includes the Inspector. For more information on layouts, see “Preset Layouts” on page 23.
5 Click the Inspector tab where the parameter you want to modify is located (filters in this example).

6 Set the parameter to the beginning value.
7 Move the playhead to a new position.
8 In the Inspector, change the parameter to a new value.
9 Click the Record button (or press A) again to disable record.

The parameter now changes over time.

**Animation Menu**

Animating in the Inspector provides additional options, such as the ability to delete or reset keyframe information. You can also navigate between keyframes in the Inspector. Every keyframeable parameter contains an Animation menu. If a parameter lacks a menu, it cannot be animated.
**Enable Animation:** This menu item remains unavailable until animation is applied to the parameter either by using the Record button or by directly adding a keyframe. Once the parameter has at least one keyframe set, the menu item is automatically renamed Disable Animation. Choosing Disable Animation at that point effectively hides the keyframes you have set, restoring the parameter to its default value. However, the keyframes are not thrown away. Choosing Enable Animation again restores the parameter to its last keyframed state.

**Reset Parameter:** Removes all keyframes and settings for this parameter. The parameter value is reset to its default value.

**Add Keyframe:** Adds a keyframe at the current frame in the project. If the playhead is positioned on a frame where a keyframe has already been added, this menu command is unavailable.

**Note:** To add a keyframe, you can also position the pointer over the Animation menu and press Option. When the keyframe icon appears next to the point, click to add a keyframe.

**Delete Keyframe:** Deletes the current keyframe. The Delete Keyframe option is only available if the playhead is positioned on a frame where a keyframe already exists.

**Previous Keyframe:** Moves the playhead to the previous keyframe for this parameter. The Previous Keyframe command is only available if a keyframe exists earlier in the project.

**Next Keyframe:** Moves the playhead to the next keyframe for this parameter. The Next Keyframe command is only available if a keyframe exists later in the project.

**Show in Keyframe Editor:** This opens the Keyframe Editor and displays the selected parameter’s keyframes and curves. For more information on working with the Keyframe Editor, see “Animating in the Keyframe Editor” later in this chapter.

**To set keyframes using the Animation menu:**

1. Enable Record (press A), then move the playhead to the frame where you want to set the first keyframe.
2. Change the value of the parameter you want to keyframe.
3. Click the Animation menu, then choose Add Keyframe. A keyframe is added at the current frame.
4. To set another keyframe for the same parameter, move the playhead to the next location and adjust the parameter. A keyframe is automatically added when you change the parameter.

To navigate to a keyframe:
1. Click the Animation menu for the parameter containing the keyframe you seek.
2. Choose Previous Keyframe if the desired keyframe is earlier in time than the current time position, or choose Next Keyframe if the desired keyframe is later in time than your current time position.

*Note:* You can also choose Mark > Go To > Previous Keyframe (or press Option-K) or Next Keyframe (or press Shift-K) to move from keyframe to keyframe.

To delete a keyframe:
1. Navigate the playhead to the frame where the keyframe is currently set.
2. Click the Animation menu for the parameter you want to change, then choose Delete Keyframe.

*Note:* To delete all of the keyframes for a parameter, choose Reset Parameter from the Animation menu.

To reset all keyframes for a parameter:
- Click the Animation menu for the parameter you want to reset, then choose Reset Parameter.

All keyframes are removed for that parameter.

**Animation Menu States**
Depending on whether or not a parameter is currently animated, and whether or not the playhead is positioned on a keyframe, the Animation menu displays a different icon. This provides the ability to determine the status of that parameter at a glance.
**The Reset Button**
Each parameter set in the Inspector is equipped with a reset button. A parameter set might be a filter, or it might be a category of effects or transformations, such as Transform, Blending, or other items in the Properties tab.

The reset button removes all keyframes applied to all of the parameters within the set and restores those parameters to their default state.

**Animating in the Timeline**
When keyframing, it is often very helpful to view your keyframes over time. This lets you line up keyframes with other important timing elements in your project such as edit points, sound cues, markers, and even other keyframes. These functions are available in the Timeline.

In order to view your keyframes in the Timeline, you must first turn on the Show Keyframes option.
To show keyframes in the Timeline:
- Click the Show/Hide Keyframes button.

You can identify a keyframe's value in the shortcut menu. Multiple keyframes on the same frame are all listed in the menu.

To display a keyframe's value:
- Control-click the keyframe in the Timeline.

A shortcut menu appears. The first items in the list are the keyframe values for any keyframes on that frame.

Note: There is no way to add keyframes in the Timeline.

Modifying Keyframes in the Timeline
When keyframes are visible in the Timeline, you can change their positions in time by dragging them horizontally in the track. This does not modify the keyframe's parameter value, it just changes the position in time when the keyframe occurs.

To move a keyframe in the Timeline:
1. Click the Show/Hide Keyframes button in the Timeline.

Any keyframes in the project become visible.
2 Identify the object where the keyframe is located.

3 Drag the keyframe to the left or right to move it forward or backward in time.

Although moving a keyframe in time does not change the parameter’s value, it can have a significant effect on the nature of the animation. For example, if you have two keyframes that animate an object from the top of the screen to the bottom over five seconds, moving one of the keyframes forces the animation to occur more slowly (if you drag them farther apart) or more quickly (if you drag them closer together).

When there are multiple keyframe values set in the same frame, you can choose any value to edit individually, though the values are represented by a single keyframe marker in the Timeline.

To edit a keyframe value already present in the Timeline:

1 Control-click the keyframe.

A shortcut menu appears. The first items in the list are the keyframe values for any keyframes on that frame.

2 Choose the keyframe value you wish to edit.

3 Type a new value into the value field, then press Return.

   Note: To exit an active value field without making any changes, press Esc.

Aligning Keyframes with Other Objects

One of the main advantages of manipulating keyframes in the Timeline is the ability to line up a keyframe with another i

4 Identify the keyframe you want to move.
Note: Control-clicking a keyframe in the Timeline displays a shortcut menu containing the parameter name and value for each keyframe. If more than one keyframe is at the same point in time, the shortcut menu lists all of them.

5 Drag the keyframe until it lines up with the edge of the object.

If you press the Shift key while you drag, the keyframe snaps to the edges of other objects.

You can use this same technique to align keyframes from one object to keyframes in another object. In this way, you can arrange two objects to both fade in or blur into focus at exactly the same frame. It doesn't matter whether the objects are in the same group or not.

1 To align keyframes of multiple objects Click the Show/Hide Keyframes button in the Timeline.

Any keyframes in the project become visible.

2 Identify the keyframe you want to move.

3 Find the object containing the parallel action.

4 Drag the keyframe in the first object until it lines up with the corresponding keyframe in the second object.

Aligning Keyframes to Markers
Other objects in your Timeline can also serve as guides for where to move your keyframes. For example, you may have a music cue or line of narration where you want a particular effect to end or change.
One great way to do this is to use time markers. Simply identify the important frame with a marker and drag the keyframe until it lines up with the marker. Markers create snap points, so pressing Shift while you drag a keyframe makes it snap to markers. To learn more about setting markers, see “Adding Markers” on page 362.

**To align a keyframe with a marker:**
1. Click the Show/Hide Keyframes button in the Timeline.
   Any keyframes in the project become visible.
2. Identify the keyframe you want to move and drag it to the marker.
3. Press the Shift key while you drag to enable snapping.
   The keyframe snaps to the marker.

**Deleting Keyframes in the Timeline**
If you ever need to remove a keyframe, or clear all keyframes from a particular object, you can delete keyframes using the shortcut menu in the Timeline.

**To delete a keyframe in the Timeline:**
1. Click the Show/Hide Keyframes button in the Timeline.
   Any keyframes in the project become visible.
2. Control-click the keyframe you want to delete, then choose Delete Keyframe from the shortcut menu.

**To delete all keyframes from an object:**
1. Click the Show/Hide Keyframes button in the Timeline.
   Any keyframes in the project become visible.
2. Control-click any keyframe for the object you want to clear, then choose Delete All Keyframes from the shortcut menu.

   For more precise control of effects using keyframes, you can use the Keyframe Editor. Any keyframe in the Timeline can be viewed in the Keyframe Editor using the shortcut menu.

**To view a keyframe in the Keyframe Editor:**
- Control-click the keyframe in the Timeline, then choose Show in Keyframe Editor from the shortcut menu.

   The Keyframe Editor is brought to the front and the keyframe (and the rest of that parameter) is highlighted in the graph.
Trimming Keyframed Effects
When the duration of an effect such as a filter or behavior in the Timeline is changed, keyframes applied to that object are scaled accordingly. This means that an effect keyframed to change over time speeds up or slows down if the object it is applied to is shortened or lengthened.

Changing the duration of an object does not modify keyframes applied to attributes in the Properties or Object tab in the Inspector. Keyframes appear in the area underneath the object bar if you choose to show keyframes in the Timeline.

You can also speed up or slow down a keyframed effect by resizing the effect bar in the Timeline.
You can prevent this automatic resizing by pressing Command while resizing an effect object. This changes the overall duration of the effect, but does not alter the speed at which the effect changes as determined by the keyframes.

Pressing Command while you resize an object with effects applied trims the object without trimming the effects. This works the same way as trimming a group without modifying the durations of the component elements.

**Animating in the Keyframe Editor**
Whenever you create two or more keyframes, Motion generates interpolated values for the frames that come between. These are called curves. The Keyframe Editor is the control that allows you to view and make modifications to those curves. This feature provides one of the most sophisticated and powerful ways to modify the objects and effects in your project.
Viewing the curves for your animated parameters gives you another way to understand how your effect is changing over time. The curves are laid out over a graph where you can compare the curves of different parameters. As you get more familiar with “reading” the graphs, you will learn how and why certain effects feel organic or synthetic.

In the Keyframe Editor you can add and delete keyframes, as well as move them in two-dimensional space to modify their values (up-down) and their positions in time (left-right). You can also directly manipulate the curves themselves with the tools Motion provides. Furthermore, you can define a variety of interpolation methods, creating dramatically different types of effects. You can also apply Parameter behaviors directly to curves in the Keyframe Editor by Control-clicking the curve name and choosing a Parameter behavior from the shortcut menu. For more information about Parameter behaviors, see “Parameter Behaviors” on page 430.

For example, in the real world, when objects move, they observe rules of physics, such as inertia and momentum. Motion’s Keyframe Editor allows you to simulate these sorts of effects in your motion graphics.

**Check Your Selection**

The parameters that are available in the Keyframe Editor depend on which objects are selected in the other windows. If you select one item in the Layers tab, Canvas, or Timeline windows, only parameters for that object are accessible in the Keyframe Editor.

If you want to compare curves from parameters across multiple objects (for example to make two separate objects begin fading in at the same time), you must select both items in the Layers tab or in another window. Then parameters for both objects are listed in the Keyframe Editor.

Additionally, you can modify curves on an group if it is selected instead of the objects within it. In this way, you can view or modify keyframe activity that affects all of the objects within the group.
To display the Keyframe Editor, do one of the following:

- If the Timing pane is already visible, click the Keyframe Editor tab in the Timing pane.
- Choose Window > Keyframe Editor.
- Press Command-8.

**Parts of the Keyframe Editor**
The Keyframe Editor is made up of a list of parameters on the left and a multifunctional graph on the right.

**Current Frame Field**
This field lets you instantly jump to any frame in your project. Because it is also a value slider, you can drag in the field to move the playhead to a new frame.

To move to a frame, do one of the following:

- Double-click in the value field, type a frame number, then press Return. The playhead moves to the specified frame.
- Drag the current frame value slider left or right. Dragging to the left moves the playhead earlier in time. Dragging to the right moves it forward in time.

**Keyframe Tools**
There are three different tools available to assist in editing keyframes and curves in the Keyframe Editor. For more information about using these tools, see “Modifying Keyframes” on page 538.

**Edit:** Select and edit keyframes.

**Sketch:** Draw curves with keyframes.
Box: Drag a selection box to enclose and manipulate keyframes.

**The Parameter List**

Any keyframeable parameters of your selected items can be displayed in the list on the left side of the Keyframe Editor tab. This includes object properties, filters, and behaviors. By selecting multiple items in the Layers tab or Timeline, you can compare parameters across multiple objects.

**Activation checkbox:** The checkbox on the left determines which parameters are displayed in the graph. Checked parameters are considered “active.”

**Parameter name column:** The second column lists the object name and the parameter names for each object.

**Value column:** The third column displays the parameter value for the frame where the playhead is currently positioned. If the playhead is parked on a keyframe, the field shows the value for that keyframe. If the playhead is not parked on a keyframe, the field shows the value of that parameter at that frame. For more information on changing the values of keyframes, see “Modifying Keyframes” on page 538.

You can click the value to activate the field. When Record is enabled, a keyframe is automatically added if you click the value field at a frame that has no keyframe. To type a value in the field, double-click it.

**Note:** Selecting a keyframe does not display the value of that keyframe, it shows the value for a parameter at the frame where the playhead is currently positioned.

**Animation menu:** The fourth column contains a pop-up menu that mimics the Animation menu found in the Inspector. However, the Animation menu in the Keyframe Editor contains several commands not found in the Inspector.

- **Enable/Disable Animation:** This command remains unavailable until keyframing is applied to the parameter, either by using the Record button or by directly adding a keyframe. Once the parameter has some animation applied, the command is automatically renamed Disable Animation. Activating it at that point effectively hides the keyframes you have set, restoring the parameter to its default value. However, the keyframes are not thrown away. Choosing Enable Animation restores the parameter to its last keyframed state.
• **Reset Parameter:** Removes all keyframes and settings for this parameter. The parameter value is reset to its default value.

• **Add Keyframe:** Adds a keyframe at the current frame in the mini-Timeline. If the playhead is positioned on a frame where a keyframe has already been added, this command is unavailable.

  *Note:* As mentioned in the Animation menu section, you can use a keyboard shortcut to quickly add a keyframe by pressing Control-K. A keyframe is automatically added to the last modified parameter of the object.

• **Delete Keyframe:** Deletes the current keyframe. The Delete keyframe command is only available if the playhead is positioned on a frame where a keyframe already exists.

• **Previous Keyframe:** Moves the playhead to the previous keyframe for this parameter. The Previous Keyframe command is only available if a keyframe exists earlier in the project.

• **Next Keyframe:** Moves the playhead to the next keyframe for this parameter. The Next Keyframe command is only available if a keyframe exists later in the project.

• **Interpolation:** Sets the type of curve for the parameter. See the table in the “Modifying Curves” section later in this chapter for examples of the different interpolation methods. Choose from Constant, Linear, Bezier, Continuous, Ease In, Ease Out, Exponential, or Logarithmic.

• **Before First Keyframe:** Defines what happens between the first keyframe and the beginning of the clip. See the table in the “Extrapolation” section later in this chapter for examples of the different extrapolation methods. Choose from Constant, Linear, Ping Pong, Repeat, or Progressive. You can also turn the extrapolation into actual keyframes by choosing Generate Keyframes.

• **After Last Keyframe:** Defines what happens between the last keyframe and the end of the clip. See the table in the “Extrapolation” section later in this chapter for examples of the different extrapolation methods. Choose from Constant, Linear, Ping Pong, Repeat, or Progressive. You can also turn the extrapolation into actual keyframes by choosing Generate Keyframes.

• **Lock/Unlock Parameter:** Locks this parameter from further changes. When a parameter is locked, neither keyframes nor curves are adjustable.
• **Reduce Keyframes**: Applies a *thinning* algorithm to the keyframes for the chosen parameter. This reduces the number of keyframes in a parameter while attempting to maintain a similar shape to the curve. The thinning algorithm can be adjusted in two ways. Increasing the Maximum Error Tolerance results in fewer keyframes. Increasing the Smoothing Factor makes smoother curves between keyframe values.

![Reduce Keyframes](image)

• **Set to Curve Snapshot**: If “Take/Show curve snapshot” is turned on (in the lower-left corner of the Keyframe Editor), this option will revert any keyframe changes made in the currently selected curve back to the most recent snapshot. For more information, see “Curve Snapshots” on page 538.

**Filtering Controls**
Effective use of the Keyframe Editor requires controlling the list of parameters currently on display in the graph area. While you may want quick access to all of the different parameters you may be animating, displaying too many parameters at once makes the graph difficult to read. Motion provides the ability to store sets of parameters to facilitate this management.

**Show Pop-Up Menu**
The Show pop-up menu allows you to display ten built-in parameter curve sets as well as custom sets you build yourself.

![Show Pop-Up Menu](image)

To view all of the parameters for all selected objects:
- Choose All from the Show pop-up menu.
By default, only the animated parameters are active in the graph. Turn individual parameters on and off by clicking the checkbox to show or hide them in the graph. You can choose to display all parameters associated with a particular group or object by checking or unchecking the checkbox for that group or object.

Alternatively, you can elect to view only the parameters that are currently animated—in other words, parameters that already contain one or more keyframes.

To view only animated (keyframed or behavior-influenced) parameters, do one of the following:

- Choose Animated from the Show pop-up menu.
- With the Keyframe Editor active, press U.
  
  Any parameters with one or more keyframes are displayed.

To view parameters that have been changed from their default values, do one of the following:

- Choose Modified from the curve set list pop-up menu.
- With the Keyframe Editor active, press Y.
  
  This option shows only the parameters that have been modified from their default values, or are currently being modified (in the Canvas, Inspector, or HUD).

To view only parameters that are currently active:

- Choose Active from the Show pop-up menu.
  
  When Active is selected and you are moving an object around in the Canvas, the X and Y Position parameters and curves are displayed.

Related Curve Sets

Motion provides a few built-in curve sets for quick parameter access. If you need to check the position of several related objects in a project, using the Position curve set makes this a lot easier. Multiple related curve sets can be displayed at the same time so you won’t have to switch back and forth between them. Each of these built-in curve sets has an associated keyboard shortcut.
To view only the Position parameters for a selected object, do one of the following:
- Choose Position from the Show pop-up menu.
- With the Keyframe Editor active, press P.
  The Position parameters for the selected object are displayed.

To view only the Rotation parameters for a selected object, do one of the following:
- Choose Rotation from the Show pop-up menu.
- With the Keyframe Editor active, press R.
  The Rotation parameters for the selected object are displayed.

To view only the Scale parameters for a selected object, do one of the following:
- Choose Scale from the Show pop-up menu.
- With the Keyframe Editor active, press S.
  The Scale parameters for the selected object is displayed.

To view only the Shear parameters for a selected object, do one of the following:
- Choose Shear from the Show pop-up menu.
- With the Keyframe Editor active, press H.
  The Shear parameters for the selected object are displayed.

To view only the Anchor Point parameters for a selected object, do one of the following:
- Choose Anchor Point from the Show pop-up menu.
- With the Keyframe Editor active, press A.
  The Anchor Point parameters for the selected object are displayed.

To view only the Opacity parameter for a selected object, do one of the following:
- Choose Opacity from the Show pop-up menu.
- With the Keyframe Editor active, press O.
  The Opacity parameter for the selected object is displayed.

**Custom Parameter Sets**

In addition to using the built-in curve sets, you can make your own. As you create and store custom parameter sets, they appear in the Show pop-up menu so you can switch quickly between them. Deleting, duplicating, and modifying custom sets is done in the Manage Curve Sets dialog.

**To create a new parameter set:**

1. Choose New Curve Set from the Show pop-up menu.
   A dialog appears.
2. Type a name for the set, then click OK.
Once your set has been created, you can choose it from the Show pop-up menu.

**To add parameters to a custom parameter set, do one of the following:**
- Drag the parameter from any of the tabs in the Inspector directly into the Keyframe Editor.
- Click the Animation menu for that parameter, then choose Show in Keyframe Editor.

The parameter is added to the custom curve set.

**Note:** If Animated is chosen from the Show pop-up menu when you use the Show in Keyframe Editor command from the Animation menu, a new untitled curve set is automatically created.
With the Keyframe Editor active, hold down the Shift key and press one of the keyboard shortcuts for the built-in relative curve sets.

*Note:* If you press the same relative curve set keyboard shortcut more than once sequentially, you create a new custom curve set with a new name each time.

**To delete parameters from a custom set:**
- Drag the parameter out of the list. It disappears with a “poof.”

**To delete all parameters from a custom set:**
- Click the “Clear curve list” button.

**To delete a custom parameter set:**
1. Choose Manage Curve Sets from the Show pop-up menu.
   - The Manage Curve Sets dialog appears.
2. Select the name of the set you want to delete.
3. Click the Delete (-) button at the top of the dialog.
   - The set is deleted.
4. Click Done to close the dialog.
To duplicate a custom parameter set:
1 Choose Manage Curve Sets from the Show pop-up menu.
   The Manage Curve Sets dialog appears.
2 Select the name of the set you want to duplicate.
3 Click the Duplicate button at the top of the dialog.
   The set is duplicated.
4 Double-click the set name in the list, then type a new name for the set.
5 Click Done to close the dialog.
   The new set now appears in the Show pop-up menu. These sets are saved with the
   project, so each time you reopen the project, they are available to you. Store as many
   parameter sets as you like. Once you have a set stored, you can change or delete that
   set as needed.

Curve Graph
A graph appears to the right of the parameter list and displays the curves for your
selected parameters. The graph has a time ruler at the top and a zoom/scroll control at
the bottom that are identical to the corresponding controls in the Timeline. These allow
you to identify at what time keyframes appear, as well as see project markers, playback
In and Out points, and the playhead. Using the zoom controls at the bottom of the
graph, you can zoom in to obtain much more precise control over keyframe
positioning and curve shape. For more information on using the zoom/scroll controls,
see “Zooming in the Timeline” on page 93.

The body of the graph displays the keyframes and curves of active parameters. Each
parameter is a different color, though some colors are duplicated.

Saving Animation Curves
Animation curves can be saved in an existing folder in the Library, such as the Favorites
category, or you can create a new folder within an existing category. Once an
animation curve is placed into the Library, it can be added to an object in any project.
Animation curves saved in the Library appear with a custom icon.

Note: Items that are saved to the Library appear in the Finder with a .molo extension
(“Motion Library object”). These items cannot be opened from the Finder.

You can save multiple curves to the Library as one file or multiple files. For example, if
you create an animation that uses multiple curves and you want to save the cumulative
effect of the animation, you can save all of the curves as one item in the Library.
Although you can save animation curves into the Content category, it is generally recommended that you save items that you use frequently in the Favorites category—some Motion Library categories contain so many items that utilizing the Favorites or Favorites Menu categories may save you search time. Within the Favorites category, you can create additional folders to assist you in better arranging your custom items.

You can also create new folders in existing categories. You can create a new folder in the Favorites, Favorites Menu, or Content category. Folders created in the Content category appear in the Library sidebar. Folders created in the subcategories, such as the Basic Motion subcategory, appear in the Library stack and not the sidebar. For more information on creating folders in the Library, see “Saving and Sharing Custom Behaviors” on page 405.

Animation curves that are saved to the Favorites Menu category can be quickly applied to objects using the Favorites menu.

**To save an animation curve to the Library:**
1. Open the Library and select the Content, Favorites, or Favorites Menu category.
2. Drag the name of the parameter animation curve you want to save from the parameter list in the Keyframe Editor into the stack at the bottom of the Library.

When you save an animation curve, it’s saved in the `/Users/username/Library/Application Support/Final Cut Studio/Motion/Library` folder.

**Note:** If an animation curve is dragged to another subcategory, such as the Glow (Filters) subcategory, it is automatically placed in the Content category and the Content category becomes active.

**To save multiple animation curves to the Library:**
1. Open the Library and select the Content, Favorites, or Favorites Menu category.
2. In the parameter list of the Keyframe Editor, select all of the animation curves you want to save and drag them to the stack, holding down the mouse button down.
3. When the drop menu appears, choose “All in one file” or “Multiple files.”
   “All in one file” saves all the animation curves together, listed as one item in the Library.
   “Multiple files” saves the curves as individual items in the Library.
4. To name the file or files, do one of the following:
   - Control-click its icon in the Library stack, choose Rename from the shortcut menu, then type a new descriptive name.
   - Select the icon, click its name, then type a new descriptive name.
**Note:** When you Control-click an animation curve icon in the Library stack, the Edit Description shortcut menu item becomes available. This is a handy tool that allows you to enter custom notes about an item saved in the Library. Once you choose Edit Description, enter your notes in the text field, then click OK.

**Modifying Keyframes**
The Keyframe Editor provides an ideal environment for manipulating your keyframes because you can see their values, placement in time, and how the changes you make affect the interpolative curves surrounding your keyframes.

**Curve Snapshots**
When modifying keyframes, it is often helpful to have a frame of reference for your curves. This is useful both as a guide as you’re editing, and as a safety net in case you make some changes, then decide to go back to your curve’s original state.

**To take and show curve snapshots:**
- Click the “Take/Show curve snapshot” button at the bottom of the Keyframe Editor.

Now, as you move keyframes in the Keyframe Editor, the original curve— as it appeared when you took the snapshot— is represented by a lighter color. As long as you remain in the Keyframe Editor editing the current set of curves, the snapshot curve will remain available.

If, after editing a curve, you wish to revert back to the snapshot, you can do so from the Animation menu in the Keyframe Editor.

**To revert a curve back to its most recent snapshot:**
- From the Animation menu in the Keyframe Editor, select Set to Curve Snapshot.
  The curve reverts to the state of its last snapshot.
**Important:** If you leave the Keyframe Editor, or load a different set of curves into the Keyframe Editor, curve snapshots are taken again, replacing the previous curve snapshots.

**Using the Edit Tool**

To use the following set of instructions, first select the Edit tool from the Keyframe tools in the Keyframe Editor.

**To change the value of a keyframe, do one of the following:**

- Click the keyframe you want to modify, then drag the keyframe along the Y axis (up and down) to change its value. To change its position in time, drag along the X axis (left to right).

  Press the Shift key while dragging to constrain movement to one axis.

  When dragging a keyframe in the graph, numbers appear indicating the new position and value of the keyframe. The first number is the frame number and the second number is the parameter value.

When you drag two keyframes closer together along the X axis, the transformation between those values happens more quickly. When you drag keyframes farther apart from each other, the change happens more slowly.

- Double-click the keyframe you want to modify, type the new value into the value field, then press Return.
This changes the value of the keyframe along the Y axis (up and down).

**Note:** To get out of an active value field without making any changes, press Esc.

- Drag in the value slider in the parameter list.

- Drag to the right to increase the value of the keyframe along the Y axis.
- Drag to the left to decrease the value of the keyframe along the Y axis.
- Press Shift while dragging to change the value in increments of 10.
- Press Option while dragging to change the value in increments of .01.

In addition to modifying existing keyframes, you can add and delete keyframes right in the graph.

**To add a keyframe:**

1. Press the Option key and move the pointer over the parameter curve you want to modify.
   The pointer turns into a plus (+).
2. Click the curve at the frame where you want the keyframe to appear.
3. Drag the keyframe to your preferred value.

**Note:** You can also add a keyframe at the current playhead position by choosing Add Keyframe from the Animation menu for any parameter, or by double-clicking the curve.

Curves created when new keyframes are added are set to the Bezier interpolation method. For more information on interpolation methods, see “Modifying Curves” on page 545.

**To delete a keyframe, do one of the following:**

- Select the keyframe, then press Delete.

  **Note:** You can drag to select multiple keyframes.

- Control-click the keyframe, then choose Delete from the shortcut menu.

- Navigate to the keyframe, then choose Delete Keyframe from the Animation menu for that parameter.

**To delete all of the keyframes for a parameter:**

- Click the Animation menu in the parameter list, then choose Reset Parameter.

  **Note:** You can also use the Animation menu in the Inspector.
Controlling Keyframes
In addition to deleting keyframes, you can lock or disable them. Also, there are special settings in the shortcut menu for keyframes that you can apply to control the shape of your curve. For more information, see “Modifying Curves” on page 545.

To lock or disable a keyframe:

- Control-click the keyframe you want to modify, then choose Lock or Disable from the shortcut menu.

  **Lock:** Prevents any further modification to that keyframe.

  **Disable:** Makes a keyframe temporarily ignored without deleting it.

Copying and Pasting Keyframes and Animation Curves
Keyframes and the animation curves they form can be moved from one parameter to another using copy and paste commands. This technique can be useful for copying a particular keyframe effect from one object to another, moving a keyframe path earlier or later in the same parameter, or for creating keyframes on one parameter and applying them to another parameter.

To copy keyframes, you must select the keyframes you want to copy, either individually, or as an entire channel or channels.

**To select keyframes, do one of the following:**

- Using the Edit tool, drag a selection box around the keyframes you want to select.
Shift-click the keyframes you want to select.

If only the curve (and not the keyframes) appear white, the keyframes are not selected.

Selected keyframes appear white.

Once you have the keyframes selected, you can cut or copy them to move them to the Clipboard.

**To copy selected keyframes:**
- Choose Edit > Copy (or press Command-C).

**To cut selected keyframes:**
- Choose Edit > Cut (or press Command-X).

To paste your selected keyframes, you must select both the parameter you want to paste to, and the place in time where you want the pasted keyframes to begin.

**To paste keyframes:**
1. Select the destination parameter in the parameter list (on the left side of the Keyframe Editor).
2. Place the playhead at the point in time where you want the keyframes to begin.
Note: Pasted keyframes may not make an identical-looking curve to the original if the parameter scales are different.

To select an entire animation curve, do one of the following:
- Select a parameter row in the parameter list of the Keyframe Editor.
- Shift-click or Control-click in the parameters list to select multiple parameters.
Once you have the keyframed parameters selected, you can cut or copy them to move them to the Clipboard.

To copy selected animation curves:
- Choose Edit > Copy (or press Command-C).

To cut selected animation curves:
- Choose Edit > Cut (or press Command-X).

When pasting animation curves, any keyframes in destination parameters are replaced, and the timing of the original keyframes is retained over the entire channel in the new destination.

To paste animation curves:
1 In the parameter list of the Keyframe Editor, select the destination parameter.
2 Choose Edit > Paste (or press Command-V).

Note: Pasted animation curves may not make an identical-looking curve to the original if the parameter scales are different.

Using the Sketch Tool
The Sketch tool (next to the Edit tool) allows you to sketch animation curves in the Keyframe Editor, creating keyframes as you go. In order to sketch a curve, the parameter you wish to animate must first appear in the parameter list. See “Custom Parameter Sets” on page 533 for methods of displaying the curves you wish to appear.

To sketch an animation curve:
1 In the parameter list, select the parameter you wish to sketch.
2 Select the Sketch tool from the Keyframe tool set.
3 Drag in the keyframe graph to sketch an animation curve.
Dragging or clicking anywhere in the Keyframe Editor replaces existing keyframes.

To add individual keyframes using the Sketch tool:
1. Select the Sketch tool from the Keyframe tools set.
2. In the parameter list, select the parameter you wish to sketch.
3. Click in the keyframe graph to add a keyframe.
   Additional clicks create additional individual keyframes.

Using the Box Tool
Also in the Keyframe tool set, the Box tool allows you to drag a selection box around a number of keyframes, then manipulate their positions by adjusting the handles of the selection box.

To draw a selection box using the Box tool:
1. Select the Box tool from the Keyframe tool set.
2. In the keyframe graph, drag to create a box enclosing the keyframes you wish to manipulate.
   A selection box with eight handles appears in the keyframe graph.
Once you have drawn a selection box, there are a number of ways to manipulate the box and keyframes therein. In general, you can drag any of the handles of the selection box to move them.

**Transforming Keyframes**
Repositioning the handles of the selection box is the same as dragging the handles of a bounding box of any object. The difference in this case is that the transforms done by moving these handles affect not only the box itself, but the keyframes enclosed therein. Moving the box moves all of the selected keyframes in whatever direction you move; as a result, you can affect where they keyframes are positioned in time or their parameter values, or both at the same time. Scaling the selection box “scales” the keyframes within the selection box, changing their timing and parameter values.

Experiment with the selection box to see how different kinds of manipulation affects the enclosed keyframes.

**To move the selection box:**
- Drag anywhere inside the selection box to move the box and the enclosed keyframes. Moving left and right repositions the keyframes in time, and moving up and down increases and decreases the parameter values of the selected keyframes.

*Note:* No matter where you drag the box, only the keyframes selected by the original box are manipulated, even if the repositioned box overlaps keyframes outside of the original selection. To manipulate additional keyframes, you must redraw the selection box in the keyframe graph.

**To scale the selection box:**
- Hold down the Option key and drag any of the handles of the selection box. The box scales up or down as you drag along the axes.

**To deform the selection box asymmetrically:**
- Hold down the Command key and drag any of the corner handles of the selection box. Each corner handle moves independently of the other three corner handles of the selection box.

**Modifying Curves**
Perhaps the most powerful and valuable feature that the Keyframe Editor offers is the ability to make changes to the curves between the keyframes. Of course, manipulating keyframes causes changes in the curves, but Motion gives you tools to control the interpolation and extrapolation of your parameter values themselves.

By using different preset mathematical algorithms or by using manual controls, you can dramatically alter the impact of your effects.
When you set the interpolation for a curve, you select the keyframe you want to modify. The method you choose determines the distribution of values through, into, or out of the selected keyframe.

**To set an interpolation method for a keyframe:**
1. Select the keyframe you want to affect.
   The keyframe turns white.
2. Control-click the keyframe to display the shortcut menu.
3. Choose an interpolation method from the Interpolation submenu.

**To set an interpolation method on a curve segment:**
- Control-click the segment, then choose an interpolation method from the Interpolation submenu.

You can set different interpolation methods for different segments of the same curve.
When different interpolation methods are applied to the different segments of an animation curve, the methods that are used in the curve appear with a dash next to their name in the Interpolation submenu (in the Keyframe Editor parameter list). In the following image, all interpolation methods are applied to the selected curve.

The different interpolation methods are described in the table below.

<table>
<thead>
<tr>
<th>Interpolation method</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td><img src="image" alt="Constant Example" /></td>
<td>Holds the keyframe at its current value when applied to a segment or keyframe and then changes suddenly to the new value when the next keyframe occurs.</td>
</tr>
<tr>
<td>Linear</td>
<td><img src="image" alt="Linear Example" /></td>
<td>When applied to a keyframe, creates a uniform distribution of values through the keyframe from its two adjacent keyframes. When applied to a segment, creates uniform distribution of values between the two points.</td>
</tr>
<tr>
<td>Bezier</td>
<td><img src="image" alt="Bezier Example" /></td>
<td>Lets you manipulate the keyframe curve manually by dragging the handles. If multiple Bezier keyframes are selected, or Bezier is applied to the curve segment, the handles of all the selected keyframes are modified.</td>
</tr>
<tr>
<td>Continuous</td>
<td><img src="image" alt="Continuous Example" /></td>
<td>This method behaves like Bezier interpolation, but without access to the handles (they are calculated automatically). The parameter begins to change gradually, reaching its maximum rate of acceleration at the midpoint, then it tapers off slightly as it approaches the second keyframe. When applied to a keyframe, the segments before and after the keyframe are affected. When applied to a curve segment, the segment between to the two keyframe is affected.</td>
</tr>
</tbody>
</table>
Alternatively, you can apply an interpolation method to the entire parameter. In the following example, the Y Position curve (green) is currently set to Bezier.

**To change the interpolation method for an entire parameter:**
- In the Keyframe Editor, click the Animation menu and choose a method from the Interpolation submenu.
The selected interpolation method (Constant in this example) is applied to the entire curve.

To change the interpolation method for multiple parameters:
1. In the parameter list of the Keyframe Editor, Shift-click to select the parameters you wish to change.
2. Click the Animation menu (in the Keyframe Editor) and choose a method from the Interpolation submenu.

The selected interpolation method is applied to all of the selected curves.

**Convert to Bezier**

Bezier interpolation method is the most flexible, allowing manual modification of the curve. Motion lets you convert any keyframe into a Bezier keyframe quickly and easily.

To convert a keyframe into a Bezier keyframe:
- While holding down the Command key, drag the keyframe in the keyframe graph.
Beziers handles appear and your mouse movement automatically controls one of the handles.

*Note:* Command-clicking a Bezier point resets it to Linear interpolation.

To simultaneously modify the handles for more than one control point, Shift-click to select multiple points, then adjust the tangents. If there are no tangents on the point, drag it while holding down the Command key.

**To break a handle:**
- While holding down the Option key, drag the handle.

**To "lock" the handle’s angle while modifying:**
- While holding down the Option key, drag the handle.

**Extrapolation**
In addition to setting interpolation for the areas between keyframes, you can define how Motion generates the values before the first keyframe and after the last one (*extrapolation*). When you set a such a method for a parameter, new keyframes are added beyond your original keyframes. This can be helpful when trying to extend the duration of an effect such as a moving background.
To apply the Before First Keyframe for a parameter:

- In the Keyframe Editor, open the Animation menu for the parameter you want to change, then choose an item from Before First Keyframe submenu.

To apply the After Last Keyframe setting for a parameter:

- In the Keyframe Editor, open the Animation menu for the parameter you want to change, then choose an item from After Last Keyframe submenu.

The following table describes the extrapolation options available in the Before First Keyframe and After Last Keyframe submenus.

<table>
<thead>
<tr>
<th>Extrapolation method</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td><img src="image" alt="Constant Example" /></td>
<td>(Default) The parameter remains at the exact value of the first and last keyframes in the extrapolated area.</td>
</tr>
<tr>
<td>Linear</td>
<td><img src="image" alt="Linear Example" /></td>
<td>Extends the curve beyond the first and last keyframes uniformly, along the existing trajectory.</td>
</tr>
<tr>
<td>Ping Pong</td>
<td><img src="image" alt="Ping Pong Example" /></td>
<td>Copies the curve and repeats it, alternating forward and backward.</td>
</tr>
</tbody>
</table>
Generate Keyframes

Ordinarily the extrapolation occurs without actually creating any new keyframes. This lets you experiment with different methods. However, you can convert an extrapolation method into actual keyframes so you can further manipulate them. This is done using the Generate Keyframes command. You can choose how many of the extrapolation cycles you want converted into keyframes. Cycles after the number you chose are left in the extrapolated state.

<table>
<thead>
<tr>
<th>Extrapolation method</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat</td>
<td><img src="image" alt="Repeat Example" /></td>
<td>Duplicates the curve, applying it again and again.</td>
</tr>
<tr>
<td>Progressive</td>
<td><img src="image" alt="Progressive Example" /></td>
<td>Extends the curve by repeating the existing shape of the curve, but rather than returning to the exact same values, it begins again from the existing end value.</td>
</tr>
</tbody>
</table>
To convert extrapolation data into keyframes:

1. In the Animation menu, choose Generate Keyframes from the Before First Keyframe or After Last Keyframe submenu. The Generate Keyframes dialog appears.

2. Choose the number of cycles you want to be keyframed.

3. Click OK to confirm your selection.

**Control Buttons**

In the Keyframe Editor, several buttons provide additional control over the Keyframe Editor window: Snapping, “Show audio waveform,” and “Fit visible curves in window.”

**Snapping:** When Snapping is enabled, keyframes snap to markers, other keyframes, and other snappable items.
**Show audio waveform:** Turns on display of the audio waveforms for the selected item in the background of the graph. This lets you line up an effect to take place at the same time as an event that occurs in the audio.

![Show audio waveform enabled](image)

**Note:** If there are multiple audio tracks in the project, a pop-up menu at the bottom of the Keyframe Editor allows you to view the waveform of any individual audio track in the project, or the master track.

**Fit visible curves in window:** Automatically scales the graph vertically to include all of the keyframes of your active parameters.

There are times when the values of your keyframes may exceed the vertical resolution of the graph. For example, as you stretch a keyframe, you can drag it so far that you force the window to scroll.
When you click this button, Motion automatically rescales the graph both vertically and horizontally so that your curve is entirely visible.

The values of your keyframes are not changed.

**Auto-scale vertically**: Click the “Auto-scale vertically” button (the magnifying glass in the upper-right corner of the Keyframe Editor) to stretch the graph to fit all of the curves currently in view.

**To turn on automatic scaling**: Click the “Auto-scale vertically” button in the upper-right corner of the Keyframe Editor.

When “Auto-scale vertically” is on, the range of the graph increases to accommodate your entire curve even as you change it. For example, if you drag a keyframe up to increase its value, as you drag past the top of the window, the whole graph is rescaled, rather than scrolled.

This can be disconcerting at first because it might appear that your curve refuses to get bigger even as you drag your keyframe. However, if you watch the zoom/scroll bar at the right side of the window, you can see that the graph is being zoomed vertically to make room for your wider range of values.

**Mini-Curve Editor**

A mini-curve editor is a scaled-down version of the Keyframe Editor. Appearing in the Inspector, mini-curve editors give you the functionality to create basic animations directly in the Inspector, without having to open the Keyframe Editor.
Two Particle behaviors—Scale Over Life and Spin Over Life—have mini-curve editors in the Inspector (when the Increment Type parameter is set to Custom.) Mini-curve editors are also present for paint objects, in the Stroke pane of the Shape Inspector.

By default, the mini-curve editor is collapsed and shows a scaled-down representation of the actual animation curve.

![Collapsed mini-curve editor](image)

**To expand a mini-curve editor:**
- Click the disclosure triangle next to the collapsed mini-curve editor.

The expanded mini-curve editor appears.

![Expanded mini-curve editor](image)

When expanded, the mini-curve editor shows a representation of the relevant animation curve. In the example above, the Range parameter is mapped to the X axis and the Spin Amount parameter is mapped to the Y axis.

The procedure for adding keyframes in a mini-curve editor is slightly different than adding them in the full-sized Keyframe Editor.
To add keyframes in the mini-curve editor, do one of the following:

- Click the curve in the mini-curve editor.
- Double-click the curve in the mini-curve editor to add a keyframe and activate its value field.
- Option-click the curve, then choose Add Keyframe from the shortcut menu.

The mini-curve editor provides the Edit, Sketch, and Box tools, and each functions in the same manner as it does in the Keyframe Editor. For more information on using the Edit tool, see “Using the Edit Tool” on page 539. For more information on using the Sketch tool, see “Using the Sketch Tool” on page 543. For more information on using the Box tool, see “Using the Box Tool” on page 544.

The Auto Fit checkbox toggles whether Motion automatically scales the animation curve to fit within the confines of the mini-curve editor.

Animating on the Fly

Another powerful feature that Motion offers is the ability to create animations while your project is playing back. This is similar to how audio engineers adjust sliders for each of their different audio channels while listening to the mix. The next time it is played back, all of those changes are incorporated.
Because so many of Motion’s effects are displayed in real time, you can perform a sort of “visual mix” and modify the various parameters of your effects while the project is playing back.

For example, it is not until you see the various elements in your project in concert that you can know whether each part is behaving as it should. One object may be fading too slowly and making another element hard to see, or a text element might come and go so quickly that it cannot be read. With keyframing on the fly, you can make adjustments to any slider or parameter in the program while your project is playing. You can also interactively manipulate objects in the Canvas. Then, if you don’t like what you did, rewind and do it again. Each time you alter a parameter, you replace any keyframes previously assigned.

To animate a parameter on the fly using the Inspector or the HUD:

1. Click the Record button (or press A) or choose Mark > Record Animation to turn on keyframe recording.
2. Click the Play button or press the Space bar to begin playback.
3. As your project plays, adjust a parameter slider.
4. Disable Record.

The changes you made during playback are recorded as keyframes for that parameter. You can view them in the Keyframe Editor.

If you don’t like the animation you made, you can delete the keyframes and try again. You can choose Edit > Undo (or press Command-Z) to revert to the state before you began recording your animation, or you can manually delete the keyframes you want to replace.

To delete keyframes, do one of the following:

- Select the keyframe, then press Delete.
- Control-click the keyframe, then choose Delete from the shortcut menu.
Select the keyframe, then choose Delete from the Animation menu for that parameter.

**Note:** To delete all of the keyframes for a parameter, choose Reset Parameter from the Animation menu in the Keyframe Editor list or Inspector.

**Handmade Motion in the Canvas**

One of the most common uses for animating on the fly is to create handmade animation paths. Although you can choose from a variety of curve types, it is very difficult to get the semi-random movement except by sketching with your mouse or pen.

**To create a handmade animation path in the Canvas:**

1. Enable Record (press A).
2. Click the Play button to begin playback.
3. Select the object you want to manipulate and drag it in the pattern of your choice. Both the position and speed of your movement are recorded and applied to the position keyframes for that object.

You can further manipulate the path either by dragging individual keyframes, or re-recording a new animation path for that object.

**Keyframe Thinning**

Due to the way keyframing works, if the playhead is at a new frame, and you set a new value for a parameter, a keyframe is added. For animating while the project is playing, this might mean setting a new keyframe on every single frame. This doesn't create a problem until you want to make a change to the curve.
In many cases, the curve created by your animation can be represented using fewer keyframes. Often, this will provide a smoother rate of change and will enable you to take advantage of the various interpolation methods such as Ease In and Ease Out.

You can simplify your keyframes in two ways: either while you are recording them, or afterwards, by simplifying an existing animation curve. For more information about simplifying keyframes after recording using the Reducing Keyframes command, see page 531.

**Recording Options**

The Recording Options dialog allows you to set the Keyframe Thinning setting, to record only on parameters that are already animated or to disable recording during playback.

The Keyframe Thinning setting only applies to recording animation while playing back. This setting has no effect on ordinary keyframing.

**To access Recording Options, do one of the following:**
- Choose Mark > Recording Options (or press Option-A).
- Double-click the Animate button.

The Recording Options dialog appears.
To set the Keyframe Thinning setting:

1. Select Off, Reduced, or Peaks Only.
2. Click OK.

**Off:** No thinning is applied. Keyframes are applied at every frame where the parameter is changed.

**Reduced:** Motion eliminates keyframes that can easily be replaced with a simple curve.

**Peaks Only:** Only keyframes with dramatic value changes are recorded.

**Disabling Animation While Playing**
If you leave the Record button on, keyframes are added whenever you make adjustments. If you want to restrict keyframing to when the project is not playing, you can disable that feature individually.
To disable animation recording while playing:
1. Choose Mark > Recording Options.
   The Recording Options dialog appears.
2. Turn on “Don't Record keyframes during playback.”
3. Click OK.

Recording Keyframes on Animated Parameters Only
When “Record keyframes on animated parameters only” is turned on, keyframes are added only to parameters that are already animated. For example, if the position of a shape is animated (keyframed) and “Record keyframes on animated parameters only” is enabled, only changes made to the position of that object are keyframed. If you change the color of the object over time, the color changes are not keyframed—even when the Record button is enabled.

Important: The Record button must be on when using the “Record keyframes on animated parameters only” option. You can still manually add keyframes, regardless of whether or not Record is enabled, by using the Animation menu in the Inspector or Keyframe Editor list, or by pressing Option-K.

Tip: If you are a Final Cut Pro user, it is recommended that you use this option to emulate the workflow with which you are familiar.

To record keyframes on animated parameters only:
1. Enable Record (or press A).
2. Choose Mark > Recording Options (or press Option-A).
3. Turn on “Record keyframes on animated parameters only.”
4. Click OK.

Keyframes are now added only when you make changes to parameters that are already animated. To observe how the “Record keyframes on animated parameters only” works, walk through the following brief exercise.

To see the “Record keyframes on animated parameters only” in action:
1. Enable Record (press A).
2. Choose Mark > Recording Options, and make sure “Record keyframes on animated parameters only” in the Recording Options dialog is turned off, then click OK.
3. At frame 1 (press Home), draw a shape in the Canvas and move the object into a start position.
   A position keyframe is created.
4. Advance to a different frame and move the object into another position.
   A second position keyframe is created.
5 Choose Mark > Recording Options, and turn on “Record keyframes on animated parameters only” in the Recording Options dialog, then click OK.

6 Go to a frame in between the two position keyframes, and move the shape in the Canvas.

A third position keyframe is added.

7 At frame 1 (press the Home key), click the Fill color well in the shape’s HUD, then change the color of the object.

8 Advance to a different frame, then change the color object again.

9 Go to frame 1 and click the Play button (or press the Space bar).

Notice that the position of the object is animated, but the color is not. This is because the shape had position keyframes when “Record keyframes on animated parameters only” was turned on.
Using Text

Text, one of the most essential motion graphics elements, is more powerfully customizable than ever in Motion.

In motion graphics, typography communicates much more than just basic information—titles, dates, and tag lines. Visual and kinetic type on the screen can also provoke an immediate and often powerful emotional response. A title sequence can set the mood of the film it introduces. A specific combination of text and animation can instantly identify a broadcast network. And a clever television interstitial can prevent a bored viewer from flipping channels during a commercial break. Type design is an art form. Just look at the opening title sequence by Friz Freleng for Blake Edwards’ *The Pink Panther*. Freleng’s animated titles—featuring a design and graphics style that holds up even today, more than 40 years later—not only set the comic tone for a film franchise, it launched the (virtual) career of an animated icon (with a little help from Henry Mancini’s suave theme music).

Although trends in type design change, the balanced use of type and graphics remains the key to achieving the right effect in commercials, documentaries, television and film titles, broadcast logos, corporate presentations, or your own personal video projects.

No matter what style your project requires, Motion provides unique text animation tools that offer immediate results.
**Using Text in Motion**

Motion lets you add text to your project directly in the Canvas—select the Text tool, click in the Canvas, then start typing. Once text is created, you can edit it in the Canvas or in the Text editor in the Inspector.

Text can be animated using behaviors or keyframes. Text has two special behavior categories: Text Animation and Text Sequence behaviors. These behaviors animate text by generating a range of values in the text parameters specific to titling effects. For example, drag the Text Tracking behavior onto the text, and the text characters gracefully spread out across the Canvas over time, even without keyframes. (You can choose to work with or without keyframes using the Text Sequence or Text Animation behaviors.)

In addition to text behaviors, you can apply any Basic Motion, Simulation, or Parameter behavior to text. For more information on these types of behaviors, see “Using Behaviors” on page 369.

Although behaviors are designed for graphics, they are an ideal way to test different text treatments without setting keyframes. You can quickly adjust the rate of an applied behavior using the behavior’s HUD, and watch as the animation updates in the Canvas. For more control, you can access all of the parameters for a behavior in the Inspector. If your project requires specific timing and positioning of text, you can still use behaviors to test effects, and then create keyframes after you know what you want to do. Or you can create keyframes from the applied text behaviors by using the Convert to Keyframes feature. This approach allows you to fine-tune the animation created by the text behaviors.

Of course, behaviors are not required to animate text. You can create text animation via traditional keyframing, or by combining both techniques.

**Note:** Although you can apply keyframes and behaviors to text, you’ll need to think about the effect you are trying to create because this workflow can defeat the purpose of behaviors. Mixing keyframes and behaviors can also yield unexpected results. For more information on combining behaviors and keyframes, see “Using Behaviors” on page 369.

Text can be placed and animated on a path, used as an image mask source, or used as a particle or replicator cell source.
After you create the desired text treatment—a customized text behavior or a text style with the perfect gradient colors and glow—you can save the behavior or style in the Library for use on other text or in a future project.

You can apply filters to text, as well as change and animate text properties such as position, blend modes, and drop shadows.

The stacking order of text can be easily changed in the Layers tab or Timeline. Text can also be moved to or duplicated/copied into another layer.

The Motion Library includes ten LiveFonts that can be applied to text. LiveFonts are animated fonts that can add a little zing to your project.
**Note:** If you have Final Cut Pro with LiveType installed on your computer, all LiveFonts appear in the Motion Library.

### Using Text as Particle and Replicator Source Objects
Text layers can be used as source cells for particle emitters and replications to quickly create stunning graphics. If you later modify the source text, Motion automatically updates the replicator and particle system. If the text used as a cell source has applied behaviors or filters, the effect is carried over into the replicator or particle system.

### Setting Layer Duration Preferences
Before you start any project, you should set up Motion Preferences according to your project requirements. When working with text, you can specify that an object (text layer) is created at the current frame (the frame where the playhead is positioned at the time you add the text). Alternatively, you can specify that the object is created at the start of the project. By default, layers are created at the current frame. You can also specify a default duration for any created layer.

**Note:** This sets the same preferences for all layers created within Motion, including text, shapes, masks, particle emitters, and replications.

**To set the layer duration preferences:**
1. Choose Motion > Preferences (or press Command-comma).
2. Click the Project icon.
   The Project preferences pane is displayed.
3. In the Still Images & Layers section, set the Default Layer Duration preference:
   - To create text that is the length of the project, select “Use project duration” (the default setting). This means that if you are working in a 300-frame project and you create text, the duration of the text is 300 frames.
     **Note:** If you have Create Layers At set to “Current frame,” and you create text at frame 50, the text exists from frame 50 to frame 300.
   - To create text that is a specific duration, select “Use custom duration.” Next, enter a value in the text field, then choose Frames or Seconds from the pop-up menu. All layers you created are set to the entered duration by default.
4. Set the Create Layers At preference:
   - To create text at the current location of the playhead, select “Current frame.”
To create text at the start of the project, select “Start of project.” This means that all text is created at the beginning of the project by default, regardless of the playhead location.

Working with Text
In Motion, you create text directly in the Canvas using the Text tool. Once text is added to your project, you can easily apply filters to the text, or animate the text using behaviors or keyframes.

Creating Text in Your Project
This section describes adding text to your project in the Canvas.

When Create Layers At is set to “Start of project” in the Project preferences, text is created at the first frame of the project. For example, if you are working in a 900-frame project and you add text, the duration of the text is 900 frames. To shorten the duration of the text, shorten the text layer duration in the Timeline or mini-Timeline. For more information, see “Using the Timeline” on page 321.

To add text in the Canvas:
1 In the Layers list, select the group to which you want to add the text layer.
   Note: If no group is explicitly selected, the text is added to the last selected group (the group with the underline beneath its name).
2 In the Toolbar, click the Text tool (or press T).
3 Click in the Canvas.

The cursor flashes in the Canvas at the insertion point. Before you enter any text, empty text layer is added to the project and the Text HUD appears.

4 Type the text you want.

The text appears in the Canvas, the Layers tab, and the Timeline.

Note: By default, the text Layout Method is set to Type. The Type layout option creates no margin, so if you enter a long string of text, it extends on a single line beyond the Canvas until you create a manual line break (press Return). This mode is useful for working with short text and panning text across the Canvas. For information on changing text layout and setting margins, see “Text Layout Controls” on page 630.

Note: To see items that extend beyond the edge of the Canvas, choose View > Show Full View Area.

5 When you are done typing, press Esc, or click the Select/Transform tool.

The text is selected and appears with a bounding box in the Canvas. The layer name updates to reflect the entered text.

Important: Once you have finished typing your text, be sure to press Esc or select another tool on the Toolbar—do not use a keyboard shortcut. When the Text tool is selected, you are in text-entry mode, so if you press S to select the Select/Transform tool, an “S” is added to your text rather than the tool being changed.
Text as a Layer
Once created, text becomes a layer. Because text layers share most of the characteristics of other layers in Motion, you can use the transform tools—Select/Transform, Anchor Point, Shear, Drop Shadow, Four Corner, and Crop—to transform a selected text layer when the Flatten checkbox is turned on in the Layout pane of the Text Inspector. These onscreen tools are shortcuts to the layer controls in the Properties tab of the Inspector. To set specific values, or fine-tune any of the transforms, use the Properties tab in the Inspector.

For more information on the Properties tab and onscreen transform tools, see “Parameters in the Properties Tab” on page 280. For more information on the Flatten checkbox, see “Text Layout Controls” on page 630.

Note: When you make changes to text using the transform tools or the parameters in the Properties tab of the Inspector, modifications are applied to the text as a layer (such as a clip or image), not as editable text. The controls for editing the text itself are located in the Text tab of the Inspector. Although some layer properties are similar to some text Style and Format controls, such as Shear (in the Properties tab) and Slant (in the Format pane of the Text tab), the layer properties are independent of the text format controls, and vice versa. For example, if you apply a Slant value of 20 in the Format pane of the Text Inspector, a slant value of 20 is applied to each character in the word, simulating italics. If you apply a Shear value of 20 in the Properties tab of the Inspector (or using the onscreen controls), a shear value of 20 is applied to the layer as a whole, not the individual text characters.

The next section briefly describes how to transform text using the onscreen transform tools. For detailed information on using the onscreen controls, see “Using 2D Transforms” on page 264.

In addition to moving text with the transform tools, you can move text up and down in the composite in the Layers tab and Timeline. Just like all other layers in Motion, text can also be copied, pasted, duplicated, and deleted. For more information, see “Managing Layers in Your Project” on page 219.

Using the Text HUD
The Text HUD contains some of the most commonly adjusted text parameters, such as Opacity, type Family, and Color.
**Note:** If no HUD is present when the text is selected, press F7 or D to display the text HUD.

![Text HUD image](image)

When a text layer and the Adjust 3D Transform tool (in the Toolbar) are selected, the 3D transform tools become available in the HUD. These additional controls allow you to transform the text object in X, Y, and Z dimensions, regardless of whether the group is 2D or 3D.

![3D Transform HUD](image)

For more information on using the 3D transform tools in the HUD, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.

The Text HUD includes the following controls:

**Opacity:** By default, the opacity of text is set to 100%. Use the slider to change the opacity value.

**Note:** The Properties tab also contains controls to change the opacity of the text. The opacity controls in the Properties tab of the Inspector are independent of the controls in the Text tab of the Inspector. In the Text tab you have control over the opacity of all text style elements including the Face, Outline, Glow, and Drop Shadow. In the Properties tab, the Opacity control sets the transparency of the text layer, no matter what style is applied.

**Blend Mode:** The text blend mode is set to Normal by default. Use the Blend Mode pop-up menu to choose another mode for the selected text.
Note: The Properties tab also contains controls to change the blend mode of the text. When you change the blend mode of text in the Text HUD, the blend mode is also changed in the Properties tab and vice versa.

Family: By default, the text font family is set to Geneva (if installed on your system). To change the font of the selected text, choose a font from the pop-up menu. Once a font is selected, new text is created using the last selected font.

Typeface: Choose the type style, such as Bold, Italic, and so on from the Typeface pop-up menu. The available typefaces are specific to the selected font family.

Color: Text color is white by default. Click the color well to display the Colors window and choose another color for the selected text. You can also Control-click a color well to display the pop-up color palette, then drag in the color spectrum to select a color.

Size: Text is created at 48 points by default. To change the point size of text, drag the Size slider.
**Note:** The text Size sliders (in the HUD and in the Inspector) are limited to 288 points. To set the text to a larger point size, type a number in the Size field in the Format pane of the Text Inspector.

**Tracking:** Tracking applies a uniform value between each text character. Tracking is set to 0 by default. To change the tracking value of text, drag the Tracking slider left (for a negative tracking value) or right (for a positive tracking value).

**Note:** The text Tracking sliders (in the HUD and in the Inspector) are limited to 100 points. To set a larger tracking value, type a number in the Tracking field in the Format pane of the Text Inspector.

**Line Spacing:** When working with multiple lines of text, drag the slider to change the space between lines of text. Dragging to the right (above 0) increases the line spacing and dragging to the left (below 0) creates negative line spacing.

**Alignment:** Text alignment is set to Left by default. To change alignment, choose Right or Center from the Alignment pop-up menu.

**Text Parameters in the Inspector**

The complete group of the text parameters (including those in the Text HUD) are located in the Text tab of the Inspector.

**To display the Inspector:**

1. Select the text.
2. Do one of the following:
   - Choose Window > Inspector.
• Click the “i” button on the HUD.
• Press Command-3.

The Inspector contains all text parameters divided into three panes: Format, Style, and Paragraph. For more information, see “Editing Text in the Inspector” on page 584.

**Adding Behaviors and Filters to Text**
Behaviors and filters are applied to text in the same manner as they are to other layers in Motion. This section provides a quick start to applying behaviors and filters to text. For more information on using the Text Animation and Text Sequence behaviors, see “Using Text Animation and Text Sequence Behaviors” on page 648.

To apply a behavior to text, do one of the following:
- In the Library, select a behavior, then drag it to the text in the Canvas, Layers tab, or Timeline.
- Select the text to which you want to apply a behavior, click the Add Behavior icon in the Toolbar, then choose a behavior from the pop-up menu.

The Text HUD is replaced with a behavior HUD.

**Note:** For more information on applying text behaviors, see “Text Animation Behaviors” on page 649 and “Text Sequence Behaviors” on page 668. For more information on other behaviors, see “Using Behaviors” on page 369.

To apply a filter to text, do one of the following:
- In the Library, select a filter, then drag it to the text in the Canvas, Layers tab, or Timeline.
- Select the text to which you want to apply a filter, click the Add Filter icon in the Toolbar, then choose a filter from the pop-up menu.

**Note:** For more information on using filters, see “Using Filters” on page 841.
About Fonts

Motion uses all supported fonts installed on your Mac OS X system. Mac OS X supported fonts include OpenType, Type1 (or PostScript), and TrueType. All supported fonts installed on your system appear in the Library, as well as the Format pane of the Text Inspector. This includes fonts located in:

- /Library/Fonts/
- /Users/username/Library/Fonts/
- Classic System Folder/Fonts/

For information on installing fonts, see your system documentation. If you have Final Cut Pro with the LiveType fonts installed, you can use the LiveFonts in Motion. If you do not have Final Cut Pro installed, Motion includes ten LiveFonts. For more information on LiveFonts, see “Using LiveFonts” on page 681.

You can preview and apply the available fonts in the Library or in the Format pane of the Text Inspector.

Using the Library Font Preview

The Motion Library includes a Fonts category and Preview area to browse fonts or change existing text.

For information on previewing and changing fonts in the Text Inspector, see “Editing Text Format” on page 585.

Previewing Fonts

When you select a font in the Fonts category of the Library, a preview of the font is displayed in the Preview area of the Library.
To preview a font in the Library:
1 In the Library, click the Fonts category.
2 Click the font subcategory you want to preview.
   Note: The first subcategory, All Fonts, contains all fonts from the other subcategories.
   If you are in list view, the font list appears in the stack. If you are in icon view, the font
   thumbnails appear in the stack. In the images on the following pages, icon view is
   selected.
3 In the stack, click a font thumbnail or name.
   The font is displayed in the Preview area, along with the font name and type.
Changing Fonts
There are two ways to use the Library to change the font of text in the Canvas. The first method is to drag a font to the text object in the Canvas. The second method is to select text, select a typeface in the Library, then click the Apply button in the Preview area.

**To change the font by dragging:**
1. In the Library, click the Fonts category and then the font subcategory.
2. Drag a font from the stack onto the text in the Canvas.

As you drag the font over the text, a transparent thumbnail of the font appears and the pointer becomes a green add pointer (+). When you release the mouse button, the text is changed to the selected font.

**To change the font with the Apply button:**
1. Select the text to which you want to apply a new font.
2. In the Library, click the Fonts category and then the font subcategory.
3. In the stack, click a font.
4 In the Preview area, click Apply.

The text is changed to the selected font.

Navigating the Font List
To quickly locate a font by its name in the font stack, you can type the first few letters of the font name.

To select a font by typing the first few letters of its name:
1 Click a font name or thumbnail in the font stack.
2 Quickly type the first two letters of the font name.
   
   Note: If you do not type the second letter of the font name quickly, the selection is reset and jumps to the font whose name begins with the second letter entered.

To move through the browser fonts in alphabetical order:
- Drag the scroll bar on the right side of the stack up or down to move through the fonts.

Using the Text Tools
As previously mentioned, text becomes a text layer when it is created. There are two ways to edit a text layer:
- Like any other layer in Motion, text can be edited using the parameters in the Properties tab in the Inspector, or by using the onscreen controls.
- You can edit the text characters using the Text parameters in the Text tab of the Inspector or in the HUD.

This section discusses the tools that can be used to create and modify text. The following interface tools are used to edit text in Motion:
- Toolbar
- Text HUDs
- Text Inspector

Note: When text is selected with the default selection tool, you can use the standard onscreen controls to move and animate the text in the Canvas.
**Text Tool and the Toolbar**

The Text tool is located in the Toolbar above the Canvas in the Create tool set.

*Note:* To customize the Toolbar layout, Control-click in the Toolbar area, then choose Customize Toolbar from the shortcut menu. For more information on the tools and the Toolbar, see “Toolbar” on page 29.

---

**Text tool:** Use this tool to create text. Click the Text tool, then click in the Canvas and begin typing. To select the text characters, click the Text tool, then drag within the text.

**Select/Transform tool:** Use this tool to select and transform text. Once text is created, click the Select/Transform tool (or press Esc) to select the text. To select existing text, click the Select/Transform tool, then click the text.

*Note:* When the Select/Transform tool is selected, you can double-click the text to automatically enter text-editing mode.

**Adding Text with the Text Tool**

Text is added to a project with the Text tool.

To add text to your project, do one of the following:

- Click the Text tool (or press T), click in the Canvas, then begin typing.
- Click the Text tool, then drag in the Canvas to draw a custom margin. Once the margin is drawn, release the mouse button and begin typing.

Once a margin is created and text is entered, you can adjust the size of the margin without affecting the scale of the text.
To adjust margin size without scaling the text, do one of the following:

- With the Text tool selected, drag one of the scale handles on the text bounding box.

- In the Text Inspector, click the Layout pane and adjust the Left, Right, Top, or Bottom Margin values.
To select text characters, do one of the following:

- Select the Text tool, then drag the text you want to select.
- Click in between two characters, press Shift, then press the Right Arrow key to select characters to the right of the insertion point to the selection, or press the Left Arrow to select characters to the left of the insertion point to the selection.
- Click the Select/Transform tool, then double-click the text.

To move the cursor between words:

- Press Option-Right Arrow to move the cursor forward between words; press Option-Left Arrow to move the cursor backward between words.

To delete an entire word:

- Position the cursor at the end of the word you want to delete, then press Option-Delete.

Adding Text with the Text Editor

Once you have added a blank text layer to your project (clicked the Text tool in the Canvas), you can enter and edit text in the Text editor rather than the Canvas. The Text editor is useful when working with large amounts of text.

To enter text in the Text editor:

1. Click the Text tool (or press T), then click in the Canvas to create a blank text layer.
2. In the Text Inspector, click the Format pane.
3  Click in the Text editor and begin typing.

Note: Because the default text Layout Method is set to Type, when text is entered in the Text editor, there are no set margins, and the text continues in one line unless you manually enter a line break. For more information on text layout, see “Editing Text Layout” on page 629.

You can also edit existing text in the Text editor, including using the Mac OS X spelling feature.

To edit existing text using the Text editor:
1 Select the text to be edited.
   The selected text appears in the Text editor.
2 Make your changes in the Text editor.
   Changes are immediately reflected in the Canvas.
To use the spelling feature in the Text editor, do one of the following:

- Click in the Text editor, then choose an option from the Edit > Spelling submenu.
- Control-click in the Text editor, then choose an item from the shortcut menu.

*Note:* The spelling feature is not available when working with text in the Canvas.

**Editing Text in the Inspector**

All text controls are located in the Text tab of the Inspector. The Text tab is divided into three panes: Format, Style, and Layout. The Format pane contains text basics, such as font, size, and tracking. Text characteristics such as face, outline, and blur are controlled in the Style pane. The Layout pane contains text layout controls, such as margins, justification and text on a path.

As with all parameters in Motion, if the parameter can be animated, the Animation menu icon appears next to the parameter in the Inspector.

To reset a parameter to its default settings (including removing keyframes), click the Animation menu icon, then choose Reset Parameter from the pop-up menu.
To reset a group of parameters, such as the text Face controls or the Sequence controls of a text behavior, click the reset button in the Inspector. To reset a single parameter within a group, click the Animation menu, then choose Reset Parameter.

**Editing Text Format**

The Text Format pane contains the controls for text basics such as font, typeface, size, kerning, and character rotation. Many of the Format parameters can be animated (keyframed).

**To show the Text Format pane:**
- In the Inspector, click the Text tab, then click the Format button.
Text Format Controls
This section describes the text Format parameters. Of the following Format parameters, Family, Typeface, Size, and Tracking also appear in the Text HUD.

Font Type: This parameter provides two methods for font filtering and selection:

- Make a choice from the pop-up menu (set to System Fonts by default) to filter which fonts appear in the Collection and Family lists (see below). You can choose to show System Fonts or LiveFonts (LiveType).
- Click Browse to display the Mac OS X Font panel.

Collections: Displays the available font collections based on what is selected in the Font Type parameter.

Family: Sets the font (the set of characters, letters, and symbols of a single font) for the text.

To preview different fonts for text in the Canvas:
1. Select the text.
2. In the Format pane of the Text Inspector, click the Family list arrow.
The font family list appears.

3 Drag the pointer in the font list up or down to preview fonts.
   As you drag through the font family list, the text changes in the Canvas to the currently selected font.

4 Once you have chosen a font, release the mouse button.
   **Note:** You can also use the scroll bar to move up and down the font list, or the wheel of a three-button mouse.

**Typeface:** Sets the type style, such as Bold, Condensed, and so on. The available typefaces are specific to the selected font family.

**Size:** Determines the size of the text. You can enter a value in the value field or use the slider. To change the font size, drag the Size slider left or right. The value of the Size in the HUD and the Inspector is limited to 288 points. To create larger text, type a value in the Size value field.

   **Note:** You can also scale the text in the Canvas using the onscreen controls, but this scales the text as a layer and is independent of setting type point size in the Format controls.
**Tracking:** Determines the spacing between the text characters. Tracking applies a uniform value between each character.

**Kerning:** Adjusts the spacing between individual characters of text.

**To kern the individual text characters:**
1. Click the Text tool (or press T).
2. In the Canvas, position the insertion point (click the mouse button) in between the characters you want to kern, and do one of the following:
   - Use the Kerning slider or value field to set a specific kerning value.
   - Press Control-Right Arrow to increase the space between the characters by one-pixel increments.
   - Press Control-Left Arrow to reduce the space between the characters by one-pixel increments.

**Baseline:** Adjusts the baseline of text characters. The baseline is a horizontal “line” to which the bottom of the characters is aligned.

**Slant:** Simulates italics by adding a slant value to the text characters.
**Scale:** Scales the text characters either proportionately in X space or Y space. To scale in only X or only Y, click the disclosure triangle to enter separate X and Y scale values. In the following image, the text X Scale is set to 50%, and the Y Scale is set to 100%.

**Offset:** Offsets the text from its original position (anchor point). Enter a value in the left value slider to offset the text in X space; enter a value in the right value slider to offset the text in Y space. Click the disclosure triangle to access the X, Y, and Z position values.

**Rotation:** Drag the dial or enter a value in the value slider to rotate the text characters in Z space. Click the disclosure triangle to access separate X, Y, and Z rotation controls and also the Animate pop-up menu.

- **Animate:** This pop-up menu allows you to change the interpolation for animated 3D rotation channels. By default, this parameter is set to Use Rotation.

  **Note:** The Rotation parameter must be keyframed for the Animate parameter options to have any effect.

  - **Use Rotation:** The default interpolation method, whereby text characters rotate from their start rotation to their final rotation. Depending on the animation, the characters may twist this way and that before reaching their final orientation (the last keyframed value). For example, if the X, Y, and Z Rotation parameters are animated from 0 degrees to 180 degrees in a project, the text characters rotate on all axes before reaching their final orientation.

  - **Use Orientation:** This interpolation method provides for smoother interpolation but does not allows multiple revolutions. This method interpolates between the text characters’ start orientation (first keyframe) to their end orientation (second keyframe).

  For more information about the Animate parameter, see “Parameters in the Properties Tab” on page 280.

**Monospace:** When enabled, this checkbox applies a fixed amount of space between each text character.

**All Caps:** This checkbox sets all text characters to uppercase.

**All Caps Size:** When All Caps is enabled, this slider sets the size of the uppercase characters based on a percentage of the font point size.

**Text:** Type directly in Text editor (the darker shaded area) to add and edit text in the Inspector. For more information, see “Adding Text with the Text Editor” on page 582.
Publish To FCP: When using a Motion project as a template in Final Cut Pro, turn on this checkbox to allow editing of certain text parameters from within Final Cut Pro. The editable parameters include the following:

- text string (text characters can be modified)
- text size
- text tracking

**Editing Text Style**

Use the Text Style pane to specify the text fill and to adjust its opacity and softness. Text can be a solid color, an image, or a color gradient. You can also apply outlines and glows, and apply drop shadows to text in the Style pane. Most of the style parameters can be animated.

A set of pre-made text styles is available in the Motion Library. Text styles are modified Style parameters that create a specific “look” for text, such as a red glow and gradient, and are applied to text like behaviors and filters. You can create custom text styles and save the styles in the Library. For more information, see “Using and Creating Text Styles” on page 622.

**To show the Text Style pane:**

- In the Inspector, click the Text tab, then click the Style button.

There are four main groups of controls in the Style pane: Face, Outline, Glow, and Drop Shadow. You can enable or disable all of the styles on a single text layer. By default, Outline, Glow, and Drop Shadow are disabled.

**Text Face Controls**

Use the text Face controls to specify whether the text is a solid color, a color gradient, or a texture. The following section describes the Face parameters. Nearly all of the Face parameters can be animated.

![Text Style Pane](image)

**Face:** Enables and disables the text face parameters (Fill, Color, Opacity, and Blur). Face is enabled by default.

**Fill with:** Click the “Fill with” pop-up menu to set the text fill to Color, Gradient, or Texture.
**Color:** Sets the text fill color. Click the Color disclosure triangle to adjust the individual Red, Green, and Blue color channels for the text.

**Opacity:** Sets the text opacity, regardless of the selected fill option (Color, Gradient, or Texture).

**Blur:** Sets the softness of the text, regardless of the selected fill option.

### Changing the Text Color
You can change text color using the Colors window, the color well in the text HUD, or the color well in the Style pane of the Text Inspector.

**Note:** To adjust the individual color channels, you must use the Style pane of the Text Inspector.

To set the text color in the HUD:

1. Select the text.
2. If the HUD is not displayed, press F7 (or D).
3. Click the color well, then use the Colors window to set the text color.

**Note:** There are many ways to choose a color using the Color parameter. For a complete list, see step 5 in the next section, which describes choosing a color in the Inspector.

The text is dynamically updated as you select your color.

**Note:** To select a color from the Canvas (or anything on the desktop), click the color picker in the Colors window, position the picker over the color you want to select, then click.
To set the text color in the Inspector:
1. Select the text.
2. In the Inspector (press Command-3), click the Text tab.
3. Click Style.
4. In the “Fill with” pop-up menu, ensure that Color is selected.
5. Do one of the following:
   - Click the color well, then use the Colors window to set the text color.
   - Click the arrow button to the right of the color well (or Control-click the color well) then click in the pop-up color palette to select a color. Drag in the lower palette to set the color to a grayscale color.
   - Click the eyedropper tool to the right of the Color well, and then click a color in the Canvas.
   - In the Inspector, click the Color disclosure triangle to show the channel parameters, and then use the sliders or value sliders to adjust each color channel.

Note: The text colors can be animated.
Applying a Gradient to Text

In the Inspector, you can apply a gradient fill to a text. The gradient can be customized and animated using the Gradient editor.

Note: The text gradient controls are nearly equivalent to the gradient controls for shapes, particles, and replicators, with a few parameter exceptions. For example, the text gradient controls include a dial to specify the direction of a linear gradient. The shape gradient controls include a start and end setting to specify the direction of a linear gradient. For more information on working with gradients and shapes, see “Using Shapes and Masks” on page 997.

In addition to applying a preset text style from the Library, preset gradients from the Library can also be applied to text. The gradient presets are located in the Gradients category of the Library. A gradient that you apply to text can also be saved in the Library for use in your current or future projects.

To apply a text gradient:
1 Select the text.
2 In the Inspector (press Command-3), click the Text tab.
3 Click Style.
4 Choose Gradient from the “Fill with” pop-up menu.

In the Inspector, the Color controls are replaced with the gradient color. The default gradient is red and blue.
In the Canvas, the default gradient is applied to the selected text.

**Applying a Preset Gradient to Text**

There are two ways to apply a preset (or saved) gradient from the Library to text. The first method is to use the Gradient preset pop-up menu in the Text Inspector. The second method is to drag a gradient from the Library to text.

**To apply a preset gradient in the Text Inspector:**

1. Make sure a gradient is applied to the text to which you want to apply a preset gradient.
2. Choose a preset from the Gradient preset pop-up menu.
The selected gradient is applied to the text.

To apply a preset gradient from the Library:

1. In the Library, click the Gradients category.
2. In the stack, select a gradient.

A preview of the selected gradient appears in the Preview area.
3 Do one of the following:

- Drag the gradient to the text in the Canvas, Layers tab, or Timeline.
- Make sure the text is selected, then click Apply in the Preview area.

After the preset gradient is applied to text, the preset can be edited with the Gradient editor.

**Using the Gradient Editor**

Use the Gradient editor to change the color, color position, number of colors, opacity, direction, and interpolation of a gradient. The color and opacity of a gradient can be animated.

This section discusses the Gradient editor in the Style pane of Text Inspector.

**Graphical controls:** Three bars that allow you to set the color, opacity, and spread of a gradient. Each graphical control activates additional controls in the Gradient editor, including Color, Opacity, and Location sliders.

**Color:** A color well that sets the color of the selected color tag.

**Opacity:** A slider that sets the transparency of the selected opacity tag (in the graphical controls above). The opacity tags control the opacity/ transparency of the gradient. You can add multiple opacity tags to create a gradient of varying levels of transparency. By default, the opacity of a gradient applied to text is 100%.

**Note:** There is also an Opacity parameter (below the Angle parameter) that controls the opacity of the gradient as a whole.

**Interpolation:** Sets the interpolation of the color tag to Constant, Linear, or Continuous.

- **Constant:** Creates a constant color distribution from the color or opacity tag, moving from left to right in the gradient. For example, if the left color tag in a three-color, left-to-right gradient is set to Constant, the gradient from the left tag to the center tag is solid.
• **Linear**: Creates a uniform distribution of opacity or color between the tags.
• **Continuous**: The opacity or color changes gradually between color or opacity tags.

**Location**: Sets the location of the selected gradient color or opacity tag, or spread control.

**Type**: This pop-up menu allows you to choose a linear or radial gradient.
• **Linear**: Creates a linear gradient.
• **Radial**: Creates a radial gradient.

**Angle**: Available when Type is set to Linear, this dial/value slider changes the angle of the gradient.

**Additional Controls that Affect Gradient Fills**
Although not part of the Gradient editor, two additional controls in the Face parameter group allow you to further adjust a text gradient.

**Opacity**: This slider determines the opacity of the overall gradient. This control is separate from the opacity controls in the Gradient editor, which control opacity within the gradient.

**Blur**: Use the slider or value slider to blur the gradient as a whole. Blur is not applied on a per-tag basis.

*Important*: The following sections assume that text is selected, and Gradient is chosen from the “Fill with” pop-up menu in the Face parameter group.
To change gradient colors:

1. Click the Gradient disclosure triangle to show the Gradient editor.

2. To change the color of a color tag, do one of the following:
   - Double-click a color tag.

   The Colors window appears. Use the Colors window to set a new color for the tag.
   - Click a color tag to enable the Color controls for the selected color, then click the Color well. The Colors window appears.
• Click a color tag, and then use the individual Red, Green, or Blue color channel sliders.

[Image: Color sliders]

- Dark blue color tag is selected.

• Click a color tag, and then click the arrow button next to the Color well to display the pop-up color palette. Click in the palette to select a new color. Click in the lower palette to set the tag to a grayscale color.

[Image: Color palette]

- Click here to select a grayscale color.

• Click a color tag, then Control-click the Color well to display the pop-up color palette.
• Click a color tag, click the eyedropper tool, then click a color in the Canvas.

To move the position of a color or opacity tag:
1 Click the color or opacity tag you want to move.
2 Do one of the following:

- Drag the tag left or right.

- In the Location parameter, use the slider or value slider to enter a specific value. A value of 100% is the rightmost position of the gradient, and a value of 0% is the leftmost position of the gradient.

**To change the spread of the gradient color or opacity:**

- Drag the small triangle (the spread control) between the color or opacity tags to change the location of the spread. The closer the triangle is to a tag, the sharper the color or opacity spread.

  The Location parameter is also updated as you move the spread control, indicating its position on the gradient.

**To change the color or opacity tag interpolation, do one of the following:**

- Control-click a tag and choose Constant, Linear, or Continuous from the shortcut menu.

- Click a tag, and then choose Constant, Linear, or Continuous from the Interpolation pop-up menu.

**To add a color tag to a gradient:**

- To add a new color tag, position the pointer in the lower color bar where you want to add the new color, then click.
A new color tag is added to the gradient.

Note: Although the colors and opacity of a gradient can be animated, the number of color and opacity tags cannot.

To add an opacity tag:
- Position the pointer in the opacity bar where you want to add the new tag, then click.
A new opacity tag is added to the gradient.

Until the value is adjusted, the gradient opacity is 100%.

To duplicate a color or opacity tag:
- Option-drag the tag to its new position.

To remove a color or opacity tag from the gradient:
- Drag the tag away from the gradient bar.
The tag is removed with a “poof.”

To change the opacity of a gradient color:
1. Click an opacity tag.
The opacity controls are enabled.

2 Use the slider or value slider to change the value of the selected opacity tag. The lower the percentage of the opacity, the greater the transparency. The gradient opacity is applied to the area of a gradient, not to a specific color tag.

The gradient transparency reflects the new opacity values. In the following image, Opacity is set to 0% at the right side of the gradient (the light pink color), so the color fades out.

**Editing color and opacity direction and distribution**

You can quickly reverse the direction or evenly distribute the gradient color and opacity tags.

**To reverse the gradient color or opacity direction:**
- Click the Reverse Tags icon next to the opacity or color bar.
The tags are reversed.

To evenly distribute the gradient color or opacity tags:
- Click the Distribute Tags icon next to the opacity or color bar.

---

**Saving Gradient Presets**

As with text styles, once you have created a gradient, you can save it to the Library.

For more information on the Library text styles, see “Using and Creating Text Styles” on page 622.

**To save a gradient to the Library:**
1. Select the text with the gradient you want to save.
2. Choose Save Gradient from the Gradient preset pop-up menu.
3. In the Save Preset To Library dialog, type the name of the gradient.
4. Click Save.
The custom gradient appears in the Gradients category in the Library. Custom presets can be identified in the Library by the small user icon that appears in the lower-right corner of the larger gradient icon. The new gradient also appears in the Gradient preset pop-up menu.
Like the preset gradients, a preview of the gradient appears in the Preview area when the gradient is selected in the stack.

![Gradient Preview](image)

**Applying Parameter Behaviors to Gradients**

To create unique gradient effects, you can apply Parameter behaviors to gradient parameters such as Opacity, Location, Angle, and Color. This is accomplished in the same manner as applying a Parameter behavior to any other parameter in Motion.

In the following example, a Randomize behavior is applied to the RGB color parameter of one color in a three-color gradient.

**To apply a Randomize parameter behavior to a gradient color:**

1. In the Inspector, select a color tag in the Gradient editor.
2. If the Color parameters are not displayed, click the Color disclosure triangle.
3. Select a color channel such as Red (the control becomes shaded when selected), Control-click the parameter, then choose Randomize from the shortcut menu.

   The Randomize parameter is applied to the color tag. Next, you must assign the color channel(s) you want to be affected by the behavior.

4. In the Randomize HUD or Inspector, choose an option from the Apply To ("Go") pop-up menu. In this example, choose Styles > Style Face > Gradient > RGB > RGB2 (for the second color tag in the gradient) > Color > All.

   **Note:** If you were using a shape, you would choose Object > Fill > Gradient > RGB > RGB2 (for the second color tag) > Color > All.

An RGB item appears for every color tag in the gradient, as does an Alpha item for each opacity tag. Because the gradient in this example has three colors, three RGB items appear (RGB1, RGB2, and RGB3). The items are numbered from left to right—RGB1 is the leftmost gradient color; RGB2 is the middle color; and RGB3 is the rightmost color.

The Offset and Middle parameters also appear in the pop-up menu above the Color item. Offset represents the location of the color in the gradient (the Location parameter), and Middle represents the spread of the color between two tags (the small triangle control between the gradient color tags).
Note: The Parameter behavior can be applied to any parameter that appears in the Apply To (“Go”) pop-up menu.

5  Click the Play button (or press the Space bar).

6  In the Randomize parameters, do the following:
   • Increase the Amount slider to approximately .5.
   • Decrease the Frequency to approximately 5 so the color changes occur less often.
   • Set Noisiness to 0 so the color changes are smoother.

When the color tag with the applied Parameter behavior is selected in the Inspector, the Behaviors icon appears next to the color channel parameters. If the Randomize behavior were only applied to the Red channel, the Behaviors icon would only appear next to the Red parameter.

Using a Texture Fill
You can use an image, movie, shape, layer, or group as the fill for text. You do this with the Texture option in the Face controls of the Inspector.

The texture parameters respect any filters applied to the source image, but not any transforms applied to the image. For example, if the image used as the source texture has a glow filter applied, the glow appears in the text’s texture. If the image used as the source texture has been scaled, moved, or contains applied behaviors, the result of the transforms does not appear in the applied texture.

To apply a texture to text:
1  Select the text.

2  In the Inspector, click the Text tab.

3  Click Style.

4  Choose Texture from the “Fill with” pop-up menu.
   The Color (or Gradient) controls are replaced with the Texture controls.
5 Click the Texture disclosure triangle.

![Image well]

By default, no texture is applied to the text.

6 In the Layers or Media tab (of the Project pane), drag the image you want to use for the texture to the Image well.

![Image well]

The image appears in the well and is applied to the text. When text is filled with an image, the texture is applied to each text character. To learn how to make the texture continuous through all text characters, see “Applying a Texture to Text Characters Versus Applying a Texture to Text” on page 612.

**Important:** When selecting an image to put into the Image well, be sure to click and drag in one movement. If you click the image and release the mouse button, the image is selected and its Inspector appears. This also applies to the Image well for masks.

**To replace a texture:**

1 Select the text and display the expanded Texture controls.
2 In the Layers or Media tab, drag the image you want to use to replace the existing texture to the Image well.

The new image appears in the well and is applied to the text.

**Note:** When an image (or a movie clip) is replaced in the Layers tab or Media tab, and that image is used as a texture source, the texture for the text is replaced with the new image.

**To remove a texture, do one of the following:**
- Click the Texture parameter reset button.
- Drag the image out of the well, then release the mouse button. Poof!
Editing a Texture

If you are using an image sequence or movie as the text’s texture source, you can specify the start frame for the texture, or choose to hold a single frame for the texture. You can also adjust the position of a texture that is applied to text so that it is offset in the text, but not repositioned in your project. If an image used as a texture is cut off, you can specify the edge behavior of the texture.

Image: Drag the image you want to use as the source texture into the image well.

Frame: When using a movie or an image sequence as the texture source, use the slider or value sliders to specify the start frame for the texture.

Hold Frame: When using a movie or an image sequence as the texture source, turn on Hold Frame to freeze the frame specified in the Frame parameter. The selected frame is used as the texture for the text layer’s total duration.

Offset: Drag or enter a number in the Offset value sliders to specify the X and Y values of the position of the source texture (relative to the text layer).

To change the position of a texture:

- In the Texture controls, do one of the following:
  - Press Command, then drag in the Image well. The image moves in the well and is offset in the text in the Canvas.
  - Adjust the Offset values. The left value slider represents the X position values; the right value slider represents the Y position values. Click the disclosure triangle to display the labeled X and Y value sliders.

Wrap Mode: Use the Wrap Mode pop-up menu to specify how the edge of a texture is treated when the texture is offset and appears cut off in the text or is too small to fill the text to which it is applied.

- None: As the default wrap mode, the texture remains transparent beyond the edge of the source image.
- Repeat: Similar to tiling behavior, the texture source is repeated beyond the edge of the source image.
- **Mirror**: Beyond the edge of the source image, the texture source is reflected like in a mirror—duplicated, tiled, and alternately reversed to encompass the full width and height of the text.

**Animating a Texture**
You can set keyframes for the offset values of the texture source to create a moving element within text. In the following example, an image of a leopard lying in the grass is used as the texture source for the text “leopard.”

To animate the texture offset:

1. Apply a texture to the text.
   
   For instructions on how to apply a texture to text, see “Using a Texture Fill” on page 606.

2. Go to the frame where you want the texture animation to begin.

3. Enable Record (press A).

   
   **Note**: Keep in mind that when Record is enabled, a keyframe is created for any change you make to an object in your project.
4 To position the texture, do one of the following:
   - Press Command, then drag in the Image well.

   - Use the Offset sliders or value sliders to enter an offset value.
     The image within the text moves, and a keyframe is created in the Offset parameters.

5 Go to the next frame where you want to set a keyframe.

6 Move the texture to the new position.
7 Go to frame 1 (or the start frame of your animation) and play the clip.
The texture offset is animated.

8 Disable Record.

Note: You can also use the Animation menu in the Inspector to manually set keyframes without enabling Record. For more information, see “Keyframes and Curves” on page 503.

Using a Layer with Behaviors and Filters As a Texture Source
You can use a layer (image, movie, image sequence, shape, replicator, particle system, group, or other text layer) that has applied behaviors and filters as a texture source for text. If the layer has active filters, in other words, you can see the result of the filters in the texture. If the layer has active behaviors or transforms, the behaviors and transforms are ignored—only the image appears as the texture. Use the following guidelines when using layers as texture sources.

When using a layer with an applied filter as a texture source:
- To use the layer with the effect of the filter, use the steps in “Using a Texture Fill” on page 606.
- If the layer is an image or image sequence, you can use the layer without the effect of the filters by dragging the image from the Media tab to the Texture Image well, rather than from the Layers tab.
- To use a layer without the effect of the applied filter, make a copy of the layer in the Layers tab, remove the filters from the layer, then turn the layer off. You can then drag the layer from the Layers tab to the Image well.

When using a layer with an applied behavior or active transforms (for example, rotate) as a texture source:
- Use the steps in “Using a Texture Fill” on page 606. The effects of the behavior or transforms are ignored.

Applying a Texture to Text Characters Versus Applying a Texture to Text
When you apply an image (or any layer) as the texture for text, the texture is applied to each text character. To use the image as a continual texture throughout the text, use the text as a mask.
To use text to mask an image:

1. In the Layers tab or Canvas, select the layer you want to use as the texture.

To use text to mask an image:

2. Choose Object > Add Image Mask (or press Shift-Command-M).
   A blank image mask layer is added to the image.

3. Drag the text that you want to use as a mask to one of the following:
   - The Mask Source well in the Image Mask HUD.
   - The Image Mask layer in the Layers tab (drop the text on the Image Mask layer in the Layers tab).
   - The Image well in the Image Mask tab of the Inspector.
The text masks the image.

For more information, see “Using Shapes and Masks” on page 997.

**Changing Text Opacity**

Use the Opacity slider or value field in the HUD or in the Inspector to adjust the opacity of text.

To set the text opacity in the HUD:

1. Select the text.
2. Press F7 (or D) to display the HUD.
   
   The opacity controls are located at the top of the HUD.
3. Drag the Opacity slider.
   
   The text opacity is dynamically updated as you drag the slider.

To set the opacity in the Inspector:

1. Select the text.
2. In the Inspector, click the Text tab.
3 Open the Style pane.

4 In the Face controls, drag the Opacity slider or enter an opacity value in the field.

Note: Because a text layer is like other layers in Motion, you can also adjust its opacity in the Properties tab. Setting the Opacity value in the Properties tab and setting the Opacity value in the Style pane are separate controls that have multiplicative effects. In other words, if Opacity is set to 50% in the Properties tab, then set to 50% in the Text Style pane, the result opacity for the text is 25%.

Changing Text Softness
Use the Blur parameter in the Style pane of the Text Inspector to adjust the softness of the text.

To adjust the softness in the Inspector:
1 Select the text.
2 In the Inspector, click the Text tab.
3 Open the Style pane.
4 In the Face controls, drag the Blur slider, or enter a blur amount in the value slider.

The text softness is dynamically updated as you drag the slider.
**Resetting the Text Face Controls**
You can reset the text to its original fill, opacity, and blur using the Inspector.

**To reset the text face parameters:**
Click the reset button in the Face parameter row.

![Reset button]

**Text Outline Controls**
Use the Outline controls in the Style pane to create text outlines. You can change the fill of the outline, as well as its opacity, softness, width, and layer order. With the exception of Layer Order, all of the Outline parameters can be animated.

![Outline controls]

**Outline:** A checkbox that enables and disables the outline of the text. Outline is disabled by default.

**Fill with:** Choose an item from the “Fill with” pop-up menu to set the fill for the outline. As with the Face controls, you can set the outline fill to Color, Gradient, or Texture.

**Color:** Click the color well to select a color for the outline. Click the Color disclosure triangle to adjust the individual Red, Green, and Blue color channels.

**Opacity:** Sets the opacity of the text outline.

**Blur:** Sets the softness of the text outline.

**Width:** Sets the thickness of the outline.

**Layer Order:** Specifies whether the outline is drawn over or under the text face.
Adding a Text Outline
To create a text outline, turn on Outline in the Style pane of the Text Inspector.

To create an outline for text:
1 Select the text.
2 In the Inspector, click the Text tab.
3 Open the Style pane.
4 In the Outline controls, turn on the Outline checkbox.
   The default outline color is red, with a width of one point.

Note: You can display the outline only of text by turning off the Face parameters.

Editing Text Outlines
Use the Outline controls to soften the opacity or blur of a text outline, change the width of an outline, or to set and edit the fill of an outline.

To change the color of a text outline:
- Click the color well, then select a color from the Colors window.

To adjust the opacity of a text outline:
- Use the Opacity slider or value field to change the opacity of the outline.

To adjust the blur of a text outline:
- Use the Blur slider or value slider to change the blur of the outline.

To change the width of a text outline:
- Use the Width slider or value slider to change the width of the outline.

To set the layer order of a text outline:
- Make a choice from the Layer Order pop-up menu.
  - Choose Under Face to place the outline behind the text face.
  - Choose Over Face to place the outline in front of the text face.

Note: The Outline fill controls—Color, Gradient, and Texture—are equivalent to the controls for the Face parameters. For information on using these controls, see “Text Face Controls” on page 590.
To reset the text outline parameters:
- Click the reset button in the Outline parameter row.

Text Glow Controls
Use the Glow controls to create a glow in front of or behind text. With the exception of Layer Order, all of the Glow parameters can be animated.

Glow: A checkbox that enables and disables the text glow effect. Glow is disabled by default.

Fill with: Choose and item from the “Fill with” pop-up menu to set the fill for the glow. As with the Face and Outline controls, you can set the glow fill to Color, Gradient, or Texture.

Color: Sets the color of the glow effect. Click the color well to select a color for the glow. Click the Color disclosure triangle to adjust the individual Red, Green, and Blue color channels.

Opacity: Sets the opacity of the text glow.

Blur: Sets the softness of the text glow.

Radius: Sets the circumference of the glow.

Scale: Sets the size of the glow.

Offset: Offsets the glow in the X or Y position.

Layer Order: Specifies whether the glow is drawn over or under the text face.

Adding a Text Glow
To create a text glow, turn on the Glow parameter in the Style pane of the Text Inspector.

To create a glow for text:
1 Select the text.
2 In the Inspector (press Command-3), then click the Text tab.
3 Open the Style pane.
4 Turn on the Glow checkbox.
   The default glow is yellow, with Scale and Opacity set to 100%, and Radius set to 1.

\[\text{mopey}\]

*Note:* You can display just the text glow by turning off the Face parameter (and any other active parameters).

**Editing Text Glow**
Use the Glow controls to soften the opacity or blur of the text glow, to change the size of the glow, or to set and edit the fill of a glow.

**To change the color of the glow:**
- Click the color well and select a color from the Colors window.

**To adjust the opacity of the glow:**
- Use the Opacity slider or value slider to change the opacity of the glow.

**To adjust the blur of the glow:**
- Use the Blur slider or value slider to change the softness of the glow.

**To adjust the radius of the glow:**
- Use the Radius slider or value slider to adjust the radius of the glow.

**To adjust the scale of the glow:**
- Use the Scale slider or value slider to proportionally scale the glow. To scale in X or Y dimensions individually, click the Scale disclosure triangle and adjust the X or Y slider.

**To adjust the position of the glow:**
- Use the Offset value sliders to change the position of the glow. The left value slider adjusts the X axis, and the right value slider adjusts the Y axis. To display the individual X or Y offset fields, click the Offset disclosure triangle.

**To set the layer order of the glow:**
- Choose an item from the Layer Order pop-up menu.
  - Choose Under Face to place the glow behind the text face.
  - Choose Over Face to place the glow in front of the text face.
**Note:** The Glow “Fill with” options—Color, Gradient, and Texture—are equivalent to the controls for the Face parameters. For information on using these controls, see “Text Face Controls” on page 590.

**To reset the text glow parameters:**
- Click the reset button in the Glow parameter row.

**Text Drop Shadow Controls**
Use the Drop Shadow controls to create a drop shadow on text, and to adjust the shadow color, opacity, offset from the text layer, softness, and angle. All of the Drop Shadow parameters can be animated.

- **Drop Shadow:** A checkbox that enables and disables the drop shadow effect. Drop Shadow is disabled by default.
  - **Note:** When the Flatten checkbox is turned on in the Layout pane of the Text Inspector, the Properties tab also contains controls to enable and disable a text layer’s drop shadow. The Drop Shadow controls in the Properties tab of the Inspector are independent of the controls in the Text Inspector. Enabling Drop Shadow in both locations adds to the existing shadow.
- **Fill with:** Choose and item from the “Fill with” pop-up menu to set the fill for the shadow. As with the Face, Outline, and Glow controls, you can set the shadow fill to Color, Gradient, or Texture.
- **Color:** Click the color well to select a color for the shadow. Click the Color disclosure triangle to adjust the individual Red, Green, and Blue color channels.
- **Opacity:** Sets the opacity of the text shadow.
- **Blur:** Sets the softness of the text shadow.
- **Scale:** Sets the size of the shadow.
- **Distance:** Specifies the offset of the text shadow.
- **Angle:** Sets the angle (or direction) of the drop shadow.
Adding a Drop Shadow
To create a text drop shadow, turn on the Drop Shadow parameter in the Style pane of the Text Inspector.

To add a drop shadow:
1 Select the text.
2 In the Inspector, click the Text tab.
3 Open the Style pane.
4 In the Drop Shadow parameters, turn on the Drop Shadow checkbox.
The default black drop shadow is applied to the text.

Adjusting the Drop Shadow Parameters
Use the Drop Shadow controls to change the color or opacity of the shadow and to adjust the softness of the shadow. You can also change the distance the shadow is offset from the text, and adjust its angle.

To adjust the color of the drop shadow:
- Click the color well and use the Colors window to set a new color.

To adjust the opacity of the drop shadow:
- In the Opacity parameter, drag the slider or use the value slider.

To adjust the softness of the drop shadow:
- Use the Blur slider or value slider to change the softness of the shadow.

To change the scale of the drop shadow:
- Use the Scale slider or value slider to proportionally scale the drop shadow. To scale in X or Y dimensions individually, click the Scale disclosure triangle and adjust the X or Y slider.

To change the distance of the shadow from the text:
- In the Distance parameter, drag the slider or use the value slider. The distance the shadow is offset is represented in pixels.
To change the angle of the shadow from the text:
- Drag the Angle dial in a circular motion or use the value slider.

*Note:* The Shadow “Fill with” options—Color, Gradient, and Texture—are equivalent to the controls for the Face parameters.

To reset the text drop shadow parameters:
- Click the reset button in the Drop Shadow parameter row.

**Using and Creating Text Styles**
The Motion Library contains a set of preset text styles that you can easily apply to text in your project. A text style is a group of Style parameters that have been modified and saved in the Library. For example, the Tropical Waters text style includes a gradient fill simulating the colors of a tropical lagoon and a sheer blue-colored glow that is set over the text face, then scaled down and offset.

You can also customize and save your own text style or format (or both) in the Library.

**Applying a Text Style**
There are two ways to apply a text style to text. The first method is to select a style in the Library. The advantage of using the Library to apply a text style is that you can preview the style before it is applied to text. The second method is to apply the style in the Text Inspector using the Style Preset pop-up menu. This section discusses both methods.
To apply a text style from the Library:

1. In the Library (press Command-2), select the Text Styles category.
2. Select a style from the stack.

A preview of the style is displayed in the Preview area.

3. Do one of the following:
   • Select the text to which you want to apply the style, then click the Apply button in the Preview area.
   • Drag the style from the stack to the text in the Canvas, Layers tab, or Timeline.
The text style is applied to the text.

To apply a text style from the Text Inspector:
1 Select the text to which you want to apply a style.
2 In the Style pane of the Text Inspector, choose an item from the Style Preset pop-up menu.

The text style is applied to the text.

Resetting Text Style
Use the reset button in the Inspector to reset the text style controls to the default parameter settings.
To reset the all text style parameters:
- Click the reset button in the Style Preset parameter row.

**Saving a Custom Text Style**

Once you have modified parameters in the Style pane (such as Gradient or Glow) or Format pane (such as Tracking or Slant), you can save the style that you have created to the Text Styles category in the Library. These custom styles can then be used and applied just like the preset styles.

*Note:* Any custom presets that you save to the Library are stored in `/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Text Styles/`. The Motion Library is stored in two places on your computer: The read-only content that is installed with Motion is in the `/Library/Application Support/Final Cut Studio/Motion/Library` folder (unless you selected a custom location when you installed Motion), and all custom content that you create is saved in the `/Users/username/Library/Application Support/Final Cut Studio/Motion/Library` folder.

**To save a modified text style to the Library:**

1. Select the text with the modified parameters you want to save as a style.
2. In the Style pane, open the Style Preset pop-up menu and choose one of the following options:
   - To save a style with only the Style pane parameters, choose Save Style.
   - To save a style with only the Format pane parameters, choose Save Format.
   - To save a style with parameters from both the Style and Format panes, choose Save All.
3. In the Save Preset To Library dialog, type the name of your preset.
4. Click Save.
The custom preset is saved to the Text Styles category in the Library. Custom presets can be identified in the Library by the small user icon that appears in the lower-right corner of the larger text style icon.

**About Rasterization and Groups**

Some operations, as well the application of certain filters or a mask, cause a group to become rasterized. When a group is rasterized, it is converted into a bitmap image. Because all text layers live in groups, rasterization affects how text interacts with other objects within your project.

*Note:* Text can be rasterized independently of the group in which it lives. This affects how the text interacts with objects within its own group. For example, applying a Circle Blur filter to text that exists in 3D space (such as text on a path) causes the text to no longer intersect with other objects in the same group. The same operations that cause a 3D group to rasterize cause 3D text to rasterize. In some situations, turning on the Flatten checkbox in the Layout pane of the Text Inspector can minimize this effect.
Rasterization affects 2D and 3D groups in different ways. When a 2D group is rasterized, the blend modes on objects within the group no longer interact with objects outside of the group. In the following illustrations, the nonrasterized 2D group that contains the text is set to the Add blend mode. The text interacts with the object beneath it in the layer stack.

In the next illustrations, the group that contains the text and upper leopard image is rasterized. The rasterization is triggered in this case by turning on the Crop parameter in the Property tab of the group. The text’s Add blend mode and the leopard image’s Multiply blend mode no longer interact with the object beneath it (the lower leopard image) in the layer stack. Notice that the group icon for the rasterized group now appears with a frame around the icon (the icon immediately to the left of the “Group - titles” group).

The titles group is not rasterized.  The text and upper leopard image blend modes interact with the group beneath it in the project.

The titles group is rasterized, indicated by the frame around the group icon.  The text and upper image modes no longer interact with the group beneath it in the project.
In addition, when a 3D group is rasterized, the group as a whole can no longer intersect with objects outside of the group. The rasterized 3D group is treated as a single object and uses layer order, rather than depth order, to composite the project.

Note: When a group is rasterized, cameras and lights in the project still interact with objects within the rasterized group.

Changes to the following parameters trigger the rasterization of a group:

2D Groups
- Making Blending changes (Opacity, Blend Mode, Preserve Opacity)
- Turning on Drop Shadow
- Turning on Four Corner
- Turning on Crop
- Applying any filter
- Adding a mask
- Adding a light

3D Groups
- Making blending changes
- Applying certain filters
- Adding a light to a 3D group with the Flatten parameter enabled (in the Group tab of the Inspector)

Once an operation triggers the rasterization of a group, the following occurs:
- A rasterization indicator (resembling an LED) appears next to the parameter in the Properties tab.
• A small frame appears around the icon for the rasterized 2D group, 3D group, emitter, replicator, or text layer (to the left of the group name) in the Layers tab and Timeline layers list.

![Rasterization frame]

**Editing Text Layout**

The Text Layout pane contains controls for type layout, such as alignment, justification, and line spacing. You can also create a “typewriter” effect using the Type On parameter in the Layout pane, or set text on a path.

**To show the Text Layout pane:**

- In the Inspector, click the Text tab, then click the Layout button.
**Text Layout Controls**

Use the Text Layout controls to specify general arrangement of your text. These controls allow you to make text flow in a single line, in a paragraph with set margins, or on a path.

**Layout Method**: Specifies whether the text layout is set to Type, Paragraph, or Path. The default Layout Method is Type, which creates a single line of text.

**Alignment**: Sets the alignment of the lines of text. The alignment choices are Left, Center, and Right.

**Justification**: Sets the justification of the lines of text. The justification choices are None, Partial, and Full.

**Line Spacing**: Specifies the distance between each line of text (leading) in point-size increments. Dragging to the right (above 0) increases the line spacing and dragging to the left (below 0) creates negative line spacing.

**Flatten**: In 3D groups, text characters on a path may be influenced by behaviors in ways that interfere with linear alignment. For instance, a simulation behavior might pull nearby text characters out of their plane. Turning on the Flatten checkbox forces text characters to remain in a 2D plane. When Flatten is turned on, the text can still interact with other objects in 3D space, but only as a flattened image, like a card.

Unflattened text on a 3D path can weave through other elements in a project.
Once Flatten is turned on, the text characters no longer move in 3D space.

Note: When a text layer that is rotated in Z space is flattened, the text that is further away from the camera (further away in Z) appears smaller. For more information, see “3D Compositing” in the Motion Supplemental Documentation PDF.

Tip: When working with text on a 3D path, the text may become difficult to read depending on its orientation and distance from the camera. If you need to edit the text, you can quickly snap the text layer to its original face-forward orientation using the Isolate button in the Layers tab (or Timeline layers list) or the Isolate command in the Object menu.

To isolate a group or layer, do one of the following:
- In the Layers tab (or Timeline layers list), click the Isolate button.
- Control-click the layer or group, and choose Isolate from the shortcut menu.
- Choose Object > Isolate.
- Click the Isolate button again to return to your previous view.

Note: Clicking a camera’s Isolate button activates that camera’s view.

Face Camera: When this checkbox is enabled, the text characters always face the camera, even when the camera is rotated or the text is rotated.
**Note:** Because text characters are 2D (flat) objects, the text may not be visible when you use the orthogonal camera views, such as Left, Right, and Top (unless the text layer or characters are rotated in 3D space). This is because orthogonal views are at right angles (perpendicular) to objects in the Canvas. For more information on using cameras, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.

**Type On:** This group of controls allows you to create a “type-on” effect, similar to a typewriter. You can keyframe the type-on effect to occur forward, backward, or move in both directions.

- **Start:** Sets the start point of the type-on effect (from the left side of the text). When set to the default 0%, the text is fully “typed on.” When set to 100%, the text is fully “typed off.” If the value animates from 0 to 100 over time, the text types off from left to right. If the value animates from 100 to 0, the text types on from right to left.

- **End:** Sets the end point of the type-on effect (from the right side) of the text. When set to the default 100%, the text is fully “typed on.” When set to 0%, the text is fully “typed off.” If the value animates from 100 to 0 over time, the text types off from right to left. If the value animates from 0 to 100, the text types on from left to right.

**Note:** There is also a Text Animation behavior called Type On which creates a forward type-on effect without setting any keyframes.

**Creating a Type On Effect**
There are two ways to create a type-on text effect: Use the Type On parameters in the Text Layout controls, or apply the Type On behavior (in the Text Animation behavior category). This section discusses using the Type On parameters in the Layout pane. For information on the Type On text behavior, see “Type On” on page 667.

**Type On Controls**
Use the Type On parameters to specify the direction, start and end points, and fade-in control for the type-on effect. You must animate these parameters in order to see the desired effect.
Fade In: When turned on, fades the text characters on or off. When turned off, the text characters pop on as they appear.

Example: Creating a Type-On Effect
In this example, text is set to type on from right to left.

To create a type on effect:
1 Select the text.
2 Go to the frame where you want the animation to begin.
3 Enable Record.
4 In the Layout pane, set the End value of the Type On parameters to 0. The text disappears (is “typed off”).
   Note: You can also use the Animation menu rather than enabling Record in the transport controls. Click the Animation menu icon next to the End parameter, then choose Add Keyframe.
5 Go to the frame where you want the animation to end (the type-on effect to be complete).
6 Set the End value to 100.
7 Play the project.
The text is appears character by character, from left to right (is "typed on").

To create a type-on effect in which the text characters “pop” on, turn off the Fade In checkbox.

Note: You can use the Type On parameter when the text Layout Method is set to Type, Paragraph (multiline text), or Path.

Tip: Remember that you can apply Parameter behaviors to nearly any parameter in Motion. For example, to make the text from the above example stutter and flash as it appears, apply the Randomize parameter behavior to the End parameter:

- Control-click the End value in the Type On controls, then choose Randomize from the shortcut menu.
  The Behaviors tab appears and displays the Randomize parameters. The text characters pop into view more roughly, with irregular timing.
- To make the stutter effect more dramatic, adjust the Randomize parameters (such as changing the Apply Mode or increasing the Noisiness parameter).
  For more information on working with Parameter behaviors, see “Applying Parameter Behaviors” on page 380.

Working with Text on a Path
You can create text on a line, circle, rectangle, wave, or along the edge of a shape or mask. An Open Spline text path can be manipulated to move through 3D space. You can change the shape of a text path, add or remove control points, as well as animate the text along the path. Text on a path can still be edited—you can change text characters or fonts, tracking, kerning, and so on. Text Style parameters can also be modified for text on a path.
Creating Text on a Path
To place text on a path, you create the text and then apply the Path layout method (via the Layout Method pop-up menu). Use the Path Options parameters to modify the text on a path.

To create text on a path:
1. Select the text you want to place on a path.
2. In the Layout pane of the Text Inspector, choose Path from the Layout Method pop-up menu.
   The Path Options parameters become available.
3. Select the Text tool (or press T) and click the text in the Canvas.

   Important: Step 3 is important—the Text tool must be selected in order to view or edit the text path.

Using Behaviors with Text on a Path
Text, Simulation, Parameter, and Basic Motion behaviors can be applied to text on a path. This allows for the creation of some very clever and complex animation that takes only seconds to create.

For more information on using Simulation and Parameter behaviors, see “Using Other Behaviors With Text” on page 676.
The path appears below the text. The default path shape is set to Open Spline and contains three control points.

**Modifying the Path Shape**
Keep in mind that the Text tool must be selected to view and edit the text path. Use the following guidelines to modify the shape of the path.

**To adjust the text path:**
- Drag a control point to change the shape of the path.
- Option-click or double-click the path to add a control point.
- To remove a control point, select the point, then press Delete. You can also Control-click the point and choose Delete Point from the shortcut menu.
- To create a linear point, Control-click the point and select Linear from the shortcut menu.
- To create a smooth (Bezier) point, Control-click the point and select Smooth from the shortcut menu.

*Note:* When Path Type is set to B-Spline, the Very Smooth option becomes available in the shortcut menu.

- To lock a point, Control-click the point and select Lock Point from the shortcut menu. A locked point cannot be edited.
- To unlock a point, Control-click the point and select Unlock Point.
Important: Text paths are modified in the same way as shape control points. For a complete information, see “Using Shapes and Masks” on page 997.

Note: Clicking any path control point and holding down the mouse button displays an info window containing the point number (based on the order the points are drawn on the path) and X, Y, and Z coordinates. All path control points are also listed by number in the Layout pane of the Text Inspector.

To adjust the text path in 3D space:

1. If there is no camera in your project, add a camera by doing one of the following:
   - Click the Add Camera icon in the Toolbar.
   - Choose Object > New Camera (Option-Command-C).

   Note: If none of your project groups are set to 3D, a dialog appears asking you if you want to switch your 2D groups to 3D groups. Click Switch to 3D to allow the camera to affect the groups.

2. Change the default camera view (Active Camera) to Top:
   - Click “Active Camera” in the upper-left corner of the Canvas (the Camera menu), then choose Top from the pop-up menu.
   - Choose View > 3D View > Top.

   The text is no longer visible because the camera is now looking down perpendicularly (on the Y axis) to the text on a path. The text path and its points are still visible. (The yellow wireframe camera icon in the Canvas represents the Active Camera you added in step 1.

   Note: The text path onscreen controls are available for all camera views. This example uses the Top view.

3. Drag a control point to adjust the text path in X, Y, or Z space.
Note: Manipulating text on a path in 3D only works when Path Shape is set to Open Spline.

![Text on a path in 3D Top view. The right and left control points are set to positive Z values.](image)

If you lose the path selection, select the text layer in the Layers list.

Note: To enter specific values for the control point locations, click the Control Points disclosure triangle in the Path Options group of the Layout pane. The first value field is X, the second value field is Y, and the third value field is Z.

4 To change to a different camera view, click “Top” in the upper left corner of the Canvas, then choose another camera view from the Camera menu in the upper-left corner of the Canvas.

![Text on a path in Right camera view.](image)

5 To reset the camera view, do one of the following:
   - Choose Active from the Camera menu.
   - Choose View > 3D View > Active.
Tip: When working with text in a 3D project, especially text that moves close to the camera, set the Render Quality in the View pop-up menu or the View pull-down menu to Best before exporting (choose View > Render Quality > Best). Use Normal when working in your project, as Best mode dramatically slows your project’s interactivity. You can also set the Render Quality on export in the Export Options dialog: Choose Export, click Options, then choose Best from the Render Quality pop-up menu. To customize an export, turn off the “Use current project and canvas settings” checkbox.

Path Options
This group of controls allows you to specify the initial shape of the text path, and to modify the path and the text on that path.

Path Shape:
- **Open Spline**: The default shape, a straight path defined by two points at the beginning and end of the path. You can choose to work with Bezier or B-Spline control points. Option-click (or double-click) anywhere on the path to add points.
- **Closed Spline**: A closed path in which the last point is in the same location as the first point. You can choose to work with Bezier or B-Spline control points. Option-click (or double-click) anywhere on the path to add points.
- **Circle**: A simplified version of Closed Spline, in which the X radius or Y radius can be adjusted to create a circle or an ellipse.
- **Rectangle**: A closed path in which the width and the height can be adjusted to create a square or a rectangle.
- **Wave**: A wavy path (a sine wave) defined by two points at the beginning and end of the path, and controlled by the End Point, Amplitude, Frequency, Phase, and Damping parameters.
- **Geometry**: The layer travels along the edge of a shape or mask that is used as the source for the path. An animated shape can be used as the text path source. For example, use a circle shape with an applied Oscillate Shape behaviors as the source shape.
Contextual Controls
Depending on the option you choose in the Path Shape pop-up menu, additional contextual controls become available:

Path Type: When Path Shape is set to Open Spline or Closed Spline, the Path Type pop-up menu becomes available, allowing you to choose one of two ways to manipulate the shape of the path: Bezier or B-Spline.

- **Bezier**: Lets you manipulate the keyframe curve manually by dragging the handles. For more information about creating and adjusting Bezier curves, see “Editing Bezier Control Points” on page 1023.

- **B-Spline**: B-Splines are manipulated using only points—there are no tangent handles. The points themselves do not lie on the surface of the shape. Instead, each B-Spline control point is offset from the shape’s surface, pulling that section of the shape towards itself as if it was a magnet, in order to create a curve. B-Splines are extremely smooth—by default, there are no sharp angles in B-Spline shapes, although you can create sharper curves, if necessary.
  
  For more information about working with B-Spline curves, see “Editing B-Spline Control Points” on page 1025.

Radius: When Circle is the defined path shape, the Radius slider becomes available. This slider allows you to change the size of the circular path. Click the disclosure triangle to individually adjust the X radius and Y radius.

**Note**: When the Text tool is selected, you can also use the onscreen control points to resize the circle. Press Shift to resize the X and Y radii uniformly.

Size: When Rectangle is the defined path shape, the Size slider becomes available. This slider allows you to change the size of the rectangular path. Click the disclosure triangle to adjust the X scale and Y scale individually.

**Note**: When the Text tool is selected, you can also use the onscreen control points to resize the rectangle. Press Shift to resize the X and Y scale uniformly.

Start Point, End Point, Amplitude, Frequency, Phase, and Damping: When Wave is the defined path shape, these controls become available.

- **Start Point**: Sets the location default start point on the wave’s path. The left value slider sets the X coordinate of the start point. The right value slider sets the Y coordinate of the start point. The start point can also be adjusted using the wave’s onscreen controls (active by default when the Text tool is selected).

- **End Point**: Sets the location of the default end point on the wave’s path. The left value slider sets the X coordinate of the start point. The right value slider sets the Y coordinate of the start point. The end point can also be adjusted using the wave’s onscreen controls (active by default when the Text tool is selected).
- **Amplitude**: A slider that defines half the distance from the highest point to the lowest point in the wave. Higher values result in more extreme waves.
- **Frequency**: A slider that sets number of waves. Higher values result in more waves.
- **Phase**: A dial that defines the percentage of the offset of the waves from the start and end points of the path. When set to 0% (default), the wave begins and ends at half the distance from the highest point to the lowest point in the wave. When set to 90%, the wave begins and ends at the highest point in the wave. When set to –90%, the wave begins at the lowest point in the wave. When set to 180%, the waves are the same as 0%, but inverted.
- **Damping**: A slider that progressively diminishes the oscillation of the wave. Positive damping values diminish the wave forward (from left to right); negative values diminish the wave backward (from right to left).

**Shape Source, “To” pop-up menu, Attach to Shape**: When Geometry is the defined path shape, these controls become available.
- **Shape Source**: An image well that defines the layer (shape or mask) to use as the motion path source.
- **To**: This pop-up menu displays a list of all layers in the current project that can be used as a shape source for the motion path.
- **Attach to Shape**: When this checkbox is enabled, the motion path follows the source shape at its original location. When disabled, the motion path can exist in a location other than its source shape.

  **Note**: When Attach to Shape is enabled, you cannot move the layer to another location.

To learn how to use spline objects as a text path source shape, see “Using Geometry for a Path Source” on page 642.

**Other Path Options Controls**
The following parameter controls are persistent for all path shapes:

- **Path Offset**: Determines where the text begins on the path. Animate this value to move text along a path. At 0%, the first text character is at the left end of the path; at 100%, the first character is at the right end of the path.

- **Wrap Around**: Available when Path Shape is set to Open Spline or Wave (an open path shape), wraps the text from the end of the path around to the first point of the path.

- **Inside Path**: When the Inside Path checkbox is on, the baseline of text on a loop path is shifted so the text appears inside of the loop.

- **Align to Path**: Aligns the text to the shape of the path. When the checkbox is off, all text characters align vertically, regardless of the shape of the path.
Control Points: Displays the X and Y positions for all control points on a path. Use the value sliders to adjust the position of the control points using the Inspector. An additional Z position parameter is available for the Open Spline path shape.

Using Geometry for a Path Source
The following section describes how to use geometry as the source for a text path.

To use geometry for a text path source:
1 Import (or draw) the shape you want to use as the path source.

2 Select the text on a path, then choose Geometry from the Path Shape pop-up menu.

The Shape Source well appears in the Inspector.
3 From the Layers tab, drag the shape to the Shape Source well.
4 When the pointer becomes a curved arrow, release the mouse button.
A thumbnail of the shape appears in the well and the shape is used as the source shape for the text path.

![Thumbnail of shape](image)

**Note:** You may want to disable the source shape in the Layers tab so it is not visible in your project.

**To select another geometry source for a text path shape:**
- Click the “To” pop-up menu (located next to the Shape Source image well) and select the layer you want to use as the text path’s shape source.

**Editing Text on a Path**
Text on a path can still be edited. This includes changing the Format parameters, such as font, tracking, and kerning, as well as modifying the Style parameters, such as changing the color and opacity (including applying styles or gradients).

When additional text characters are added to text that is already on a path, the default path may appear too short. In the following images, the first image shows the original text placed on a path. The second image shows additional text. Notice that in the second image with the added text characters, the path is shorter than the text.

![Initial text placed on path](image) ![Additional characters added to original text](image)

Footage provided courtesy of National Geographic Television and Film Library
To extend a text path:

- With the Text tool selected, drag the last control point toward the end of the text.

When dragging, press Shift to constrain the path to a straight line. Once a path has been extended, you can add control points for extra control over the shape of the path.

**Animating Text on a Path**
Text can be animated to move across the text path.

To animate text on a path:

1. Create the path for the text to travel along.

2. Go to the frame where you want to begin the animation, and enable Record.

   *Note:* Remember that using shortcut keys while in text editing mode may result in adding characters to your text.

3. In the Layout pane, adjust the Path Offset slider or value slider to the amount you want to move the text on the path.
A keyframe is added to the Path Offset parameter.

A positive value moves the text toward the right and a negative value moves the text toward the left. You can enter values greater than 100% or less than 0% in the value slider. A value greater than 100% moves the text completely off the path to the right; a value less than 0% moves the text off the path to the left. In the following image, the Path Offset is set to 105%, so the text is completely off the right end of the text path.

4 Go to the frame where you want to end the animation (or set the next keyframe).
5 Adjust the Path Offset slider or value slider to reposition the text on the path.
6 Play the project to see the text travel along the text path.

7 Disable Record.
Working with Text Margins
By default, the text Layout Method is set to Type. This creates one long string of text until you manually enter a line break. There are several ways to create and adjust text margins, including using the onscreen controls and the Layout pane in the Text Inspector. You can set a margin for text before or after it is created.

Margin Options
This group of controls, which becomes available when the Layout Method is set to Paragraph, sets the size and location of the text margins.

Left, Right, Top, and Bottom Margins: Use these controls to set the margins for the text layout in the Canvas. The Layout Method must be set to Paragraph to enable the margin parameters.

Creating a Text Margin
You can create a custom margin using the Margin controls in the Layout pane of the Text Inspector, or by drawing a text bounding box in the Canvas.

To create text margins with the Text tool:
1 Select the Text tool (or press T) and drag in the Canvas.
   When you release the mouse button, a text bounding box appears.
**Note:** You can create a text bounding box (create margins) that extends beyond the edge of the Canvas.

Once you release the mouse button, the insertion point flashes in the bounding box and you can enter text in the Canvas or the Text editor in the Format pane. The Layout Method is automatically set to Paragraph.

2 To resize the text margins, ensure the Text tool is selected, then drag a scale handle on the bounding box.

**Note:** You can also resize the margins of the text bounding box using the Margin controls in the Layout pane of the Text Inspector. (see step 3 in the following example.)

3 Press Esc or click the Select/Transform tool to select the text bounding box and exit text-editing mode.

**Note:** Do not use the Select/Transform tool to resize the text bounding box margins. If you select a scale handle of a text bounding box with the Select/Transform tool and resize, the text is resized, not just the bounding box.

**To create text margins in the Inspector:**

1 Create some text.

**Note:** You also can create a blank text layer by clicking the Text tool in the Canvas.

2 In the Layout pane, set Layout Method to Paragraph.

3 Set margin values using the Left, Right, Top, and Bottom Margin parameters.

4 Press Esc or click the Select/Transform tool to select the text bounding box and exit text-editing mode.
Using Text Animation and Text Sequence Behaviors

While you can apply any behavior (Basic Motion, Parameter, or Simulation) in Motion to text, text also has its own special behavior categories: Text Animation and Text Sequence behaviors. Text behaviors create animation by applying a range of values to text parameters specific to titling effects—without creating keyframes. By dragging a behavior to text in the Canvas, Layers tab, or Timeline, you can easily create a left or right text crawl, scroll, a “type-on” effect, or a tracking animation.

Using the Sequence Text behavior in the Text Animation group, you can create a custom animation that sequences through the characters of text using the text Format and Style parameters. For example, you can choose to animate the Scale, Blur, and Opacity parameters of text in a given sequence. The sequence can run through the text from left to right, right to left, or you can create a custom animation for the direction of the sequence. The sequence can also be applied per character, per word, per text layer, and so on.

The Text Sequence subcategory includes more than 100 sequence behaviors. Each behavior in this category is a preset that uses the parameters of the Sequence Text behavior (in the Text Animation subcategory). For example, the Drop In Random Text Sequence behavior animates the Position parameter so that the text characters drop in vertically in a random order. Although the Text Sequence behaviors are all presets—the parameters are already selected and animated—you can still add, remove, or modify any parameter that is available to the Sequence Text behavior.

You can save a modified behavior to the Library. For more information, see “Saving a Modified Text Behavior to the Library” on page 675.

Note: Remember that you can apply any Basic Motion, Parameter, or Simulation behavior to text. For more information, see “Using Other Behaviors With Text” on page 676.
Text Animation Behaviors

The Text Animation behaviors create basic text crawls, scrolls, “type-on” effects, and tracking animation. This group also includes the powerful Sequence Text behavior, which allows you to create a custom animation that sequences through the characters of text using all of the Style parameters and most of the Format parameters.

Text Animation behaviors are applied in the same manner as all other behaviors and filters in Motion—by using the Library or the Add Behavior icon in the Toolbar. As with other behaviors, the Library allows you to see a preview of the behavior before it is applied to text. The Add Behavior icon allows you to quickly apply a behavior to a single or multiple text layers.

To apply a Text Animation behavior from the Library:

1 In the Library, select the Behaviors category and then select Text Animation from the Behaviors subcategories.
2 Select a text behavior in the stack.

Like other behaviors in Motion, a preview of the animation plays in the Preview area. Keep in mind that the preview merely represents the default animation of the behavior, which can be modified.

3 Do one of the following:

- Drag the behavior to the text in the Canvas, Layers tab, or Timeline.
- Click the Apply button in the Preview area.

The Text HUD is replaced with the text behavior HUD.

**To apply a Text Animation behavior from the Add Behavior icon:**

1 Select the text layer (or layers) to which you want to apply the behavior.

2 In the Toolbar, click the Add Behavior icon, then choose a Text Animation behavior from the pop-up menu.

**Example: Using a Text Animation Behavior**

In this section, the Crawl Left behavior is used to illustrate working with the Text Animation behaviors. The guidelines for modifying the Crawl Left behavior also apply to the Crawl Right, Scroll Down, and Scroll Up behaviors.

The Crawl Left behavior scrolls the text to the left across the Canvas.

**To use the Crawl Left behavior:**

1 Using one of the above methods, apply the Crawl Left behavior (from the Text Animation subcategory) to the text.

The behavior animation path appears and displays the projected motion of the text. The animation path extends from the anchor point of the text. For example, if the alignment of the text in the following image was set to Center, the animation path would extend from the anchor point at the center of the text.
**Note:** To show and hide animation paths, use the View pop-up menu in the upper-right corner of the main window (above the Canvas).

2 Click Play (or press Space bar).

The text moves horizontally across the Canvas over the duration of the text to which it is applied.

**Modifying the Crawl Left Behavior**

Use the Crawl Left parameters to modify the speed, start offset, and end offset of the crawl. With the exception of parameters added to the Sequence Text behavior, all Text Animation behavior parameters appear in the HUD and in the Behaviors tab of the Inspector.

**Rate:** Increases or decreases the rate of the crawl. By default, Rate is set to 10 (pixels per second). A higher rate increases the speed of the crawl, so the text travels a greater distance over time; a lower rate slows the crawl.

**Note:** Although the Rate slider value is limited to 100, you can enter a higher value in the value slider.

**Position Offset:** Offsets the start position of the text. By default, the crawl animation begins at the original position of the text. To move the text further to the right at the start of the animation, enter a higher number in the Position Offset field. For example, to move the text 80 pixels to the right, drag the Position Offset slider to 80 or enter 80 in the value slider.
Note: Although the slider value is limited to 100, you can enter a higher value in the Offset value slider.

In the following image, the Crawl Left Rate is set to 200, and the Position Offset set to 80. Because the Rate is increased, the animation path reflects the distance the text travels over time. Because the Position Offset is set to 80, the position of the text is shifted by 80 pixels.

End Offset: By default, the text crawls to the end of the duration of the text. To stop the crawl 60 frames from the end of the text layer (or project), for example, drag the End Offset slider to 60 or enter 60 in the value slider.

Note: Although the slider value is limited to 100, you can enter a higher value in the End Offset value slider.

Crawl Right
The Crawl Right behavior scrolls the text to the right across the Canvas.

Scroll Down
The Scroll Down behavior scrolls the text downward in the Canvas.

Scroll Up
The Scroll Up behavior scrolls the text upward in the Canvas.

Note: The Crawl Right, Scroll Down, and Scroll Up behaviors contain the same parameters as the Crawl Left behavior.

Setting the In and Out Points of the Text Animation Behaviors
By default, the animation created by the Text Animation behaviors begins at the first frame of the text layer to which they are applied. To offset the start and end points of a Text Animation behavior, set new In and Out points for the behavior. Again, the Crawl Left behavior is used to illustrate setting new In and Out points for the Text Animation behaviors.
To change the In point of the Crawl Left behavior:

1. Select the Crawl Left behavior.
   The Crawl Left behavior is selected in the mini-Timeline.

2. Do one of the following:
   - In the mini-Timeline, click the left end (start) of the Crawl Left bar and drag toward the right to the frame where you want the animation to begin.
     As you drag, the new In point, the duration of the text (Crawl Left behavior), and the delta (amount of change) are displayed.

   - In the Timeline, click the left end (start) of the Crawl Left bar and drag toward the right to the frame where you want the animation to begin.

   - Go to the frame where you want to set the new In point, then choose Mark > Mark In (or press I).

     The text does not begin crawling until the playhead reaches the new In point.

To change the Out point of the Crawl Left behavior:

1. Select the Crawl Left behavior.
   The Crawl Left behavior is selected in the mini-Timeline.

2. Do one of the following:
   - In the mini-Timeline, click the right end (end) of the Crawl Left bar and drag toward the left to the frame where you want the animation to end.
   - In the Timeline, click the right end (end) of the Crawl Left bar and drag toward the left to the frame where you want the animation to end.
   - Position the playhead at the frame where you want to set the new Out point, and choose Mark > Mark Out (or press O).

     The text stops crawling when the playhead reaches the end of the Crawl Left behavior bar.
For more information about the Timeline, see Chapter 4, “Using the Timeline” on page 321.

**Sequence Text**
The Sequence Text behavior allows you to select and apply text Format and Style parameters, such as Position, Color, Scale, or Opacity, and animate those parameters in sequence through the text characters. For example, you can create a sequence in which the text characters fall vertically into place as they scale down, fade in, and rotate. The sequence works by moving a selection area, represented by small white lines, through the characters of the text. You can set the sequence to repeat, change direction, or to randomize. The location of the selection can also be keyframed to customize the direction of the sequence. For example, you can animate the selection to move through half of the text, return to the beginning of the text, then move to the end of the text.

**Note:** All of the Text Sequence behaviors (in the Text Sequence subcategory) are presets based on this behavior. This means that each sequence behavior (in the Text Sequence subcategory) contains at least one text parameter that animates through the characters of text. The Text Sequence behaviors contain the same controls and are modified in the same manner as the Sequence Text behavior.

Once you have added and modified the Sequence Text behavior, you can save the behavior to the Library. For information on saving a modified behavior to the Library, see “Saving a Modified Text Behavior to the Library” on page 675.

**To apply a parameter to the Sequence Text behavior:**

1. Apply the Sequence Text behavior (from the Text Animation subcategory) to the text. In the Canvas, the text bounding box is replaced with the sequence bounding box.

![Sequence bounding box](image)

Artwork provided courtesy of Adam Cetorelli, ©2005

The Sequence Text HUD (press F7 or D) also appears and the behavior is added to the text in the Layers tab and Timeline.
**Important:** Before any animation can occur, you must explicitly add at least one parameter to the behavior from within the Inspector. Until a parameter is added, adjustments made in the HUD have no effect.

2. With the Sequence Text behavior selected, display the Behaviors tab in the Inspector.

The upper area of the Sequence Text controls contains the Add and Remove pop-up menus, which are used to select parameters to add to the behavior, or to remove parameters. The second group of parameters are the Sequence controls, which include options for setting the direction of the animation, whether the animation is applied per character, per word, or per text layer, and so on.

3. In the Parameter row, click the Add pop-up menu, choose Format, then choose Scale.

The Scale parameter is added to the behavior and is set to 100% by default (which represents the original size of the text).
4 Set Scale to the largest (or smallest) value you want the text to become in your animation. In this example, the Scale value is set to 350%. To enter separate values for the X and Y scale, click the Scale disclosure triangle.

Note: Often, you can enter values larger than a parameter's slider allows by typing in the value slider.

5 Click the Play button (or press the Space bar).

The first character begins at 100%, scales up to 350%, and then scales back down to 100%. The animation sequence moves through the text.

As the animation sequences through the text, small white lines travel with the animation. These lines represent selection—whatever is in between the two solid white lines is the current selection, and receives the full effect of the animation. The soft line represents the selection falloff, and "leads" the next character into the animation.
6 Add the Rotation parameter to the Sequence Text behavior. (Choose Format > Rotation from the Add pop-up menu (in the Parameter row of the Behaviors tab).

7 Set Rotation to the largest (or smallest) value you want the text to rotate in your animation. In this example, Rotation is set to 90 degrees.

The first character begins at 0 degrees, rotates to 90 degrees, and then rotates back to 0 degrees.

The animation—which begins at the default value for any added parameter, animates to the value you specify, and resolves back to the default value—cycles completely through each character because the Select parameter is set to Character by default. When Select is set to Word, each word in the text scales up and down as a single character.

8 Click the Select pop-up menu, then choose All.

All of the text characters begin at 350% scale and 90 degrees rotation simultaneously.
Note: Make sure that the Map Animation parameter is set to To Entire Object.

9 In the Parameter row, click the Add pop-up menu, choose Face, then choose Opacity.

Set the Opacity to the lowest value you want to use in your animation. In this example, Opacity is set to 0% so that the text characters begin completely transparent and fade in to become opaque.

To create a softer transition between each character, you can adjust the Spread parameter.

To adjust the Spread parameter:
- In the Behaviors tab, drag the Spread slider (or type a number in the value slider).
  This example uses a Spread value of 4.
Modifying the Sequence Text Behavior

Use the Sequence controls to repeat the animation over the duration of the text, to randomize the order in which the effect is applied to the text characters, to change the direction of the animation, to "soften" the effect between characters, and so on.

Parameter: Use the Add and Remove pop-up menus to add and remove text format and style parameters to the sequence.

Sequence Controls

Contains parameters to modify the way the animation moves through the text to randomize the animation, to change the direction of the animation, and so on.

Traversal: Use this pop-up menu to set the action of the sequence behavior to Ramp, Ping Pong, Ease In, Ease Out, Ease In/Out, or Custom.

- **Ramp:** Moves the selection from one end of the text to the other at a constant speed. The sequence moves in the direction specified in the Direction pop-up menu.
- **Ping Pong:** Moves the selection back and forth from one end of the text to the other. The sequence moves in the direction specified in the Direction pop-up menu.

  *Note:* Loops must be set to a value greater than 1 for the sequence to Ping Pong.
- **Ease In:** The sequence animation (the movement of the selection bars) begins slowly and increases to normal speed as it moves through the text.
- **Ease Out:** The sequence animation begins at normal speed and slows toward the end of the text.
- **Ease In/Out:** The sequence animation begins slowly, increases to normal speed as it moves toward the middle of the duration of the text, and slows as it reaches the end of the text.
- **Custom:** Allows you to keyframe how the selection (the animation) moves through the text. When Custom is selected from the Traversal pop-up menu, the Location parameter replaces the Loops parameter. For more information on using Custom, see “Using the Sequence Text Custom Behavior Option” on page 663.

Location: Defines the location of the text where the animation is in effect.
**Loops:** Use the slider or value slider to set the number of times the animation sequences through the text layer over its duration.

**Note:** Loops is not available when the Traversal parameter is set to Custom.

**Random:** Turn on this checkbox to randomize the selection of the text sequence. For example, a text sequence (using the Scale parameter) set to Ramp scales the text characters from one end of the text to the other. When Random is turned on, the characters are scaled in a random order.

If the Behavior parameter is set to Custom and there is a keyframed animation using the Location parameter, Random respects the keyframe values and randomizes the effect within the values set by the keyframes.

**Note:** When turned on, Random overrides the Direction parameter.

**Random Seed:** When you first enable Random, an initial random “seed” is created. If you are not happy with the randomness of the character selection when you first turn on Random, click Generate or enter a value in the field. This creates a new random seed which changes the way the characters are selected. The random variation in the text selection is based on the random seed number displayed in the Generate field.

**Note:** Generate has no effect unless Random is turned on.

**Direction:** Sets the direction of the sequence through the text to travel Left to Right (default) or Right to Left.

**Select:** A pop-up menu that specifies how the values set in the parameters (for example, Opacity set to 0%) are applied to the text. The choices include Character (default), Word, Line, All, and Custom.

- **Character:** Selects single characters of text to be affected by the values set in the applied parameters.
- **Word**: Selects the separate words of text to be affected by the values set in the applied parameters.
- **Line**: Selects the separate line of text to be affected by the values set in the applied parameters.
- **All**: Selects all characters of text to be affected by the values set in the applied parameters.
- **Custom**: Allows you to offset the start and end points of the selection (based on the location of the selection).

**Spread**: Controls the amount of falloff of the selection. To create a softer transition between each character, increase the Spread value.

![Spread parameter sequence with Spread set to 0 and 4](image_url)

Footage provided courtesy of National Geographic Television and Film Library.
**Map Animation**: The Map Animation parameter sets the timing of the animation to either “To Entire Object” or “To Selection.” In a basic example, the Scale parameter is added to the Sequence Text behavior. Next, the Scale parameter is keyframed to animate from 100% to 250% over 10 seconds. With the given example, use the following guidelines to understand the difference between the two Map Animation options.

- **To Entire Object**: Leaves the original animation timing of the sequence across the entire text layer untouched, and the selection follows the animation at its current point in time.

  Using the above example, in which Scale animates from 100% to 250% over 10 seconds, the first character in the text grows slightly and returns to its original value, the second character grows a little more, the third a little more, and so on until finally the last character grows to the full 250% value.

  **Important**: You do not need to create an animation (keyframes) to use the “To Entire Object” option.

- **To Selection**: Changes the timing of the original animation to “fit” within the selection. Each selection (by character, word, line, and so on) goes through the entire source animation as the selection moves across the text.
Using the same 100 to 250% Scale animation example, the first character grows from 100% to 250% and holds at 250%, the second character grows from 100% to 250% and holds at 250%, and so on, until all characters have completed the animation.

The Text Sequence behavior Drop & Bounce is an example of the To Selection animation mapping.

**Important:** Using the To Selection option requires a keyframed animation.

---

**Using the Sequence Text Custom Behavior Option**

When Behavior is set to Custom, you can create location keyframes to specify where the effect of the sequence is at any given time.

**To use the Custom Traversal parameter:**

1. Once the Sequence Text behavior is applied to the text, add the format or style parameters that you want to include in the sequence.

2. Set the values for the added parameters. In this example, the Scale parameter is added and the Y scale value set to 25%.

For more information on adding parameters to the Sequence Text behavior, see the steps in “To apply a parameter to the Sequence Text behavior:” on page 654.
3 Choose Custom from the Traversal pop-up menu.

In the Canvas, the first few characters are selected by default, and are affected by the Scale value.

In the Behaviors Inspector, the Location parameter becomes available.

When Traversal is set to Custom, the Location parameter becomes available. Use the Location slider to keyframe how the sequence moves through the text.

4 Enable Record (press A).

5 At the frame where you want to begin the animation, drag the Location slider (or use the value slider) to set where the sequence begins.

As you drag the slider, the selection bars move through the text characters. Values less than 0% select toward the left of the text (regardless of where the anchor point is); values greater than 100% select from the beginning of the text toward the right.
In the Inspector, a keyframe is added to the Location parameter.

6 Go to the next frame where you want to set a keyframe, and move the Location slider.
7 Repeat step 6 until you have created all of your keyframes.
8 Play the project (press the Space bar).
   The selection moves through the text based on its keyframed locations.

**Text Tracking**

The Text Tracking behavior applies rate of change to the Tracking parameter of the Format pane (in the Text Inspector). Tracking applies a uniform space between each character of text.

To use the Text Tracking behavior:
- Apply the Text Tracking behavior (from the Text Animation subcategory) to the text.
  By default, a Tracking value of 2 is applied to the text.
Once the Text Tracking behavior is applied to text, the Behaviors icon appears in the Tracking parameter (in the Format pane of the Text Inspector). As the project plays, the change in tracking value over time is displayed in the Tracking parameter field. The change in value is based on the rate set in the Rate parameter of the Text Tracking behavior.

*Note:* Just like the Tracking parameter in the Format pane of the Text Inspector, the Text Tracking behavior respects the Alignment setting of the text. For example, to track from the center of the text outward, the Alignment of the text must be set to Center. This parameter is located in the text HUD or the Layout pane of the Text Inspector.

---

**Modifying the Tracking Behavior**

Use the Tracking parameters to modify the rate and end offset of the character tracking. The identical Tracking behavior parameters appear in the HUD and in the Behaviors tab of the Inspector.

**Rate:** Controls the rate of the change in tracking values. The higher the rate, the greater the tracking values.

**End Offset:** Use the End Offset parameter to offset the end of the effect of the Tracking behavior. By default, the text characters track to the end of the duration of the text. For example, to stop the tracking animation 60 frames from the end of the text layer (or project), drag the End Offset slider to 60 or enter 60 in the value slider.

*Note:* Be sure to use the End Offset parameter to stop the effect of the tracking behavior before the end of the text layer (or project) rather than changing the duration of the Tracking behavior in the mini-Timeline or Timeline. If you trim the end of the behavior, the text snaps back to its default tracking value at the end of the behavior.
**Type On**
The Type On behavior quickly creates a “type-on” effect.

**To use the Type On behavior:**
- Apply the Type On behavior (from the Text Animation subcategory) to the text.

By default, the text “pops” on. To create a softer fade-in effect, enable Fade In in the Type On HUD or Inspector.

Because the Type On behavior is applied to the duration of the text layer to which it is applied, it takes the duration of the layer to complete the type-on effect. You can modify the time it takes the text appear on in the mini-Timeline or Timeline.

**Modifying the Type On Behavior**
Use the following guidelines to modify the default Type On behavior. The Type On controls include only a single parameter: Fade In. The identical Type On behavior parameters appear in the HUD and the Inspector.

**Fade In:** When turned on, each text character fades in rather than appearing with the default “pop” effect.

**Changing the Speed of the Type-On Effect**
As mentioned above, the type-on effect occurs over the duration of the text layer to which it is applied. In other words, if your text layer is 300 frames long and you apply the Type On behavior, the last text character is fully typed on at frame 300. You can shorten the duration of the behavior so the type-on effect is completed sooner.
To increase the speed of the type on effect:

1. Select the Type On behavior.

   The Type On behavior is selected in the mini-Timeline and Timeline.

2. Do one of the following:

   • In the mini-Timeline, click the right end (end) of the Type On bar and drag toward the left to the frame where you want the animation to end.

   As you drag, the new In point, the duration of the text layer (Type On behavior), and the delta (amount of change) are displayed.

   • In the Timeline, click the right end (end) of the Type On bar and drag toward the left to the frame where you want the animation to end.

   • Go to the frame where you want to set the new Out point, then choose Mark > Mark Out (or press O).

   By the time the playhead reaches the end of the new behavior duration bar, the type on effect is complete.

   **Note:** You can also slow the type-on effect by extending the behavior beyond the duration of the text layer.

**Text Sequence Behaviors**

The Motion Library includes more than 100 preset Text Sequence behaviors. All of the sequence behaviors are variations on the Sequence Text behavior in the Text Animation subcategory. Although the Text Sequence behaviors are predefined animations, the parameter values can be modified, and other parameters can be added or removed. For example, the Blur Fade In Text Sequence behavior animates the text Blur and Opacity values by default. However, you can add the Scale parameter to the behavior. As with all behaviors, you can save a modified behavior to the Library.

The Text Sequence behaviors are applied to text layers in the same manner as all other behaviors. However, there is one big difference between the Text Sequence behaviors and all other behaviors in Motion: Once added to text, the Text Sequence behaviors do not last the duration of the text. This is because usually—to achieve the desired preset effect—you want the animation to complete in a shorter period of time than over the duration of the text. The default duration of the behavior can be modified to slow down or speed up the effect of the animation.

Like the Text Animation and other behavior subcategories, clicking a behavior in the Library stack plays the animation in the Preview area.
Example: Using a Text Sequence Behavior
In this section, the Drop In From Left behavior is used to illustrate working with the
Text Sequence behaviors. In general, the guidelines for modifying the Drop In From Left
behavior also apply to the other sequence behaviors.

Note: Because the sequence behaviors are preset variations of the Sequence Text
behavior (in the Text Animation subcategory), the guidelines for modifying the
Sequence Text behavior also apply to the Text Sequence behaviors.

Drop In From Left
The Drop In From Left behavior creates an animation in which the text characters fade
and drop in vertically from left to right to land in their original position. The parameters
included in the behavior are Opacity and Position. The following steps begin at the first
frame of the text.

To use the Drop In From Left behavior:
1 Apply the Drop In From Left behavior (from the Text Sequence subcategory) to the text.
Because the behavior creates an animation in which the text starts above its original position and drops in, the behavior selection box moves up in the Canvas. Also, the selection bar is located at the left edge of the box because the animation starts at the leftmost text character. This appears and displays the projected motion of the text.

Once applied, the Drop In From Left behavior appears in the Layers tab and Timeline.

The HUD also appears (press F7). Remember that because the sequence behaviors are all preset variations on the Sequence Text behavior, the Drop In From Left HUD parameters are identical to the parameters in the Sequence Text behavior (in the Text Animation subcategory).
As with the Sequence Text behavior, the specific text parameters that the behavior uses to create the animation are listed in the Inspector. Because the Drop In From Left behavior uses the Opacity (from the Face controls) and Position (from the Format controls) parameters, those parameters are listed in the Inspector.

Also, because you can apply sequence behaviors to text with applied styles (such as Glow or a Library text style), all of the Style parameters also appear in the Text Sequence behavior parameters. Using the Drop In From Left behavior as an example, if the Glow and Outline are enabled for the text to which the behavior is applied, the Glow and Outline are also affected by the Opacity preset.

2 Click Play (or press the Space bar).

From left to right, the text characters fade and drop in and land in their original position. As the text animates, the selection box expands to encompass the text characters.
Modifying Text Sequence Behaviors

Use the following guidelines to modify the default Drop In From Left behavior. The difference between the parameters that are displayed in the HUD and those displayed in the Inspector is the same as with the Sequence Text behavior (in the Text Animation subcategory): The group of Sequence controls is displayed in the HUD; the affected parameters and group of Sequence controls are displayed in the Inspector.

If necessary, use the Drop In From Left parameters to modify the preset animation.

Format/Position: Because the Drop In From Left behavior animates the text characters to drop in one at a time (by default), the Position parameter is included in the behavior parameters. The value of the Y Position determines the furthest vertical point from the original position of the text. The default Y Position value is 200, which means the text animation begins 200 points above the original position of the text. To change the initial starting position of the text, enter a different number in the Position parameter value sliders.

In the following image, the Y Position value is set to 100, so the text falls a shorter distance (than the default 200 pixels). A value of 100 is also set in the X Position value, so the text falls at an angle rather than completely vertical.

Face/Opacity: Because the Drop In From Left behavior animates the opacity of the characters of text, the Opacity parameter is included in the behavior parameters. The Opacity value determines the most transparent point in the text animation. The default Opacity value is 0%, which means the text animation begins completely transparent and ends at the Opacity value of the original text. To change transparency of the text, enter a different number in the Opacity parameter value field.

Note: You can set different Opacity values for the different text style parameters (Outline, Glow, and Drop Shadow).

Sequence Controls: These controls, Behavior, Repeat, Random, and so on, are identical to the Sequence behavior controls. For more information, see “Sequence Text” on page 654.
Changing the Speed of Text Sequence Behaviors
With the Drop In From Left behavior selected, notice that the duration of the behavior is much shorter than the duration of the text layer to which it is applied. You can see this in the mini-Timeline or the Timeline. By default, the duration of a Text Sequence behavior is 60 frames.

Like the Type On behavior (in the Text Animation subcategory), you slow down or speed up the animation by changing the duration of the behavior.

To slow the sequence animation:
1 Select the sequence behavior.
2 Do one of the following:
   • In the mini-Timeline or Timeline, click the right end of the behavior bar and drag toward the right (extend the behavior) to the frame where you want the animation to end.
   • Go to the frame where you want to set the new Out point, then choose Mark > Mark Out (or press O).

**Note:** Conversely, you can speed up the animation by shortening the duration of the behavior.

Adding or Removing Text Sequence Behavior Parameters
Although the Text Sequence behaviors include predetermined parameters, you can add and remove parameters. Parameters are removed and added in the same manner as adding parameters to the Sequence Text (Text Animation) behavior—using the Parameter Add and Remove pop-up menus. The following example continues with the Drop In From Left behavior to illustrate adding parameters to a Text Sequence behavior.
To add a parameter to a sequence behavior:

1. Select the sequence behavior to which you want to add a new parameter.
2. In the Parameter row, choose a parameter from the Add pop-up menu.

The chosen parameter is added to the sequence behavior.
3 Set a value in the new parameter (Scale). In this example, the Scale value is set to 150%. In addition to the text dropping and fading in, the text Scale value begins at 150% scale and changes to 100% as the characters land in place.

4 To remove a parameter, choose a parameter from the Remove pop-up menu. The chosen parameter is removed from the sequence behavior.

**Saving a Modified Text Behavior to the Library**
As with all modified behaviors, filters, generators, and so on, you can save a modified Text Sequence behavior to the Library. This example continues using the Drop In From Left behavior from the above sections to illustrate saving a modified behavior.

**To save a modified behavior to the Library:**
1 Select the behavior you want to save.
   
   **Note:** Although not required, it is recommended that you rename the behavior to a more descriptive name for organizational purposes.

2 In the Library (press Command-2), select the location in which you want to store the behavior, such as the Text Sequence subcategory or Favorites category.

3 From the Layers tab or Timeline, drag the behavior to the Library stack. In this example, the behavior is dragged to the Favorites stack. When the green add pointer (+) and black outline around the stack window appear, release the mouse button.
The behavior is saved to the Library. A custom behavior is represented by a user icon in the lower-right corner of the Behaviors icon.

For more information saving items to the Library and organizing your custom content, see “Adding Your Own Content to the Library” on page 232.

Using Other Behaviors With Text

Because text is like all other layers in Motion, you can apply any Basic Motion, Parameter, or Simulation behavior to text layers. Because the characters of text make the object a group, you can create some unique animations using the Simulation behaviors. This section provides a quick overview to working with non-text behaviors applied to text. For more information on using behaviors, see “Using Behaviors” on page 369.

Behaviors are applied to text in the same manner as all other layers—by using the Library or the Add Behavior icon in the Toolbar. As mentioned earlier, the Library allows you to see a preview of the behavior before it is applied to text. The Add Behavior icon allows you to quickly apply a behavior to a single or multiple text layers.

To apply a non-text behavior to text, do one of the following:

- In the Library, select the Behaviors category, select a Basic Motion, Parameter, or Simulation subcategory, and drag the desired behavior from the stack to the text (in the Canvas, Layers tab, or Timeline).
- Select the text, click the Add Behavior icon, then choose the behavior you want.

In the following example, an animation is created in which the text moves and collides with the edge of the screen. You can set the text to hit the edge as a single object, or have each text character hit the edge one at a time.
To create a text animation using non-text behaviors:

1. From the Basic Motion subcategory, apply the Throw behavior to the text.

2. Adjust the Throw so that the text moves across the Canvas.

3. From the Simulations subcategory, apply the Edge Collision and Vortex behaviors to the text.

4. In the Inspector, turn on the Affect Subobjects checkbox for the Edge Collision behavior.

5. Play the project (press the Space bar).

   The text characters are swept around the screen in a vortex pattern. If the text characters start to move off the screen, they collide with the edge of the screen.

   Related Objects is the default setting in the Affect parameter of the Vortex behavior, which means that all objects within the same group are affected. You can change this to Specific Objects to select which layers are affected, or change it to All Objects.
**Note:** Remember that behaviors often contain parameters for how layers to which the behavior is applied are affected. These controls greatly affect the result of a behavior when it is applied to text. For example, if you have text on a circular path and you apply a Spin behavior to the text, the text layer rotates as a whole around its anchor point. To rotate the individual text characters, turn on Affect Subobjects in the Spin parameters.

For more information on using behaviors, see "Using Behaviors" on page 369.

### Using Behaviors to Animate Text in 3D

Although text has no inherent 3D parameters, a text layer can be moved and rotated in 3D space. Once text is placed on an Open Spline path, the text path can be manipulated in 3D space. Simulation behaviors can also influence text characters to move out of their X and Y planes into Z space. The text must be a member of a 3D group to be pulled out of the X and Y planes by a behavior.

For example, you can apply an Orbit Around behavior to a text layer and assign a target object that is offset in Z space. With Affect Subobjects turned on and all three axes (X, Y, and Z) enabled in the Orbit Around behavior, the text characters circle about the target object in X, Y, and Z space.

When Face Camera is turned on (in the Text Layout pane), the text characters actively face the camera if the camera or text is rotated.
Tip: When working with text in a 3D project, especially text that moves close to the camera, set the Render Quality in the View pop-up menu or the View pull-down menu to Best before exporting (choose View > Render Quality > Best). Use Normal when working in your project, as Best mode dramatically slows your project’s interactivity. You can also set the Render Quality on export in the Export Options dialog: Choose Export, click Options, then choose Best from the Render Quality pop-up menu. To customize an export, turn off the “Use current project and canvas settings” checkbox.

For more information about 3D effects in Motion, see “3D Compositing” in the Motion Supplemental Documentation PDF.

Animating Text with Keyframes
You can create keyframes for most of the text parameters. As with all layers in Motion, there are two ways to create keyframes: the Record button in the transport controls or the Animation menu in the Inspector. The following example uses both methods to animate text Tracking and Opacity.

Note: Most text behaviors automatically animate the text parameters without creating keyframes. For example, when the Tracking behavior is applied to text, the tracking occurs at the rate specified in the behavior. For more information, see “Using Text Animation and Text Sequence Behaviors” on page 648.

Example: Creating Text Tracking and Opacity Keyframes
The following example animates text to fade in as the tracking animates. You can also create this same effect using the Fade In/Fade Out behavior (in the Basic Motion behavior category) and the Tracking behavior (in the Text Animation behavior category).
Using Keyframes Versus Using Behaviors

The text animation method you use (keyframing or behaviors) depends on your project, or more specifically, your timing needs. In general, if you need a very specific action to happen at a specific point in time in your project, use keyframing. For example, if you want text to be completely transparent at frame 1, become completely opaque at frame 60, become transparent again at frame 90, and opaque again at frame 120, use keyframing. Keyframes apply specific values to a layer’s parameters at certain frames.

If the effect is more general, for example, you want the text to be completely transparent at frame 1, become opaque over frames 60-90, and become transparent by frame 120, use the Fade In/Fade Out behavior. Behaviors generate a range of values that are applied to a layer’s parameters.

You can combine keyframing and behaviors on all layers in Motion. For example, if you keyframe text opacity, you can then apply the Tracking behavior to automatically animate the text tracking, or you can keyframe the Tracking parameter. Keep in mind, however, that if you keyframe the text Opacity parameter, and then apply a Fade In/Fade Out behavior to the text, unexpected results may occur. For more information on combining behaviors and keyframes, see “Combining Behaviors with Keyframes” on page 398.

To create text tracking keyframes:
1. Go to the frame where you want to start the tracking animation.
2. Select the text.
3. Enable Record (press A).
   When enabled, the Record button pulses red and a keyframe is automatically created whenever you change the value of a parameter.
4. In the Format pane of the Text Inspector, enter the first Tracking value.
   Because keyframing is enabled, a Tracking keyframe is created. The lower the Tracking value, the closer the text characters are to each other.
5. Go to the frame where you want to end the tracking animation.
6. Enter the end tracking value.

To create text opacity keyframes:
1. Go to the frame where you want to start the opacity animation.
2. Click Style, and set the first Opacity value.
3. Go to the frame where you want to end the opacity animation.
4. Enter the end Opacity value.
5. Disable Record.
To view the keyframes for a text parameter in the Keyframe Editor, click that parameter’s Animation menu icon, then choose Show in Keyframe Editor. For more information on the Keyframe Editor, see “Animating in the Keyframe Editor” on page 526.

**Using LiveFonts**

The Motion Library includes ten LiveFonts that can be applied to text. LiveFonts are complete animated character sets that are a part of the LiveType titling application that is included with Final Cut Pro. If you have Final Cut Pro with LiveType installed on your system, all of the LiveType fonts can be used in Motion.

**To preview the LiveFonts:**
1. In the Library, click the LiveFonts category.
   The available LiveFonts are listed in the stack.
2. Click a LiveFont in the stack.
   The preview of the animated font plays in the Preview area.

The following image shows the original text prior to the application of the LiveFont.

![Original text image]
To apply a LiveFont to text, do one of the following:

- Drag the LiveFont from the Library to the text in the Canvas, Layers tab, or Timeline.

Depending on the frame where you apply the font, the font may not appear, may appear partially drawn, or may appear complete.

- Select the text, select the LiveFont in the Library, then click the Apply button in the Preview area.
- Select the text, select LiveFonts from the Font Type pop-up menu in the Format pane of the Text Inspector, then choose the specific LiveFont from the Family pop-up menu.
Modifying Applied LiveFonts

Use the following guidelines to modify the default LiveFont animation. The LiveFont parameters only appear in the Format pane of the Text Inspector once a font is applied to text.

Because LiveFonts are movies, they are applied with default timing settings. You can modify the timing settings, such as randomness, play direction, start time and so on, using the LiveFont Timing parameters.

Random: Drag the slider or use the value slider to apply the LiveFont movie to each character in the text in a different order. For example, the Freehand font movie draws the characters from the first character to the last. When you apply a Random value, the characters are drawn (the movie plays) in random order.

Random Seed: Click Generate or enter a value in the field to create a new random “seed” that changes the way the LiveFont movie is applied to each character. The random variation in the text selection is based on the random seed number displayed in the Generate field.

Note: Generate has no effect unless a Random value is set.

Sequence: Controls the timing of the sequence. Using the Freehand font as an example, the default Sequence value for the Freehand font is 50%, which “draws” (the movie plays) the text characters on one at a time in sequence. When Sequence is set to 0, all characters are drawn at the same time.

Direction: Sets the direction of the animation to run From Left, From Right, or Ping Pong.
**Speed:** Allows you to play the LiveFont movie more quickly or slowly based on a percentage of the default speed.

**Play:** Sets the LiveFont movie to play Forward, Backward, or Ping Pong. This is not the same as the Direction parameter. Using the Freehand font as an example, when Play is set to Backward, the text begins completely drawn and erases (in the direction specified in the Direction parameter).

**Loop:** Sets the number of times the LiveFont movie plays through. The default setting is 1, meaning that the LiveFont plays one time. A value of 3 means that it plays through three times. For example, when the Loop parameter of the Freehand font is set to 3, each character is drawn one time, then disappears, is drawn a second time, then disappears, and is drawn a third time and remains.

**To End:** Loops the movie until the end of the text duration.

**Note:** When To End is enabled, the Loop parameter is ignored.

**Hold First:** Drag the slider or use the value slider to set the delay, in seconds, of the start of the font’s “animation.” For example, when using the Freehand font and Hold First is set to 3, the text does not begin to “draw on” for 3 seconds.

**Note:** The font “animation” varies depending on the LiveFont and can include the drawing on of the font, the moving of highlights around the font, and so on.

**Hold Last:** Drag the slider or use the value slider to set the amount of time, in seconds, that the font stays visible once the movie is completed. For example, when using the Freehand font and Hold Last is set to 0, the text disappears as soon as it is finished drawing.
Using particle systems, you can simulate real-world effects such as smoke and sparks, or you can bend the rules and create sophisticated abstract textures.

Particle systems allow you to quickly and easily create sophisticated animated effects involving large numbers of automatically animated objects. You can use the included particle emitters library to add a pre-made particle system to your composition, or you can create your own custom particle effects using nearly any layer or group in your project. Particle systems in Motion are flexible enough to create many different kinds of effects.
For step-through examples of creating particles, including how to set up a 3D particle system, see “Particle System Examples” on page 741.

Particle systems consist of two basic elements: a cell and an emitter. Think of the cells as the “mold” for the particles that are generated by the emitter. You can use nearly any layer or group in Motion as a source for a particle cell, including images, shapes, text, movies, and image sequences. Each particle that is created is essentially a duplicate of the original cell, and is animated according to the parameters for that particle system (a particle cell and emitter) over its lifetime.

The layer you use as a particle system’s cell determines how that particle system looks. Particle systems can contain multiple cells, resulting in the release of several types of particles from a single emitter. You’ll find that many of the most sophisticated particle presets are constructed in this way.
Anatomy of a Particle System

Every particle system is made up of an emitter and one or more particle cells. Each cell appears inside of the emitter in the Layers tab and the Timeline.

The emitter and cells have separate sets of parameters that control the particle system's behavior. If you imagine that a garden hose is a particle system, the nozzle acts as the emitter, while the water represents the flow of particles. Changing the parameters of the emitter changes the shape from which the particles are emitted and their direction, while changing the cell's parameters affects each individual particle.

By changing a few parameters, it’s possible to create very different effects using the same cell.

*Note:* In a particle system, cells and particles are not the same thing. A cell is a layer (in the Layers list) that acts as the “mold” for the particles (the multiple objects generated in the Canvas). The cell itself is a copy of a source object (*cell source*) that appears dimmed (disabled) in the Layers list, and therefore is by default not visible in the Canvas.

As with any effect in Motion, particle system parameters can be keyframed in order to change a particle effect’s dynamics over time. For example, you can create a path of bubbles that follows an object onscreen by keyframing the emitter’s Position parameter. For more information on keyframing, see Chapter 6, “Keyframes and Curves,” on page 503.
You can also track an emitter to a moving object in a clip, or apply existing tracking data in your project to an emitter. For more information on using the Motion Tracking behaviors, see “Motion Tracking” in the Motion Supplemental Documentation PDF.

In addition, you can add behaviors to each cell or to the emitter itself to create even more varied effects (simulation behaviors can be especially effective). Any behavior that you apply to a cell is in turn applied to each particle it generates. This lets you achieve almost limitless variation. Adding behaviors to cells in addition to the particle system’s own parameters is an easy way to create complex, organic motion that would be impossible to accomplish any other way. You can also apply a behavior to another object in your project (an object that is not part of the particle system), such as Repel, and have the particles weave around that object.

**Cell Source**

Each cell in a particle emitter is a copy of a source object known as the cell source. The cell source appears dimmed (disabled) in the Layers list, and therefore does not appear in the Canvas. Almost any layer in Motion can be used as a cell source, including shapes, text, images, image sequences, and clips. Transformations that you apply to the source are respected in the cell layer, which in turn propagates those transformations to the particles that are generated in the Canvas. For example, if you use a rectangle shape that is sheared and rotated as the cell source, particles created using that rectangle as the cell source are sheared and rotated.

If the layer used as the cell source for the particle system has applied filters, the effects of the filters are retained in the particles.

*Note:* Keep in mind that using a movie with applied filters as a particle cell source adversely impacts your computer’s processing performance. For better performance, export your sequence with the filter applied, then import it back into Motion and use the movie as the cell source.
Using Particle Systems
Despite their sophistication, particle systems are easy to set up and simple to use. This section describes how to use pre-made particle systems from the Particle Emitters category of the Library. Afterward, this section explains how to create a simple particle system of your own.

Particle Systems and Layer Sizes
Particle systems often create particles that grow or move off the Canvas before they die. This can make the size of a layer or group much larger than that of the Canvas. Although the particles are not visible once they move off the Canvas (unless Show Full View Area is turned on in the View menu), they are still present in the project and are processed. If you apply a filter to a layer containing growing particles, or use that layer as a source object, it is recommended that you turn on the Fixed Resolution checkbox in the Group tab of the Inspector (available only when a group is the selected object). The Fixed Resolution parameter allows you to set the specific width and height of a group, cropping anything beyond those values. For more information, see “Fixing the Size of a Group” on page 244.
Using the Particle Library

The easiest way to add a particle system to your project is to use one of the presets from the particle library. The particle library is located in the Particle Emitters category of the Library, and is a collection of pre-made particle effects that you can add to your project. There are many types of particle effects to choose from. If you find one that is close to what you need, you can easily customize its parameters after you add it to your project. Particle systems are added to a project exactly like any other object.

To add a particle system from the Library:

1. In the Library, click the Particle Emitters category.
2. Click one of the particle subcategories, such as Nature, Pyro, SciFi, and so on.
3. Select a particle preset in the Library stack.
An animated preview of the selected particle emitter plays in the Preview area. While it is playing, you can drag the pointer around in the Preview area to see how the particle looks while in motion.

**Note:** If the preview does not automatically start playing, click the Play button in the Preview area. To automatically play items selected in the File Browser or Library, choose Motion > Preferences (or press Command-comma), then select “Play items automatically on a single click” in the File Browser & Library section of the General pane.

4 When you find a particle preset you want to use, do one of the following:

- Click Apply to add the selected particle system to your project at the center of the Canvas. It is added to the current layer.
  
  **Note:** If Create Layers At is set to “Start of project” in the Project pane of Motion Preferences, the particle system is added at the first frame.

- Drag the particle system into the Canvas to the position where you want it to appear.

- Drag the particle system into a group in the Layers tab or Timeline layers list. The particle system appears at the center of the Canvas.

- Drag the particle system to the track area of the Timeline. When you reach the frame where you want the new particles to start, release the mouse button.
The new particle system layer appears in your project, composited against any other layers that you’ve already added.

**Motion Blur and Particles**

To achieve the optimal look for the following particle emitters, it is recommended that you enable motion blur in your project:
- Jelly Bands
- Light Transit 1
- Light Transit 2
- Light Transit 3
- Light Transit 4
- Rain Streaks
- Silly String 1
- Silly String 2

*Note:* To enable motion blur, choose Motion Blur from the View pop-up menu, or choose View > Motion Blur (or press Option-M).

Once you have added a particle system from the Library, it acts exactly as it appeared in the Preview area. If necessary, you can edit a particle system’s Emitter parameters in the HUD to tailor it to your own use.

*Note:* You can only modify a particle system after it’s been added to a project.

The HUD displays a selected particle system’s most essential parameters, including the size and number of particles that are created, how long they remain onscreen, how fast they move, and the direction and area in which they travel. Select an individual cell in the Layers tab or Timeline to edit its parameters in the HUD.

For more detailed information on using the particle HUD, see “Customizing a Particle System Emitter” on page 696. For more comprehensive information on customizing all of a particle system’s parameters, see “Advanced Particle System Controls” on page 712.

**Creating a Simple Custom Particle System**

While Motion comes with a wide variety of particle system presets, many times you’ll want to create something completely new. Creating a particle system begins with selecting a layer in your project to use as the source for a cell within a new particle emitter.

You can use any layer in your project as a source for a cell in an emitter, including still graphics, animation or video clips, or shapes created in Motion. The layer you select when you create an emitter becomes the first cell in that particle system. In the Layers tab, cells appear as a sublayer under the emitter layer. The cell specifies the look of the actual particles generated in the Canvas.
Note: You can also use a group as the source for an emitter cell, but keep in mind that your project’s interactivity may slow drastically.

To create an emitter:
1. Place a layer that you want to use to generate particles into your project.
   This example uses an image of a simple white circular gradient, such as the “basic blur.png” image located in the Library (in the Particle Images subcategory of the Content category).

2. Move the layer in the Canvas to the location where you want the center of your particle system to be.

3. Select the object, then do one of the following:
   - In the Toolbar, click the Make Particles icon.
   - Press E.
Once an emitter is added to the project, the following occurs:

- An emitter appears in the Layers tab and is selected.
- A cell containing the image to be “particle-ized” appears underneath the emitter.
- The original source layer (the cell source) is disabled.

**Note:** Changes made to the original source layer, such as opacity or shearing, are respected in the particles even after the emitter is created.

- In the Canvas, the emitter bounding box appears, which can be transformed using the onscreen controls.
- The first particle appears in the Canvas in the same location as the original layer. Although it appears as if the particle is selected, the bounding box represents the emitter.
- The Emitter HUD is displayed. If you have hidden the HUD, press F7.

**Note:** For projects with a frame rate greater than 30 frames per second (fps), at times only the bounding box (not the first particle) may appear at the first frame of your project. Because, by default, particles are generated at 30 particles per second, there is no guarantee that a particle will appear on every frame.

By default, the first frame of a new particle system (with a single cell) has one particle. If you play your project, additional particles are generated and emerge from the center of the emitter.
By default, new cells emit one particle per frame in all directions (for 30 fps projects), and each particle moves 100 pixels per second away from the emitter over a lifetime of 5 seconds (150 frames in a 30-frames-per-second project).

**Note:** The Initial Number parameter in the Emitter or Particle Cell tab of the Inspector allows you to change the default behavior so that a particle system begins with a burst of particles at the first frame. For more information, see “Advanced Particle System Controls” on page 712.

**The Predictability of Particle Systems**
When you create a particle system or modify one of the parameters of an existing particle system, the path of each particle in that system is immediately calculated and predetermined. While the number and motion of particles may seem random, they are actually completely predictable based on that system’s parameters. Playing the same particle system twice with the same parameters results in exactly the same particle motion. This means that once you create a particle system that looks right, it is always the same.

**Using Multiple Cells Within a Single Emitter**
When you create a particle system from scratch, you don’t have to restrict yourself to using just one cell. You can create a particle system that emits many different kinds of overlapping particles by placing multiple cells inside of a single emitter in the Layers tab.

You can add as many cells as you want within a single emitter. Each cell has its own particle cell parameters that govern how particles from that cell are created. When selected in the Layers tab, each cell displays its own Particle Cell tab in the Inspector. Particle systems with multiple cells generate particles from each cell simultaneously, according to each cell’s parameters.

For an example of using multiple cells within a single emitter, see “Example 2: Creating Animated Pixie Dust” on page 744.
Additional cells can be created by either selecting multiple sources when initially creating the emitter, or by dragging additional source layers onto the emitter in the Layers tab.

*Note:* When multiple sources are used to create a particle system, the resulting emitter is positioned at the average of the sources’ position.

**Customizing a Particle System Emitter**

When you create an emitter, the particle system starts working according to the default parameters in its Emitter and Particle Cell tabs, located in the Inspector. You can use the Emitter HUD to easily change the most important of these parameters to suit your needs.

**To display the HUD for a particle emitter:**

- Select the emitter for which you want to display the HUD.
- The HUD appears when you select the emitter. If the HUD does not appear, press F7.

**Emitter HUD Parameters**

The HUD contains the most frequently used emitter controls that are necessary to modify a particle system’s size and shape. These parameters are a subset of those found in the Emitter tab of the Inspector. In 2D projects, the Emitter HUD contains a group of sliders and the emission control, which provides a visual way to manipulate three different particle system parameters—Emission Range, Emission Angle, and Speed.

![2D Emitter HUD](image)
When 3D is enabled in the Emitter tab of the Inspector, the Emitter HUD offers additional 3D controls. In 3D, the emission control modifies the Emission Latitude and Emission Longitude parameters.

![3D Emitter HUD](image)

3D Emitter HUD

When an emitter and the Adjust 3D Transform tool (in the Toolbar) are selected, the 3D Emitter HUD expands to display additional controls that allow you to transform the emitter in X, Y, and Z space, regardless of whether the group containing the emitter is 2D or 3D.

![3D Emitter HUD](image)

For more information on using the 3D transform controls in the HUD, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.
For particle systems containing multiple cells, the Emitter HUD parameters simultaneously modify the effect of each cell’s parameters relative to one another. This means that for a particle system consisting of two cells with different scale values, changing the scale in the HUD resizes both cells simultaneously. For example, increasing the scale in the HUD by 200% does not change the scale of both cells to 200%, but resizes the cells relative to their original scale values.

For this reason, in emitters with multiple cells, the HUD parameters are displayed as percentages. When you modify the parameters of a single cell, the cell parameters are adjusted directly.

**Birth Rate:** A slider defines how many particles are created every second.

**Life:** A slider defines how long each particle remains onscreen (in seconds) before disappearing from existence.

**Scale:** A slider defines the size of each particle, relative to the original size of the cell.

**Emission Control:** A graphical control that lets you modify several parameters.

- **Emission Range (2D only):** Drag the two points on the outer ring of the graphical emission control to define the range of degrees at which particles are generated. In other words, the Emission Range parameter defines the size of the “slice” of the pie graph that the particles fill when generated.

- **Emission Angle:** Drag inside the emission control to change the direction in which particles are emitted, inside the area defined by the Emission Range.

- **Speed (2D only):** Drag inside the emission control to shorten or lengthen the arrows to define how quickly particles move away from the emitter.

Use the following modifier keys to more precisely manipulate the graphical emission control in the HUD:

- **Shift** (while adjusting Angle): restricts angles to 45 degree increments.
- **Shift** (while adjusting Range): When working with a 2D emitter, restricts to 22.5-degree increments.
- **Command**: When working with a 2D emitter, adjusts Angle only.
- **Option**: When working with a 2D emitter, adjusts Speed only.
- **Emission Latitude/Emission Longitude (3D only)**: When using a 3D particle emitter (when 3D is turned on in the Emitter tab of the Inspector), the emission control of the HUD lets you modify the Emission Latitude and Emission Longitude.

Drag the sphere in the center of the circle to modify the emission direction (in degrees latitude and longitude) of the particles. You can also enter specific values in the Emitter tab of the Inspector.

Drag the Emission Range slider (above the sphere) to define the range of degrees at which particles are generated. In other words, this control defines the size of the cone that the particles fill when generated in 3D space.
**Emission Latitude/Emission Longitude:** These combined parameters specify the emission direction (in degrees latitude and longitude) of the particles. You can enter specific values in the Emitter tab of the Inspector.

**Using the HUD to Create a Simple Smoke Effect**
In this example, use the Emitter HUD to create a smoke effect. Use the emitter created in “Creating a Simple Custom Particle System” on page 692. A Blur image from the Content category in the Library will serve as the cell source.

Before making adjustments to the selected particle system, it may be helpful to move the playhead forward in the Timeline to a frame where you can see the particle system in full effect. That way, any adjustments you make are readily apparent.

The first thing you may notice in this example is that the size of each particle is so big that it’s hard to make out any texture in the particle system.

**To modify the particles’ appearance using the Emitter HUD:**
1. In the Emitter HUD, drag the Scale slider to the left to reduce every particle’s size so that the individual particles are more textured.
2 In the HUD, click anywhere along the outer edge of the emission control and drag to define a narrow segment that limits the range of the angle at which particles are created (the emission range).

Both points defining the emission range rotate around the center of the emission control symmetrically, so your initial wedge points to the right. As you adjust the emission range, the particles rearrange themselves in the Canvas, enabling you to see the resulting effect.

3 To make the particles drift upward, drag in the middle of the Emission Range segment, rotating the arrow counterclockwise until it points up and slightly to the right of the center control.

The emission angle of the particles updates in the Canvas to reflect the new setting in the HUD.
4 Drag to lengthen the arrow so that it is approximately halfway between the center and the edge of the emission control to create a slowly drifting column of particles.

Remember: While the angle of the arrow controls the emission angle of the particles, the length of the arrow controls the speed of the particles. The longer the arrow, the faster the particles, and vice versa.

At this point, the particles are all moving in the correct direction, but there aren’t very many of them (there isn’t much of a fire yet).

5 Move the Birth Rate slider to the right to increase the number of particles created by the emitter.

As you increase the birth rate, more particles are created, forming a nearly unified column of “smoke.” The particles move farther apart as they drift away from the emitter.

As you can see, a single object can be used to create a credible column of smoke rising gently into the sky.

While the HUD controls are quite powerful, the Emitter and Particle Cell tabs in the Inspector have many more parameters you can customize. For more information, see “Advanced Particle System Controls” on page 712.
Modifying Emitter Properties
Emitter parameters can be modified in the Properties tab of the Inspector like any other object in Motion.

Note: The only parameter that appears for cells in the Properties tab of the Inspector is Timing.

Transform Parameters
As a particle system plays, the cells in the system are duplicated, according to the parameters for that system, to create each individual particle in the Canvas. Because all particles emerge relative to the position of the emitter (because the emitter can be a point, a circle, geometry, a sphere, and so on), changing the emitter’s position in the Canvas also changes the position of every particle in that system.

The exception to this is if the emitter’s position is animated using a behavior or keyframes. In this case, particles emerging from the emitter’s position at each frame continue to move relative to that position, regardless of changes to the emitter’s position in subsequent frames. This results in a trail of particles following the path of the emitter.
The Attach to Emitter parameter in the Particle Cell tab of the Inspector modifies this behavior. When set to 0%, the particles are completely independent of the emitter. When set to 100%, the particles try to keep up with the position of the animated emitter. Depending on any applied behaviors, such as Drag, the particles may not be able to keep up with the emitter.

Modifying an emitter’s other transformation parameters (Rotation, Scale, Shear, and Anchor Point) changes the distribution of particles from that emitter and transforms each particle. For example, if you create an emitter, then modify its Shear parameter, the distribution of the emitted particles changes to reflect the new plane of the emitter, and the particles are sheared along the same plane.

**Blend Mode**
Any changes you make to the opacity or blend mode parameters for an emitter are applied to the particle system as a whole—the result of the emitter is blended into the scene. For more information about blend modes, see “Using Blend Modes” on page 290. For more information about the Preserve Opacity setting, see “Preserve Opacity Option” on page 289.

**Note:** Within the emitter, the particles can be blended additively or normally (using the Additive Blend checkbox).

**Lighting**
A 2D or 3D emitter can interact with lights in a 3D project. As with all layers, the Shading pop-up menu must be set to On or Inherited for the lights to affect the particles. For more information on using lights, see “3D Compositing” in the Motion Supplemental Documentation PDF.

**Drop Shadow**
Drop shadows can be applied to a 2D particle system. When the Drop Shadow parameter is enabled for the source object (in the Properties tab in the Inspector), each generated particle appears with a drop shadow. For more information on working with drop shadows, see “Drop Shadows” on page 309.
Note: This parameter is not available with the Box or Sphere emitter shapes, or when the 3D checkbox is turned on in the Emitter tab of the Inspector.

Four Corner
The Four Corner controls in the Properties tab allow you to stretch an emitter into different polygonal shapes by moving the corner points. Adjusting the corners of the emitter affects the entire system.

Note: This parameter is not available with the Box or Sphere emitter shapes, or when the 3D checkbox is turned on in the Emitter tab of the Inspector.

Crop
The Crop controls in the Properties tab allow you to hide portions of a particle system. You can also use the onscreen cropping controls by choosing the Adjust Crop tool from the Toolbar, then dragging any of the replicator object’s four edges or corners.

Note: This parameter is not available with the Box or Sphere emitter shapes, or when the 3D checkbox is turned on in the Emitter tab of the Inspector.

For more information on cropping objects in Motion, see “Cropping Objects” on page 278.

Masks
As shown in the following images, you can apply masks to the cell source layer of a particle emitter.

![Original source layer](image1)
![Bezier mask applied to source layer](image2)
![Resulting particle system](image3)
You can also apply masks to the emitter object itself.

For more information on working with masks, see “Masking a Layer or Group” on page 1087.

**Timing**

Once you create a particle system, its duration can be as long or short as necessary, regardless of the duration of the original layers used to create the particle system. The duration of a particle system is defined by the duration of the emitter object. Changing the In or Out point of an emitter in the Properties tab, Timeline, or mini-Timeline changes the duration of the entire particle system.

By default, particles are generated by every cell in a system over the entire duration of the emitter. The duration of each individually generated particle is defined by the Life parameter of the cell that generated it, and not by the duration of the cell itself.

The duration of the cell actually controls the duration over which new particles are generated. You can change a cell’s duration by dragging either its position or its In and Out points in the Timeline. In this way, you can adjust the timing that defines when each cell’s particles emerge.
For example, you can create a particle system that simulates an explosion by offsetting the appearance of three different types of particles. First, dense white particles emerge from the center. Half a second later, more diffuse orange particles appear around a larger area. One second after that, small sparks emerge from underneath both of these layers as they fade away.

You can offset a cell in the Timeline or mini-Timeline to start before the emitter. This creates a “preroll” in which the particle simulation starts before the particles are drawn.

For more information on adjusting the timing of layers in the Timeline, see “Using the Timeline” on page 321.

**About Rasterization and Groups**

Some operations, as well the application of certain filters or a mask, cause a group to be rasterized. When a group is rasterized, it is converted into a bitmap image. Because all particles live in groups, this affects how particles interact with other objects within your project. For more information on rasterization, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.
Additionally, a 3D emitter (with the 3D checkbox turned on and Render Particles set to In Global 3D (Better) in the Emitter tab of the Inspector) can be rasterized independently of the group in which it lives. This affects how the particles interact with objects within their own group. For example, applying a Circle Blur filter to an emitter causes the particles to no longer intersect with other objects in the same group. The same operations that cause a 3D group to rasterize cause a 3D emitter to rasterize. To minimize this effect, apply the filter directly to the emitter’s source object, or turn off 3D in the Particles tab.

Rasterization affects 2D and 3D groups in different ways. When a 2D group is rasterized, the blend modes on objects within the group no longer interact with objects outside of the group. In the following illustrations, the non-rasterized 2D group that contains the emitter is set to the Add blend mode. The particles interact with the object beneath it in the project.

The particles group is not rasterized. The particles blend mode interacts with the group beneath it in the project.
In the next illustrations, the group that contains the emitter is rasterized. The rasterization is triggered by turning on Four Corner in the Group's Properties tab. The emitter’s Add blend mode no longer interacts with the group beneath it in the layer stack. Notice that the icon for the rasterized group now appears with a frame around its icon. This is called a *rasterization frame*.

![The group containing the emitter is rasterized, indicated by the frame around its icon.](image1)

![The emitter blend mode no longer interacts with the group beneath it in the project.](image2)

In addition, when a 3D group—a group or a 3D emitter—is rasterized, the group as a whole can no longer intersect with objects outside of the group. The rasterized 3D group is treated as a single object and uses layer order, rather than depth order, to composite the project. In the following illustration on the left, the nonrasterized group that contains the particle emitter intersects with images from another group (when Render Particles is set to In Global 3D). In the illustration on the right, a Bloom filter applied to the particles group has triggered a rasterization, so the emitter no longer intersects with images from another group.

![3D particles before the group is rasterized. The two orange texture movies exist in another group that is interacting with the emitter.](image3)

![The particles after the group is rasterized. The particles now exist in their own 3D world and no longer intersect with objects outside of their own group. Because the movie group is underneath the particles group in the Layers list, it appears behind the particles.](image4)
Note: When a group is rasterized, cameras and lights in the project still interact with objects within the rasterized group.

Changes to the following parameters trigger the rasterization of a group:

**2D Groups**
- Making blending changes (Opacity, Blend Mode, Preserve Opacity)
- Turning on Drop Shadow
- Turning on Four Corner
- Turning on Crop
- Applying any filter
- Adding a mask
- Adding a light

**3D Groups**
- Making blending changes
- Applying certain filters
- Adding a light to a 3D group with the Flatten parameter enabled (in the Group tab of the Inspector)

Once an operation causes a group to rasterize, the following occurs:
- A rasterization indicator appears next to the parameter in the Properties tab.
- A small outline appears around the icon of the rasterized 2D group, 3D group, emitter, replicator, or text object in the Layers tab and Timeline layers list.

Note: Unlike vector graphics, rasterized groups lose quality when scaled.

For more information on rasterization and 3D groups, see “3D Compositing” in the Motion Supplemental Documentation PDF.
Creating Graphics and Animations for Particle Systems

Creating a new particle system from scratch begins with designing the particles you want it to emit. You can use any image, shape, text, or movie supported by Motion as a source for a cell. This section presents things to keep in mind when you create particle imagery.

Creating Still Image Graphics for Particle Systems

Particle systems that use still images as their cell sources render in real time much faster than systems that use video or animation clips. A still image is often all you need to create a compelling particle system. Here are some guidelines for creating graphics for use as particles.

Graphics Size

If you are unsure what size you want your particles to be, it's a good idea to make your graphics larger rather than smaller. Increasing the size of particles beyond the size of the original graphic may introduce unwanted artifacts. One caveat, however, is that the larger the cell source size, the slower your interactivity.

Particle Edges

Keep in mind that the quality of the edges of your graphics can be extremely important for creating convincing particles. Soft, translucent edges might look better than hard, over-defined ones.

Object Color

By default, particles are created using the original colors of the image being used as the cell. If necessary, you can tint the emitted particles using the Color Mode parameters in the Emitter and Particle Cell tabs. Choose between tinting all particles by a single color or creating a gradient tint that changes color over time. You can also choose to apply a Library gradient to the particles. Tinting particles applies the tint color uniformly over the entire particle system.

Create Graphics with an Alpha Channel

Always create graphics that you want to use as cells with predefined alpha channels. For more information on importing files with alpha channels, see “More About Alpha Channels” on page 212.

Creating Animations to Use as Cells

You can also use QuickTime movies as cells. For example, you can create an animation in Motion, render it as a QuickTime movie, and import it into another Motion project to use as a cell. In general, the same recommendations for creating still graphics apply to the creation of animation or video clips you intend to use as cells, but there are additional considerations.

If a clip has been retimed, in the Properties tab or with a Retiming behavior, the effect of the retiming is carried through to the particles system.
Note: Keep in mind that using a movie as the source cell for an emitter may impact your project’s interactivity.

Create Clips That Loop
Particles created from QuickTime clips loop over and over for the duration of each individual particle’s life. If the clip you use doesn’t loop well, there will be a jump cut at every loop point. Another option is to use very short movies to introduce randomness into the appearance of the particle system.

Use Video Clips with Minimal Compression
Ideally, QuickTime clips to be used as particles should be saved using a high-quality codec, such as Animation or Uncompressed 8- and 10-bit 4:2:2. Other codecs can be used, but they may introduce unwanted artifacts depending on the level of compression used.

There is an option to use random start frames, which cause the clips to play out of sync relative to one another in the Canvas. There is also an option to play or not play the clip. For more information, see “Additional Cell Parameters for QuickTime Movies” on page 733.

Advanced Particle System Controls
While the HUD provides a fast way to modify a particle system’s main parameters, the particle system’s Emitter and Particle Cell tabs in the Inspector give you total control over every aspect of that particle system. This includes individual parameters for each cell in a system.

The Difference Between Emitter and Particle Cell Parameters
Emitter and Particle Cell parameters, though closely related, serve different purposes. Emitter parameters control the overall shape and direction of the animated mass of particles generated by the system. Other emitter parameters simultaneously modify the parameters of all cells inside that emitter.

Particle Cell parameters, on the other hand, control the behavior of particles generated from each cell that’s inside the particle emitter. For more information, see “Single-Cell Emitter and Particle Cell Parameters” on page 725.

When only one layer is used as a particle cell source, the cell controls appear in the Emitter tab as well as in the Particle Cell tab. Once more than one layer is added to a Particle Emitter, all cell controls appear in the Particle Cell tab. To access this tab, the cell must be selected in the Layers tab or Timeline.
Emitter Parameters
Several parameters in the Emitter tab are identical to those found in the Emitter HUD, with one difference. While the emission control in the Emitter HUD allows you to manipulate the Range, Angle, Latitude (3D), Longitude (3D), and Speed parameters using a single, graphical control, the Emitter tab uses individual controls for each parameter.

Note: There is no way to directly control the animation of individual particles.

Important: The emitter parameters in the Properties and Emitter tabs can be keyframed to change values over time.

Curve Appearance in the Keyframe Editor
The selected object determines which curves appear in the Keyframe Editor (when Animated is selected from the Show pop-up menu in the Keyframe Editor list):

- Select the emitter to display animated emitter parameters such as Position and Rotation (in the Properties tab) or Emission Angle and Range (in the Emitter tab).
- Select the cell to display animated parameters such as Birth Rate or Angle (in the Particle Cell tab).

Note: To manually send an animated parameter to the Keyframe Editor, click the parameter’s Animation menu, then choose Show In Keyframe Editor.
The parameter is displayed in the Keyframe Editor in a new, untitled curve set.

**To open a particle system’s Emitter tab:**
1. Select an emitter object in the Layers tab, Timeline, or Canvas.
2. In the Inspector, click the Emitter tab.

The Emitter parameters appear.

The contents of the Emitter tab are dynamic, and different parameters appear depending on the number of cells in the particle system, the emitter shape that’s used, and whether 3D is turned on or off.

**Single Cell Versus Multi-Cell Emitter Parameters**
At first glance, many of the parameters in the Emitter tab appear to mirror identically named parameters in the Particle Cell tab. If a particle system has only one cell, the Emitter tab displays all of the parameters for the cell, as well as the emitter’s own parameters. In this case, you can control every aspect of the particle system directly from this single tab, which saves you from having to go back and forth between the Emitter and Particle Cell tabs.
If a particle system has two or more cells, the Emitter tab looks much different. The list of parameters is much shorter, and the majority of the cell parameters are replaced with a smaller group of master controls.

Changes made using the master controls modify the effect of each cell’s parameters relative to the other cells in the system. This means that for a particle system with three cells that have different Scale values, increasing the Scale parameter in the Emitter tab multiplies the Scale value of all three cells by the same percentage. This has the result of increasing or reducing the size of every particle in the system, while keeping the size of each particle relative to one another the same.

For this reason, the master control parameters of multi-cell particle systems appear as percentages.

**Emitter Shape Parameter**
The first parameter in the Emitter tab is the Shape pop-up menu. When 3D is turned off, nine options are available. When 3D is turned on, two additional shapes become available. Different shapes significantly alter the distribution of generated particles. When you choose an emitter shape, different Emitter tab parameters appear that are unique to that shape. For example, when Rectangle is the selected Emitter Shape, Outline, Tile Fill, and Random Fill become available in the Arrangement options. When Spiral is the selected Emitter Shape, the Arrangement parameter goes away and new parameters such as Radius, Number of Arms, and Twists become available. These different parameters provide additional control over the distribution of particles.
In addition, when the 3D checkbox is turned on, the Render Particles, Emission Latitude, Emission Longitude, and Depth Ordered parameters become available for all emitter shapes.

**Point:** This is the simplest emitter shape and is the default shape for newly created emitters. It specifies a single point of emission for a particle system. There are no additional parameters for the Point shape.

**Line:** Particles emerge from a line. Using the onscreen controls (with the Adjust Item tool) or the Properties tab of the Inspector, you can specify the length and location of the line. In the Inspector, you can set a specific number of points from which particles emerge. This emitter shape is good for creating sheets of particles that cascade over a wide area. The Line shape displays additional parameters.
**Rectangle:** Particles emerge from a rectangle along its edge, or in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the rectangle. Drag the corners to adjust width and height; drag edges to adjust width or height independently. Depending on the selected Arrangement, the Rectangle emitter shape displays additional parameters. In the following image, the Emitter shape Arrangement parameter is set to Outline.

Use the following modifier keys to more precisely manipulate the corners of the Rectangle onscreen controls (with the Adjust Item tool):

- **Option:** Adjustments to size are scaled uniformly, with the anchor point remaining fixed.
- **Shift:** Adjustments to size are made proportionally.

**Circle:** Particles emerge from a circle-shaped emitter. Particles can be emitted in an Outline, Tile Fill, or Random Fill pattern. This emitter shape is good for surrounding an element in a composition with particles that emerge from its edge. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the circle. Depending on the selected Arrangement, the Circle emitter shape displays additional parameters. In the following image, the shape's Arrangement parameter is set to Outline.
**Burst:** Particles emerge from a burst pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the burst. The Burst shape displays additional parameters.

**Spiral:** Particles emerge from a spiral pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the spiral. The Spiral shape displays parameters.

**Wave:** Particles emerge from a waveform. Using the onscreen controls (with the Adjust Item tool) or the parameters in the Inspector, you can specify the length and location of the wave. The Wave shape displays additional parameters.
**Geometry:** Particles emerge from the edge of a shape, defined by a spline object used as the shape source. The Geometry shape displays additional parameters.

**Image:** Particles emerge from within an area defined by an image or from only the edges of the image. The image may or may not have an alpha channel. If it does, the shape of the alpha channel can also be used to define the emitter shape. The Image shape displays additional parameters.
Box: This option is available when the 3D checkbox is turned on in the Emitter tab. Particles are emitted from a three-dimensional cube along its surface (Outline), or in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the rectangle. Drag the front horizontal edge to adjust height; drag the front vertical edge to adjust width; drag a back edge to adjust depth; drag a front corner to simultaneously adjust the width and height. To reposition the emitter, drag in the shape (but not on an edge or corner point). Depending on the selected Arrangement, the Box shape displays additional parameters. In the following image, the box’s Arrangement is set to Tile Fill.

![Box Emitter Example](image)

Sphere: This option is available when the 3D checkbox is turned on in the Emitter tab. Particles are emitted from a three-dimensional sphere along its surface (Outline) or in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the radius and location of the circle. Drag the outline of the sphere to adjust its radius; drag within the sphere to reposition it in the Canvas. When Sphere is selected, the Arrangement parameter becomes available. Depending on the selected Arrangement, the Sphere shape displays additional parameters.

Additional Emitter Parameters
The following parameters appear in the Emitter tab depending on the option chosen from in the Shape pop-up menu. These parameters apply only to emitters and affect the overall shape of particle systems by controlling the flow of particles.

Arrangement (Rectangle, Circle, Image, Box, Sphere): Specifies the pattern from which the particles are generated. The arrangement options are:

- **Outline**: Emits particles along the edge of the shape in 2D emitters and along the surface of the shape in 3D emitters.
- **Tile Fill**: Emits particles from a tiled pattern of rows, columns, and ranks (3D emitters) within the circle, rectangle, image, box, or sphere. You can specify the number of columns, rows, and ranks, as well as the Tile Offset.
- **Random Fill**: Emits particles randomly from within the circle, rectangle, image, box, or sphere.
Size (Rectangle, Box): Defines the size of the rectangle or cube from which particles are emitted. This parameter is available whether the Arrangement is set to Outline, Tile Fill, or Random Fill. When Rectangle is the selected shape, the Width and Height parameters are available. When Box is selected, an additional Depth parameter is available.

Note: The Height is measured in project pixels; however, the Width is measured in square pixels. This is done so that a shape that is numerically square will look square when Correct for Aspect Ratio is turned on (checkmarked) in the View pop-up menu in the top-right corner of the Canvas.

Emit At Points (Line, Rectangle [Outline, Random] or Circle [Outline, Random], Burst, Spiral, Wave, Geometry, Box [Outline], Sphere [Outline]): When turned on, particles emerge from a limited number of points (as defined in the Points parameter). When turned off, particles may emerge from anywhere on the line or edge. When the Adjust Item tool is selected, the points are visible in the Canvas. When Emit At Points is turned on, two additional parameters appear:

- **Offset** (Line, Rectangle [Outline], Circle [Outline], Burst, Spiral, Wave, Geometry, Image): Offsets either the emitter itself or the particles generated on the shape. For example, when the emitter Shape is a Line, changing the Offset value moves the emitter’s position in the Canvas. When the emitter Shape is a Rectangle and Pattern is set to Outline, changing the Offset value moves the particles along the edge of the shape.

- **Points/Points Per Arm** (Line, Rectangle, Image, or Circle [Outline or Random Fill], Burst, Spiral, Wave, Geometry): Defines the number of points from which particles are emitted. For Rectangle or Circle shapes, the particles are emitted from evenly distributed points along the edge of the shape when Outline is chosen from the Pattern pop-up menu. When the Adjust Item tool is selected, the points are visible in the Canvas.

  Keep in mind that using a large number of points slows your computer’s processing time.

Radius (Circle, Burst, Spiral, Sphere): Defines the size of the shape from which particles are emitted.

Columns (Rectangle, Circle, Image, Box, Sphere): When Tile Fill is selected, this parameter specifies the number of horizontal emitter points on a grid over the selected emitter shape. In the case of an irregular shape (nonrectangular), grid points that fall outside of the shape are ignored.

Rows (Rectangle, Circle, Image, Box, Sphere): When Tile Fill is selected, this parameter specifies the number of vertical emitter points on a grid over the selected emitter shape. In the case of an irregular shape (nonrectangular), grid points that fall outside of the shape are ignored.
**Tile Offset** (Rectangle, Circle, Image, Box, Sphere): This parameter appears when Tile Fill is chosen from the Arrangement pop-up menu. Values from 0 to 100% offset the rows toward the right, and values from 0 to –100% offset the rows toward the left. A value of 50 or –50% creates a “brickwork” pattern.

**Ranks** (Box, Sphere): When Tile Fill or Outline (Box only) is the selected Arrangement, this parameter specifies the number of points in Z space on a grid over the selected shape from which particles are emitted.

**Twists** (Spiral): A slider that defines the number of turns in the spiral. The default value is 0.25.

**Number of Arms** (Burst or Spiral): A slider that defines the number of branches from which particles are emitted. The default value is 3.

**Amplitude** (Wave): A slider that defines half the distance from the highest point to the lowest point in the wave. Higher values result in more extreme waves.

**Frequency** (Wave): A slider that defines the number of waves. Higher values result in more waves.

**Phase** (Wave): A dial that defines the degrees of the offset of the waves from the start and end points of the path. When set to 0 degrees (default), the wave begins and ends at half the distance from the highest point to the lowest point in the wave. When set to 90 degrees, the wave begins and ends at the highest point in the wave. When set to 90 degrees, the wave begins at the lowest point in the wave. When set to 180 degrees, the waves are the same as 0 degrees, but inverted.

**Damping** (Wave): A slider that progressively diminishes the oscillation of the wave. Positive damping values diminish the wave forward (from left to right); negative values diminish the wave backward (from right to left).
**Start Point** (Line, Wave): Two sliders that define, in X and Y coordinates, the first point of the line used as the emitter shape. Click the disclosure triangle to modify the Z position of the start point. You can adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool).

**End Point** (Line, Wave): Two sliders that define, in X and Y coordinates, the second point of the line used as the emitter shape. Click the disclosure triangle to modify the Z position of the start point. You can adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool).

**Shape Source** (Geometry): An image well where you can specify an object that defines the shape of the emitter. Spline objects may be dropped onto this well to assign the desired shape.

**Image Source** (Image): An image well where you can specify the object used to define the shape of the emitter. Any image or movie clip can be dropped onto this well to assign the desired shape.

**Emission Alpha Cutoff** (Image): When the Image Source object contains an alpha channel, this slider defines the minimum opacity value that is necessary to create particles at that point on the source image. For example, when set to 25%, particles appear only where the alpha value of the image is equal to or greater than 25% opacity. The lower the Emission Alpha Cutoff value, the more particles appear. In order for this parameter to be effective, the alpha channel needs to have areas of varying transparency.

**Emission Angle** (all 2D shapes): Available for 2D emitter shapes, this dial sets the direction in which particles travel. This parameter works in conjunction with the Emission Range parameter. It is equivalent to one of the functions of the graphical emission control in the Emitter HUD.

**Note:** When using an emitter shape other than a point, such as a line, circle, rectangle, spiral, burst, or wave, and Outline is chosen from the Arrangement pop-up menu, setting the Emission Angle parameter to 180 degrees and the Emission Range parameter to 0 degrees restricts the emission of particles to the inside of the shape. Setting the Emission Angle parameter to 0 degrees and the Emission Range parameter to 0 degrees restricts the emission of the particles to outside of the shape.

**Emission Range** (all shapes): A dial that restricts the area around the center of each emission point from which particles are generated, in the direction of the Emission Angle. It is equivalent to one of the functions of the graphical emission control in the Emitter HUD.

**Note:** When using a line, circle, rectangle, spiral, burst, or wave (but not geometry), setting the Emission Range parameter to 0 degrees keeps particles perpendicular to the emitter when they emerge.
**Render Order:** A pop-up menu that determines whether new particles are drawn on top of or underneath particles that have already been generated. There are two options:

- **Oldest First:** New particles appear on top of older particles.
- **Oldest Last:** New particles appear underneath older particles.

**Interleave Particles:** Turning this checkbox on mixes particles generated from multiple cells together. Turning this checkbox off layers particles in the same order as the cells that generate them.

*Note:* This option has no effect with particle systems containing only one cell. Leaving this option off speeds rendering with multiple cells.

**Emitter 3D Checkbox**

The 3D checkbox is located in the Emitter tab underneath the emitter-specific parameters. When this control is turned on, the 3D emitter shapes (Box and Sphere) become available. Because all emitter shapes can be used in 3D space, additional 3D parameters are available for all emitter shapes when 3D is turned on. These additional parameters appear in the Emitter Inspector and HUD.

These parameters are available for all shapes, regardless of the Arrangement setting.

For more information on the additional 3D controls in the HUD, see “Emitter HUD Parameters” on page 696.

**To show the emitter 3D parameters:**

- Turn on the 3D checkbox.

![Image of Emitter Inspector with 3D checkbox highlighted]

3D: When turned on, the Box and Sphere shapes become available from the Shape pop-up menu. The Render Particles, Emission Latitude, and Emission Longitude parameters become available.

**Render Particles:** This pop-up menu allows you to choose between two different rendering methods for the particles.
• **In Local 3D (Faster):** The default setting, renders particles faster but does not allow for intersections with layers within the particles group or with layers in other groups.

• **In Global 3D (Better):** This setting allows the particles to intersect with layers within the emitter group and with layers in other groups. When turned on, your project’s interactivity is slowed.

**Emission Latitude:** Available when 3D is turned on, this control specifies the emission direction (in degrees latitude) of the particles.

**Emission Longitude:** Available when 3D is turned on, this control specifies the axis of rotation (in degrees longitude) from which the particles are emitted.

**Tip:** When working with elements in 3D space, you can quickly snap an object back to its original orientation using the Isolate command.

**Important:** A project must contain a camera in order to access the Isolate option.

**To isolate a group or layer, do one of the following:**

- In the Layers tab (or Timeline layers list), click the Isolate button.
- Control-click the layer or group, then choose Isolate from the shortcut menu.
- Choose Object > Isolate.
- Click the Isolate button again to return to your previous view.

**Note:** Clicking a camera’s Isolate button activates that camera’s view.

**Single-Cell Emitter and Particle Cell Parameters**

The following parameters apply to the creation and motion of the individual particles generated by each cell within an emitter.
**Birth Rate:** A slider that defines the birth rate of the cell. In other words, this parameter defines how many particles of this cell emerge from the emitter every second. Higher values create denser particle effects.

**Birth Rate Randomness:** A slider that defines an amount of variance in the Birth Rate of generated particles. A value of 0 results in no variance—particles emerge from the emitter at the same rate. A value greater than 0 introduces a variance defined by the the Birth Rate parameter, plus or minus a random value falling within the Birth Rate Randomness.

**Initial Number:** A slider that defines the initial number of particles. This parameter determines how many particles of this cell appear at the first frame of a particle effect. The result is an initial burst of particles that eventually evens out according to the Birth Rate parameter.
Life: A slider that defines the duration of every particle, in seconds. This parameter specifies how long each particle lasts before vanishing from existence. This effect is similar to how sparks disappear after flying away from a sparkler. Unless the Color Over Life or Opacity Over Life parameters are used to fade each particle out over its life, particles immediately vanish at the end of their lifetimes.

Life Randomness: A slider that defines an amount of variance in the life of generated particles. A value of 0 results in no variance—all particles from the selected cell emerge with the same lifetime. A value greater than 0 introduces a variance defined by the Life parameter, plus or minus a random value falling within the Life Randomness.

Speed: A slider that defines initial speed. This parameter determines how quickly each particle flies away from the emitter. This, in conjunction with the Life and Birth Rate parameters, determines how many particles appear in the Canvas at any given frame. It is equivalent to one of the functions of the graphical emission control in the HUD.

Speed Randomness: A slider that defines an amount of variance in the speed of generated particles. A value of 0 results in no variance—all particles from the selected cell emerge with the same speed. A value greater than 0 introduces a variance defined by the Speed parameter, plus or minus a predetermined random value falling within the Speed Randomness.

Align Angle: When turned on, the particles automatically rotate to match the shape on which they are positioned. This parameter is available in all cases but the following: Rectangle, Circle, Image, Box, and Sphere shapes with Tile Fill or Random Fill and Point.

Angle: A dial that defines the angle of rotation, in degrees, at which new particles are created.

Angle Randomness: A dial that defines an amount of variance in the angle of generated particles.
Spin: A dial that animates particles in a system by initially spinning each individual particle around its center. Adjustments to this control are in degrees per second.

Spin Randomness: A dial that defines an amount of variance in the spin of generated particles. A value of 0 results in no variance—all particles from the selected cell spin at the same rate. A value greater than 0 introduces a variance defined by the Spin parameter, plus or minus a random value falling within the Spin Randomness.

Additive Blend: By default, particles are composited together using the “normal” blend mode. Turn on this checkbox to composite all overlapping generated particles together using the Additive blending mode. This blending occurs in addition to whichever compositing method is already being used. The result is that the brightness of overlapping objects is intensified. This effect applies only to the particle system itself—the blend mode of the emitter determines how the result of the emitter is blended into the scene.

Color Mode: A pop-up menu that determines if and how particles are tinted. There are five options:

- Original: Particles are generated using their original colors. When Original is chosen, the Opacity Over Life parameter appears. Adjust the opacity controls to animate changes to the opacity of particles over their lifetime.
• **Colorize**: Particles are tinted using the color specified in the Color parameter. Additional Color and Opacity Over Life parameters appear.

• **Over Life**: Particles are tinted based on their age. The Color Over Life gradient editor defines the range of color that each particle assumes as it ages, beginning with the leftmost color in the gradient, and progressing through the range of colors until finally reaching the rightmost color at the end of its life.

When Over Life is selected, the Color Repetitions slider becomes available. Drag the slider to increase the number of times the gradient is repeated over the life of the particle.

*Note*: For more information on using gradient controls, see “Using the Gradient Editor” on page 1033.
• Pick From Color Range: Particles are tinted at random, with the range of possible colors defined by the Color Range gradient editor. A point on the gradient is randomly chosen, so the relative sizes of each color region determine the frequency of the color being used.

• Take Image Color: When you choose this mode, each new particle’s color is based on the color of the image at the position where the particle was generated. This mode is available only when the Shape pop-up menu in the Emitter tab is set to Image.

Scale: A slider that defines the scale of every particle of a cell. Click the disclosure triangle next to the Scale parameter to reveal separate X and Y scaling subparameters, which can be used to resize the width and height of generated particles. This control affects the initial scale of the particle (compared to the Scale Over Life behavior).

Note: When you use an image as a particle cell source and set a low Scale value, it is recommended that you set the Render Quality in the View pop-up menu or View pull-down menu to Best (choose View > Render Quality > Best).
Scale Randomness: A slider that defines an amount of variance in the scale of generated particles. A value of 0 results in no variance—all particles from the selected cell emerge with the same size. A value greater than 0 introduces a variance defined by the Scale parameter, plus or minus a random value falling within the Scale Range. The disclosure triangle of the Scale parameter reveals separate X and Y subparameters, which can be used to set the width and height of the Scale Range separately.

Attach To Emitter: A slider that determines how closely particles follow the position of a moving emitter. If it is set to zero, particles follow their own path after being emitted, resulting in particles that trail along the motion path the emitter is following. If this parameter is set to 100, in the absence of other behaviors, all generated particles follow along with the emitter, surrounding it in a moving cloud of particles.

Show Particles As: You can view particles in one of a variety of preview modes, or as they actually appear. These nonimage modes play more efficiently when viewing a complex particle system and also provide other ways of analyzing particle motion. By default, this parameter is set to Image, which displays each particle as it is supposed to appear. There are four options from which to choose:

- Points: Each particle is represented by a single point. This is the fastest preview mode and is useful for displaying the type and speed of particle motion in a system. When selected, the Point Size parameter is revealed.
- **Lines**: Each particle is represented by a line. This is a good preview mode to use to analyze the vector of each particle’s motion. The length of each line is determined by that particle’s speed, and the angle of each line equals each particle’s direction.

![Lines image](image1)

- **Wireframe**: Each particle is represented by a bounding box. Because the bounding boxes are good indicators of each particle’s orientation in the system, this preview mode is useful for evaluating the movements of individual particles. For example, it’s easy to see the angle of rotation for particles that are spinning or following a complex motion path.

![Wireframe image](image2)

- **Image**: This is the final particle system effect.

![Image](image3)
Note: Whatever is selected in the Show Particles As pop-up menu appears in your final render.

Random Seed: Although particle systems seem random, they’re actually deterministic. This means that the random variation in each particle system is created based on the number shown here. Unless this seed number is changed, a particle system with the same parameter settings always plays back with the same motion. If you don’t like the current random motion or distribution of the particle system, you can change the seed number by typing a new number or clicking Generate. This changes the random calculations performed for that system for all randomness parameters.

For more information about the random nature of particle systems, see “The Predictability of Particle Systems” on page 695.

Particle Source: In particle systems with more than one cell, a parameter representing each cell appears at the bottom of the Emitter tab. Each cell parameter has a checkbox you can use to enable or disable that cell, a name field, and an image well for that object.

Additional Cell Parameters for QuickTime Movies
If you create a particle system using a QuickTime movie as a cell, additional parameters appear. These five parameters are:

Play Frames: This checkbox controls playback. If it’s turned on, it loops the playback of the animation or movie clip used to generate each particle. If it’s turned off, particles are generated using the still frame specified by either the Random Start Frame parameter or the Source Start Frame parameter.

Random Start Frame: This checkbox introduces variation into animated particles generated from QuickTime objects. If it’s turned on, each newly generated particle begins at a different frame of the animation. Stills are chosen randomly if Play Frames is turned off.

Source Start Frame: Chooses the frame to begin animation, if Play Frames is turned on, or the still frame to display if Play Frames is turned off. This parameter only appears if Random Start Frame is turned off.

Hold Frames: The number of times each frame of the source movie is repeated during playback. The larger the Hold Frames value, the slower your playback.

Hold Frames Randomness: Varies the number of frames to “hold.” See the Hold Frames parameter description.
Additional Cell Parameters Based on the Selected Color Mode

Each of the options in the Color Mode pop-up menu displays a different set of parameters.

**Color:** Color controls available when the Color Mode is set to Colorize. Use them to specify a color to use to tint the particles. You can also modify each particle’s alpha channel, altering its opacity. This parameter is unique to the cell object. You can click the color well to choose a color, use the eye dropper, or open the disclosure triangle and adjust the Red, Green, Blue, and Alpha channel sliders.

**Opacity Over Life:** An opacity control that appears when Color Mode is set either to Original or Colorize. Use it to change the opacity of particles based on their age. This control is limited to grayscale values, which are used to represent varying levels of transparency. White represents solid particles. Progressively darker levels of gray represent decreasing opacity. Black represents complete transparency. A simple white to black gradient represents a particle that is solid when first generated, but which fades out gradually over its lifetime until finally vanishing at the end. The Opacity Over Life parameter has the following controls:

- *Gradient preset pop-up menu:* Gradients from the Library (default or custom) appear in this pop-up menu. Choose a custom opacity gradient from this menu to load it into the gradient editor.
  
  **Note:** None of the default gradients have opacity gradients. If a color gradient preset is selected, it has no effect on the opacity gradient.

- *Opacity bar:* To add a new opacity tag to the gradient, click anywhere within the opacity bar. Click an opacity tag to select it, and then change its value with the Opacity slider. To change the distribution of opacity, drag an opacity tag along the opacity bar, or select an opacity tag and use the Location slider. Change the spread of color between two gradient tags using the spread controls (triangles). To delete an opacity tag, drag it away from the opacity bar until it disappears.

- *Opacity slider:* Changes the shade of a selected gradient tag, from 100 (opaque/white) to 0 (transparent/black).

- *Interpolation:* Sets the interpolation of the selected opacity tag to Constant, Linear, or Continuous.

- *Location slider:* Changes the location of the selected gradient tag relative to the gradient bar.

**Color Over Life:** Gradient controls that appear when the Color Mode is set to Over Life. Use these controls to change the color of generated particles based on their age. When born, particles are tinted with the leftmost color in the gradient. Over their lives, their color changes through the range of the gradient, from left to right, until finally reaching the rightmost color at the end of their lives. The Color Over Life parameter has the following controls:
• **Gradient preset pop-up menu:** Gradients from the Library (default or custom) appear in this pop-up menu. Choose a gradient from this menu to load it into the gradient editor.

• **Gradient editor:** A set of graphical controls that allow you to adjust the color and opacity of particles over time.

  **Note:** For more information on using gradient controls, see “Using the Gradient Editor” on page 1033.

• **Color controls:** When a color tag is selected in the gradient editor, you can change its color via the controls in this section.

• **Opacity slider:** When an opacity tag is selected in the gradient editor, you can use this slider to change its shade, from 100 (opaque/white) to 0 (transparent/black).

• **Interpolation:** Sets the interpolation of the selected opacity tag to Constant, Linear, or Continuous.

• **Location slider:** Changes the location of the selected tag or spread control in the gradient editor.

**Color Range:** A gradient control that appears when the Color Mode parameter is set to Pick From Color Range. Use it to define a range of colors used to randomly tint new particles. The direction of the gradient colors is not relevant, only the number of colors that appear within the gradient. The Color Range parameter has the same controls as the Over Life parameter.

  **Note:** For more information on how to use gradient controls, see “Using the Gradient Editor” on page 1033.

**Cell Parameters in the Particle Cell Tab**
Parameters in the Particle Cell tab control the behavior of particles generated by the selected cell, independently of the parameters governing the emitter. In particle systems with multiple cells, each has its own particle cell parameters. This lets you create particle systems made up of many kinds of particles, each with distinctly different behaviors.

For more information on using the Particle Cell parameters, see “Single-Cell Emitter and Particle Cell Parameters” on page 725.

**To open a cell’s Particle Cell tab:**
1. Select any cell within an emitter in the Layers tab or Timeline layers list.
2. In the Inspector, click the Particle Cell tab.
The Particle Cell parameters appear.

**Animating Objects in Particle Systems**

You can add behaviors to a particle system’s emitter, or to the cells themselves, to quickly achieve sophisticated, organic effects with very little effort. You can animate any emitter using Basic Motion, Parameter, or Simulation behaviors. Emitter parameters and cell parameters can also be animated via keyframes. If you animate emitter-specific parameters such as Emission Angle or Emission Range, the position and distribution of new particles generated by that emitter are animated. All animation occurs relative to the duration of the emitter.

Animating an emitter’s Properties tab parameters is useful for altering the position and geometric distribution of a particle system over time. Keyframing an emitter’s Position parameter moves the source of newly emitted particles without affecting any particles that were generated at previous frames, which creates a trail of particles.
Keyframing an emitter’s Emitter tab parameters is a good way to modify the particle system’s overall characteristics over time, such as increasing or decreasing the size, speed, or lifetime of newly generated particles.

Particles also have their own category of behaviors. The Particles behaviors include Scale Over Life and Spin Over Life, which allow you to modify and animate the rotation and size of the particles over their lifetime.

Using the Motion Tracking behaviors, you can apply existing tracking data to an emitter or track an emitter to a clip. For more information on using the Motion Tracking behaviors, see “Motion Tracking” in the Motion Supplemental Documentation PDF.

For an example of a keyframed emitter object in a particle system, see “Example 2: Creating Animated Pixie Dust” on page 744. For more information on keyframing parameters in the Curve Editor, see “Keyframes and Curves” on page 503.

Applying Behaviors to Emitters
Applying behaviors to emitters is a quick and easy way to move emitters in your project. Attaching the Motion Path and Snap Alignment to Motion behaviors to an emitter affects the position of the source of all new generated particles. Throw and Spin affect the position and rotation, respectively, of the emitted particles, unless Affect Subobjects is turned off.

With all Basic Motion behaviors, once individual particles emerge, they’re unaffected by changes to the position of the emitter. This means that moving the emitter around the screen using behaviors results in the creation of a trail of particles that behave according to their particle cell parameters.

Note: This effect can be overridden by increasing a cell’s Attach to Emitter parameter value.

To apply a behavior to an emitter:
- Drag a behavior from the Library onto an emitter in the Canvas, Layers tab, or Timeline. The behavior is applied to the emitter, which begins to move according to the parameters of the behavior.

Note: Not all behaviors instantly activate a object when applied. For example, when a Throw behavior is applied to a object, the Throw Velocity parameter must be adjusted before the object moves.
Applying Behaviors to Cells
Simulation behaviors that are applied directly to cells are in turn applied to each individual particle generated from that cell. This can result in some extremely complex animations as dozens of particles move according to the behaviors you’ve defined. Behaviors applied to cells have no effect on the position of the emitter. Parameter behaviors on a cell only affect particles when they are created.

To apply a behavior to a cell:
- Drag a behavior from the Library to a cell in the Layers tab or Timeline.

The behavior is applied to the cell, and all particles generated from that cell begin to move according to the parameters of the behavior.

Tip: If you do not see your expected result when applying behaviors to particle cells, try turning the Affect Subobjects parameter on or off or selecting a different option from the Affect pop-up menu in the HUD or Behaviors tab of the Inspector. These parameters determine whether the entire object (such as the particle emitter) or its components (such as the particle cells) are affected by the behavior and how an object interacts with surrounding objects, respectively.

Note: The Affect Subobjects checkbox only appears in the Behaviors tab when the Throw and Spin behaviors are applied to a group that contains multiple objects, such as a group, particle emitter, or text.

Applying Parameter Behaviors to Emitters or Cell Parameters
As with all objects in Motion, you can apply Parameter behaviors to the parameters in the Emitter or Cell tab.

To apply a parameter behavior to an emitter or cell parameter, do one of the following:
- Drag a behavior from the Library onto an emitter or cell in the Layers tab or Timeline. In the Apply To section of the Behaviors tab or HUD, choose an option from the Go pop-up menu.
- Select an emitter or cell in the Layers tab or Timeline, click Add Behavior, and choose a Parameter behavior. In the Apply To section of the Behaviors tab or HUD, choose an option from the Go pop-up menu.
- In the Emitter or Particle Cell tab, Control-click a parameter, then choose a Parameter behavior from the shortcut menu.

Using Particles Behaviors
The Particles category in the Library contains two behaviors specifically for use with the cells or emitter in a particle system:
Scale Over Life
This behavior lets you grow or shrink the particles in a system over the duration of each particle's life. It has one main parameter, and three optional parameters that appear depending on the selected Increment Type.

Increment Type: Choose an option from this pop-up menu to determine which method is used to resize particles over their lifetime. There are four options:

- **Natural Scale:** Specifies starting and ending scale percentages that are used to animate each particle's size over its lifetime. Natural Scale uses an exponential curve to allow the animation to progress slowly when the scale values are small, and speed up when the values are large. This creates the illusion that the scaling is occurring at a constant speed. When Natural Scale is selected, the Scale At Birth and Scale At Death parameters become available.

- **Scale At Birth:** Determines the initial size of particles when they are created.

- **Scale At Death:** Determines the size of each particle at the end of its lifetime.

- **Rate:** Specifies a steady rate at which particles change size over their entire lifetimes. When Rate is selected, the Scale Rate parameter becomes available.

- **Scale Rate:** Allows you to define how quickly each particle changes size. Positive values grow particles over time, while negative values shrink particles over time.

- **Birth and Death Values:** Specifies starting and ending scale percentages that are used to animate each particle's size over its lifetime. The scale amount generated by this option for a specific particle at a specific time is multiplied by the pre-existing particle Scale (defined in the Cell Controls section of the Emitter tab). When this option is selected, the Scale At Birth and Scale At Death parameters become available.

- **Scale At Birth:** Determines the initial size of the particles when they are created.

- **Scale At Death:** Determines the size of the particles at the end of their lifetime.

- **Custom:** This mini-curve editor allows you to customize the scale of the particles over their lifetime. Click the disclosure triangle to display the mini-curve editor in the Inspector. For more information on using mini-curve editors, see “Mini-Curve Editor” on page 555.

- **Custom Scale:** Use this slider to adjust the value of the selected keyframe in the mini-curve editor.

- **Over Life:** Use this slider to adjust the position of the selected keyframe in the life of the particle.

Spin Over Life
This behavior lets you spin the particles in a system over the duration of each particle's life. It has one main parameter and three optional parameters that appear depending on the selected Increment Type:
**Increment Type:** Determines which method is used to spin particles over their lifetime. There are three options:

- **Rate:** Specifies a steady rate at which particles change spin over their lifetime. When Rate is selected, the Spin Rate parameter becomes available.
- **Spin Rate:** Allows you to define how quickly each particle changes spins. Positive values spin particles faster over time and negative values spin particles slower over time.
- **Birth and Death Values:** Specifies starting and ending spin degrees that are used to animate each particle's rotation over its lifetime. The spin amount generated by this option for a specific particle at a specific time is added to the pre-existing particle spin (defined in the Cell Controls section of the Emitter tab). When this option is selected, the Spin At Birth and Spin At Death parameters become available.
  - **Spin At Birth:** Determines the initial spin of the particles when they are created.
  - **Spin At Death:** Determines the spin of the particles at the end of their lifetime.
- **Custom:** This mini-curve editor allows you to customize the spin of the particles over their lifetime. Click the disclosure triangle to display the mini-curve editor in the Inspector. For more information on using mini-curve editors, see “Mini-Curve Editor” on page 555.
  - **Custom Spin:** Use this slider to adjust the value of the selected keyframe in the mini-curve editor.
  - **Over Life:** Use this slider to adjust the position of the selected keyframe in the life of the particle.

**Applying Filters to Particle Systems**

Filters can only be applied to a particle system’s emitter. (Filters can be applied to the source of a particle cell, but not to a cell directly.) As a result, filters always affect the entire particle system, including every single cell, as if it were a single object. You cannot apply separate filters to individual cells.
For more information on applying filters to layers in your project, see “Using Filters” on page 841. For more information on keyframing particle system parameters, see “Animating Objects in Particle Systems” on page 736.

**Particle System Examples**

This section presents two examples of how to use particle systems to create very different effects. The particle system created in the second example is turned into a 3D particle system after the “pixie dust” is animated.

Tip: You can use the Make Clone Layer command to clone an emitter and then use the Retiming controls or Retiming behaviors to create unique animations. For example, you can create a starburst that explodes outward, then retracts, then explodes, and so on. For more information on cloning, see “Making Clone Layers” on page 283.

**Example 1: Creating an Animated Background**

This first example describes how to create an animated background using a single still image. By using the parameters available in the Emitter tab, a single image can be turned into a complex animated texture. Once the example is created, quickly turn the system into 3D particles using the 3D checkbox in the Emitter tab of the Inspector.

To create an animated background from a single image:

1. Drag a file into the Canvas.
   
   This example uses a simple star graphic.

2. With the new layer selected, click the Make Particles icon in the Toolbar (or press E).

   Once an emitter is added to the project, the following occurs:
   
   - The emitter appears in the Layers tab and is selected.
A cell containing the image to be “particle-ized” appears underneath the emitter.

The original source layer (cell source) is disabled.

In the Canvas, the emitter bounding box appears, which can be transformed using the onscreen controls.

The first particle appears in the Canvas in the same location as the original object. Although it appears as if the particle is selected, it is actually the bounding box for the emitter.

The Emitter HUD is displayed. If you have hidden the HUD, press D or F7.

*Note:* For projects with a frame rate greater than 30 fps, at times only the bounding box (not the particle cell) may appear at the first frame of your project. Because particles are generated at a rate of 30 per second, there is no guarantee a particle will appear on every frame.

3 In the Emitter tab of the Inspector, choose Circle from the Shape pop-up menu.

4 Choose Tile Fill from the Arrangement pop-up menu.

5 In the Cell Controls section of the Emitter tab, set the Initial Number parameter to 12. This creates a distributed group of particles that partially fills the Canvas.

6 To turn the particles into a uniform abstract mass, adjust the following parameters:
   - Set Life to 4.
   - Set Speed to 140.
   - Set Spin to 60.
   - Set Spin Randomness to 15.
   - Turn on Additive Blend.
   - Set Color Mode to Pick From Color Range. (Or, select another gradient from the Preset pop-up menu if you prefer.)
   - Set Scale to 65%.
   - Set Scale Randomness to 150.
   - Set Random Seed to 10000.
• Advance to frame 100. The resulting image now looks similar to this:

Apply a filter to the emitter.

In this example, adding the Crystallize filter creates an even more abstract effect. You might also consider adjusting the color gradient, or applying color correction to make the background fit more appropriately with your foreground elements.

Adjust the Color Range opacity gradient so the particles fade in and out rather than popping into and out of existence.
Example 2: Creating Animated Pixie Dust

This example shows you how to create a particle system that uses two different cells to generate a streak of particles that trails behind another animated layer. Using two cells adds more variation to a particle system than can be achieved with a single set of cell parameters.

To create a two-cell particle system that leaves a trail:

1. Drag the first image file into the Canvas.

   This example uses the “Flare01.png” image from the Particle Images subcategory in the Content category of the Library. This is a small image of a lens flare against black, with a built-in alpha channel.

2. With the flare object selected, click the Make Particles icon in the Toolbar (or press E).

   An emitter is added to the project, but nothing happens yet because the playhead is at the first frame of the project, and only one particle has been created. Move the playhead forward a few seconds to view the particle system at a frame where more particles have been generated. You can also play the project while you make your modifications to the particle system.

3. To create a variety of particles, place additional layers into the emitter you just created.

   The easiest way to do this is to drag each additional layer you want to use into the group containing the emitter.
Note: If you do not have any additional images in your project, you can create them in the project or search the Content category in the Library for images.

Next, drag the new layer either onto the emitter, or below it (but not onto an existing cell). This example uses the “Spark12.png” file, also located in the Content folder in the Library.

This results in the following image:

4 To make the particles generated by each different cell mingle together, turn on the Interleave Particles parameter in the Emitter tab of the Inspector.

5 Select the Flare01 cell in the Layers tab, then set the Scale slider in the Particle Cell tab of the Inspector to 15%.
   Doing this reduces the size of the particles generated by this cell.

6 Select the Spark12 cell in the Layers tab, then set the Scale slider in the Inspector to 45%.
The resulting image should look approximately like this:

![Image](image.png)

*Note:* If necessary, disable the original Spark12 source layer.

Next, change the color of the particles generated by the Spark12 cell by doing the following:

a. Choose Colorize from the Color Mode pop-up menu.
b. Click the color well in the Color section of the Inspector and choose a light red color in the Colors window.
c. Close the Colors window.

All particles generated by that cell are now red.
8 Use the Opacity Over Life control to make this cell’s particles fade out over their life.

9 To make the spark particles spin as they move away, set the Spin parameter value to 60.

10 In the Layers tab, select the Flare01 cell of the particle system. Its parameters automatically appear in the Inspector.

11 Follow the procedure in Step 7 to make these particles light yellow.

12 To make the particles generated from this cell spin in the opposite direction, set the Spin parameter value to –60.

13 To create a trail of particles, the emitter needs to be animated to follow the required motion path. Do the following to create a motion path for the particle system:

   a Place the playhead at frame 1.
   b Click the Record button (or press A) to turn on animation recording.
   c Select the emitter and drag the particle system to the lower-left corner of the screen.
   d Press End to go to the last frame of the project.
   e Drag the emitter toward the upper-right corner.
   f Disable Record (press A).
   g Click the Play button to begin playback.
Use the following illustration as a guide to adjust the Emission Range and Angle so the particles appear to follow behind the emitter.

The result should look something like this:

You may want to adjust the Emitter parameters for Birth Rate, Life, and Speed to customize the effect to your liking.

To turn the system into 3D particles:
1. In the Emitter Inspector, turn on 3D.
2  If your project does not contain a camera, click the New Camera button in the Toolbar. If your project is a 2D project, a dialog appears asking if you want to switch your 2D groups to 3D.

3  Click Switch to 3D.

A camera is added to the project, and your layers are turned into 3D layers.

4  In the 3D View tools (in the upper-right corner of the Canvas), drag the Orbit tool (the center tool).

As the camera rotates, you can see that the particles are emitted in Z space.
If you want your particles to intersect with other rotated layers, choose In Global 3D (Better) from the Render Particles pop-up menu in the Emitter Inspector. In the following image on the left, the particles intersect with other objects in the project that are transformed in 3D space. In the image on the right, the particles do not intersect with other objects.

![Image](image-url)

When Global 3D is enabled, the particles intersect with other rotated objects in 3D space. When Local 3D (default) is enabled, the particles do not intersect with other rotated objects in 3D space. The particles appear above or below the other objects, based on their position in the Layers list.

**Saving Custom Particle Effects to the Library**

Once you have created a particle system that you are particularly proud of, you can save it as a particle preset in the Particle Emitters, Favorites, or Favorites Menu folder of the Library, for future use. Once you place particle systems in the Library, they become particle presets that can be used just like any other particle preset.

**To save a particle system to the Library:**

1. Open the Library and select either the Particle Emitters, Favorites, or Favorites Menu category.
2. Drag the emitter you want to save into the stack at the bottom of the Library.

**Note:** For organizational purposes, you may find it useful to create a new folder of your own in the Favorites or Favorites Menu category to store custom particle systems.

When you save a particle preset, it’s saved as a file in the `/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Particle Emitters` folder. Any custom objects that you used to create that particle system also appear here.
You can copy particle presets you create from this location to give to other Motion users, or you can place particle presets that are given to you in this same folder. Whenever you copy a particle preset file, you should make sure that you also copy any graphics or movie files that it uses as well.

For more information on saving custom objects to the Library, see “Adding Your Own Content to the Library” on page 232.
Using the Replicator

The Replicator allows you to easily create patterns of repeating elements that can be quickly animated in mechanical or organic ways.

Patterns of repeating elements are prevalent in various types of motion graphics projects, including television title sequences, news graphics, bumpers, and commercials. This type of graphic—created through the careful duplication of elements, followed by animating those elements with keyframes—is usually very time-consuming.

The replicator in Motion is specifically designed to quickly and fluently build such patterns of repeating elements, including video, still images, shapes, or other layers in a Motion project. For example, with very few clicks of your mouse you can create a “video wall” from a QuickTime movie, a spinning pinwheel, or other mesmerizing graphics.

Footage provided courtesy of National Geographic Television and Film Library
Once you have replicated a layer, you can quickly change the shape of the pattern and animate its elements by animating the replicator parameters. You can also use behaviors to animate many of the replicator parameters. In addition, the replicator has a special behavior that allows you to animate the pattern's elements in sequence over the pattern.

**The Difference Between a Replicator and a Particle System**

Although the replicator and particle systems share many of the same parameters, they are very different tools. While both use layers (shapes, text, images, and so on) as cell sources and generate elements from those cells along or within a shape such as a circle, line, or spiral, the cells are used differently by each tool. A particle system uses the cell source as the "mold" for the particles that are generated by the emitter. As mentioned in Chapter 8, "Working with Particles," if you imagine that a garden hose is a particle system, the nozzle acts as the emitter, while the water represents the flow of particles. Particles are animated over time by default—they are born, move away from the emitter, and die. The particle system is not designed for pattern-based replication purposes.

In a replicator, elements are not emitted (they do not have "birth rate," "life," or "speed" parameters) like particles. The replicator simply builds a pattern of static copies of a source layer in a shape and arrangement that you specify. Although the replicated layers (elements) are static by default, the replicator parameters can be animated. In a simple example, a star shape is used as the source and replicated along the outline of a circle. The Offset and Color parameters can be keyframed so the stars travel around the circle while changing color.

The replicator also has a special behavior called Sequence Replicator that allows you to sequence parameters, such as position, scale, and opacity, over the pattern of elements. How the animation moves through the replicator pattern is determined by the build style or origin of the replicator, as well as the parameters of the Sequence Replicator behavior. This behavior works very similarly to the Sequence Text behavior. For more information on using the Sequence Replicator behavior, see "Using the Sequence Replicator Behavior" on page 821.
You can replicate nearly any layer in Motion, including images, shapes, text, movies, and image sequences. You cannot replicate a particle emitter or replicator layers. Each element that is created is essentially a duplicate of the source layer. Unlike the particles of a particle system, however, the elements are not animated over time by default.

The layer you use as the source for a replicator’s cells helps determine the look of the replicator pattern. A single replicator can contain multiple source layers, resulting in different cells in the same pattern and arrangement.

Replicators take advantage of Motion’s 3D capabilities. Certain replicator shapes are inherently 3D, and others can have points that exist in 3D space. Additionally, behaviors applied to a replicator can pull pattern elements out of a plane. For more information on using replicators in 3D, see “Using Replicators in 3D” on page 780.

Anatomy of a Replicator

When you replicate a layer, two new layers appear in the Layers tab:

- A replicator layer that controls the onscreen pattern as a whole
- A cell layer that controls the individual elements in the pattern
Each cell appears under the Replicator layer in the Layers tab and Timeline layers list. Once replicated, the source layer remains in its original position in the Layers tab. If you clicked Replicate in the Toolbar (or chose Objects > Replicate), the source layer is disabled by default. If you dragged the source to an existing replicator layer, the source remains enabled.

The replicator and cells have separate sets of parameters that control the look of the elements. If you imagine the replicator as the “pattern,” the cells (and their elements) are the “stitches” of that pattern. The pattern is created by selecting a shape on which to arrange the elements. Changing the parameters of the replicator changes the shape on which the elements are arranged, while changing the cell’s parameters affects each individual element in the replicator, such as its angle, color, and scale.

Replicator parameters are dynamic—different parameters appear depending on what shape is selected. For example, when Rectangle is the selected shape, parameters appear that allow you to define the size of the rectangle, the number of rows and columns in the rectangle, as well as the origin of the elements in the rectangle (if the elements are arranged from the center outward, from right to left, and so on).
When Spiral is the selected shape, parameters appear that allow you to define the radius of the spiral, the number of twists and arms in the spiral, the number of points (the location on the shape in which the element sits) per arm, as well as the origin of the elements in the spiral (from the center outward, or from the edge inward).

Further, different parameters are also available depending on the selected arrangement for the shape. In the following image, notice that the Columns, Rows, and Tile Offset parameters are replaced with the Points and Offset parameters when the rectangle arrangement is changed from Tile Fill to Outline.
Very different looks can be achieved by changing only a few parameters.

![Images of different replicator effects](image)

As with any effect in Motion, replicator parameters can be keyframed in order to change a pattern’s dynamics over time. For example, you can create a wave of dots that follow one another across the screen by keyframing the replicator’s Offset parameter.

![Keyframed replicator effects](image)

You can add behaviors to the replicator or its cells to create even more varied effects (simulation behaviors can be especially effective). Behaviors applied to a replicator or a cell can be applied to each element of the pattern. This lets you achieve almost limitless variation and complexity that would take hours to animate using keyframes. You can also apply a behavior, such as Vortex, to another object in your project (an object that is not part of the replicator pattern), and have the pattern elements circumnavigate that object.

**Replicator Source Objects**
Almost any layer in Motion can be replicated (used as a cell source), including shapes, text, images, image sequences, and clips.

*Note:* Although you can replicate a layer used as the source for a particle emitter, you cannot replicate a particle emitter itself. You also cannot replicate a replicator.

Transformations that you apply to the source are respected in the replicator cells. For example, if you use a rectangle shape that is sheared and rotated as the replicator object, the replicated elements are sheared and rotated. If the source layer has applied filters, the effects of the filters are retained in the elements of the replicator pattern.
Note: Keep in mind that replicating a movie, especially with applied filters, adversely impacts your computer’s processing performance. For better performance, output your sequence with the filter applied, then import and use the movie as a source.

Creating Graphics and Animated Clips for a Replicator
Creating a replicator from scratch begins with designing the graphic you want to replicate. You can use any image, shape, text, or movie supported by Motion as a source for a replicator cell. The guidelines for creating source layers for a particle system also apply to creating sources for the replicator. For more information, see “Creating Graphics and Animations for Particle Systems” on page 711.

Using the Replicator
Although you can use the numerous replicator controls to create incredibly complex, intricate animated patterns, replicating a layer in your project can be fast and easy. This section describes how to use pre-made replicators from the Library. The following section explains how to create a simple replicated pattern of your own.

Using the Replicator Library Presets
The easiest way to add a replicator to your project is to use a replicator preset from the Library. Because the Library replicators are pre-made using Motion content, they are for more generalized usage. If you find one that is close to what you need, you can easily customize its parameters after you add it to your project. Library replicators are added to a project exactly like any other object.

For information on replicating your own objects, see “Creating a Simple Custom Replicator Pattern” on page 762.

To use a replicator from the Library:
1 Select the layer to which you want to add the replicator.
2 In the Library, select the Replicator category.
   The Replicator category is divided into subcategories, such as Mattes, Transitional, Backgrounds, and so on.
3 Select a subcategory, then select a replicator object, such as Curved Drops (in the Miscellaneous subcategory).
A preview appears in the Preview area.

![Replicator Preview](image)

**Note:** If the preview does not automatically start playing, click the Play button in the Preview area. To automatically play items selected in the File Browser or Library, choose Motion > Preferences (or press Command-comma), then enable “Play items automatically on a single click” in the File Browser & Library section of the General pane.

4 Once you have selected the replicator preset you want to use, do one of the following:
- Click Apply in the Preview area to add the replicator to the center of the Canvas.
- Drag the replicator to the Canvas.
- Drag the replicator to the desired group in the Layers tab or Timeline.
- Drag the replicator to the track area of the Timeline. As you drag, a tooltip displays the current frame number.

**Note:** When adding items to the Timeline, additional options are available for compositing, inserting, or overwriting layers. For more information, see “Adding Objects to the Timeline” on page 331.

The replicator preset appears in the project, composited above any objects below it in the Layers tab.

Once you have added a replicator preset from the Library, it acts exactly as it appeared in the Preview area. If necessary, you can edit the replicator parameters in the HUD or in the Replicator tab of the Inspector to suit your project. You can also replace the preset source with one of your own images, clips, shapes, or text layers as the source for the pattern cells.

**Note:** You can only modify a replicator after it's been added to a project. Once modified, you can save the replicator in the Library. For information on saving custom replicators to the Library, see “Saving Custom Replicators to the Library” on page 839.

**To replace a replicator preset’s source image:**
1 In the File Browser or Library, select the file you want to use as the replacement graphic for the replicator preset, then add it to the project.
2 In the Layers tab, drag the object over the replicator cell you want to replace.
3 When the pointer becomes a curved arrow, release the mouse button.

The original source object is replaced with the new object.

The HUD displays a selected replicator’s most essential parameters. Blend Mode, Opacity, and Shape always appear in the HUD.

When a replicator and the Adjust 3D Transform tool (in the Toolbar) are selected, the 3D transform tools become available in the HUD. These additional controls allow you to transform the replicator in X, Y, and Z space, regardless of whether the group is 2D or 3D.

For more information on using the 3D transform controls in the HUD, see “3D Compositing” in the Motion Supplemental Documentation PDF.
As mentioned above, the rest of the controls in the HUD are dynamic—they appear depending on what is selected from the Shape and Arrangement pop-up menus. Select a replicator cell in the Layers tab or Timeline to edit its parameters in the HUD. The angle and scale parameters always appear in the HUD.

Creating a Simple Custom Replicator Pattern

Creating a custom replicator pattern begins by selecting a layer in your project to use as a source for the cells of a new replicator pattern. To replicate an object, select the layer that you want to use as a source, then click the Replicate icon in the Toolbar. By default, a filled rectangular pattern is created from the source. You can then modify the replicator parameters to suit your project needs.

*Note:* Like all other customized objects in Motion, you can save a replicator to the Library. For more information, see “Saving Custom Replicators to the Library” on page 839.

To create a pattern from a source layer:

1. Place an object that you want to replicate into your project.

This example uses the “5-sided star” from the Shapes category in the Library. Once added to the project, the star object is scaled to 20%.
2 Select the object, then do one of the following:

- In the Toolbar, click the Replicate icon.
- Choose Object > Replicate.
- Press L.

Once a layer is replicated, the following occurs:

- The *Replicator* layer appears in the Layers tab and is selected.
- A duplicate of the original layer (the star shape) becomes the *replicator cell*.
- The original *source layer* (the star shape) is disabled.

*Note:* Changes made to the original source layer, such as opacity or shearing, are respected in the pattern after the replicator is created.

- In the Canvas, the replicator bounding box appears, which can be transformed using the onscreen controls.
- In the Canvas, the default rectangle pattern appears, in the same location as the source object. The pattern's elements are created from the replicator cell.
In the Toolbar, the Adjust Item tool is selected so that you can immediately begin using the replicator’s onscreen controls.

When the Adjust Item tool is selected, dragging the pattern’s bounding box resizes the replicator. Dragging in the Canvas (not over the bounding box outline) repositions the replicator object as a whole.

The Replicator HUD is displayed.

**Note:** If you have hidden the HUD, press D.

By default, the patterns created by the replicator are not animated.

**Removing a Replicator**

You can remove a replicator from the Layers tab or Timeline layers list.

**To remove a replicator:**

- Select the replicator, and press Delete.

  The original source layer or layers remain in the project.

**Using Multiple Source Layers for the Replicator**

When you create a replicator pattern from scratch, you don’t have to restrict yourself to using just one cell source. You can create a pattern that includes different elements by placing multiple cells inside of a single replicator.

You can add as many sources as you want to a single replicator. Each source becomes a cell in the replicator, and each cell has its own set of parameters. The cell parameters govern the elements in the pattern. When you select a replicator cell in the Layers tab or Timeline layers list, its parameters are displayed in the Replicator Cell tab in the Inspector.

Additional cells can be created either by selecting multiple sources when initially creating the replicator, or by dragging sources to the replicator layer in the Layers tab or Timeline layers list.
The following example uses two shapes as source layers for a single replicator.

To use multiple source layers for a replicator pattern:

1. Shift-click to select the layers you want to replicate.

   This example uses a white circle shape and a red elliptical shape (both created with the Circle tool).

2. Do one of the following:
   - In the Toolbar, click the Replicate icon.
   - Choose Object > Replicate (or press L).

   Note: Command-click noncontiguous layers that you want to add to the replicator.
The cells of the default rectangle pattern are created from the source layers.

When multiple cells create a replicator pattern, the elements appear at the same points (the location in which the elements appear) on the pattern. The replicator is positioned at the average of the source’s positions.
The elements in the pattern are stacked according to the order they appear in the Layers tab and Timeline layers list. To change the stacking order of the layers, move the lower cell above the upper cell.

Once the cells are reordered in the Layers tab, the red ellipse element appears in front of the white circle element in the pattern.

**Removing a Source Layer from a Replicator**
In the Layers tab or Timeline layers list, you can remove a cell from a replicator that contains multiple cells.

**To remove a cell from a replicator:**
- In the Layers tab or Timeline layers list, select the cell you want to remove, and then press Delete.

The original source layers remain in the project.

**Customizing a Replicator Using the HUD**
When a replicator is created from a source layer, the pattern is built using the default parameters in the Replicator tab of the Inspector. You can also use the Replicator HUD to easily change the most important of these parameters to suit your needs.
To display the Replicator HUD:

- In the Layers tab or Timeline layers list, select the replicator you want to display the HUD.

**Note:** If the HUD does not appear, choose Window > Show HUD (or press F7). You can also press D to show the HUD.

**Replicator HUD Parameters**

Like all objects in Motion, the Replicator HUD contains frequently used parameters that are necessary to modify the shape and arrangement of the replicator. These parameters are a subset of the parameters found in the Replicator tab of the Inspector. The HUD contains a group of sliders and pop-up menus that provide an easy way change the shape of the pattern, as well as the arrangement of the objects within the pattern. The HUD also provides quick access to the Opacity and Blend Mode parameters, which are located in the Properties tab of the Inspector.

When working in 3D, additional transform parameters become available in the HUD. For more information on using the HUD’s 3D transform controls, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.
For replicators containing multiple cells, the Replicator HUD parameters simultaneously modify the cell’s parameters.

**Important:** The Opacity, Blend Mode, and Shape parameters always appear in the Replicator HUD. The parameters below Shape and Arrangement (available when the selected shape is a Rectangle, Circle, or Image) in the HUD are dynamic—they change depending on what is selected from the Shape and Arrangement pop-up menus. For a discussion of all replicator parameters, see “Advanced Replicator Controls” on page 783.

The following section describes the default Replicator HUD parameters.

**Opacity:** Defines the opacity of the replicator pattern as a whole. If a replicator contains multiple cells, this setting affects the opacity of all pattern elements.

To individually control the opacity of the elements in a replicator with more than one source, do one of the following:

- Select the cell and use the Opacity Gradient control (or change Color Mode to Colorize and adjust the Alpha parameter in the Color controls) in the Replicator Cell tab.
- Select the original source layer—not the replicator cell itself—and change its opacity in its HUD or Properties tab of the Inspector.

**Blend Mode:** A pop-up menu that defines the blend mode of the replicator. Changing this setting affects the pattern as a whole according to the layers composited beneath it in the Layers tab—it does not affect the interaction of elements that may be stacked on one another in a pattern. To affect the blending of elements within a pattern, you can enable Additive Blend in the Replicator tab of the Inspector.

**Note:** For more information on blend modes, see “Blend Modes” on page 285.
**Shape:** A pop-up menu that defines the shape of the replicator. The default shape is Rectangle. The shape options include Line, Rectangle, Circle, Burst, Spiral, Wave, Geometry, Image, Box and Sphere.

![Replicator Shape set to Rectangle](default) ![Replicator Shape set to Circle](Arrangement set to Outline) ![Replicator Shape set to Spiral](default)

**Note:** Different parameters are available depending on what is selected from the Shape pop-up menu.

**Arrangement:** A pop-up menu that defines the layout of the elements within the replicator pattern. When the Shape parameter is set to the default Rectangle, the default arrangement is Tile Fill. The Arrangement parameter is available only when Shape is set to Rectangle, Circle, or Image.

Think of the Arrangement parameter as necessary only when you need to specify how elements are arranged in a closed shape (a circle, rectangle, or image). If Shape is set to Line, for example, the elements appear along that line—there is no "space" within which to arrange the pattern's elements.

![Arrangement set to Tile Fill](default) ![Arrangement set to Outline](default) ![Arrangement set to Random Fill](default)

Different parameters are available depending on what is selected from the Arrangement pop-up menu.
Columns: Defines the number of vertical columns in the pattern. Pattern elements are distributed at points along the columns. This parameter is available when the selected shape is closed, such as a rectangle, circle, box, sphere, or image, and when the arrangement is set to Tile Fill. It is also available for box and sphere when Arrangement is set to Outline.

Note: The default Columns value limit is 20. You can set a higher number in the value field in the Replicator tab of the Inspector.

Rows: Defines the number of horizontal rows in the pattern. This parameter is available when the selected shape is closed, such as a rectangle, circle, box, sphere, or image, and when the Arrangement is set to Tile Fill. It is also available for box and sphere when Arrangement is set to Outline.

Note: The default Rows value limit is 20. You can set a higher number in the value field in the Replicator tab of the Inspector.

Origin: Specifies how the elements traverse across the pattern from a point of origin. For example, when using a Rectangle shape and Origin is set to Left, the elements sweep across the rectangle from left to right. When set to Upper Right, the elements build from the upper-right corner point of the shape to the lower-right corner. This parameter is available when the Arrangement is set to Tile Fill or Random Fill.

Modifying a Replicator Using the Properties Tab
Like any other layer in Motion, a replicator’s properties (such as position, scale, blend mode, shear, or drop shadow) can be modified in the Properties tab of the Inspector or by using the onscreen transform modes. These properties are separate from the replicator parameters in the Replicator and Replicator Cell tabs, which control the shape and size of the replicator, as well as all aspects of its pattern and cells.

Note: When a replicator cell is selected, only the Timing parameter appears in the Properties tab of the Inspector. This allows you to control the In and Out points of the replicator source cell.
About Rasterization and Groups

Some operations, as well the application of certain filters or a mask, cause a group to be rasterized. When a group is rasterized, it is converted into a bitmap image. Because all replicators live in groups, this affects how replicators interact with other objects within your project.

*Note:* A replicator can be rasterized independently of the group in which it lives. This affects how the replicator interacts with objects within its own group. For example, applying a Circle Blur filter to a replicator causes the replicator to no longer intersect with other objects in the same group. The same operations that cause a 3D group to rasterize cause a 3D replicator to rasterize. To minimize this effect, apply the filter directly to the replicator’s source object, or turn off 3D in the Replicator tab.

Rasterization affects 2D and 3D groups in different ways. When a 2D group is rasterized, the blend modes on objects within the group no longer interact with objects outside of the group. In the following illustrations, the nonrasterized 2D group that contains the replicator is set to the Add blend mode. The replicator interacts with the group beneath it in the layer stack.

The Elements group is not rasterized.

The replicator blend mode interacts with the group beneath it in the project.
In the next illustrations, the group that contains the replicator is rasterized. The rasterization is triggered by setting the Opacity parameter of the group to 90%. The replicator’s Add blend mode no longer interacts with the group beneath it in the layer stack. Notice that the group icon for the rasterized group now appears with a frame around the icon (the icon immediately to the left of the Elements group).

In addition, when a 3D group is rasterized, the group as a whole can no longer intersect with objects outside of the group. The rasterized 3D group is treated as a single object and uses layer order, rather than depth order, to composite the project. In the following illustration on the left, the nonrasterized group that contains the replicator intersects with an image from another group. In the illustration on the right, a Gradient Blur filter applied to the replicator group has caused the replicator group to rasterize. As a result, the replicator no longer intersects with images from another group.
Note: When a group is rasterized, cameras and lights in the project still interact with objects within the rasterized group.

Changes to the following parameters trigger the rasterization of a group:

**2D Groups**
- Making Blending changes (Opacity, Blend Mode, Preserve Opacity)
- Turning on Drop Shadow
- Turning on Four Corner
- Turning on Crop
- The application of any filter
- Adding a mask
- Adding a light

**3D Groups**
- Blending changes
- The application of certain filters
- Adding a light to a 3D group with the Flatten parameter enabled (in the Group tab of the Inspector)

Once an operation triggers a rasterization on a group, the following occurs:
- A rasterization indicator (resembling an LED) appears next to the parameter in the Properties tab.
- A small outline appears around the rasterized 2D group, 3D group, emitter, replicator, or text icon (to the left of the group name) in the Layers tab and Timeline layers list.

Note: Unlike vector graphics, rasterized groups may lose quality when scaled.

For more information on rasterization and 3D groups, see “3D Compositing” in the Motion Supplemental Documentation PDF.
To display the replicator Properties Tab:

- In the Layers tab or Timeline layers list, select the replicator, then open the Properties tab in the Inspector.

Note: To transform the replicator pattern in the Canvas, you can also use the transform tools available in the Toolbar. Once a replicator is selected, you can press Tab to cycle through the transform tool modes. The last tool mode is the Adjust Item tool, which can be used to change the size of the replicator shape. For more information on the onscreen transform tools, see “View Tools” on page 30.

Position, Rotation, Shear, and Anchor Point

Because all elements are attached to the points of the replicator pattern, changing the replicator’s position, rotation, shear, or anchor point in the Canvas changes every element in the replicator. This results in the entire pattern being transformed at once. Modifying the anchor point moves the point for the entire pattern—it does not change the anchor point for the pattern elements.
**Scale**

Using the Scale parameter resizes the replicator, affecting the size of the pattern elements in X, Y, or Z space. To modify the size of the pattern without changing the size of its elements, use the parameters in the Replicator tab. For example, to enlarge a rectangle replicator without increasing the size of its elements, use the Scale parameter (in the Replicator tab); to lengthen a line replicator, use the Start Point and End Point parameters; to increase the size of a circle replicator, use the Radius parameter.

![Original replicator](image1)

![When replicator is scaled using the Scale parameter in the Properties tab, the entire pattern and its elements are scaled.](image2)

![When replicator is scaled using the Replicator size parameters in the Replicator tab, the pattern is scaled, not the cells.](image3)

**Blending**

Any changes you make to the opacity or blend mode parameters for a replicator are applied to the replicator as a whole—the result of the replicator pattern is blended into the scene. For more information about blend modes, see “Using Blend Modes” on page 290. For more information about the Preserve Opacity setting, see “Preserve Opacity Option” on page 289.

*Note:* Within the replicator, the pattern elements can be blended additively or normally (using the Additive Blend checkbox in the Replicator tab).
Lighting
A 2D or 3D replicator can interact with lights in a 3D project. As with all layers, the Shading pop-up menu (in the Lighting section of the Properties tab in the Inspector) must be set to On or Inherited for the lights to affect the replicator. For more information on using lights, see “3D Compositing” in the Motion Supplemental Documentation PDF.

Drop Shadow
A Drop shadow can be applied to a 2D replicator. The drop shadow of the replicator affects layers composited behind the replicator—if the pattern contains overlapping elements, the shadow does not appear on the individual elements. When the Drop Shadow parameter is enabled for the source layer (in the Properties tab in the Inspector), overlapping pattern elements appear with a drop shadow.

Note: This parameter is only available when a 2D replicator shape is selected.

For more information on working with drop shadows, see “Drop Shadows” on page 309.

Four Corner
The Four Corner controls in the Properties tab allow you to stretch a replicator into different polygonal shapes by moving one of the corner points, leaving the other three corners locked into place. Adjusting the corners of the replicator affects the entire pattern as a whole.
Note: This parameter is only available when a 2D replicator shape is selected.

Crop
The Crop controls in the Properties tab allow you to hide portions of a replicator pattern. You can also use the onscreen cropping controls by choosing the Adjust Crop tool from the Toolbar, then dragging any of the replicator object’s four edges or corners.

Note: This parameter is only available when a 2D replicator shape is selected.

For more information on cropping objects in Motion, see “Cropping Objects” on page 278.

Timing
Once you create a replicator, its duration can be as long or short as necessary, regardless of the duration of the original sources used for the pattern cells. The duration of a replicator is defined by the duration of the replicator layer. Changing the In or Out points of a replicator in the Properties tab, Timeline, or mini-Timeline changes the duration of the replicator.

While the duration of the source layers has no affect on the replicator, the duration of each cell affects how long the elements created from that cell are visible in the project. You can change a cell’s duration by dragging either its position or its In and Out points in the Timeline. In this way, you can adjust the timing that defines when each cell type appears. For example, you can create a pattern in which three different types of elements appear at different times in the animation by offsetting the cells in the Timeline. In the following image, the arc cells appear first. One second later, the star cells appear. One second after that, the circle cells appear.

Note: You can animate the opacity of each cell so that it fades in by keyframing the Opacity parameter in the Replicator tab or the Replicator Cell tab.

For more information on adjusting the timing of layers in the Timeline, see “Using the Timeline” on page 321.
Using the Replicator Onscreen Controls
In addition to using the Position parameters in the Properties tab or the Select/Transform tool to move the replicator in the Canvas, you can also use the Adjust Item tool. This section provides two examples of using the Adjust Item tool to modify a replicator using the onscreen controls.

To use the Adjust Item tool:
1 Select the replicator you want to adjust.
2 In the Toolbar, click and hold the Select/Transform tool, then choose the Adjust Item tool from the tool options.

Once the Adjust Item tool is selected, the replicator onscreen controls appear. Dragging the pattern’s shape adjusts the size of the replicator shape. For example, if the shape is a spiral or circle, dragging the shape changes the Radius parameter value. Dragging in the Canvas (not directly on the shape) repositions the replicator in the Canvas.
If the shape is a rectangle, dragging a corner or edge of its bounding box changes the Size parameter value. You can adjust only the width, only the height, only the depth (for a box [3D] replicator), or all size parameters simultaneously.

Drag the left or right edge of the bounding box to adjust its width.

Drag the top or bottom edge to adjust its height.

Drag the corner handles to adjust width and height simultaneously. Press Shift to adjust width and height uniformly.

Using Replicators in 3D
Replicators use 3D in different ways. Two of the replicator shapes are inherently 3D: Box and Sphere. The Box and Sphere shape options are available only when 3D is turned on in the Replicator tab. Box and Sphere replicators build a pattern of elements in 3D space. Whereas the 2D Rectangle and Circle replicator shapes have columns (in the Y plane) and rows (in the X plane), Box and Sphere have an additional Ranks parameter, which adds depth to the replicator.

Box replicator with 13 columns, 12 rows, and 3 ranks.

Sphere replicator with 14 columns, 14 rows, and 5 ranks.

For more information on Box and Sphere, see “Rectangle, Circle, Image, Box, and Sphere Shape Parameters” on page 791.
The Line and Wave replicator shapes can have start and end points that exist in Z space. In the following image, the Z Start Point (yellow end of the pattern) is set to 20 and the Z End Point is –18 (red end of the pattern).

Although the Rectangle, Circle, Line, Wave, Image, and Geometry replicators have no inherent 3D parameters, they can be moved and rotated in 3D space. Pattern elements can also be pulled out of their plane when behaviors are applied. The replicator must be a member of a 3D group in order to be pulled out of the X and Y planes by a behavior.

The Burst replicator’s Z position is set to 0 and the white circle’s Z position is set to 225. An Attracted To Simulation behavior is applied to the replicator, with the white circle set as the target object.

As the project plays, the replicator elements move forward in Z space toward the attractor.

Here, the camera is rotated to look behind the replicator. Under the behavior’s influence, the replicator elements move past their attractor element, and return to their original position.

**Tip:** When working with elements in 3D, you can quickly snap an object back to its original orientation by using the Isolate command.

To isolate a group or layer, do one of the following:

- In the Layers tab (or Timeline layers list), click the Isolate button.
• Control-click the layer or group, then choose Isolate from the shortcut menu.
• Choose Object > Isolate.
Click the Isolate button again to return to your previous view.

**Note:** Clicking a camera’s Isolate button activates that camera’s view.

**Applying Masks to the Replicator**
As shown in the following images, you can apply masks to the source layer of a replicator.

When a masked layer is used as the source for a replicator cell, the mask is respected in the pattern cells.

Masks can also be applied to 2D replicators (all replicator shapes except Box and Sphere).
When a mask is applied to a replicator, the entire pattern is masked.

For more information on working with masks, see “Masking a Layer or Group” on page 1087.

**Advanced Replicator Controls**

When a replicator is created from a source layer, the default replicator parameters are used, creating a rectangular pattern consisting of five rows and five columns of elements. Although the HUD provides a fast way to modify the basic replicator parameters, the Replicator tab in the Inspector gives you total control over every aspect of that pattern. This includes individual parameters for each cell in a pattern (when a single cell source object is used).

**To open the Replicator tab:**

1. Select a replicator.
2. In the Inspector, click the Replicator tab.

The replicator parameters appear.

The contents of the Replicator tab are dynamic, and different parameters appear depending on the replicator shape that’s used. Also, different parameters appear depending on the Arrangement parameter assigned to closed shapes (such as a rectangle or circle). Further, open shapes (such as Spiral or Burst) can have additional dynamic parameters. For example, when Shuffle Order is turned on for a burst replicator, the Replicate Seed parameter appears.

**The Difference Between Replicator and Replicator Cell Parameters**

The replicator and replicator cell parameters, though closely related, serve different purposes. Replicator parameters control the overall shape, arrangement, number of elements, offset, stacking order, and origin or build order of elements in the replicator pattern.
Replicator cell parameters control the behavior and appearance of the elements within the replicator pattern. For more information, see “Replicator Cell Parameters” on page 805.

For a replicator with only one cell (one source layer), the replicator and replicator cell controls appear in the same Replicator tab. In this case, you can control every aspect of the replicator directly from this single tab, which saves you from having to go back and forth between the Replicator and Replicator Cell tabs. For a replicator with multiple cells, the replicator parameters remain in the Replicator tab and the cells are listed in the lower portion.
Each cell has its own Replicator Cell tab that contains all parameters for that cell. To access the cell parameters, you must select a cell in the Layers tab or Timeline layers list (under the replicator layer).

**Replicator Parameters**

The parameters in the Replicator tab give you complete control over every aspect of the pattern created by the selected replicator. This includes the shape on which the pattern is built and the shape's related parameters, such as the size of the replicator, how the elements are arranged in the pattern, and so on.

**Options in the Replicator Shape Parameter**

The first parameter in the Replicator tab is the Shape pop-up menu. The options in this pop-up menu significantly alter the distribution of the pattern elements. When you choose a replicator shape, different replicator parameters are revealed that are unique to that shape. For example, when Rectangle is selected in the Shape pop-up menu, the Outline, Tile Fill, and Random Fill options become available in the Arrangement pop-up menu. When Spiral is the selected Shape, the Arrangement parameter goes away and new parameters such as Radius, Twists, and Number of Arms become available. These different parameters provide additional control over the pattern.

For more information on using the replicator onscreen controls, see “Using the Replicator Onscreen Controls” on page 779.

*Note:* The Shape parameter, as well as the Shuffle Order and Reverse Stacking parameters, are persistent in the Replicator tab (they do not change based on what is selected in another parameter). The Cell Controls in the Replicator tab and the Replicator Cell tab are also persistent.
The following options are available in the Shape pop-up menu:

- **Line:** Elements are positioned on a line. Using the onscreen controls (with the Adjust Item tool) or the Inspector, you can specify the length and location of the line. In the Inspector, you can set a specific number of points on the line—one element is positioned at every point (including the end points of the line). The Line shape displays additional Start Point, End Point, Points, and Offset parameters.

![Line Shape Image]

- **Rectangle:** Elements are positioned in a rectangle along the replicator outline, or in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the rectangle. Drag the corners to adjust width and height; drag edges to adjust width or height independently. When Rectangle is selected, the Arrangement parameter becomes available. Depending on the selected Arrangement, the Rectangle shape displays additional parameters.

![Rectangle Shape Images]

Use the following modifier keys to more precisely manipulate the corners of the Rectangle onscreen controls:

- **Option:** Adjustments to size are scaled uniformly, with the anchor point remaining fixed.
- **Shift:** Adjustments to size are made proportionally.
• **Circle:** Elements are positioned in a circle along the replicator outline, or in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the radius and location of the circle. When Circle is selected, the Arrangement parameter becomes available. Depending on the selected Arrangement, the Circle shape displays additional parameters. In the following image, the circle's Arrangement is set to Outline.

![Circle](image1)

• **Burst:** Elements are positioned in a flare pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the radius and location of the burst. The Burst shape displays additional Radius, Number of Arms, Points Per Arm, Offset, and Origin parameters in the Replicator tab.

![Burst](image2)
• **Spiral:** Elements are positioned in a spiral pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the radius and location of the spiral. The Spiral shape displays additional Radius, Twists, Number of Arms, Points Per Arm, and Offset parameters in the Replicator tab.

![Spiral Diagram](image)

• **Wave:** Elements are positioned on a waveform. Using the onscreen control (with the Adjust Item tool) or the Inspector, you can specify the length and location of the wave. The Wave shape displays additional Start and End Point, Amplitude, Frequency, Phase, Damping, Points, and Offset parameters in the Replicator tab.

![Wave Diagram](image)
• **Geometry:** Elements are positioned along the edge of a shape, defined by a spline object used as the shape source. The Geometry shape displays additional Shape Source, Points, and Offset parameters in the Replicator tab.

For information on using geometry (a shape) as a replicator shape, see “Using Geometry for a Replicator Shape” on page 801.

• **Image:** Elements appear within an area defined by an image or along its border, depending on what is chosen from the Arrangement pop-up menu. The image may or may not have an alpha channel. If it does, the shape of the alpha channel can also be used to define the pattern. When Image is selected, the Arrangement parameter becomes available. Depending on the selected Arrangement, the Image shape displays additional parameters.

For information on using an image as a replicator shape, see “Using an Image for a Replicator Shape” on page 791.
• **Box:** This option is available when the 3D checkbox is turned on in the Replicator tab. Elements are positioned in a three-dimensional cube along the replicator outline, or on its surface in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the rectangle. Drag the front horizontal edge to adjust height; drag the front vertical edge to adjust width; drag a back edge to adjust depth; drag a front corner to simultaneously adjust the width and height. To reposition the replicator, drag in the replicator (but not on an edge or corner point). Depending on the selected Arrangement, the Box shape displays additional parameters. In the following image, the box’s Arrangement is set to Tile.

![Image of Box Shape]

• **Sphere:** This option is available when the 3D checkbox is turned on in the Replicator tab. Elements are positioned in a three-dimensional sphere along the replicator outline, or on its surface in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the radius and location of the circle. Drag the outline of the sphere to adjust its radius; drag within the sphere to reposition it in the Canvas. When Sphere is selected, the Arrangement parameter becomes available. Depending on the selected Arrangement, the Sphere shape displays additional parameters.

**Shape-Specific Parameters**

The following parameters appear depending on what is selected in the replicator Shape pop-up menu. They apply only to the replicator shapes, and affect the overall pattern created by the replicator.

Many parameters are shared between all shapes. For example, the Points (or Points Per Arm) parameter is always available for the Line, Burst, Spiral, Wave, Geometry shapes. The Points parameter is also available for the Rectangle, Circle, and Image shapes when Outline or Random Fill is selected in the Arrangement pop-up menu. The Points parameter is also available for the Box and Sphere shapes when Random Fill is selected in the Arrangement pop-up menu. The following parameter descriptions are divided into shapes that have the most parameters in common.
**Note:** Keep in mind that just because a parameter is described in a specific section below does not mean that parameter is exclusive to the shapes discussed in that section.

**Rectangle, Circle, Image, Box, and Sphere Shape Parameters**

When the selected shape is a Rectangle, Circle, Image, Box, or Sphere the following parameters become available:

**Arrangement:** Specifies the layout of the elements in the selected shape. The arrangement options are:

- **Outline:** Elements are positioned along the edge of the shape.
- **Tile Fill:** Elements are positioned in a tiled pattern of rows and columns within the circle, rectangle, image, box, or sphere. You can specify the number of columns and rows, as well as the Tile Offset.
- **Random Fill:** Positions elements randomly from within circle, sphere, rectangle, or box.

**Size (Rectangle, Box):** Defines the size of the rectangle or box shape. This parameter is available whether the Rectangle or Box Arrangement is set to Outline, Tile Fill, or Random Fill. Click the disclosure triangle to display separate width, height, and depth (for box) parameters. When Box is selected, Size contains an additional Depth parameter. When Circle is the selected shape, this parameter becomes Radius.

**Note:** For projects using the default camera settings and a default Z position for the replicator (the replicator has not been transformed in 3D space), the Height is measured in pixels, however, the Width is measured in square pixels. This is done so that a shape that is numerically square appears square when “Correct for Aspect Ratio” is turned on in the View pop-up menu in the top-right corner of the Canvas.

**Radius (Circle, Sphere):** Defines the size of the circle or sphere.

**Origin:** Specifies how the elements traverse across the pattern from a point of origin. For example, when set to Left, the elements sweep across the rectangle (or image) from left to right. When set to Upper Right, the elements from the upper-right corner point of the shape to the lower-right corner. This parameter is available when the Arrangement is set to Tile Fill or Random Fill.

**Image Source (Image):** This parameter, which becomes available when the Shape parameter is set to Image, allows you load an image object as the source for the replicator shape. To set the image source, drag an image from the Layers tab or Timeline layers list to the Image Source well.

**Using an Image for a Replicator Shape**
The following section describes how to use an image as the source for a replicator pattern.
To use an image for a replicator shape:
1 Import the image you want to use as the pattern source into your project.
2 In the Replicator tab, choose Image from the Shape pop-up menu.
   The Image Source well appears in the Inspector and HUD.
3 From the Layers tab, drag the image to the Image Source well.
4 When the pointer becomes a curved arrow, release the mouse button.
   A thumbnail of the image appears in the well and the image is used as the source shape for the replicator.

*Note:* You may want to disable the source image in the Layers tab so it is not visible in your project.
**Emission Alpha Cutoff** (Image): When the Image Source object contains an alpha channel, this slider defines the minimum opacity value that is necessary to create an element at that point on the source image. For example, when set to 25%, elements only appear at points where the alpha value of the image is equal to or greater than 25% opacity. The lower the Emission Alpha Cutoff value, the more cells appear. In order for this parameter to be effective, the alpha channel needs to have areas of varying transparency.

![Shape with a feathered edge used as Image Source](image1.png) ![Emission Alpha Cutoff set to 75%](image2.png) ![Emission Alpha Cutoff set to 30%](image3.png)

**Points:** Specifies the number of evenly distributed element points along the edge of the shape. This parameter is available when the Arrangement is set to Outline or Random Fill.

**Offset:** Adjusting this value moves the elements along the edge of the shape. This parameter is available when the Arrangement is set to Outline.

**Build Style:** When the Arrangement is set to Outline, this parameter specifies the direction in which the elements are placed along the edge of the shape. For the Rectangle, Circle, and Image shapes, when Arrangement is set to Tile Fill and Origin is set to Upper Left, Upper Right, Lower Left, or Lower Right, this parameter specifies how the elements are built over the pattern. For the Box and Sphere shapes, when Arrangement is set to Tile Fill and Origin is set to a corner (Front Upper Right, Front Upper Left, Front Lower Left, Front Lower Right, Back Upper Left, Back Upper Right, Back Lower Left, or Back Lower Right), this parameter specifies how the elements are built over the pattern.

When Arrangement is set to Outline, the Build Style options are:

- **Clockwise:** Places the elements along the shape in a clockwise direction.
- **Counter Clockwise:** Places the elements along the shape in a counterclockwise direction.

The following images show the difference between the Clockwise and Counter Clockwise parameters, using a replicator that applies a gradient over its pattern elements.
Note: When the cell Color Mode is set to Over Pattern, a gradient is applied to the elements over the replicator pattern. In this example, the gradient begins yellow, becomes orange in the middle, and becomes red at its end.

When Build Style is set to Clockwise, the gradient is applied to the pattern in a clockwise pattern. When set to Counter Clockwise, the gradient is applied in the reverse direction.

For Rectangle and Image shapes with Arrangement set to Tile Fill and Origin set to Upper Left, Upper Right, Lower Left, or Lower Right, the Build Style options are:

- **Across**: Builds the elements across the pattern in the direction implied by the Origin parameter.
- **By Row**: Builds the elements over the pattern by row.
- **By Column**: Builds the elements over the pattern by column.

For Box shapes with the Arrangement set to Tile Fill and Origin set to Front Upper Left, Front Upper Right, Front Lower Left, Front Lower Right, Back Upper Left, Back Upper Right, Back Lower Left, or Back Lower Right, the Build Style options are:

- **Across**: Builds the elements across the pattern in the direction implied by the Origin parameter.
- **By Row, Column, Rank**: Builds the elements over the pattern by row, column, then rank starting from the Origin.
• **By Column, Row, Rank**: Builds the elements over the pattern by column, row, then rank starting from the Origin.

• **By Row, Rank, Column**: Builds the elements over the pattern by row, rank, then column starting from the Origin.

• **By Column, Rank, Row**: Builds the elements over the pattern by column, rank, then row starting from the Origin.

• **By Rank, Row, Column**: Builds the elements over the pattern by rank, row, then column starting from the Origin.

• **By Rank, Column, Row**: Builds the elements over the pattern by rank, column, then row starting from the Origin.

**Columns**: Specifies the number of vertical columns (or horizontal element points) on a grid over the selected replicator. In the case of an irregular shape (nonrectangular), points that fall outside of the shape are ignored. This parameter is available when the Arrangement parameter is set to Tile Fill. It is also available for Box and Sphere when Arrangement is set to Outline.

**Note**: The default Columns value limit is 20. You can set a higher number in the value field.

**Rows**: Specifies the number of horizontal rows (or vertical element points) on a grid over the selected replicator. In the case of an irregular shape (nonrectangular), points that fall outside of the shape are ignored. This parameter is available when the Arrangement parameter is set to Tile Fill. It is also available for Box and Sphere when Arrangement is set to Outline.

**Note**: The default Rows value limit is 20. You can set a higher number in the value field.

**Ranks**: When the Box or Sphere shape is selected, specifies the number of points in Z space on a grid over the selected replicator. In the case of an irregular shape (nonrectangular), points that fall outside of the shape are ignored. This parameter is available when the Arrangement parameter (for Box and Sphere) is set to Tile Fill. This parameter is also available when the Arrangement parameter for Box is set to Outline.
**Tile Offset:** Specifies the amount (in percentage points) that the elements are offset from the pattern. Values from 0 to 100% offset the rows toward the right, and values from 0 to –100% offset the rows toward the left. A value of 50 or –50% creates a “brickwork” pattern. This parameter is available when the Arrangement parameter is set to Tile Fill.

![Circle set to Tile Fill](image1)

![Tile Offset set to a value of 20%](image2)

**Origin:** Specifies how the elements traverse across the pattern from a point of origin. For example, when set to Left, the elements sweep across the pattern from left to right. When set to Upper Right, the elements traverse from the upper-right corner point of the shape to the lower-right corner. This parameter is available when the Arrangement parameter is set to Tile Fill or Random Fill.

![Origin set to Left](image3)

![Origin set to Upper Right](image4)

When Rectangle or Image is chosen from the Shape pop-up menu and Arrangement is set to Tile Fill or Random Fill, the Origin options are:

- **Upper Left:** The elements originate in the upper-left corner of the pattern and end in the lower-right corner.
- **Upper Right:** The elements originate in the upper-right corner of the pattern and end in the lower-left corner.
- **Lower Left:** The elements originate in the lower-left corner of the pattern and end in the upper-right corner.

- **Lower Right:** The elements originate in the lower-right corner of the pattern and end in the upper-left corner.

- **Center:** The elements originate in the center of the pattern and move outward. This is the default Origin option.

- **Left:** The elements originate at the left side of the pattern and end at the right side.

- **Right:** The elements originate at the right side of the pattern and end at the left side.

- **Top:** The elements originate at the top of the pattern and end at the bottom.

- **Bottom:** The elements originate at the bottom of the pattern and end at the top.

When Circle or Sphere is chosen from the Shape pop-up menu and Arrangement is set to Tile Fill or Random Fill, the Origin options are:

- **Center:** The elements originate in the center of the pattern and build outward. This is the default Origin option.

- **Edge:** The elements originate along the edge of the pattern and build inward.

![Origin set to Center for a Circle shape](image1)

![Origin set to Edge for a Circle shape](image2)

When Box is chosen from the Shape pop-up menu and Arrangement is set to Tile Fill or Random Fill, the Origin options are:

- **Front Upper Left:** The elements originate in the front upper-left corner of the pattern and end in the back lower right.

- **Front Upper Right:** The elements originate in the front upper-right corner of the pattern and end in the back lower left.

- **Front Lower Left:** The elements originate in the front lower-left corner of the pattern and end in the back upper right.

- **Front Lower Right:** The elements originate in the front lower-right corner of the pattern and end in the back upper left.
- **Back Upper Left**: The elements originate in the back upper-left corner of the pattern and end in the front lower right.
- **Back Upper Right**: The elements originate in the back upper-right corner of the pattern and end in the front lower left.

- **Back Lower Left**: The elements originate in the back lower-left corner of the pattern and end in the front upper-right.
- **Back Lower Right**: The elements originate in the back lower-right corner of the pattern and end in the front upper-left.
- **Left**: The elements originate at the left side of the pattern and end at the right side. The pattern is identical on each row.
- **Right**: The elements originate at the right side of the pattern and end at the left side. The pattern is identical on each row.
- **Top**: The elements originate at the top of the pattern and end at the bottom. The pattern is identical on each rank.

- **Bottom**: The elements originate at the bottom of the pattern and end at the top. The pattern is identical on each rank.
- **Front**: The elements originate at the front of the pattern and end at the back. The pattern is identical on each column.
- **Back**: The elements originate at the back of the pattern and end at the front. The pattern is identical on each column.
- **Center**: The elements originate in the center of the pattern and move outward. This is the default Origin option.
- **X Axis**: The elements originate along the X axis of the pattern and move outward.
- **Y Axis**: The elements originate along the Y axis of the pattern and move outward.

**Note**: The origin parameter also determines where the Sequence Replicator behavior starts its animation. For more information on the Sequence Replicator behavior, see “Using the Sequence Replicator Behavior” on page 821.

**Replicate Seed**: Modifies the Random Fill pattern. Although the result of the Random Fill option from the Arrangement pop-up menu seems random, it's actually deterministic. This means that the random variation in the pattern is created based on the number shown here. Unless this seed number is changed, a replicator with the same parameter settings and source object always appears the same. If you don’t like the current random fill, you can change the seed number by typing a new number or clicking Generate. This changes the random calculations performed for that pattern. This parameter is also used to randomize the Shuffle Order parameter. For more information on Shuffle Order, see “Other Persistent Parameters” on page 803.

**Line and Wave Shape Parameters**
When the selected shape is a Line or Wave, the following parameters become available:

**Start Point**: Two sliders that define, in X, Y, and Z coordinates, the first point of the line or wave on which the elements are positioned. Click the disclosure triangle to access the Z Start Point value slider. You can adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool).

**End Point**: Two sliders that define, in X, Y, and Z coordinates, the second point of the line or wave on which the elements are positioned. Click the disclosure triangle to access the Z Start Point value slider. You can adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool).
Points: Defines the number of evenly distributed element points on the line or wave. When the Adjust Item tool is selected, the points are visible in the Canvas.

Offset: Adjusting this value moves the elements along the line or wave.

Additional Wave Parameters

Amplitude: Defines half the distance from the highest point to the lowest point in the wave. Higher values result in more extreme waves.

Frequency: Defines the number of waves. The default is value is 1.

Phase: A dial that defines the degree of offset of the waves from the start and end points of the path. When set to 0 degrees (default), the wave begins and ends at half the distance from the highest point to the lowest point in the wave. When set to 90 degrees, the wave begins and ends at the highest point in the wave. When set to –90 degrees, the wave begins at the lowest point in the wave. When set to 180 degrees, the waves are the same as 0 degrees, but inverted.

Damping: A slider that progressively diminishes the oscillation of the wave. Positive damping values diminish the wave forward (from left to right); negative values diminish the wave backward (from right to left).
**Burst and Spiral Shape Parameters**
When the selected shape is a Burst or Spiral, the following parameters become available:

**Radius:** Defines the size of the burst or spiral shape.

**Number of Arms:** Defines the number of branches on which the elements are positioned. The default value is 3.

**Points Per Arm:** Defines the number of element points on each branch of the burst or spiral. When the Adjust Item tool is selected, the points are visible in the Canvas.

**Additional Spiral Parameters**

**Twists:** Defines the number of turns in the spiral. The default value is 0.25. When Number of Arms is set to one, a single spiral is created.

---

**Geometry Shape Parameters**
When the selected shape is Geometry, the following parameters become available:

**Shape Source:** This parameter, which becomes available when the Shape parameter is set to Geometry, allows you to load a shape as the source for the replicator shape. To set the shape source for the replicator, drag a shape from the Layers tab or Timeline layers list to the Image Source well.

**Using Geometry for a Replicator Shape**
The following section describes how to use geometry as the source for a replicator pattern.

**To use geometry for a replicator shape:**

1. Import (or draw) the shape you want to use as the pattern source.
2. In the Replicator tab, select Image from the Shape pop-up menu.
The Shape Source well appears in the Inspector and HUD.

3. From the Layers tab, drag the shape to the Shape Source well.

4. When the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the shape appears in the well and is used as the source for the shape of the replicator.

**Note:** You may want to disable the source shape in the Layers tab so it is not visible in your project.

**Points:** Defines the number of evenly distributed element points around the shape.

**Offset:** Adjusts the position of the elements along the edge of the shape.

**Build Style:** Specifies the direction in which the elements are placed along edge of the shape. The options are:

- **Clockwise:** Places the elements along the shape in a clockwise direction.
- **Counterclockwise:** Places the elements along the shape in a counterclockwise direction.
Other Persistent Parameters

In addition to the Shape parameter, Shuffle Order, 3D, Reverse Stacking, and Face Camera also remain available regardless of what is selected in another parameter.

Note: This list does not include the Cell Controls, available for all replicator shapes, discussed in “Replicator Cell Parameters” on page 805.

Shuffle Order: When enabled, rearranges the order in which the elements appear. When Shuffle Order is turned on, the Replicate Seed parameter becomes available.

3D: When turned on, the Box and Sphere shapes become available from the Shape pop-up menu. In addition, if the Face Camera checkbox is turned on, the pattern elements actively face the camera when the camera or the replicator is rotated in 3D space.

Reverse Stacking: Inverts the order in which the elements are stacked. To see the effect of this parameter, elements must be overlapping.
Face Camera: When this checkbox is turned on, the pattern elements actively face the camera when the camera or the replicator are rotated. When Face Camera is turned off, the elements face forward in the replicator pattern and appear flat (unless the source layer or pattern elements are rotated in 3D space). Because Motion only supports 2D objects, this option is key to giving 2D objects the appearance of 3D as the camera is animated.

Note: Because replicator pattern elements are 2D (flat) objects, the pattern elements are not visible when you use the orthogonal camera views, such as Left, Right, and Top (unless the source layer or pattern elements are rotated in 3D space). This is because orthogonal views are at right angles (perpendicular) to the elements. For more information on using cameras, see “3D Compositing” in the Motion Supplemental Documentation PDF.

Animating Replicator Parameters
Any parameter that contains an Animation menu can be animated. The Animation menu is represented by a small dash at the end of the parameter row. If you have animated the replicator parameters, and you then apply a Simulation behavior, or a Throw or Spin behavior, to the replicator, the keyframes that affect position or rotation are ignored. For more information on applying behaviors to the replicator, see “Using Behaviors with Replicators” on page 836.
**Replicator Cell Parameters**

The replicator cell parameters apply to the elements (the replicated layers) created within a replicator. In a replicator with only a single cell, the cell parameters appear in the Replicator tab in the Cell Controls group. In a replicator with multiple cells, each cell has its own Replicator Cell tab that contains all parameters for that cell.

To display the Cell Controls for a single-cell replicator:

1. Select a replicator layer.
2. In the Inspector, click the Replicator tab.

The cell parameters appear in the Cell Controls group.

---

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shape</td>
<td>Rectangle</td>
</tr>
<tr>
<td>Arrangement</td>
<td>Tile Fill</td>
</tr>
<tr>
<td>Size</td>
<td>Width 655.88, Height 12.88</td>
</tr>
<tr>
<td>Columns</td>
<td></td>
</tr>
<tr>
<td>Rows</td>
<td></td>
</tr>
<tr>
<td>Tile Offset</td>
<td></td>
</tr>
<tr>
<td>Origin</td>
<td>Center</td>
</tr>
<tr>
<td>Anchor Order</td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td></td>
</tr>
<tr>
<td>Reverse Stacking</td>
<td></td>
</tr>
<tr>
<td>Fill Copies</td>
<td></td>
</tr>
<tr>
<td>Cell Controls</td>
<td></td>
</tr>
<tr>
<td>Angle</td>
<td></td>
</tr>
<tr>
<td>Angle End</td>
<td></td>
</tr>
<tr>
<td>Angle Random</td>
<td></td>
</tr>
<tr>
<td>Additive Blend</td>
<td></td>
</tr>
<tr>
<td>Color Mode</td>
<td>Original</td>
</tr>
<tr>
<td>Opacity</td>
<td></td>
</tr>
<tr>
<td>Interpolation</td>
<td>Constant</td>
</tr>
<tr>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td></td>
</tr>
<tr>
<td>Scale End</td>
<td></td>
</tr>
<tr>
<td>Scale Random</td>
<td></td>
</tr>
<tr>
<td>Show Objects As</td>
<td>Image</td>
</tr>
<tr>
<td>Random Seed</td>
<td></td>
</tr>
<tr>
<td>Object Source</td>
<td></td>
</tr>
</tbody>
</table>
To display the Cell Controls for a multi-cell replicator:

1. In the Layers tab or Timeline layers list select a cell (located beneath the replicator layer).

Align Angle: When enabled, the replicator elements automatically rotate to match the shape on which they are positioned. This parameter is available in all cases but the following: Rectangle, Circle, Image, Box, and Sphere shapes with Tile Fill or Random Fill and Point.

Angle: Specifies (in degrees) the rotation of the replicator elements. Using the default dial or value slider (when the disclosure triangle is closed), the Z angle is affected. To individually modify the rotation of the pattern elements in X, Y, and Z space, click the disclosure triangle.
• **Animate**: This pop-up menu allows you to change the interpolation for animated 3D rotation channels. By default, Method is set to Rotate.

  **Note**: The Angle parameter must be keyframed for the Method parameter options to have any effect.

• **Use Rotation**: This is the default interpolation method. Pattern elements rotate from their start rotation to their final rotation. Depending on the animation, the elements may twist this way and that before reaching their final orientation (the last keyframed value). For example, if the X, Y, and Z Angle parameters are animated from 0 degrees to 180 degrees in a project, the elements rotate on all axes before reaching their final orientation.

• **Use Orientation**: This interpolation method provides for smoother interpolation but does not allow multiple revolutions. It interpolates between the pattern elements’ start orientation (first keyframe) to their end orientation (second keyframe).

  For more information about the Animate parameter, see “Parameters in the Properties Tab” on page 280.

**Angle End**: Specifies (in degrees) the rotation of the replicator elements at the end of the pattern. The angle value of the elements at the end of the pattern equals the Angle value (start) plus the Angle End value. For example, if Angle is set to 0 degrees and Angle End set to 90 degrees, the elements are not rotated at all at their origin, and are rotated by 90 degrees at the end of the pattern.

Using the default dial or value slider (when the disclosure triangle is closed), the Z angle is affected. To individually modify the rotation of the pattern elements about the X, Y, and Z axes, click the disclosure triangle. For information on the Method parameter, see the Angle parameter description, above.
**Angle Randomness:** Defines an amount of variance in the rotation of the replicator cells. A value of 0 results in no variance—all elements have the same rotational value. A value greater than 0 introduces a variance. The angle for an individual element is defined by the Angle and Angle End parameter, plus or minus a random value falling within the Angle Randomness.

Using the default dial or value slider (when the disclosure triangle is closed), the Z angle is affected. To individually modify the rotation of the pattern elements in X, Y, and Z space, click the disclosure triangle. For information on the Method parameter, see the Angle parameter description, above.

**Additive Blend:** By default, replicator elements are composited together using the Normal blend mode. Turn on this checkbox to composite all overlapping elements together using the Additive blend mode. This blending occurs in addition to whichever compositing method is already being used. The result is that the brightness of overlapping objects is intensified. This applies only to the replicator itself—the blend mode of the replicator layer determines how the result of the pattern is blended into the scene.

**Color Mode:** Specifies the origin of the color for the replicated elements as Original, Colorize, Over Pattern, Pick From Color Range, and Take Image Color.

- **Original:** Elements are created using the original colors from the source layer. When Original is chosen, the Opacity Gradient editor appears, allowing you to change the opacity of the replicator elements over the pattern.

- **Colorize:** Elements are tinted using the color specified in the Color parameter. Additional Color and Opacity Gradient parameters appear.

  **Note:** For more information on the Colorize parameters, see “Additional Replicator Cell Parameters Based on the Selected Color Mode” on page 813.
• **Over Pattern**: Elements are tinted based on how they are ordered in the pattern. The gradient editor defines the range of color of the pattern, beginning with the leftmost color in the gradient, and progressing through the range of colors until reaching the rightmost color at the end of the pattern. Gradual color changes do not appear in each element, but only across the pattern as a whole. An Opacity control is available at the top of the gradient editor.

[Image of gradient editor and pattern]

• **Color Repetitions**: Drag the slider to increase the number of times the gradient is repeated over the pattern.

  *Note:* For more information on using the gradient controls, see “Using the Gradient Editor” on page 1033.

• **Pick From Color Range**: Elements are tinted at random, with the range of possible colors defined by the gradient editor. A point on the gradient is randomly chosen, so the relative sizes of each color region determine the frequency of the color being used.

• **Take Image Color**: Each element’s color is based on the color of the image at the position of the element point. This mode is only available when an image is used as the replicator shape.
Tip: When using images larger than the Canvas as a replicator shape image source, it is recommended that you enable Down-Res to Canvas Size in Motion Preferences (in the Still Images & Objects section of the Project pane) before importing the images.

Scale: Defines the scale of the replicator elements. Click the disclosure triangle next to the Scale parameter to reveal separate X Scaling and Y Scaling subparameters that can be used to scale the width and height of the elements separately. By default, Scale is set to 100%—the size of the replicator elements is equal to the size of the source layer.

Scale End: Specifies the scale of the replicator cells at the end of the pattern, relative to the Scale value. For example, if Scale is set to 100% and Scale End set to 50%, the cells are 100% at their origin, and half of their size at the end of the pattern.

Scale Randomness: Defines an amount of variance in the scale of the replicator elements. A value of 0 results in no variance—all elements in the pattern are the same size. A value greater than 0 introduces a variance. The scale for an individual element is defined by the Scale parameter, plus or minus a random value falling within the Scale and the Scale End. The disclosure triangle of the Scale Randomness parameter reveals separate X and Y subparameters, which can be used to set the width and height of the Scale Randomness separately.

Show Objects As: You can display replicator elements in one of a variety of preview modes, or as they actually appear. The nonimage modes play more efficiently when viewing a complex replicator pattern. By default, this parameter is set to Image, which displays each element as it is supposed to appear. There are four options from which to choose:

- Points: Each element is represented by a single point. This is the fastest preview mode.
• **Point Size:** This parameter appears when Points is selected from the Show Objects As pop-up menu. This allows you to increase the size of the points for easier viewing. In the following image, the Point Size is set to 8.

![Image of points with Point Size set to 8]

• **Lines:** This parameter is effective only when the elements of the replicator are animated using Simulation behaviors or the Throw (Basic Motion) behavior. The movement of each pattern element is represented by a line and is useful in analyzing the vector of each element's motion. The length of each line is determined by that element's speed, and the angle of each line equals each element's direction. In the following image, the replicator elements are animated using the Vortex behavior.

![Image of replicator elements animated with Vortex behavior]

*Note:* Element movement created by using the Sequence Replicator behavior or by keyframing the replicator parameters is not displayed.
• **Wireframe:** Each pattern element is represented by a bounding box. Because the bounding boxes are good indicators of each element’s orientation in the pattern, this preview mode is useful for evaluating the movements of individual elements. For example, it’s easy to see the angle of rotation for elements that are spinning or following a complex motion path.

![](image1.png)

• **Image:** Displays the elements as they are supposed to appear in your final render.

![](image2.png)

**Important:** If the Show Objects As parameter is set to a nonimage mode upon exporting the project, the project renders in the selected mode.

**Random Seed:** Although the result of adjusting the Angle Randomness, Scale Randomness, Pick From Color Range, Random Start Frame, or Hold Frame Randomness parameters seems random, it’s actually deterministic. This means that the random variation in the pattern is created based on the number shown here. Unless this seed number is changed, a replicator with the same parameter settings always appears the same. If you don’t like the current random scale or angle, you can change the seed number by typing a new number or clicking Generate.

**Object Source:** The cells of a replicator are listed at the bottom of both the Replicator tab and the Replicator Cell tab. Each cell appears in an image well, and a checkbox allows you to enable or disable that cell (if the replicator has multiple cells).
Additional Replicator Cell Parameters Based on the Selected Color Mode

Each of the options in the Color Mode pop-up menu displays a different set of parameters.

Many of the following options use the opacity or color gradient controls. For more information on using gradient editors, see “Using the Gradient Editor” on page 1033.

Color: A color well that becomes available when the Color Mode is set to Colorize. Use it to specify a color to use to tint the replicator elements. You can also modify each element’s Alpha value, altering its opacity. This parameter is unique to the cell object. You can either click the color well to choose a color, or open the disclosure triangle and use the Red, Green, Blue, and Alpha channel sliders or value sliders.

Opacity Gradient: This gradient editor appears when Color Mode is set either to Original or Colorize. Use it to change the opacity of the replicator elements over the pattern. This gradient control is limited to grayscale values, which are used to represent varying levels of transparency. White represents solid elements, progressively darker levels of gray represent decreasing opacity, and black represents complete transparency. A simple white to black gradient represents a pattern that is solid at its origin, but which fades out gradually. The Opacity Gradient has four parameters:

- Gradient preset pop-up menu: Gradients from the Library (default or custom) appear in this pop-up menu. Choose a gradient from this menu to load it into the gradient editor. None of the default gradients have opacity gradients.
- Opacity bar: To add a new opacity tag to the gradient, click anywhere within the opacity bar. Click an opacity tag to select it, and then change its value with the Opacity slider. To change the distribution of opacity, drag an opacity tag along the opacity bar, or select an opacity tag and use the Location slider. Change the spread of color between two gradient tags using the spread controls (triangles). To delete a gradient tag, drag it away from the gradient bar until it disappears.
- Opacity slider: Changes the shade of a selected gradient tag, from 100 (opaque/white) to 0 (transparent/black).
- Interpolation: Sets the interpolation of the selected opacity tag to Constant, Linear, or Continuous.
- Location slider: Changes the location of the selected gradient tag relative to the gradient bar.

Color Gradient: This gradient editor appears when the Color Mode is set to Over Pattern. Use it to change the color of the replicator elements over the pattern. At their origin, elements are tinted with the leftmost color in the gradient. The elements progress through the range of colors until reaching the rightmost color at the end of the pattern. Gradual color changes do not appear in each element, only across the pattern as a whole. Similar to the Opacity Gradient editor, the Color Gradient editor has five parameters:
• **Gradient preset pop-up menu**: Gradients from the Library (default or custom) appear in this pop-up menu. Choose a gradient from this menu to load it into the gradient editor.

• **Opacity bar**: Use it to change the opacity of the replicator elements over the pattern. All color tags are limited to shades of gray.

• **Color bar**: A gradient control that allows you to tint replicator elements over the pattern.

• **Color control**: When a color tag is selected in the gradient editor control, you can change its color by either clicking the color well and choosing a color using the Colors window, or Option-clicking the well and using the pop-up color palette.

• **Opacity slider**: When an opacity tag is selected in the Opacity Gradient control, you can use this slider to change its shade, from 100 (opaque/white) to 0 (transparent/black).

• **Interpolation**: Sets the interpolation of the selected gradient tag to Constant, Linear, or Continuous.

• **Location slider**: Changes the location of the selected gradient tag or spread control relative to the gradient bar.

**Color Range**: A gradient control that appears when the Color Mode is set to Pick From Color Range. Use it to define a range of colors used to randomly tint pattern elements. The direction of the gradient colors is not relevant, only the number of colors that appear within the gradient. The Color Range parameter has the same controls as the Over Pattern parameter.

**Note**: For more information on using gradient editors, see “Using the Gradient Editor” on page 1033.

**Additional Cell Parameters for QuickTime Movies and Image Sequences**

If you create a replicator pattern using a QuickTime object as the source for a cell, additional parameters appear. These six parameters are:

• **Play Frames**: A checkbox that controls playback. If it’s turned on, it loops the playback of the animation or movie clip used for each element. If it’s turned off, the elements use the still frame specified by either the Random Start Frame parameter or the Source Start Frame parameter.

• **Random Start Frame**: A checkbox that introduces variation into elements using QuickTime objects as their source objects. If it’s turned on, each element in the pattern begins at a different frame of the animation. Stills are chosen randomly if Play Frames is turned off.

• **Source Start Frame**: Chooses the frame to begin animation, if Play Frames is turned on, or the still frame to display if Play Frames is turned off. This parameter appears only if Random Start Frame is turned off.
**Source Start Frame Offset:** Offsets the start frame chosen in the Source Start Frame parameter over the pattern. At their origin, the elements play the animation from the frame specified in the Source Start Frame parameter. Each step away from the origin advances the start frame by the offset amount. This parameter only appears if Random Start Frame is turned off.

**Hold Frames:** Sets the number of times each frame of the source movie is repeated during playback. The larger the Hold Frames value, the slower your playback.

**Hold Frames Randomness:** Varies the number of frames to “hold.”

### Animating Replicator Parameters
Most of the replicator and replicator cell parameters can be animated with keyframing or using Parameter behaviors. If you animate the replicator’s shape-specific parameters such as Radius, Twists, and Offset (of a Spiral replicator), the pattern on which the elements are built is animated, not the elements themselves. To animate the elements of the pattern, you keyframe the parameters in the Cell Controls group (or the Replicator Cell tab).

Keyframing the replicator parameters (or using Parameter behaviors) animates all elements in the replicator symmetrically. To animate the individual elements in sequence over time—without having to create keyframes—use the Sequence Behavior, described in “Using the Sequence Replicator Behavior” on page 821. To animate the replicator using Basic Motion or Simulation behaviors, see “Using Behaviors with Replicators” on page 836.

**Important:** If you apply a Simulation behavior, or a Throw or Spin behavior to a replicator with animated parameters, some of the keyframed parameters are ignored. For more information on using behaviors with the replicator, see “Using Behaviors with Replicators” on page 836.
You can also use keyframes to animate the parameters in a replicator’s Properties tab. Parameters in this tab affect the replicator as a whole, not the individual replicator elements. This can be useful for changing the replicator’s position or rotation over time.

**Example: Creating an Animated Replicator**

The following example demonstrates how quickly you can create attractive, complex animated patterns with minimal effort. An animated replicator is created using a hand-drawn shape as the source for the replicator’s cell. Once the replicator is created, the Angle and Scale parameters are keyframed, and a Parameter behavior is applied to the Radius parameter.

To create an animated replicator using keyframes:

1. Place the object that you want to replicate into your project.
   
   This example uses a bow-shaped Bezier shape object that is filled with a custom gradient. (You can also use a shape with the default white fill, and apply a gradient to the replicator elements rather than the original source object.)

2. In the Layers tab, select the source layer and click the Replicate icon in the Toolbar (or press L).
   
   The default replicator object (rectangle shape with the tile fill arrangement) appears in the Layers tab and in the Canvas. The original source layer is disabled.
3 In the Replicator tab of the Inspector, do the following:
   a Select Circle from the Shape pop-up menu.
   b Select Outline from the Arrangement pop-up menu.
      The cells appear in a circle. By default, the circle shape contains five points, and its
      Radius is set to 200. An element appears at every point on the circle.

   c If necessary, adjust the Radius parameter so that elements are not cut off in the
      Canvas. In this example, Radius is set to 145.
   d Increase the Points value until the elements overlap. An element is created at every
      point on the shape. In this example, Points is set to 30.

   e In the Cell Controls group, turn on Align Angle.
      Based on the location of the anchor point of the source layer, the replicator elements
      automatically rotate to match the curve of the circle.
f Turn on Additive Blend.

The color values in every overlapping pixel are added together, and all overlapping midrange color values are lightened.
4 Go frame 1 (press Home), and enable Record (press A).
When Record is enabled, the Record button in the transport controls is red and all 
animateable values in the Inspector appear pink. Keyframes are created for any 
changes made to a layer.

5 In the Replicator tab, click in the Angle value field, type 0, and press Enter to create a 
keyframe.

*Note:* You can create keyframes without using the Record button by positioning the 
cursor over the Animation menu icon and pressing Option. When a keyframe symbol 
appears next to the pointer, click to create a keyframe.

6 Set the Scale value to 50%.

7 Advance to the end of the project (press End), or to the frame where you want the 
amination to stop. In this example project, the last frame is 150.

8 Set the Angle value to 240 degrees and the Scale value to 80%.

9 Press A to disable Record, deselect the object (click in a gray area of the Canvas), then 
play the project (press the Space bar).
The replicator elements rotate and increase in size over time to create a pinwheel.

*Tip:* A simple way to create a new look for a replicator is to move the position of the 
source object’s anchor point. You can continue to play the project while you adjust the 
anchor point until you create a look that you like.
To change the anchor point of a replicator source layer:
1 In the Layers tab, select the source.
   Although not required to adjust its anchor point, you can enable the source layer so you can see it in the Canvas.
2 In the Toolbar, select the Adjust Anchor Point tool.

![Adjust Anchor Point tool](image)

Note: You can also press Tab to cycle through the onscreen control modes.

3 In the Canvas, move the source object’s anchor point.

The alignment of the elements to the replicator shape (the circle) changes based on the position of the anchor point.

To animate a replicator parameter using a Parameter behavior:
1 Continuing with the above example, select the replicator in the Layers tab.

Note: Remember, you can continue to play back a project while making parameter adjustments.

2 Control-click the parameter to which you want to add a Parameter behavior (this discussion uses the Radius parameter), and choose Oscillate from the shortcut menu.

The size of the replicator oscillates in the Canvas, bringing the elements closer together and further apart through the animation to create yet another look for the replicator pattern. The Oscillate parameters appear in the Behaviors tab, and a Parameter behavior icon appears in the Animation menu of the Radius parameter in the Replicator tab.

3 Adjust the Oscillate parameters, if necessary.
For more information on the Oscillate and other Parameter behaviors, see “Parameter Behaviors” on page 430.

**Displaying Replicator Animation Curves in the Keyframe Editor**

The replicator parameters in the Properties and Replicator tabs can be keyframed to create a change in values over time. There is a difference, however, in what object needs to be selected to show the curves in the Keyframe Editor (when Animated is selected from the Show pop-up menu):

- Select the *replicator layer* to display animated replicator parameters such as Position and Rotation in the Properties tab, or Size or Tile Offset (available when the shape is a rectangle) in the Replicator tab.
- Select the *cell layer* to display animated parameters in the Cell Controls section of the Replicator tab or the Replicator Cell tab, such as Angle or Scale.

*Note:* To manually send any animated parameter to the Keyframe Editor, click the keyframe icon in the Animation menu, and choose Show in Keyframe Editor. The parameter is displayed in the Keyframe Editor in a new, untitled curve set.

For more information on keyframing parameters in the Curve Editor, see “Keyframes and Curves” on page 503.

**Using the Sequence Replicator Behavior**

The replicator also has a special behavior called Sequence Replicator, which allows you to animate the individual elements in sequence over time. This is the only way to animate the elements individually—keyframing the cell parameters or applying other behaviors affects all elements in the pattern uniformly.

The Sequence Replicator is very similar to the Sequence Text behavior, which allows you to animate text parameters in sequence through the characters of a text layer. With the Sequence Replicator behavior, you can select and apply replicator cell parameters, such as Position, Color, Scale, Rotation, or Opacity, and animate those parameters in sequence through the elements of a replicator pattern.
The starting point for the sequence animation is based on the replicator’s origin or build style. For example, if a spiral replicator’s Origin parameter is set to Center, the sequence animation begins at the center of the spiral and moves outward; if the Origin of a rectangle replicator with a tile fill is set to Upper Left, and the Build Style is set to Across, the sequence begins with the elements in the upper-left of the pattern, and moves toward the lower-right.

The Sequence Replicator behavior can be applied to the replicator object itself, or to the cells of the replicator. When applied to the different cells of a replicator with multiple cells, different animations can be created for each cell.

Like most other layers in Motion, once you have created a Sequence Replicator behavior, you can save the behavior to the Library.

**To apply a Sequence behavior to a replicator, do one of the following:**

- In the Layers tab or Timeline layers list, select the replicator to which you want to apply the Sequence behavior. In the Toolbar, click the Add Behavior icon and choose Replicator > Sequence Replicator.

- In the Library, select the Behaviors category, and then the Replicator subcategory. Drag the Sequence Replicator behavior from the stack to the replicator in the Layers tab, Canvas, or Timeline layers list.


At the top of the Sequence Replicator controls in the Inspector are the Parameter pop-up menus, which are used to add parameters to the behavior, or to remove them once they’ve been added. The added parameters determine which properties are animated.
Underneath the Parameter pop-up menus are the Sequence Control parameters, which determine how the added parameters affect the onscreen elements. These controls include options for setting the direction of the animation, whether the animation is applied per element or to the whole pattern, the number of times the animation cycles through the pattern, and so on.

Important: Before any sequencing animation can occur, you must explicitly add at least one parameter to the behavior from within the Inspector or HUD, and then set a value for that parameter. Until a parameter is added, adjustments in the HUD have no effect.

Adding Parameters to the Sequence Replicator Behavior

In the following example, the Rotation, Opacity, and Scale parameters are added to the Sequence Replicator behavior. The behavior is applied to a replicator with its Shape set to Burst, and its Origin set to Center. This example uses the source object from the “Example: Creating an Animated Replicator” on page 816.
To add and animate Sequence behavior parameters:

1. With the Sequence Replicator behavior selected, display the Behaviors tab in the Inspector.

2. In the Parameter row, do the following:
   a. Choose Rotation from the Add Parameter pop-up menu.
   b. Choose Opacity from the Add Parameter pop-up menu.
   c. Choose Scale from the Add Parameter pop-up menu.

   The added parameters appear above the Add and Remove pop-up menus. No animation occurs until a value is set for the parameters.

   Play the project (press the Space bar) to better see the effects of the sequencing.

3. Set Rotation to the largest (or smallest) value you want the cells to rotate in the animation. In this example, Rotation is set to 160 degrees.

   Each element rotates from 0 degrees to 160 degrees over the pattern over the duration of the Sequence Replicator behavior.

   **Note:** If the elements are already rotated (in the Cell Controls), the elements are rotated 160 degrees from their original rotation value.

   Each element rotates and pops into place before the next element begins its animation. To soften this effect, increase the Spread value.

4. Increase the Spread value. In this example, Spread is set to 12.
In addition to creating a more graceful animation, changing the Spread value can also dramatically change the appearance of the pattern.

5 Set Opacity to the lowest value you want the elements to become in the animation. In this example, Opacity is set to 0.

Each element fades from 100% opacity to 0% opacity over the pattern over the duration of the Sequence Replicator behavior.

Note: If the elements already contain some transparency, they fade from their original opacity value to 0%.

6 Increase the Scale value. In this example, Scale is set to 190%.
The animation begins at the original value for any added parameter, then transforms to the value you specify in the Sequence Replicator parameters. The animation begins at the origin of the pattern (set in the Origin or Build Style parameter of the Replicator tab or HUD) and moves through to the end of the pattern.

**Adjusting the Sequence Control Parameters**

Once you have created a sequence animation, you can use the Sequence Control parameters to change the manner in which the sequence moves through the replicator pattern. The following section continues with the project used in the previous examples.

**To change the way the sequence moves through the pattern:**

1. With the Sequence Replicator behavior selected, display the Behaviors tab in the Inspector.
2. Play the project (press the Space bar) to better see the effects of the sequencing.
   
   By default, Sequencing is set to "To," which specifies that the animation begins at the original value of the cells and moves to the value set in the Sequence Replicator behavior for that parameter. The starting point for the sequence animation is based on the build or "origin" of the pattern (as defined in the Origin or Build Style parameters in the Replicator parameters). In the example project, the elements begin completely opaque, at 100% scale, and with 0 degrees of rotation at the origin of the pattern. As the sequence moves toward the end of the pattern, the elements become completely transparent, are scaled to 190%, and rotated 160 degrees.

3. In the Sequencing pop-up menu, choose From.
   
   The animation moves from the value set in the Sequence Replicator behavior to the original value of the cells. This is the opposite of the To Sequencing option.
4 In the Sequencing pop-up menu, choose Through.
   The sequence goes through a full animation cycle starting at the original value of the cells, moving to the value set in the Sequence Replicator, then returning to the original value of the cells. This is similar to combining the To and From Sequencing options.

5 Choose All from the Unit Size pop-up menu.
   The sequence animation affects all replicator elements simultaneously. The default is Object, which applies the sequence animation to the elements of the replicator based on the origin of the pattern.

6 Increase the Loops value to a minimum value of 3.
   By default, a sequence animation plays through one time. The value of the Loops parameter defines the number of times the animation repeats over the duration of the replicator object.

7 Choose Ping Pong from the End Condition pop-up menu.
   By default, the End Condition parameter is set to Hold, which completes a sequence animation cycle, then starts the cycle again from the beginning. When set to Ping Pong, the animation cycles forward one time, then cycles backward, then forward, and so on.

   Note: The End Condition parameter has no effect for Loop values less than or equal to 1.
For more information on the Sequence Replicator parameters, see “Sequence Replicator Parameters” on page 828.

Modifying the Sequence Replicator Behavior
Use the Sequence Replicator controls to define how the change in cell value animates through the replicator pattern and how many times the animation repeats over the duration of the replicator. You can also use the Sequence Replicator controls to “soften” the effect between pattern elements.

Once you have created and modified a Sequence Replicator behavior, you can save the behavior to the Library.

Sequence Replicator Parameters
Use the following parameters to modify the sequence animation. With the exception of the Add and Remove Parameter pop-up menus, all of the following parameters also appear in the Sequence Replicator HUD.

Parameter: Use the Add and Remove Parameter pop-up menus to add and remove replicator cell parameters to the sequence. These parameters are very similar to the cell parameters. Once the parameter is added, set (or keyframe) a value for that parameter. The sequence animation is based on the change in value between these parameters and the original values of the cells. The available parameters are:

- **Rotation**: Specifies (in degrees) the rotation of the replicator elements. You can either rotate the dial or use the value slider.
- **Color**: Specifies a color to use to tint the replicator elements. You can either click the color well to choose a color, or open the disclosure triangle and use the Red, Green, and Blue sliders or value fields. When Color is chosen from the Add pop-up menu, the color well and individual color channel parameters appear.
- **Scale**: Defines the scale of the replicator elements. Click the disclosure triangle next to the Scale parameter to reveal separate X Scaling and Y Scaling subparameters, which can be used to scale the width and height of the cells separately. By default, Scale is set to 100%—the size of the replicator cells is equal to the original size defined in the cell parameters.
- **Opacity**: Defines the transparency of the pattern elements.
• **Position**: Defines the offset of the elements from their original position. Click the disclosure triangle next to the Position parameter to reveal separate X, Y, and Z Position subparameters. For example, to create an animation in which the elements move upward in Y over the replicator pattern, enter a positive value in the Y Position field. In the following images, Y Position is set to 300.

For more information about the Rotation, Color, Scale, Opacity, and Position parameter, see “Parameters in the Properties Tab” on page 280.

**Sequence Control**
The Sequence Control section of the Sequence Replicator behavior parameters contains controls that allow you to modify the way the animation moves through the replicator pattern, such as changing the direction of the animation.

**Sequencing**: Specifies how the sequence animation—the value change from the original parameter value to the value set in the Sequence Replicator parameters—moves through the elements of the pattern. The starting point for the sequence animation is based on the selected Origin or Build Style parameters (in the Replicator parameters). For example, if a line replicator’s Origin parameter is set to End Point, the sequence animation begins at the end of the line and moves toward the start of the line by default. To change the starting point for the sequence animation, change the Origin or Build Style of the pattern in the replicator controls—the Replicator tab or HUD. The Sequencing options are:

• **To**: Specifies that the animation begins at the original value of the cells and moves to the value set in the Sequence Replicator behavior for that parameter. For example, if the original opacity value of a pattern cell is 100%, and opacity is set to 0% in the Sequence Replicator parameters, the elements begin completely opaque and become completely transparent.

• **From**: Specifies that the animation moves from the value set in the Sequence Replicator behavior to the original value of the cells. For example, if the original opacity value of a pattern cell is 100%, and opacity is set to 0% in the Sequence Replicator parameters, the elements begin completely transparent and become completely opaque. This is the opposite of the To Sequencing option.
• **Through**: Specifies that the sequence goes *through* a full animation cycle starting at the original value of the cells, moves to the value set in the Sequence Replicator, and then returns to the original value of the cells. For example, if the original opacity value of a pattern cell is 100%, and opacity is set to 0% in the Sequence Replicator parameters, the elements begin completely opaque, become transparent, and then become completely opaque again.

• **Through Inverted**: Specifies that the sequence goes *through an inverted* animation cycle starting from the value set in the Sequence Replicator, moves to the original value of the cells, and then returns to the value set in the Sequence Replicator. For example, if the original opacity value of a pattern cell is 100%, and opacity is set to 0% in the Sequence Replicator parameters, the elements begin completely transparent, become opaque, and then become completely transparent. This is the opposite of the Through Sequencing option.

• **Custom**: Allows you to use animation originally created in the source layer’s parameters (except alpha parameters) or to keyframe how the animation moves through the values set in the Sequence Replicator parameters over an individual element. Each element undergoes the same value sequence. When Custom is chosen from the Sequencing pop-up menu, the Source parameter becomes available.

• **Source**: This option is available when Custom is chosen from the Sequencing pop-up menu. The Source options are:
  - **Use Source Animation**: If the source layer parameters are keyframed (in the Replicator tab or HUD), choose this option to enable the animation created by those keyframes.
  - **Ignore Source Animation**: If the source layer parameters are keyframed (in the Replicator tab or HUD), choose this option to ignore the animation created by those keyframes.

**Unit Size**: Specifies whether the sequence animation is applied to the replicator pattern as a whole, to its individual elements, or to a keyframed range. The Unit Size options are:
• **Object**: Applies the sequence animation over each element as its own entity. Object is the default setting.

When Unit Size is set to Object, each replicator pattern cell is affected individually.

• **All**: Applies the sequence animation to all replicator elements simultaneously.

When Unit Size is set to All, every replicator pattern cell is affected simultaneously.
- **Custom**: Allows you to specify the percentage of elements in the pattern that are affected by the sequence animation at once. Although you can create keyframes for the Custom option, it is not required in order to affect the sequence. As shown in the following images, the Object and All options allow you to sequence the animation only through the origin or build style of the pattern, or through all pattern elements simultaneously.

![Unit Size set to Object sequences the animation over the build of the pattern.](image1)

![Unit Size set to All sequences the animation over all cells simultaneously.](image2)

Custom allows you to define an area of elements—based on percentage—that are affected by the sequence.

![Unit Size set to Custom allows you to define the percentage of cells affected as the sequence moves through the pattern.](image3)

When Custom is chosen from the Unit Size pop-up menu, the Start and End parameters become available.

- **Start**: Specifies the offset of the start of the range of elements affected by the sequence animation as it moves over the replicator pattern. In the above image, Start is set to 10%. 

- **End**: Specifies the end of the range of elements affected by the sequence animation as it moves over the replicator pattern. By default, End is set to 10%. In the above image, End is set to 30%.

  **Note**: If the Sequencing pop-up menu is set to Custom, the Custom option in the Unit Size parameter has no affect.

- **Spread**: Controls the amount of falloff of the animation. To create a softer transition between each element, increase the Spread value.

- **Traversal**: Sets the action of the sequence behavior to Constant Speed, Ease In, Ease Out, Ease In/Out, Accelerate, Decelerate, or Custom.
  - **Ramp**: Moves the animation from the origin of the replicator pattern through the end of the pattern at a constant speed. The sequence moves in the direction specified in the replicator parameters, such as the origin or build style.
  - **Ease In**: The sequence animation begins slowly and increases to normal speed as it moves through the replicator pattern.
  - **Ease Out**: The sequence animation begins at normal speed and slows toward the end of the replicator pattern.
  - **Ease In/Out**: The sequence animation begins slowly, increases to normal speed as it moves toward the middle of the duration of the replicator pattern, and slows as it reaches the end of the replicator pattern.
  - **Accelerate**: The sequence animation increases in speed.
  - **Decelerate**: The sequence animation decreases in speed.
  - **Custom**: Allows you to keyframe how the animation moves through the replicator pattern. When Custom is selected from the Traversal pop-up menu, the Location parameter replaces the Loops parameter.
  - **Location**: Defines the location of the pattern where the animation is in effect.

  For more information on using the Custom Traversal option, see “Using the Sequence Replicator Custom Traversal Option” on page 834.

- **Loops**: Sets the number of times the animation sequences through the replicator pattern over its duration.

  **Note**: Loops is not available when the Traversal parameter is set to Custom.

- **End Condition**: Determines how the sequence animation is repeated over the duration of the replicator object. This parameter has no effect for Loop values less than or equal to 1. The End Condition options are:
  - **Hold**: Completes the sequence animation cycle one time, then starts it over again from the beginning (once the last element in the sequence has completed its animation).
  - **Wrap**: Treats the sequence animation as a continuous loop so the spread wraps from the last element in the sequence to the first element.
• **Ping Pong:** Completes the sequence animation cycle forward, then completes the animation backward, then forward, and so on.

**Using the Sequence Replicator Custom Traversal Option**

When Traversal is set to Custom, you can create location keyframes to specify where the effect of the sequence is at any given time. This allows you to create a sequence animation that travels through a replicator pattern in a unique way. In this example, use the Custom Traversal option to scale the elements around a circle replicator shape by creating keyframes.

**To use the Custom Traversal parameter:**

1. Once the Sequence Replicator behavior is applied to the replicator, add the parameters that you want to include in the sequence in the Behaviors tab.
2. Set the values for the added parameters. In this example, the Scale parameter is added and the Scale value set to 200%.

   ![Sequence behavior applied to replicator with Scale parameter set to 200%, Sequencing set to Through, and Spread set to 4](image)

   For more information on adding parameters to the Sequence Replicator behavior, see “Adding Parameters to the Sequence Replicator Behavior” on page 823.

3. Choose Custom from the Traversal pop-up menu.
   
   The Location parameter becomes available.

   ![When Traversal is set to Custom, the Location parameter becomes available. Use the Location slider to keyframe how the sequence moves through the replicator pattern.](image)

4. Enable Record (press A).
5 At the frame where you want to begin the animation, drag the Location slider (or use the value slider) to set where the sequence begins.

As you drag the slider, the sequence moves through the pattern elements. Values displayed in the Location parameter specify where in the pattern the sequence is (in percentage points)—0 representing the origin of the pattern, and 100% representing the end of the pattern.

In the Inspector, a keyframe is added to the Location parameter.

6 Go to the next frame where you want to set a keyframe, and move the Location slider.

7 Repeat step 6 until you have created all of your keyframes.

8 Play the project (press the Space bar).

The animation moves through the replicator pattern based on its keyframed locations. In this case, the scale moves erratically back and forth around the circle, rather than in a constant direction.

Using Parameter Behaviors With the Sequence Replicator Behavior

Like all other layers in Motion, you can add Parameter behaviors to the Sequence Replicator parameters to create even more varied, complex effects without keyframing.

To apply a Parameter behavior to a Sequence Replicator behavior:

1 In the Layers tab or Timeline layers list, select the Sequence Replicator behavior.

2 Control-click the parameter to which you want to add a Parameter behavior, then choose a Parameter behavior from the shortcut menu.
The Parameter behavior is added, and appears above the Sequence Replicator behavior in the Behaviors tab. A Parameter behavior icon appears in the Animation menu of the Sequence Replicator parameter.

Note: When the Wriggle or Randomize Parameter behavior is added to a Sequence Replicator parameter, additional Affect Subobjects parameter is available. This allows each object to have a different random behavior.

For more information on using Parameter behaviors, see “Parameter Behaviors” on page 430.

Using Behaviors with Replicators
As with all layers in Motion, you can apply Basic Motion, Parameter, and Simulation behaviors to a replicator or to its cells.

Only the Throw and Spin behaviors (from the Basic Motion subcategory) can be applied to the replicator cell layer. All behaviors from the Basic Motion subcategory can be applied to the replicator layer.

As previously noted, the replicator also has a special behavior called Sequence Replicator, which allows you to animate the individual cells in sequence over time. For more information on the Sequence Replicator behavior, see “Using the Sequence Replicator Behavior” on page 821.
For more information on applying Parameter behaviors to the Sequence Replicator behavior, see “Using Parameter Behaviors With the Sequence Replicator Behavior” on page 835.

To apply a behavior to a replicator, do one of the following:

- Drag a behavior from the Library onto a replicator in the Canvas, Layers tab, or Timeline.
- Select the replicator in the Layers tab, Timeline layers list, or Canvas, click the Add Behavior icon in the Toolbar, then choose a behavior from the shortcut menu.

The behavior is applied to the replicator, which begins to move according to the parameters of the behavior.

Not all behaviors instantly activate a layer when applied. For example, when a Throw behavior is applied to a layer, the Throw Velocity parameter must be adjusted before the object moves.

For more information on behaviors, see “Using Behaviors” on page 369.

Special Behavior Considerations

When Simulation behaviors, as well as the Spin and Throw behaviors, are applied to a replicator that has animated parameters, some of the animation created by the keyframes is ignored. For example, if the Angle parameter in the Cell Controls of the Replicator tab is keyframed so that the pattern elements rotate over time and you apply a Spin behavior—with the Affect Subobjects checkbox turned on—the elements rotate according to the rate set in the Spin behavior parameters, and ignore the replicator’s Angle keyframes. To rotate the entire replicator layer and enable the Angle keyframe animation, turn off Affect Subobjects in the Spin parameters.

Simulation Behaviors and Keyframes

A good rule to keep in mind is that any Simulation behavior, as well as the Throw and Spin behaviors (Basic Motion), applied to a replicator disables all animation that affects the position or rotation or the individual elements.

To return to any keyframed animation that was created before you applied the behavior, simply disable the behaviors. To disable a behavior, turn off its checkbox in the Inspector, Layers tab, or Timeline layers list.
Remember that behaviors often contain parameters that control how layers are affected. These controls greatly affect the result of a behavior when it is applied to a replicator layer. For example, if you apply a Spin behavior to a replicator, all pattern elements rotate individually (rather than the replicator as a whole) when the Affect Subobjects checkbox is turned on. When Affect Subobjects is turned off, the replicator layer rotates (rather than the individual elements).

**Applying Filters to Replicators**
Filters can be applied to a replicator or its sources. When applied to the replicator, filters affect every element of the replicator pattern, as if it were a single layer. When filters are applied to the source layers of a replicator, the effect of the filter is retained once the layer is replicated. Filters cannot, however, be applied to the individual cells of a replicator.

For more information on applying filters to layers in your project, see “Using Filters” on page 841.
Saving Custom Replicators to the Library

Once you have created a replicator that makes you particularly happy, you can save it as a replicator preset in the Replicator or Favorites category of the Library for future use. Once you place a custom replicator in the Library, it can be used just like any other replicator preset.

To save a custom replicator to the Library:

1. Open the Library and select either the Replicators, Favorites, or Favorites Menu category.

2. From the Layers tab or Timeline layers list, drag the replicator you want to save into the stack at the bottom of the Library.

   Note: For organizational purposes, you may find it useful to create a new folder of your own in the Favorites or Favorites Menu category to store your replicators.

When you save a replicator preset, it's saved as a file in the /Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Replicators (or Favorites or Favorites Menu) folder.

You can copy replicator presets you create from this location to give to other Motion users, or you can add replicator presets that are given to you to this same folder.

   Note: Whenever you copy a replicator preset file, you should make sure that you also copy any graphics or movie files that it uses as well.
Filters are an exciting way to spice up any motion graphics project. With the magic of Motion, you can preview and tweak images faster than ever before.

About Filters
The same way different font choices add flavor to text, filters add flavor to images. Fonts can help to determine mood or style. Much the same way, the filters you select can shape the character of your project. A sepia tone color correction on an object can make the viewer think of days gone by. You can use a kaleidoscope filter to transform an object into something completely new. A slit-scan filter can provide a window into another world.

When desktop publishing was first introduced, people tended to fill their publications with numerous fonts on a page, simply because they could. And with Motion’s great performance with filters, you might be tempted to do the same. This is what is called a bad idea. The best way to think about filters is as a condiment for your project—not the entree. A handful of thoughtfully-selected and well-executed filters goes much further than a grab bag of every filter in the Library. Not only does a bunch of filters start to affect performance, but they clutter and confuse the look of your project.

To get the best performance from Motion, use a recommended graphics card. For more information, visit the Motion website at http://www.apple.com/finalcutstudio/motion.
Working with Filters
You add filters to objects in much the same way as behaviors, and you have the same ability to adjust the parameters of the filters over time without having to adjust keyframes.

Filter Types
There are 13 categories of filters in Motion, organized alphabetically in the Library.

An Introduction to Filters
In this section, you’ll learn how to quickly add, modify, and delete filters in a project.

Browsing For and Previewing Filters
All installed filters appear in the Library. Select the Filters category to display the 13 filter subcategories. Select a subcategory to show all filters of that type in the stack.
Once a filter is selected in the stack, a preview and brief description of the filter appears in the Library Preview area.

To browse for a filter:
1. In the Library, click the Filters category.
   A list of subcategories appears on the right side of the library.
2. Click a filter subcategory.
   A list of filters in that subcategory appears in the stack.
3. Click a filter in the stack to select it.
   A preview and short description of the selected filter appear in the Preview area at the top of the Library.

**Applying and Removing Filters**
Each filter affects how a specific object is displayed, and is applied directly to objects in the Canvas, Layers tab, or the Timeline.

**To apply a filter, do one of the following:**
- Drag a filter to an object in the Canvas, Layers tab, or the Timeline.
- Select an object in the Canvas, Layers tab, or Timeline, then select a filter from the Library stack and click Apply in the Preview area.
Select an object in the Canvas, Layers tab, or Timeline, and in the toolbar, select the Add Filter icon, then select a category and a filter to apply.

To remove a filter from an object:
1. Select a filter that's been applied to an object in the Layers tab, Timeline, or Filters tab of the Inspector.
2. Do one of the following:
   - Choose Edit > Delete.
   - Press Delete.

To modify a filter on an object:
1. Select a filter that's been applied to an object in the Layers tab, Timeline, or Filters tab of the Inspector.
2. Adjust parameters in the Inspector or the HUD.

Applying Multiple Filters to an Object
You can apply any number of filters to an object in Motion. When multiple filters are applied to a single object, they all work together to create a final look for the object. Multiple filters appear under the object to which they are applied.

Note: Remember that the more filters you use in a project, the more you impact the performance of Motion.
**Improving Performance with Filters**
When applying filters to several different layers in Motion, it is recommended to apply the filters to the layers’ parent group. Also, when applying filters to very large groups (such as a group containing a growing particle system), it is recommended to turn on the Fixed Resolution parameter in the Group tab of the Inspector. When Fixed Resolution is turned on, layers that are in the group but are outside of the Canvas are cropped to the size of the group defined in the parameter. The Group tab is only available when a group is selected. For more information, “Fixing the Size of a Group” on page 244.

**Note:** When enabled, the Fixed Resolution parameter crops the group to the size specified in the Fixed Width and Fixed Height parameters around the anchor point of the group.

**Where Filters Appear**
After you apply a filter, it appears underneath the object to which it is applied in the Layers tab and the Timeline.
The most recently applied filters appear at the top of the Filters tab of the Inspector.

![Filters tab](image)

When a filter is applied to an object, it is applied with the filter’s default settings. For example, when you apply the Bevel border filter to an object, that object appears with a border with the angle of the light hitting the bevel set to 0 degrees, the width of the bevel set to 0.2, its opacity set to 0.8, and the color of the bevel’s light set to white. See “Bevel” on page 869 for more details.

**Adjusting Filters**

Filters can be tailored to your specific needs by adjusting their parameters. The parameters can be adjusted in a number of different ways, such as using sliders in the HUDs, the controls in the Inspector, the onscreen controls, by adding keyframes, or by applying parameter behaviors.
Using the HUD
Each filter has a subset of parameters that appear in its HUD. All of the controls available for modifying each filter also appear in the Filters tab of the Inspector. Both the HUD and the Filters tab reference the same parameters—changing a parameter in one automatically changes that parameter in the other. Frequently, the controls available in a filter’s HUD represent the parameters with the exception of the position parameters. For example, compare the controls for the Fisheye filter in the Filters tab to those available in the HUD:

Most filter parameters have only a single set of numbers that represent their value. Parameters with a disclosure triangle, however, may have additional numbers that represent a different way of describing the same value. In the case of the Center parameter, the numbers indicated in the value sliders are absolute values, but the X and Y values under the disclosure triangle represent percentages. If the defaults for X and Y are both 0.5, that represents the center of the image. Changing the percentages updates the absolute values in the value sliders.

Adjusting Parameters
Each filter has its own distinct set of parameters. These parameters can be adjusted in one of two places: the Filters tab of the Inspector, or the filter’s HUD. As with all parameters in Motion, the HUD contains the most essential parameter controls for modifying a filter, whereas the Filters tab in the Inspector contains the filter’s entire list of editable parameters.

Note: Often, the parameters in the HUD are equivalent to those in the Inspector.

For more information on accessing the Inspector and HUD controls, see “Inspector” on page 125 and “The Heads-Up Display (HUD)” on page 16.
In most cases, you interact manually with the parameters of a filter. The following image shows the Filters tab in the Inspector for the Hatched Screen filter. The Hatched Screen filter has six controls: Center, Angle, Scale, Skew, Stretch, and Contrast.

![The Hatched Screen filter in the Inspector](image)

Use the dial, slider, the value slider, or value field to set and enter values for each parameter as you see fit.

**Important:** Although the sliders are limited to a predetermined range of values, using either the value slider or the value field may allow you to specify a parameter value outside of the slider’s range. The parameter ranges listed for each filter in this chapter define the slider’s range.

**Using Onscreen Controls**
Some of the filters have onscreen controls that manipulate certain filter parameters, especially position. As you use these controls, the associated parameters will update in the Inspector.

**Keyframing Filter Parameters**
Animating filter parameters is easy. The following section shows two ways to change a filter parameter over time using keyframes.

**To animate filter parameters using Record:**
1. Select the filter you want to animate.
2. Click the Record button (or press A) to enable recording.
3. Go to the frame where you want to add a keyframe.
4. Change the value of the parameter to the desired value. A keyframe is automatically added with the value you select.
5. Go to the next frame where you want a keyframe.
6. Repeat steps 3 and 4 until you are finished.
To animate filter parameters using the Animation menu:
1. Select the filter you want to animate.
2. Go to the frame where you want to add a keyframe.
3. In the Inspector, click the Animation menu for the parameter you want to animate, then choose Add Keyframe from the menu.
4. Change the value of the parameter to the desired value.
5. Go to the next frame where you want a keyframe.
6. Repeat steps 3 and 4 until you are finished.
   
   **Note:** Remember to add a keyframe before adjusting a parameter value.

For more detail on using keyframes and the animation menu, see “Animation Menu” on page 517.

**Applying Behaviors to Filter Parameters**

Animating filter parameters is easy using Parameter behaviors. For example, if you have an object with an applied Circle Blur filter, you can randomize the amount of blur applied to the object over time.

**To randomize the blur applied to an object:**
1. Select the object with the applied blur filter.
2. In the Inspector, open the Filters tab.
3. Select the Amount parameter.
4 Control-click Amount, then choose Randomize from the shortcut menu.

The Behaviors icon appears in the Animation menu, and the Behaviors tab opens in the Inspector.

Adjusting the Amount parameter in Randomize changes the amount of variance between the random values. A small number causes small variations in the random values, and a larger number means larger variations in the values. For more detailed information about the Randomize behavior, see “Randomize” on page 447.

For more detailed information about all of the Parameter behaviors, see “Parameter Behaviors” on page 430.

**Working with Filters**

This section presents more detailed information about working with filters.

For information about adding filters to and removing filters from objects in Motion, see “An Introduction to Filters” on page 842.

When you apply a filter to an object in your project, it appears in three different places—the Layers tab, the Timeline, and the Filters tab of the Inspector.
Enabling, Renaming, and Locking Filters
While the Filters tab in the Inspector contains all of the editable parameters for any filter that has been applied to an object, the Layers tab and Timeline have three primary controls for each filter that appears.

The following filter controls appear in the Layers tab and Timeline:

**Activation checkbox:** Turns each individual filter on or off. Filters that are turned off are not rendered.

**Name:** The name of each filter can be customized by double-clicking the name and typing a new one.

**Lock:** Click the lock icon to toggle the locked state on and off for the filter.

Copying, Pasting, and Moving Filters
Filters can be easily copied, pasted, and moved like any other object in Motion. There are a number of ways you can move and copy filters among the other objects in the Timeline or Project pane. They can be pasted over other filters, and moved across projects. When you cut or copy a filter in the Timeline or Project pane, you also copy the current state of all that filter’s parameters.

**To cut or copy a filter:**
1 Select the filter in the Layers tab or Timeline.
2 Do one of the following:
   • To remove a filter, choose Edit > Cut (or press Command-X).
   • To copy the filter, choose Edit > Copy (or press Command-C).

**To paste a filter:**
1 Select the object to which you want to apply the filter.
2 Choose Edit > Paste (or press Command-V).

The filter is applied with all its parameter settings intact.
**Note:** Pasting a filter does not paste it at the current playhead location. To quickly move the filter to the playhead location, press the Shift key while you drag the pasted object. As you approach the current playhead location, it snaps into place.

**Moving Filters**
You can move filters from one object to another.

**To move a filter:**
- Drag the filter from its current location to the new object to which you want to apply the filter.

**Duplicating Filters**
You can also duplicate a filter and apply the duplicate to another object.
To duplicate a filter:
- Option-drag the filter from its current location to the new object to which you want to apply the filter.

![Image](image.png)

The pointer changes to indicate copying the filter.

Note: You can also choose Edit > Duplicate (or press Command-D) to duplicate the filter.

Reordering Filters
When multiple filters are applied to a single object, they appear beneath that object in the Timeline or Project pane. You can change the order in which they are applied to the object, to change how they interact.

Some filters yield better results depending on the order in which they are applied. For instance, you wouldn't want to apply a color correction after a blur. To get the most accurate color correction, you want to apply it to the source object, not a modified version of the source. The same is true for extracting keys, and just about anything that depends on color information.

To reorder a filter:
1. Select the filter you want to reorder.
2. Click the name of the filter or the icon to the left of the name, then drag it up or down in the Layers list.
   - A position indicator shows the new position for the filter when you release the mouse button.
3 Release the mouse button when the position indicator is in the new location.

Changing Filter Timing
Filters appear as a bar in the Timeline and like other duration bars, can be trimmed or moved in time.

Changing a Filter's Duration
When you apply a filter to an object, the duration of the filter defaults to the length of the object to which it is applied. This can be seen in the Timeline.

Once applied, a filter’s duration can be modified to affect the object over a different amount of time than the object’s duration. For example, applying the Soft Focus filter to an object results in that object being blurred for the entire object’s duration in the Timeline. Changing In and Out points of the Soft Focus filter, however, changes when the blur is applied to the object.

To trim a filter in the Timeline:
1 Position the pointer on the In or Out point (the left or right edge) of the filter you want to trim.
2  When the pointer changes to the trim pointer, drag the In or Out point to change the duration of the filter.

As you drag, the new In or Out points are displayed. Also displayed is the delta value, which represents the amount of change for the duration.

**Slipping Filters in Time**

In addition to changing a filter’s duration, you can also slip its position in the Timeline relative to the layer it’s nested under. This allows you to set the frame at which a filter begins to take effect.

**To slip a filter in the Timeline:**

- Click anywhere in the middle of a filter in the Timeline, and drag it to the left or right to move its In point to another frame.

The filter is moved and its duration is not affected. While you drag, the new In and Out points are indicated, along with the amount of change (the delta).

**About Rasterization**

The application of some filters can cause a group to be rasterized. When a group is rasterized, it is converted into a bitmap image. In 2D groups, the application of any filter causes rasterization. In 3D groups, the application of certain filters causes rasterization.
Rasterization affects 2D and 3D groups in different ways. When a 2D group is rasterized, the blend modes on objects *within* the group no longer interact with objects *outside* of the group. In addition, when a 3D group is rasterized, the group as a whole can no longer intersect with objects outside of the group. The rasterized 3D group is treated as a single object and uses layer order, rather than depth order when composited in the project.

For more information on rasterization and 3D groups, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.

**Note:** When a group is rasterized, cameras and lights in the project still interact with objects within the rasterized group.

Once an operation triggers a rasterization on a group, the following occurs:

- A rasterization indicator (resembling an LED) appears next to the parameter in the Properties tab.
- A small outline appears around the 2D or 3D group icon (to the left of the group name) in the Layers tab and Timeline layers list.

The following filters force rasterization of 3D groups:

**Blur**
- Circle Blur
- Compound Blur
- Gradient Blur
- Movement Blur
- Radial Blur
- Variable Blur
- Zoom Blur

**Border (All)**

**Color Correction**
- Colorize
- Equalize
- Negative
- Saturate
- Tint

**Distortion (All)**

**Glow**
- Light Rays
Matte
- Matte Magic

Sharpen
- Unsharp Mask

Stylize
- Bad TV
- Circle Screen
- Circles
- Crystallize
- Edge Work
- Edges
- Extrude
- Halftone
- Hatched Screen
- Highpass
- Indent
- Lens Flare
- Line Art
- Line Screen
- MinMax
- Pixellate
- Relief
- Slit Scan
- Slit Tunnel
- Texture Screen
- Vignette
- Wavy Screen

Tiling (All)

Time (All)

Video
- Deinterlace

Blur Filters
Blur filters take many forms in Motion. They can be used practically to simulate the real-world blurring that occurs due to the depth of field in photographed material, or they can be used creatively to make all sorts of designed effects. Motion provides a wide variety of blur filters you can use for any task.
**Channel Blur**

Gives you control over blurring each color channel of an object. The Channel blur can be applied selectively to each of the different color channels of the object: red, green, blue, and alpha.

Blurring individual channels allows you to create customized glow effects by retaining sharpness in selected channels while softening others.

![Original image](image1) ![Amount = 15, Blur Red On](image2)

**Parameters in the Inspector**

- **Amount**: Sets the radius of the object blur. Values range from 0 (no blur) to 32.
- **Blur Red**: Sets the blur to affect the red channel. Can be turned On or Off.
- **Blur Green**: Sets the blur to affect the green channel. On or Off.
- **Blur Blue**: Sets the blur to affect the blue channel. On or Off.
- **Blur Alpha**: Sets the blur to affect the alpha channel. On or Off.
- **Horizontal**: Sets the percentage of maximum horizontal blur. This is a percentage of the Amount parameter.
- **Vertical**: Sets the percentage of maximum vertical blur.
- **Crop**: Toggles whether or not the image is cropped beyond its original borders.
- **Mix**: Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

**HUD Controls**

The HUD contains the Amount, Blur Red, Blur Green, Blur Blue, and Blur Alpha controls.
**Circle Blur**

Creates a circular blur within an image, specified by a center point which sets the center of the blur effect, and a radius which sets the size of the affected region. The amount of blur within the affected area can also be customized.

This filter is useful for quickly blurring a limited area within an image. For more sophisticated control of the image region to be blurred, try the Compound Blur filter.

This filter causes rasterization in 3D groups.

![Original image of a crab](image1.png) ![Center of circle on the right side of crab](image2.png)

**Parameters in the Inspector**

- **Center**: Sets the position of the center of the blur effect.
- **Amount**: Sets the amount of the blur. Values range from 0 to 100.
- **Radius**: Sets the radius of the circle defining the blurred area. Values range from 0 to 1000.
- **Crop**: Toggles whether or not the image is cropped beyond its original borders.

**HUD Controls**

The HUD contains the Amount, Radius, and Crop controls.

**Compound Blur**

Blurs an object using the specified channel of a blur map image. You can use any shape, still image, or movie file as the blur map image. You can select any or all of the red, green, blue, alpha, or luminance channels to create the overall shape of the blur.

One of the fastest ways to use this filter is to create a shape object, and trace the subject of the image you want to blur. Then, assign this shape as the Blur Map image, using either its Luminance or Alpha as the map channel to define the blurred area, and turn off the original shape object in the Layers tab or Timeline to reveal the new blur effect.
When this filter is initially applied, Compound Blur behaves as if there was a black image applied to the Blur Map well, which will not blur any part of the target.

This filter causes rasterization in 3D groups.

To add an image to the Blur Map image well:
1. Use the File Browser to find the object you would like to use as a blur map.
2. In the Project pane, click the Media tab.
3. Drag the desired object from the File Browser into the Media tab.
4. In the Filters tab of the Inspector, select the Compound Blur filter.
5. Drag the desired object from the Media tab into the Blur Map image well of the filter.

Parameters in the Inspector

Amount: Sets the radius of the blur. Values range from 0 (no blur) to 32.

Blur Map: An image well that displays a thumbnail of the map chosen.

Map Channel: Selects the channel to be blurred. The blur is applied to the red, green, blue, alpha, or luminance channel.

Invert Map: Sets whether or not the blur map is inverted.

Stretch Map: Sets whether or not the map is stretched.

Horizontal: Sets the percentage of maximum horizontal blur.

Vertical: Sets the percentage of maximum vertical blur.

Mix: Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

HUD Controls
The HUD contains the Amount, Blur Map, and Map Channel controls.

Defocus
A more accurate model of the out-of-focus effect that occurs through a real-world camera lens. The Defocus filter blurs an image while creating a controlled glow effect in brighter areas of the image. The resulting object has a lens aperture-shaped structure around the highlights. The shape of the blurred glow around the affected highlights can be customized.
Use this filter when you are trying to blur one image to match video or stills that were shot with a camera. For example, if you have keyed a woman standing in front of a bluescreen, and you intend to place a background image behind her to make it look like she's standing in a valley with mountains in the background, use the Defocus filter instead of a Gaussian Blur to create a realistic depth-of-field effect for the mountains in the distance.

![Original image Defocus applied](image)

**Parameters in the Inspector**

**Amount:** Sets the radius of the defocus. Values range from 0 (in focus) to 16.

**Gain:** Sets the amount of gain applied to the high luminance areas. Values range from 0.05 to 4.

**Shape:** Sets the shape of the lens aperture. Circle or Polygon.

**Sides:** Sets the number of sides of the lens aperture, if Circle is set to Off. Values range from 3 to 12.

**Rotation:** Sets the angle of rotation of the polygonal lens aperture, if Shape is set to Polygon.

**Aspect Ratio:** Sets the aspect ratio of the lens aperture. Values range from 0 to 2.

**Crop:** Toggles whether or not the blur will be cropped at the object's original border.

**Mix:** Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Crop checkbox.

**Directional Blur**
Blurs an object out along a specific angle. This filter creates a blurred streaking effect.
Note: Remember that the more filters you use in a project, the more you impact the performance of Motion.

Blur Filters Without the Mix Parameter
Some blur filters don't have the Mix parameter. You can duplicate the effects of the Mix parameter by copying the original layer in the Layers tab, then changing the filtered image's Opacity to combine the original image with the blurred image. This effect is especially interesting when used with a directional blur, as it creates a different sort of effect than the filters in the Glow category. A similar effect, though without the directional control, can be achieved using the Soft Focus filter, described on page 867.

Parameters in the Inspector

Amount: Sets the radius of the blur. Values range from 0 (no blur) to 32.

Angle: Sets the angle of the direction of movement.

Crop: Toggles whether or not the blur is cropped at the object’s original boundaries.

Mix: Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the Crop checkbox.

Gaussian Blur
The Gaussian blur is the softest blur effect you can apply, and is one of the most frequently used blur effects. By default, it affects the entire image uniformly, although you can control the amount of horizontal and vertical blur independently.
Gaussian blur is entirely appropriate for most motion graphics tasks, and can be animated for a variety of focus-control effects. However, to more accurately simulate camera focus, the Defocus filter may be more appropriate. For more information on the Defocus filter, see “Defocus” on page 860.

Parameters in the Inspector

**Amount**: Sets the radius of the blur. Values range from 0 (no blur) to 64.

**Horizontal**: Sets the percentage of the Amount applied in the horizontal direction.

**Vertical**: Sets the percentage of the Amount applied in the vertical direction.

**Crop**: Sets whether or not the object is cropped at its original boundaries.

**Mix**: Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Crop toggle.

**Gradient Blur**
The Gradient Blur filter allows you to control the blurred region of an image by creating a graduated blur between two points. Point one is the beginning of the blur, and the point at which the image is at its sharpest. Point two is the end of the blur, and the point at which the image is at its blurriest, depending on the value set in the Amount parameter.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

Point 1: Sets the position of the first point of the gradient.

Point 2: Sets the position of the second point of the gradient.

Amount: Sets the radius of the blur.

Crop: Sets whether or not the object is cropped at its original boundaries.

HUD Controls

The HUD contains the Amount and Crop controls.

Movement Blur

Analyzes movement in a clip using optical flow methods, blurs the movement, and mixes the result with the original image.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

Amount: Sets the radius of the blur. Values range from 0 to 10.

Sensitivity: Sets the sensitivity of blur detection. The higher the value, the lower the threshold of movement required to result in motion blur. Values range from 0 to 1.

Quality: Sets the quality of the blur calculations. A higher values increases the quality of the resulting blur. Values range from 1 to 10.

Smoothness: Sets the smoothness of the blur. Values range from 0 to 10.
**Display**: Sets how the Movement Blur is displayed. Values are “Motion Blur” and “Optical Flow.” Motion Blur shows the blurred image. Optical Flow shows reference points for how the movement of the image was analyzed to determine the application of blur.

**Grid Size**: Sets the size of each panel in the grid overlay used for optical flow analysis. Values range from 1 to 64.

**Grid Scale**: Sets the scale of the entire grid used for optical flow analysis. Values range from 0 to 1000.

**Mix**: Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Amount, Sensitivity, Quality, Smoothness, and Display controls.

**Prism**
Blurs and refracts the image as if seen through a prism, creating a rainbow effect.

![Original image](image1.png) ![Prism applied](image2.png)

**Parameters in the Inspector**

**Amount**: Sets the radius of the blur. Values range from 0 to 32.

**Angle**: Sets the angle of refraction. Values range from 0 to 360 degrees.

**Crop**: Sets whether or not the object is cropped at its original boundaries.

**Mix**: Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Amount and Angle controls.
Radial Blur
This filter creates a rotational blur centered on a point. The effect is similar to the motion blur you would see if an image were spinning quickly.

Parameters in the Inspector

**Center:** Sets the position of the center of the radial blur.

**Angle:** Sets the angle of rotation of the blur.

**Subsampling:** Sets the number of samples.

**Crop:** Sets whether or not the object is cropped at its original boundaries.

HUD Controls
The HUD contains the Angle, Subsampling, and Crop controls.
**Soft Focus**

This filter creates an effect that's similar to duplicating an object, using the Screen blend mode to composite it against itself, and then blurring one of the overlapping objects. The advantage of this filter is that you can do this all within a single filter. The Strength parameter controls how much of the blurred image is added back to the original image, while other sliders let you control the overall, horizontal, and vertical amount of blur.

![Original image](image1) ![Soft Focus filter applied](image2)

**Parameters in the Inspector**

**Amount:** Sets the radius of the blur. Values range from 0 (no blur) to 32.

**Strength:** Sets the amount of opacity of the blurred composite. Values range from 0 to 1.

**Horizontal:** Sets the percentage of the maximum horizontal blur.

**Vertical:** Sets the percentage of the maximum vertical blur.

**Crop:** Sets whether or not the object is cropped at its original boundaries.

**Mix:** Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

**HUD Controls**

The HUD contains the Amount and Strength controls.

**Variable Blur**

A blur which can either include or exclude a circular region, to create a sort of tunnel focus effect. If the inner radius of the circle is larger than the outer radius of the circle, the blur is applied outside of the circle. Otherwise, the blur is applied to the area within the circle.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

Center: Sets the position of the center of the circle.

Amount: Sets the percentage of the blur.

Inner Radius: Sets the inner radius of the circle.

Outer Radius: Sets the outer radius of the circle.

Crop: Sets whether or not the object is cropped at its original boundaries.

HUD Controls
The HUD contains the Amount, Inner Radius, Outer Radius, and Crop controls.

Zoom Blur
This filter creates a blur that simulates a fast camera zoom in to a point. This filter causes rasterization in 3D groups.
Parameters in the Inspector

**Amount:** Sets the radius of the blur, ranging from 0 (no blur) to 32.

**Center:** Sets the position of the center of the blur.

**Crop:** Toggles whether the object is cropped at its original boundaries.

**Mix:** Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Amount control.

**Border Filters**
Border filters allow you to frame objects in a composition in various ways.

**Bevel**
Creates a bevelled border around the edges of an object by superimposing an angled frame over the original image. The simulated direction of reflected light and opacity of the bevel can be adjusted to vary the effect.

This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Bevel applied](image2.png)

Parameters in the Inspector

**Light Angle:** Sets the angle at which the light is hitting the bevel.

**Bevel Width:** Sets the width of the bevel as a percentage of the area of the object.

**Opacity:** Sets the opacity of the bevel, ranging from 0 (invisible) to 1.0 (opaque).

**Light Color:** Picks the color of the light hitting the bevel border. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders to more precisely select colors.
**Mix:** Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

**Simple Border**
Creates a solid color border of variable width around the edges of an object. This filter causes rasterization in 3D groups.

**Parameters in the Inspector**

**Size:** Sets the thickness of the border. Values can range from 0 (no border) to 100 pixels.

**Color:** Picks the color of the border. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders to more precisely select the color of the border.

**Mix:** Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Size and Color controls.

**Widescreen**
This filter “letterboxes” an object by masking the object at its top and bottom to simulate a variety of video and film aspect ratios. Because this filter is masking the image, what appears behind the object is either the background color of the project or the object that is beneath the masked object in the composite. You can also add an additional border to the masked image and customize the color and size of the border.

This filter causes rasterization in 3D groups.
Note: Because the Widescreen filter is masking the object to which it is applied, the object is not cropped and retains its original shape.

Parameters in the Inspector

Aspect Ratio: Sets the aspect ratio of the mask. Values can be selected from the following: 1.66:1, 1.70:1, 1.78:1, 1.85:1, 2.35:1, 2.55:1, and 3.00:1.

Offset: Sets the position of the mask relative to the Y center of the object. Values range from –1.0 (the bottom of the object) to 0 (the center of the object) to 1.0 (the top of the object).

Border Size: Sets the thickness of the border. Values range from 0 (no border) to 10.

Note: The border has no effect on the aspect ratio mask, but merely adds an additional frame within the edge of the image created by the mask.

Border Color: Picks the color of the border. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders to more precisely select the color of the border.

Mix: Sets what percentage of the original image is blended with the blurred image. Values range from 0 to 100%.

HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

Color Correction Filters
Color correction filters can be used in a number of ways. You can change a mood by making an object sepia colored, or to make your object stand out by oversaturating it. In addition, they can be used to fix a problem with contrast, color, gamma, or brightness.
**Brightness**
Boosts or lowers the uniform brightness of an image by the specified amount.

Although this may seem to be the first filter to use if you want to correct for improper exposure in an image, the drawback of this filter is that it boosts or lowers everything in an image at once. This means that raising the brightness in an image raises it everywhere, including in the shadows. The result is that a brightened image may look washed out.

On the other hand, this filter can come in very handy as a way to modify the edges and effects of shapes, masks, particle systems, and generators.

A better filter for exposure correction is the Gamma filter. For more information, see “Gamma” on page 881.

![Original image](image1.jpg)  ![Brightness Filter applied](image2.jpg)

**Parameters in the Inspector**

**Brightness**: Sets the multiplying brightness value applied to the object. Values range from 0 (no brightness, black image) to 10.

**Mix**: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Brightness control.

**Channel Mixer**
Allows cross-mixing of red, green, blue, and alpha channels into one another. The Channel Mixer filter’s main parameters are divided into four sections, each of which manipulates an individual channel. In each section, you can adjust the value of the relevant color channel added to or subtracted from the red, green, blue, and alpha channels. This is a more flexible version of the Channel Swap filter below.
Parameters in the Inspector

**Red – Red:** Sets the amount of input red added to the output red. The default value is 1.0, which leaves the red channel unmodified. As this value increases, the output value of red increases by the amount of input red multiplied by the value of Red – Red. Values range from –2 to 2.

**Red – Green:** Sets the amount of input green added to the output red. The default value is 0, which leaves the red channel unmodified. As this value increases, the output value of red increases by the amount of input green multiplied by the value of Red – Green. Values range from –2 to 2.

**Red – Blue:** Sets the amount of input blue added to the output red. The default value is 0, which leaves the red channel unmodified. As this value increases, the output value of red increases by the amount of input green multiplied by the value of Red – Blue. Values range from –2 to 2.

**Red – Alpha:** Sets the amount of input alpha added to the red channel. The default value is 0, which leaves the red channel unmodified. As this value increases, the value of red increases by the amount of input alpha multiplied by the value of Red – Alpha. Values range from –2 to 2.

**Green – Red:** Sets the amount of input red added to the output green. The default value is 0, which leaves the green channel unmodified. As this value increases, the output value of green increases by the amount of input red multiplied by the value of Green – Red. Values range from –2 to 2.

**Green – Green:** Sets the amount of input green added to the output green. The default value is 1.0, which leaves the green channel unmodified. As this value increases, the output value of green increases by the amount of input green multiplied by the value of Green – Green. Values range from –2 to 2.

**Green – Blue:** Sets the amount of input blue added to the output green. The default value is 0, which leaves the green channel unmodified. As this value increases, the output value of green increases by the amount of input blue multiplied by the value of Green – Blue. Values range from –2 to 2.

**Green – Alpha:** Sets the amount of input alpha added to the green channel. The default value is 0, which leaves the green channel unmodified. As this value increases, the value of green increases by the amount of input alpha multiplied by the value of Green – Alpha. Values range from –2 to 2.

**Blue – Red:** Sets the amount of input red added to the output blue. The default value is 0, which leaves the blue channel unmodified. As this value increases, the output value of blue increases by the amount of input red multiplied by the value of Blue – Red. Values range from –2 to 2.
**Blue – Green:** Sets the amount of input green added to the output blue. The default value is 0, which leaves the blue channel unmodified. As this value increases, the output value of blue increases by the amount of input green multiplied by the value of Blue – Green. Values range from –2 to 2.

**Blue – Blue:** Sets the amount of input blue added to the output blue. The default value is 1.0, which leaves the blue channel unmodified. As this value increases, the output value of blue increases by the amount of input blue multiplied by the value of Blue – Blue. Values range from –2 to 2.

**Blue – Alpha:** Sets the amount of input alpha added to the blue channel. The default value is 0, which leaves the blue channel unmodified. As this value increases, the value of blue increases by the amount of input alpha multiplied by the value of Blue – Alpha. Values range from –2 to 2.

**Alpha – Red:** Sets the amount of input red added to the output alpha. The default value is 0, which leaves the alpha channel unmodified. As this value increases, the output value of pixels with non-transparent alpha increases by the amount of input red multiplied by the value of Alpha – Red. Values range from –2 to 2.

**Alpha – Green:** Sets the amount of input green added to the output alpha. The default value is 0, which leaves the alpha channel unmodified. As this value increases, the output value of pixels with non-transparent alpha increases by the amount of input green multiplied by the value of Alpha – Green. Values range from –2 to 2.

**Alpha – Blue:** Sets the amount of input blue added to the output alpha. The default value is 0, which leaves the alpha channel unmodified. As this value increases, the output value of pixels with non-transparent alpha increases by the amount of input blue multiplied by the value of Alpha – Blue. Values range from –2 to 2.

**Alpha – Alpha:** Sets the amount of input alpha added to the output alpha channel. The default value is 1.0, which leaves the alpha channel unmodified. As this value increases, more alpha is added to the pixels in the alpha channel. Values above 1 have no effect, unless the alpha has been eroded by negative values in the other alpha parameters. Values range from –2 to 2.

**Monochrome:** Sets the filter to monochrome mode. In monochrome mode, all three color channels are affected by the Red controls.

**Allow Mono > 1:** Allows monochromatic color channels to be set to values greater than one. On is the default value of this parameter. Color values are normally between 0 and 1, but can go over 1 or below 0 if your project’s bit depth is set to 16 bits or 32 bits per channel. If this value is set to Off, each of the Red color output controls are linked. Moving any one of them causes the others to automatically adjust to keep the total value at 1.0. The filter must be in monochrome mode for this parameter to be active.
**Include Alpha:** Sets whether or not to include the alpha channel in the mono calculation. The filter must be in monochrome mode for this parameter to be active.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

**Channel Swap**
Substitutes the color value of a color channel with that of either a selected channel, or its inverse. If you select Blue from Red, the value of blue in the object will match the value of red across the entire object. The Channel Swap filter can be used in a variety of ways, including simply inverting the alpha channel of an object.

**Parameters in the Inspector**

**Red from:** The numerical value of red is replaced by the numerical value of color of the selected channel. Values can be selected from Red (unchanged), Green, Blue, Alpha, Inverse Red, Inverse Green, Inverse Blue, and Inverse Alpha.

**Green from:** Sets the value of green to the value of the selected channel. Values can be selected from Red, Green (unchanged), Blue, Alpha, Inverse Red, Inverse Green, Inverse Blue, and Inverse Alpha.

**Blue from:** Sets the value of blue to the value of the selected channel. Values can be selected from Red, Green, Blue (unchanged), Alpha, Inverse Red, Inverse Green, Inverse Blue, and Inverse Alpha.

**Alpha from:** Sets the value of the alpha to the value of the selected channel. Values can be selected from Red, Green, Blue, Alpha (unchanged), Inverse Red, Inverse Green, Inverse Blue, and Inverse Alpha.
**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the mix control.

**Color Balance**
Color balance generally refers to the overall tint of an image reflecting the color temperature of the primary source of light. For example, sunlight is generally bluer than interior tungsten light, which tends to be more orange. Although most film and video is shot to make sure that the whites in an image are a true neutral white, different film stocks and video color balance settings result in slight tints in the image.

Use this filter to adjust the color balance of an object by boosting or lowering the individual amount of reds, greens, and blues in the shadows, midtones, and highlights of an image. You can use this filter to correct for improper color balance, or to change the color balance in an image for a stylized effect.

![Original image](image1) ![Midtone Blue = 0.20, High Blue = -0.5](image2)

**Parameters in the Inspector**

**Shadow Red:** Picks the color gain applied to the shadow range of the red color channel. Values range from −1.0 (no color) to 0 (unaltered color) to 1.0 (maximum color).

**Shadow Green:** Picks the color gain applied to the shadow range of the green color channel.

**Shadow Blue:** Picks the color gain applied to the shadow range of the blue color channel.

**Midtone Red:** Picks the color gain applied to the midtone range of the red color channel.
**Midtone Green:** Picks the color gain applied to the midtone range of the green color channel.

**Midtone Blue:** Picks the color gain applied to the midtone range of the blue color channel.

**Highlight Red:** Picks the color gain applied to the highlights of the red color channel.

**Highlight Green:** Picks the color gain applied to the highlights of the green color channel.

**Highlight Blue:** Picks the color gain applied to the highlights of the blue color channel.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the mix control.

**Color Reduce**
Reduces the full range of color in an image down to two, three, or four colors that you select. Depending on the number of substitute colors you choose in the Reduce To parameter, this filter breaks down the full range of colors in the image into a color range for each Match Color parameter that's available. It then substitutes the selected Replace With color for each interpreted range of color.

If two colors are selected, all color information in the object is reduced to the selected two colors; if three, they are reduced to three; and so on.

![Original image](image1.png) ![Color Reduce defaults applied](image2.png)

**Parameters in the Inspector**

**Smoothness:** Sets the smoothness of the transitions between the reduced areas. Values range from 0 (hard edges) to 1 (smooth blending).
Reduce To: Selects the number of colors in the reduced object. Choices are 4 Colors, 3 Colors, or 2 Colors.

Match Color 1: Picks the color of the first selection color for reduction. The color picker can be expanded with the disclosure triangle to reveal Red, Green, Blue, and Alpha sliders for more precise color selection.

Replace With: Picks the color that is substituted for the selection determined by Color 1.

Match Color 2: Picks the color of the second selection color for reduction.

Replace With: Picks the color that is substituted for the selection determined by Color 2.

Match Color 3: Picks the color of the third selection color for reduction. This parameter is used only if Reduce To is set to 3 Colors or 4 Colors.

Replace With: Picks the color that is substituted for the selection determined by Color 3. This parameter is used only if Reduce To is set to 3 Colors or 4 Colors.

Match Color 4: Picks the color of the fourth selection color for reduction. This parameter is used only if Reduce To is set to 4 Colors.

Replace With: Picks the color that is substituted for the selection determined by Color 4. This parameter is used only if Reduce To is set to 4 Colors.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the mix control.

Colorize
Substitutes the blacks and whites in an image with different colors you select. All other colors in the image are remapped to a duochrome range that falls between these two colors.
Interesting colorized “negative” effects can be achieved by remapping the blacks in an image to a lighter color than the whites.

Parameters in the Inspector

**Remap Black To:** Sets the color that is mapped to black.

**Remap White To:** Sets the color that is mapped to white. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders to more precisely select the color.

**Intensity:** Sets the strength of the colorization. Values range from 0 (no colorization) to 1.00.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector.

**Contrast**
Adjusts the contrast of an object.
Parameters in the Inspector

**Contrast:** Sets the amount of contrast to be applied to the object. Values range from 0 (no contrast) to 1 (default contrast) to 2.00 (high contrast).

**Pivot:** Sets the point around which the contrast is adjusted. The point of contrast adjustment is the level which is displayed if Contrast is set to 0. Values range from 0 to 1.00.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls

The HUD contains the same controls as the Inspector, with the exception of the Mix control.

**Desaturate**

Reduces the amount of color in an image by a specified amount. This filter can be used to mute the color in an image, making brighter colors less saturated. It can also be used to completely eliminate the color from an image, turning a color image to a grayscale one.

![Original image](image1) ![Desaturated image](image2)

Parameters in the Inspector

**Desaturation:** Sets the amount of desaturation. Values range from 0 (no change) to 1.00 (full desaturation).

**Luminance:** Sets how the luminance type is calculated. Values can be selected from the following: NTSC, PAL, Film, Red, Green, and Blue. If NTSC, PAL, or Film is selected, luminance is calculated based on weighting for those standards; if a channel is selected, luminance is calculated using that channel.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.
HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the mix control.

Equalize
Remaps the black and white points in an image, resulting in individual adjustments to the contrast in the dark and light parts of an image. The Equalize filter can be used to adjust the overall contrast range of an image, crushing the whites and blacks, or it can be used to create selective washed out or darkened effects.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

Black Point: Sets the relative color value used for black. Values range from 0 to 1.0.

White Point: Sets the relative color value used for white. Values range from 0 to 1.0.

HUD Controls
The HUD contains the same controls as the Inspector.

Gamma
The Gamma filter adjusts the relative distribution of brightness within the midtones of an image, while leaving the white and black points alone. The perceived result is to brighten and darken the areas of medium brightness within an image, while leaving the highlights and shadows alone. This avoids a washed-out result.
This is one of the most useful filters for correcting poor exposure in images, and should almost always be used first before trying the Brightness filter.

**Parameters in the Inspector**

**Gamma:** Sets the gamma correction. Values range from 0 to 5.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Gamma control.

**Gradient Colorize**
Uses each pixel's color value to determine the application of a color value from a gradient.

**Parameters in the Inspector**

**Gradient:** Selects a gradient preset to be applied to the object, or is used to edit a custom gradient.
Offset: Sets an amount, in degrees, that the color wheel is offset to determine color application. Values start at 0 degrees.

Repeats: Sets the number of times the gradient repeats over the course of its range. Values range from 1 to 32.

Repeat Method: Sets the method by which the gradient is mapped when repeating. Values can be set to either Mirror (default) or Wrap. This parameter only affects the filter when Repeats is set to a number greater than 1.

Map Channel: Sets the channel used to determine how the image is colorized. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the Gradient Editor and the Mix control.

HSV Adjust
An alternate method of performing color correction based on the HSV color model. HSV is often used in color picking interfaces, and is employed by the default color wheel method of the Apple Color Picker.

This filter provides controls to adjust the Hue, Saturation, and Value levels in an image, independently. The Hue control is an angular representation of the color values in an image. By rotating the Hue angle, you uniformly remap the colors throughout an image, similar to the effect of turning the hue or phase knob of a broadcast monitor.
The saturation controls the intensity of the color in an image, with a high saturation resulting in vivid color, and a low saturation resulting in a grayscale image with no color at all. The Value slider, on the other hand, adjusts the overall brightness or darkness of all colors in an image, including the blacks and whites in a desaturated image.

Parameters in the Inspector

Hue: Sets the angle of adjustment used to set the zero point of the color wheel.

Saturation: Sets the color saturation of the object, ranging from –1.0 (no color information) to 0.0 (unadjusted color) to 3.0.

Value: Sets the intensity adjustment applied to the object, ranging from 0.0 to 2.0.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls

The HUD contains the same controls as the Inspector, with the exception of the mix control.
**Invert**

Inverts all color and brightness in an image. This filter can be used to turn a scanned negative image into a properly displayed positive.

![Original image](image1.png) ![Image inverted](image2.png)

**Parameters in the Inspector**

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**

The HUD contains the mix control.

**Levels**

This filter provides controls to remap the white and black points of an image, along with a Gamma control to adjust the midtones, all at once. A histogram provides an analysis of the image that you can use to help you judge the adjustments you want to make.

A powerful option within this filter is the ability to make independent adjustments to the red, green, blue, and alpha channels of an object.

**Parameters in the Inspector**

**Histogram:** An analysis of the object. By default, the RGB channels are selected. A pop-up menu can be used to select red, green, blue, or alpha channels individually for viewing.

For each channel parameter (RGB, Red, Green, Blue, Alpha, and Gamma):

**Black In:** Sets the In point for black, below which values are considered black. The parameter ranges from 0 to 1.

**Black Out:** Sets the minimum brightness value that appears in the output. Other values are scaled between Black Out and White Out values.
**White In:** Sets the In point for white, above which values will not be output.

**White Out:** Sets the maximum brightness value that appears in the output. Other values are scaled between Black Out and White Out values.

**Gamma:** Sets the amount of gamma correction. This parameter ranges from 0 to 5.00.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
There are no controls for this filter in the HUD.

**Negative**
Simulates the effect of turning an image into a film negative. This filter causes rasterization in 3D groups.

![Original image](image1.jpg) ![Negative applied](image2.jpg)

There are no parameters for this filter.

**HUD Controls**
There are no controls for this filter in the HUD.

**Reduce Banding**
Reduces the amount of banding in the image.

**Parameters in the Inspector**

**Noisiness:** Sets the amount of noise to introduce into the object, ranging from -0.0 (no noise) to 100.0 (maximum noise).

**Movement:** Sets whether or not to animate the noise in the image.

**Mix:** Sets the amount of the original image to mix with the filtered image.

**HUD Controls**
The HUD contains the Noisiness control.
**Saturate**

Increases or decreases the amount of color in an image by a specified amount. This filter can be used to mute the color in an image, making brighter colors less saturated. It can also be used to completely eliminate the color from an image, turning a color image to a grayscale one.

This filter causes rasterization in 3D groups.

**Parameters in the Inspector**

**Saturation:** Sets the color saturation of the object, ranging from –1.0 (no color information) to 0.0 (unadjusted color) to 3.0.

**HUD Controls**

The HUD contains the Saturation control.

**Sepia**

Tints an object with a sepia tone. The black and white points are remapped to dark and light sepia colors. The amount of tinting can be adjusted, to achieve either a subtle mix of the original and tinted colors, or a completely tinted image.
This filter is good for that “old-time western” look.

Parameters in the Inspector

**Amount:** Sets the amount of sepia tone applied to the object. Values range from 0 (no sepia tone) to 1.00 (100 percent sepia).

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the intensity control.

**Threshold**
Reduces all colors in an image to a duotone, with the additional ability to limit the range of midtones that are preserved in the image. The result is an extremely high-contrast image that defaults to black and white—but you can reduce the image to any two colors.
Parameters in the Inspector

**Threshold:** Sets the threshold of selection for color substitution. Values range from 0 to 1.00. The threshold determines what will be considered light and what will be considered dark areas of the object.

**Smoothness:** Sets the smoothness of transition between the two colors substituted, with values ranging from 0 to 1.00.

**Dark Color:** Picks the color used to represent the dark interpreted areas of the object. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders, for more precise color selection.

**Light Color:** Sets the color used to represent the light interpreted areas of the object.

**Correct For Alpha:** This setting renders semi-transparent pixels correctly. Enable this setting if the edges of the filtered image show artifacts.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the mix control.

**Tint**
Tints an entire image with a single color. Shadows and highlights are less affected, but all of the midrange colors in the image are gradually replaced with the tint color as the Intensity parameter is increased.

---

Parameters in the Inspector

**Color:** Picks the color that is used to tint the object. The color picker can be expanded with the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.
Intensity: Sets the amount of tint applied to the object.

HUD Controls
The HUD contains the same controls as the Inspector.

YIQ Adjust
Allows color adjustment in YIQ color space. The YIQ color space definition was formerly used to describe an NTSC broadcast signal.

Parameters in the Inspector
Y: Sets the intensity of the Y color channel. Values range from –1.0 to 1.0.
I: Sets the phase of the I color channel. Values range from –1.0 to 1.0.
Q: Sets the phase of the Y color channel. Values range from –1.0 to 1.0.
Mix: Sets the amount the original image to mix with the filtered image.

HUD Controls
The HUD contains the Y, I, and Q controls.

YUV Adjust
Allow color adjustment in YUV color space. The YUV color space definition is used to describe NTSC and PAL broadcast signals.

Parameters in the Inspector
Y: Sets the intensity of the Y color channel. Values range from –1.0 to 1.0.
U: Sets the phase of the U color channel. Values range from –1.0 to 1.0.
V: Sets the phase of the V color channel. Values range from –1.0 to 1.0.
Mix: Sets the amount the original image to mix with the filtered image.

HUD Controls
The HUD contains the Y, U, and V controls.

Distortion Filters
Distortion filters are used to change the shape of your objects, warping, twisting, and pulling them in all directions.

Basic 3D (Obsolete in Motion 3)
Allows you to rotate an object on the X, Y, and Z axes, and set its position and perspective. In Motion 3, this filter is available only in projects created with an earlier version of Motion, in which the Basic 3D filter was applied.
This filter causes rasterization in 3D groups.

**Parameters in the Inspector**

**X Rotation:** Sets the amount, in degrees, that the object is rotated along the X axis.

**Y Rotation:** Sets the amount, in degrees, that the object is rotated along the Y axis.

**Z Rotation:** Sets the amount, in degrees, that the object is rotated along the Z axis.

**Distance:** Sets the distance the object is pushed away from the Canvas. Values range from 0 to 1.

**Perspective:** Sets the amount of perspective shift placed on the object. Values range from 0 to 1.

**Back Face:** An image well to which you can drag an object to use as the “back” side of a rotated object.

**Back Face Style:** A pop-up menu that contains fit and display options for the object in the Back Face image well:
- **Center:** Positions the object in the Back Face image well in the center of the rotated object.
- **Stretch:** Stretches the object in the Back Face image well to the size of the rotated object.
- **Transparent:** Hides the object in the Back Face image well.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the mix control.
**Black Hole**
This filter distorts an image by causing part of it to disappear into the specified center point, and by bowing the top, bottom, and sides inward. As the value of the Amount parameter increases, the more the sides bow in, and the more of the image at the center point disappears into it. The Poke filter, on page 903, has a similar effect without removing part of the image.

This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Black Hole applied](image2.png)

**Parameters in the Inspector**

**Center:** Sets the position of the center of the black hole.

**Amount:** Sets the amount of force pulling on your object. Values range from 0 (no gravity) to 1000 (the entire object is pulled into the black hole).

**HUD Controls**
The HUD contains the Amount control.

**Bulge**
This filter distorts an image as if pushed outward, as if something were “shoving” it from behind.
This filter causes rasterization in 3D groups.

Parameter in the Inspector

Center: Sets the position of the center of the bulge.

Amount: Sets the amount of the bulge. Values range from 0 (no bulge) to 1000.

Scale: Sets the direction and scale of the bulge. Values range from –10 (the maximum bulge inwards) to 10 (the maximum bulge outwards).

HUD Controls
The HUD contains the Amount and Scale controls.

Bump Map
This filter uses a source object to define a bump pattern which can be used to deform an object, with parameters to control the amount of distortion. You can use any image, movie, or shape as the source object.

When this filter is initially applied, Bump Map behaves as if there were a black image applied to the Map Image well, which does not distort the target image at all.

To learn how to add an object to the Map Image well, see “Compound Blur” on page 859.
This filter causes rasterization in 3D groups.

**Parameters in the Inspector**

**Map Image:** An image well that displays a thumbnail of the map chosen.

**Direction:** Sets the angle at which the bump map protrudes.

**Amount:** Sets how far the bump map protrudes. Positive values push upward, negative values push downward.

**Repeat Edges:** Sets whether or not the edges of the object are repeated.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Repeat Edges and Mix controls.

**Disc Warp**
Stretches the image outward around a circular region. As the radius of the warping region increases, the image is warped outward with a greater amount of distortion. The color of the resulting disk is determined by the color value of the pixel where the center is placed.
This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Disc Warp applied](image2.png)

**Parameters in the Inspector**

**Center**: Sets the position of the center of the disc.

**Radius**: Sets the size of the disc. Values range from 0.01 to 1000.

**HUD Controls**
The HUD contains the Radius control.

**Displace**
This filter uses an image to define a displacement region within the image, with parameters to control the horizontal and vertical scale of displacement. You can use any image, movie, or shape as the source image.

When this filter is initially applied, Displace behaves as if there were a black image applied to the Map Image well, which does not displace the target.

To learn how to add an object to the Map Image well, see “Compound Blur” on page 859.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

**Map Image:** An image well that displays a thumbnail of the map chosen.

**Horizontal Scale:** Sets the horizontal scaling of the object, ranging from –2.00 to 2.00.

**Vertical Scale:** Sets the vertical scaling of the object, ranging from –2.00 to 2.00.

**Repeat Edges:** Toggles whether or not the edges of the object are repeated.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Map Image, Horizontal Scale, and Vertical Scale controls.

**Droplet**
This filter simulates the effect of a drop of liquid falling onto the surface of a pool, with your image displaced as the surface of the pool. This filter is not automatically animated, but animating the Width parameter of this filter creates the effect of the ripples spreading out from the center.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

**Center**: Sets the position of the center of the droplet effect.

**Radius**: Sets the radius of the droplet effect. Values range from –50 to 950.

**Height**: Sets the height of the droplet ripples. Values range from –50 to 50.

**Width**: Sets the width of the rippling waves from the droplet. Values range from 0 to 100.

**HUD Controls**
The HUD contains the Radius, Height, and Width controls.

**Earthquake**
Creates an animated displacement effect on an object, adjusting its position as if shaken by an earthquake. This filter causes rasterization in 3D groups.
Parameters in the Inspector

**Twist**: Sets the amount the object is rotated as it is displaced. Values range from 0 to 1.

**Horizontal Shake**: Sets the maximum amount the image is displaced horizontally. Values range from 0 to 1.

**Vertical Shake**: Sets the maximum amount the image is displaced vertically. Values range from 0 to 1.

**Layers**: Sets the number of copies of the original object are overlayed. Values range from 1 to 8. Larger values create a motion-blurred effect.

**Epicenter**: Sets the position of the center of the earthquake, around which the Twist occurs.

**Random Seed**: Sets the value of the random seed used to determine what frames are changed by the filter. Values range from 0 to 1000.

**Mix**: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Twist, Horizontal Shake, Vertical Shake, Layers, and Random Seed controls.

**Fisheye**
Distorts an object as if it were seen through the view of a fisheye lens. The result is an extremely wide-angle warping effect which is also known as barrel distortion.

You can try using the Fisheye filter with a negative Amount value as an imprecise way to correct for certain types of barrel distortion in images that were shot using a wide-angle lens.

This filter causes rasterization in 3D groups.
Parameters in the Inspector

**Radius:** Sets the radius of the fisheye lens effect. Values range from 0 (nothing distorted) to 2 (maximum distortion).

**Amount:** Sets the amount and nature of the distortion. Values range from –100 (completely concave distortion) to 0 (no distortion) to 100 (completely convex distortion).

**Center:** Sets the position of the center of the fisheye effect.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains the Radius and Amount controls.

**Flop**
Reverses an image horizontally, vertically, or in both directions. This filter causes rasterization in 3D groups.

Parameters in the Inspector

**Flop:** Sets the direction in which the object is flopped. Values can be selected from the following: Horizontal, Vertical, or Both.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains the Flop control.

**Fun House**
Simulates the distortion caused by an imperfectly shaped mirror, similar to those in a carnival fun house. This filter causes rasterization in 3D groups.

![Original image](Original image) ![Fun House applied](Fun House applied)
Parameters in the Inspector

Center: Sets the position of the center of the fun house mirror.

Width: Sets the width of the fun house mirror. Values range from 1 to 1000.

Amount: Sets the amount of distortion of the fun house mirror. Values range from 1 to 100.

Angle: Sets the angle at which the fun house mirror is set.

HUD Controls
The HUD contains the Width, Amount, and Angle controls.

Glass Block
This filter cuts an object into a series of tiles and offsets the portion of the image within each tile to create a duplicated pattern effect. The number of tiles into which the image is broken, and the amount that each portion of the image is offset, can be customized.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

Center: Sets the position of the origin of the glass block effect.

Scale: Sets the scale of the portions of the duplicated parts. Values range from 0.10 to 10.00.

Angle: Sets the angle of offset used to sample the duplicated parts.

Tile Size: Sets the size of the glass blocks. Values range from 1 to 1000.

HUD Controls
The HUD contains the Scale, Angle, and Tile Size controls.
Glass Distortion
Simulates the effect of your object being deformed as it shows through a piece of glass. An image well lets you assign an object to use as the pattern in the glass, using any image, movie, or shape. Other parameters let you control the scale and amount of distortion.

When this filter is initially applied, Glass Distortion behaves as if there were a black image applied to the Map Image well, which will leave the target object unchanged.

To learn how to add an object to the Map Image well, see “Compound Blur” on page 859.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

Map Image: An image well that displays a thumbnail of the image map chosen.

Center: Sets the position of the center of the tiling of the glass distortion.

Scale: Sets the relative scale of the map image. Values range from 0 to 2.

Amount: Sets the amount of offset. Values range from 0 to 2000.

Softness: Sets how much blur is applied to the map image. Values range from 0 to 5.

HUD Controls
The HUD contains the Scale, Amount, and Softness controls.
**Insect Eye**
Maps a repeating hexagonal distortion pattern to an image, mimicking the POV of an insect. This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Insect Eye applied](image2.png)

**Parameters in the Inspector**

**Size:** Sets the size of the hexagons, in pixels. Values range from 8 to 128.

**Refraction:** Sets the amount of distortion present in each hex. Values range from 0 to 4.

**Border:** Sets the width, in pixels, of the border of each hex. Values range from 0 to 8.

**Border Color:** Picks the color of the border of the hexagons. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders, for more precise color selection.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

**Mirror**
By default, this filter splits an image in half vertically, and reverses the remaining half to create a reflection. The center point and angle of this split point can be customized. This filter is excellent for recreating the magic of 1980s music videos.
This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Mirror filter applied](image2.png)

**Parameters in the Inspector**

**Center**: Sets the position of the center of the mirror.

**Angle**: Sets the angle of the mirror's orientation.

**Mix**: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Angle control.

**Poke**
This filter distorts an image by bowing the top, bottom, and sides inward, and appears to push the object into the Canvas at the specified Center point. As the value of the Amount parameter increases, the more the sides bow in. The Black Hole filter, on page 892, has a similar effect but also removes part of the image at the center point.

This filter causes rasterization in 3D groups.

![Original image](image3.png) ![Poke applied](image4.png)
Parameters in the Inspector

Center: Sets the position of the center of the poke.

Radius: Sets the radius of the poke effect. Values range from 0 (a point) to 1000.

Scale: Sets the scale of the distortion. Values range from 0 (no pinching) to 1.

HUD Controls
The HUD contains the Radius and Scale controls.

Refraction
Creates a glass-distortion effect on an image, with an optional height map. This filter causes rasterization in 3D groups.

Parameters in the Inspector

Softness: Sets the amount of softness applied to the refracted edges. Values range from 0 to 1.

Refraction: Sets the amount that the image is distorted. Values range from 0 to 200.

Height Map: An image well that displays a thumbnail of the height map chosen. The height map is used to determine the edges along which the image is refracted.

Map Channel: Sets the channel which is used to determine how the image is refracted. If a height map is present, the channel is selected from the height map, otherwise the channel is selected from the source object. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.
HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

Ring Lens
This filter creates a ring of distortion over the image. The result can be a donut-like bulge in the image. This filter causes rasterization in 3D groups.

Parameters in the Inspector
Center: Sets the position of the center of the lens.
Radius: Sets the radius of the ring. Values range from 0 to 1000.
Thickness: Sets the thickness of the ring as a percentage of the radius. Values range from 0 (no thickness) to 1.00 (no hole in the center of the ring lens).
Refraction: Sets the amount of refraction of the lens. Values range from –5 to 5.

HUD Controls
The HUD contains the Radius, Thickness, and Refraction controls.

Ring Warp
Similar to the Ring Lens, but the image is distorted with multiple concentric rings. The number of rings can be increased or decreased using the Radius and Refraction parameters.
This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Ring Warp applied](image2.png)

**Parameters in the Inspector**

**Center:** Sets the position of the center of the rings.

**Radius:** Sets the radius of the rings. Values range from 0.01 to 200.

**Refraction:** Sets the amount of refraction. Values range from 0 to 20.

**HUD Controls**
The HUD contains the Radius and Refraction controls.

**Ripple**
Creates animated ripples over the surface of an object. This filter is automatically animated to create an undulating effect on the surface of the affected image. The amplitude can be adjusted to increase or decrease the rippling effect.

This filter causes rasterization in 3D groups.

![Original image](image3.png) ![Ripple applied](image4.png)
Parameters in the Inspector

**Center**: Sets the position of the origin of the effect.

**Amplitude**: Sets the width of the waves. Values range from 0 to 100.

**Crop**: Toggles whether the object is cropped at its original boundaries.

**Mix**: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Amplitude control.

**Scrape**
Smears an image along an angle defined by the Rotation parameter. The Scrape effect starts at the center point, and continues to the edge of the object.

This filter causes rasterization in 3D groups.

Original image  Scrape applied

Parameters in the Inspector

**Center**: Sets the position of the center of the scrape.

**Rotation**: Sets the angle of rotation of the scrape.

**Amount**: Sets the ramping of the number of pixels spread across the range of the scrape. Values range from 0 (very gradual) to 200 (hard edge).

**Mix**: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Rotation and Amount controls.
**Sphere**
Simulates the effect of an image being wrapped around a sphere. This filter can be used to turn an image of a map into an imprecise globe.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

- **Center**: Sets the position of the center of the sphere.
- **Radius**: Sets the radius of the sphere. Values range from 0 to 1000.

**Starburst**
Radiates solid-colored rays out from the center of your object. The colors are derived from pixel values around the selected center point, with the number of colors used determined by the Radius parameter.

This filter causes rasterization in 3D groups.
Parameters in the Inspector

**Center:** Sets the position of the center of the starburst.

**Radius:** Sets the radius of pixel sampling for ray color determination. Values range from 0.01 to 200.

**HUD Controls**
The HUD contains the Radius control.

**Stripes**
By default, this filter turns your object into a series of vertical stripes. The angle of generated stripes can be changed using the Angle parameter. The stripe colors are derived from pixel values along a line through the center point at the angle specified by the Angle parameter. The distribution of colors is determined by the Offset parameter.

This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Stripes applied](image2.png)

Parameters in the Inspector

**Center:** Sets the position of the center of the stripe effect.

**Angle:** Sets the angle of the stripes.

**Offset:** Sets the angle of pixel sampling used for sampling pixel color values.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Angle and Offset controls.
**Target**
The Target filter draws bands of concentric circles outward from the center point value. The target colors are derived from pixel values around the selected center point, with the distribution of colors determined by the Angle parameter.

This filter causes rasterization in 3D groups.

![Original image](image1) ![Target applied](image2)

**Parameters in the Inspector**

**Center:** Sets the position of the center of the target.

**Angle:** Sets the angle of the line used to select pixels for the bands of circles in the target.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Angle control.

**Twirl**
Twirls an image like a fork twisting a plate of spaghetti. The image appears to stretch from the sides to the center around in a spiral. The amount of spiraling is determined by the Twirl parameter.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

Amount: Sets the radius of the twirl. Larger values affect more of the image. Values range from 0 (none of the image is affected) to 1.00 (largest amount of the image is affected).

Twirl: Sets the amount of twirl.

Center: Sets the position of the center of the twirl.

Crop: Toggles whether the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains the Amount and Twirl controls.
Underwater
Applies an animated distortion to your object, as if it is being viewed through water. This filter causes rasterization in 3D groups.

Parameters in the Inspector

Size: Sets the size of the ripples in the water. The smaller the number, the more ripples there are in the water simulation. Values range between 0 and 10.

Speed: Sets the speed at which the distortion is animated. Values range from 0 to 2.

Refraction: Sets the amount that the image is distorted. Values range from 0 to 200.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains the same controls as the Inspector.

Wave
Distorts the object to simulate waves oscillating across it. The wave filter is not automatically animated, but you can animate the Offset parameter to animate the effect of waves causing the image to undulate.
This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Wave filter applied](image2.png)

**Parameters in the Inspector**

**Amplitude:** Sets the amplitude of the waves. Values range from 0 to 100.

**Wavelength:** Sets the length of the waves. Values range from 1 to 100.

**Offset:** Sets the offset of the wave, with values ranging from –500 to 500.

**Vertical:** Toggles whether the waves run vertically or horizontally.

**Repeat Edges:** Toggles whether or not the edges of the object are repeated.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Amplitude, Wavelength, Offset, and Vertical controls.

**Glow Filters**
Glow filters combine blur with brightness and color effects. The results are automatically recomposited over the original image in many different ways. Glows can be used to simulate film effects, as a method to make your footage more abstract, or used more subtly, as accents to make individual elements in a composition stand out.
Aura
This is a highly stylized filter that adds light or dark halos around well-defined areas of an image. The resulting glow appears solarized, and the underlying image creates outlines that show through the glow effect.

Parameters in the Inspector

**Inner Radius:** Sets the amount the aura extends inward from their point of origin. Values range from 0 to 32.

**Outer Radius:** Sets the amount the aura extends outward from its point of origin. Values range from 0 to 32.

**Brightness:** Sets the brightness of the aura. Values range from 0 to 100.

**Crop:** Toggles whether or not the aura is cropped at the original boundaries of the object.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Inner Radius, Outer Radius, and Brightness controls.
**Bloom**
This filter simulates the effect of extremely overexposed highlights on film. Highlights above a certain threshold are blurred, brightened, and recomposited with the original. All unaffected regions of the image interact with the glow effect, but otherwise retain their detail.

![Original image](image1) ![Bloom applied](image2)

**Parameters in the Inspector**
- **Amount**: Sets the amount of the bloom. Values range from 0 (no bloom) to 32.
- **Brightness**: Sets the brightness of the bloom. Values range from 0 to 100.
- **Threshold**: Sets the luminance threshold at which the bloom starts. Values range from 0 to 100.
- **Horizontal**: Sets the amount of horizontal bloom. Values range from 0 to 100.
- **Vertical**: Sets the distance of vertical bloom. Values range from 0 to 100.
- **Crop**: Toggles whether or not the bloom is cropped at the original boundaries of the object.
- **Mix**: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Amount, Brightness, and Threshold controls.
Dazzle
This filter adds glowing star-shaped accents to the highlights in an image. This filter can be customized to create anything from subtle highlights to outrageous, colorful flashes of color.

Parameters in the Inspector

Amount: Sets the radius of the spikes from the glow of Dazzle. Values range from 0 to 60.

Angle: Sets the angle of rotation of the spikes from Dazzle.

Brightness: Sets the amount of brightness of the glow of Dazzle. Values range from 0 to 100.

Threshold: Sets the luminance threshold of the glow. Values range from 0 to 100.

Spike Count: Sets the number of spikes coming off of the glows. Values range from 3 to 10.0.

Crop: Toggles whether or not the glowed object is cropped at its original borders.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains the Amount, Angle, Brightness, Threshold, and Spike Count controls.
**Gloom**
This filter creates a muted, dark glow. The image is darkened, and areas of fine detail are evened out into larger regions of color. It’s spooky.

![Original image](image1) ![Gloom applied](image2)

**Parameters in the Inspector**

**Radius:** Sets the radius of the gloom. Values range from 0 to 100.

**Amount:** Sets the amount of gloom. Values range from 0 (no gloom) to 2 (maximum gloominess).

**HUD Controls**
The HUD contains the Radius and Amount controls.

**Glow**
The most basic glow filter in this category, which can be customized for a wide variety of effects.

**Parameters in the Inspector**

**Radius:** Sets the radius of the glow. Values range from 0 to 100.

**Opacity:** Sets the opacity of the glow. Values range from 0 to 3.0.

**Threshold:** Sets the luminance threshold at which the glow begins. Values range from 0 to 1.0.

**Softness:** Sets the amount of softness applied to the glow. Values range from 0 to 1.0.

**HUD Controls**
The HUD contains the same controls as the Inspector.
**Light Rays**
A glow filter that uses the zoom blur to distribute the resulting glow, instead of a gaussian blur. The effect is that of light rays shining through an object from a specified point.

This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Light Rays applied](image2.png)

**Parameters in the Inspector**

- **Amount**: Sets the amount of the light ray effect. Larger values extend the length of the rays. Values range from 0 to 200.
- **Center**: Sets the position of the center point of the light source.
- **Glow**: Sets the brightness multiplier of the light rays. Values range from 0 to 8.
- **Expansion**: Sets the distance the light rays extend outside the boundary of the source object. Values range from 0 to 2.
- **Mix**: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Amount and Glow controls.
**Outer Glow**

Adds a glow to the alpha channel of an object. The result is a glow around the outside of an object, while the object’s actual image is unaffected.

![Original image](image1.jpg) ![Outer glow filter applied](image2.jpg)

**Parameters in the Inspector**

- **Radius**: Sets the size of the glow. Values range from 0 to 15.
- **Brightness**: Sets the brightness of the glow. Values range from 0 to 100.
- **Inner Color**: Picks the inner color of the glow. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.
- **Outer Color**: Picks the outer color of the glow.
- **Range**: Sets the gradient position between the two glow colors. Values range from 0 to 1.0.
- **Horizontal**: Sets the amount of horizontal glow. Values range from 0 to 100.
- **Vertical**: Sets the amount of vertical glow. Values range from 0 to 100.
- **Crop**: Toggles whether or not the object is cropped at its original boundaries.
- **Mix**: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**

The HUD contains the Radius, Brightness, Inner Color, Outer Color, and Range controls.
**Overdrive**

Creates an animated glow effect by compositing numerous glowing tinted duplicates of the original image. Fine detail is lost, and the highlights of the image are emphasized. You can customize the inner glow and outer glow colors.

![Original image](image1) ![Overdrive applied](image2)

**Parameters in the Inspector**

**Intensity:** Sets the number of samples. Values range from 0 to 32.

**Size:** Sets the radius of the effect. Values range from 0 to 32.

**Rotation:** Sets the angle of rotation of the collected offsets. Values range from 0 to 360 degrees.

**Inner Glow:** Picks the color of the inner part of the glow. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Outer Glow:** Picks the color of the outer part of the glow.

**Crop:** Toggles whether or not the object is cropped at its original boundaries.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**

The HUD contains the same controls as the Inspector, with the exception of Crop and Mix.

**Keying Filters**

Keying filters are used to isolate a subject that is surrounded by an area of fairly uniform color or brightness, by generating an alpha channel based on the shape of that area. Keying is most commonly performed on subjects that were shot against a blue- or green-colored background, but keys can also be based on brightness values.
A common example of color keying is the meteorologist on TV. This person is always seen standing in front of an animated map of the weather, but in reality he or she is standing in front of a big greenscreen. As part of the broadcast, the greenscreen is keyed out, and replaced by the map. You can do the same thing in Motion.

**Important:** Keying a foreground subject is not always easy, and it takes time and patience to learn how to use the parameters in each filter to achieve the best effect. Even so, most keys are pulled using more than one tool to do the job. Good compositing artists usually combine one or more masked keying filters, Matte Choker filters, a Spill Suppressor filter, and one or more garbage and holdout masks to isolate a single subject. For more information on techniques you can use to improve a key, see “Performing Multiple Keys on a Single Subject” on page 1112.

**Blue Green Screen**
The Blue Green Screen filter is intended for subjects that were shot in front of a bluescreen or greenscreen. This filter renders the blue or green areas of the image transparent, allowing one or more background images to show through.

**Parameters in the Inspector**

**Key:** Selects one of three keying modes: blue, green, or blue/green difference.

**Color Level:** Sets the percentage of color purity being keyed. Values range from 0 to 100.

**Tolerance:** Sets the color tolerance for your key. Larger values allow a greater difference between the set key color and other color values that are incorporated into the key. Values range from 1 to 100.

**Edge Thin:** Sets the amount of thinning done at the edges of the matte. A positive value erodes the matte edge. Values range from –100 to 100.

**Invert Matte:** Toggles whether or not the matte is inverted.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Mix control.
**Color Key**
This filter can pull a key based on any color you select. Bear in mind that if the color is too close to that of the subject you’re trying to isolate, parts of your foreground subject may disappear as well. The resulting effect renders the selected color transparent, allowing a background image to show through.

![Original image](image1.png) ![Color Key filter rendering gray transparent](image2.png)

**Parameters in the Inspector**

**Color:** Picks the color for your key. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Tolerance:** Sets the color tolerance for your key. Values range from 0 to 1.

**Invert Matte:** Toggles whether or not the alpha channel of your color key is inverted.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Mix control.
**Luma Key**

Luma Key pulls a key from your object based on a selected brightness level. This can be effective if you’re keying a subject that was shot against a solid white or black background, and exposed so that there are no absolute highlights or shadows within the foreground subject. Despite this, shadows and highlights in the image usually make this a difficult filter with which to pull a perfect key.

**Parameters in the Inspector**

**Key Mode:** Sets the mode used to calculate the luminance value of your object. The modes can be selected from the following: Key Out Brighter, Key Out Darker, Key Out Similar, or Key Out Dissimilar.

**Luminance:** Sets the type of luminance that is keyed. The types can be selected from the following: NTSC, PAL, Film, Red, Green, and Blue.

**Threshold:** Sets the threshold of the key. Values range from 0 to 1.

**Tolerance:** Sets the tolerance of the threshold. Larger values allow a greater difference between the set key color and other color values that are incorporated into the key. Values range from 0 to 1.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

**HUD Controls**

The HUD contains the same controls as the Inspector, with the exception of the Mix control.
**Primatte RT**

The Primatte RT filter is a high-quality keying filter, which renders the blue or green areas of the image transparent, allowing one or more background images to show through.

Parameters in the Inspector

**Output Type:** Sets the output type of the keyer. Select values from the following: Foreground, Background, Processed Foreground, and Matte.

**Backing Color:** Pick the backing color for the matte. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection. In addition, clicking the color well opens the Colors window, which allows you to use the color picker to select a color from the object.

**Auto Sample:** Automatically samples the dominant color type in the image to be used for the key. Select Red, Green, or Blue.

**Replacement Color:** Picks the color to be used to fill in pixels in spill and transition areas. The intelligent edge smoothing of the Primatte RT filter can take pixel color values from the background to substitute in spill and transition areas.

**Noise Removal:** Sets the threshold for noise removal. Values range from 0 to 0.94.

**Matte Density:** Sets the density of the matte. Values range from 0 to 1. This value cannot be set to a value lower than Noise Removal.

**Spill Suppression:** Sets the amount of spill suppression applied to the matte. Values range from 0 to 1. This value cannot be set to a value lower than Noise Removal.

**HUD Controls**
The HUD contains the same controls as the Inspector.
An Example Using Primatte RT
Getting the basics down of using Primatte RT is easy. Here’s an example.

To create a simple composite using Primatte RT:
1 Import a background image into your project.

![Background Image](image1)

2 Import the foreground image for which a matte needs to be generated.

![Foreground Image](image2)

3 Select the foreground object, and turn off the background to directly observe the filter’s effects.

![Selected Object](image3)

4 Apply the Primatte RT filter to the object.
The Primatte RT filter makes a guess as to the non-subject color you are trying to remove. It makes a guess based on the dominant color present in the image, which may or may not be the color of the background. For example, if the image is a large red object that obscures most of a greenscreen, Primatte RT selects Red as its base sample. In this case, however, Primatte RT correctly guesses that you're trying to key out the blue color. If Primatte RT's guess is incorrect, use the Auto Sample buttons to choose a different color.

Tweaking the Noise Removal parameter can help for blue or greenscreens that have some variance in their color value. Additionally, the darker areas of your object can fool the keyer's defaults, so in order to get a clean matte you may have to adjust Matte Density so the background doesn't show through these dark areas. Lastly, Spill Suppression can be used to reduce bluescreen reflections or interactions with the foreground object.

5 Turn on the background layer.

**Spill Suppressor**

Whenever you key an image that was shot against a blue or greenscreen, there's a good chance that some color reflected off of the screen and illuminated the edge of the foreground subject. This fringing around the edge of the subject is called *spill*, and is usually difficult to eliminate because it's actually part of the subject you're trying to preserve. The Spill Suppressor filter deals with this by tinting the keyed color in order to turn it into a neutral tone.

*Note:* The Spill Suppressor may inadvertently tint other areas of the foreground subject in addition to the colored fringe, so adjust its settings with care.

**Parameters in the Inspector**

**Spill Type:** Sets the type of spill to be suppressed. Select Blue or Green.

**Amount:** Sets the amount of spill to be suppressed. Values range from 0 to 1.

**Mix:** Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.
HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

Matte Filters
Matte filters are used to modify mattes.

Matte Choker
This filter increases or decreases the semi-transparent area of an object’s alpha channel by performing a gamma correction (similar to the Gamma color correction filter) to all regions of the alpha channel falling between solid black and solid white. This allows you to widen or narrow the semi-transparent areas within an object, while leaving all 100% solid and transparent areas unaffected.

Parameters in the Inspector

Edge Thin: Higher positive edge thin values eat into the alpha channel, eliminating fringing around the edges of translucent areas. Negative values fill in translucent areas, filling in holes and widening the matte into regions of fringing.

Feather: Lower values reduce the amount of translucency in a matte, but this results in harder edges around holes and edges in the alpha channel.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains the Edge Thin and Feather controls.

Matte Magic
This filter shrinks and softens the edges of a matte.

Original image with rectangular matte
Matte Magic filter applied
Parameters in the Inspector

Shrink: Shrinks the edges of the matte with a soft edge to eat into the alpha channel, to reduce fringing.

Feather: Feathers the edges of the matte.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains the Edge Thin and Feather controls.

Note: The Matte Magic filter has no effect on images with a solid alpha channel.

Sharpen Filters
These filters sharpen images by creating a high contrast overlay that emphasizes edges within the image.

Sharpen
Sharpenes an image by enhancing the color contrast around edges within the image.

Parameters in the Inspector

Intensity: Sets the intensity of the sharpening. Values range from 0 to 2.

Amount: Sets the amount of the sharpening. Values range from 0 to 100.

HUD Controls
The HUD contains the Amount and Intensity controls.
Unsharp Mask
Similar to Sharpen, this filter provides many more options to refine and control the amount of sharpening applied to the image. This filter causes rasterization in 3D groups.

Parameters in the Inspector

Radius: Sets the amount of the mask’s effect. Values range from 0 to 32.

Amount: Sets the amount of the multiplier used to sharpen the object’s edges. Values range from 0 to 2.

Threshold: Sets the threshold of luminance difference to be considered as a high contrast range, between 0 and 1.

Horizontal: Sets the horizontal width of the unsharp mask. Values range from 0 to 100.

Vertical: Sets the vertical scale of the unsharp mask. Values range from 0 to 100.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains the Radius, Amount, and Threshold controls.

Stylize Filters
Unlike distortion filters, which warp and deform an image, filters in the stylize subcategory make an image appear as if it was created with a different medium.
Add Noise
This filter adds an overlay noise of the selected type to an image. This filter causes rasterization in 3D groups.

Parameters in the Inspector

Amount: Sets the amount of noise added to the image. Values range from 0 to 1.

Type: Sets the type of noise added to the image. Values can be selected from White Noise (Uniform), Pink Noise (TV Static), and Gaussian Noise (Film Grain).

Monochrome: Toggles whether the added noise is monochrome or color.

Blend Mode: Sets the blend mode used to add noise to the image.

Autoanimate: Toggles whether the noise is animated automatically.

Random Seed: Sets the seed used to generate the position of the noise. This parameter is only available if Autoanimate is turned off.

Mix: Sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

HUD Controls
The HUD contains all the same controls as the Inspector, with the exception of the control.
Bad TV
This filter simulates poor analog television reception, adding attributes like exaggerated video field scan lines, static and roll. This filter causes rasterization in 3D groups.

Parameters in the Inspector

Waviness: Sets the amount of horizontal offset applied to the video fields. Values range from 0 to 200.

Roll: Sets the amount of vertical offset applied to the image. The entire image is displayed, but the image is split along the roll line, with the otherwise missing part of the footage shown joined along the roll line.

Static: Sets the amount of static added to the image. Values range from 0 to 1.0.

Color Synch: Sets the amount of horizontal RGB channel offset applied to the image. Values range from 0 to 1.0.

Saturate: Sets the amount of color saturation applied to the image. Negative values reduce saturation, positive values add saturation. Values range from −100 to 100.

Scan Line Brightness: Sets the brightness of the video field scan lines added to the image. Value range from 0 to 5.

Scan Line Thickness: Sets the thickness of the video field scan lines added to the image. Values range from 0 to 100.

Scan Line Distance: Sets the distance between each of the video field scan lines added to the image. Values range from 1 to 100.

Mix: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.
HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

Circle Screen
This filter reduces an image to a high-contrast grayscale version of itself. It then screens it using a pattern of concentric circles, simulating a sort of etched screening technique. The image is represented by varying thicknesses in the circular pattern.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

Center: Sets the position of the center of the circle screen.

Scale: Sets the scale of the circle screen. Values range from 0 to 100.

Contrast: Sets the contrast level. Values range from 0 to 0.99.

HUD Controls
The HUD contains the Scale and Contrast controls.

Circles
This filter adds elliptical facets to an image, giving it a mosaic-like appearance. Each facet takes a color sample from the center of it. Unlike some of the other mosaic filters, the edges of the facets do not join, so part of the untouched image is displayed between the facets.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

Size: Sets the size of the facets. The facets range in size from 3 (tiny) to 200 (huge).

Falloff: Sets the amount of alpha blending done at the edges of the each facet. Values range from 0 to 1.

Invert: Toggles whether the facets are elliptical or tiles with elliptical cut-outs.

Mix: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the Mix control.
**Color Emboss**

This filter traces high-contrast edges in the image with darker versions of the color already in the image. This gives the object the appearance of being stamped into the Canvas, while retaining the colors of the original image. The Direction and amount of Relief can be customized.

Parameters in the Inspector

- **Direction:** Sets the angle of direction of the offset emboss.
- **Relief:** Sets the amount of the offset. Values range from 0 to 3.
- **Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**

The HUD contains the same controls as the Inspector, with the exception of the Mix control.

**Crystallize**

This mosaic filter simulates the effect of viewing an image through a pane of glass with irregular facets patterned into it. These facets give an image a crystallized appearance. This filter is automatically animated, and the facets appear to shift and turn according to the value in the Speed parameter. To prevent the facets from moving, set the Speed to zero.
This filter causes rasterization in 3D groups.

![Original image](image1.jpg) ![Crystallize applied](image2.jpg)

**Parameters in the Inspector**

**Size:** Sets the size of the facets. The facets range in size from 3 (tiny) to 64 (huge).

**Speed:** Sets the speed of the animation of the facets. Values range from 0 to 2.

**Smooth:** Toggles whether facet colors are based on average values in the area they are replacing, or single samples taken from the center of the facet.

**Feathering:** Sets the amount of feathering that is applied to the edges of the facets. Values range from 0 to 2.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**

The HUD contains the same controls as the Inspector, with the exception of the Mix control.

**Edge Work**

This filter reduces an image to a high-contrast, grayscale version of itself. The detail in this grayscale image can then be reduced and smoothed using various parameters to create an image that resembles something hand-drawn. Depending on the amount of smoothing you apply, many different effects are possible with this filter.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

**Radius**: Sets the radius of transition between light and dark areas. Values range from 0 to 100.

**Blur**: Sets the amount the image should be blurred before edge detection. Values range from 0 to 3.5.

**Amount**: Sets the amount of contrast between light and dark areas. Values range from 0 to 30.

**Smoothness**: Sets the smoothness of the edge lining, ranging from 0 to 5.

HUD Controls
The HUD contains the same controls as the Inspector.

**Edges**
An edge detection filter that examines the luminance of an image to derive the high contrast borders between different regions of brightness. These edges are then traced, and all other detail is replaced by black. The amount of eliminated detail depends on the value of the Intensity parameter. The colors of the resulting highlights are intensified variants of the colors from the original image.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

Intensity: Sets the intensity of the edges. Values range from 0 to 50.

Mix: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

HUD Controls
The HUD contains the Intensity control.

Extrude
Gives an object simulated depth, by creating a “front” and “back” side, then offsets them and extrudes the edges so they connect.

Note: Because this filter only simulates depth, an object with the Extrude filter applied does not interact with 3D aspects of Motion.

This filter causes rasterization in 3D groups.
Parameters in the Inspector

**Angle:** Sets the angle at which the object is extruded.

**Distance:** Sets the distance the object is extruded. Values range from 0 to 100.

**Clipping:** Sets the distance at which the extrusion is clipped. Values range from –100 to 100.

**Back Size:** Sets the size of the back object, as a proportion of its original size. Values range from 0 to 2.

**Face Brightness:** Sets a brightness level applied to the face of the object. Values range from 0 to 2.

**Front Brightness:** Sets a brightness level applied to the front of the object. Values range from 0 to 2.

**Back Brightness:** Sets a brightness level applied to the back of the object. Values range from 0 to 2.

**Extrude Style:** Selects the method used to extrude the sides of the object. Shading or Gradient can be selected. With Shading selected, the color values of the pixels at the edges of the object are used along the extrusion. With Gradient selected, a gradient preset or custom gradient can be used.

**Gradient:** Selects a gradient preset to be applied to the object. Can also be used to edit a custom gradient. The gradient is applied only if the Extrude Style is set to Gradient.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**

The HUD contains all of the same controls as the Inspector, with the exception of the Gradient control.

**Halftone**

This filter reduces an image to a black and white version of itself, simulating the halftone screening method for print, in which the shadows and highlights of an image are recreated using patterns of small and large dots.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

Center: Sets the position of the center of the halftone dots.

Angle: Sets the angle of the alignment of the dots.

Scale: Sets the scale of the halftone dots. Values range from 2 to 100.

Contrast: Sets the amount of contrast between the lightest and darkest dots. Values range from 0 to 0.99.

HUD Controls
The HUD contains the Angle, Scale, and Contrast controls.

Hatched Screen
This filter reduces an image to a black and white version of itself, simulating a halftone pen-and-ink method of shading an image, in which the shadows and highlights of an image are recreated using hatched patterns of lines.

This filter causes rasterization in 3D groups.
Parameters in the Inspector

**Center**: Sets the position of the center of the hatched screen.

**Angle**: Sets the angle of the hatched screen.

**Scale**: Sets the scale of the hatched screen. Values range from 1 to 100.

**Skew**: Sets the amount of skew of the hatched screen. Values range from −3 to 3.

**Stretch**: Sets the amount of skew of the hatched screen. Values range from −2 to 2.

**Contrast**: Sets the relative amount of contrast between light and dark areas. Values range from 0 to 0.99.

**HUD Controls**
The HUD contains the Angle, Scale, Skew, Stretch, and Contrast controls.

**Highpass**
This filter emphasizes areas of detail in an image, and stylizes the colors in the resulting image to create a psychedelic display. This filter causes rasterization in 3D groups.

![Original image](image1) ![Highpass applied](image2)

**Parameters in the Inspector**

**Radius**: Sets the amount of variance of detail to consider. Values range from 0 (entire range of color) to 100 (only the most detailed portions).

**Amount**: Sets the amount of emphasis. Values range from 0 to 30.

**HUD Controls**
The HUD contains the Radius and Amount controls.
**Indent**

Creates a shiny, bump-mapped appearance on an image, giving the appearance of “depressed” and “flat” areas. This filter causes rasterization in 3D groups.

![Original image](image1.jpg) ![Indent applied](image2.jpg)

**Parameters in the Inspector**

- **Softness**: Sets the softness of the transition between the flat and raised areas. Values range from 0 to 1.
- **Brightness**: Sets the level of brightness of the object. Values range from 0 to 10.
- **Ambient**: Sets the amount of ambient light hitting the object. Values range from 0 to 1.
- **Highlight Brightness**: Sets the amount of brightness applied to the highlights of the object. Values range between 0 and 100.
- **Highlight Sharpness**: Sets the degree of sharpness applied to the highlights of the object. Values range between 1 and 100.
- **Light Rotation**: Sets the angle, in degrees, at which the ambient light hits the object.
- **Depth**: Sets the amount of depth between the flat and raised areas. Values range between 0 and 20.
- **Height Map**: An image well that displays a thumbnail of the height map chosen. If present, the height map is used to determine the flat and raised areas of the object.
  - **Map Channel**: Sets the channel from the object that is used to determine the flat and raised areas of the image. If a height map is present, the channel is selected from the height map. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.
- **Stretch To Fit**: Toggles whether the Height Map is stretched to fit the dimensions of the filtered object. The default value is on. If this parameter is toggled off, the following four parameters are available to edit:
• **Height Map X Scale:** Sets the scaling used to determine the width of the Height Map. Values range from 0 to 10.

• **Height Map Y Scale:** Sets the scaling used to determine the height of the Height Map. Values range from 0 to 10.

• **Height Map X Offset:** Sets the amount of offset used to position the Height Map horizontally. Values range from 0 to 100%.

• **Height Map Y Offset:** Sets the amount of offset used to position the Height Map vertically. Values range from 0 to 100%.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

**Line Art**
Performs an edge detection of the high-contrast borders between regions of differing brightness in an object, tracing the edges and reducing all other detail in the image to the color specified by the Paper Color parameter. The color of the resulting outline can also be customized. The result is to simulate the look of a line drawing drawn on paper.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

**Threshold:** Sets the threshold of edge detection. Values range from 0 to 0.2.

**Smoothness:** Sets the level of smoothness of transition between the lines and the background. Values range from 0 to 1.
**Paper Color:** Sets the color of the paper. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders to more precisely select the color.

**Paper Opacity:** Sets the opacity of the paper. Values range from 0 to 1.

**Ink Color:** Sets the color of the ink used in the line drawing.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

**Line Screen**
This filter reduces an image to a high-contrast grayscale version of itself. It then screens it using a pattern of straight lines, simulating a sort of etched screening technique. The image is represented by varying thicknesses in the pattern of the parallel lines.

This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Line Screen applied](image2.png)

**Parameters in the Inspector**

**Center:** Sets the position of the center of the hatched screen.

**Angle:** Sets the angle of the hatched screen.

**Scale:** Sets the scale of the hatched screen. Values range from 1 to 100.

**Skew:** Sets the amount of skew of the hatched screen. Values range from –3 to 3.

**Stretch:** Sets the amount the hatched screen is stretched. Values range from –2 to 2.

**Contrast:** Sets the relative amount of contrast between light and dark areas. Values range from 0 to 0.99.
HUD Controls
The HUD contains the Angle, Scale, Skew, Stretch, and Contrast controls.

MinMax
This filter softly patterns an image by choosing a maximum or minimum color value for pixels within the specified radius. The result erodes or dilates the light or dark areas of your object into soft, blocky regions.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

Mode: Sets the mode of the minmax. The following modes are available: Minimum and Maximum.

Radius: Sets the radius of the minmax. Values range from 0 to 100.

Mix: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

HUD control
The HUD contains the Mode and Radius controls.
Noise Dissolve
Dissolves an object by adding a pattern of noise to it. Raising the value of the Dissolve Amount parameter gradually eats away at more and more of the image. The alpha channel is set to zero within the noisy areas, so background images are revealed as the Dissolve Amount increases.

Parameters in the Inspector

**Dissolve Amount:** Sets the percentage of pixels dissolved by noise.

**Random Seed:** Sets a number to be used as a seed for noise placement. Values range from 0 to 1000.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

HUD Controls
The HUD contains the Dissolve Amount and Random Seed controls.

Pixellate
This filter turns an image into a mosaic of blocks using colors taken from an object. The scale of the blocks can be increased or decreased.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

Center: Sets the position of the center of the pixellation effect.

Scale: Sets the scale of the pixellation. Values range from 1 to 100.

HUD Controls
The HUD contains the Scale control.

Posterize
This filter reduces the number of colors in your object to a set number per color channel, adjustable using the Levels parameter.

Parameters in the Inspector

Levels: Sets the number of levels of posterization. Values range from 2 to 255.

Mix: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.
HUD Controls
The HUD contains the Level control.

Relief
Uses the color values of an object or height map to calculate height vertices, creating the appearance of a 3D height map.

Note: As this filter simulates depth, an object with the Relief filter applied does not interact with 3D aspects of Motion.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

Front: Sets the position of the center point of the front of the height map, determining the direction to which the height vertices are projected. Values are coordinates.

Front Size: Sets the size of the front object, as a proportion of its original size. Values range from 0 to 2.

Back: Sets the position of the center point of the back of the height map, determining the direction from which the height vertices are projected. Values are coordinates.

Back Size: Sets the size of the back object, as a proportion of its original size. Values range from 0 to 2.

Fuzziness: Sets the amount of fuzziness applied to the height vertices. The higher the Fuzziness, the softer the edges of the height vertices. Values range from 0 to 1.

Height Map: An image well that displays a thumbnail of the height map chosen. If present, the height map is used to calculate the height vertices.
**Map Channel:** Sets the channel used to calculate the height vertices. If a height map is present, the channel is selected from the height map, otherwise the channel is selected from the source object. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Front Size, Back Size, Fuzziness, Height Map, and Map Channel controls.

**Slit Scan**
Create an animated fly-through effect by simulating the slit scan process used to create “stargate” images in science fiction films.

This filter causes rasterization in 3D groups.

![Original image](image1.jpg) ![Slit Scan applied](image2.jpg)

**Parameters in the Inspector**

**Center:** Sets the position of the center of the slit.

**Rotation:** Sets the angle of rotation of the slit.

**Speed:** Sets the speed of the simulation. Values range from 0 to 400.

**Perspective:** Sets the angle of perspective on the object. Values range from 0 to 1.

**Glow:** Sets the amount of the glow on the slit. Values range from 0 to 1.

**Glow Color:** Picks the color of the glow of the slit. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Offset:** Sets the amount of offset between what is above and what is below the slit. Values range from 0 to 1.
**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Rotation, Speed, Perspective, Glow, Glow Color, and Offset controls.

**Slit Tunnel**
Simulates a circular version of the slit scan process used to create “warp tunnel” images in science fiction films. This filter is automatically animated to create a fly-through effect.

This filter causes rasterization in 3D groups.

**Parameters in the Inspector**

**Center:** Sets the position of the center of the tunnel.

**Rotation:** Sets the angle of rotation of the object during movement.

**Speed:** Sets the speed of the simulation. Values range from 0 to 400.

**Perspective:** Sets the angle of perspective on the object. Values range from 0 to 1.

**Glow:** Sets the amount of the glow at the end of the tunnel. Values range from 0 to 1.

**Glow Color:** Picks the color of the glow at the end of the tunnel. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Rotation, Speed, Perspective, Glow, and Glow Color controls.
**Texture Screen**

This filter uses a source object specified by the Map Image parameter to screen the target. The source object used can be any image, movie, or shape you want.

By default, Texture Screen behaves as if there were a black image applied to the Map Image well, which makes the target appear desaturated and washed out.

To learn how to add an object to the Map Image well, see “Compound Blur” on page 859.

This filter causes rasterization in 3D groups.

![Original image](image1.png) ![Texture Screen filter applied, circle image](image2.png)

**Parameters in the Inspector**

**Map Image**: An image well that displays a thumbnail of the map chosen to generate the screen.

**Center**: Sets the position of the center of the texture screen.

**Angle**: Sets the angle at which the texture screen is placed.

**Skew**: Sets the amount of skew applied to the map image. Values range from –3 to 3.

**Stretch**: Sets the amount of stretch applied to the map image. Values range from –2 to 2.

**Scale**: Sets the scale applied to the map image. Values range from –2 to 2.

**Image Contrast**: Sets the amount of contrast applied to the image by the screen. Values range from 0 to 20.

**Threshold**: Sets the threshold of brightness of the background image used to determine the brightness of the luminance map. Values range from –2 to 2.

**Noise Contrast**: Sets the amount of contrast added to the noise. Values range from 0 to 20.
Noisiness: Sets the amount of noise. Values range from 0 to 20.

HUD Controls
The HUD contains the same controls as the Inspector, with the exception of Center.

Vectorize Color
Makes the object appear as multicolored polygons. Four colors are substituted over the entire color range of the object.

Parameters in the Inspector

Resolution: Sets the resolution of the polygons. The smaller the value, the smaller the size of polygons in the resulting image. Values range from 3 to 64.

Smoothness: Sets the smoothness of transition between the colors that you select. Values range from 0 to 1.

Curvaceousness: Sets the spikiness of the polygons generated by the filter. The larger the number, the more rounded each polygon. Values range from 0 to 1.

First Color: Picks the first color that is substituted. The color picker can be expanded with the disclosure triangle to display Red, Green, Blue, and Alpha sliders, for more precise color selection.

Second Color: Picks the second color that is substituted.

Third Color: Picks the third color that is substituted.

Fourth Color: Picks the fourth color that is substituted.

Mix: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.
HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

Vignette
Simulates the light fall-off and blurring that can be seen in the corners of images as seen through some camera lenses.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

Size: Sets the size of the vignette. The larger the size, the more of the object is affected by the vignette. Values range between 0 and 1.5.

Falloff: Sets the amount of feathering applied to the border of the vignette. The higher the falloff, the softer the edge of the vignette. Values range from 0 to 1.

Blur Amount: Sets the amount of blur applied to the part of the image affected by the vignette. Values range between 0 and 16.

Darken: Sets the amount the affected part of image is darkened by the vignette. Values range between 0 and 1.

Saturation: Sets the amount of color saturation applied to the parts of the image affected by the vignette. Values range from –1 to 1.

Mix: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the Mix control.
**Wavy Screen**

This filter reduces an image to a high-contrast grayscale version of itself. It then screens it using a pattern of angled lines, simulating a sort of etched screening technique. The image is represented by varying thicknesses in the pattern of the zigzagging lines.

This filter causes rasterization in 3D groups.

### Parameters in the Inspector

- **Amplitude:** Sets the amplitude of the waves. Values range from 0 to 100.
- **Wavelength:** Sets the wavelength. Values range from 0 to 500.
- **Scale:** Sets the scale of the waves. Values range from 1 to 100.
- **Contrast:** Sets the contrast of the screen. Values range from 0 to 0.99.

### HUD Controls

The HUD contains the Amplitude, Scale, Wavelength, and Contrast controls.

---

**Tiling Filters**

Tiling filters don’t create a simple repetition of objects in a rectangular grid. Tiles can be created using many different shapes and be arranged into many new and exciting mosaics.

**Kaleidoscope**

This filter simulates the effect of looking at an image through a kaleidoscope. It is not automatically animated, but by animating the Offset Angle parameter you can simulate the effect of twisting the kaleidoscope’s knob to rotate the image pattern.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

**Center**: Sets the position of the center of the kaleidoscope.

**Segment Angle**: Sets the angle at the tip of each triangular tile. Values range from 0 to 360.

**Offset Angle**: Sets the rotation of the whole kaleidoscope. Values range from 0 to 360.

**Partial Segments**: Toggles allowing partial segments to complete the radius of the kaleidoscope. When turned off, segments may be distorted in order to map them across the radius of the kaleidoscope with facets of equal size.

**Mix**: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

HUD Controls
The HUD contains the Segment Angle and Offset Angle controls.

**Kaleidotile**
Simulates looking through a kaleidoscope with rectangular facets. It is not automatically animated, but by animating the Angle parameter you can simulate the effect of twisting the kaleidoscope to rotate the image pattern.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

Center: Sets the origin of the kaleidotile.

Width: Sets the width of the panels of the kaleidotile. The panels range in size from 8 to 256.

Height: Sets the height of each of the panels. The panels range in size from 8 to 256.

Angle: Sets the angle of rotation of the panels. The panels range in size from 0 to 360.

Mix: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

HUD Controls
The HUD contains the Width, Height, and Angle controls.

Offset
Treats an object as a tile, offsetting its horizontal and vertical origins but displaying the entire object nevertheless. This filter causes rasterization in 3D groups.
Parameters in the Inspector

Horizontal Offset: Sets the horizontal offset of the object.

Vertical Offset: Sets the vertical offset of the object.

Mix: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

HUD Controls
The HUD contains the Horizontal Offset and Vertical Offset controls.

Parallelogram Tile
Simulates looking through a kaleidoscope with facets made of parallelograms. It is not automatically animated, but by animating the Angle parameter you can simulate the effect of twisting the kaleidoscope to rotate the image pattern.

This filter causes rasterization in 3D groups.

Original image Parallelogram Tile applied

Parameters in the Inspector

Center: Sets the position of the origin of the parallelogram tiles.

Angle: Sets the angle of rotation of the panels.

Acute Angle: Sets the acute angle at which the parallelogram sides meet.

Tile Size: Sets the size of the panels. The panels range in size from 1 to 200.

HUD Controls
The HUD contains the Acute Angle, Angle, and Tile Size controls.

Perspective Tile
Endlessly tiles an image, mapping it onto a grid that can be positioned in simulated 3D space. Can create an endlessly repeating video wall stretching off into the distance.
This filter causes rasterization in 3D groups.

Parameters in the Inspector

**Top Left:** Sets the position of the top-left corner of the grid.

**Top Right:** Sets the position of the top-right corner of the grid.

**Bottom Right:** Sets the position of the bottom-right corner of the grid.

**Bottom Left:** Sets the position of the bottom-left corner of the grid.

**HUD Controls**

The HUD has no controls for this filter.

**Random Tile**

Tiles your object in an irregular pattern with circular panels. This filter causes rasterization in 3D groups.
Parameters in the Inspector

**Center:** Sets the center point on the object from which the tiles are generated. Values are coordinates.

**Radius:** Sets the radius of each tile. Values range from 4 to 32.

**Feathering:** Sets the amount of feathering applied to the edges of each tile. Values range from 0 to 1.

**Seed:** Sets a number to be used as a seed for tile placement and stacking. Values range from 0 to 1000.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Radius, Feathering, and Seed controls.

---

**Tile**
This filter tiles an image. The number of duplicates of the image that appear depends on the value of the Scale parameter.

This filter causes rasterization in 3D groups.

---

Parameters in the Inspector

**Center:** Sets the position of the origin of the tiles.

**Skew:** Sets the amount of skew applied to the tiles. Values range from –3 to 3.

**Scale:** Sets how much the tiles are scaled. Values range from 0.05 to 20.

**Stretch:** Sets the amount tiles are stretched vertically. Values range from 0.1 to 10.

**Angle:** Sets the angle of rotation of the tiles.
HUD Controls
The HUD contains the Skew, Scale, Stretch, and Angle controls.

Triangle Tile
Tiles your object with triangular shaped panels. The effect is similar to one of the kaleidoscope filters. It is not automatically animated, but by animating the Angle parameter you can simulate the effect of twisting the kaleidoscope to rotate the image pattern.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

Center: Sets the origin of the tile.

Angle: Sets the angle of rotation of the triangles.

Tile Size: Sets the size of the triangles. Values range from 1 to 200.

HUD Controls
The HUD contains the Angle and Tile Size controls.

Time Filters
Where other filters manipulate objects in two or three dimensions, Time filters manipulate objects in the fourth dimension—time. These filters are most often used with moving footage.

Echo
Echoes an object’s motion by repeating frames. The result is that moving areas of an image leave a streaking trail behind as they move.

This filter causes rasterization in 3D groups.
Parameters in the Inspector

**Delay**: Sets the amount of delay between echoes. Values range from 0 to 1. A value of 0 is a zero frame echo, and a value of 1 represents a 60 frame echo.

**Number**: Sets the number of echoes.

**Decay**: Sets the amount of time it takes for an echo to decay.

**Amount**: Sets the relative opacity of each echo. Values range from 0 to 1.

**Mix**: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Delay, Number, Decay, and Amount controls.

**Scrub**
Moves a virtual playhead around a clip, allowing you to change the timing of the clip without moving it in the Timeline. Additionally, it allows you to animate the offset parameter, often with interesting results. Try adding the Scrub filter to a clip, then applying the Randomize behavior to the Frame offset, with the “Offset from” parameter set to Current Frame. Also, you can create a hold frame by setting Offset to First Frame, then using “Frame offset” to find the frame you wish.

*Important*: Scrub does not affect clip audio.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

**Frame offset**: Sets the offset of the virtual playhead. Values range from –100 to 100.

**Offset from**: Sets the position from which the virtual playhead is offset. Values can be selected from First Frame or Current Frame.

**Frame Blending**: Toggles the blending between frames on and off.

**Mix**: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Mix control.

**Strobe**
Strobes the image by holding frames for a set duration. The effect is that moving images appear to skip frames as they play.
Parameters in the Inspector

**Strobe Rate:** Sets the number of frames of each strobe. Values range from 1 to 60.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**

The HUD contains the Strobe Duration control.

**Trails**

Draws light or dark trails following an object’s movement. This filter is only effective with moving images.

This filter causes rasterization in 3D groups.

Parameters in the Inspector

**Duration:** Sets the duration of the trails. Values range from 0 to 1.00.

**Echoes:** Sets the number of echoes trailing behind. Values range from 1 to 30.

**Decay:** Toggles whether the trails decay over time or disappear at the end of the duration.

**Trail On:** Sets the kind of values that trigger the trails. This can be set to Light or Dark.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**

The HUD contains the same controls as the Inspector, with the exception of the Mix control.
**WideTime**
Similar to the Echo filter, but WideTime holds frames both before and after the current frame to stretch the image's motion out in time. This filter causes rasterization in 3D groups.

**Parameters in the Inspector**

- **Duration**: Sets the number of frames before and after the current frame that are blended. Values range from 0 to 1.
- **Decay**: Sets the amount of time the added frames are held. Values range from 0 to 1.
- **Amount**: Sets the amount of opacity of the delayed object being overlaid. Values range from 0 (no reduction) to 1.0 (transparent).
- **Mix**: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Duration, Decay, and Amount controls.

**Video Filters**
Video filters are more utilitarian in nature, and can be used to help prepare a project for broadcast output.

**Broadcast Safe**
This filter limits the range of luminance or chrominance in an image to the broadcast legal limit.

**Parameters in the Inspector**

- **Video Type**: Sets the rule set to be used for filtering image data. Value can be NTSC or PAL.
- **Fix Method**: Sets the type of fix to be made to the image. Value can be Reduce Luminance or Reduce Saturation.
- **Mix**: Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

**HUD Controls**
The HUD contains the Video Type and Fix Method controls.

**Deinterlace**
This filter deinterlaces an interlaced object using one of several possible methods. This filter causes rasterization in 3D groups.
Parameters in the Inspector

**Dominant Field:** Selects the dominant field. Value can be Upper or Lower.

**Method:** Sets how the object is interlaced. The method can be Duplicate, Interpolate, or Blend.

- **Duplicate:** The non-dominant field is eliminated, and the data from the dominant field is duplicated to fill in the missing lines.
- **Interpolate:** The non-dominant field is eliminated, and a new field is created by averaging each pair of adjacent video lines to create new ones.
- **Blend:** The non-dominant field is eliminated, and new lines are created by averaging the eliminated line along with each pair of adjacent video lines.

**Mix:** Sets the amount of the filtered frame to be mixed with the original source frame. Values range from 0 to 100%.

HUD Controls
The HUD contains the Dominant Field and Method controls.

Working with Third-Party Filters
Motion supports After Effects-compatible third-party plug-ins (on the PowerPC platform only). Once you specify the location of the third-party plug-ins in Motion Preferences, they appear in the 3rd Party Filters category of the Library.

**To set the path to third-party plug-ins:**
1. Choose Motion > Preferences (or press Command-comma).
2. Click General.
3. In the 3rd Party Plug-ins section, click Choose (next to Search Path).
4. In the dialog, navigate to the folder that contains your third-party plug-ins, then click Choose.
   
   A dialog appears informing you that the path has changed and the change will take effect the next time you open Motion.

5. Quit and reopen Motion.

   The third-party plug-ins appear in the 3rd Party Filters’ category of the Library and are applied in the same manner as all other filters.

**Note:** If you specify an alias for the plug-ins, the plug-ins are not recognized.
Use the generators in the Motion Library to quickly add life to your project.

About Generators
Generators are objects in the Library that you add to your project to instantly create solids or patterns such as colors, bars, stripes, noise, or gradients. Some generators create animated patterns, while most create static, patterned images.

Once a generator is added to a project, you can modify its preset values as well as animate nearly all of its parameters—whether the generator is animated or static. Once you have modified a generator, you can save it to the Library for later use.

Using Generators
Generators are added to your project in the same manner as other files—you drag the generator to your project from the Library. When a generator is added to a project, it becomes a layer in the Layers tab (and Timeline layers list) and appears in the Canvas. When added to your project, the generator is set to the duration and size of your project by default. For example, if you are working on an NTSC D1 project and you add a generator to your project, the generator will have a 720 x 486 (.90) pixel aspect ratio.

Note: The duration of the generator depends on the Project settings in Motion Preferences. If Create Layers At is set to “Start of project,” the generator starts at the first project frame regardless of where the playhead is when the generator is added. If set to “Current frame,” the generator starts at the playhead’s frame.

Once a generator is added to a project, you can edit its parameters in the HUD or Inspector. As with all objects, the generator HUDs contain a subset of the larger group of controls located in the Inspector. Nearly all generator parameters can be keyframed, whether the default generator is an animated texture or a static image.
Like all other objects in Motion, generators can be moved, rotated, duplicated, copied and pasted, and animated. Generators can be reordered and set to different blend modes. Also, like other objects, you can apply behaviors to generators and apply Parameter behaviors to the parameters of a generator. You can also apply filters to generators, or use a generator as the source for a particle cell.

The following sections discuss adding a generator to a project, the different types of generators, modifying and animating a generator, and saving a modified generator to the Library. Applying a Parameter behavior to a generator is also discussed. Two generators are used in the following examples: the Checkerboard and the Star generators. All generators are modified, animated, and saved in the same manner. The best way to see what generators can do is to simply experiment with their various parameters.

**Note:** Performance may slow drastically when using generators in projects with large resolutions and with better render-quality settings.

**Adding a Generator**

This section provides a quick introduction to adding a generator to a project. For a description of each generator, see “Generator Types” on page 967.

**To add a generator to a project:**

1. In the Library, click the Generators category.
2. In the stack, click a generator.
   
The generator preview appears in the Preview area. If the generator is animated, such as Swirly, the generator plays in the Preview area. You can click the Play/Pause button to stop playback of the generator preview.

3. Drag the generator to your project.
   
   Like all other objects, you can add the generator to your project by dragging it to the Canvas, the Layers tab, or the Timeline.

   The generator and its HUD appear in your project. (If the HUD is not visible, press F7.) The HUD contains a subset of the complete controls that appear in the Generator tab of the Inspector.
**Note:** Generators that are added to a project are not added to the Media tab. The Media tab only includes media files that are imported into Motion, such as image sequences, Photoshop files, and audio files.

4. Click Play (or press the Space bar).

**Generator Types**
There are two types of generators in the Library: animated and static. Both types of generators create images on the fly, but an animated generator creates a moving pattern by default. Although a static generator is not animated by default, you can keyframe its parameters to create an animated pattern. You can use a generator as is or modify its settings to create different effects. The following section briefly describes each generator.

**Note:** All generators contain Opacity and Blend Mode controls in the HUD. Like all objects in Motion, the Opacity and Blend Mode parameters for any generator can also be modified in the Properties tab of the Inspector.

Although the sliders in the Inspector are usually limited to a specific range, you can often manually enter values outside of that range in the value fields.

**Parameters in Common**
All generators have Width, Height, and Pixel Aspect Ratio controls, which are located in the Generator tab of the Inspector. The controls specific to each type of generator are discussed later in the specific descriptions.

**Width:** Sets the width of the generator, in pixels. Values range from 1 to the width of your project.

**Height:** Sets the height of the generator, in pixels. Values range from 1 to the height of your project.

**Pixel Aspect Ratio:** Sets the aspect ratio of the pixels drawn by the generator. Values can be selected from the following options: Square, NTSC D1/DV, NTSC D1/DV Anamorphic, PAL D1/DV, PAL D1/DV Anamorphic, Anamorphic 2:1, D4/D16, D4/D16 Anamorphic, DVCPro HD 720p/1080i5, DVCPro HD 1080i60, or Custom. When a value other than Custom is selected, the Pixel Aspect Ratio of that selection is displayed in a value field next to the pop-up menu. Enter values from 0 to 10000 in the value field. If the value does not correspond to a preset value (for example, 2 for Anamorphic 2:1), Custom appears in the pop-up menu.

**HUD Controls**
The HUD for each generator contains all the same controls as the Inspector, as well as the Opacity and Blend Mode parameters.
Caustics

The Caustics generator creates an animated, simulated water surface. The size, speed, refraction, brightness, and color of the Caustics pattern can be modified and animated. You can use the Caustics generator to add light patterns to a project, or as the source object for an image map.

Parameters in the Inspector

Size: Sets the size of the shapes and spaces in the pattern. Values range from 0 to .5.

Speed: Sets the speed of movement of the light patterns. Values range from 0 to 2.

Refraction: Sets the refraction of the light shapes. Values range from 0 to 200.

Brightness: Sets the brightness of the light shapes. Values range from 0 to 50.

Color: Picks the color of the light shapes. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.
Cellular
The Cellular generator creates an animated pattern that looks like cells moving under a microscope. You can change the color, size, and speed of the cells.

Parameters in the Inspector
Size: Sets the size of the cells in the pattern. Values range from 0 to 64.
Speed: Sets the speed of movement of the light patterns. Values range from 0 to 2.
Gradient: Sets the color gradient used for the cells. For information on using gradients, see “Using the Gradient Editor” on page 596.

Checkerboard
The Checkerboard generator creates a static checkerboard pattern. The contrast, color, size, and position of the checkerboard squares can be edited and keyframed.

Parameters in the Inspector
Center: Sets the center of the generator. Values range from 0 to 1.
**Color 1**: Picks the first color in the checkerboard. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Color 2**: Picks the second color in the checkerboard. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Size**: Sets the size of the squares in the checkerboard. Values range from 0 to 800.

**Contrast**: Sets the sharpness of the division between squares. Values range from 0 to 1.

**Clouds**

The Clouds generator creates an animated cloud pattern. You can modify or animate the color, scale, speed, and strength of the cloud layers.

Parameters in the Inspector

**Horizontal Scale**: Gives the appearance of zooming in or out of the simulation by horizontally scaling the generator. Larger numbers indicate a higher level of zoom. The default slider values range from 8 to 64.

**Vertical Scale**: Gives the appearance of zooming in or out of the simulation by vertically scaling the generator. Larger numbers indicate a higher level of zoom. The default slider values range from 8 to 64.

**Speed**: Sets the speed of movement of the clouds. Values range from 0 to 2.

**Gradient**: Sets the color gradient used for the clouds. For information on using gradients, see “Using the Gradient Editor” on page 596.

**Method**: Sets the algorithm used to generate the clouds. Values can be set to Normal (default) or Turbulent.

**Offset**: Sets the coordinates of the center of the clouds. Coordinates are calculated from the center of your object, which is the coordinate origin.
**First Layer Strength:** Sets the strength of the first layer of clouds. Values range from 0 to 1.

**Second Layer Strength:** Sets the strength of the second layer of clouds. Values range from 0 to 1.

**Third Layer Strength:** Sets the strength of the third layer of clouds. Values range from 0 to 1.

**Fourth Layer Strength:** Sets the strength of the fourth layer of clouds. Values range from 0 to 1.

**Color Solid**
The Color Solid generator creates a single-colored object. You can adjust the color of the solid, as well as keyframe the color to create an animated texture of changing colors.

*Note:* When you want to create and animate a small, color-filled box or shape, use the Shape tools to draw a vector-based shape rather than creating and masking a color solid. This is more efficient in terms of processor time and workflow.

**Parameters in the Inspector**

**Color:** Sets the color. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.
Gradient
The Gradient generator initially creates a nonanimated blue-and-red linear gradient. You can change the gradient from linear to radial, add and remove colors in the gradient, and change the gradient start and end points. You can save a modified gradient to the Gradient category in the Library and later apply it to shapes, text objects, or particle cells. The gradient controls can be keyframed to create a moving, color-changing gradient.

Parameters in the Inspector

Gradient: Sets the color gradient used for the clouds. For information on using gradients, see “Using the Gradient Editor” on page 596.

Grid
The Grid generator creates a grid pattern made of two different colored lines. By default they are white lines on a black background. Using the controls in the Inspector, you can customize the colors and line widths of the grid, and add additional graph paper lines.
Parameters in the Inspector

**Offset:** Sets the coordinates of the center of the grid. Coordinates are calculated from the center of your object, which is the coordinate origin.

**Line Color:** Sets the color of the grid lines.

**Background Color:** Sets the color of the grid background.

**Background Opacity:** Sets the opacity of the background. Values range from 0 to 1.

**Feather:** Sets the feathering or sharpness of the grid lines. Values range from 0 to 1.

**Line Width:** Sets the width of the grid lines. Values range from 0 to 200.

**Autofit:** Rounds grid background width and height values to ensure that there aren’t any partial columns or rows at the edge of the grid.

**Background Width:** Sets the width of the background or space between the lines. Values range from 0 to 200.

**Background Height:** Sets the height of the background or space between the lines. Values range from 0 to 200.

**Graph Paper Lines:** Adds an additional grid pattern on top of the existing grid. With this option selected, use the Graph Line Color control to set color and Graph Line Frequency to set how frequently a grid line is also a graph line.

**Lens Flare**

Lens flares result from a bright light source pointed right at a lens, refracting off multiple elements in the lens assembly of a camera. This filter allows you to add a simulated lens flare to an object.

This filter can be used to simulate a bright light source in the picture.

![Original image](image1.png) ![Lens Flare applied](image2.png)
Parameters in the Inspector

**Center:** Sets the position of the center of the lens flare.

**Size:** Sets the radius of the ring of the lens flare. Values range from 0 to 400.

**Intensity:** Sets the intensity of the lens flare. Values range from 0 to 4.

**Falloff:** Sets how fast the lens flare falls off. Values range from 0 to 10.

**Color:** Picks the color of the lens flare. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Outer Color:** Picks the outer color of the lens flare.

**Ring Color:** Picks the color of the ring of the lens flare.

**Streak Color:** Picks the color of the streaks in the lens flare.

**Streak Intensity:** Sets the intensity of the streaks. Values range from 0 to 1.

**Streak Count:** Sets the number of streaks in the lens flare. Values range from 1 to 100.

**Streak Noise Frequency:** Sets the frequency of the noise in the streaks. Values range from 1 to 100.

**Streak Noise Level:** Sets the level of noise in the streaks of the lens flare. Values range from 0 to 20.

**Ring Radius:** Sets the radius of the ring of the lens flare. Values range from 0 to 1.

**Ring Width:** Sets the ring's width, with values ranging from 0 to 1.

**Glow Falloff:** Sets how fast the glow falls off of the lens flare. Values range from 0 to 20.

**Streak Map:** An image well that displays a thumbnail of the map chosen for the streaks of the lens flare.

HUD Controls
The HUD contains the same controls as the Inspector, except Center.
Membrane
The Membrane generator creates a sheer, animated sheet that appears to move gracefully about in 3D space. The speed, start and end points, offset, brightness, and color can be modified and animated. To expand the animation beyond the Canvas borders, increase the Width and Height parameters in the Inspector.

Parameters in the Inspector

**Speed:** Sets the speed of movement of the sheet. Values range from 0 to 2.

**Start 1-4:** Sets the starting point for the sheet wave. Experiment with these controls to find different wave shapes.

**End 1-4:** Sets the ending point for the sheet wave. Experiment with these controls to find different wave shapes.

**Offset:** Sets the coordinates of the center of the sheet. Coordinates are calculated from the center of your object, which is the coordinate origin.

**Brightness:** Sets the brightness of the sheet. Values range from 0 to 50.

**Color:** Picks the color of the lens flare. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.
**Noise**

Where would motion graphics artists be without a noise filter or generator? To make animated noise, you can keyframe the Random Seed parameter in the Noise HUD or Inspector. When filters are applied to an animated Noise generator, you can create some unique textures. In the second image below, the Scrape distortion filter is applied to an animated Noise generator to create a vibrant, electric light-type texture.

![Default Noise generator](image1)

![Noise generator with applied Scrape filter](image2)

**Parameters in the Inspector**

**Random Seed:** Each seed value gives you a different noise image, so changing this over time allows you to get constantly changing noise. The easiest way to see and use the random seed parameter is to add a ramp behavior to it, then ramp from a very small random seed value to a very large random seed value over time. Values range from 0 to 1000.

**One Color Ray**

The One Color Ray generator creates a ray pattern based on variations of a color. You can select the color, the degree of variance, the number of divisions represented, and rotation of the pattern.

![One Color Ray generator](image3)

![One Color Ray generator modified](image4)
Parameters in the Inspector

**Color Space:** Sets the color space. Generally, if you are working in NTSC, use YIQ. If you are working in PAL, use YUV.

**Offset:** Sets the coordinates of the ray pattern’s center. Coordinates are calculated from the center of your object, which is the coordinate origin.

**Color:** Picks the base color for the one color ray.

**Color Variance:** Sets how much the colors differ from each other.

**Divisions:** Sets the number of divisions in the ray pattern.

**Rotation:** Sets the rotation of the whole pattern from the center point.

**Op Art**

There are three Op Art generators to help confuse your background-foreground senses. The Op Art generators create mathematically oriented patterns using a repetition of simple shapes. Although some static patterns create a visual illusion of movement, you can keyframe the Op Art parameters to create actual moving moiré patterns.

**Op Art 1**

Parameters in the Inspector

**Line Thickness:** Sets the thickness of the lines in the pattern.

**Contrast:** Sets how sharp or blurred the division is between the lines and the background.

**Wavelength 1:** Sets the frequency of the wave up and down.

**Wavelength 2:** Sets the frequency of the wave from left to right.
Amplitude: Sets the amplitude of the waves.

Roundness: Sets the shape of the wave.

Op Art 2

Parameters in the Inspector

Scale: Sets how close or far away the dots appear.

Angle: Sets the angle of the dot rows.

Contrast: Sets how sharp or blurred the division is between the dots and the background.

Dot Size: Sets how much the colors differ from each other.

Compression: Sets how shallow or deep the fold in the imaginary paper appears.

Op Art 3
Parameters in the Inspector

**Line Thickness**: Sets the thickness of the lines in the pattern.

**Contrast**: Sets how sharp or blurred the division is between the lines and the background.

**Wavelength**: Sets the frequency of the wave.

**Amplitude**: Sets the number of amplitude of the wave.

**Skew**: Sets rotation of the wave pattern.

**Roundness**: Sets the shape of the wave.

**Soft Gradient**

The Soft Gradient generator creates a soft-edged, radial gradient. The gradient contains an alpha channel so that you can place the generator over another image in the project. You can change and keyframe the color, size, and position of the Soft Gradient.

![Default Soft Gradient generator vs Modified Soft Gradient generator over image](image)

Parameters in the Inspector

**Center**: Sets the position of the center of the lens flare.

**Color**: Picks the color of the gradient. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Radius**: Sets the radius of the gradient circle. Values range from 0 to 1000.
**Star**

The Star generator creates a glowing star shape that contains an alpha channel. The scale, width, angle, epsilon (which fine-tunes the size of the star spikes), and opacity of the spikes can be modified and keyframed, as well as the position, color, and radius of the star.

![Default Star generator](image1.png) ![Multiple modified Star generators over gradient](image2.png)

**Parameters in the Inspector**

**Center:** Sets the position of the center of the star.

**Color:** Picks the halo around the star. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Radius:** Sets the radius of the circle at the center of the star. Values range from 0 to 300.

**Spike Scale:** Sets the size of the star spikes. Values range from 0 to 100.

**Spike Angle:** Sets the angles of the star spikes.

**Spike Opacity:** Sets the opacity of the star spikes. Values range from –8 to 0.

**Spike Width:** Sets the width of the star spikes. Values range from 0 to 50.

**Epsilon:** Fine-tunes the strength of the star spikes.
Stripes
The Stripes generator creates a default image with vertical bands of two alternating colors. You can change and keyframe the position, colors, size, and contrast of the stripes. By animating the Center parameter, you can create an animation in which the stripes continuously move across the screen without the need to resize and pan the object across the Canvas. In the second image, the generator object is rotated so the stripes are horizontal.

Parameters in the Inspector

Center: Sets the position of the center of the stripe pattern.

Color 1: Picks the color of the first stripe. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

Color 2: Picks the color of the second stripe. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

Size: Sets the width of the individual stripes.

Contrast: Sets the sharpness or blurriness of the edge between the stripes. Values range from 0 to 1.
**Swirly**

The Swirly generator creates an animated pattern in one of three different styles called Pulse, Spiderweb Spin, and Spiky. Once you select a style, you can modify and animate the scale, rotation, persistence, radius, amplitude, and number of passes of the pattern.

Parameters in the Inspector

**Scale:** Sets the size of the swirly shape.

**Rotation:** Sets the rotation of the initial shape.

**Persistence:** Sets the number of times the shape is repeated.

**Minimum Radius:** Sets the minimum radius of the initial shape.

**Radius Amplitude:** Sets the amplitude of the whole shape.

**Amplitude:** Sets the amplitude of the waves that make up the shape.

**Passes:** Sets the number of shapes morphing at one time.

**Style:** Sets the style of Swirly–Pulse, Spiderweb Spin, or Spiky.
Two Color Ray
The Two Color Ray generator creates a ray pattern alternating between two colors. You can select the colors, the number of divisions represented, and rotation of the pattern.

Parameters in the Inspector

Offset: Sets the coordinates of the center of the ray pattern. Coordinates are calculated from the center of your object, which is the coordinate origin.

Color 1: Picks the base color for the two color ray.

Color 2: Picks the alternating color for the two color ray.

Divisions: Sets the number of divisions in the ray pattern.

Rotation: Sets the rotation of the whole pattern from the center point.

Modifying Generators
In this section, the Checkerboard generator is used to illustrate how to edit and animate a generator using the HUD. Once a generator has been customized, you can save the generator to the Library for use in future projects. This section also briefly discusses applying Parameter behaviors to the parameters of a generator.

Editing Generators
In this section, the Checkerboard generator parameters are edited to modify the appearance of the default generator.

To edit the Checkerboard generator:

1 Add the Checkerboard generator to your project.

Note: For information on adding a generator to your project, see “Adding a Generator” on page 966.
The default Checkerboard generator appears in the Canvas, Layers tab, and in the Timeline, and the HUD appears.

The Checkerboard generator HUD contains controls for editing and animating the checkerboard, such as Opacity, Blend Mode, Width, Height, Color, Size (of the checkers), and Contrast. The only Checkerboard parameter that does not appear in the HUD is Pixel Aspect Ratio (which appears in the Inspector).

1. Click the Color 1 color well and select a new color. If you are using the color wheel, click the center point and drag the pointer to select a new color.
Color 1 is replaced with the new color.

*Note:* You can save a color in the swatches along the bottom of the Colors window. Click in the color bar (to the right of the color picker tool), then drag the color chip to a white swatch, and release the mouse button.
3 Click the Color 2 color well and select a new color.

Color 2 is replaced with the new color.

4 Drag the Size slider to change the size of the checkers.

The checker size is 80 by default. Drag the slider to the left to make smaller checkers, and to the right to make larger checkers.

To scale the generator (rather than the size of the checkers), use the Width and Height parameters.

**Note:** You can also use the standard object scaling methods—the onscreen transform controls or the Scale parameter in the Properties tab of the Inspector. However, scaling generators in this manner has a greater impact on your system’s performance.

5 Drag the Contrast slider to adjust the contrast between Color 1 and Color 2.
Although the checkerboard pattern is not changing, adjusting the Contrast parameter creates the appearance of a different texture.

**Animating Generators**

Although most generators create static images, you can animate the parameters of a generator to create a moving texture over time. This section discusses using the HUD to animate the Checkerboard generator from the above example.

*Note:* You can also animate the parameters of an animated generator.

For information on using Parameter behaviors to animate a generator, see “Applying Behaviors to Generators” on page 990.

**To animate the Checkerboard generator parameters:**

1. Go to the frame where you want to begin the animation.
2. Enable Record (press A).
3. Set the initial generator parameter values:
   - Drag the Size slider to set the initial checker size.
     Once a keyframe is set for any parameter in a generator, a keyframe is set for all of the generator parameters. In other words, once the Size parameter is keyframed, the Color 1, Color 2, Contrast, and Center parameters are keyframed.
   - Click the color wells and pick the initial colors.
   - Drag the Contrast slider to set the initial contrast value.
   - Drag one of the Center parameter value sliders to set the initial Center value.
     The value slider on the left of the Center parameter is the X position of the checkers, and the value slider on the right is the Y position. To animate the checkers horizontally, use the left value slider. To animate the checkers vertically, use the right slider. To view the X and Y parameters, click the Center disclosure triangle.
4. Go to the frame where you want to create the next keyframe.
5. Change the generator Size, Colors, and Contrast parameter values.
6. Play the project (press the Space bar).
The animated generator parameters create a moving, changing texture.

Saving Modified Generators
Once you have modified the parameters of a generator, you can save the generator to the Library. For organizational purposes, it is recommended that you name objects that you save back to the Library with a descriptive name. For example, if you save a Checkerboard generator, it is named “Checkerboard 1” by default.

To save a customized generator to the Library:
1 To rename the modified generator, double-click the generator name in the Layers tab.

2 Type the new generator name, then press Return.

3 In the Library, navigate to the Generators category.

*Note:* You can also save the modified generator in another category, such as Favorites.
4 From the Layers tab, drag the modified generator to the Library stack.

The modified generator is saved in the Generators category and appears organized alphabetically in the stack. Custom items saved in the Library are identified with the user icon in the lower right of the icon.
Sharing Saved Generators
By default, any generator that you save in the Library is stored in your user folder: `/Users/username/Library/Application Support/Motion/Library/Generators`. To share custom presets, templates, layouts, behaviors, filters, or Library content with another user, the other user must copy the files into his or her home directory.

Applying Behaviors to Generators
Like all other objects in Motion, you can apply Basic Motion, Parameter, or Simulation behaviors to a generator. This section describes applying the Randomize parameter behavior to the Opacity parameter of the Star generator to create a flickering star.

To apply a Parameter behavior to the Star generator:
1. Select the Star generator and display the Generator tab in the Inspector.
2. In the Generator tab, click Spike Opacity to select the parameter. The selected parameter appears in a darker gray than the other parameters.
3. Control-click the Spike Opacity parameter, then choose Randomize from the shortcut menu.
The Randomize parameter behavior is applied to the Spike Opacity parameter, and the Behaviors tab is automatically displayed so you can adjust the Randomize parameters.

When a Parameter behavior is applied to a parameter, a Behaviors icon appears in the Animation menu for that parameter. In the Generator tab, the Behaviors icon appears in the Animation menu for the Spike Opacity parameter.

4 Click Play (or press the Space bar).
Because the Randomize parameter behavior is applied to the opacity of the star spikes, the star appears to flicker.

![Flickering star over a background image](image)

To increase or decrease the effect of the flicker, you can modify the Randomize parameters. To quickly jump to the Randomize parameters from the Generator tab, click the Behaviors icon, then choose Randomize from the shortcut menu.
For more information on using Parameter behaviors, see “Parameter Behaviors” on page 430.

Using Generators as Particle Cell Sources
Like other objects, generators can be used as a source for particle cells. The following example uses the Soft Gradient generator. It is recommended that you scale the generator down in the Generator tab of the Inspector to give your particle system more flexibility and to keep the project from taking too much processing power.

To use a generator as a particle cell source:
1. Add the Soft Gradient generator to your project.

2. In the HUD or Generator tab of the Inspector, lower the Radius value. This example uses a Radius value of 40.

3. Lower the Width and Height values. In this example, Width is set to 82 and Height is set to 75.
The size of the gradient and its bounding box are scaled down.

4 With the generator still selected, do one of the following:
   • Press E.
   • In the Toolbar, click the Make Particles icon.

Once an emitter is added to the project, the following occurs:
   • In the Layers tab, the Emitter object appears selected.
   • The generator object (the Soft Gradient) becomes an emitter source for the new particle cells.
   • The original reference object (the Soft Gradient) is disabled.

   • In the Canvas, the emitter bounding box appears, which can be transformed using the onscreen controls or the Inspector.
   • The particle appears in the Canvas in the same location as the original object. Although it appears as if the particle is selected, it is actually the bounding box for the emitter.
   • The Emitter HUD is displayed.
5 Play the project (press Space bar).

Soft gradient particles are emitted.

You can change the particle color, emitter shape, scale, emission angle, birth rate, and so on in the Emitter controls. For more information on working with particles, see “Working with Particles” on page 685.

Modified particles using the Soft Gradient generator as a particle cell source
Using Shapes and Masks

Motion has a flexible tool set that you can use to create simple shapes, complex illustrations, and paint effects right in your project. The same techniques you use for drawing can also be used to mask objects to produce a wide variety of transparency effects, to crop out parts of still images, and to rotoscope moving subjects.

Shapes and masks are vector-based objects that are drawn and edited using control points that define mathematical curves. Each control point in a shape defines some sort of corner or curve, and the actual spline that makes up the shape connects these control points together like a connect-the-dots drawing. You can edit or animate any shape by moving and editing its control points or by applying a Shape behavior.

Shape behaviors are designed specifically to be applied to shapes and masks, and perform tasks such as oscillating the position of the control points, tracking the control points, writing on a shape over time, as well as randomizing or wriggling the position of the control points. As with all objects in Motion, you can also apply Basic Motion, Parameter, and Simulation behaviors to shapes.

A paint stroke is a shape that is created in one of two ways: You can “paint” the stroke in the Canvas using the Paint Stroke tool in the Toolbar, or you can modify the outline of an existing shape. The Paint Stroke tool allows you to use a stylus and graphics tablet (or a mouse) to create a paint stroke, rather than drawing the shape in a point-by-point fashion (like a Bezier or B-Spline shape). In addition to sharing other shape outline parameters, paint strokes have a unique tool set that allows you to change the look of the paintbrush and to create particle-type effects with the stroke. Paint strokes have a special behavior called Sequence Paint, which allows you to sequence the stroke parameters over time, such an opacity, rotation, and scale.

The Paint Stroke feature is a design and graphics tool, not a retouching or roto sketching tool.
**Note:** Using a stylus and graphics tablet is recommended when using the paint feature. While you can create paint strokes using the mouse, a pen allows for a more fluid creation of strokes.

Because shapes are mathematically defined, you can take advantage of the vector nature of shapes to resize them by any amount, without introducing unwanted artifacts. Shapes are similar to imported PDF objects in that they're completely resolution independent.

As with all objects in Motion, you can save a shape or a shape style to the Library. This means that once you create or animate that shape, or both, you can save it to the Library for use in a future project. You can also save just the style of a shape—such as a custom gradient fill or modified brush stroke.

**The Difference Between Shapes, Paint Strokes, and Masks**
Shapes are primarily used to create all kinds of visual elements. They work like any other object, except that they are created in Motion and are stored within your project file. A single shape can be used as a background or colored graphic in a composition, or you can create complex illustrations using many shapes. You can use paint strokes to create unique graphic elements that can be drawn on over time. Each illustration below is composed of shapes created within Motion.
Masks, on the other hand, are used to create regions of transparency in layers. While shapes work as objects by themselves, masks must be assigned to an object to have an effect. For example, if you have a picture in which you want to isolate the foreground subject, you can create a mask to cut out the background.

Shapes and masks can be animated using behaviors and keyframes, like other layers. Shapes also have their own special category of behaviors. However, you can also animate the control points used to create each shape or mask in your project. This allows you to animate the actual form of each shape, in addition to the shape's basic position, rotation, and scale parameters.

**Shape and Mask Drawing Tools**

Shapes and masks are made with splines, and they’re created and edited using similar tools. This section covers the two spline-drawing methods that are available in Motion—Bezier splines and B-Splines. You can use Bezier shapes and B-Spline shapes interchangeably for any task. The default shape type is Bezier.

Bezier splines are good for drawing shapes for illustration. The controls used to manipulate Bezier splines are similar to those found in many other drawing and compositing applications, so they may already be familiar to you. Bezier controls lend themselves to the creation of precise, detailed shapes. Tangent handles adjust the curvature of the shape on either side of the control point, and this defines the surface of the shape.
B-Splines can also be used to draw shapes, but unlike Bezier controls, B-Splines are manipulated using only points—there are no tangent handles. Furthermore, the points themselves do not lie on the surface of the shape. Instead, each B-Spline control point is offset from the shape's surface, pulling that section of the shape toward itself as if it was a magnet, in order to create a curve. By combining the influence of multiple B-Spline points, you can create different curves. B-Splines are extremely smooth—by default, there are no sharp angles in B-Spline shapes, although you can create sharper curves, if necessary.

Because B-Spline controls are so simple, they’re easy to animate and manipulate. The tools you use for a particular task are largely a matter of personal preference.

*Note:* Shapes drawn with Bezier and B-Spline tools can be converted into paint strokes by selecting the shape’s Outline checkbox and choosing a different brush type in the Inspector. For more information, see “Creating Paint Strokes” on page 1012.

**Drawing Masks and Shapes Using Bezier Splines**

This section describes how to draw a Bezier shape from scratch. These methods are identical whether you use the shape or masking tools. This section focuses on drawing shapes. For more information on drawing masks, see “Masking Layers to Create Transparency” on page 1087.

**To draw a Bezier shape:**

1. Click the Bezier tool in the Toolbar (or press B).

*Note:* The Bezier Mask tool is located in the Mask tools section of the Toolbar.
The Bezier Tool HUD appears. To change the color of the shape before it is drawn, use the color controls in this HUD. Select the Outline checkbox to create an outline with the shape. The Width slider adjusts the width of the outline. Once the shape is created, the Shape HUD appears.

*Note:* Outlines can be added and edited after a shape is drawn.

2 Click in the Canvas to draw the first point.

3 To add additional points to further define the shape, do one of the following:
   • Click to make a linear corner point.
   • Click, then drag to make a curved Bezier point, adjusting it to the shape you want.

*Note:* Press Shift while making a curved point to constrain its tangents to 45-degree angles.

While you’re drawing a shape, you can also use any of the point-editing procedures described below to move and adjust existing control points prior to finishing the shape. You can adjust any control point except for the first one you created, since clicking the first point closes the shape.

*Tip:* If you need a closer look at what you’re doing, you can magnify the Canvas while drawing a shape. Use Command-equal sign (=) to zoom in and Command-hyphen to zoom out. You can also scroll around by pressing the Space bar as you drag in the Canvas.

4 To finish the shape, do one of the following:
Click the first point you drew to create a closed shape.

Press C to close the shape, joining the first point you created to the last.

Double-click anywhere in the Canvas to create the last point of an open shape, creating a line with a default width of 3 pixels.

Press Return to create the last point of an open shape, creating a line with a default width of 3 pixels.

**Note:** Before a shape is closed, you can press Esc at any time to cancel the entire operation, deleting the shape.

Immediately after finishing a shape, the Shape HUD appears and the Adjust Control Points tool is selected, which allows you to edit the shape you’ve just created.

**Note:** Once you have finished drawing a shape, press Esc to change to Select/Transform mode.

**Drawing Masks and Shapes Using B-Splines**

This section describes how to draw a B-Spline. These methods are identical whether you’re using the shape or masking tools, but this section focuses on drawing shapes. For more information on drawing masks, see “Masking Layers to Create Transparency” on page 1087.
To draw a B-Spline shape:

1. Click the B-Spline tool in the Toolbar (or press B).

   ![B-Spline tool](image1)

   **Note:** The B-Spline Mask tool is located in the Mask tools.

   ![B-Spline Mask tool](image2)

   The B-Spline Tool HUD appears. To change the color of the shape before it is drawn, use the color controls in this HUD. Select the Outline checkbox to create an outline with the shape. The Width slider adjusts the width of the outline. Once the shape is created, the Shape HUD appears.

2. Click in the Canvas to draw the first point.

3. Continue clicking to draw additional points to define the shape you need.

   As you create new B-Spline control points, keep the following rules in mind:

   - The control points you draw influence the shape of the curve from a distance. They do not lie directly on the surface of the curve.
• To create more detailed curves, create more points. However, it’s a good habit to use the fewest number of points necessary to create the amount of detail you need. Shapes with an excessive number of points can be difficult to edit later on.

![Simple B-Spline curve](image1) ![Multi-point B-Spline curve](image2)

• In many instances, it is easier to create a loose group of control points first, and then adjust them afterwards to create the precise curve you need in a later step.

![Starting with a loose collection of points](image3) ![Fine-tuning the illustration later](image4)

4 While drawing a shape, you can move and adjust the control points you’ve already created prior to finishing the shape. You can adjust any control point except for the first one you created, since clicking the first point closes the shape.

Tip: If you need a closer look at what you’re doing, you can magnify the Canvas while in the middle of drawing a shape. You can also scroll around by pressing the Space bar while you drag in the Canvas.

5 When you’re ready to finish your shape, do one of the following:
• Click the first point you drew to create a closed shape.
• Press C to close the shape, joining the first point you created to the last.

• Press Return to finish an open shape at the last point you made.

• Double-click anywhere in the Canvas to define the last point of an open shape, creating a line with a default width of two pixels.

*Note:* You can press Esc at any time while drawing a shape to cancel the entire operation and delete the shape.
Immediately after finishing a shape, the Shape HUD appears and the Adjust Control Points tool is selected, which allows you to edit the shape you’ve just created.

**Drawing Masks Using the Freehand Mask Tool**

This section describes how to draw a freehand mask. Like the Paint Stroke tool, the Freehand Mask tool allows you to create a shape in one movement, rather than drawing the shape in a point-by-point fashion (like a Bezier or B-Spline shape). It is recommended to use a stylus and tablet when using the Mask Freehand tool. For more information on drawing masks, see “Masking Layers to Create Transparency” on page 1087.

**To draw a freehand mask:**

1. Select the layer you want to mask, click the Mask tool in the Toolbar, then choose the Freehand Mask tool.

The Freehand Mask Tool HUD appears.

2. Adjust the controls in the Freehand Mask Tool HUD.
   - To change the blend mode of the mask before it is drawn, use the Mask Blend Mode pop-up menu in this HUD.
   - Adjust the Feather slider to soften the mask. Positive values spread the feathering outward, while negative values feather the shape inward.

3. Touch the stylus on the tablet to begin drawing the mask in the Canvas (if using a mouse, click in the Canvas).
Continue drawing around the object you are masking. To close the mask, finish the line at the mask's starting point.

**Note:** If you don't close the mask at its starting point, the mask is automatically closed when you release the mouse button.

![A small circle indicates target to close mask.](image)

The mask is completed.

4 Edit your control points to fine-tune the mask.

For more information on editing control points, see “How to Edit Shapes” on page 1017.

---

**Creating and Editing Shapes**

Use the Bezier and B-Spline shape tools to create any kind of line or shape you need. Once you draw a shape, you can adjust the fill, outline, and feathering to suit your needs.

**Note:** You can only feather shapes that have the outline turned off.

To make a freehand shape using the Bezier or B-Spline tool:

1 Select the Bezier or B-Spline tool.

2 Click in the Canvas to create the necessary control points for the line you need.

   For more information, see “Shape and Mask Drawing Tools” on page 999.

3 To finish drawing the line, do one of the following:
   - Double-click to create the last point.
   - Press Return to finish the line at the last point you drew.
By default, the Outline checkbox is selected for open shapes.

**To edit a shape's outline:**
1. Select a shape, then open the Shape tab in the Inspector.
2. To manipulate the shape's outline, do one of the following:
   - To toggle a shape's outline on or off, click the Outline checkbox.
   - To change the color of the outline, use the Brush Color parameter in the Outline controls.
   - To change the width of the outline, drag the Width slider.
   
   **Note:** You can also use the Shape HUD to turn the outline on and off, and to change its color and width.
   - To change how the outline's sharp corners are drawn, choose an option from the Joint pop-up menu.
   - To change the shape of an outline's start and end caps, choose an option from the Start Cap or End Cap pop-up menu.
   - To change whether the outline appears over or under a shape's fill, choose a command from the Order pop-up menu.
   - To change the outline from the default solid to an editable paint stroke, set Brush Type to Airbrush or Image. For more information, see “Style Pane Parameters” on page 1032.

**To create filled or empty shapes:**
1. Click the Bezier or B-Spline shape tool.
2. Create the necessary control points for the shape you need.
   
   **For more information, see “Shape and Mask Drawing Tools” on page 999.**
3. When you're ready to close the shape, click the first point you created.
4. By default, new closed shapes are filled. To make the shape empty, select it, then deselect the Fill checkbox in the Shape HUD.

![Filled shape](image1.png) ![Empty shape](image2.png)
To edit a shape’s fill:
1 Select a shape, then open the Shape tab in the Inspector.
2 Do one of the following:
   • To toggle a shape’s fill on or off, click the Fill checkbox.
   • To change a shape’s fill mode from a solid color to a gradient, choose an option from the Fill Mode pop-up menu.
   • If the shape’s fill mode is set to a solid color, you can choose the color using the Fill Color controls.
   • If the shape’s fill mode is set to a gradient, you can either choose a gradient from the gradient preset pop-up menu, or click the Gradient parameter’s disclosure triangle to display the Gradient editor and create your own custom gradient. For more information on using the Gradient editor, see “Using the Gradient Editor” on page 596.

To feather a shape:
1 Select the shape you want to feather.
2 If the shape’s Outline checkbox is selected, deselect the checkbox in the Shape tab of the Inspector.
3 Adjust the Feather slider in the HUD or in the Style pane of the Shape Inspector.
   Positive values spread the feathering outward, while negative values feather the shape inward.

Tip: You can also blur a shape in other ways using filters. For more information, see “Applying Filters to Shapes” on page 1063.
Creating Rectangles, Circles, and Lines
The Rectangle and Line tools create simple linear shapes. The Circle tool creates a simple Bezier shape. Once drawn, a shape can be converted to a Linear, Bezier, or B-Spline shape in the Inspector. The resulting shapes can be edited just like any other Bezier shape, using the methods described in “How to Edit Shapes” on page 1017.

To make a rectangle:
1 Click the Rectangle tool (or press R).

The Rectangle Tool HUD appears. To change the color of the shape before it is drawn, use the color controls in the HUD. Select the Outline checkbox to create an outline with the shape. The Width slider adjusts the width of the outline. Once the shape is created, the Shape HUD appears.

The Rectangle shape layer does not appear in the Layers list until an object is drawn.

Note: Outlines can be added and edited after a shape is drawn.

2 Click in the Canvas to define the first corner of the rectangle, then drag until the resulting rectangle is the size you want, and release the mouse button to finish drawing.

Note: To create a perfect square, press Shift while you drag. To draw the rectangle from its anchor point, press Option while you drag.

3 Once the shape is created, press S or Esc to exit shape-drawing mode and activate the Select/Transform tool.

To make a circle:
1 Click and hold the Rectangle tool, and select the Circle tool (or press C).
Chapter 12  Using Shapes and Masks

The Circle Tool HUD appears. To change the color of the shape before it is drawn, use the color controls in the HUD. Select the Outline checkbox to create an outline with the shape. The Width slider adjusts the width of the outline. Once the shape is created, the Shape HUD appears.

2 Click in the Canvas to define the start point of the bounding box that defines the circle, then drag until the resulting circle is the size you want, and release the mouse button to finish drawing.

Note: To create a perfectly symmetrical circle, press Shift while you drag. To draw the circle from its anchor point, press Option while you drag.

Tip: If you change a circle’s Shape Type to B-Spline in the Geometry pane of the Shape Inspector, you can use different methods to manipulate the circle.

3 Once the shape is created, press S or Esc to exit shape-drawing mode and activate the Select/Transform tool.

To make a line:
1 Click and hold the Rectangle (or Circle) tool, then select the Line tool.

The Line Tool HUD appears. To adjust the color and width of the line before it is drawn, use the controls in the HUD.

2 Click in the Canvas to define the start point of the line, then drag until the resulting line is the length you want, then release the mouse button.

Important: Because a line is really an outline, all of the Outline parameters in the Inspector apply to a line.
3 Once the shape is created, press S or Esc to select the Select/Transform tool to exit line-drawing mode.

The Shape HUD appears.

*Note:* Rectangles and circles can be converted into paint strokes by selecting the shape’s Outline checkbox and choosing a different brush type in the Inspector. By default, a line is an outline. For more information, see “Using a Shape Outline as a Paint Stroke” on page 1027.

**Creating Paint Strokes**

Unlike a freehand Bezier or B-Spline shape that is drawn one point at a time, a paint stroke is created with one continuous movement.

*Note:* The Paint Stroke feature is a design and graphics tool, not a retouching or rotoscoping tool.

There are two ways to create a paint stroke:

- Use the Paint Stroke tool in the Toolbar and draw a stroke in the Canvas using a stylus and tablet (or a mouse).
- Create a shape (paint stroke, line, rectangle, or circle) in the Canvas, select the Outline checkbox, and modify the outline in the Style pane of the Shape Inspector.

To access additional paint stroke controls in the Stroke and Advanced panes of the Shape Inspector, the Brush Type parameter in the Style pane must be set to Airbrush or Image.

*Note:* This section discusses creating a paint stroke using the Paint Stroke tool in the Toolbar. For information about converting a shape to an editable paint stroke, see “Using a Shape Outline as a Paint Stroke” on page 1027.

The Paint Stroke tool creates a shape outline that is comprised of **dabs**. Dabs—alogous to the cells of a replicator or particle emitter—define the appearance of the stroke. While particle cells emit a variety of different particle types, paint has only a single dab type. The dabs can be very close together or spaced widely apart along the stroke. The dabs’ color, opacity, spacing, scale, angle, and so on can be modified once a stroke is created in the Inspector.

For more information on modifying a paint stroke after the stroke is created, see “Shape Parameters in the Inspector” on page 1031.

Paint strokes can be animated using behaviors or by keyframing. In addition to Basic Motion, Simulation, and Parameter behaviors, shapes have their own category of behaviors that includes a behavior that allows you to sequence effects over the length of the stroke. For more information on using the Shape behaviors, see “Animating Shapes” on page 1063.
Note: The strokes’ shape (defined by its control points) and open/closed state can be modified in the Canvas or Inspector. Because a stroke is a shape, it can be edited just like any other shape, using the methods described in “How to Edit Shapes” on page 1017.

Once you click the Paint Stroke tool in the Toolbar and prior to drawing the stroke in the Canvas, you can define the color and other attributes of the stroke in the Paint Tool HUD. In the HUD, you select a preset shape style to use as your brush source.

There are several ways to set the style of a paint stroke:

- Select a preset shape style in the Paint Stroke tool HUD prior to drawing a stroke. If no preset shape is selected prior to drawing a stroke, a basic solid stroke (outline) is created.
- Modify a paint stroke created with the Paint Stroke tool using the Shape Style pop-up menu in the Style pane of the Shape Inspector.
- Select the Outline checkbox and modify the outline of a shape (circle, rectangle, and so on). The Outline checkbox can be selected or deselected in the Shape HUD or the Style pane of the Shape Inspector.
- Drag a shape style (in the Shape Styles category) from the Library to the paint stroke object in the Layers tab. The style of the shape from the Library is applied to the paint stroke.

Depending on the effect you want, you may achieve better results using a stylus and tablet with the Paint Stroke tool. Many styles and brushes take advantage of the pen pressure and speed applied when creating the stroke using a graphics tablet. You can apply the pressure or speed to different stroke parameters, such as width, opacity, and spacing. For example, choosing Width from the Pen Pressure pop-up menu results in wider strokes when you apply more pen pressure.

Note: Speed can also be read when using a mouse rather than a stylus.

Using the Write On parameter, you can record a stroke so that it “draws” over time. In this case, a Write On Shape behavior is applied to the stroke using as its settings the time it took to draw the stroke and the speed at which each section of the stroke was created. These settings can be modified after the stroke is created. A Write On behavior can also be applied after a paint stroke has been created. For more information on using the Write On behavior, see “Animating Shapes” on page 1063.
To make a paint stroke:

1. Select the Paint Stroke tool (or press P).

   Important: The Paint Stroke tool HUD appears. Like the other drawing tool HUDs, this HUD is available only after the Paint Stroke tool is selected and before you create your stroke in the Canvas. The Paint Tool HUD allows you to determine the properties derived from the pressure and speed of the stylus before the stroke is drawn.

2. Define a paint stroke style in the HUD:
   - Choose an option from the Shape Style preset pop-up menu.
   - Modify the Brush Color and Width settings.

   If a preset is not used, a basic solid stroke is created. Once the stroke is created, you can still apply a preset to the stroke using the Inspector. Presets do not override the width or color of the stroke set in the HUD.

   Note: The Pen Pressure and Pen Speed parameters become available depending upon the chosen style. These parameters are not available with a solid brush type.

3. If you want to create a stroke that is drawn over time, select the Write On checkbox.

   When a paint stroke is created with the Write On checkbox selected, a Write On behavior is applied to the stroke. Like any other behavior, you can modify its parameters in the HUD or Inspector.

   For more information on using the Write On behavior, see “Animating Shapes” on page 1063.

4. Draw your stroke in the Canvas. Once the stroke is complete, press Esc or select the Select/Transform tool to exit paint mode.
The Paint Stroke Tool HUD is replaced with the Shape: Paint Stroke HUD. The Paint Stroke HUD parameters are identical to all other shape HUDs. Once a stroke is drawn, you must use the Inspector to modify parameters unique to the paint stroke and its dabs.

**Paint Stroke Tool HUD Parameters**

The Paint Stroke Tool HUD is displayed after the Paint tool is selected in the Toolbar and before a stroke is drawn. This HUD contains controls that define the color and width of the stroke, how pen pressure and speed affect the stroke (opacity, width, and so on), a checkbox that allows the stroke to be “drawn in” over time, smoothing controls, and a Shape Style pop-up menu for quick access to preset brush styles.

**Brush Color:** A color well, pop-up color palette, and eyedropper that sets the color of the brush. For more information on using the color controls, see the section about changing gradient colors on page 1035.

**Width:** A slider that defines the width of the paint stroke.

**Pen Pressure:** When using a stylus and tablet to create paint strokes, this pop-up menu allows you to determine stroke properties derived from the pressure of your pen prior to creating the stroke. The affected parameters include width, opacity, spacing, angle, and jitter. This parameter is not available for solid brush types.

**Note:** This parameter is not relevant when you are using a mouse.

- **Nothing:** Pen pressure is ignored.
- **Width:** The harder the pen pressure, the wider the stroke. To adjust the width of the dabs after the stroke is created, use the Width controls in the Stroke or Style pane.
- **Opacity:** The harder the pen pressure, the more opaque the stroke. To adjust the opacity of the dabs after the stroke is created, use the opacity controls in the Stroke pane.
- **Spacing:** The harder the pen pressure, the greater the spacing in between the stroke dabs. To adjust the spacing of the dabs after the stroke is created, use the Spacing controls in the Stroke or Style pane.
- **Angle:** The harder the pen pressure, the greater the angle of the stroke dabs. To adjust the angle of the dabs after the stroke is created, use the Angle controls in the Stroke pane.
- **Jitter:** The harder the pen pressure, the larger the amount of jitter on the stroke. Jitter randomizes the position of the paint dabs, giving the dabs a particle-like appearance. To adjust the jitter of the dabs after the stroke is created, use the Jitter controls in the Stroke pane.
**Pen Speed:** When you are using a pen and tablet or mouse to create paint strokes, this pop-up menu allows you to affect the stroke's width, opacity, spacing, angle, and jitter based on the speed of your pen strokes. This parameter is not available for solid brush types.

- **Nothing:** Pen speed is ignored.
- **Width:** The faster you move the pen, the more narrow the stroke; the slower you move the pen, the wider the stroke. To adjust the width of the dabs after the stroke is created, use the Width controls in the Stroke or Style pane.
- **Opacity:** The faster you move the pen, the less opaque the stroke. To adjust the opacity of the dabs after the stroke is created, use the opacity controls in the Stroke pane.
- **Spacing:** The faster you move the pen, the greater the spacing in between the dabs of the stroke. To adjust the spacing of the dabs after the stroke is created, use the Spacing controls in the Stroke or Style pane.
- **Angle:** The faster you move the pen, the greater the angle of the stroke dabs. To adjust the angle of the dabs after the stroke is created, use the Angle controls in the Stroke pane.
- **Jitter:** The faster you move the pen, the larger the amount of jitter on the stroke. Jitter randomizes the position of the paint dabs so they appear more like particles. To adjust the jitter of the dabs after the stroke is created, use the Jitter controls in the Stroke pane.

*Note:* You can affect multiple parameters on a single stroke, such as pressure affecting opacity and spacing. Choose an option before the stroke is created, such as Opacity. Once the stroke is created, apply a pen shape behavior to the stroke and apply the action to another parameter, such as Spacing. For more information on the pen shape behaviors, see “Using the Shape Behaviors” on page 1064.

**Write On:** This parameter allows a stroke to be “painted” on the Canvas over time. For more information, see “Animating Shapes” on page 1063.

**Smoothing:** Select this checkbox to create a smoother stroke with fewer control points.

**Shape Style:** A pop-up menu that allows you to apply a preset shape style (from the Library) to the selected shape. You can also save any custom shape style to the Library using this pop-up menu. Any stroke (shape) presets you have saved to the Library also appear in this list.

The lower portion of the Paint Stroke Tool HUD also contains a sketch area and a play button. This allows you to preview what a paint stroke effect will look like.
To preview the paint stroke in the Paint Stroke Tool HUD’s sketch area:

1. Click the Paint Stroke tool in the Toolbar.

2. Do one of the following:
   - Draw a stroke in the sketch area of the Paint Stroke Tool HUD to see a preview of the paint stroke.
   - Turn on the Write On checkbox, draw a stroke in the sketch area, then click the Play button to see a preview of the write-on stroke.
   - Choose a preset from the Shape Style pop-up menu.
     - If the preset is an animated stroke, the stroke is automatically drawn in the sketch area. Press the Play button to see the stroke animation again. Although a preset is selected, you can still draw your own preview of the stroke in the sketch area.

Note: To create a paint stroke that is “painted” on the Canvas over time (if your chosen preset is not animated), turn on the Write On checkbox in the HUD prior to drawing the paint stroke in the Canvas.

Important: Some operations, as well as the application of certain filters or a mask, cause a group to be rasterized. Because all paint strokes live in groups, this affects how strokes interact with other objects within your project. For more information, see “About Rasterization and Groups” on page 1115.

How to Edit Shapes

There are two ways to edit shapes. You can edit them in their entirety like any other object using the Transform, Pivot, Shear, Drop Shadow, or Four Corner tools, or you can adjust them point-by-point using the Adjust Control Points tool. The shape-editing techniques in this section apply to both shapes and masks.

You perform most of your detailed editing using a shape’s individual control points. The Transform, Pivot, and Shear transform tools are better for overall transformations of an entire shape. The following guidelines apply to all shape types: shapes, masks, and paint strokes.

Turning Dynamic Guides On or Off While Editing

The Canvas Dynamic Guides help you snap the selected points to one another. Use the following guidelines to turn Dynamic Guides off, so that snapping doesn’t interfere with subtle shape adjustments:
   - Press N to turn off the dynamic guides. Press N again to turn the Dynamic Guides back on.
   - Once you begin to move the selected control point, press Command to turn off snapping as you drag the point.
Note: If you press Command and then drag a control point, adjustable tangent handles are created. If you press Command and click a curved point, it turns into a corner point. For more information on editing Bezier curve control points, see “Editing Bezier Control Points” on page 1023.

To transform a Bezier or B-Spline shape:
1. Click the Select/Transform tool.
2. Click a shape.
3. Move, resize, or rotate the shape.

Note: To quickly enter control point adjustment mode (select the Adjust Control Points tool), double-click the shape.

When you move, resize, rotate, or shear a shape, you also transform its control points to match the new orientation of the shape.

For more information about how to perform object transformations, see “Using 2D Transforms” on page 264.

Displaying a Shape’s Control Points
There are several ways to display the control points of a shape to allow point-by-point editing in the Canvas.

To show a shape’s control points, do one of the following:
- Select the shape you want to edit, click the Select/Transform tool, then choose the Adjust Control Points tool from the pop-up menu.

The control points appear.
Click and hold the Select/Transform tool, choose the Adjust Control Points tool from the pop-up menu, then select a shape in the Layers list or Timeline layers list.

Control-click an object in the Canvas, then choose Edit Points from the shortcut menu.

**Note:** Overlays must be enabled in the View menu (or the Canvas View menu) in order to see the control points and outline of a shape. In addition, if Handles are turned off in the View > Overlays submenu (or the Canvas View menu), you cannot see a shape's Bezier or B-Spline control points when editing. When editing shapes, make sure that Handles are turned on.

Once you display a shape's control points, you need to select one or more control points to edit them.

While editing the control points of a shape, you can quickly select another shape and remain in control point adjustment mode. This allows for quick modification of another shape's control points.

**To select another shape in control point adjustment mode:**
- While editing a shape using the Adjust Control Points tool, click an unselected shape in the Canvas or Layers list.

The new shape is selected in control point adjustment mode.

**Selecting and Deselecting Control Points on a Shape**

The methods you can use to select and deselect points are similar to those available for selecting and deselecting shapes in the Canvas.

**To select one or more control points, do one of the following:**
- Click any control point.
- Drag a selection box over one or more points.
- Shift-click unselected control points to add them to the selection.
- Shift-drag a selection box around unselected control points to add them to the selection.

**To select every control point on a shape:**
- Choose Edit > Select All (or press Command-A).

**To deselect one or more selected control points, do one of the following:**
- Shift-click one or more selected points.
- Shift-drag a selection box over one or more selected points.

**To deselect every control point on a shape, do one of the following:**
- Click the Canvas anywhere outside the selected shape.
- Choose Edit > Deselect All (or press Shift-Command-A).
To select a specific control point (based on the order the shape is drawn):

- Click any control point to display its control point number.

Note: All shape control points are also listed by number in the Geometry tab of the Shape Inspector.

**Moving Control Points to Adjust a Shape**

Because the control points define the shape, simply move control points to change the shape.

**To move one or more control points:**

- Select one or more points, then drag them to a new position.

As you drag one or more selected control points, the rest of the shape automatically stretches or curves to accommodate the change.

![Selecting three points](image1.png) ![Moving all three points simultaneously](image2.png)

**To constrain the movement of selected points horizontally and vertically:**

1. Select one or more control points.
2. Press Shift while you drag one of the selected points either horizontally or vertically.

*Important:* Selected control points can only be moved—you cannot rotate, shear, or corner-pin them.

**Adding and Deleting Control Points**

If you did not create enough control points to make the shape you need, you can add more to the existing shape. You can also extend or close an open shape.

**To add control points to a selected shape:**

1. Select the Adjust Control Points tool.
2. Do one of the following:
   - Double-click or Option-click the edge of a shape to add a new control point.

*Note:* To add control points to a B-Spline shape, double-click or Option-click the B-Spline frame’s edge, rather than the edge of the shape itself.
• Control-click the edge, then choose Add Point from the shortcut menu.

Adding more control points does not immediately change a Bezier shape, unless you drag Bezier curve points as you create them.

Adding more control points to a B-Spline shape, on the other hand, nearly always changes its shape.

To add control points to the end of an open shape:
1 Select an open shape with the Adjust Control Points tool.
2 Option-click anywhere outside of the shape to add new control points to the end of the shape.
3 Option-click the first point in the shape to close it (or press C).
   The closed shape is not filled.

If a shape has more control points than are necessary, you can delete points from it to make it easier to edit. This can be helpful if you animate the shape later on.

To close an open shape, do one of the following:
• Option-click the first point in the shape to close it (or press C).
  The closed shape is not filled.
• Control-click a control point, then choose Close Curve from the shortcut menu.
Display the Geometry pane in the Shape tab of the Inspector, then select Closed. You can reopen the shape by deselecting the Closed checkbox.

**To create an open shape from a closed shape, do one of the following:**

- Control-click a point on the shape, then choose Open Curve from the shortcut menu. The segment before the point (in a clockwise order) is removed from the shape. If the originally closed shape was filled, the Fill checkbox remains selected. To disable the fill, deselect the Fill checkbox in the HUD or Style pane of the Shape Inspector.
- Select the shape and deselect the Closed checkbox in the Geometry pane of the Shape Inspector.

**Note:** The spline before the first point drawn is removed. To change the start point (the first point drawn) of the shape, Control-click a point and choose Set Start Point from the shortcut menu.

**To delete control points from a shape:**

1. Select a shape with the Adjust Control Points tool.
2. Select one or more points to delete, then do one of the following:
   - Choose Edit > Delete.
   - Control-click the selected points, then choose Delete Point from the shortcut menu.
   - Press Delete.

The shape changes to adjust to the missing point. If you remove points from a closed shape, the shape remains closed.

**Warning:** If you delete a point from a shape that already has a keyframed shape animation parameter in the Keyframe Editor, that control point is removed from the entire animation.
Locking Control Points
You can lock individual control points in a shape to fix them in place and prevent them from being accidentally adjusted. A shape with locked points can still be moved. Locking a control point simply prevents it from being adjusted while you edit a shape using the Adjust Control Points tool.

To lock and unlock points:
1. Choose the Adjust Control Points tool, then select a shape.
2. Control-click a control point, then choose Lock Point from the shortcut menu.
   If the point was unlocked, it becomes locked. If the point was locked, Unlock Point appears in the shortcut menu, and it becomes unlocked.

Editing Bezier Control Points
The methods used to adjust Bezier shapes are similar to those used by many other applications. Bezier control points are widely used to modify curves, and allow you to easily draw any shape you may need.

Each point in a Bezier shape can be toggled to act as a hard corner or as a curve.
To toggle control points between corners and curves, do one of the following:

- Command-click a curved point to turn it into a corner (Linear) point.
- Command-drag a corner point to turn it into a curved (Bezier) point, creating adjustable tangent handles.
- Control-click one or more selected points, then choose Linear or Smooth from the shortcut menu to change the control point type.

Curved Bezier control points have two tangent handles that you use to adjust the curvature of the shape on either side of the control point. These handles can be adjusted in a variety of ways to create symmetrical and asymmetrical curves. By default, these tangent handles are locked to one another at an angle of 180 degrees, although this can be overridden to allow each tangent to be independently adjusted.

**Important:** If Record (automatic keyframing) is turned on, turning a corner into a curve results in an animated effect of the corner gradually turning into the curve.

To adjust a Bezier curve using the control point's tangent handles, do one of the following:

- Drag a tangent handle to adjust its length. By default, the angle of each opposing tangent is locked to 180 degrees, and adjusting the angle of one tangent automatically adjusts the other. However, the length of each tangent can be independently adjusted.

- Option-drag either tangent to break the relationship between opposing tangents. Once this relationship is broken, adjustments to one tangent have no effect on the other, and both tangents can be rotated freely.

- Option-drag a broken tangent to temporarily lock the angle of the tangents together.
Control-click a handle control point and choose Break Handle from the shortcut menu to break the relationship between opposing handles.

Control-click a handle control point and choose Link Handle from the shortcut menu to lock the two handles in their current angle. The tangents now maintain their relationship when moved and rotated.

**Note:** You can also press Command-Option and drag a control point so the tangents maintain their broken relationship when moved and rotated.

Control-click a handle control point and choose Align Handles from the shortcut menu to align the tangents (but not lock them) to a 180-degree angle.

**Tip:** Press Shift while you adjust a tangent to constrain its movement to 45-degree angles.

To simultaneously modify the handles for more than one control point, Shift-select the points and then adjust the tangents.

**Important:** If Record (automatic keyframing) is enabled, curve adjustments are keyframed, creating animated shape changes.

**Editing B-Spline Control Points**
Editing the position of control points in B-Spline shapes is similar to editing Bezier shapes. In fact, the steps for selecting, moving, adding, deleting, and locking control points are almost exactly the same. The main difference in editing both types of shapes lies in how you manipulate and adjust curves.
The simplest, and usually fastest, way to manipulate B-Spline curves is to move one or more B-Spline points closer to or farther away from one another. When B-Spline points are moved closer to one another, a sharper curve is created. B-Spline points that are farther away from one another create shallower curves.

Each B-Spline control point tugs on a section of the shape, pulling it toward itself. As a result, you manipulate a shape’s curve by moving its control points in the direction you want to pull the shape. For example, notice how every control point creating the S curve below is offset in the direction of the curve it influences.

**Note:** You can show and hide the B-Spline frame lines that enclose B-Spline control points by choosing View > Overlays > Lines.

By default, B-Spline shapes have no corners. While this is the default behavior, you can adjust the amount of curvature at each individual B-Spline control point. This allows you to create sharper curves using fewer control points, even creating corners at a single point, if necessary.

The easiest way to adjust B-Spline point curvature is by switching among three preset degrees of curvature.
To switch a B-Spline control point among three degrees of curvature, do one of the following:

- Command-click one or more selected B-Spline control points to toggle three progressively sharper amounts of curvature.

- Control-click a B-Spline point, then choose Very Smooth, Smooth, or Linear from the shortcut menu.

You can also adjust B-Spline control points along a sliding scale by pressing the Command key and dragging.

**To adjust the amount of curvature in a B-Spline control point by dragging:**

- Command-drag one or more selected B-Spline control points to make their curves progressively sharper.
  - Dragging to the right makes the curve progressively sharper.
  - Dragging to the left makes the curve progressively looser.

**Note:** Once the handle appears, you can modify the curve without the Command key. Drag the handle to the right to make the curve sharper. Drag the handle to the left to make the curve looser.

If you later decide you don't like the B-Spline curve adjustment you made, you can always reset the degree of curvature by Command-clicking the point (or Control-clicking and choosing an option from the shortcut menu) to toggle it to the default curvature amount.

**Using a Shape Outline as a Paint Stroke**

You can convert a shape outline into a paint stroke by modifying the Brush Type in the Inspector. Once a shape outline is assigned a different brush type, all of the paint stroke parameters become available. You can modify and animate its brush parameters, as well as apply the Sequence Paint behavior.

**To convert an existing shape into an editable paint stroke:**

1. Select an existing shape.
2. In the Shape HUD or Inspector, select the Outline checkbox.
Modify any Outline parameter you want. In this example, the outline is widened and colored orange.

Note: A line shape has no fill and is a paint stroke upon creation.

If you don’t want the shape filled, deselect the Fill checkbox in the Shape HUD or Inspector.

Note: Solid must be chosen from the Brush Type pop-up menu in the Style pane of the Shape Inspector for the shape fill options to remain available.

Once Fill is turned off, the shape icon in the Layers list becomes a paint stroke icon.
4 In the Shape tab of the Inspector, choose Airbrush from the Brush Type pop-up menu.

Once the Brush Type is changed to Airbrush (or Image), the following occurs:

- The stroke softens because it is using a soft brush type. A paint stroke is comprised of *dabs* and the brush type is the source for the dabs. The brush profile can be modified to vary opacity within the brush. You can apply a custom opacity gradient to the brush profile.
- The Stroke pane becomes available. Use the Stroke pane to set the Stroke Color mode and Brush Scale parameters, and to adjust the Opacity, Spacing, Width, Angle, and other options.
- The Advanced pane becomes available. The Advanced pane contains a single group of controls that allow the dabs of a paint stroke to be animated like particles. For more information on Dynamics, see “Advanced Pane Controls” on page 1057.

*Note:* When a paint stroke is created using the Paint Stroke tool in the Toolbar, additional stylus parameters appear in the Advanced pane.

5 Use the controls in the Style, Stroke, and Advanced panes of the Shape Inspector to modify or animate your paint stroke.
For a complete description of these parameters, see “Style Pane Outline Controls” on page 1043, “Stroke Pane Controls” on page 1049, and “Advanced Pane Controls” on page 1057. In this example, the Additive Blend is enabled in the Style pane. Additionally, the Color Over Stroke, Spacing Over Stroke, Width Over Stroke, Brush Scale, and Brush Scale Randomness parameters are modified in the Stroke pane.

Illustrating Using the Shape Tools
You can use the shape tools to create anything from simple graphic elements to complex multi-shape illustrations. You can create lines or filled objects, manipulate their edge and fill characteristics, and combine and reorder the shapes into nested groups to produce complicated designs.

Although you can import vector artwork as PDF files, creating shapes and illustrations directly in your project gives you more options for integrating the result with the rest of your composition. Additionally, you can animate illustrations created directly within Motion using behaviors or keyframes, since each piece of the illustration is an individual layer with its own animateable parameters. You can also apply filters directly to layers within a project for even more creative possibilities.
Shape Parameters in the HUD

Once a shape (including paint strokes) is created and selected, the Shape HUD appears. Additional parameters appear in the HUD along with the standard Opacity, Blend Mode, and Drop Shadow controls. For more information on these standard parameters, see “Parameters in the Properties Tab” on page 280.

**Note:** Like all other layers, you can adjust the opacity of a shape (with its outline) in the Properties tab of the Inspector.

**Fill:** Select this checkbox to fill the shape with the color specified in the adjacent color well.

**Outline:** Select this checkbox to turn on an outline for the shape. By default, this option is off for closed shapes, and on for open shapes. When Outline is on, you can select the outline color with the adjacent color controls.

**Width:** Available when the Outline checkbox is selected, sets the width of the shape’s outline in pixels. This option is available only when the Outline checkbox is selected.

**Feather:** Drag this slider to feather (soften) the edges of a shape. Positive feathering values soften the edge of the shape from its edge outward. Negative feathering values soften the edge of a shape inward.

**Note:** You cannot feather a shape when the Outline checkbox is selected.

**Shape Style:** Choose an option from this pop-up menu to apply a preset shape style (from the Library) to the selected shape.

Shape Parameters in the Inspector

The Shape tab in the Inspector appears when you select a shape in the Canvas, Layers list, or Timeline. This tab contains the Style, Stroke, Advanced, and Geometry panes. These panes contain parameters that let you further customize the shape.
Style Pane Parameters
The Shape tab’s Style pane contains controls to modify the fill and outline of a shape, including changing the brush type for an outline or paint stroke. The parameters are grouped into two main categories of controls: Fill and Outline.

Shape Style: This pop-up menu allows you to apply a preset shape style (from the Shape Styles category in the Library) to the selected shape. In addition to the preset styles, any custom styles you have saved to the Library also appear in this list.

Style Pane Fill Controls
The Style pane contains the HUD parameters (listed above in “Shape Parameters in the HUD”), as well as other basic shape controls. These controls include outline brush controls, first and last point offset controls, and outline order. This section discusses the shape Fill controls, including the Gradient editor.

Fill: By default, this checkbox is selected for new closed shapes, which are filled with the color specified in the Fill color well.

Fill Mode: This parameter defines how a shape is filled. There are two options:
- Color: When this option is selected, the Fill Color controls appear and allow you to pick a color to fill the shape.
- Gradient: When this command is selected, the Gradient editor appears, as well as the Gradient preset pop-up menu.

The Gradient preset pop-up menu allows you to apply a preset gradient (from the Gradients category in the Library) to the selected shape. In addition to the preset gradients, any custom gradients you have saved to the Library also appear in this list. Click the disclosure triangle to the left to display the Gradient editor, which you can use to create your own custom gradients.

For complete instructions on using the Gradient editor, see “Using the Gradient Editor” on page 1033.

Note: The controls for the Gradient editor are identical to the gradient controls for text, with one exception. The text gradient parameters include a dial to control the angle of the gradient. The shape gradient parameters use Start and End point controls, which are available in the Inspector or in the onscreen controls.
Fill Color: These controls let you pick a color fill for the shape. To define a color, do one of the following:

- Click the disclosure triangle to the left to display Red, Green, and Blue sliders that allow you to choose a color mix.
- Click the color well to use the Colors window to select a color.
- Click the triangle to the right of the color well to display the pop-up color palette. Drag the eyedropper in the palette to select a new color. Drag in the lower palette to select a grayscale color.
- Click the eyedropper tool, and then click a color in the Canvas.

Fill Opacity: Adjusts the opacity of the fill (independently of the outline, if enabled).

Feather: A slider that feathers (softens) the edges of a shape. Positive feathering values soften the edge of the shape from its edge outward. Negative feathering values soften the edge of a shape inward from the edge.

Note: You cannot feather an object when the Outline checkbox is selected.

Using the Gradient Editor
Use the Gradient editor to change the color, color position, number of colors, opacity, direction, and interpolation of a gradient. The color and opacity of a gradient can be animated.

This section discusses the Gradient editor in the Inspector. For information on using the Gradient editor onscreen controls, see “Using the Onscreen Gradient Controls” on page 1040.

Color: Sets the color of the selected gradient tag.
Opacity: Sets the transparency of the selected opacity tag (in the bar above the gradient bar). The opacity tags control the opacity of the gradient. You can add multiple opacity tags to create a gradient of varying levels of transparency. By default, the opacity of a gradient is 100%.

Interpolation: Sets the interpolation of the gradient tag to Constant, Linear, or Continuous.

- **Constant**: Creates a constant color distribution between two color or opacity tags. For example, if the left color tag in a three-color, left-to-right gradient is set to Constant, the gradient from the left tag to the center tag is solid.

- **Linear**: Creates a uniform distribution of color or opacity between two color or opacity tags.

- **Continuous**: Creates a gradual color or opacity transition between two color or opacity tags.

Location: Sets the location of the selected gradient color or opacity tag or spread control.

Type: This pop-up menu allows you to choose a linear or radial gradient.

- **Linear**: Creates a linear gradient.

- **Radial**: Creates a radial gradient.

Start: Value sliders that set the start position of the gradient. This parameter affects the gradient as a whole—colors and opacity. X position is the left value slider and Y position is the right value slider. Click the disclosure triangle to display the individual X and Y parameters.

End: Value sliders that set the end position of the gradient. This parameter affects the gradient as a whole—colors and opacity. X position is the left value slider and Y position is the right value slider. Click the disclosure triangle to display the individual X and Y parameters.
**Feather:** Use the slider or value field to soften the gradient fill. Positive values soften the shape outward; negative values soften the shape inward.

**Important:** The following sections assume that the shape is selected and Gradient is chosen from the Fill Mode pop-up menu in the Style pane of the Shape Inspector.

**To change gradient colors:**
1. Click the Gradient disclosure triangle to show the Gradient editor.

2. To change the color of a color tag in the Gradient editor, do one of the following:
   - Double-click a color tag.
   - Click a color tag to enable the Color controls for the selected color, and then click the color well. The Colors window appears.
• Click a color tag, then use the individual Red, Green, or Blue color channel slider.

Red gradient color tag is selected

• Click a color tag, then click the triangle next to the color well to display the pop-up color palette. Drag the eyedropper in the palette to select a new color. Drag in the lower palette to set the tag to a grayscale color.
• Click a color tag, then Control-click the color well to display the pop-up color palette.
• Click a color tag, click the eyedropper tool, then click a color in the Canvas.

To move the position of a color or opacity tag:
1. Click the color or opacity tag you want to move.
2. Do one of the following:
   • Drag the tag left or right.

   Drag the color tag to change position of the color.

   Location slider

• In the Location parameter, use the slider or value field to enter a specific value. A value of 100% is the rightmost position of the gradient, and a value of 0% is the leftmost position of the gradient.

To change the spread of the gradient color or opacity:
• Drag the small triangle between the color or opacity tag to change the location of the spread. The closer the spread control is to a tag, the sharper the color or opacity spread.
The Location parameter is also updated as you move the spread control, indicating its position on the gradient.

**Note:** The Spread control does not appear for color or opacity tags that are set to Linear or Constant.

**To change the color or opacity tag interpolation, do one of the following:**
- Control-click a tag, then choose Constant, Linear, or Continuous from the shortcut menu.
- Click a tag, then choose Constant, Linear, or Continuous from the Interpolation pop-up menu.

**To add a color tag to a gradient:**
- To add a new color tag, position the pointer in the lower color bar where you want to add the new color, then click.
  A new color tag is added to the gradient.

**Note:** Although the colors, opacity, and position of the tags of a gradient can be animated, the number of color and opacity tags cannot.

**To add an opacity tag:**
- Position the pointer in the opacity bar where you want to add the new tag, then click.
  A new opacity tag is added to the gradient.

Until the value is adjusted, the gradient opacity is 100%.

**To duplicate a color or opacity tag:**
- Option-drag the tag to its new position.

**To remove a color or gradient tag from the gradient:**
- Drag the tag away from the gradient bar.
To change the opacity of a gradient color:

1. Click an opacity tag.

   The opacity controls are enabled.

2. Use the slider or value field to change the value of the opacity.

   The lower the percentage of the opacity, the greater the transparency.

   The gradient transparency reflects the new opacity values.

**Editing Color and Opacity Direction and Distribution**

You can quickly reverse the direction or evenly distribute the gradient color and opacity tags.

**To reverse the gradient color or opacity direction:**

- Click the Reverse Tags icon next to the opacity or color gradient.

   The tags are reversed.

**To evenly distribute the gradient color or opacity tags:**

- Click the Distribute Tags icon next to the opacity or color gradient.
To change the direction of a shape’s gradient:
1. With the shape selected, click the Gradient disclosure triangle to show the Gradient editor.
2. Use the Start and End value sliders to change the direction of the gradient. The left value slider is X and the right value slider is Y.

**Saving Gradient Presets**
As with shape styles, once you have created a gradient, you can save it in the Library.

**To save a gradient in the Library:**
1. Select the text with the gradient you want to save.
2. Choose Save Gradient from the Gradient preset pop-up menu.
3. In the Save Preset To Library dialog, type the name of the gradient.
4. Click Save.
The custom gradient appears in the Gradients category in the Library. Custom presets can be identified in the Library by the small user icon that appears in the lower-right corner of the larger gradient icon. The new gradient also appears in the Gradient preset pop-up menu.

Like the preset gradients, a preview of the gradient appears in the Preview area when the gradient is selected in the stack.

**Using the Onscreen Gradient Controls**

Onscreen controls provide a more interactive way to edit a gradient’s color, location of the color and opacity tags, opacity, and start and end points. You can also add color and opacity tags, as well as change their interpolation.

**To display the onscreen gradient controls:**
- In the Canvas, Control-click the object with the applied gradient, then choose Edit Gradient from the shortcut menu.
  
  The onscreen controls appear.

**To adjust the start and end gradient positions:**
- To adjust the Start X and Y position of the gradient, drag the top triangle (at the end of the gradient line).
- To adjust the End X and Y position of the gradient, drag the bottom triangle (at the end of the gradient line).
To change the location of the gradient tags:
- To change the location of the gradient color, drag the color tags along the gradient line.
- To change the location of the gradient opacity, drag the opacity tags along the gradient line.

To remove a color or opacity tag:
- Drag the color tag or opacity tag away from the onscreen controls and release the mouse button.

To add a color tag, do one of the following:
- Control-click the gradient control line at the location you want the new tag, then choose Add Color Tag from the shortcut menu.
- Double-click or Option-click the gradient control line at the location you want the new tag.

To duplicate a color or opacity tag:
- Option-drag the tag to its new position.

To change the color of a gradient tag:
- Control-click the tag, then drag the eyedropper in the pop-up color palette to select a new color. As you drag over the color spectrum, the gradient color is actively updated.
To add an opacity tag, do one of the following:
- Control-click the gradient control line at the location you want the new tag, then choose Add Opacity Tag from the shortcut menu. By default the new tag is set to 100% opacity.
- Shift-Option-click the gradient control line at the location you want the new tag.

To change an opacity tag's transparency:
- Control-click the tag, then drag the eyedropper in the pop-up palette to set a new opacity value for the tag. White represents more opaque values, progressively darker levels of gray represent decreasing opacity, and black represents complete transparency. As you drag over the spectrum, the gradient is actively updated.

To change a color tag's interpolation:
- Control-click the line next to the tag, then choose Constant, Linear, or Continuous from the Color Interpolation submenu.

To change an opacity tag's interpolation:
- Control-click the line next to the tag, then choose Constant, Linear, or Continuous from the Opacity Interpolation submenu.

To reverse the direction of the color gradient:
- Control-click the gradient control line, then choose Reverse Color from the shortcut menu.

To reverse the direction of the opacity gradient:
- Control-click the gradient control line, then choose Reverse Opacity from the shortcut menu.

To evenly distribute the gradient color tags:
- Control-click the gradient control line, then choose Distribute Color from the shortcut menu.

To evenly distribute the gradient opacity tags:
- Control-click the gradient control line, then choose Distribute Opacity from the shortcut menu.

To apply a preset gradient style:
- Control-click the gradient control line, choose Presets from the shortcut menu, and then choose a preset style from the list.

To remove an opacity or a color tag:
- Drag the tag away from the gradient onscreen controls and release the mouse button.
Style Pane Outline Controls
The shape Outline controls allow you to customize the outline of a shape. You can create a solid outline or use the outline as a paint stroke. When you select the Outline checkbox, the Brush Type, Brush Color, Brush Opacity, Width, First and Last Point Offsets, Order, and other controls become available.

Outline: When this checkbox is selected, the shape outline appears in the Canvas and the outline controls become available. By default, this checkbox is off for closed shapes and on for open shapes and paint strokes.

Brush Type: This pop-up menu lets you choose a Solid, Airbrush, or Image brush to create the outline.

- Solid: The default setting, creates a solid outline along the splines of a shape or creates a solid paint stroke.
• **Airbrush**: Creates an outline made up of editable brush strokes referred to as *dabs*. You can set the dabs to be close together so that the line appears solid, or you can space the dabs further apart. When Brush Type is set to Airbrush, the Stroke and Advanced panes become available in the Shape Inspector.

![Airbrush Example](image)

• **Image**: Allows you to use a layer as a dab source. When Brush Type is set to Image, the Stroke and Advanced panes become available in the Shape Inspector.

![Image Example](image)

**Brush Color**: Lets you pick a color to use for the outline or paint dabs. These color well controls are identical to the shape Fill color wells (and all color wells throughout Motion).

*Note*: When Stroke Color Mode (in the Stroke pane) is set to Color Over Stroke or Pick From Color Range, Brush Color is not available.

**Opacity**: Defines the opacity of the entire stroke, regardless of the Brush Type setting.

*Note*: When Stroke Color Mode (in the Stroke pane) is set to Color Over Stroke or Pick From Color Range, the Brush Opacity parameter is unavailable.

*Note*: When Brush Type is set to Airbrush or Image, you can adjust the opacity, in the Stroke pane, to change over the course of the stroke. For more information on using the Opacity Over Stroke parameter, see “Stroke Pane Controls” on page 1049.
This parameter allows you to define a different opacity value for a shape and its outline.

**Outline opacity set to 100%**

**Outline opacity set to 50%**

**Width:** A slider that changes the width of a shape’s outline or width of a paint stroke’s dabs.

**Note:** If you used the pressure parameters in the Paint Stroke Tool HUD to create variations in the stroke when the stroke was created, adjusting the Width parameter affects the width of the stroke uniformly.

**Spacing:** Available for the Airbrush and Image brush types, this parameter defines the space in between outline dabs. A lower number creates a more solid line, and a higher number creates a greater distance in between dabs.

**Additive Blend:** By default, dabs are composited together using the Normal blend mode. Select this checkbox to composite all overlapping dabs together using the Additive blend mode. This blend mode occurs in addition to whichever compositing method is already being used. This parameter is only available when Brush Type is set to Airbrush or Image.

**Reverse Stacking:** Available when Brush Type is set to Airbrush or Image, this parameter inverts the order in which the dabs are stacked. To see the effect of this parameter, dabs must be overlapping.

**First Point Offset:** This parameter allows you to offset and animate the start point of the outline. This is very useful for effects such as drawing a line across a map over time.

You can also use the Shape Write On behaviors to draw a stroke or outline over time. For more information, see “Animating Shapes” on page 1063.

**Last Point Offset:** This parameter allows you to offset and animate the end point of the outline.

**Order:** A pop-up menu lets you choose whether an outline is drawn over or under the shape fill color or gradient. The effect is more apparent with thicker outline widths.
• **Over Fill:** Outlines appear on top of the selected fill of the shape.
• **Under Fill:** Outlines are obscured beneath the selected fill of the shape.

**Solid Brush Additional Parameters**
The following parameters are available when Solid is the selected Brush Type.

**Preserve Width:** When this checkbox is selected, the defined width of the outline/stroke does not change when the shape is scaled. This option is only available when Solid is the selected Brush Type.

**Joint:** When Solid is the selected Brush Type, this pop-up menu lets you choose how hard corners on a shape's outline are drawn. There are three options:
• **Square:** All corners are squared off.
• **Round:** All corners are rounded.
• **Bevel:** All corners are cut at an angle.

**Start Cap:** A pop-up menu that lets you choose the shape of an outline's start cap. This option is only available when Solid is the selected Brush Type.

**End Cap:** A pop-up menu that lets you choose the shape of an outline's end cap. This option is only available when Solid is the selected Brush Type.
There are four options:

- **Square**: The cap is squared off.
- **Round**: The cap is rounded.
- **Bevel**: The cap is cut at an angle.
- **Arrow**: The cap is a customizable arrow.
  - **Arrow Length**: Adjust the sliders to set the length of the arrow.
  - **Arrow Width**: Adjust the sliders to set the width of the arrow.

**Airbrush Additional Parameters**
The following parameters are available when Airbrush is the selected Brush Type.

**Brush Profile**: Available when Airbrush is the selected Brush Type, the brush profile is a gradient editor that allows you to create varying levels of opacity within the brush. The brush profile uses the same opacity controls as a standard gradient editor. For more information, see “Using the Gradient Editor” on page 1033.

![Image showing Airbrush Profile and example gradient].

The default gradient creates a soft airbrush.

Modify the Brush Profile opacity gradient to create new brush looks.

**Image Brush Additional Parameters**
The following parameters are available when Image is the selected Brush Type.

**Brush Source**: When Image is the selected Brush Type, drag a layer into the Brush Source image well for use as the outline's brush source. You can use images, image sequences, QuickTime movies, text, and shapes as the brush source.

When a movie is the brush source, additional parameters appear:
- **Play Frames**: A checkbox that controls playback. If the checkbox is selected, it loops the playback of the animation or movie clip. If it's turned off, the paint dabs use the still frame specified by either the Random Start Frame parameter or the Source Start Frame parameter.

- **Random Start Frame**: A checkbox that introduces variation using QuickTime objects as the dabs' source objects. If the checkbox is selected, each dab begins at a different frame of the animation. Stills are chosen randomly if the Play Frames checkbox is deselected.

- **Source Start Frame**: This mini-curve editor allows you to define the frame at which playback of the source clip begins in the paint dabs. The Source Start Frame default keyframe value is 0, at which playback starts from frame 1. You can simply change the start frame for all dabs, or you can create a curve so that start frames vary over the length of the stroke (different dabs use different start frames). For example, if the first Source Start Frame value is 50, each dab begins playback at frame 50. If you create an animation curve that begins at 50 and ends at 250, each dab begins clip playback at a progressively later frame.

  The Play Frames checkbox must be selected in order for playback to occur. If Play Frames is turned off, you can display different still frames over the length of the stroke. This parameter only appears if Random Start Frame is turned off.

  **Note**: For information on using the mini-curve editors, see “Mini-Curve Editor” on page 555.

- **Source Start Frame**: Use the sliders or enter a number into the value fields to change the value of the selected keyframe.

- **Stroke Length**: Stroke Length is mapped horizontally on the mini-curve editor graph and provides a visual representation of the position of the changes in start frame value (keyframes) over the length of the stroke. Use the sliders or enter a number into the value field to change the value of the selected keyframe.

- **Hold Frames**: Sets the number of times each frame of the source movie is repeated during playback. The larger the Hold Frames value, the slower your playback.

- **Hold Frames Randomness**: Varies the number of frames to “hold.”

  **Note**: Although you can drag a particle emitter, replicator, or a group that contains an emitter or replicator into the Brush Source well, keep in mind that your project interactivity will slow drastically.
Stroke Pane Controls

Once an airbrush or image paint stroke has been created using the Paint Stroke tool, a set of paint stroke controls becomes available, combining controls similar to those of a particle system or replicator. Use these controls to set the Stroke Color Mode and Brush Scale parameters, and to adjust the Opacity, Spacing, Width, and Angle Over Stroke parameters.

The Width Over Stroke parameter can be adjusted directly on the selected paint stroke in the Canvas. For information, see "Using the Width Over Stroke Onscreen Controls" on page 1053.

**Stroke Color Mode:** Use this pop-up menu to specify how the color is applied to the stroke over its length. There are three options: Use Brush Color, Color Over Stroke, and Pick From Color Range.

- **Use Brush Color:** Uses the color of the brush as defined by the Brush Color parameter in the Style pane. The stroke is a solid color over its length. When you choose Use Brush Color from the Stroke Color Mode pop-up menu, the Opacity Over Stroke control becomes available:
Opacity Over Stroke: An opacity control that appears when Stroke Color Mode is set to Use Brush Color. Use it to change the opacity of dabs based on their location on the stroke. This gradient control is limited to grayscale values, which are used to represent varying levels of transparency. White represents solid dabs, progressively darker levels of gray represent decreasing opacity, and black represents complete transparency. A simple white to black gradient represents a stroke that is solid at its start, but that fades out gradually over its length until finally vanishing at the end. For information on using the Gradient editor, see “Using the Gradient Editor” on page 1033.

Use the gradient preset pop-up menu to load a custom opacity gradient into the gradient editor.

Note: None of the default gradients have opacity gradients. If a color gradient preset is selected, it has no effect on the opacity gradient.

• Color Over Stroke: The second option in the Stroke Color Mode pop-menu. Dabs are tinted based on their position over the paint stroke. A gradient editor defines the range of color of the stroke, beginning with the leftmost color in the gradient, and progressing through the range of colors until reaching the rightmost color at the end of the stroke. Gradual color changes do not appear in each dab, only across the stroke as a whole. An opacity bar appears at the top of the gradient editor. For information on using the gradient editors, see “Using the Gradient Editor” on page 1033.
• **Color Repetitions**: Drag this slider to increase the number of times the gradient is repeated over the stroke.

• **Pick From Color Range**: The third option in the Opacity Over Stroke pop-up menu. Dabs are tinted at random, with the range of possible colors defined by a gradient editor. A point on the gradient is randomly chosen, so the relative sizes of each color region determine the frequency of the color being used. When you choose Color Over Stroke from the Stroke Color Mode pop-up menu, the Color Range control becomes available:

  **Color Range**: A gradient editor that appears when the Stroke Color Mode is set to Pick From Color Range. Use it to define a range of colors used to randomly tint the stroke’s paint dabs. The direction of the gradient colors is not relevant, only the number of colors that appear within the gradient. The Color Range parameter has the same controls as the Color Over Stroke parameter. For information on using gradient editors, see “Using the Gradient Editor” on page 1033.

**Spacing Over Stroke**: This mini-curve editor allows you to customize the spacing of the dabs over the length of the stroke. You can create a curve that gradually increases the dabs’ spacing over the length of the stroke; create a curve that varies the dabs’ spacing over the length of the stroke, and so on. Select or add a keyframe in the graph to make changes to the Spacing Over Stroke and Stroke Length parameters. In the following illustrations, the default value of 100% creates an even distribution of the dabs—based on the value set in the Spacing parameter in the Style pane.
In the following illustrations, the Spacing Over Stroke curve is adjusted so that a greater value is used at the start of the stroke, and 100% is used at the end of the stroke. The dabs at the beginning of the stroke are spaced more widely apart and get closer at the end of the stroke.

Two parameters let you fine-tune the curve in the graph:

- **Spacing Over Stroke**: Use the sliders or enter a number in the value field to change the value of the selected keyframe.

- **Stroke Length**: Stroke Length is mapped horizontally on the mini-curve editor graph and provides a visual representation of the position of the changes in spacing value (keyframes) over the length of the stroke. Use the sliders or enter a number in the value field to change the value of the selected keyframe.

**Note**: For information on using the mini-curve editors, see “Mini-Curve Editor” on page 555.

**Fixed Brush Dabs**: When animating brush strokes using behaviors or keyframes, selecting the Fixed Brush Dabs checkbox keeps the number and spacing of the dabs constant regardless of the changes in the stroke’s shape over time.

**Anchor Dabs To**: This parameter, available when the Fixed Brush Dabs checkbox is turned off, defines whether dabs are added to or removed from the start point or the start and end points of a paint stroke when the length of the paint stroke is modified. When the Fixed Brush Dabs checkbox is turned on, dabs are anchored to the start and end of the paint stroke.

**Note**: Changing a shape’s control points or adjusting the Width or Spacing parameters (in the Style pane) or Spacing Over Stroke and Width Over Stroke parameters (in the Stroke pane) affect the dab spacing because larger dabs can be spaced further apart.
**Width Over Stroke:** This mini-curve editor allows you to customize the width of the dabs over the length of the stroke. You can create a curve that gradually increases the dabs' width over the length of the stroke, create a curve that varies the dabs' width over the length of the stroke, and so on. Select or add a keyframe in the graph to make changes to the Width Over Stroke and Stroke Length parameters. The start value for the dab width is based on the value set in the Width parameter in the Style pane.

- **Width Over Stroke:** Use the sliders or enter a number in the value field to change the value of the selected keyframe.
- **Stroke Length:** Stroke Length is mapped horizontally on the mini-curve editor graph and provides a visual representation of the position of the changes in width value (keyframes) over the length of the stroke. Use the sliders or enter a number in the value field to change the value of the selected keyframe.

**Using the Width Over Stroke Onscreen Controls**

You can adjust the Width Over Stroke keyframe values directly in the Canvas. An editable control appears at each keyframe in the stroke.

**To use the onscreen Width Over Stroke controls:**

1. In the Canvas, Control-click the paint stroke, then choose Stroke from the shortcut menu.
   Small control points (+) appear at each keyframe over the stroke. The red paint guideline also appears.
2. Click the plus sign (+) that represents the keyframe you want to adjust.
   Control handles appear on either side of the control point.
3. To increase the width of the dabs, drag away from the point; to decrease the width of the dabs, drag toward the point.
4. To change the position of a width keyframe, drag the point along the length of the stroke. Keyframes can be dragged over one another.
   The mini-curve editor is updated as you make your onscreen adjustments.
**Brush Scale:** A slider and value field that allow you to change the size of the brush (the source of the dabs). Click the disclosure triangle to adjust the X and Y scale values independently. By default, Scale is set to 100%—the size of the dabs is equal to the size of the source brush.

**Brush Scale Randomness:** Defines an amount of variance in the scale of the stroke’s brush. A value of 0 results in no variance—all dabs in the stroke are the same size. A value greater than 0 introduces a variance. The scale for an individual dab is defined by the Scale parameter, plus or minus a random value falling within the Brush Scale, Width Over Stroke, and Width (in the Style pane) parameters. Click the disclosure triangle to adjust the X and Y values independently.

**Align Brush Angle:** When this checkbox is selected, the stroke dabs automatically rotate to match the shape on which they are positioned.

**Brush Angle:** Specifies (in degrees) the rotation of the stroke dabs. Using the default dial or value slider (when the disclosure triangle is closed), the Z angle is affected. To individually modify the rotation of the pattern elements in X, Y, and Z space, click the disclosure triangle.

- **Animate:** This pop-up menu allows you to change the interpolation for animated 3D rotation channels. By default, Animate is set to Use Rotation. For more information about the Animate parameter, see “Parameters in the Properties Tab” on page 280.

**Angle Over Stroke:** This mini-curve editor allows you to customize the Z rotation (in degrees) of the dabs over the length of the stroke. You can create a curve that gradually increases the dabs’ angle over the length of the stroke, a curve that varies the dabs’ angle over the length of the stroke, and so on. Select or add a keyframe in the graph to make changes to the Angle Over Stroke and Stroke Length parameters.

- **Angle Over Stroke:** Use the dial or value slider to change the value of the selected keyframe.
• **Stroke Length**: Stroke Length is mapped horizontally on the mini-curve editor graph and provides a visual representation of the position of the changes in angle value (keyframes) over the length of the stroke. Use the sliders or enter a number in the value field to change the value of the selected keyframe.

**Brush Angle Randomness**: Defines an amount of variance in the rotation of the stroke dabs. A value of 0 results in no variance—all dabs have the same rotational value. A value greater than 0 introduces a variance. The angle for an individual dab is defined by the Brush Angle and Angle Over Stroke parameters, plus or minus a random value falling within the Brush Angle Randomness.

Using the default dial or value slider (when the disclosure triangle is closed), the Z angle is affected. To individually modify the rotation of the dabs in X, Y, and Z space, click the disclosure triangle.

• **Animate**: This pop-up menu allows you to change the interpolation for animated 3D rotation channels. By default, Animate is set to Use Rotation. For more information about the Animate parameter, see “Parameters in the Properties Tab” on page 280.

**Local 3D**: This checkbox allows you to take advantage of Motion’s 3D workspace. When the Local 3D checkbox is selected, the following become possible:

• When the Face Camera checkbox is selected, paint dabs actively face the camera when the camera or stroke is rotated and/or animated.

• When the Dab Depth Ordered checkbox is selected, dab ordering remains consistent when the paint stroke is rotated in X or Y space. When not selected, the dabs jump in front of each other each time the stroke rotates 180 degrees.

• When the Dynamics checkbox is selected in the Advanced pane, a paint stroke acts similarly to an emitter—the dabs become particles. When the Local 3D checkbox is selected, the dabs are animated in 3D space. When the Local 3D checkbox is deselected, the particles are animated in X and Y space only. For more information on Dynamics, see “Advanced Pane Controls” on page 1057.

• When the Dynamics checkbox is selected in the Advanced pane, dabs can be pulled out of their plane when certain Simulation behaviors are applied. For example, if a paint stroke has an applied Attracted To behavior (with the Affect Subobjects checkbox selected), and the target layer is in a different location in Z space, the dabs are pulled into Z space and move toward the target layer. The paint stroke must be a member of a 3D group to be pulled out of the X and Y planes by a behavior.

**Note**: Even in a 2D project, a paint stroke’s general properties can be adjusted in 3D space. For example, you can modify the Z parameter using the Position, Scale, Rotation, and Anchor Point controls in the Properties tab of the Inspector.
**Important:** Although the Local 3D checkbox is turned on, paint strokes do not intersect with the "global" 3D world. This means that paint strokes can exist in 3D space, but do not intersect with objects that exist inside their own group, or objects in other groups. A 3D paint stroke is composited with the rest of the objects in the project based on layer order.

**Note:** Lighting has no effect on 3D paint strokes.

**Face Camera:** When this checkbox is selected, the stroke dabs actively face the camera if the camera is rotated or if the paint stroke is rotated and/or animated. When the Face Camera checkbox is deselected, the elements face forward in the replicator pattern and appear flat (unless the source layer or paint dabs are rotated in 3D space).

**Note:** The Face Camera checkbox is available only when the Local 3D checkbox is selected.

Because paint source dabs are 2D (flat) objects, the pattern elements are not visible when you use the orthogonal camera views, such as Left, Right, and Top (unless the source layer or dabs are rotated in 3D space). This is because orthogonal views are at right angles (perpendicular) to the elements. For more information on using cameras, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.

**Dab Depth Ordered:** When this checkbox is selected, paint dab ordering remains consistent when the paint stroke is rotated in X or Y space. When not selected, the dabs jump in front of each other each time the stroke rotates 180 degrees.

**Note:** The Dab Depth Ordered checkbox is available only when the Local 3D checkbox is selected.

**Jitter:** This slider and value field allow you to create a little chaos in your paint dabs. The higher the value, the more dispersed the dabs. Click the disclosure triangle to display the individual X and Y controls. Jitter can be animated so that the dabs behave like particles.

- **X:** Moves the dabs parallel to the stroke's curves at its control points.
- **Y:** Moves the dabs perpendicular to the stroke's curves at its control points.

**Jitter Over Stroke:** This mini-curve editor allows you to customize the scatter of the dabs over the length of the stroke. You can create a curve that gradually increases the dabs' jitter over the length of the stroke, a curve that varies the dabs' jitter over the length of the stroke, and so on. Select or add a keyframe in the graph to make changes to the Jitter Over Stroke and Stroke Length parameters.

- **Jitter Over Stroke:** Use the sliders or enter a number in the value field to change the value of the selected keyframe.
• **Stroke Length**: Stroke Length is mapped horizontally on the mini-curve editor graph and provides a visual representation of the position of the changes in jitter value (keyframes) over the length of the stroke. Use the sliders or enter a number in the value field to change the value of the selected keyframe.

![A green line represents the stroke length.]

**Random Seed**: The variation of the Jitter, Brush Angle Randomness, and Brush Scale Randomness parameters (in the Stroke pane) and the Life, Speed, and Spin Randomness parameters (in the Advanced pane) are based on the number shown here. If you don’t like the current random distribution of the dabs, you can change the seed number by typing a new number or clicking Generate. The Jitter value must be 1 or more for this parameter to have any effect.

**Advanced Pane Controls**
The Advanced pane of the Shape tab contains controls that allow the dabs of a paint stroke to be animated like particles. Unlike particles, dabs are only “born” one time, but age and die like particles. Dynamic dabs share several controls with particles, such as Emission Angle, Life, Speed, and Spin. When Dynamics is turned off, dabs are immortal.

When you select a shape created with the Paint Stroke tool, Pen Pressure and Pen Speed controls appear in the Advanced pane.

**Note**: All of the Dynamics controls can be animated using keyframes or by applying Parameter behaviors to the individual parameters.

**Dynamics**: When this checkbox is selected, the dabs of a paint stroke become particles.

**Note**: When a Simulation behavior is applied to a paint stroke, the Affect Subobjects parameter only appears in the behavior if Dynamics is turned on for the paint stroke.

**Emission Angle**: A dial and value slider that set the direction in which the paint dabs travel. This parameter works in conjunction with the Emission Range parameter.
**Emission Range:** A dial and value slider that restrict the area in which the dabs travel, in the direction of the Emission Angle. Setting the Emission Range parameter to 0 degrees keeps dabs perpendicular to the paint stroke.

**Life:** A slider that defines the duration of each dab, in seconds. This specifies how long each dab lasts before disappearing. This is similar to how sparks disappear after flying away from a sparkler.

**Life Randomness:** A slider and value field that define an amount of variance in the life of the paint dabs. A value of 0 results in no variance—all dabs from the selected stroke share the same life span. A value greater than 0 introduces a variance defined by the Life parameter, plus or minus a random value falling within the Life Randomness value.

**Speed:** A slider and value field that defines initial speed, determining how quickly each dab flies away from the stroke.

**Speed Randomness:** A slider and value field that define an amount of variance in the speed of the paint dabs. A value of 0 results in no variance—all dabs from the selected stroke move with the same speed. A value greater than 0 introduces a variance defined by the Speed parameter, plus or minus a predetermined random value falling within the Speed Randomness value.

**Spin:** A dial and value slider that animate the dabs of a paint stroke by initially spinning each individual dab around its center. Adjustments to this control are in degrees per second.

**Spin Randomness:** A dial and value slider that define an amount of variance in the spin of the paint dabs. A value of 0 results in no variance—all dabs from the selected stroke spin at the same rate. A value greater than 0 introduces a variance defined by the Spin parameter, plus or minus a random value falling within the Spin Randomness value.

**Pen Pressure:** This parameter appears only when a stroke is created using the Paint Stroke tool in the Toolbar. It allows you to affect the width, opacity, spacing, angle, or jitter of the paint stroke based on the pressure of your stylus on the tablet when the stroke was created. This parameter only appears when a stroke is created using the Paint Stroke tool and a stylus and tablet.

These controls are identical to the Apply Pen Pressure (Shape behavior) parameters. For a description of the Pen Pressure parameters, see “Apply Pen Pressure” on page 1064.

**Pen Speed:** This parameter appears only when a stroke is created using the Paint Stroke tool in the Toolbar. It allows you to affect the width, opacity, spacing, angle, or jitter of the paint stroke based on the speed of your stylus on the tablet when the stroke was created. This parameter only appears when a stroke is created using the Paint Stroke tool and a stylus and tablet.
These controls are identical to the Apply Pen Speed (Shape behavior) parameters. For a description of the Pen Speed parameters, see “Apply Pen Pressure” on page 1064.

**Geometry Pane Controls**
The Shape Inspector’s Geometry pane controls allow you to change the shape type, to close or open a shape, and to individually adjust the position of a shape’s control points using value sliders.

**Shape Type:** Use this pop-up menu to change the type of control points that are used to define the shape. For example, if you originally created a Bezier shape, you can choose B-Spline from this menu to change each Bezier control point into a B-Spline control point. Changing the shape type does not move the control points, although the shape is changed, sometimes dramatically.

- **Linear:** All control points are joined by hard angles, and the resulting shape is a polygon. The control points of a Linear shape lie directly on its edge.
- **Bezier:** Control points can be a mix of Bezier curves and hard angles, creating any sort of shape. The control points of a Bezier shape lie directly on its edge.
- **B-Spline:** Control points are all B-Spline points, with different degrees of curvature. B-Spline control points lie inside, outside, or on the edge of the shape, and are connected by the B-Spline frame.

  *Note:* To toggle the display of the B-Spline frame, choose View > Overlays > Lines.

You can change a shape’s type at any time. Changing a shape’s type changes its form. For example, a single set of control points produces the following three shapes, depending on the selected Shape Type.

![Linear shape](image1)
![Bezier shape](image2)
![B-Spline shape](image3)

**Closed:** If you select an open shape, this checkbox is turned off. Turning this checkbox on connects the first and last points of an open shape. If you select a closed shape, this checkbox is selected. Turning this checkbox off disconnects the first and last points, turning it into an open shape.

**Control Points:** Click the disclosure triangle to display the position parameters for the shape control points. Use the value sliders to adjust the position of a control point.
The Control Points parameter also contains an Animation menu, which allows you to add keyframes, reset the shape's animation, display the animation curve in the Keyframe Editor, and so on. For more information on using the Animation menu, see “Animation Menu” on page 517.

Creating Illustrations Using Multiple Shapes
You can use groups of shapes to create more detailed shapes and even complete illustrations. For example, the following illustration was created using nested groups of Bezier shapes.

It is important to understand that it’s not necessary to create every part of an illustration with a single shape. Most of the time it is easier, and sometimes essential, to use multiple overlapping shapes to create different parts of an illustration.

For example, the face in the example above uses a gradient, but the eyes are a different solid color. This is only possible using two shapes.

Organizing Objects Used in Multi-Shape Illustrations
You can arrange related layers in a project into groups. When you create illustrations using multiple shapes, it is helpful to take advantage of the organizational tools in Motion by grouping shape layers together. In the example above, the objects that make up the illustration are grouped by category: The shapes that comprise the face are contained in the “face” group, the shapes that form the right eye are contained in the “right eye” group, and so on.
Each of these groups can in turn be nested inside a larger enveloping group that can be used to transform or animate the entire illustration.

Within each group, you can use the Bring and Send commands in the Object menu to reorder objects, controlling which layers are in front of others. By nesting layers that belong together within the same group, you gain the ability to control the ordering of each shape group relative to one another. For example, spiky locks of hair should cascade over animé eyes, and not the other way around.

For more information on controlling group and layer hierarchies, see “Reorganizing in the Layers Tab” on page 240. For more information on using the Bring and Send commands, see “Arrangement Commands in the Object Menu” on page 259.

**Locking Layers and Shapes While Editing Illustrations**
You can lock layers and shapes that are behind the shapes you’re drawing and editing in the foreground to avoid accidentally selecting and modifying the wrong one. Layers and shapes can be locked and unlocked at any time. To lock a layer or shape, use the lock icons in the Layers tab or Timeline layers list.

**Using Object Alignment**
While arranging groups of shapes to create more complex illustrations, you can use the Alignment commands in the Object menu. For more information on using object alignment, see “Using Object Alignment Commands” on page 268.
Creating Holes and Transparency in Shapes
There are several ways you can create holes and transparency within shapes. You can use the Opacity, Blend Mode, and Preserve Opacity parameters in the Properties tab to modify a shape's overall transparency.

For more information on using object blending parameters, see “Blend Modes” on page 285.

You can also use one or more masks to punch holes inside shapes using the mask drawing tools. You can also apply image masks to a shape, which allow you to use any object to define transparency. For more information on using masks and image masks, see “Masking Layers to Create Transparency” on page 1087.
Applying Filters to Shapes
You can apply filters to shapes, just like any other layer. When you apply a filter to a shape, it remains editable, even though the filter changes it from a vector-based object into a bitmapped object in order to perform the operation.

You can apply filters to individual shapes or to a group that contains a number of shapes. You can use filters to stylize shapes far beyond the options that are available in the Shape tab of the Inspector. More importantly, you can use filters in conjunction with the Shape tab parameters to interactively customize a shape’s look, while preserving the ability to re-edit the shape at any time.

Important: Once you apply a filter to a shape, you can no longer smoothly increase the size of that shape using the object’s transform controls. This is because filters change shapes from vector objects to bitmapped objects. As a result, they scale like other bitmapped objects, which display artifacts if they’re enlarged too much.

For more information on using filters, see “Using Filters” on page 841.

Animating Shapes
You can animate shapes using both behaviors and keyframes. In addition to using Basic Motion, Simulation, and Parameter behaviors, shapes have their own special category of Shape behaviors. Shape behaviors allow you to oscillate, randomize, or wriggle the individual control points of shapes, to write on a shape outline over time, or to apply tracking data to the control points of a shape.

You can also modify a paint stroke created with the Paint Stroke tool (in the Toolbar) based on how it was drawn with the stylus. For example, you can apply the Apply Pen Pressure behavior to a paint stroke in your project and map the pressure used in drawing the stroke to opacity. The resulting stroke appears more opaque in the segments where you pressed hardest when drawing that stroke.
Basic Motion and Simulation behaviors animate multiple parameters of a shape parameters, such as Position, Rotation, and Scale. Applying behaviors to shapes works the same as with any layer in Motion, and keyframed animation of any of these parameters is stored in the Keyframe Editor.

For more information on using Basic Motion, Parameter, and Simulation behaviors, see “Using Behaviors” on page 369.

Using the Shape Behaviors
Shape behaviors are specifically designed to be applied to shapes created within Motion. After drawing a stroke or other shape, apply a Shape behavior to wriggle, oscillate, or randomize a shape's control points or to map pen pressure to various paint stroke characteristics.

Apply Pen Pressure
This behavior is designed to be applied to a paint stroke created using a stylus and graphics tablet. Once a stroke is created, this behavior allows you to affect the width, opacity, spacing, angle, or jitter of the paint stroke based on the pressure of your stylus on the tablet when the stroke was created. The parameters in the HUD are identical to the parameters in the Inspector.

Note: In the Paint Stroke Tool HUD, you can select how the pressure of the stylus affects the stroke before the stroke is created. Applying the Pen Pressure behavior allows you to affect more than one parameter (such as Opacity, Width, or Jitter) of the stroke using the same pressure data. To further modify the stroke after its creation, use the associated parameters in the Stroke or Style pane.

Apply To: Use this pop-up menu to select how your paint stroke is affected by pen pressure.
- **Width**: Pen pressure affects the width of the stroke. The harder the pressure, the wider the stroke.
- **Opacity**: Pen pressure affects the opacity of the stroke. The harder the pressure, the more opaque the stroke.
- **Spacing**: The harder the pressure, the greater the spacing in between the dabs of the stroke.
- **Angle**: The harder the pressure, the greater the angle of the stroke dabs.
- **Jitter**: The harder the pressure, the larger the amount of jitter on the stroke. Jitter randomizes the position of the paint dabs so that they appear more like particles.
**Min Pressure:** Adjusts the minimum threshold of pressure sensitivity. Pressure values below the minimum value are remapped to 0. For Opacity and Width, that section of the stroke does not appear. For Spacing, Angle, and Jitter, the values will not be modified. If the Min and Max pressure are plotted on a graph, Min Pressure represents the minimum value, or 0. The area of the graph between Min and Max is remapped to the output values.

**Max Pressure:** Adjusts the maximum threshold of pressure sensitivity. Pressure values above the maximum value are remapped to 1. For Opacity, Width, Spacing, Angle, and Jitter, that section of the stroke will have the greatest effect. If the Min and Max pressures are plotted on a graph, Max Pressure represents the maximum value, or 1. The area of the graph between Min and Max is remapped to the output values.

**Scale:** Determines the magnitude of the effect. Defines the output range for the dabs based on the mapped values between minimum (0) and maximum (1) pressure, multiplied by the value defined in the slider (or value field). This amount is then applied to the channel (width, opacity, and so on) by multiplying (for Width, Opacity, Spacing, and Jitter) or adding (for Angle). This control is independent of the Scale parameter in the Stroke pane.

**Invert:** This checkbox inverts the attributes of the stroke created by the behavior. For example, if pen pressure is set to affect the opacity of the stroke, transparent areas of the stroke become more opaque and opaque areas become more transparent when the checkbox is selected.

**Apply Pen Speed**
When using a stylus or mouse to create paint strokes, this behavior allows you to affect the width, opacity, spacing, angle, or jitter of the paint stroke based on the speed of your pen strokes.

**Note:** In the Paint Stroke Tool HUD, you can select how the speed of the stylus affects the stroke before the stroke is created. Applying the Pen Speed behavior allows you to affect more than one parameter (such as Opacity, Width, or Jitter) of the stroke using the same pressure data. The Pen Speed parameter also appears in the Advanced pane of the Shape Inspector.

**Apply To:** Use this pop-up menu to select how your paint stroke is affected by pen speed.

- **Width:** The quicker you move the pen, the more narrow the stroke; the slower you move the pen, the wider the stroke.
- **Opacity:** Pen speed affects the opacity of the stroke. The faster you move the pen, the less opaque the stroke.
- **Spacing:** The faster you move the pen, the greater the spacing in between the *dabs* of the stroke.
- **Angle**: The faster the movement of the pen, the greater the angle of the stroke dabs.
- **Jitter**: The faster the movement of the pen, the larger the amount of jitter on the stroke. Jitter randomizes the position of the paint dabs so they appear more like particles.

**Min Speed**: Adjusts the minimum threshold of speed sensitivity. Speed values below the minimum value are remapped to 0. For Opacity and Width, that section of the stroke does not appear. For Spacing, Angle, and Jitter, the values will not be modified. If the Min and Max speeds are plotted on a graph, Min Speed represents the minimum value, or 0. The area of the graph between Min and Max is remapped to the output values.

**Max Speed**: Adjusts the maximum threshold of speed sensitivity. Speed values above the maximum value are remapped to 1. For Opacity, Width, Spacing, Angle, and Jitter, that section of the stroke will have the greatest effect. If the Min and Max speeds are plotted on a graph, Max Speed represents the maximum value, or 1. The area of the graph between Min and Max is remapped to the output values.

**Scale**: Determines the magnitude of the effect. Defines the output range for the dabs based on the mapped values between minimum (0) and maximum (1) speed, multiplied by the value defined in the slider (or value field). This amount is then applied to the channel (width, opacity, and so on) by multiplying (for Width, Opacity, Spacing, and Jitter) or adding (for Angle). This control is independent of the Scale parameter in the Stroke pane.

**Invert**: This checkbox inverts the attributes of the stroke created by the behavior. For example, if pen speed is set to affect the width of the stroke, thin areas of the stroke become wide and wide areas become thin when the checkbox is selected.

**Apply Pen Tilt**

When you are using a stylus to create paint strokes, this behavior allows you to affect the width, opacity, spacing, angle, or jitter of the paint stroke based on the tilt of the pen while creating strokes.

**Apply To**: Use this pop-up menu to select how your paint stroke is affected by the tilt of your pen as you draw.

- **Width**: The tilt of the stylus affects the width of the stroke. The greater the tilt, the wider the stroke.
- **Opacity**: The tilt of the stylus affects the opacity of the stroke. The greater the tilt, the more opaque the stroke.
- **Spacing**: The greater the tilt of the stylus, the greater the spacing in between the dabs of the stroke.
- **Angle**: The greater the tilt of the stylus, the larger the value of the angle of the stroke.
- **Jitter:** The greater the tilt of the stylus, the larger the amount of jitter on the stroke. Jitter randomizes the position of the paint dabs so they appear more like particles.

**Calculate Tilt:** The pen tilt is measured on two axes: X and Y. X represents the stylus tilting to the right and left (toward the right or left side of the tablet); Y represents the stylus tilting up and down (toward the top or bottom of the tablet). Use this pop-up menu to select how the tilt of the stylus affects the stroke.

- **Absolute:** Takes the maximum tilt from any axis.
- **X Only:** Measures the tilt only on the X axis.
- **Y Only:** Measures the tilt only on the Y axis.
- **Axis:** When Axis is chosen from the Calculate Tilt pop-up menu, the Tilt Axis parameter becomes available.
  - **Tilt Axis:** Allows you to define the axis along which the tilt is measured.
- **Polar:** Uses the tilt of the stylus as if it were an angle. When viewed from above, the stylus points in a certain direction. That angle represents a polar value.

**Min Tilt:** Adjusts the minimum threshold of tilt sensitivity. Tilt values below the minimum value are remapped to 0. For Opacity and Width, that section of the stroke does not appear. For Spacing, Angle, and Jitter, the values will not be modified. If the Min and Max tilt are plotted on a graph, Min Tilt represents the minimum value, or 0. The area of the graph between Min and Max is remapped to the output values.

**Max Tilt:** Adjusts the maximum threshold of tilt sensitivity. Tilt values above the maximum value are remapped to 1. For Opacity, Width, Spacing, Angle, and Jitter, that section of the stroke will have the greatest effect. If the Min and Max tilt are plotted on a graph, Max Tilt represents the maximum value, or 1. The area of the graph between Min and Max is remapped to the output values.

**Scale:** Determines the magnitude of the effect. Defines the output range for the dabs based on the mapped values between minimum (0) and maximum (1) tilt, multiplied by the value defined in the slider (or value field). This amount is then applied to the channel (width, opacity, and so on) by multiplying (for Width, Opacity, Spacing, and Jitter) or adding (for Angle). This control is independent of the Scale parameter in the Stroke pane.

**Invert:** This checkbox inverts the attributes of the stroke created by the behavior. For example, if pen tilt is set to affect the width of the stroke, thin areas of the stroke become wide and wide areas become thin when the checkbox is selected.

**Oscillate Shape**
The Oscillate Shape behavior animates a shape by cycling its control points between two different values. You can customize how wide apart the high and low values are, as well as the number of oscillations per minute. This behavior is useful for creating fluid shape movements (think shape yoga) that would be time-consuming to keyframe.
When the Oscillate Shape behavior is applied to a shape, all control points of the shape are affected by default. When the behavior is selected in the Layers list, affected control points appear white. To disable one or more control points, click the control points. A disabled point appears blue. Drag to select multiple control points.

The Oscillate Shape HUD contains the Wave Shape, Phase, Amplitude, Speed, and Alternate Phase parameters. These controls, and the additional parameters in the Inspector, are described below.

Parameters in the Inspector

**Wave Shape:** A pop-up menu that lets you select the shape of the oscillation’s wave. The options are Sine (default), Square, Sawtooth, and Triangle. For more information on wave shapes, see “Oscillate” on page 440.

**Phase:** A slider that lets you adjust the point of the specified oscillation at which the behavior starts. This parameter allows you to put multiple shapes with identical Oscillate behaviors out of phase with one another so that they don’t all look the same.

**Amplitude:** A slider that lets you adjust the maximum values that the control points oscillate between. The control point swings between the amplitude values, and the negative of the amplitude value. Higher values result in more extreme swings from the beginning to the ending of each oscillation.

**Speed:** A slider that lets you adjust the speed at which the oscillation occurs, in oscillations per minute. Higher values result in faster oscillations.

**Alternate Phase:** When this checkbox is selected, the motion of each control point is offset by a phase of 180 degrees from its neighboring control point.

**Oscillate Around:** This pop-up menu allows you to define whether the oscillation for each vertex is generated from a point or a perpendicular line.
• **Point Origin**: Each vertex's oscillation is generated from a point. You can change the location of the point using the onscreen controls (dragging the small blue circle at the center of the shape) or using the X and Y Origin parameters in the Inspector.

  ![Point Origin Image]

  - The shape oscillates around the location of the point.
  - The point's origin can be animated to create a more varied oscillation effect.

• **Line**: Each vertex's oscillation is generated from a line. You can change the start and end points of the line using the onscreen controls (dragging the small blue circles at either end of the line) or using the Start and End parameters in the Inspector.

  ![Line Image]

  - Use the onscreen start and end points to change the position of the line.

**Randomize Shape**
Randomize allows you to animate the control points of a shape by applying a random offset to each point of the shape. This behavior is useful for creating rapid and varied effects on a shape.
When the Randomize Shape behavior is applied to a shape, all control points of the shape are affected by default. When the behavior is selected in the Layers list, affected control points appear white. To disable one or more control points, click the control points. A disabled point appears blue. Drag to select the points to select multiple control points.

The Randomize Shape HUD contains the Amount, Multiplier, Apply To, Frequency, Noisiness, Link, and Preserve Angle parameters. These controls, and the additional parameters in the Inspector, are described below.

Parameters in the Inspector

**Amount/Multiplier:** This parameter is set to Amount when the Apply Mode is set to Add, Subtract, or Add and Subtract; it is set to Multiplier when the Apply Mode is set to Multiply. This parameter defines the maximum value the Randomize behavior will generate.

**Apply To:** A pop-up menu that defines whether the behavior is applied to the shape’s control points, tangent handles, or both points and handles.

- **Points:** The control points of the shape are randomized, changing their position over the duration of the behavior.
- **Tangents:** The control points’ tangent handles (rather than the control points) of the shape are randomized. The control points stay in a fixed position while the curves in between the points are animated.
- **Points and Tangents:** Both the control points and handles are animated.
Apply Mode: A pop-up menu that determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides you with different ways of using a Randomize behavior to modify a vertex’s preexisting values. The options are Add, Subtract, Multiply, or Add and Subtract.

Frequency: A slider that lets you adjust the amount of random variation per second. Higher values generate faster variations, whereas lower values generate slower variations.

Noisiness: A slider that adds an additional overlay of random variance to the Frequency you’ve set. Higher Noisiness values result in more erratic variations in the affected parameter.

Link: This parameter appears when you apply this behavior to a two-dimensional (such as Shear) or three-dimensional parameter (such as Position or Rotation), that consists of X, Y, and/or Z values. Turn this checkbox on to keep the behavior’s effect on each value proportional.

Preserve Angle: When this checkbox is selected, the tangent handles become (or remain) flat, maintaining the continuity of the curves.

Random Seed: A button that lets you pick a new random seed number. This number is used to randomly generate new sequences of values, based on the other parameters of this behavior.

Sequence Paint
Sequence Paint allows you to animate the individual dabs of a paint stroke in sequence over time. This is the only way to animate the dabs individually—keyframing the stroke parameters or applying other behaviors affects all dabs in the stroke uniformly. The Sequence Paint behavior is very similar to the Sequence Text and Sequence Replicator behaviors, which allow you to animate the Rotation, Color, Opacity, Scale, and Position parameters in sequence through the characters of a text layer or the elements of a replicator pattern. The Sequence Paint behavior adds Width to that list of parameters, allowing you to create sequenced animation through the dabs of a paint stroke.
For an example of using a sequence behavior, see "Using the Sequence Replicator Behavior" on page 821.

The Sequence Paint HUD contains the Sequencing, Unit Size, Spread, Traversal, Loops, and End Condition parameters. These controls, and the additional parameters in the Inspector, are described below.

Parameters in the Inspector

**Sequence Paint**: A checkbox that turns sequencing on or off. Before any sequencing animation can occur, you must explicitly add at least one parameter to the behavior from within the Inspector, and then set a value for that parameter. Until a parameter is added, adjustments in the Inspector or HUD have no effect.

**Parameter**: Use the Add and Remove Parameter pop-up menus to add and remove parameters to the sequence. Once the parameter is added, additional controls appear in the Behaviors tab of the Inspector. Adjust those controls to create a sequence animation based on the difference between the original value of the dabs and the modified value. The available parameters are:

- **Rotation**: Specifies (in degrees) the rotation of the stroke dabs. You can either rotate the dial or use the value slider.
- **Color**: Specifies a color to use to tint the stroke dabs. You can either click the color well to choose a color, or open the disclosure triangle and use the Red, Green, and Blue sliders or value fields.
- **Opacity**: Defines the opacity of the stroke dabs. Set a new value using the slider.
- **Scale**: Defines the scale of the stroke dabs. Click the disclosure triangle next to the Scale parameter to reveal separate X Scaling and Y Scaling subparameters, which can be used to scale the width and height of the dabs separately. By default, Scale is set to 100%—the size of the stroke dabs is equal to the original size defined in the stroke parameters.
- **Width**: Defines the width of the dabs. Set a new value using the slider.
- **Position**: Defines the offset of the dabs from their original position. Click the disclosure triangle next to the Position parameter to reveal separate X, Y, and Z Position subparameters. For example, to create an animation in which the dabs move upward in the Y axis over the paint stroke, enter a positive value in the Y Position field.
Sequence Control
The Sequence Control section of the Sequence Paint behavior parameters contains controls that allow you to modify the way the animation moves through the paint stroke, such as changing the direction of the animation.

Sequencing: Specifies how the sequence animation—the value change from the original parameter value to the value set in the Sequence Paint parameters—moves through the dabs of the stroke. The starting point for the sequence animation is based on the first control point of the paint stroke.

Note: To change the start point of the shape, select the shape, click the Select/Transform tool and choose the Adjust Control Points tool from the shortcut menu. Then Control-click a control point and choose Set Start Point from the shortcut menu.

The Sequencing options are:

• To: Specifies that the animation begins at the original value of the dabs and moves to the value set in the Sequence Paint behavior for that parameter. For example, if the original opacity value of a stroke is 100%, and opacity is set to 0% in the Sequence Paint parameters, the dabs begin completely opaque and become completely transparent.

• From: Specifies that the animation moves from the value set in the Sequence Paint behavior to the original value of the stroke. For example, if the original opacity value of a stroke is 100%, and opacity is set to 0% in the Sequence Paint parameters, the dabs begin completely transparent and become completely opaque. This is the opposite of the To Sequencing option.

• Through: Specifies that the sequence goes through a full animation cycle starting at the original value of the stroke, moves to the value set in the Sequence Paint behavior, and then returns to the original value of the stroke. For example, if the original opacity value of a stroke dab is 100%, and opacity is set to 0% in the Sequence Paint parameters, the dabs begin completely opaque, become transparent, and then become completely opaque again.

• Through Inverted: Specifies that the sequence goes through an inverted animation cycle starting from the value set in the Sequence Paint behavior, moves to the original value of the stroke, and then returns to the value set in the Sequence Paint behavior. For example, if the original opacity value of a stroke is 100%, and opacity is set to 0% in the Sequence Paint parameters, the dabs begin completely transparent, become opaque, and then become completely transparent. This is the opposite of the Through Sequencing option.

• Custom: Allows you to keyframe how the animation moves through the values set in the Sequence Paint parameters over a stroke. Each dab undergoes the same value sequence. When Custom is selected, the added parameters must be animated to see any effect.
Unit Size: Specifies whether the sequence animation is applied to the stroke as a whole, to its individual dabs, or to a keyframed range. The Unit Size options are:

- Dab: Applies the sequence animation over each dab as its own entity. Dab is the default setting.
- All: Applies the sequence animation to all stroke dabs simultaneously.
- Custom: Allows you to specify the percentage of dabs on the stroke that are affected by the sequence animation at once. Although you can create keyframes for the Custom option, it is not required in order to affect the sequence. Custom allows you to define an area of dabs—based on percentage—that are affected by the sequence.

- Start: Available when Unit Size is set to Custom, this parameter allows you to specify the starting point for the dabs on the stroke (based on percentage) that is affected by the animation.
- End: Available when Unit Size is set to Custom, this parameter allows you to specify the ending point for the dabs on the stroke (based on percentage) that is affected by the animation.

Spread: To create a softer transition between dabs, increase the Spread value. (This parameter is not available when Unit Size is set to All.)

Traversal: A pop-up menu that sets the action of the sequence behavior to Constant Speed, Ease In, Ease Out, Ease In/Out, Accelerate, Decelerate, or Custom.

- Constant Speed: Moves the animation from the origin of the paint stroke through the end of the stroke at a constant speed. The sequence moves in the direction in which the stroke was created.
- Ease In: The sequence animation begins slowly and increases to normal speed as it moves through the paint stroke.
- Ease Out: The sequence animation begins at normal speed and slows toward the end of the paint stroke.
- Ease In/Out: The sequence animation begins slowly, increases to normal speed as it moves toward the middle of the stroke, and slows as it reaches the end of the paint stroke.
- Accelerate: The sequence animation increases in speed.
- Decelerate: The sequence animation decreases in speed.
- Custom: Allows you to keyframe how the animation moves through the paint stroke. When you choose Custom from the Traversal pop-up menu, the Location parameter replaces the Loops parameter.

- Location: Defines the location of the stroke where the animation is in effect. For more information on using the Custom Traversal option, see “Using the Sequence Replicator Custom Traversal Option” on page 834.
Loops: Sets the number of times the animation sequences through the paint stroke over its duration.

Note: Loops is not available when the Traversal parameter is set to Custom.

End Condition: Determines how the sequence animation is repeated over the duration of the sequence behavior. This parameter has no effect for Loop values less than or equal to 1. The End Condition options are:

- Hold: Completes the sequence animation cycle one time, then starts it over again from the beginning (once the last dab in the sequence has completed its animation).
- Wrap: Treats the sequence animation as a continuous loop so the spread wraps from the last dab in the sequence to the first dab.
- Ping Pong: Completes the sequence animation cycle forward, then completes the animation backward, then forward, and so on.

Track Points
This behavior allows you to either track the control points of a shape or mask to a moving clip or animated object, or to apply existing tracking data to a shape or mask. For information on using the Track Points behavior, see “Motion Tracking” in the Motion Supplemental Documentation PDF.

Wriggle Shape
This behavior works similarly to the Randomize behavior, but with a slower effect (think of a shape that’s had one too many espressos before dance class). It also allows for a greater range of possible values.

When the Wriggle Shape behavior is applied to a shape, all control points of the shape are affected by default. When the behavior is selected in the Layers list, affected control points appear white. To disable one or more control points, click the control points. A disabled point appears blue. Drag to select multiple control points.

The Wriggle Shape HUD contains the Amount, Multiplier, Apply To, Frequency, Wriggle Offset, Noisiness, Link, and Preserve Angle parameters. These controls, and the additional parameters in the Inspector, are described below.
Parameters in the Inspector

**Amount/Multiplier:** This parameter is set to Amount when the Apply Mode is set to Add, Subtract, Add and Subtract; it is set to Multiplier when the Apply Mode is set to Multiply. This parameter defines the maximum value the Wriggle behavior generates.

**Apply To:** A pop-up menu that defines whether the behavior is applied to the shape's control points, tangent handles, or both points and handles.
- **Points:** The control points of the shape are wriggled, changing their position over the duration of the behavior.
- **Tangents:** The control points' tangent handles (rather than the control points) of the shape are wriggled. The control points stay in a fixed position while the curves in between the points are animated.
- **Points and Tangents:** Both the control points and handles are animated.

**Apply Mode:** A pop-up menu that determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides you with different ways of using a Wriggle behavior to modify a vertex's preexisting values. The options are Add, Subtract, Multiply, or Add and Subtract.

**Frequency:** A slider that lets you adjust the amount of random variation per second. Higher values generate faster variations, whereas lower values generate slower variations.

**Wriggle Offset:** A slider that allows you to offset the sequence of random values when you want to apply the same Wriggle behavior to multiple shapes. By offsetting each shape's version of the Wriggle behavior, you can prevent them from moving in sync.

**Noisiness:** This slider adds an additional overlay of random variance to the Frequency you've set. Higher Noisiness values result in more erratic variations in the affected vertices.

**Link:** This parameter appears when you apply this behavior to a two-dimensional (such as Shear) or three-dimensional parameter (such as Position or Rotation) that consists of X, Y, and/or Z values. Turn this checkbox on to keep the behavior's effect on each value proportional.

**Preserve Angle:** When this checkbox is selected, the tangent handles become (or remain) flat, maintaining the continuity of the curves.

**Random Seed:** A button that lets you pick a new random seed number. This number is used to randomly generate new sequences of values, based on the other parameters of this behavior.
**Write On**

The Write On behavior provides a quick way to draw a paint stroke or outline on the Canvas over time. This allows you to create a handwritten text effect, create the ever-popular old serial travel map effect, create a hand-sketched alpha mask for a transition or reveal, create an animated graph for a business presentation, produce graphics to prevent monitor burn-ins, and so on. The behavior can be automatically applied to a paint stroke created with the Paint Stroke tool or added to an existing shape. You can have the shape draw, erase, draw and erase, draw in reverse, and so on, over time.

When Write On is applied to a shape, such as a circle or rectangle, only the outline of the shape is drawn.

**Note:** You can manually animate the First Point Offset and Last Point Offset parameters in the Style pane of the Shape Inspector to achieve the same effect as the Write On behavior.

The Write On HUD contains the Shape Outline, Stroke Length, Stroke Offset, Direction, Speed, and Custom Speed parameters. These controls, and the additional parameters in the Inspector, are described below.

**Parameters in the Inspector**

**Shape Outline:** This pop-up menu determines whether the stroke is drawn, erased, or drawn and erased.

- **Draw:** Draws the stroke over the duration of the behavior.
- **Erase:** The stroke is completely drawn at the beginning of the behavior, and is erased over the duration of the behavior.
- **Draw and Erase:** The stroke is drawn, then erased over the duration of the behavior.
- **Erase and Draw:** The stroke is completely drawn at the beginning of the behavior, is erased, then is drawn again.

**Stroke Length:** This slider defines the length, as a percentage, of the drawn or erased stroke. A value of 100% uses the entire length of the stroke, bounded by the First Point Offset and Last Point Offset parameters. If Stroke Length is set to 50%, once 50% of the stroke is drawn on, it begins to erase (from the beginning of the stroke) so that only half of the length of the stroke is ever displayed over the duration of the behavior.

**Stroke Offset:** This slider offsets where the stroke begins on the shape. The value is expressed as a percentage of the total length of the shape from the start point defined on the shape.

**Direction:** This pop-up menu sets the direction in which the stroke is drawn.

**Speed:** A pop-up menu that defines the stroke's "draw-on" velocity from the first to the last point in the stroke. There are nine options:
• **Constant:** The stroke is drawn at a steady speed from the first to the last point in the stroke.

• **Ease In:** The drawing of the stroke starts at a slow speed, then reaches and maintains a steady speed through the last point on the stroke.

• **Ease Out:** The drawing of the stroke starts at a steady speed, then slows down as it gradually decelerates to a stop at the last point of the stroke.

• **Ease Both:** The drawing of the stroke slowly accelerates from the first point on the stroke, and then slows down as it gradually decelerates to a stop at the last point of the stroke.

• **Accelerate:** The stroke is drawn with increasing speed.

• **Decelerate:** The stroke is drawn with decreasing speed.

• **Natural:** The speed in which the stroke is drawn along the path is determined by the shape of the path. For example, if the stroke is a U-shape curve, the stroke is drawn on more quickly as it moves toward the low point of the U, and more slowly as it moves up the edges.

• **Recorded:** This option only appears if there is a recorded time over which the stroke was drawn. In other words, if a shape is converted to a paint stroke, this parameter does not appear. If the paint stroke is created with the Paint Stroke tool in the Toolbar (using a stylus or mouse), this option does appear.

• **Custom:** Custom allows you to draw the stroke along its path by setting keyframes for the stroke's speed from 0 to 100%. In other words, you determine what portion of the stroke is drawn along its path in time.

  • **Custom Speed:** This parameter becomes available when Speed is set to Custom. You can modify the Custom Speed velocity curve in the Keyframe Editor. For example, you can keyframe custom values to draw a stroke forward to a specific percentage of its path, then backward, then forward, and so on before it reaches the end of the animation.

**End Offset:** This slider offsets the end of the behavior inward from the defined Out point and holds the last value. In other words, it offsets the visible paint stroke from the end of the path of the stroke.

**Creating a Write On Paint Stroke Using the Paint Stroke Tool**

This section describes creating a “write-on” paint stroke using the Paint Stroke tool in the Toolbar. To create a paint stroke that appears over the course of several frames, select the Write On checkbox. Once the stroke is created, additional parameters become available in the Behavior tab of the Inspector.

**To paint a stroke over time:**

1. In the Toolbar, click the Paint Stroke tool (or press P).

   The Paint Tool HUD appears. If the HUD does not appear, press F7 or D.

2. In the HUD, select the Write On checkbox and select any other desired stroke settings.
3 In the Canvas, create your stroke.

4 Once the stroke is complete, press Esc to exit the paint mode.

The Paint Tool HUD is replaced with the Paint Stroke shape HUD. In the Layers list, a Write On Shape behavior is automatically applied to the stroke. To modify the Write On parameters, select the behavior and use the HUD or the Behaviors tab in the Inspector.

The speed at which the stroke is “painted” (including the duration it took to draw the stroke) is mapped over the time extent (in frames) of the stroke. The faster a stroke is drawn, the shorter the duration of the Write On behavior.

**Note:** If your Motion Project Preferences Create Layers At option is set to Current Frame, the paint stroke is created at the current playhead position. If set to Start of Project, the stroke is created at frame 1.

5 Play back your project. The stroke is “painted” on as the project plays.

6 To modify the speed at which the stroke is painted, adjust the duration of the behavior in the Timeline or mini-Timeline.

You can modify additional parameters, such as customizing the speed at which the stroke is drawn, drawing on only a percentage of the stroke, offsetting the stroke, or drawing the stroke in reverse. These parameters are available in the Write On behavior, described above.

**Creating a Write On Paint Stroke Using an Existing Shape**

You can apply the Write On behavior to an existing shape to draw its outline on over time. Because the Write On behavior only affects outlines, Outline must be enabled in the Shape parameters.

![Images of a smiley face being written on]

**Note:** Unlike a paint stroke created using the Paint Stroke tool, when a Write On behavior is added to an existing shape, the behavior spans the duration of the shape to which it is applied.

**To create a write on stroke using an existing shape:**

1 Select the shape you want to use and select its Outline checkbox in the HUD or Shape tab Inspector.
Note: You can leave the Fill checkbox selected, but only the outline is affected by the Write On behavior.

2 In the Toolbar, click Add Behavior and choose Shapes > Write On.
   The Write On behavior appears in the Layers list. If the playhead is located at the start of the shape, the visual shape disappears and only the path is visible.

3 Play the project (press the Space bar).
   The outline is drawn on over the length of the behavior.

4 To adjust the speed at which the stroke is painted, adjust the duration of the behavior in the Timeline or mini-Timeline.

5 To adjust the properties of the stroke, use the Shape tab in the Inspector. For more information, see “Shape Parameters in the Inspector” on page 1031.

Keyframing Shape Animation
You can also keyframe a shape's animation parameter to animate adjustments to its individual control points. This opens up powerful animation possibilities, since you can reform an entire shape using keyframe animation.

To keyframe a shape's control points:
1 Use the Adjust Control Points tool (in the Select/Transform Tool options) to select the shape you want to animate.
The shape's control points appear in the Canvas. In this example, the selected shape is the lower lip of the mouth illustration.

2 Enable Record (press A).

3 Move to the frame where you want to change the shape, then make any necessary changes to the shape's control points.

In the Keyframe Editor (and also in the Timeline, if the Show/Hide Keyframes button is turned on), a keyframe appears for each adjustment you make at a new frame.

*Note:* Adjusting a shape while the playhead is on an already existing keyframe adjusts the shape at that keyframe.
4. Continue advancing frames and making changes as needed. Every time you make a change to the shape at a new frame, you automatically create a keyframe in that shape’s Shape Animation parameter.

5. When you are done animating the shape, disable Record.

   The animated shape object interpolates between each keyframed shape. If you don’t like how the interpolation is working, you can add more keyframes to force the control points to follow the path you want.

You can also create, delete, and edit the timing of Shape Animation keyframes directly in the Keyframe Editor. For simplicity, each change you make to a shape is recorded as a single keyframe, no matter how many control points are edited. The Shape Animation parameter only allows keyframes set to linear interpolation. You cannot use any other form of keyframe interpolation.

The process used to animate both shapes and masks is identical. To see an example of mask animation, see “Keyframing a Mask’s Shape for Animation and Rotoscoping” on page 1101. For more information on keyframing in general, see “Keyframes and Curves” on page 503.

**Saving Shapes and Shape Styles**
Like all objects in Motion, shapes and shape styles (a custom gradient fill and outline, for example) can be saved to the Library. This allows you to add to the content that Motion provides to create a library of your own custom objects and styles, including customized behaviors and filters or whole project groups. Content you put into the Library is available to every project in Motion.

Custom shapes (including masks) can be saved in the Shapes, Favorites, or Favorites Menu categories of the Library. Custom shape styles, which are saved via the Shape Style pop-up menu, are automatically saved in the Shape Styles category. You can create your own folders within the Library categories or subcategories to better organize your effects.
Each customized shape or shape style saved to the Library is saved as a separate file in the Motion folder of the Application Support directory. For example, a saved custom shape named “red heart” in the Shapes category of the Library appears in the Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Shapes folder.

![red heart.molo]

Items that are saved to the Library appear in the Finder with a .molo extension (“Motion Library object”). These items cannot be opened from the Finder.

**To save a shape to the Library:**
1. Open the Library and select the Favorites, Favorites Menu, or Shapes category.
2. Drag the shape you want to save from the Layers tab or Timeline layers list into the stack at the bottom of the Library.

Shapes that are saved to the Favorites Menu category can be quickly added to a project via the Favorites menu.

The saved custom shape appears in the Shapes category of the Library in the /Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Shapes folder.

**To save multiple shapes to the Library:**
1. Open the Library and select the Favorites, Favorites Menu, or Shapes category.
2. In the Layers tab, select all of the shapes you want to save, drag them to the stack, and hold down the mouse button.
3. When the drop menu appears, choose “All in one file” or “Multiple Files.”

“All in one file” saves all the shapes together, and they are listed as one item in the Library. “Multiple Files” saves the shapes as individual objects in the Library.
4 To name the file, do one of the following:
   • Control-click the icon, choose Rename from the shortcut menu, then type a descriptive name.
   • Select the icon, click "Untitled," then type a descriptive name.

   Note: When you Control-click the icon, the Edit Description option becomes available. This is a handy tool that allows you to enter custom notes about an item saved in the Library. Once you choose Edit Description, enter your notes in the text field and click OK.

   To save a shape style to the Library:
1 With the shape selected, choose Save Shape Style from the Shape Style pop-up menu in the Style pane of the Shape Inspector.
2 Type a name for the style in the Save Preset to Library dialog and click Save (or press Return).

   The custom style is saved to the Library in the All subcategory of the Shape Styles category by default. You can move the preset into an existing subcategory, or create your own folders to organize your custom styles (see below).

   When the style is selected in the Library stack, a preview is displayed in the Preview pane. The new preset now appears in the Shape Style pop-up menu in the Style pane of the Shape Inspector.

   The saved custom shape style appears in the Shape Styles category of the Library in the /Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Shape Styles folder.
To apply a shape style to a shape, do one of the following:
- With the shape selected, click the Style pane in the Shape Inspector, then choose a style from the Shape Style pop-up menu.
- Drag a shape style from the Library to a shape in the Canvas, Layers tab, or Timeline.

To create a new folder in a Library category:
1 Open the Library and select the Shapes, Shape Styles, Favorites, or Favorites Menu category.
2 Do one of the following:
   - Click the New Folder button at the bottom of the window.
   - Control-click an empty area of the Library stack (the lower section of the Library) then choose New Folder from the submenu.

   *Note:* You may have to expand your stack window or use icon view to access an empty area.

   The new untitled folder appears in the Library stack. The new folder does not appear in the Library sidebar.
3 Double-click the name of the folder, type a new name, then press Enter.

To create a new folder in a Library subcategory:
1 Open the Library and select a subcategory, such as the Fauna subcategory.
2 Do one of the following:
   - Click the New Folder button at the bottom of the window.
   - Control-click an empty area of the Library stack (the lower section of the Library), then choose New Folder from the shortcut menu.

   *Note:* You may have to expand your stack window or use icon view to access an empty area.

   The new untitled folder appears in the Library stack. The new folder does not appear in the Library sidebar.
3 Double-click the name of the folder, type a new name, then press Enter.

To move a shape to a custom folder in a Library category:
- Drag the shape to the new folder in the Library sidebar.

The custom preset is added to the new folder and to the All subcategory.
To move a shape to a custom folder in a Library subcategory:
- Drag the shape to the new folder in the Library stack.
  The custom preset is added to the new folder and to the All subcategory.

To move a shape style to a custom folder in a Library category:
- Once the new preset is saved via the Shape Style pop-up menu in the Style pane of the Shape Inspector, drag the custom behavior from the All subcategory in the Library stack to the new folder in the Library sidebar.
  The custom preset is added to the new folder.

  Note: Because shape styles are saved via the Shape Style pop-up menu in the Style pane of the Shape Inspector, they cannot be dragged directly to the Library.

To move a shape style to a custom folder in a Library subcategory:
- Once the new preset is saved via the Shape Style pop-up menu in the Style pane of the Shape Inspector, drag the custom behavior from the All subcategory in the Library stack to the new folder in the Library sidebar.
  The custom preset is added to the new folder.

To delete a custom shape or shape style:
- Control-click the custom item, then choose Move to Trash from the shortcut menu.

To delete a custom folder from a subcategory in the Library stack:
- Control-click the folder in the Library stack, then choose Move to Trash from the shortcut menu.

  Note: You can also delete the folder from the Finder. The folder is stored in the Users/username/Library/Application Support/Final Cut Studio/Motion/Library folder.

  Important: Deleting a custom object or folder cannot be undone.

To delete a custom folder from a category in the Library sidebar:
- In the Finder, navigate to the Users/username/Library/Application Support/Final Cut Studio/Motion/Library folder, Control-click the folder, then choose Move to Trash from the shortcut menu.
Masking Layers to Create Transparency
When you create a mask to define transparency within a layer, you're drawing a shape to use as that layer's alpha channel. Because a layer's alpha channel is a grayscale channel, masks are grayscale objects, where white defines solid areas, progressively darker levels of gray define decreasingly opaque areas, and black defines areas of complete transparency. If you choose View > Channels > Alpha to set the Canvas to display the alpha channel only, you can see the grayscale alpha channel directly.

Masks can be used with layers that already have an alpha channel, and can add to, subtract from, intersect, or replace the layer's original alpha channel.

Masking a Layer or Group
Use the mask tools to create different shapes with which to mask a layer or group. There are five mask tools available that are analogous to the five shape drawing tools covered earlier in this chapter:
- Rectangle Mask
- Circle Mask
- Freehand Mask (used like the Paint Stroke tool)
- Bezier Mask
- B-Spline Mask

Note: You can also use an Image Mask to mask a layer. For more information, see “Applying Image Masks to a Layer” on page 1104.
**Important:** A mask cannot be applied to a nonflattened 3D group. (To flatten a 3D group, turn on the Flatten checkbox in the Group tab of the Inspector.) A mask can be applied to a layer within a 3D group. To add a mask to a layer that has been manipulated in 3D space, use the Isolate button. Masks cannot be manipulated in 3D space. For example, the Position parameter for a mask only includes the X and Y position parameters, but not the Z position parameter; the Rotation parameter only includes Z, but not X or Y. For more information, see “Masking Objects in a 3D Project” on page 1090.

Drawing and editing masks using these tools works identically to drawing and editing shapes. The main difference is that while drawing a shape creates a new layer in your project, masks must be drawn on top of another layer in your project. Once drawn, masks are nested within the specific layers or groups for which they were created, in the Layers tab and Timeline. Once a mask is attached to a layer, a Masks icon appears to the right of the name of the layer. Toggle the mask display by clicking this icon.

**Note:** Masks created for one layer can be copied or moved to other layers.

**Important:** When a mask is applied to a 2D or flattened 3D group, the group is rasterized. For more information, see “About Rasterization and Groups” on page 1115.

**To mask a layer:**
1. Select a layer in the Canvas or Layers list.
2 Choose a mask drawing tool (the Rectangle Mask tool, the Circle Mask tool, the Freehand Mask tool, the Bezier Mask tool, or the B-Spline Mask tool).

![Mask tool](image)

*Note:* If you haven’t selected a layer, the mask tools are not available.

3 Begin drawing the shape you need in order to mask the layer.

For more information about how to draw and edit shapes, see “Shape and Mask Drawing Tools” on page 999.

![Lion image](image)

4 When you’re done, you can finish the mask by doing one of the following:

- Click the first point to close the mask.
- Press C to close the mask, joining the first point you created to the last.
- Double-click to close the mask, joining the first point you created to the last.
- Press Return to close the mask, joining the first point you created to the last.
- When using the Freehand Mask tool, join the end of the mask to the target circle at the beginning of the mask. If you don’t reach the beginning of the mask, it is automatically closed when you lift the stylus or release the mouse button.

*Note:* Unlike shapes, masks are always closed.
After you’ve finished drawing the mask, its effect is immediate, and the mask you created appears nested underneath the layer to which it’s applied in the Layers tab and Timeline.

You can create multiple masks for a single layer. To add additional masks, select the object again, then follow the above procedure. By default, all new masks are set to the Add blend mode. You can change the Mask Blend Mode parameter in the Inspector to combine masks for different effects. For more information about using multiple masks together, see “Combining Multiple Masks” on page 1096.

**Masking Objects in a 3D Project**

When working in a 3D project, you may want to mask a layer once it has been transformed or the camera has been rotated. You can immediately switch a transformed object into a “work view” using the Isolate button in the Layers tab or Timeline layers list, or the Isolate command in the Object menu. Once a camera is added to a project, the Isolate option is available for any layer, group, or camera in the project.

**Note:** Masks can be applied to the layers within a 3D group, but not the 3D group itself (unless you’ve activated the Flatten checkbox in the Group tab of the Inspector). For more information about the Flatten checkbox, see “Inspector Tabs” on page 131.
To isolate a layer:

1. In the 3D project, select the layer that you want to mask. In this example, the center leopard image is the layer to be masked.

   The Isolate button appears to the right of the layer name.

   Note: A project must contain a camera in order to access the Isolate option.

2. Click the Isolate button or choose Object > Isolate.

   Note: You can also Control-click the layer or group and choose Isolate from the shortcut menu.

   The layer is switched into “work view” allowing you to mask the layer at its original orientation.
To return to your previous view (the view before you isolated the layer), click the Isolate button again.

*Note:* Clicking a camera’s Isolate button activates that camera’s view.

**Mask Parameters**
A selected mask's parameters appear in the Mask tab of the Inspector. These parameters allow you to adjust how the mask is drawn, how each mask operates upon an object, and how masks are combined with one another.

**Shape Type:** This pop-up menu lets you change the type of control points that are used to define the mask. For example, if you originally created a Bezier mask, you can choose B-Spline from this menu to change how the mask is drawn. You can change a mask’s shape type at any time, but changing a mask from a Bezier shape to a B-Spline shape might dramatically change its form.

- **Linear:** All of a mask’s control points are joined by hard angles, and the resulting mask is a polygon. The control points of a Linear mask lie directly on its edge.
- **Bezier:** Control points can be a mix of Bezier curves and hard angles, creating any sort of mask. The control points of a Bezier mask lie directly on its edge.
- **B-Spline:** Control points are all B-Spline points, with different degrees of curvature. B-Spline control points lie outside the surface of the mask, but are connected by the B-Spline frame.

*Note:* You can hide the B-Spline frame by turning off Lines in the View pop-up menu above the Canvas.

**Mask Blend Mode:** Determines how a mask interacts with the alpha channel of the layer to which it’s applied. When a layer has multiple masks, each mask can have a different Mask Blend Mode. When this happens, each mask adds to, or subtracts from, the layer’s alpha channel according to the selected mode. The final alpha channel is the combined result of all the masks that are applied. The four choices are:
Add: This is the default selection for new masks. Each new mask adds to the existing alpha channel. This is useful for adding back regions of an image that other masks are cutting out. In this example, both the rectangle and circle masks are creating opaque regions.

If the layer already contains an alpha channel, a mask set to Add mode isolates only the masked section of the original alpha channel.
• **Subtract:** Subtracts a mask from the alpha channel. This is useful for creating holes in the middle of objects, or for masking out additional regions of an image that are untouched by other masks. In this example, both the rectangle and circle masks are creating transparent regions.

![Example of Subtract](image1.png)

• **Replace:** This setting uses the current mask to completely replace the object’s original alpha channel, as well as any other masks that are applied to the same object that appear underneath the current mask in the Layers list. You can add additional masks above, set to whatever blending mode you like. In the following example, the circle mask is overriding the rectangle, since it is at the top of the masks that are nested within the gradient object.

![Example of Replace](image2.png)
• **Intersect:** Masks that are set to intersect do not replace an object’s original alpha channel. Instead, they mask out all regions of the object that do not overlap the mask itself. This includes other masks applied to the same object that appear nested underneath the intersecting mask in the Layers tab. In the following example, only the overlapping areas of the rectangle and circle masks are opaque. Everything else is transparent.

![Image of Intersect](image)

**Invert Mask:** When this checkbox is selected, the mask is inverted—its solid and transparent areas are swapped. This is useful if you need to switch the solid and transparent areas of a mask you have already created.

**Tip:** You can apply different filters and effects to the foreground and background of an image by first masking the foreground subject, duplicating the layer and its mask, then inverting the duplicate layer’s mask. Effects that are applied to the background can then be completely isolated from the foreground, or vice versa.

**Note:** You can adjust the opacity of a mask in the Properties tab of the Inspector.

**Feather:** A slider that feathers (softens) the edges of a mask. Positive feathering values soften the edge of the mask from its edge outward. Negative feathering values soften the edge of a mask inward from the edge. Feathering the edge of a mask can soften a harsh rotoscoping job, making the masked object blend more easily with the background.

**Control Points:** Click the disclosure triangle to display the Position parameters for the mask control points. Use the value sliders to adjust the position of a control point. The left value slider represents X and the right value slider represents Y.
Combining Multiple Masks

Often, you may find that it is impossible to create the mask shape you need using only a single mask. For example, when masking something that has a hole in it, you need to use at least two masks—one set to Add to mask the overall object, and a second one set to Subtract to cut the necessary hole in the middle of it. In the following example, the only way to mask the space between the diver’s arms and legs is to create three overlapping masks set to Subtract.

Other times, you may find that it’s simply more convenient to mask a complex object using multiple masks. This is frequently the case when rotoscoping an object and animating the masks. In this example, the dog’s head is masked with four different masks set to Add—one for the head, one for each ear, and a separate mask for the mouth. This makes it easier to make adjustments later on, especially when animating a mask to do rotoscoping.

Whatever the reason, you can easily combine multiple masks for any object by adjusting each mask’s Mask Blend Mode parameter in the Inspector to create any combination.
Each mask’s blend mode determines whether the mask adds to, subtracts from, or replaces a layer’s previously existing alpha channel. Additionally, blend modes affect how masks interact with one another. Ultimately, every mask applied to a layer combines according to the specified blend modes to create that layer’s final alpha channel. Mask Blend Modes can be changed at any time.

Blend mode operations are also determined by the order in which each mask appears in the Layers tab, particularly with the Replace and Intersect modes. For example, a mask set to the Intersect mode masks out all other regions of a layer that do not overlap it. A mask set to Intersect affects all masks nested underneath it. Masks added above it are unaffected by this behavior.

**Masks That Add and Subtract**
New masks always default to the Add blend mode, allowing you to add to an existing alpha channel without cropping what’s already there. Once you’ve drawn the first mask, you may need to use additional masks set to Add or Subtract to refine it.

Masks set to Add create white areas in the alpha channel, making those parts of the object opaque. This can be useful when masking several unconnected subjects in a single image.

**Note:** To display the rest of a masked layer so you can trace it to create a second mask, turn off the first mask in either the Layers tab or Timeline. The outline of the first mask remains visible, even though it’s no longer affecting the layer’s transparency.
Predictably, masks set to Subtract have the opposite effect, creating black areas in the layer's alpha channel and making those parts of the object transparent. This is particularly useful for cutting holes in an object.

Intersecting Masks
In many instances, you may find that you want to cut out parts of an object, while leaving the rest of the object alone. Using a mask set to Intersect is a good way to do this.

For example, if you import a TIFF file with an alpha channel and you want to cut out part of it without losing the alpha information that's already there, the Intersect blend mode is the only way to do this. This is also true for layers with keying filters applied.

Replace Masks
A mask set to Replace completely replaces the previously existing alpha channel. It also completely replaces all other masks appearing underneath it in the Layers tab. For this reason, it is unlikely that any but the bottommost mask would be set to this blend mode.
Feathering Masks

One of the easiest ways to adjust a mask is to feather its edges. Feathering a mask by a few pixels can make the masked object blend more seamlessly with a background. Feathering a mask by larger amounts allows you to create progressively softer edges for a variety of design purposes.

You can feather mask edges either outward or inward. The direction in which you feather a mask is dictated by the subject you’re masking. When rotoscoping a subject, a combination of masks using both inward and outward feathered masks may be necessary for the best results.

To feather the edge of a mask:
1 Select a mask.
2 Open the Mask tab in the Inspector.
3 Do one of the following:
   • Drag the Feather value slider to the right for a positive value to feather the mask outward.
   • Drag the Feather value slider to the left for a negative value to feather the mask inward.
Applying Filters to Masks

As with shapes, you can apply filters to masks, which remain editable even after the fact. Although uses for this technique might not be immediately obvious, it’s actually an extremely powerful way to further manipulate the alpha channel created by one or more masks.

For example, you could apply the Crystallize filter to a mask to stylize its edges. This results in jagged edges that resemble facets of crystal around the edges.

![Original mask (color channel)](image1)
![Original mask (alpha channel)](image2)

![Crystallize filter applied to alpha channel](image3)
![Crystallize filter applied to alpha channel](image4)

When applying filters to masks, it’s useful to bear in mind that masks are just grayscale images. In the example above, the Crystallize filter creates patterns in the grayscale mask image, which results in a rippled translucent pattern.

To apply a filter to a mask, do one of the following:
- Drag a filter from the Library directly onto a mask in the Layers tab or Timeline.
- Select a mask in the Layers tab or Timeline layers list, then choose a filter from the Add Filter pop-up menu in the Toolbar.

The filter appears nested underneath the mask layer to which it’s applied.
Applying Behaviors to Masks

You can apply behaviors directly to masks. When you apply a behavior to a mask, the mask is animated like any other layer. However, since the mask only affects the transparency within a layer, and not the position, rotation, or scale of the layer itself, the result is similar to that of a “traveling matte,” where the mask moves within the layer to which it's applied, hiding and showing different areas of the image as it moves.

To apply a behavior to a mask, do one of the following:
- Drag a behavior from the Library directly onto a mask in the Layers tab or Timeline.
- Select a mask in the Layers tab or Timeline, then choose a behavior from the Add Behavior pop-up menu in the Toolbar.

The behavior appears nested underneath the mask to which it's applied.

Keyframing a Mask's Shape for Animation and Rotoscoping

You can keyframe a mask's animation parameter to change its shape over time. This can serve many purposes. For example, you can animate a subtractive mask to change the shape of a hole in a foreground object, allowing other layers in the background to show through.

A more conventional use of animated masks is to rotoscope a foreground subject. Rotoscoping is the process of manually tracing a foreground subject in order to isolate it from the background. The end result is similar to a bluescreen or greenscreen effect. Why would you bother? In a wide variety of situations, keying is either impractical or impossible if the shot wasn't well planned. Even for shots where keying is possible, manual rotoscoping is often necessary to create garbage or holdout mattes to improve the effect. (For more information on creating garbage and holdout mattes or masks using masks, see “Using Masks to Aid Keying Effects” on page 1108.)

All mask animation is stored in the Shape Animation parameter. It's worth noting that animated masks trigger the same motion blur as any other keyframed parameter in Motion. For example, if you animate a layer's position so that it moves really fast, the layer is blurred when you enable motion blur. If you animate a layer's mask so that it also moves fast, the edges of the mask are blurred as well. This is important as an animated mask's blur should ideally match any blur that's present in the foreground subject itself.

For more information about motion blur, see “Render Settings Tab of the Project Properties Dialog” on page 187.
To rotoscope a subject by animating a mask:

1. Choose View > Resolution > Full to ensure that you are viewing the Canvas at full resolution.

   **Warning:** If the Canvas resolution is not set to full, the outlines of objects and images may shift slightly. As a result, masks created to trace a subject at less than full resolution may not be accurate.

2. Move to the first frame where the mask animation should begin, then draw a mask that accurately isolates the subject.

3. When you’re finished drawing the first mask, enable Record (press A).

4. Move to the first frame of the Timeline where you want to change the shape of the mask, then make any necessary changes to its control points.

   **Tip:** A good way to start rotoscoping an image is to find the frame with the most detail showing in the subject you’re masking, and use that as your starting frame. For example, if you’re masking someone walking, choose a frame where both that person’s arms and legs are out in mid-stride. This allows you to decide how many control points you need to start with. Using the minimum number of control points you can to achieve the necessary level of detail in your mask makes it much easier to animate.

   You should also bear in mind that it’s not always necessary to rotoscope an entire subject with a single mask. Motion allows you to apply multiple masks to a single object, so you can rotoscope different parts of a subject with separate masks. This can make your job much easier. For example, if you’re rotoscoping someone carrying something while walking across a room, you could use one mask for the upper part of the person’s body which doesn’t change shape very much, and another two masks for the legs, which change shape considerably as the person walks.

   You can also use the Track Points behavior to apply tracking data to a shape or mask. For more information on the Track Points behavior, see “Motion Tracking” in the Motion Supplemental Documentation PDF.
In this example, the best place to start when rotoscoping the dolphin is the frame in which all the fins are showing.

When rotoscoping a moving subject, it’s a good idea to play through the clip and examine its direction and speed to get a sense of how the mask needs to be animated. In particular, you may find it helpful to place markers indicating frames where the subject or camera stops, changes direction, or changes speed, since these are likely candidates for your first pass of keyframed mask changes.

By noting these changes, you can attempt to reduce the amount of keyframing by making your first keyframed mask shape adjustments at these major changes in speed and direction. Because animated masks are automatically interpolated to change from one keyframed shape to another, you can let Motion do some of your work for you.

Note: If at any time the mask is deselected, you need to select the mask you’re working on in the Layers tab so that its control points become visible in the Canvas. Make sure that the Show Masks checkbox is selected in the Layers tab so that masks are visible.

Continue moving the playhead and making changes as needed, since the interpolated shape of the mask isn't going to be perfect.

One imprecise rule of thumb is to move to the frame that's halfway between any two keyframed mask shapes and make new adjustments. Continue keyframing shape changes at the halfway point between every two keyframes until the mask accurately follows the motion of the subject. For irregularly shaped objects or objects with complex motion, don't be surprised if you need to add a large number of keyframes. Nobody ever said that rotoscoping was fast!
Every time you move the playhead to a new frame and make a change to the mask’s shape, a keyframe is automatically created in that shape’s Shape Animation parameter. If you move the playhead directly on top of a previously existing keyframe, you change the mask’s shape at that point without creating a new keyframe.

*Note:* You can also transform and shear masks as you would any other layer. If you move, rotate, scale, shear, or change the anchor point for a mask while animation recording is enabled, you add keyframes to additional channels in the Keyframe Editor.

6 When you’ve finished animating the mask, disable Record (press A).

You can also create, delete, and edit the timing of a mask’s Shape Animation keyframes directly in the Keyframe Editor. For simplicity, each change you make to a mask is recorded as a single keyframe, no matter how many control points you edited. The Shape Animation parameter only allows keyframes set to Constant—you cannot use any other form of keyframe interpolation.

The process used to animate both masks and shapes is identical. To see an example of shape animation, see "Animating Shapes" on page 1063. For more information on keyframing in general, see "Keyframes and Curves" on page 503.

Applying Image Masks to a Layer

Another way you can create transparency in a layer is by using image masks. An image mask creates transparency in another layer by deriving an alpha channel from another layer, such as a shape, text, movie, or still image.

*Note:* You can use masks and image masks together.
The power of image masks is that they do not have to be drawn or animated. Instead, you can use virtually any image or movie clip to create transparency in another layer. By default, movie clips create animated image masks, but you can also set an image mask to use only a single frame.

Image masks can also be used to assign masks that were created in other applications. For example, you can import an animated mask that was created in another application and exported as a QuickTime movie into your Motion project, then use it as an image mask.

When you use a layer as an image mask, you can choose which of the layer’s channels to apply to create transparency via the Source Channel pop-up menu in the Image Mask tab of the Inspector. The choices include:

- Red
- Green
- Blue
- Alpha
- Luminance

Because alpha channels are basically 8-bit grayscale images, you can use any single color channel as an image mask. You can also use another layer’s alpha channel. Luminance allows you to use the aggregate luminance from the red, green, and blue channels of an image to create transparency. For all these options, color is ignored.

Assigning an image mask is a two-part process. First, you create a blank image mask underneath a layer. Then you assign the image you want to use to create transparency.

To add an image mask to a layer:
1. Select the layer you want to mask.
2. Choose Object > Add Image Mask (or press Shift-Command-M).

The image mask appears underneath the layer in the Layers tab and Timeline.

3. With the image mask selected, do one of the following:
• Open the Image Mask tab in the Inspector, then drag the layer you want to use as the mask into the Mask Source well.

![Mask Source well]

• Drag the layer you want to use as the mask into the Mask Source well in the HUD.

  **Important:** Be sure to click and drag in one movement to successfully drop a layer in an image well. If you select the layer to use as the source, then release the mouse button, you lose the selection.

  In this example, text is used as the mask layer.

4 Choose the channel you want to use to create transparency from the Source Channel pop-up menu, as well as any other options that are necessary to create the required transparency.

![leopard]

**Image Mask Parameters**

Once you’ve added an image mask to a layer, the following parameters become available in the Image Mask tab of the Inspector.

**Mask Source:** An image well that assigns a layer (a shape, text, an image, a movie, particle emitter, numbered image sequence, and so on) to use to mask a layer.
Frame: When you use a movie or image sequence as the assigned image, this slider allows you to select the start frame for playback.

Hold Frame: When you use a movie or an image sequence as the assigned image, selecting this checkbox freezes the frame specified in the Frame parameter. That frame is then used as the mask for the masked layer's total duration.

Offset: Offsets the X and Y values of the mask's position, relative to the layer it is masking. This allows you to change which part of the layer is masked.

Wrap Mode: If an image mask is smaller than the layer to which it has been assigned, you can increase the area it affects by selecting a wrap mode.
- None: The object is used as is.
- Repeat: The object is duplicated and tiled to fill up the full width and height of the image.
- Mirror: The layer is duplicated, tiled, and reversed to fill up the full width and height of the image. This may create a more seamless repetition for some images.

Source Channel: Lets you choose which channel of the assigned image is used to create the mask. There are five choices:
- Red: Uses the red channel as a grayscale mask.
- Green: Uses the green channel as a grayscale mask.
- Blue: Uses the blue channel as a grayscale mask.
- Alpha: Uses the alpha channel from the mask layer.
- Luminance: Uses the aggregate luminance from the red, green, and blue channels as a grayscale mask.

Mask Blend Mode: A pop-up menu that determines how an image mask interacts with the alpha channel of the layer to which it is applied. When a layer has multiple image masks, each mask can have a different Mask Blend mode. When this happens, each mask adds to, or subtracts from, the layer's alpha channel according to the selected mode. The final alpha channel is the combined result of all the image masks that are applied. These modes are identical to the Mask Blend Mode options available for shape masks. The four options are:
- Add: This is the default selection for new masks. The mask is added to the alpha channel. This is useful for adding back regions of an image that other masks are cutting out.
- Subtract: Subtracts a mask from the alpha channel. This is useful for creating holes in the middle of layers, or for masking out additional regions of an image that are untouched by other masks.
• **Replace:** This setting uses the current mask to completely replace the layer’s original alpha channel, as well as any other masks that are applied to the same layer that appear underneath the current mask in the Layers list. You can add additional masks above, set to whatever blending mode you like.

• **Intersect:** Masks that are set to Intersect do not replace a layer’s original alpha channel. Instead, they mask out all regions of the layer that do not overlap the mask itself. This includes other masks applied to the same layer that appear nested underneath the intersecting mask in the Layers tab.

**Invert Mask:** When this checkbox is selected, the mask is inverted—its solid and transparent areas are swapped. This is useful if you need to switch the solid and transparent areas of a mask you’ve already created.

**Stencil:** When this checkbox is selected, the layer’s geometric transforms are respected by the mask. If you’re creating a mask with transformed Scale, Position, Rotation, or other parameters, select this checkbox to use the modified layer.

**Stretch:** When this checkbox is selected, the mask is stretched to fit the boundaries of the image and remains centered on the layer’s center point.

**Note:** Stencil and Stretch are mutually exclusive.

**Applying Filters to Image Masks**
Like shape masks, you can add filters to image masks to further manipulate the transparency effect. In particular, you may be able to improve the mask that’s created by using color correction filters such as Brightness, Contrast, and Gamma to manipulate the contrast of the mask, pulling out or reducing detail to create the transparency effect you need.

Filtering image masks works identically to filtering shape masks. For more information, see “Applying Filters to Masks” on page 1100.

**Applying Behaviors to Image Masks**
You can also apply behaviors to image masks to create animated transparency effects. For more information, see “Applying Behaviors to Masks” on page 1101.

**Using Masks to Aid Keying Effects**
Keying is rarely a one-step process. Although adding a keying filter is the first step, there is usually additional work that needs to be done to create a good key that retains detail around the edge of your subject. The mask tools and alpha channel filters presented in this section can be used to turn a decent key into a great one.
Garbage Masks
The second step in many keying shots is to create a garbage mask to crop out unwanted objects in the shot that can’t be keyed, such as the edge of a bluescreen stage, lighting rigs, or tape that appears in the background.

You can also use a garbage mask to conceal parts of the background that are too difficult to key without the loss of foreground detail.

To create a garbage mask:
- Select a keyed layer, and use one of the mask tools to draw a mask around the foreground subject.
  
  Note: You may need to animate the garbage mask if the subject is moving.

By default, the mask is set to Add, and crops out everything outside the mask, while leaving the transparent areas within the mask alone.

For more information about using Motion’s keying filters, see “Keying Filters” on page 920.
Holdout Masks
Sometimes, while pulling a key, you lose part of the image you’re trying to keep. This can happen when the color of the subject’s clothes is too close to the color of the background being keyed out, or when you need to use keying values that are too aggressive. In this example, very small parts of the lioness’s head and face are getting removed with the key, rather than just the blue sky.

In these cases, you can duplicate the original layer, mask the part of the subject that’s being incorrectly keyed, and composite it over the keyed version to fill it back in.

**Note:** The Spill Suppressor filter can modify the color of the foreground subject as well. If you’re using the Spill Suppressor filter on the keyed layer, you may have to apply the same filter to the holdout mask layer to make sure the color matches.

**To create a holdout mask:**
1. Key and mask the foreground subject.
   
   For more information about using Motion’s keying filters, see “Keying Filters” on page 920.

2. Duplicate the keyed layer, then move it so that it appears above the original layer in the Layers tab or Timeline layers list.

3. Mask the area of the foreground that is incorrectly keyed.
Make sure that the mask is entirely within the subject being keyed.

Note: You may need to animate the holdout mask if the subject is moving.

4 On the newly duplicated layer, delete the original keying filters since they’re unnecessary.

If you’ve used a Spill Suppressor filter, don’t delete it, since it’s probably changing the color of the subject.

5 Feather the edge of the holdout mask you’ve just created, to make sure that it blends in with the object you initially keyed.

6 As an optional step, you can nest the originally keyed layer along with the holdout matte you just created inside a dedicated group so that you can manipulate the entire subject as a single object.
Performing Multiple Keys on a Single Subject
In some instances, it may be difficult to key an entire subject with a single keying filter while retaining fine details. For example, uneven lighting or background color might mean that the best settings to key a subject’s hair may not work elsewhere.

If you attempt to key the entire subject with a single keying filter, chances are that you need to use such extreme settings that a lot of edge detail is lost. In such cases, masks can be used to isolate different parts of a subject, so that you can apply different keying settings to each area.

To segment a subject into separate keying zones:
1. Create a new group, and place the layer you’re keying within the new group.
2. Duplicate the layer you’re keying until you have a separate duplicate for each part of the image you want to key separately.
3. Use one of the mask tools to mask each part of the subject in each of the duplicate layers.
   Make sure that all of the duplicate layers overlap, so that there are no gaps in the foreground.
   Note: You may need to animate the overlapping masks if the foreground subject is moving.
4. Apply the appropriate keying filter to each of the isolated parts of the subject, and adjust each filter’s settings as necessary.
   Eventually, you may find you can achieve an optimal key for each part of the subject. Furthermore, with all duplicates nested within a single group, you can continue to manipulate the subject as a single object.

Manipulating Alpha Channels Using Filters
In addition to using shape and image masks to create transparency within layers, there are also filters you can use to manipulate or even replace a layer’s alpha channel.

For example, all of the keying filters create transparency by generating an alpha channel based on colors or luminance values in that layer. Keying filters are usually used on layers that have no alpha channel information, and they add a new alpha channel to the layers to which they’re applied. For more information on the use of the keying filters, see “Keying Filters” on page 920.
The process of improving a keying effect, or of customizing an alpha channel created using one or more shape or image masks, may require the use of special filters. Although you can apply any filter directly to a shape or image mask to modify that particular mask’s effect, the filters described in this section modify a layer’s entire alpha channel directly, including the sum total of all masks and other filters that have been applied to that layer.

For example, if you’ve applied a keying filter, you can use the following filters to modify the resulting alpha channel even though no mask appears for that layer in the Layers tab or Timeline.

**Channel Blur**: This filter, found in the Blur category of the Filters library, lets you selectively blur the alpha channel. You can set the amount of horizontal and vertical blur independently.
**Matte Choker:** This filter, found in the Matte subcategory of the Filters library, increases or decreases the semi-transparent area of a layer’s alpha channel by performing a gamma correction (similar to the Gamma color correction filter) to all regions of the alpha channel falling between solid black and solid white. This allows you to widen or narrow the semi-transparent areas within a layer, while leaving all 100 percent solid and transparent areas unaffected. Once you’ve added a Matte Choker to a layer, the following parameters become available in the Filters tab of the Inspector:

- **Edge Thin:** A slider that allows you to modify the edges of the matte. Higher positive Edge Thin values eat into the alpha channel, eliminating fringing around the edges of translucent areas. Negative values fill in translucent values, filling in holes and widening the matte into areas of fringing.
- **Feather:** A slider that allows you to adjust edge translucence. Lower values reduce the amount of translucence in a matte, but this results in harder edges around holes and edges in the alpha channel.
- **Mix:** A slider that sets what percentage of the original image is blended with the filtered image. Values range from 0 to 100%.

![Keyed original object (color channel)](image1.png) ![Keyed object with holes (alpha channel)](image2.png)  
*Keyed original object (color channel) Keyed object with holes (alpha channel)*

![Keyed object with Matte Choker (color channel)](image3.png) ![The Matte Choker eliminates the holes (alpha channel)](image4.png)  
*Keyed object with Matte Choker (color channel) The Matte Choker eliminates the holes (alpha channel).*
**About Rasterization and Groups**

Some operations, as well as the application of certain filters or a mask, cause a group to be rasterized. When a group is rasterized, it is converted into a bitmap image. Because all shape (masks, shapes, and paint strokes) layers live in groups, this affects how shapes interact with other objects within your project.

*Note:* Paint strokes render in a plane, so they can always be thought of as rasterized. This is independent of other objects within the group in which it lives. This affects how the dabs interact with objects within its own group.

Rasterization affects 2D and 3D groups in different ways. When a 2D group is rasterized, the blend modes on objects within the group no longer interact with objects outside of the group.

In addition, when a 3D group is rasterized, the group as a whole can no longer intersect with objects outside of the group. The rasterized 3D group is treated as a single object and uses layer order, rather than depth order, when composited in the project. For more information on layer order versus depth order, see “3D Compositing” in the *Motion Supplemental Documentation* PDF.

*Note:* When a group is rasterized, cameras and lights in the project still interact with objects within the rasterized group.

Changes to the following parameters trigger the rasterization of a group:

**2D Groups**
- Making Blending changes (Opacity, Blend Mode, Preserve Opacity)
- Turning on Drop Shadow
- Turning on Four Corner
- Turning on Crop
- The application of any filter
- Adding a mask
- Adding a light

**3D Groups**
- Blending changes
- The application of certain filters
- Adding a light to a 3D group with the Flatten parameter enabled (in the Group tab of the Inspector)

Once an operation causes a group to rasterize, the following occurs:
- A rasterization indicator (resembling an LED) appears next to the parameter in the Properties tab.
• A small outline appears around the rasterized 2D group, 3D group, emitter, replicator, or text icon (to the left of the group name) in the Layers tab and Timeline layers list.

Note: Because a paint stroke is always rasterized, no rasterization indicator appears around the paint stroke icon.

For more information on rasterization and 3D groups, see “3D Compositing” in the Motion Supplemental Documentation PDF.
Working with Audio

Sound is an integral part of many motion graphics projects. Use audio in your project for background music, dialogue, or scratch tracks.

You can add audio files to your project and use markers and keyframes to sync the audio with other events in your project. You can import several different types of audio files, including the audio tracks from QuickTime movie clips. For each mono audio file you add to a project, Motion creates a single audio track. For each multichannel audio file you add to a project, Motion creates a single audio track for each channel.

You can turn audio tracks on and off, select and play individual tracks, mute and solo tracks, and control volume and pan settings for each track in the Audio tab of the Project pane.
You can add keyframes for volume and pan to an audio track and trim an audio track in the Audio Editor or in the Keyframe Editor. You can also trim an audio track in the Timeline.

You can export audio with video, or export audio alone, in a variety of formats. See “Exporting Audio” on page 1145 for a list of the audio export formats Motion supports.

If you have Soundtrack Pro installed, an audio file that exists in a Motion project can be opened and modified in Soundtrack Pro. The modified file is automatically updated in Motion. For more information, see “Using Soundtrack Pro with Motion” on page 1144.

**Audio Files in Motion Projects**

You can add different kinds of audio files to a Motion project. In addition, Motion lets you preview files before adding them to your project and lets you view the audio files in a project in several ways.

**Import File Formats**

Motion supports audio in a variety of common file formats, sample rates, and bit depths. Supported import file formats include:

- AIFF
- WAV
- MP3
- AAC (except rights-protected AAC files)
- QuickTime Audio (.mov)

*Note:* Multitrack QuickTime movie files and multichannel audio files are also supported.

You can import audio files with sample rates up to 192 kHz and with bit depths up to 32 bits. Mono and stereo files are supported.

*Note:* Because MP3 and AAC are compressed file formats, playback quality may not be as high as with uncompressed formats such as AIFF.
When you add an audio file to your project, Motion converts it to its own internal format. This allows you to use audio files with different formats, sample rates, and bit depths in the same project. When you export your project, the audio is exported according to the current audio settings in the Export dialog.

**Previewing an Audio File**
You can listen to, or preview, an audio file in the File Browser before adding it to a project.

To preview an audio file, do one of the following:

- In the File Browser, select the audio file.
  The file begins to play.

  **Note:** If the file does not play automatically, select “Play items automatically on a single click” in General Preferences (or press Command-comma).

- In the File Browser, select the audio file, then click the Play button in the Preview area.
  While the file is playing, you can click the button again to pause playback or click the Mute button to mute/unmute the sound.

**Adding an Audio File**
To work with audio in your project, you start by adding an audio file to the project.

**Note:** Although you can see a connected iPod in the File Browser as a hard disk, you can only browse for and import files stored in the hard disk storage area of the iPod into Motion.

To add an audio file from the File Browser, do one of the following:

- Drag the file from the File Browser or the Finder into the Canvas.
- Drag the file from the File Browser or the Finder into the Project pane or Timeline layers list.
  - Dragging the file to the Layers tab adds the audio file to the Media tab and the Audio tab.
  - Dragging the file to the Media tab adds the audio file to the Media tab but does not add it to the project. To add the file to the project, drag the file from the Media tab to the Canvas.
• Dragging the file to the Audio tab adds the audio file to the Media tab and the Audio tab.

• Drag the file from the File Browser or the Finder into the audio area of the Timeline (not the Audio Editor).

**Note:** To display audio in the Timeline, click the Show Audio button in the bottom of the Timeline layers list.

When a black border appears around the audio section, release the mouse button.

• In the Audio tab, click the Add button (+), locate the file you want to add, then click Import.

**Note:** If you use the Add button (+) in the Media tab, the audio file is only added to that tab. To use the file in the project, drag the file from the Media tab to the Canvas.

**To add an audio file from iTunes:**
1. In the Library, select the Music category.
2. Select a playlist, then select a song in the file stack.
3. Do one of the following:
   • In the Preview area, click Apply.
   • Drag the file to the Canvas, Project pane, or Timeline layers list.

**Note:** Rights-protected AAC files cannot be imported into Motion and do not appear in the file stack. This includes all music purchased from the iTunes Store.
The audio file is added to the project and appears in the Audio tab of the Project pane, the Audio Editor, and the Timeline (if the Show Audio button is turned on). The start point of the audio file is determined by the Create Layers At preference in the Project pane of Motion Preferences. If set to “Start of project,” the file starts at the beginning of the project. If set to “Current frame,” it starts at the current location of the Timeline playhead. A HUD for the audio appears in the Canvas.

**Note:** If the HUD does not appear, press D or F7.

When you drag a QuickTime movie into the Canvas or the Layers tab of the Project pane, the movie's video and audio tracks are imported into your project. You can choose to add only the audio track of a QuickTime movie.

You can also drag the file directly to the Media tab. As with image files, this stores the file in the project but does not "use" the file until you actively add the file to the Timeline layers list or Canvas. To use the file, drag the media file from the Media tab to the Canvas or Timeline layers list.

**To add only the audio track from a QuickTime movie:**
- In the File Browser or in the Finder, locate the QuickTime movie file, then drag it into the Audio tab of the Project pane.
  - The audio track from the movie is added to your project, without the video footage.
  - The video footage is added to the Media tab.

If the QuickTime movie contains multiple audio tracks, drag and the file over the Audio tab, the Canvas, or the Timeline layers list, holding down the mouse button until the drop menu appears. To import the file with a single audio track, choose Mix To Stereo. To import the file with individual tracks, choose Import All Tracks. For more information, see “Importing Multichannel Audio to Motion” below.

**Importing Multichannel Audio to Motion**
Multichannel audio files can be imported as a single track or as individual tracks. The same applies to QuickTime movie files that contain multiple audio tracks, including files with stereo audio tracks. For the purposes of this document, multichannel audio files and multitrack QuickTime files can be manipulated in the same way, and should be considered interchangeable. When this document refers to multitrack QuickTime files, multichannel audio files are treated in the same way.

When importing a multitrack QuickTime movie file, you can import the audio portion of the file as a single audio track or as individual tracks.
When you add any media file to Motion, an audio track appears that can be used independently of the video file. When the file is unlinked from its source, a track can be individually enabled, disabled, or deleted. Deleting a source QuickTime movie file from the Media tab, however, deletes all audio and video that originated from that file.

**Important:** Because Soundtrack Pro also supports multichannel and multitrack audio files, you can open a multichannel file in Soundtrack Pro from Motion. For more information on modifying audio tracks in Soundtrack Pro, see “Using Soundtrack Pro with Motion” on page 1144.

**Note:** When you export a multichannel audio file from Motion, you may choose whether to export all channels or mix them down into a single track.

**To import a multitrack QuickTime movie file using the drop menu:**

1. Drag the file from the File Browser or the Finder to the Canvas, holding down the mouse button until a drop menu appears.

2. Do one of the following:
   - To import the movie with a single audio track, choose Mix To Stereo, then release the mouse button.
   - To import the movie file with a single audio track for each track, choose Import All Tracks, then release the mouse button.

When you choose Mix To Stereo, the file appears in the Audio tab as a single audio track and the video appears in the Canvas (and Layers tab). The link icon in the Lock column of the Audio tab indicates that the audio object has a corresponding video element.

**Note:** When a multitrack QuickTime file is imported without using the drop menu, Mix To Stereo is the default import method.
In the Layers tab, the link icon also appears in the Lock column for the object, indicating the object has a corresponding audio element.

When you choose Import All Tracks from the drop menu, the file appears in the Audio tab with an individual audio track for each track in the file. The following image shows the Audio tab after importing a multitrack QuickTime movie file that contains six channels with a single channel in each track.

To import a multitrack QuickTime movie file using the Import command:
1. Choose File > Import (or press Command-I).
2. In the Import File dialog, select the QuickTime file.
3. Choose an import option from the Audio pop-up menu (located at the bottom of the Import Files dialog), then click Import.

The file is imported with your chosen option.
Viewing Audio Files
You can view a listing of all the audio tracks in your project and view the audio waveform for an individual track. You can also view information about each track, including its duration, sample rate, and file size. In the Audio tab, each channel in a multichannel audio file—or each track in a multitrack file—can be selected separately.

To view a listing of your project’s audio tracks:
- In the Project pane, click the Audio tab to see the audio files in your project.

To view the waveform of an audio track:
- Select an audio file or channel of a multichannel file in the Audio tab, then do one of the following:
  • Click the Timeline tab in the Timing pane, then click the Show/Hide Audio button at the lower left of the pane.
    A bar appears, containing the waveform of the file, if the Timeline row size is tall enough. If the bar does not contain a waveform, adjust the height of the bars in the Timeline. For more information about how to adjust Timeline tracks, see “Timeline Layers List Display Options” on page 87.
  
  Important: In a multichannel audio file, all of the audio channels in the file appear in the Timeline.

  • Click the Keyframe Editor tab in the Timing pane, then click the Show Audio Waveform button at the lower-left corner of the pane.
    The waveform of the track appears in the Keyframe Editor, along with any keyframes, if the Timeline row size is tall enough.

  Note: If there are multiple audio tracks in the project, the waveform of the master track appears in the Keyframe Editor, and a pop-up menu at the bottom of the Keyframe Editor allows you to view the waveform of any individual audio track in the project or the master track.

  • Click the Audio Editor tab in the Timing pane.
    The waveform of the selected track appears in the Audio Editor.
Viewing the audio waveform can be useful in the Keyframe Editor to synchronize motion and other parameter changes with audio events such as peaks or points of silence, and in the Audio Editor to synchronize level and pan changes with audio events.

To view information about your project’s audio files, do one of the following:

- In the Project pane, click the Media tab.
- In the Media tab of the Project pane, select the audio file, and then display the Inspector (press Command-3).

The Media tab and Inspector display information about each audio file, including kind, duration, sample rate, format, file size, and other details.

**Cutting, Copying, and Pasting Audio Tracks**

You can cut, copy, and paste audio tracks in the Audio tab. You can also duplicate tracks.

**To cut an audio track:**

- In the Audio tab, select the audio track, then do one of the following:
  - Choose Edit > Cut (or press Command-X).
  - Control-click the track, then choose Cut from the shortcut menu.

**To copy an audio track:**

- In the Audio tab, select the audio track, then do one of the following:
  - Choose Edit > Copy (or press Command-C).
  - Control-click the track, then choose Copy from the shortcut menu.

**To paste an audio track:**

- In the Audio tab, do one of the following:
  - Choose Edit > Paste (or press Command-V).
  - Control-click an empty area, then choose Paste from the shortcut menu.

**To duplicate an audio track:**

- In the Audio tab, select the audio track, then do one of the following:
  - Choose Edit > Duplicate (or press Command-D).
  - Control-click the track, then choose Duplicate from the shortcut menu.

The duplicate appears below the original file in the Audio tab.
Deleting an Audio File
There are two ways to remove an audio track from your project.

To delete an audio track:
- In the Audio tab, select the audio track, then do one of the following:
  - Press the Delete key.
  - Click the Delete button (–) at the top of the Audio tab.
  - Control-click the file you want to remove, then choose Delete from the shortcut menu.

If you try to delete an audio file with linked video, the following alert dialog appears:

Note: Deleting tracks from the Audio tab removes the associated file from the Media tab if “Automatically removed unused media” is selected in the General pane of Motion Preferences.

Working with Audio Tracks
When you add an audio file to your project, Motion creates one or more audio tracks for the file. In the Audio tab of the Project pane, you can turn audio tracks on and off, select tracks, mute and solo tracks, and control their volume and pan settings.

Any changes you make to an audio track, such as renaming or trimming it, do not affect the source audio file.

Turning Audio Tracks On or Off
When you add an audio file to your project, it becomes a track in the Audio tab and is turned on by default. You can turn individual audio tracks on or off in the Audio tab. Turning off an audio track silences it during playback, and means the track is not part of your final mix when you export the project.
To turn an audio track on or off, do one of the following:

- In the Audio tab of the Project pane, click the activation checkbox on the left side of the track. Click the checkbox again to return the track to its previous state (on or off).

- In the Timeline, with the Show/Hide Audio button turned on, click the activation checkbox (in the left column). Click the checkbox again to return the track to its previous state.

Turning an audio track off removes it from the overall audio mix.

### Selecting Audio Tracks

To display an audio track in the mini-Timeline and in the Audio Editor, you first select it.

**To select an audio track:**

- Click anywhere in the row containing the track’s name and controls in the Audio tab. Selected tracks are highlighted.

You can select multiple tracks by Shift-clicking. However, the Audio Editor can display only one track at a time. When multiple tracks are selected, the Audio Editor appears empty.

### Playing Audio Tracks

When you click the Play button in the transport controls, you hear the audio tracks in your project play in time with your visuals. You can also play an individual audio track separately from the project Timeline.

**To play audio with your project:**

- Click the Play button in the transport controls.

When you click the Play button, you hear all audio tracks in the project that are turned on and are not muted.

**To play an individual audio track:**

1. In the Audio tab, select the audio track.
2. In the Audio Editor, click the Play button.

   The audio track plays, and the playhead in the Audio Editor shows the region of the track currently playing. Playback in the Audio Editor is independent of the project. By default, when you play audio tracks, the playback sample rate and bit depth are determined by the playback device. If you are playing audio using an external device, Motion plays the audio using the sample rate of the device.
Muting and Soloing Tracks

When you mute an audio track, it is silent during playback, but is still part of the mix when you export your project. When you solo an audio track, all other audio tracks are muted, which lets you hear the soloed track more clearly.

You can mute, unmute, solo, or unsolo an audio track at any time, even during playback. When you export your project, all tracks that are turned on are included in the final mix, regardless of whether they are muted or soloed.

To mute an audio track, do one of the following:
- Click the Mute button.
- Click the Mute button again to unmute the track.
- Control-click the track, then choose Mute from the shortcut menu.

To solo an audio track, do one of the following:
- Click the Solo button.
- Click the Solo button again to unsolo the track.
- Control-click the track, then choose Solo from the shortcut menu.

You can also solo multiple audio tracks. When you solo more than one track, all tracks not soloed are muted (silent) during playback.

Setting Levels

Level refers to the loudness or volume of an audio track (sometimes referred to as gain). You can adjust an audio track’s level using the Level slider. The available range is from –96 (minimum level) to 6 (maximum level). The default is 0 (sometimes called unity gain). The values correspond to the decibel scale (dB).

To set an audio track’s level:
- In the Audio tab, the track’s HUD, or the Audio Track tab of the Inspector, drag the Level slider to set the level you want. In the Audio tab, the Level slider is located in the Name column under the track’s name.

You can also type a value in the value field. You can set the level in integer increments (–1, 0, 1, and so on).
Selecting Output Channels
If you’re working with multichannel audio, you can adjust which tracks are assigned to which output channels, or you can create your own multichannel file from mono tracks.

To set or change output channels for an audio track:
1. Choose 5.1 Surround from the Master Output Channel pop-up menu at the bottom of the Audio tab.
2. Choose an output channel for the specific audio track from the Output Channel pop-up menu (in the track list of the Audio tab).

Note: If you do not have surround-sound hardware, the Center, LFE, Left Surround, and Right Surround output channels will be italicized. You can still select those channels and your choices will be reflected in an exported project or playback on a system that does have the right hardware.

Setting Track Panning
Pan refers to the left-right balance of a track in the stereo field. You can adjust a track’s pan position using the Pan slider. The available range is from –100 (hard left) to 100 (hard right). The default is 0 (center).

To set a track’s pan position:
- In the Audio tab, the track’s HUD, or the Audio Track tab of the Inspector, drag the Pan slider to the left or right to set the pan position for the track.
  You can also type a value in the value field. You can set the pan position in integer increments (–1, 0, 1, and so on). The pan field shows numbers in a three-digit format (000, for example).

Locking Tracks
Locking a track prevents it from being edited. When a track is locked, you cannot mute or solo the track, change its level or pan, move or trim it, or add keyframes. You can still play the track, and turn it on or off.

To lock a track:
- In the Audio tab, click the lock icon on the right side of the track. Click the lock icon again to unlock the track.

Renaming Tracks
You can also rename a track, to give it a more useful name in the project.

To rename a track:
- In the Audio tab, double-click the track’s name in the Name column, then type a new name.
**Working with the Master Track**

Each project has a Master audio track. The controls for the Master track are located at the bottom of the Audio tab, below the individual audio tracks. Using the Master track's controls, you can make changes that affect the final mixed output of all audio tracks. For example, you can lower the volume of all tracks at once, or pan all tracks to the left or right. In addition, you can turn the Master track on or off, or mute it.

You select the Master track by clicking its area at the bottom of the Audio tab. When selected, the Master track area appears highlighted.

**Turning the Master Track On or Off**

The Master track is turned on by default. When it is turned off, no sound is audible when you play the project, and no audio is included when you export your project. When it is turned on, all audio tracks that are turned on are included in your export.

To turn the Master track on or off:
- Click the checkbox at the left side of the Master track. Click the checkbox again to return the Master track to its previous state.

When the master track is selected, a master waveform appears in the Audio Editor.

**Setting Master Level**

You can use the Master Level slider to set the overall volume level for the audio in your project.

To set the master level:
- Drag the Master Level slider to set the level you want.

The Master level works in conjunction with the level setting for each individual track. For example, if you set a track's level to 0.5 and you set the master level to 0.5, the combined level is 0.25 (one-fourth) of the original.

**Note:** If you raise both an individual track's level and the Master level so that the combined increase is greater than 2, you may cause audio distortion or "clipping." For information about how to prevent clipping, see “Preventing Clipping” on page 1131.
Viewing the Master Level
To the right of the Master track controls is a pair of stereo level meters that display the combined level of all the audible tracks.

If either of the two red dots above the level meters (called clipping indicators) light up during playback, this indicates that your master levels are too high, causing audio distortion or clipping.

Preventing Clipping
Typically, when working with digital audio, audio engineers set the overall volume level as high as possible without causing clipping. If the clipping indicators light up above the master level meters, you need to find where clipping is occurring and lower the level to eliminate the cause of the clipping.

If clipping occurs, play the project and observe where the clipping indicators light up. You may want to solo each audio track to determine if a particular track is causing the clipping. You can also play a track in the Audio Editor and watch the Audio Editor’s level meters, which show only the levels of the track playing.

Once you determine which track is causing the clipping, you can lower the track’s overall level, or use keyframes to lower the track’s level at the specific point in time where clipping occurs.

The clipping indicators are “sticky,” meaning that once they light up, they stay lit until you reset them or close the project. This is intended to help remind you to find and eliminate the cause of the clipping before you export your project. As you work to eliminate clipping, reset the clipping indicators and play the project again to make sure clipping no longer occurs.

To reset the clipping indicators:
- Click the clipping indicator that is lit.

Setting Master Pan
You can use the Pan slider in the Master track to set the left-right pan position for the audio.

To set the Master pan position:
- Drag the Pan slider to place the sound where you want it in the stereo field.
The Master pan slider works in conjunction with the pan setting for each individual track. For example, if you pan a track to –100 (hard left) and you pan the master to 100 (hard right), the track is inaudible.

**Slipping Audio Tracks**
When you import an audio file, its start point is set to the location based on the setting of the Create Layers At parameter in Motion preferences. You can slip an audio track so it starts playing at a different point in time.

![Slipping Audio Tracks](image)

**To slip an audio track:**
1. In the Audio tab, select the track.
   The bar for the audio file appears in the mini-Timeline.
2. In the mini-Timeline, drag the track’s bar left or right. As you drag the bar, a help tag appears, showing the In and Out points for the track.

   *Note:* You can also show and slip the timebar for an audio track in the Timeline. To display audio in the Timeline, click the Show/Hide Audio button in the display options (located in the lower section of the Timeline layers list).

**Trimming Audio Tracks**
You can edit the start and end points of an audio track to cut down the length of the audio in the track, or to have it start or end at a specific point in time. This is called “trimming” the track. Motion lets you trim audio tracks, either visually or by entering numeric values for the In and Out points.

When you trim an audio track, the audible part of the track is highlighted in green in the Audio Editor. Trimming an audio track is nondestructive, and does not affect the original audio file.

**To trim an audio track visually:**
1. In the Audio tab, select the audio file you want to trim.
   The track’s timebar appears in the Audio Editor and in the mini-Timeline.
2 In the Audio Editor or the mini-Timeline, position the pointer over the beginning or end of the timebar, and the trim pointer appears.

3 Drag the beginning or end of the timebar to the point where you want to set the In or Out point for the file.

The progress of your trim is displayed in the Audio Editor and lets you see the time markers, so you can trim more precisely.

To trim an audio track numerically, do one of the following:
- In the Audio Editor, type a value in the In field where you want the track to begin, or type a value in the Out field where you want the track to end.
- Click the arrow at the left edge of the field to decrease the value, or click the arrow at the right edge of the field to increase the value. Shift-click to move in increments of 10.
- Position the pointer over the number in either the In or Out field, and the drag pointer appears. Drag left to increase the value, or drag right to decrease the value.

Scrubbing an Audio Track
You can scrub an audio track in the Audio Editor to hear a portion of the track. Use the Audio Scrubbing button to turn scrubbing on or off. Scrubbing is turned on by default in the Audio Editor (it is off by default in the Timeline).

To scrub an audio track:
1 In the Audio tab, select the track.
2 If scrubbing is turned off, click the Audio Scrubbing button, located at the lower-left corner of the Audio Editor, to turn on scrubbing.
3 Drag the playhead in the Audio Editor left or right. Keep the pointer still to loop continuously on the frames adjacent to the current frame.

**Note:** By default, audio scrubbing loops continuously on the 5 frames adjacent to the current frame when you keep the pointer still. You can turn off looping by choosing Motion > Preferences, clicking the Project icon, then turning off the “Loop audio while scrubbing” checkbox under Playback Control.

You can also scrub audio in the Timeline or Keyframe by Option-dragging in the ruler at the top of the Timeline. You can scrub audio in the mini-Timeline by Option-dragging the playhead in the mini-Timeline.

**Keyframing Level and Pan Changes**

Each audio track has curves for both level and pan, and you can add and edit keyframes to automate level and pan changes over time. This lets you create fade-ins and fade-outs, drop audio levels for voiceovers and other sound effects, and eliminate clipping. You edit the curves directly on the audio waveform in the Audio Editor, allowing you to make accurate edits.

For more information about using keyframes and editing curves, see “Keyframes and Curves” on page 503.

**Recording Keyframes**

You can record keyframes for audio level and pan by clicking the Record button, then moving the sliders in the Audio tab, the HUD, or the Inspector. Recording keyframes for audio level and pan can be useful for trying out changes, and when you want to hear the results in real time.

**Adding and Editing Keyframes**

In the Audio Editor, level curves are displayed as a purple dashed line, and pan curves are displayed as a blue dashed line. Both curves appear overlaid on top of the audio waveform. The ranges of level and pan curves are:

- Level curves range from –96 to 6 with 0 equivalent to 0 dB (unity gain).
- Pan curves range from –100 to 100.

The range of values is displayed along the left side of the Audio Editor. Because level and pan curves each use a different scale, you can only see numerical values for a curve if the checkbox for that curve is turned on, and the checkbox for the other curve is turned off.

**To add keyframes to a level curve:**

1. Turn on the Level checkbox. You may want to turn off the Pan checkbox, so that you can see the level curve more clearly, and see its numeric values on the left.

2. Option-click the purple level curve to add a keyframe.
3 Drag the keyframe up or down to set the level you want at a specific time. Drag down to lower the level, or drag up to raise the level.

4 Add any other keyframes you need, and drag each one to set its value.

![Keyframe Editor](image)

You can use curves to create fade-ins, fade-outs, and other level changes in the Audio Editor.

**Note:** You can also perform these operations in the Keyframe Editor.

**To add keyframes to a pan curve:**

1 Turn on the Pan checkbox.

You may want to turn off the Level checkbox, so that you can see the pan curve more clearly, and see its numeric values on the left.

2 Option-click the blue pan curve to add a keyframe.

3 Drag the keyframe up or down to set the pan position you want at a specific time.

   Drag down to pan to the left, or drag up to pan to the right.

4 Add any other keyframe you need, and drag each one to set its value.

   **Note:** When modifying Pan values, you can Control-click a keyframe to display a shortcut menu that lets you set different interpolation methods between points on your curve. See “Modifying Curves” on page 545 for more information. Only the Linear interpolation method is available for Level.

**Crossfading Audio Tracks**

In the Keyframe Editor, you can view the audio tracks in your project, along with the level, pan, and speed curves for each track.

To create a crossfade, add keyframes to the level curve of each track at the same (or nearly the same) points in time, where you want the crossfade to start and end. You can use the frame numbers in the ruler of the Audio Editor for reference.

Be sure to listen to the crossfade as you work. You may find that the best-sounding results are achieved by having the level curves for the two tracks be slightly asymmetrical. This is because the perceived loudness of different sounds with the same numerical value in the Audio Editor can be different.
Syncing Audio and Video Tracks
Motion lets you determine how to handle the playback of audio if the audio tracks are not in sync with the video. You can choose to skip video frames in order to re-sync with the audio, or to pause audio playback to avoid skipping frames if the video is out of sync.

To set audio sync preferences:
1. Choose Motion > Preferences, then click the button for the Project pane.
2. In the Playback Control section of the Project pane, click the “Skip video frames” button to skip frames, or click the “Pause audio playback” button to pause audio playback.

When you select “Pause audio playback,” audio playback pauses when video and audio are out of sync, then begins playing when it catches up on the next loop.

Retiming Audio
Motion allows you to retime audio clips or individual channels to speed them up, slow them down, or play them back at a different speed. All of the controls below can apply either to a stereo audio clip, or individual channels.

Note: When retiming video, audio attached to the footage is automatically retimed along with it. You can unlink video and audio to retime them separately. For more information on retiming footage, see “Retiming” on page 312.

Timing Controls in the Inspector
Each audio object has individual timing parameters in the Properties tab.

Speed: Sets the speed of the audio clip as a percentage. The default is 100%. Values lower than 100 play back the audio clip more slowly than its original speed, and also extend the Duration of the audio clip. Values higher than 100 play back the audio clip faster than its original speed, and shorten the Duration of the audio clip.

In: Sets the In point of the audio clip. Adjusting this parameter always moves the audio clip In point to the specified frame without affecting its duration.

Out: Sets the Out point of the audio clip. Adjusting this parameter always moves the audio clip Out point to the specified frame without affecting its duration.

Duration: Sets the total duration of the audio clip. Adjusting Duration will also affect the Speed and the Out point.

End Condition: Sets how playback continues when the end of the audio clip is reached.
- None: The default setting. The audio clip's duration in your project is equal to the duration of its source media file.
• **Loop:** When the last frame of the audio clip is reached, it loops back to the first frame and plays again. This can cause a jump in the audio clip's apparent playback unless it was designed to be looped seamlessly.

• **Ping-Pong:** When the last frame of the audio clip is reached, the next iteration of clip playback is reversed. This is mainly for reference, as Motion does not support true reverse playback.

• **Hold:** With this selected, the audio stops at the loop point.

**End Duration:** Sets the number of frames by which the clip is extended at the end of its duration. This value may be adjusted only if End Condition is set to a value other than None.

**Adjusting a Track's Speed in the Timeline**
Motion allows you to change the timing of audio tracks in the Timeline as well.

**Important:** To affect all channels of a multichannel audio file, select all the tracks in the Audio tab (press Command-A) before making adjustments in the Timeline.

**To shorten the audio clip's duration and speed up its playback speed:**
1. Move the pointer over the Out point of the audio track.
2. Press and hold down the Option key. The pointer turns into the retiming pointer.
3. While continuing to hold down the Option key, do one of the following:
   • Drag the In point of the track bar to the right.
   • Drag the Out point of the track bar to the left.
As you drag, the tooltip displays the clip's duration and speed.

**To slow down an audio clip:**
1. Move the pointer over the audio track in the Timeline.
2. Press and hold down the Option key. The pointer turns into the slip pointer.
3. To lengthen the clip's duration and slow down its playback speed, do one of the following:
   • Drag the In point of the track bar to the left.
   • Drag the Out point of the track bar to the right.
As you drag, the tooltip displays the clip's duration and speed.
Looping an Audio Clip

Another way of extending a clip's duration is by looping it. You can easily loop a clip by adjusting it in the Timeline. When a looped audio clip reaches its last frame, the audio starts playing again from its first frame.

To loop an audio clip:
1. Move the pointer close to the Out point of the audio track in the Timeline.
2. Press and hold down the Option and Shift keys.
   The pointer turns into the loop pointer.
3. Drag the Out point of the layer's bar to the left.

As you drag, the tooltip displays the clip's In and Out points, duration and loop duration. A looped clip has barriers to indicate where loops begin and end in the Timeline.

The first loop barrier in a clip's bar is interactive. Moving the barrier changes the point at which the clip loops.

To change the loop point of an audio clip:
- Drag the first loop barrier left or right.
  The end point of the clip's loop moves as you drag.

Using Markers with Audio

When you add project markers to the Timeline, they appear in all three tabs of the Timing pane: the Timeline, the Keyframe Editor, and the Audio Editor. You can use project markers to designate “hit points” as you play back the project, to quickly jump to a specific point in time, or to highlight points where you want to synchronize visual and audio events.
For information on adding and deleting markers, moving markers, editing marker information, and using markers, see “Adding Markers” on page 362.

**Audio Behaviors**

Audio behaviors can be applied either to audio tracks from movie clips with sound or standalone audio tracks. There are several ways to apply an audio behavior:

- Dragging an Audio behavior from the Library directly to an audio track in the Audio tab or Timeline
- Selecting a track in the Audio tab or Timeline and then clicking the Add Behavior icon in the Toolbar and choosing an Audio behavior from the pop-up menu

For more information about applying behaviors, see “Applying and Removing Behaviors” on page 374.

There are two useful behaviors to control audio tracks in Motion:

**Audio Auto Pan**

Automates commonly-used panning effects in an audio track.

**Parameters in the Inspector**

**Pan Position:** Sets the position of the pan. If the Pan Position is set to 0, the sound is equally balanced between the left and right channels. With larger negative values of Pan Position, the sound increases in volume in the left channel and decreases in the right channel. With larger positive values of Pan Position, the sound increases in volume in the right channel and decreases in the left channel.

**Depth:** Sets how far the automatic pan occurs in the left and right channels. Values range from 0 to 100.

**Direction:** Sets the direction in which the pan moves over the behavior’s duration. Value can be set to Left or Right. If the direction is set to right, over the behavior’s duration the volume of the audio decreases in the left channel as it increases in the right channel, giving the impression of a sound moving from left to right. If the direction is set to Left, over the behavior’s duration the volume of the audio decreases in the right channel as it increases in the left channel, giving the impression of a sound moving from right to left.

**Volume:** Sets how the audio levels are affected during the pan. Value can be set to Constant, Ramp Up, Ramp Down, Crescendo, or Decrescendo.

<table>
<thead>
<tr>
<th>Peak type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ramp Up</td>
<td>An animation curve that creates a constant increase in volume</td>
</tr>
<tr>
<td>Ramp Down</td>
<td>An animation curve that creates a constant decrease in volume</td>
</tr>
<tr>
<td>Peak type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Crescendo</td>
<td>A logarithmic animation curve that creates a slowly-accelerating increase in volume</td>
</tr>
<tr>
<td>Descrescendo</td>
<td>A logarithmic animation curve that creates a slowly-decelerating decrease in volume</td>
</tr>
</tbody>
</table>

**Gain:** Sets the target gain used for volume. Values range from –96 dB to +6 dB.

**Loops:** Sets the number of times the auto pan effect repeats. Values range from 1 to 30.

**Apply Volume:** Sets how the audio levels change when the Auto Pan effect repeats. Value can be set to Once Per Loop or Over Entire Duration. If set to Once Per Loop, the Auto Pan affects audio level changes each time a loop marker is met. If set to Over Entire Duration, the Auto Pan affects audio level changes.

**End Condition:** Sets how the pan loops when the Auto Pan effect repeats. Value can be set to Repeat or Ping Pong. This setting has an effect only if Loops is set to a value greater than 1.

**Start Offset:** Sets the number of frames from the beginning of the audio after which the audio effect starts.

**End Offset:** Sets the number of frames from the end of the audio before which the audio effect stops.

**HUD Controls**
The HUD contains the same controls as the Inspector, with the exception of the Start Offset and End Offset controls.

**Audio Fade In/Fade Out**
Automates fading in and out an audio track.

**Parameters in the Inspector**

**Fade In Time:** Sets the number of frames over which the audio fades in from –96 dB to 0 dB from the first frame of the audio track. A duration of 0 frames leaves the beginning of the audio track unmodified.

**Fade Out Time:** Sets the number of frames over which the audio fades out from 0 dB to –96 dB. A duration of 0 frames leaves the end of the audio track unmodified.

**Start Offset:** Sets the number of frames from the beginning of the audio track after which the volume animation starts. Adjust this parameter to make the behavior start after the beginning of the audio track.
**End Offset**: Sets the number of frames from the end of the audio before which the animation stops. Adjust this parameter to make the behavior end before the end of the audio track.

**HUD Controls**
This behavior has a custom HUD, shown below.

---

**Audio Parameter Behavior**
Motion provides an easy and automated way for you to generate audio-driven animations in your projects, using the Audio parameter behavior. Whereas other behaviors are applied to an object as a whole (usually modifying multiple parameters at once), a Parameter behavior is applied to an individual parameter of an object. The Audio Parameter behavior—available in the Parameter category in the Behaviors Library (and via the Add Behavior icon in the Toolbar)—lets you make a particle system pulse to the beat of music, or have an audio track's bass amplitude affect an object's opacity. For more information on applying parameter behaviors, see “Parameter Behaviors” on page 430.

**Audio**
The Audio Parameter behavior performs an analysis of a specific property of an audio track, then applies an animation curve to a parameter based on that analysis.

**Parameters in the Inspector**

**Source Audio**: Sets the audio track from which to read audio data. Can be set to any single audio track in the project, or the Master track. Either drag an audio clip or a video clip with audio into the image well, or use the pop-up menu to choose a source for audio analysis.

**Note**: In order for the Audio Parameter behavior to have an effect on an object, audio must be present in the Timeline at the position of the behavior.

**Respond To**: Sets the type of audio data analysis to perform. Value can be set to Amplitude or Transients. If set to Amplitude, the behavior responds to peak values of a particular frequency. If set to Transients, the behavior responds to rapid changes in frequency.
**Graph Range:** Sets the initial range of frequency values to be analyzed by the behavior. Can be set to All Frequencies, Bass, Mid, or Treble. The choice of display affects the frequency range of the Low Frequency and High Frequency parameters below.

**Audio Graph:** Displays a visual representation of the Source Audio data analyzed by the behavior per frame.

During playback initiated by the Play button beneath the Audio Graph, the selected Source Audio data is displayed. If audio analysis is being performed, progress is displayed in the Audio Graph area as shown below.

The values of Low Frequency, High Frequency, Floor, and Ceiling can be set visually using the graph, or set numerically using the parameters directly to isolate certain frequencies and values for analysis.

**Low Frequency:** Sets the low frequency threshold of audio analysis. Only audio frequencies above this value will be analyzed. Values range from 1 Hz to 22,050 Hz.

**High Frequency:** Sets the high frequency threshold of audio analysis. Only audio frequencies below this value will be analyzed. Values range from 1 Hz to 22,050 Hz.

**Floor:** Sets the minimum value of audio input, below which results are ignored. Values range from 0 to 1.

**Ceiling:** Sets the maximum value of audio input, above which results are ignored. Values range from 0 to 1.

**Smoothness:** Sets the window size to smooth the result curve. Any value other than 0 triggers a keyframe reduction with an error tolerance of 1%. Values range from 0 to 10. This parameter is only available if Respond To is set to Amplitude.
**Sensitivity:** Sets the sensitivity of the transient detection. Values range from 0% to 100%. This parameter is only available if Respond To is set to Transients.

**Channel:** Sets the audio channel to analyze. Value can be set to Mix/Mono, Left, or Right.

*Note:* With a multichannel audio file used as a source, Mix/Mono must be selected in order for audio analysis to be performed properly.

**Peaks:** Sets the way the key points are linked when drawing the peak curves generated by the audio analysis. Value can be set to Sharp, Smooth, Square, or Continuous.

The different peak types are described in the table below.

*Note:* The examples below are for reference only. Because the audio behavior does not generate keyframes, you won’t see actual keyframes in the Keyframe Editor.

<table>
<thead>
<tr>
<th>Peak type</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sharp</td>
<td><img src="sharp.png" alt="Example" /></td>
<td>Each peak of the animation curve is described by three keyframes with a straight line drawn between them. A selected keyframe has no tangent handles.</td>
</tr>
<tr>
<td>Smooth</td>
<td><img src="smooth.png" alt="Example" /></td>
<td>Each peak of the animation curve is drawn by a single keyframe with a Bezier curve. A selected keyframe has a tangent handle to change the shape of the curve.</td>
</tr>
<tr>
<td>Square</td>
<td><img src="square.png" alt="Example" /></td>
<td>Each peak of the animation curve is drawn by four keyframes. A selected keyframe has no tangent handles.</td>
</tr>
<tr>
<td>Continuous</td>
<td><img src="continuous.png" alt="Example" /></td>
<td>This method behaves like Smooth interpolation, but without access to Bezier handles, as they are calculated automatically from peak to peak.</td>
</tr>
</tbody>
</table>
**Attack**: The amount of the offset in frames between the first keyframe of the curve and the peak of the curve generated by the Audio behavior. The number of frames that the curve takes to reach its peak from its initial value is called the Attack. This parameter is only available if Respond To is set to Transients.

<table>
<thead>
<tr>
<th>Attack side of the curve</th>
</tr>
</thead>
</table>

**Release**: The amount of the offset in frames between the peak of the curve generated by the Audio behavior and the last keyframe of the curve. The number of frames that the curve takes to reach its final value from its peak is called the Release. This parameter is only available if Respond To is set to Transient.

**Apply Mode**: Sets the method by which the audio analysis affects the curve. Value can be set to Add, Subtract, Multiply, or Add and Subtract.

**Delay**: Sets a delay in frames to offset the resulting keyframes.

**Scale**: Sets the scale factor to affect the result of the audio analysis.

**Apply To**: Sets the object parameter to which the audio behavior is applied.

**HUD Controls**
The HUD contains the Source Audio, Respond To, Graph Range, Audio Graph, Scale, and Apply To controls.

**Using Soundtrack Pro with Motion**
Once an audio file is imported into Motion, Soundtrack Pro can be opened from within Motion and used to modify the audio track. After the audio track has been edited and saved in Soundtrack Pro, the track is automatically updated in Motion.

**To edit an audio track in Soundtrack Pro from within Motion:**
1. In the Audio tab or Timeline layers list, select the audio track you want to modify.
2. Choose Edit > Send to Soundtrack Pro.
The Save As dialog appears.

![Save As dialog](image)

**Note:** If Soundtrack Pro is not installed on your system, Send to Soundtrack Pro is not available in the menu.

3 If needed, type a name for the modified audio track and select a location in which to save the file.

**Note:** Because this process creates a modified copy of the original audio file, the source audio is not changed.

4 Click Save as Soundtrack Pro Audio.

A project that contains the audio track is opened in Soundtrack Pro.

5 In Soundtrack Pro, make your changes to the audio file and save the project (press Command-S).

**Note:** Do not choose File > Save As (from within Soundtrack Pro) and save a file with a new name. If you save a new file, the live link between the audio track and Motion is lost.

When Motion is displayed, the track and its saved name are automatically updated in the Motion Audio tab. The original file, as well as the new Soundtrack Pro file, appear in the Motion Media tab. A Soundtrack Pro file appears in the Media tab with a .stap extension.

**Important:** If you send a single track that is part of a multitrack or multichannel file imported as separate tracks, all the tracks are replaced when coming back from Soundtrack Pro.

For more information on Soundtrack Pro, see the Soundtrack Pro documentation.

### Exporting Audio

A Motion project can be exported as an audio-only QuickTime movie (.mov), or as a QuickTime movie with both video and audio.

**To export audio:**

1 Choose File > Export.

2 In the Export dialog, type a name for the exported file, then browse to the location where you want to save the file.
3 Choose QuickTime Movie from the Kind pop-up menu.

4 Choose an export preset from the Export Preset pop-up menu, or click the Options button to view and select export options.

5 Choose Audio Only from the Include pop-up menu to export audio only, or choose Video and Audio to export a movie with both video and audio.

6 If you want to export only the marked play range instead of the entire project, click the “Use play range” checkbox.

7 Click Export.

Your exported file is saved to the specified location.

After you export audio as a QuickTime movie, you can convert the QuickTime movie file to another format using QuickTime Pro or another audio application.

For more information about exporting and export options, see “Exporting Motion Projects” on page 1147. This chapter includes information on exporting using Compressor, which allows you to export audio to other file formats, such as AIFF.

For a complete listing of all video, still image, and audio export formats, see Appendix B, “Video and File Formats,” on page 1203.
Exporting Motion Projects

Exporting your project renders it into a movie or series of still frames, based on your export choices. You can also render out audio tracks to a sound or movie file.

When it’s time to share your project with the rest of the world (either the finished version or a draft), you export your project. When you export your project, all of your project’s media, and all edits you have made, are rendered to an export file or series of files.

In the Export dialog, you can choose the kind of export you want, and whether the export file includes video with audio, video only, or audio only.

To make exporting easier, Motion includes a variety of export presets. There are export presets for both broadcast-quality and highly compressed QuickTime movies, for image sequences, and for still images. You can customize the existing export presets, or create new presets to suit your specific needs.

You can take full control over the export process by setting export options separately, including the format of the exported project, the codec used for compression, the frame rate, and frame size.

If you have set a play range in your project, you can export the entire project, or just export the play range.

You can also export your project using the Compressor application, either from within Motion, or by opening Compressor and adding your project to the Compressor Batch window. When you export using Compressor, you can choose Compressor presets to apply to your project. You can continue working on your project in Motion, or work on another project, while your project is being exported in Compressor.
Exporting Your Project

When you export your project, you can choose the kind of export and which media to include in the exported file. You can choose an export preset, or set video, audio, and output export options individually. You can export the entire project or, if you have marked a play range, export only the play range.

To export your project:


   The Export dialog appears and the project name appears in the Save As field.

2. Type a new name in the Save As field or use the existing project name.

3. Browse to the location where you want to save the file using the pop-up menu and buttons at the top of the dialog.

   To show a file browser pane, click the arrow button to the right of the Save As field.

4. Choose the kind of export from the Export pop-up menu.

   You can export a QuickTime movie, an image sequence, or the current frame as a still image. For information about the different kinds of export files, see “Choosing the Export Type” on page 1149.

5. Choose a preset from the Use pop-up menu.

   For information about Use settings, see “Using Export Presets” on page 1149.

6. If necessary, click the Options button to set export options individually.

   For information about setting export options, see “Setting Export Options” on page 1154.

7. Choose the media to include in the export file from the Include pop-up menu.

   You can export video and audio, video only, or audio only.

8. Turn on the “Use play range” checkbox if you want to export only the marked play range, rather than the entire project.

   For information about marking a play range, see “Defining the Play Range” on page 359.
9 Click Export.

An Export progress window appears, and shows the time elapsed and time remaining. Depending on the size and complexity of your project, exporting may take some time. When the export is finished, the window closes.

Choosing the Export Type
You can export your project as a QuickTime movie or as a numbered sequence of images, and can also export the current frame as a still image.

QuickTime Movie
When you export your project as a QuickTime movie, the project is rendered as a movie file (.mov). Exported QuickTime movies can include both video and audio, video only, or audio only.

Image Sequence
When you export your project as an image sequence, each frame is rendered as an image file. The filename of each image file includes a sequence number that is incremented for each successive file. Exported image sequences can include video only.

You can define the number of digits in the sequence number by adding a pound character (#) for each digit to the end of the filename, and enclosing the pound characters in square brackets [ ]. For example, to make the sequence number four digits long, you add [####] to the end of the filename.

Note: When you export an image sequence, Motion creates a still image for each frame of the project, which can result in a large number of files. You may want to create an empty folder to contain the image sequence files.

Current Frame
When you choose Current Frame, your project is exported as a still image (based on the current playhead position). Exported still images include video only.

For a complete listing of video, image, and audio export formats, see Appendix B, “Video and File Formats,” on page 1203.

Using Export Presets
You can export your project using an export preset. Export presets let you quickly render your project using predefined groups of export settings. In many cases, using an export preset can simplify your workflow.

You can edit the existing export presets, duplicate an export preset to use as a template for creating a custom preset, or create a new export preset with the settings you choose.
Choosing an Export Preset

Motion includes export presets for many typical work situations. There are presets for QuickTime movie, image sequence, and current frame export. These presets, available in the Use pop-up menu of the Export dialog, include:

**QuickTime Movie presets**
- Apple ProRes 422 (HQ)
- Apple ProRes 422 (SQ)
- DV NTSC Movie
- DV PAL Movie
- DVCPro HD 1080i50 Movie
- DVCPro HD 1080i60 Movie
- DVCPro HD 1080p24 Movie
- DVCPro HD 1080p30 Movie
- DVCPro HD 720p24 Movie
- DVCPro HD 720p25 Movie
- DVCPro HD 720p30 Movie
- DVCPro HD 720p50 Movie
- DVCPro HD 720p60 Movie
- HDV 1080i50 Movie
- HDV 1080i60 Movie
- HDV 1080p24 Movie
- HDV 1080p25 Movie
- HDV 720p24 Movie
- HDV 720p25 Movie
- HDV 720p30 Movie
- Lossless+Alpha Movie
- Pixlet Movie
- Uncompressed 10-bit 48 kHz
- Uncompressed 8-bit 48 kHz
- XDCAM HD 1080i50 Movie
- XDCAM HD 1080i60 Movie
- XDCAM HD 1080p24 Movie
- XDCAM HD 1080p25 Movie
- XDCAM HD 1080p30 Movie
Image Sequence presets
- JPEG Sequence
- OpenEXR Sequence
- Photoshop Sequence
- PICT Sequence
- PNG Sequence
- TGA Sequence
- TIFF Sequence

Current Frame presets
- JPEG
- OpenEXR
- Photoshop
- PICT
- PNG
- TGA
- TIFF

*Note:* The Photoshop export preset supports only a single-layer image, not multiple layers.

**Exporting with Alpha Channels**
To export your project with an alpha channel, use a preset that supports alpha channels, such as Lossless+Alpha Movie. The default QuickTime Movie preset—“Movie-current project and Canvas setting”—uses the Animation codec, which supports alpha channels. Also, to export your project with a transparent background, make sure that Background is set to Transparent in the Project Properties dialog (press Command-J).

You can view extended descriptions of the export presets in Motion Preferences.

**To view export preset settings in Motion Preferences:**
1. Choose Motion > Preferences, then click Presets.
2. In the Presets pane, choose Export Presets from the Show pop-up menu.
3 Click a preset in the list, and its settings appear in the Summary field at the right, along with a brief description.

The preset selected in Motion Preferences is also displayed in the Export Options dialog.

To choose an export preset:
- In the Export dialog, choose a preset from the Use pop-up menu.

Editing an Export Preset
You can edit an existing preset. When you edit an existing preset, you replace the original preset settings with your changes (unless you rename the preset).

To edit an export preset:
1 Choose File > Export, then click the Options button in the Export dialog.
   The Export Options dialog appears, with the Video/Audio pane visible.
2 In the Video/Audio pane, edit the video and audio settings you want to change. Click the Advanced buttons for video and audio to edit advanced export options.
3 Click the Output tab of the Export Options dialog, turn off the “Use current project and canvas settings” checkbox, then edit the output settings you want to change.
4 When you are finished, click Save.
   To save a copy of the preset with a different name, type a name for the preset in the Name field, then click Save As.

Note: You can also edit an export preset from the Presets pane of Motion Preferences by choosing Export Presets from the Show pop-up menu, selecting an export preset, then clicking the Edit button.
Duplicating an Export Preset
You can duplicate an existing preset, and use it as the starting point for creating a new preset.

To duplicate an export preset:
1. Choose File > Export, then click the Options button in the Export dialog.
   The Export Options dialog appears, with the Video/Audio pane visible.
2. In the Video/Audio pane, edit the video and audio settings you want to change. Click the Advanced buttons for video and audio to edit advanced export options.
3. Click the Output tab of the Export Options dialog, turn off the "Use current project and canvas settings" checkbox, then edit the output settings you want to change.
4. When you are finished, click Save As, then type a name for the preset.
   Note: You can also duplicate an export preset from the Presets pane of Motion Preferences by choosing Export Presets from the Show pop-up menu, selecting an export preset, then clicking the Duplicate button.

Creating an Export Preset
If none of the included presets suits your needs, you can create a new export preset.

To create an export preset:
1. Choose Motion > Preferences, then click Presets.
2. Choose Export Presets from the Show pop-up menu.
3. Click the Add button (+) to add a new preset.
4. Type a name for the preset in the Name field.
   You can optionally type a description for the preset in the Description field. (This is helpful if there are settings or other information you want to remember about the preset.)
5. Select the video and audio settings for the preset in the Video/Audio pane of the Export Options dialog. Click the Advanced buttons to change QuickTime compression or audio settings.
6. Click the Output tab of the Export Options dialog.
   If you want to change output settings, turn off the "Use current project and canvas settings" checkbox, then select the output settings for the preset.
7. When you are finished, click OK.
Deleting an Export Preset
If you decide you no longer need an export preset, you can delete it. You can delete only user-created export presets, but not the default export presets that come with Motion.

To delete an export preset:
1 Choose Motion > Preferences, then click Presets.
2 Choose Export Presets from the Show pop-up menu.
3 Select the export preset you want to delete.
4 Click the Delete (–) button.

Setting Export Options
If no export preset meets your specific needs, you can customize the export settings for your project. You can set export options for video, audio, and output individually. You can also set advanced export options, including QuickTime compression and audio settings.

To change the video export options:
1 Choose File > Export, then click the Options button.
The Export Options dialog appears, with the Video/Audio pane visible.
2 In the Video section of the Video/Audio pane, choose the video settings you want:

- Choose the kind of export from the Kind pop-up menu.
- Choose the codec used to compress the exported project from the Compressor pop-up menu. The available choices change depending on the kind of export you selected.
Drag the Quality slider to adjust the level of compression. You can also type a value between 1 and 100 in the field next to the slider. The lowest level of quality is 1, and the highest level of quality is 100. Some codecs may not allow you to adjust the quality level.

If you are exporting an image sequence, type a number for the starting frame of the sequence in the “Start number” field. Turn on the “Add spaces” checkbox to add an extra space to the filename between the name and number. Some applications require the space to read the image sequence files in the correct order.

Click the Advanced button to view and select advanced audio video options. The available options change depending on the kind of export you selected.

To change the audio export options:
1.Choose File > Export, then click the Options button.
2.In the Audio section of the Video/Audio pane, choose the audio settings you want:
   • Choose the export sample rate from the “Sample rate” pop-up menu.
   • Choose a mix type from the Mix pop-up menu.
   • Click the Advanced button to set the compressor format, rate, quality, bit depth, and channel mix settings in the Sound Settings dialog.
Additional export settings are available in the Output tab of the Export Options dialog.

To change the output export options:
1. Choose File > Export, then click the Options button.
2. Click the Output tab.
3. In the Output pane, choose the output settings you want.
Turn on the “Use current project and canvas settings” checkbox to use the current project settings as displayed in the Project Properties dialog or turn it off to specify different settings.

**Note:** Export presets are exported with “Use current project and canvas settings” turned on by default. When this checkbox is turned on, the Color option is set to Color + Alpha, and the “Premultiply alpha” option is turned on. All other fields are disabled.

When the “Use current project and canvas settings” checkbox is turned off, the export uses the settings below, which override your project settings:

- Choose one of the project preset sizes from the Resolution pop-up menu, or choose Custom and type a custom frame size in the two Resolution value fields.
- Choose whether the export file includes only color data, only alpha channel (transparency) data, or both from the Color pop-up menu.

**Note:** Some codecs do not support alpha channels.

- Turn on the Premultiply alpha checkbox to mix semi-transparent pixels in the exported file with the project’s background color, as set in Project Properties.
- Turn on the Field Rendering checkbox to render individual fields, instead of rendering whole frames.
- Turn on the Motion Blur checkbox to have motion blur applied to moving objects, regardless of the setting in the View menu pop-up menu (above the Canvas).

For more information on the Export Options, see “Export Options Dialog” on page 155.

**Setting Advanced Export Options**

You can select advanced export options for video and audio. The Advanced buttons in the video and audio sections of the Export Options dialog display the standard QuickTime export options.

Advanced video export options are available only when you are exporting your project as a QuickTime movie. The options available depend on the export format of your project.

**To change the advanced video export options:**
1. Choose File > Export, then click the Options button.
2. In the Video section of the Video/Audio pane, click the Advanced button.
3 In the Compression Settings dialog, choose the settings you want:

- Choose a codec from the “Compression type” pop-up menu.
- Choose the frame rate for your exported video in the “Frames per second” pop-up menu, or choose Custom, then type a number in the field that appears next to the pop-up menu.
- If the codec you choose uses temporal compression, you can set the frequency of keyframes by turning on the “Key frame every” checkbox and typing the number of frames you want in the field.
- If the codec lets you set the data rate for your exported video, you can do so by turning on the “Limit data rate to” checkbox and typing a number in the field.
- Drag the Quality slider to adjust the level of compression. Some codecs may not allow you to adjust the quality level.
- Choose the scan mode (Interlaced or Progressive) of the export from the Scan Mode pop-up menu.
- Choose the aspect ratio of the exported video from the Aspect Ratio pop-up menu.

To change the advanced audio export options:
1 Choose File > Export.
2 Click the Options button.
   The Export Options window appears.
3 In the Audio section of the Video/Audio pane, click the Advanced button.

*Note:* There are two different mix types for exporting audio: Stereo and 5.1 Surround. Each of them have different advanced options.
4 In the Sound Settings dialog, choose the settings you want:

- Choose a codec to compress the audio from the Format pop-up menu.
- Choose an audio export format from the Channels pop-up menu.
- Choose a sample rate for audio export from the Rate field.
- Choose a quality from the Render Settings pop-up menu.
- Specify any additional export options relevant to the codec format.
- If there is an Options button, select it to view and set additional export options.

5 Click OK.

About Sound Format Compression Settings
Each of the compression algorithms in the Format pop-up menu of the Sound Settings dialog has additional settings to control render quality and speed. In the Render Settings Quality pop-up menu, choose Faster, Fast, Normal, Better, or Best. Some of the compression formats have additional settings:

<table>
<thead>
<tr>
<th>Format</th>
<th>Additional settings</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear PCM</td>
<td>Sample Size</td>
<td>8-, 16-, 24-, or 32-bit</td>
</tr>
<tr>
<td></td>
<td>Little Endian</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Floating Point</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unsigned</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Non-Interleaved</td>
<td></td>
</tr>
<tr>
<td>A-Law 2:1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AAC</td>
<td>Target Bit Rate</td>
<td>8, 16, 20, 24, 28, 32, 40, 48, 56, 56, 64, 80, 96, 112, 128, 160, 192, 224, or 256 kbps</td>
</tr>
</tbody>
</table>
If you choose Stereo mix, you can export your project from Motion in either mono or stereo. If you choose 5.1 Surround mix, Motion gives you the same mono or stereo options, plus the following additional channel layouts for Channels in the Sound Settings dialog:

<table>
<thead>
<tr>
<th>Format</th>
<th>Channels exported and mix layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMR Narrowband</td>
<td>5.0 (L R C Ls Rs) Left, Right, Center, Left Surround, Right Surround</td>
</tr>
<tr>
<td></td>
<td>5.0 (L R Ls Rs C) Left, Right, Left Surround, Right Surround, Center</td>
</tr>
<tr>
<td></td>
<td>5.0 (L C R Ls Rs) Left, Center, Right, Left Surround, Right Surround</td>
</tr>
<tr>
<td></td>
<td>5.0 (C L R Ls Rs) Center, Left, Right, Left Surround, Right Surround</td>
</tr>
<tr>
<td></td>
<td>5.1 (L R C LFE Ls Rs) Left, Right, Center, Low-Frequency Effects, Left Surround, Right Surround</td>
</tr>
<tr>
<td>Qdesign Music 2 Bitrate</td>
<td>8, 10, 12, 16, 20, 24, 32, 40, or 48 kbps</td>
</tr>
<tr>
<td>Qualcomm PureVoice™ Options</td>
<td>PureVoice™ Full Rate, Qualcomm Half Rate</td>
</tr>
<tr>
<td>µ-Law 2:1</td>
<td></td>
</tr>
</tbody>
</table>

These settings use the output channel settings from the Audio tab to assign tracks to each output bus. For more information on assigning tracks to output busses, Chapter 13, “Working with Audio,” on page 1117.
Exporting a Play Range
If you have defined a play range for your project, you can export the entire length of the project, or export only the play range.

To export a play range:
- Choose File > Export, then turn on the "Use play range" checkbox.

For information about setting a play range, see “Defining the Play Range” on page 359.

Export a Selection
The Export Selection option allows you to export only certain elements in your project.

To export a selection:
1. Select at least one file in your project in the Project pane or Timeline.
2. Choose File > Export Selection.
3. Follow the same steps as for regular exporting. For information about exporting, see “Exporting Your Project” on page 1148.

Exporting with Compressor
You can export your project using the Apple Compressor application. When you export using Compressor, you can use the presets included with Compressor for your exported file.

There are two ways you can export a Motion project using Compressor. From within Motion, you can choose File > Export Using Compressor. From within Compressor, you can drag the Motion project into the Batch window.

When you export your project using Compressor, Motion saves a temporary copy of the project. You can continue working with the project while it is being exported, or work on another project in Motion.
To export a project using Compressor from within Motion:


   The Compressor Export Options dialog appears.

2. Choose an export preset from the Export Preset pop-up menu.

   To see a summary of the Compressor settings, click the Summary button.

3. Choose which media to include in the export from the Include pop-up menu.

4. In the Output section of the Compressor Export Options dialog, choose whether to use the current project settings by turning on the checkbox, or select the settings you want to use.

5. Click Export.

   The Compressor application opens, and your project is listed in the Batch window (the main window of the Compressor workspace), along with the preset, destination, and output filename.

6. If you want to change or add additional presets, select the project and choose the preset you want in the Settings window or choose Target > Change Setting.

7. Choose a location for the exported file by choosing Target > Destination.

   You can choose Source, Desktop, User’s Movies Folder, Cluster Storage, or Other and browse to a different location.

   If you do not specify a destination, and you have not previously saved the project, the export file is saved in the following location:

   /Users/username/Desktop/Motion Batch Export Files/

   If you have previously saved and named the project, it is output to the save location, in a folder named Motion Batch Export Files.

8. If necessary, type a new filename for the export file in the text field.
9 Click the Submit button.

The Submit dialog appears.

10 Check the Name field to confirm the batch name.

11 Use the Cluster pop-up menu to choose a computer or cluster to process the batch.

The default Cluster setting is This Computer, which means Compressor will not involve any other computers in completing the batch. You can choose from any other available clusters that appear in this list.

12 Check the “Include unmanaged services on other computers” checkbox to create an ad hoc cluster including “This Computer” and any available service nodes.

13 Use the Priority pop-up menu to choose priority level for the batch.

14 Click Submit or press Return to submit the batch for processing.

If Auto Launch Batch Monitor is selected in Compressor Preferences, Batch Monitor opens on submission. If Auto Launch Batch Monitor is not enabled, click the Batch Monitor icon to open Batch Monitor and track the progress of the export.

15 When you are finished, choose Compressor > Quit to exit Compressor.

If you opened Batch Monitor, choose Batch Monitor > Quit.

While your project is being exported, you can continue to work on the project in Motion, or work on another project. Any further changes you make are not part of the file currently being exported.
To export a project from within Compressor:

1 Open Compressor.

The Batch window appears.

2 Drag the project from the Finder into the Batch window.

3 In the Settings tab, locate the Compressor preset you want, then drag it to the Batch window.

You can choose multiple presets.

4 Choose a location in the Destinations tab, then drag it to the file destination in the Batch window you want to affect.

5 Optionally, select the output filename and type a new name for the export file.

6 Click the Submit button.

The Submit dialog appears.

7 Check the Name field to confirm the batch name.

8 Use the Cluster pop-up menu to choose a computer or cluster to process the batch.

The default Cluster setting is This Computer, which means Compressor will not involve any other computers in completing the batch. You can choose from any other available clusters that appear in this list.

9 Check the “Include unmanaged services on other computers” checkbox to create an ad hoc cluster including This Computer and any available service nodes.
10 Use the Priority pop-up menu to choose the priority level for the batch.

11 Click Submit to submit the batch for processing.

If Auto Launch Batch Monitor is selected in Compressor Preferences, Batch Monitor opens on submission. If Auto Launch Batch Monitor is not enabled, click the Batch Monitor icon to open Batch Monitor and track the progress of the export.

12 When you are finished, choose Compressor > Quit.

If you opened Batch Monitor, choose Batch Monitor > Quit.

Using Compressor Presets
Compressor includes a large number of presets, including video, image, and audio presets. When you export a Motion project using Compressor, you can select a preset in the Compressor Export Options dialog. These presets cannot be edited in Motion, but you can edit them and create new presets in Compressor.

You can use multiple Compressor presets by choosing them from the Preset pop-up menu in the Compressor Batch window.

For more information on working with Compressor presets, see the Compressor User Manual available from the Compressor Help menu.

Rendering a Project for iPod Playback
You can create and export projects that can be played on a video iPod.

To create a new iPod project:
1 Choose File > New (or press Command-N).

2 In the Select Project Preset dialog, choose iPod Video from the Presets pop-up menu and click OK.

A 320 x 240 project is created.
If your new projects are defaulting to a different project size, choose Edit > Project Properties (or press Command-J) once the project is open. In the General pane of the Project Properties window, choose iPod Video from the Presets pop-up menu. You can change the default new project size in the Presets pane of Motion Preferences.

**Note:** If you prefer (and because the iPod Video format is small), you can create a larger project format in which to work and then proceed to step 3.

3 When you are ready to export your project, choose File > Export (or press Command-E).

4 In the Export dialog, do the following:
   a Enter a filename and location in which to save the project.
   b Choose QuickTime Movie from the Export pop-up menu.
   c Choose “Movie – current project and Canvas settings” from the Use pop-up menu.
   d Choose an option from the Include pop-up menu (Video and Audio, Video Only, or Audio Only).
   e Click Options.
   f In the Video/Audio tab of the Export Options dialog, choose QuickTime Movie from the Kind pop-up menu and H.264 from the Compressor pop-up menu.
      This is the codec used by the video iPod.

5 Click OK.

6 In the Export dialog, click Export.

**Exporting an Audio File**

You can export an audio-only QuickTime movie. When you export audio only, the exported movie includes all audio tracks in your project that are turned on and not muted.

**To export an audio file:**

1 Choose File > Export.

2 In the Export dialog, type a name for the exported file, then browse to the location where you want to save the file.

3 Choose QuickTime Movie from the Export pop-up menu.

4 Choose an export preset from the Use pop-up menu, or click the Options button to view and select export options.

5 Choose Audio Only from the Include pop-up menu to export audio only, or choose Video and Audio to export a movie with both video and audio.

6 If you want to export only the marked play range instead of the entire project, turn on the “Use play range” checkbox.

7 Click Export.
Your exported file is saved to the specified location.

After you export audio as a QuickTime movie, you can convert the QuickTime movie file to another format using QuickTime Pro, Compressor, or another audio application.

There are no audio-only export presets. However, you can use any QuickTime movie export preset and edit the audio export options. For more information on working with audio files, see “Working with Audio” on page 1117.
Use keyboard shortcuts to streamline your work in Motion. The following tables organize the keyboard shortcuts by menu, component, and task.

Some keyboard shortcuts are always active, whether or not you are working in the group that they are listed in, while other keyboard shortcuts are only active under special circumstances.

**Note:** Some keyboard shortcuts described in this chapter may conflict with system commands assigned to the Mac OS X Finder.

The keyboard shortcuts listed in the following pages are the Standard Set of shortcuts available in Motion. You can use the Command Editor to customize and save your own keyboard shortcuts to create a set that works best for you. The Command Editor lets you import and export saved sets, as well as duplicate a set of shortcuts to modify. For more information, see “Using the Command Editor” on page 1196.

### General Interface Commands

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ X + ☐</td>
<td>Open a project.</td>
</tr>
<tr>
<td>⌘ X + N</td>
<td>Create a new project.</td>
</tr>
<tr>
<td>⌘ X + option + N</td>
<td>Create a new project from a list of project presets.</td>
</tr>
<tr>
<td>⌘ X + shift + ☐</td>
<td>Open a template.</td>
</tr>
<tr>
<td>⌘ X + J</td>
<td>Open the Project Properties dialog.</td>
</tr>
<tr>
<td>⌘ X + S</td>
<td>Save a project.</td>
</tr>
<tr>
<td>⌘ X + shift + S</td>
<td>Save a project as a new project.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ x + option + S</td>
<td>Save all open projects.</td>
</tr>
<tr>
<td>⌘ x + W</td>
<td>Close a project.</td>
</tr>
<tr>
<td>⌘ x + option + W</td>
<td>Close all open projects.</td>
</tr>
<tr>
<td>⌘ x + I</td>
<td>Import a file.</td>
</tr>
<tr>
<td>⌘ x + E</td>
<td>Export a project.</td>
</tr>
<tr>
<td>⌘ x + shift + E</td>
<td>Export a project using Compressor.</td>
</tr>
<tr>
<td>⌘ x + P</td>
<td>Print the current view of the Canvas.</td>
</tr>
<tr>
<td>⌘ x + shift + I</td>
<td>Import files as a project.</td>
</tr>
<tr>
<td>⌘ x + Z</td>
<td>Undo the last change.</td>
</tr>
<tr>
<td>⌘ x + shift + Z</td>
<td>Redo the last change.</td>
</tr>
<tr>
<td>⌘ x + X</td>
<td>Cut</td>
</tr>
<tr>
<td>⌘ x + C</td>
<td>Copy</td>
</tr>
<tr>
<td>⌘ x + V</td>
<td>Paste</td>
</tr>
<tr>
<td>⌘ x + D</td>
<td>Duplicate</td>
</tr>
<tr>
<td>⌘ x + A</td>
<td>Select all items.</td>
</tr>
<tr>
<td>⌘ x + shift + A</td>
<td>Deselect all items.</td>
</tr>
<tr>
<td>delete</td>
<td>Delete</td>
</tr>
<tr>
<td>⌘ x + W</td>
<td>Close the active window.</td>
</tr>
<tr>
<td>⌘ x + M</td>
<td>Minimize the active window.</td>
</tr>
<tr>
<td>⌘ x + `</td>
<td>Cycle through project windows. Press repeatedly until the window you want is displayed.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ X + ,</td>
<td>Open Motion Preferences.</td>
</tr>
<tr>
<td>⌘ X + ?</td>
<td>Open Motion Help.</td>
</tr>
<tr>
<td>⌘ X + ⌘ shift + P</td>
<td>Display Page Setup dialog.</td>
</tr>
<tr>
<td>⌘ X + H</td>
<td>Hide Motion.</td>
</tr>
<tr>
<td>⌘ X + option + H</td>
<td>Hide other open application files.</td>
</tr>
<tr>
<td>⌘ X + O</td>
<td>Quit Motion.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>space</td>
<td>Play/Pause a project.</td>
</tr>
<tr>
<td>A</td>
<td>Record animation.</td>
</tr>
<tr>
<td>home</td>
<td>Go to the start of a project.</td>
</tr>
<tr>
<td>end</td>
<td>Go to the end of a project.</td>
</tr>
</tbody>
</table>

### Motion Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ X + ,</td>
<td>Open Motion Preferences.</td>
</tr>
<tr>
<td>⌘ X + H</td>
<td>Hide Motion.</td>
</tr>
<tr>
<td>⌘ X + option + H</td>
<td>Hide other open application files.</td>
</tr>
<tr>
<td>⌘ X + O</td>
<td>Quit Motion.</td>
</tr>
</tbody>
</table>

### File Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ X + N</td>
<td>Create a new project.</td>
</tr>
<tr>
<td>⌘ X + O</td>
<td>Open a project.</td>
</tr>
</tbody>
</table>
# Keyboard Shortcuts

## Edit Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ X + shift + O</td>
<td>Open a template.</td>
</tr>
<tr>
<td>⌘ X + W</td>
<td>Close a project.</td>
</tr>
<tr>
<td>⌘ X + S</td>
<td>Save a project.</td>
</tr>
<tr>
<td>⌘ X + shift + S</td>
<td>Save a project as a new project.</td>
</tr>
<tr>
<td>⌘ X + I</td>
<td>Import a file.</td>
</tr>
<tr>
<td>⌘ X + shift + I</td>
<td>Import files as a project.</td>
</tr>
<tr>
<td>⌘ X + E</td>
<td>Export a project.</td>
</tr>
<tr>
<td>⌘ X + option + E</td>
<td>Export selection.</td>
</tr>
<tr>
<td>⌘ X + shift + E</td>
<td>Export a project using Compressor.</td>
</tr>
<tr>
<td>⌘ X + shift + P</td>
<td>Display Page Setup dialog.</td>
</tr>
<tr>
<td>⌘ X + P</td>
<td>Print the current view of the Canvas.</td>
</tr>
<tr>
<td>⌘ X + option + N</td>
<td>Create a new project from a list of project presets.</td>
</tr>
<tr>
<td>⌘ X + option + W</td>
<td>Close all open projects.</td>
</tr>
<tr>
<td>⌘ X + option + S</td>
<td>Save all open projects.</td>
</tr>
</tbody>
</table>

## Edit Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ Z</td>
<td>Undo the last change.</td>
</tr>
<tr>
<td>⌘ Z + shift + Z</td>
<td>Redo the last change.</td>
</tr>
<tr>
<td>⌘ X</td>
<td>Cut</td>
</tr>
<tr>
<td>⌘ C</td>
<td>Copy</td>
</tr>
</tbody>
</table>
### Key command | Function
--- | ---
⌥ + ⌘ + V | Paste special.
⌥ + V | Duplicate
Delete | Delete
Shift + Delete | Perform a ripple delete which removes the selected object and closes the gap left behind.
⌥ + A | Select all items.
⌥ + Shift + A | Deselect all items.
⌥ + U | Send Audio to Soundtrack Pro.
⌥ + J | Open the Project Properties dialog.

### Mark Menu

| Key command | Function |
--- | --- |
<p>| I | Mark In point. |
| O | Mark Out point. |
| Shift + I | Move the selected object to the In point. |
| Shift + J | Move the selected object to the Out point. |
| Shift + M | Add a project marker at the current frame. |
| Shift + Option + M | Add a global marker at the current frame. |
| Option + I | Open the Edit Marker dialog. |
| Option + Shift + I | Mark In point of play range. |
| Option + Shift + O | Mark Out point of play range. |</p>
<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>option</code> + <code>X</code></td>
<td>Reset the play range by moving the In and Out points to the first and last frame of the project.</td>
</tr>
<tr>
<td><code>space</code></td>
<td>Play/Pause a project.</td>
</tr>
<tr>
<td><code>shift</code> + <code>L</code></td>
<td>Enable/Disable loop playback.</td>
</tr>
<tr>
<td><code>A</code></td>
<td>Record animation.</td>
</tr>
<tr>
<td><code>option</code> + <code>A</code></td>
<td>Open the Recording Options dialog.</td>
</tr>
<tr>
<td><code>home</code></td>
<td>Go to the start of project.</td>
</tr>
<tr>
<td><code>end</code></td>
<td>Go to the end of project.</td>
</tr>
<tr>
<td><code>shift</code> + <code>home</code></td>
<td>Go to the start of play range.</td>
</tr>
<tr>
<td><code>shift</code> + <code>end</code></td>
<td>Go to the end of play range.</td>
</tr>
<tr>
<td>←</td>
<td>Go to the previous frame.</td>
</tr>
<tr>
<td>→</td>
<td>Go to the next frame.</td>
</tr>
<tr>
<td><code>shift</code> + ←</td>
<td>Go backward ten frames.</td>
</tr>
<tr>
<td><code>shift</code> + →</td>
<td>Go forward ten frames.</td>
</tr>
<tr>
<td><code>option</code> + <code>K</code></td>
<td>Go to previous keyframe.</td>
</tr>
<tr>
<td><code>shift</code> + <code>K</code></td>
<td>Go to next keyframe.</td>
</tr>
<tr>
<td><code>option</code> + <code>proxy</code> + ←</td>
<td>Go to the previous marker.</td>
</tr>
<tr>
<td><code>option</code> + <code>proxy</code> + →</td>
<td>Go to the next marker.</td>
</tr>
<tr>
<td><code>shift</code> + <code>I</code></td>
<td>Go to the In point of the selected object.</td>
</tr>
<tr>
<td><code>shift</code> + <code>O</code></td>
<td>Go to the Out point of the selected object.</td>
</tr>
<tr>
<td><code>proxy</code> + <code>R</code></td>
<td>Render a RAM Preview for the play range.</td>
</tr>
</tbody>
</table>
### Appendix A  Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍀️ + option + R</td>
<td>Render a RAM Preview for the selected object.</td>
</tr>
<tr>
<td>🍀️ + shift + option + R</td>
<td>Render a RAM Preview for the entire project.</td>
</tr>
</tbody>
</table>

### Object Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍀️ + shift + V</td>
<td>Add a new empty group to the project.</td>
</tr>
<tr>
<td>🍀️ + option + C</td>
<td>Add a new camera to the project.</td>
</tr>
<tr>
<td>🍀️ + shift + L</td>
<td>Add a new light to the project.</td>
</tr>
<tr>
<td>🍀️ + option + D</td>
<td>Add a new drop zone to the project.</td>
</tr>
<tr>
<td>🍀️ + shift + G</td>
<td>Move the selected object to the top of the Layers list.</td>
</tr>
<tr>
<td>🍀️ + shift + D</td>
<td>Move the selected object to the bottom of the Layers list.</td>
</tr>
<tr>
<td>🍀️ + G</td>
<td>Move the selected object up the Layers list by one level.</td>
</tr>
<tr>
<td>🍀️ + D</td>
<td>Move the selected object down the Layers list by one level.</td>
</tr>
<tr>
<td>🍀️ + shift + G</td>
<td>Group the selected objects into a new layer.</td>
</tr>
<tr>
<td>🍀️ + option + G</td>
<td>Ungroup a group of objects so you can manipulate the objects individually.</td>
</tr>
<tr>
<td>control + T</td>
<td>Make an object active or deactivate an object.</td>
</tr>
<tr>
<td>control + S</td>
<td>For an audio track, enable/disable the Solo button of the selected track. For an object, solo the object.</td>
</tr>
<tr>
<td>control + I</td>
<td>Isolate the selected group or layer.</td>
</tr>
<tr>
<td>control + L</td>
<td>Lock/Unlock an object.</td>
</tr>
<tr>
<td>shift + control + S</td>
<td>Unsolos only the video portion of a file that contains video.</td>
</tr>
<tr>
<td>control + D</td>
<td>Create a 3D Group of the selected objects.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ + X + Shift + M</td>
<td>Add an image mask to the selected object.</td>
</tr>
<tr>
<td>⌘ + K</td>
<td>Add keyframe (to the last modified parameter for the selected object).</td>
</tr>
<tr>
<td>⌘ + ⌘ + K</td>
<td>Convert the applied behaviors to keyframes.</td>
</tr>
<tr>
<td>⌘ + E</td>
<td>Make the selected object the cell source for a particle emitter.</td>
</tr>
<tr>
<td>⌘ + L</td>
<td>Replicate the selected object.</td>
</tr>
<tr>
<td>⌘ + K</td>
<td>Clone the selected layer.</td>
</tr>
<tr>
<td>Shift + ⌘ + F</td>
<td>Open the Media tab and Inspector to display the source and properties of media objects.</td>
</tr>
</tbody>
</table>

### View Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ + X + =</td>
<td>Zoom in.</td>
</tr>
<tr>
<td>⌘ + X + -</td>
<td>Zoom out.</td>
</tr>
<tr>
<td>Option + Z</td>
<td>Zoom to 100 percent.</td>
</tr>
<tr>
<td>Shift + Z</td>
<td>Zoom to fit in window.</td>
</tr>
<tr>
<td>F8</td>
<td>Show/Hide the Canvas in Full Screen mode.</td>
</tr>
<tr>
<td>⌘ + F12</td>
<td>Send output to external monitor.</td>
</tr>
<tr>
<td>Shift + V</td>
<td>Show Full View Area.</td>
</tr>
<tr>
<td>⌘ + A</td>
<td>Set 3D View to Active Camera.</td>
</tr>
<tr>
<td>⌘ + P</td>
<td>Set 3D View to Perspective.</td>
</tr>
<tr>
<td>⌘ + C</td>
<td>Set 3D View to Next Camera.</td>
</tr>
<tr>
<td>⌘ + R</td>
<td>Reset 3D Camera View.</td>
</tr>
<tr>
<td>Key command</td>
<td>Function</td>
</tr>
<tr>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>shift + C</td>
<td>Show all color channels.</td>
</tr>
<tr>
<td>shift + T</td>
<td>Show the transparent channel.</td>
</tr>
<tr>
<td>shift + option + T</td>
<td>Show the alpha channel overlay.</td>
</tr>
<tr>
<td>shift + option + C</td>
<td>Show the RGB channels only.</td>
</tr>
<tr>
<td>shift + R</td>
<td>Show the red channel.</td>
</tr>
<tr>
<td>shift + G</td>
<td>Show the green channel.</td>
</tr>
<tr>
<td>shift + B</td>
<td>Show the blue channel.</td>
</tr>
<tr>
<td>shift + A</td>
<td>Show the alpha channel.</td>
</tr>
<tr>
<td>shift + option + A</td>
<td>Show the inverted alpha channel.</td>
</tr>
<tr>
<td>V</td>
<td>Toggle between the current channel and alpha channels.</td>
</tr>
<tr>
<td>shift + Q</td>
<td>Show the Canvas at full resolution.</td>
</tr>
<tr>
<td>option + L</td>
<td>Enable/Disable lighting in the Canvas.</td>
</tr>
<tr>
<td>option + F</td>
<td>Enable/Disable field rendering in the Canvas.</td>
</tr>
<tr>
<td>option + M</td>
<td>Enable/Disable motion blur in the Canvas.</td>
</tr>
<tr>
<td>option + control + B</td>
<td>Enable/Disable frame blending in the Canvas.</td>
</tr>
<tr>
<td>\</td>
<td>Enable/Disable preview float bit depth.</td>
</tr>
<tr>
<td>⚫ ☠ + /</td>
<td>Show Overlays.</td>
</tr>
<tr>
<td>⚫ ☠ + shift + R</td>
<td>Show the rulers.</td>
</tr>
<tr>
<td>⚫ ☠ + ′</td>
<td>Show/Hide the grid.</td>
</tr>
<tr>
<td>⚫ ☠ + ;</td>
<td>Show/Hide the guides.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ ⌘ + shift + ;</td>
<td>Show/Hide the Dynamic Guides.</td>
</tr>
<tr>
<td>⌘ ⌘</td>
<td>Show/Hide the Safe Zones.</td>
</tr>
<tr>
<td>⌘ ⌘ + shift + ;</td>
<td>Show/Hide the Film Zones.</td>
</tr>
<tr>
<td>⌘ ⌘ + option + ;</td>
<td>Lock the guides.</td>
</tr>
<tr>
<td>⌘ N</td>
<td>Enable/Disable snapping to guides.</td>
</tr>
<tr>
<td>⌘ ⌘ + shift + -</td>
<td>Show 3D grid.</td>
</tr>
<tr>
<td>⌘ ⌘ + T</td>
<td>Show the Font dialog.</td>
</tr>
<tr>
<td>⌘ ⌘ + shift + C</td>
<td>Show the Colors window.</td>
</tr>
<tr>
<td>⌘ ⌘ + option + T</td>
<td>Show/Hide the Toolbar.</td>
</tr>
</tbody>
</table>

### Window Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ ⌘ + M</td>
<td>Minimize the active window.</td>
</tr>
<tr>
<td>control + U</td>
<td>Show the project in Standard layout.</td>
</tr>
<tr>
<td>shift + control + U</td>
<td>Show the project in Alternate layout.</td>
</tr>
<tr>
<td>option + control + U</td>
<td>Show the project in Cinema layout.</td>
</tr>
<tr>
<td>F1</td>
<td>Show/Hide the Properties tab in Inspector.</td>
</tr>
<tr>
<td>F2</td>
<td>Show/Hide the Behaviors tab in Inspector.</td>
</tr>
<tr>
<td>F3</td>
<td>Show/Hide the Filters tab in Inspector.</td>
</tr>
<tr>
<td>F4</td>
<td>Show/Hide the Object tab in Inspector.</td>
</tr>
<tr>
<td>F5</td>
<td>Show/Hide the Project pane.</td>
</tr>
</tbody>
</table>
### Appendix A  Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F6</td>
<td>Show/Hide the Timing pane.</td>
</tr>
<tr>
<td>F7</td>
<td>Show/Hide the HUD.</td>
</tr>
<tr>
<td>⌘ X + 1</td>
<td>Show/Hide the File Browser.</td>
</tr>
<tr>
<td>⌘ X + 2</td>
<td>Show/Hide the Library.</td>
</tr>
<tr>
<td>⌘ X + 3</td>
<td>Show/Hide the Inspector.</td>
</tr>
<tr>
<td>⌘ X + 4</td>
<td>Show/Hide the Layers tab.</td>
</tr>
<tr>
<td>⌘ X + 5</td>
<td>Show/Hide the Media tab.</td>
</tr>
<tr>
<td>⌘ X + 6</td>
<td>Show/Hide the Audio tab.</td>
</tr>
<tr>
<td>F6 or ⌘ X + ?</td>
<td>Show/Hide the Timeline.</td>
</tr>
<tr>
<td>⌘ X + 8</td>
<td>Show/Hide the Keyframe Editor.</td>
</tr>
<tr>
<td>⌘ X + 9</td>
<td>Show/Hide the Audio Editor.</td>
</tr>
</tbody>
</table>

#### Help Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ X + ?</td>
<td>Open Motion Help.</td>
</tr>
<tr>
<td>⌘ X + 0</td>
<td>Show the Welcome Screen.</td>
</tr>
</tbody>
</table>

#### Audio Editor

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ X + 9</td>
<td>Show/Hide the Audio Editor.</td>
</tr>
<tr>
<td>space</td>
<td>Play/Pause a project.</td>
</tr>
</tbody>
</table>
### Audio Tab

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>A</code> or <code>M</code></td>
<td>Add a marker at the current frame.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>control</code> + <code>T</code></td>
<td>Make the object active or deactivate the object.</td>
</tr>
<tr>
<td><code>control</code> + <code>L</code></td>
<td>Lock/Unlock an audio file.</td>
</tr>
<tr>
<td><code>control</code> + <code>S</code></td>
<td>Enable/disable the Solo button of a selected track.</td>
</tr>
<tr>
<td><code>↑</code></td>
<td>Move up one level in the Audio list.</td>
</tr>
<tr>
<td><code>↓</code></td>
<td>Move down one level in the Audio list.</td>
</tr>
<tr>
<td><code>control</code> + <code>/</code></td>
<td>Import.</td>
</tr>
</tbody>
</table>

### Canvas

**View Group (Includes Transform Tools)**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Global Transform Commands</code></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>S</code></td>
<td>Choose the selected transform mode.</td>
</tr>
<tr>
<td><code>shift</code> + <code>S</code></td>
<td>Choose the Select/Transform tool.</td>
</tr>
<tr>
<td><code>tab</code></td>
<td>Cycle through the transform modes. Press repeatedly until the transform mode you want is selected.</td>
</tr>
<tr>
<td><code>shift</code> + <code>drag</code></td>
<td>Constrain the movement of an object to the guidelines.</td>
</tr>
<tr>
<td>Key command</td>
<td>Function</td>
</tr>
<tr>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>Option + drag</td>
<td>Override snapping while moving an object.</td>
</tr>
<tr>
<td>Option + drag</td>
<td>Duplicate a selected object.</td>
</tr>
</tbody>
</table>

**Select/Transform Tool**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift + drag handle</td>
<td>Scale an object proportionally.</td>
</tr>
<tr>
<td>Option + drag handle</td>
<td>Scale an object from its center.</td>
</tr>
<tr>
<td>Shift + Option + drag handle</td>
<td>Scale an object proportionally from its center.</td>
</tr>
<tr>
<td>Shift + drag rotation handle</td>
<td>Snap the rotation of an object to 45° increments.</td>
</tr>
<tr>
<td>Option</td>
<td>Activate 3D transform tool</td>
</tr>
</tbody>
</table>

**Crop Tool**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift + drag handle</td>
<td>Crop an object proportionally.</td>
</tr>
<tr>
<td>Option + drag handle</td>
<td>Crop an object from its center.</td>
</tr>
<tr>
<td>Shift + Option + drag handle</td>
<td>Crop an object proportionally from its center.</td>
</tr>
<tr>
<td>Option + drag</td>
<td>Pan a cropped object within the bounding box.</td>
</tr>
<tr>
<td>Option + Option + drag</td>
<td>Move the bounding box around a cropped object.</td>
</tr>
</tbody>
</table>

**Adjust Control Points Tool**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option + click</td>
<td>Add a point to path.</td>
</tr>
<tr>
<td>Option + drag</td>
<td>Convert a point to linear.</td>
</tr>
<tr>
<td>Option + drag</td>
<td>Create tangents on control point.</td>
</tr>
<tr>
<td>Option + drag</td>
<td>Scale tangents proportionally.</td>
</tr>
<tr>
<td>Option + drag</td>
<td>Adjust a B-Spline point bias.</td>
</tr>
<tr>
<td>Key command</td>
<td>Function</td>
</tr>
<tr>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>🈲 x + click</td>
<td>Toggle a B-Spline point bias.</td>
</tr>
<tr>
<td>option + drag</td>
<td>Break or relink a tangent handle.</td>
</tr>
<tr>
<td>shift + drag</td>
<td>Constrain a tangent to 45° and original value.</td>
</tr>
</tbody>
</table>

### Pan & Zoom Tools

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Select the Pan tool.</td>
</tr>
<tr>
<td>Z</td>
<td>Select the Zoom tool.</td>
</tr>
<tr>
<td>option + click</td>
<td>Zoom Out with the Zoom tool selected.</td>
</tr>
</tbody>
</table>

### Create Group

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Select the Rectangle Shape tool.</td>
</tr>
<tr>
<td>C</td>
<td>Select the Circle Shape tool.</td>
</tr>
<tr>
<td>shift + drag</td>
<td>Draw a shape proportionally.</td>
</tr>
<tr>
<td>option + drag</td>
<td>Draw a shape from its center.</td>
</tr>
<tr>
<td>shift + option + click</td>
<td>Draw a shape proportionally from its center.</td>
</tr>
<tr>
<td>shift + drag rotation handle</td>
<td>Snap the rotation of an object to 45° increments.</td>
</tr>
</tbody>
</table>

### Bezier Tool

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Select the Bezier tool.</td>
</tr>
<tr>
<td>B</td>
<td>Toggle between the Bezier and B-Spline tools.</td>
</tr>
<tr>
<td>C</td>
<td>Close shape.</td>
</tr>
</tbody>
</table>

Double-click or option + click | Add a point to path. |
<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>click</td>
<td>Convert a point to linear.</td>
</tr>
<tr>
<td>drag</td>
<td>Create tangents on point.</td>
</tr>
<tr>
<td>drag</td>
<td>Scale tangents proportionally.</td>
</tr>
<tr>
<td>+ drag</td>
<td>Break or relink a tangent handle.</td>
</tr>
<tr>
<td>+ drag</td>
<td>Constrain a tangent to 45° and original value.</td>
</tr>
<tr>
<td>+ drag</td>
<td>Cancel shape drawing and delete the open shape.</td>
</tr>
<tr>
<td>+ drag</td>
<td>Exit shape drawing mode.</td>
</tr>
</tbody>
</table>

**B-Spline Tool**

| B         | Select the B-Spline tool. |
| B         | Toggle between the Bezier and B-Spline tools. |
| C         | Close shape. |

Double-click or Add a point to path.

| + click   | Adjust a B-Spline point bias. |
| + click   | Toggle a B-Spline point bias. |
| + click   | Cancel shape drawing and delete the open shape. |
| + return  | Exit shape drawing mode. |

**Paint Stroke Tool**

| P         | Activate Paint Stroke tool. |
| P         | Adjust stroke width. |

**Text Tool**

| T         | Select the Text tool. |
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>?, , , , or →</td>
<td>Move the insertion point by character.</td>
</tr>
<tr>
<td>option + ↑, ↓, ←, or →</td>
<td>Move the insertion point by word.</td>
</tr>
<tr>
<td>⌘ + ←</td>
<td>Move to the beginning of a line of text.</td>
</tr>
<tr>
<td>option + →</td>
<td>Move to the end of a line of text.</td>
</tr>
<tr>
<td>shift + ?, , , , or →</td>
<td>Select one or more characters from the insertion point.</td>
</tr>
<tr>
<td>shift + option + ↑, ↓</td>
<td>Select one or more words from the insertion point.</td>
</tr>
<tr>
<td>←, or →</td>
<td>Select a line of text from the insertion point.</td>
</tr>
<tr>
<td>control + →</td>
<td>Increase kerning from the insertion point.</td>
</tr>
<tr>
<td>control + ←</td>
<td>Decrease kerning from the insertion point.</td>
</tr>
<tr>
<td>⌘ + A</td>
<td>Select All.</td>
</tr>
<tr>
<td>⌘ + shift + A</td>
<td>Deselect All.</td>
</tr>
<tr>
<td>esc</td>
<td>Exit Text tool.</td>
</tr>
</tbody>
</table>

### Mask Group

#### Rectangle Mask & Circle Mask Tools

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>option + R</td>
<td>Select the Rectangle Mask tool.</td>
</tr>
<tr>
<td>option + C</td>
<td>Select the Circle Mask tool.</td>
</tr>
<tr>
<td>shift + drag</td>
<td>Draw a shape proportionally.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>option + drag</td>
<td>Draw a shape from its center.</td>
</tr>
<tr>
<td>shift + option + drag</td>
<td>Draw a shape proportionally from its center.</td>
</tr>
<tr>
<td>shift + drag rotation handle</td>
<td>Snap the rotation of an object to 45° increments.</td>
</tr>
</tbody>
</table>

**Bezier Mask Tool**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>option + B</td>
<td>Select the Bezier Mask tool.</td>
</tr>
<tr>
<td>option + B</td>
<td>Toggle between the Bezier Mask and B-Spline Mask tools.</td>
</tr>
<tr>
<td>C</td>
<td>Close mask.</td>
</tr>
</tbody>
</table>

Double-click or Add a point to path.

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>option + click</td>
<td>Add a point to path.</td>
</tr>
<tr>
<td>click</td>
<td>Add a point to path.</td>
</tr>
</tbody>
</table>

Convert a point to linear.

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>drag</td>
<td>Convert a point to linear.</td>
</tr>
</tbody>
</table>

Create tangents on point.

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>drag</td>
<td>Create tangents on point.</td>
</tr>
<tr>
<td>drag</td>
<td>Scale tangents proportionally.</td>
</tr>
</tbody>
</table>

Break or relink a tangent handle.

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>option + drag</td>
<td>Break or relink a tangent handle.</td>
</tr>
<tr>
<td>shift + drag</td>
<td>Constrain a tangent to 45° and original value.</td>
</tr>
</tbody>
</table>

Cancel shape drawing and delete the open shape.

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>return</td>
<td>Exit shape-drawing mode.</td>
</tr>
</tbody>
</table>

**B-Spline Mask Tool**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>option + B</td>
<td>Select the B-Spline Mask tool.</td>
</tr>
<tr>
<td>option + B</td>
<td>Toggle between the Bezier Mask and B-Spline Mask tools.</td>
</tr>
<tr>
<td>C</td>
<td>Close mask.</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts

### Transport Controls

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>space</code></td>
<td>Play/Pause a project.</td>
</tr>
<tr>
<td><code>A</code></td>
<td>Record an animation.</td>
</tr>
<tr>
<td><code>shift</code> + <code>.</code></td>
<td>Enable/disable loop playback.</td>
</tr>
<tr>
<td><code>home</code></td>
<td>Go to the start of a project.</td>
</tr>
<tr>
<td><code>end</code></td>
<td>Go to the end of a project.</td>
</tr>
<tr>
<td><code>shift</code> + <code>home</code></td>
<td>Go to the start of the play range.</td>
</tr>
<tr>
<td><code>shift</code> + <code>end</code></td>
<td>Go to the end of the play range.</td>
</tr>
<tr>
<td><code>←</code></td>
<td>Go to the previous frame.</td>
</tr>
<tr>
<td><code>→</code></td>
<td>Go to the next frame.</td>
</tr>
<tr>
<td><code>shift</code> + <code>←</code></td>
<td>Go backward ten frames.</td>
</tr>
<tr>
<td><code>shift</code> + <code>→</code></td>
<td>Go forward ten frames.</td>
</tr>
</tbody>
</table>
## View Options

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ + =</td>
<td>Zoom In.</td>
</tr>
<tr>
<td>⌘ + -</td>
<td>Zoom Out.</td>
</tr>
<tr>
<td>option + click</td>
<td>Zoom Out with the Zoom tool selected.</td>
</tr>
<tr>
<td>⌘ + drag</td>
<td>Zoom to region.</td>
</tr>
<tr>
<td>option + Z</td>
<td>Zoom to 100 percent.</td>
</tr>
<tr>
<td>shift + Z</td>
<td>Zoom to fit in the Canvas.</td>
</tr>
<tr>
<td>shift + C</td>
<td>Show all color channels.</td>
</tr>
<tr>
<td>shift + T</td>
<td>Show the transparent channel.</td>
</tr>
<tr>
<td>shift + option + T</td>
<td>Show the alpha channel overlay.</td>
</tr>
<tr>
<td>shift + option + C</td>
<td>Show the RGB channels only.</td>
</tr>
<tr>
<td>shift + R</td>
<td>Show the red channel.</td>
</tr>
<tr>
<td>shift + G</td>
<td>Show the green channel.</td>
</tr>
<tr>
<td>shift + B</td>
<td>Show the blue channel.</td>
</tr>
<tr>
<td>shift + A</td>
<td>Show the alpha channel.</td>
</tr>
<tr>
<td>shift + option + A</td>
<td>Show the inverted alpha channel.</td>
</tr>
<tr>
<td>shift + Q</td>
<td>Show the Canvas at full resolution.</td>
</tr>
<tr>
<td>option + F</td>
<td>Enable/Disable field rendering in the Canvas.</td>
</tr>
<tr>
<td>option + M</td>
<td>Enable/Disable motion blur in the Canvas.</td>
</tr>
<tr>
<td>⌘ + shift + R</td>
<td>Show the rulers.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ X + option + ;</td>
<td>Lock the guides.</td>
</tr>
<tr>
<td>⌘ X + ′</td>
<td>Show/Hide the grid.</td>
</tr>
<tr>
<td>⌘ X + ;</td>
<td>Show/Hide the guides.</td>
</tr>
<tr>
<td>⌘ X + shift + ;</td>
<td>Show/Hide dynamic guides.</td>
</tr>
<tr>
<td>shift +</td>
<td>Show/Hide film zones.</td>
</tr>
<tr>
<td>⌘ X + /</td>
<td>Show overlays.</td>
</tr>
<tr>
<td>V</td>
<td>Toggle between the current channel and alpha channel.</td>
</tr>
<tr>
<td>′</td>
<td>Show/Hide safe zones.</td>
</tr>
<tr>
<td>N</td>
<td>Enable/Disable snapping to guides.</td>
</tr>
<tr>
<td>X</td>
<td>Expose active layers.</td>
</tr>
<tr>
<td>shift + X</td>
<td>Expose all layers.</td>
</tr>
</tbody>
</table>

### Miscellaneous

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>Create particle emitter.</td>
</tr>
<tr>
<td>⌘ X + shift + M</td>
<td>Import an image mask to the selected object.</td>
</tr>
<tr>
<td>?</td>
<td>Select the next object above.</td>
</tr>
<tr>
<td>‾</td>
<td>Select the next object below.</td>
</tr>
<tr>
<td>⌘ X + ‾, ‾, ‾, or ‾</td>
<td>Nudge the selected object(s) one pixel.</td>
</tr>
<tr>
<td>⌘ X + shift + ? ‾, ‾, ‾</td>
<td>Nudge the selected object(s) ten pixels.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>shift + drag</code></td>
<td>Add/Remove selected objects using the region box.</td>
</tr>
<tr>
<td><code>click</code></td>
<td>Select multiple objects in a group or layer.</td>
</tr>
<tr>
<td><code>shift + click</code></td>
<td>Add to selection.</td>
</tr>
</tbody>
</table>

### HUD

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>F7</code></td>
<td>Show/Hide the HUD.</td>
</tr>
<tr>
<td><code>D</code></td>
<td>Cycle through the HUDs from top to bottom (when more than one effect is applied to an object).</td>
</tr>
<tr>
<td><code>shift + D</code></td>
<td>Cycle through the HUDs from bottom to top (when more than one effect is applied to an object).</td>
</tr>
</tbody>
</table>

### File Browser

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>X + I</code></td>
<td>Show/Hide File Browser.</td>
</tr>
<tr>
<td><code>X + O</code></td>
<td>Open project.</td>
</tr>
<tr>
<td><code>X + shift + O</code></td>
<td>Open template.</td>
</tr>
<tr>
<td><code>X + N</code></td>
<td>New project.</td>
</tr>
<tr>
<td><code>FS</code></td>
<td>Show/Hide Project pane.</td>
</tr>
<tr>
<td><code>↑</code></td>
<td>Move up one item in the sidebar or file stack.</td>
</tr>
<tr>
<td><code>↓</code></td>
<td>Move down one item in the sidebar or file stack.</td>
</tr>
<tr>
<td><code>←</code></td>
<td>Move left one item in the file stack.</td>
</tr>
<tr>
<td><code>→</code></td>
<td>Move right one item in the file stack.</td>
</tr>
</tbody>
</table>
### Inspector

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>space</code></td>
<td>Show/Hide the Inspector.</td>
</tr>
<tr>
<td><code>x</code> + ↑ or ↓</td>
<td>Increase a slider value by an increment of one.</td>
</tr>
<tr>
<td><code>x</code> + ↓ or ↑</td>
<td>Decrease a slider value by an increment of one.</td>
</tr>
<tr>
<td><code>x</code> + <code>shift</code> + ↑ or ↓</td>
<td>Increase a slider value by an increment of ten.</td>
</tr>
<tr>
<td><code>x</code> + <code>shift</code> + ↓ or ↓ or ←</td>
<td>Decrease a slider value by an increment of ten.</td>
</tr>
</tbody>
</table>

### Keyframe Editor

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>x</code> + <code>s</code></td>
<td>Show/Hide Keyframe Editor.</td>
</tr>
<tr>
<td><code>x</code> + <code>k</code></td>
<td>Convert the applied behaviors to keyframes.</td>
</tr>
<tr>
<td><code>f</code></td>
<td>Fit visible curves.</td>
</tr>
<tr>
<td><code>u</code></td>
<td>Show animated curves.</td>
</tr>
<tr>
<td><code>y</code></td>
<td>Show modified curves.</td>
</tr>
<tr>
<td><code>p</code></td>
<td>Show position curves.</td>
</tr>
<tr>
<td><code>r</code></td>
<td>Show rotation curves.</td>
</tr>
<tr>
<td><code>s</code></td>
<td>Show scale curves.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Show shear curves.</td>
</tr>
<tr>
<td>A</td>
<td>Show anchor point curves.</td>
</tr>
<tr>
<td>O</td>
<td>Show opacity curves.</td>
</tr>
</tbody>
</table>

### Layers

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌃ ⌘ + shift + N</td>
<td>Create a new group.</td>
</tr>
<tr>
<td>⌃ ⌘ + /</td>
<td>Bring the object to the top of the group.</td>
</tr>
<tr>
<td>⌃ ⌘ + /</td>
<td>Send the object to the bottom of the group.</td>
</tr>
<tr>
<td>⌃ ⌘ + /</td>
<td>Bring the object up one level in the Layers list.</td>
</tr>
<tr>
<td>⌃ ⌘ + /</td>
<td>Send the object down one level in the Layers list.</td>
</tr>
<tr>
<td>⌃ ⌘ + shift + G</td>
<td>Place the selected objects in a new group.</td>
</tr>
<tr>
<td>⌃ ⌘ + option + G</td>
<td>Ungroup a group of objects so you can manipulate the objects individually.</td>
</tr>
<tr>
<td>control + T</td>
<td>Make the object active or deactivate the object.</td>
</tr>
<tr>
<td>control + S</td>
<td>Enable/disable the Solo button of a selected track.</td>
</tr>
<tr>
<td>control + I</td>
<td>Isolate the selected group or layer.</td>
</tr>
<tr>
<td>control + L</td>
<td>Lock/Unlock an object.</td>
</tr>
<tr>
<td>?</td>
<td>Move up one level in the Layers list.</td>
</tr>
<tr>
<td></td>
<td>Move down one level in the Layers list.</td>
</tr>
</tbody>
</table>
**Keyboard Shortcuts**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Collapse a group in the Layers list.</td>
</tr>
<tr>
<td>⌘ X + /</td>
<td>Import</td>
</tr>
<tr>
<td>⌘ X + shift + M</td>
<td>Add an image mask to the selected object.</td>
</tr>
<tr>
<td>⌘ X + K</td>
<td>Convert the applied behaviors to keyframes.</td>
</tr>
<tr>
<td>shift + F</td>
<td>Open the Media tab and Inspector to reveal the source and properties of media objects.</td>
</tr>
<tr>
<td>K</td>
<td>Clone the selected layer.</td>
</tr>
</tbody>
</table>

**Library**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Show/Hide the Library.</td>
</tr>
<tr>
<td>space</td>
<td>Select the first item in the sidebar or file stack.</td>
</tr>
<tr>
<td>?</td>
<td>Move up one item in the sidebar or file stack.</td>
</tr>
<tr>
<td>↓</td>
<td>Move down one item in the sidebar or file stack.</td>
</tr>
<tr>
<td>←</td>
<td>Move left one item in the file stack.</td>
</tr>
<tr>
<td>→</td>
<td>Move right one item in the file stack.</td>
</tr>
<tr>
<td>⌘ X + ?</td>
<td>Move up one level in the folder hierarchy of the file stack.</td>
</tr>
</tbody>
</table>

**Media Tab**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ X + S</td>
<td>Show/Hide Media tab.</td>
</tr>
<tr>
<td>?</td>
<td>Move up one level in the Media list.</td>
</tr>
</tbody>
</table>
### Appendix A  Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Move down one level in the Media list.</td>
<td></td>
</tr>
<tr>
<td>Key command</td>
<td>Function</td>
</tr>
<tr>
<td>⌘ ⌘ +</td>
<td>Import</td>
</tr>
</tbody>
</table>

### Timeline

#### Editing and Navigating

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Nudge one frame forward.</td>
<td></td>
</tr>
<tr>
<td>Nudge one frame backward.</td>
<td></td>
</tr>
<tr>
<td>Nudge ten frames forward.</td>
<td></td>
</tr>
<tr>
<td>Nudge ten frames backward.</td>
<td></td>
</tr>
<tr>
<td>Move the selected object to the In point.</td>
<td></td>
</tr>
<tr>
<td>Move the selected object to the Out point.</td>
<td></td>
</tr>
<tr>
<td>Mark the In point of the play range.</td>
<td></td>
</tr>
<tr>
<td>Mark the Out point of the play range.</td>
<td></td>
</tr>
<tr>
<td>Reset the play range by moving the In and Out points to the first and last frames of the project.</td>
<td></td>
</tr>
<tr>
<td>Enable/Disable loop playback.</td>
<td></td>
</tr>
<tr>
<td>Open the Recording Options dialog.</td>
<td></td>
</tr>
<tr>
<td>Go to the start of play range.</td>
<td></td>
</tr>
<tr>
<td>Go to the end of play range.</td>
<td></td>
</tr>
<tr>
<td>Go to the In point of the selected object.</td>
<td></td>
</tr>
<tr>
<td>Key command</td>
<td>Function</td>
</tr>
<tr>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td><code>shift</code> + O</td>
<td>Go to the Out point of the selected object.</td>
</tr>
<tr>
<td>←</td>
<td>Go to the previous frame.</td>
</tr>
<tr>
<td>→</td>
<td>Go to the next frame.</td>
</tr>
<tr>
<td><code>shift</code> + ←</td>
<td>Go backward ten frames.</td>
</tr>
<tr>
<td><code>shift</code> + →</td>
<td>Go forward ten frames.</td>
</tr>
<tr>
<td>⌘ + option + →</td>
<td>Go to the next marker.</td>
</tr>
<tr>
<td>⌘ + option + ←</td>
<td>Go to the previous marker.</td>
</tr>
<tr>
<td>⌘ + R</td>
<td>Render a RAM Preview for the play range.</td>
</tr>
<tr>
<td>⌘ + option + R</td>
<td>Render a RAM Preview for the selected object.</td>
</tr>
<tr>
<td>⌘ + shift + option + R</td>
<td>Render a RAM Preview for the entire project.</td>
</tr>
<tr>
<td>/</td>
<td>Mark an In point.</td>
</tr>
<tr>
<td>O</td>
<td>Mark an Out point.</td>
</tr>
<tr>
<td>. or M</td>
<td>Add a marker at the current frame.</td>
</tr>
<tr>
<td>⌘ + option + M</td>
<td>Open the Edit Marker dialog.</td>
</tr>
<tr>
<td>space</td>
<td>Play/Pause the project.</td>
</tr>
<tr>
<td>A</td>
<td>Record animation.</td>
</tr>
<tr>
<td>home</td>
<td>Go to the start of project.</td>
</tr>
<tr>
<td>end</td>
<td>Go to the end of project.</td>
</tr>
<tr>
<td>⌘ + K</td>
<td>Convert the applied behaviors to keyframes.</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts

### Keyframing Commands

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift + delete</td>
<td>Perform a ripple delete.</td>
</tr>
<tr>
<td>option + drag + click</td>
<td>Paste special.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>option + click</td>
<td>Double-click or Add a point to path.</td>
</tr>
<tr>
<td>shift + drag + click</td>
<td>Convert a point to linear.</td>
</tr>
<tr>
<td>shift + drag</td>
<td>Create tangents on point.</td>
</tr>
<tr>
<td>shift + drag</td>
<td>Adjust a B-Spline point bias.</td>
</tr>
<tr>
<td>option + click</td>
<td>Toggle a B-Spline point bias.</td>
</tr>
<tr>
<td>shift + drag</td>
<td>Break a tangent handle.</td>
</tr>
<tr>
<td>shift + drag</td>
<td>Constrain a tangent to 45° and original value.</td>
</tr>
</tbody>
</table>

### Shape and Mask Commands

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift + drag</td>
<td>Draw a shape proportionally with the Rectangle, Circle Shape, and Mask tools.</td>
</tr>
<tr>
<td>option + drag</td>
<td>Draw a shape from its center with the Rectangle, Circle Shape, and Mask tools.</td>
</tr>
<tr>
<td>shift + option + drag</td>
<td>Draw a shape proportionally from its center with the Rectangle, Circle Shape, and Mask tools.</td>
</tr>
<tr>
<td>esc</td>
<td>Cancel shape drawing and delete the open shape.</td>
</tr>
<tr>
<td>return</td>
<td>Exit shape drawing mode.</td>
</tr>
</tbody>
</table>
### Toolbar

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide the Toolbar.</td>
<td>![ ] + ![ ] + ![ ]</td>
</tr>
<tr>
<td>Choose the selected transform mode.</td>
<td>![ ]</td>
</tr>
<tr>
<td>Choose the Select/Transform tool.</td>
<td>![ ] + ![ ]</td>
</tr>
<tr>
<td>Cycle through the transform modes. Press repeatedly until the transform mode you want is selected.</td>
<td>![ ]</td>
</tr>
<tr>
<td>Select the Pan tool.</td>
<td>![ ]</td>
</tr>
<tr>
<td>Select the Zoom tool.</td>
<td>![ ]</td>
</tr>
<tr>
<td>Select the Rectangle Shape tool.</td>
<td>![ ]</td>
</tr>
<tr>
<td>Select the Circle Shape tool.</td>
<td>![ ]</td>
</tr>
<tr>
<td>Toggle between the Bezier and B-Spline tools.</td>
<td>![ ]</td>
</tr>
</tbody>
</table>
## Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>Select the Text tool.</td>
</tr>
<tr>
<td>option + R</td>
<td>Select the Rectangle Mask tool.</td>
</tr>
<tr>
<td>option + C</td>
<td>Select the Circle Mask tool.</td>
</tr>
<tr>
<td>option + B</td>
<td>Toggle between the Bezier Mask and B-Spline Mask tools.</td>
</tr>
<tr>
<td>F7</td>
<td>Show/Hide the HUD.</td>
</tr>
<tr>
<td>control + 1</td>
<td>Show/Hide the File Browser.</td>
</tr>
<tr>
<td>control + 2</td>
<td>Show/Hide the Library.</td>
</tr>
<tr>
<td>control + 3</td>
<td>Show/Hide the Inspector.</td>
</tr>
<tr>
<td>F5</td>
<td>Show/Hide the Project pane.</td>
</tr>
<tr>
<td>F6 or control + 7</td>
<td>Show/Hide the Timing pane.</td>
</tr>
<tr>
<td>control + T</td>
<td>Show the Fonts dialog.</td>
</tr>
<tr>
<td>control + shift + C</td>
<td>Show the Colors window.</td>
</tr>
</tbody>
</table>

### 3D Commands

<table>
<thead>
<tr>
<th>Key Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q</td>
<td>Select the 3D transform tool.</td>
</tr>
<tr>
<td>.</td>
<td>Toggle 3D transform tool between position-only and universal.</td>
</tr>
<tr>
<td>.</td>
<td>Toggle the 3D transform tool between rotate-only and universal.</td>
</tr>
<tr>
<td>.</td>
<td>Toggle the 3D transform tool between scale-only and universal.</td>
</tr>
<tr>
<td>control + A</td>
<td>Set 3D View to Active Camera.</td>
</tr>
</tbody>
</table>
Using the Command Editor

Motion provides a wide variety of menu commands and keyboard shortcuts that let you control almost every aspect of your project, from playback to displaying windows and inspectors to working with tools. The Command Editor lets you search or browse the various commands and keyboard shortcuts in Motion. In addition, the Command Editor lets you customize keyboard shortcuts so you can streamline the way you work.

This section covers how to modify keyboard shortcuts using the Command Editor.

Use the Command Editor’s search tools to find keyboard commands, view their descriptions, and preview highlighted key combinations in a visual representation of your keyboard. You can modify existing shortcuts, create new shortcuts, and save multiple sets that can be imported and exported for use by others. If you’re more familiar with keyboard commands from other applications, you can use the Command Editor to substitute those commands for Motion’s default set.

Motion provides four built-in sets of keyboard shortcuts for the following languages: English, Japanese, French, and German.

To display the Command Editor in Motion:

- Choose Motion > Commands > Customize.
The Command Editor appears.

**Command Editor Interface**

The upper half of the Command Editor displays a virtual keyboard. The lower half contains a Command List that sorts menu commands by group and offers a brief description of each command, along with its associated key combination, if any.

The virtual keyboard is color-coded to help you identify the type of command each key performs. For example, transport commands, such as Play (Space bar) and Record (A), are light blue, while alignment commands are pink. The Command Groups window on the left side of the Command List contains a clickable color key for reference.

Keys that are assigned to shortcuts are marked with a dark gray dot, while unassigned keys have no additional markings. Several keys are shaded with a hatch pattern, indicating that they are reserved for system use.
Choosing a Set
By default, Motion uses the Standard Set of commands, with the language choice that you specified when you set up your computer.

To choose a key command set, do one of the following:

- Choose Motion > Commands, then choose a set from the submenu.
- If the Command Editor is already open, choose a set from the pop-up menu in the upper-left corner.

Once you choose the command set you want, the keyboard shortcuts in the set become active in Motion.

Viewing Keyboard Shortcuts by Group
The Command List displays several groupings of commands, organized by Motion menus as well as types of commands (Alignment, Tools, Transport, Go To, View, and Mark). Click a group to quickly filter the Command list to display only the commands and keyboard shortcuts in that group.

Searching for Commands
Use the Search field in the upper-right corner of the Command Editor to quickly locate a command or keyboard equivalent. You can search by command name, description, or keyboard shortcut.

To search for a keyboard shortcut:

- In the Command Editor, click in the Search field type a word that describes the keyboard shortcut you need.
The Command List immediately displays the search results, listing all commands and key combinations related to the search term.

You can further narrow your search by choosing a category from the Search field pop-up menu. The menu options include All, Command, Description, and Key Equivalent.

**Note:** Do not use the Shift key to capitalize letters when typing in the Search field. The Search field recognizes the Shift key as a modifier key in a keyboard shortcut.

You can use the Search field in conjunction with the virtual keyboard to highlight keyboard shortcuts.

**To search for and highlight a shortcut on the virtual keyboard:**

1. Click the Keyboard Highlight button to the left of the Search field.
   
   The keyboard dims.

2. Click in the Search field and begin typing.

   Motion filters the Command List as you type and highlights the keys related to your search term.

   For example, in the image below, the search term “Ripple” returns two keyboard shortcuts for the Ripple Delete command, and the command keys are highlighted in the virtual keyboard.

   **Note:** When you turn on the Keyboard Highlight button, only command keys are highlighted. Modifier keys that may be part of the keyboard shortcut (Command, Shift, Option, and Control) are not highlighted.

![Image of keyboard with highlighted keys](image-url)

Command keys are highlighted on the keyboard for easy reference.
Filtering the View by Modifier Keys
You can use the Modifier buttons (Command, Shift, Option, and Control) at the top of
the Command Editor to quickly see which keys work in conjunction with the various
modifier keys.

To filter by modifier keys:
1 Click one of the four modifier buttons at the top of the Command Editor (or click one
of the modifier keys on the virtual keyboard).
 Keys assigned to work in conjunction with the selected modifier key appear marked
 with a dark gray dot.
2 If necessary, click another modifier button (or modifier key in the virtual keyboard) to
 create a combination.
The virtual keyboard updates to show which keys are assigned to shortcuts that use
 those the combined modifier keys.

Viewing Key and Command Details
The window to the right of the Command List additional information about a selected
key in the virtual keyboard or a selected command in the Command List. When you
select a key in the virtual keyboard, this window displays a list all keyboard shortcuts
associated with that key.

When you select a command in the Command List, this window displays a brief
description of the command.
Customizing Keyboard Shortcuts

Customizing shortcuts in the Command Editor is fast and easy. Because the default Standard Set includes commands for which no shortcut is defined, you may want to apply a new shortcut to them. Because you cannot modify the Standard Set, you must first duplicate that set and then customize new duplicate set.

To duplicate the currently active command set:
1. Choose Duplicate from the pop-up menu at the top of the Command Editor.
   A dialog appears and prompts you to name the new set.
2. Type a name in the dialog, then click OK.
   The new duplicate set is saved and appears as an item at the bottom of both the pop-up menu and the top-level Motion > Commands menu.

Now that you have a duplicate set of assigned keyboard shortcuts, you can modify the individual key settings to create new or modified shortcuts.

To add or modify a key command:
1. Using the Search field (or browsing the Command List) of the Command Editor, select the command to which you want to assign a new shortcut key combination.
2. Using your physical keyboard, press the combination of keys you want to use for the command (for example, Shift-Option-T, or any other keys).
   If the key combination is not already assigned to a command, the virtual keyboard updates to show the new key assignment. A gray dot appears on newly assigned key (or keys), and a color is applied if the command belongs to a color-coded command group.
   If the key combination is already assigned to a command, Motion displays the current setting, and prompts you to confirm the change.

Once you make changes to the command set, you can use several methods to save the changes.

To save a command set:
- Click the Save button in the lower-right corner of the Command Editor.
  If you close the Command Editor with unsaved changes, Motion prompts you to save the set.

To delete a command set:
1. Make sure you are using the set you want to delete, then choose Delete from the pop-up menu at the top of the Command Editor.
   A dialog appears.
2. Click Delete.
   The set is removed, and the Standard Set becomes the active set of commands.
Importing and Exporting Command Sets

Once you save a command set, you may want to export it to create a backup or to share the new set with another user. Exported sets are saved in a file that can be imported back into Motion at a later time.

To export a set of keyboard shortcuts:
1. If necessary, use the pop-up menu to activate the command set you want to export, then do one of the following:
   • In the Command Editor, choose Export from the pop-up menu.
   • Choose Motion > Commands > Export.
     A Save As dialog appears.
2. Navigate to the location where you want to save the exported set, then type a name in the Save As field.
3. Click OK.
   The file is saved in the location you chose, with the "commandset" filename extension.

To import a set of shortcuts:
1. Do one of the following:
   • In the Command Editor, choose Import from the pop-up menu.
   • Choose Motion > Commands > Import.
     An Open dialog appears.
2. Navigate to the location where you have stored a command set file, select it, then click Open.
   The new command set is added to the Motion > Commands submenu and the pop-up menu in the Command Editor.
   If you are already using a set with the same name, a dialog appears and prompts you to rename the set.
Motion supports a wide variety of media and video formats for broadcast and multimedia. This appendix covers the technical specifications for the most popular video formats in use today.

Motion allows you to create projects that integrate many media types using a wide variety of formats. This appendix provides an overview of the most popular file formats that are supported.

In addition, whether you’re using one of the Motion project presets or creating your own, it’s important to be aware of what distinguishes one video format from another. More information is provided to explain the different characteristics of video, with explanations for the different frame sizes, how interlacing works, the difference between square and nonsquare pixels, and which frame rates correspond to which video formats.

Finally, this appendix explains how to create artwork that is optimized for broadcast, taking into account the benefits and limitations of broadcast video.

**Supported File Formats**

Motion supports the use of a wide variety of video, still image, and audio files within a single project. Because it’s a QuickTime standard application, Motion supports many of the same file formats that QuickTime does.

**QuickTime Video Codecs**

Motion supports QuickTime video files using nearly any codec installed on your computer, including, but not limited to:

- Animation
- BMP
- Cinepak
- Component Video
- DV - PAL
- DV/DVCPRO - NTSC
- DVCPRO - PAL
- DVCPRO HD 1080i50, 1080i60, 1080p25, 1080p30, and 720p50, 720p60
- DVCPRO50 - NTSC
- DVCPRO50 - PAL
- Uncompressed 8- and 10-bit 4:2:2
- Graphics
  - H.261
  - HDV 1080i50, 1080i60, 1080p24, 1080p25, and 720p24, 720p25, 720p30
- Apple Intermediate Codec
- Motion JPEG A and JPEG B
- MPEG IMX 525/60 (30Mb/s, 40 Mb/s, 50 Mb/s)
- MPEG IMX 625/50 (30Mb/s, 40 Mb/s, 50 Mb/s)
- MPEG-4 Video
- Photo - JPEG
- Apple Pixlet Video
- Planar RGB
- PNG
- Apple ProRes 422 (HQ and SQ)
- TGA
- TIFF
- VC H.263
- Video
- XDCAM HD 1080i50, 1080i60, 1080p24, 1080p25, 1080p30 (35 Mb/s VBR)
- H.263
- H.264
- JPEG 2000
- Sorenson Video 3
- Sorenson Video

**Still Image Formats**

Motion supports most commonly used still image file types, including:

- SGI
- Photoshop
- BMP
- JPEG
- PICT
- PNG
Other Image Formats
In addition, Motion includes special support for the following image types:
- Layered Photoshop files
- PDF files

Audio Formats
You can import audio files with sample rates up to 192 kHz and with bit depths up to 32 bits. Mono and stereo files are supported. Multichannel audio files are also supported. Motion supports the following audio file types:
- WAV
- AIFF
- .cdda
- MP3
- AAC (AAC files are listed in the Finder with the .m4p file extension.)
- QuickTime Audio, with support for the following audio codecs:
  - 8-bit
  - 8-bit Unsigned (Little Endian/WAV)
  - 16-bit Integer
  - 24-bit Integer
  - 32-bit Integer
  - 32-bit Float
  - 64-bit Float
  - ALaw 2:1
  - AMR Narrowband
  - Apple Lossless
  - IMA 4:1
  - MACE 3:1
  - MACE 6:1
  - MPEG-4 Audio

Important: You cannot import rights-managed AAC files, such as those purchased from the iTunes Store.
For more information about the file formats supported by Motion, go to the Motion website at: http://www.apple.com/finalcutstudio/motion.

**Standard Definition Versus High Definition Video Formats**

Motion is extremely flexible and can work with both highly compressed and uncompressed video.

**Standard Definition Video**

Despite having differing frame sizes, NTSC and PAL standard definition video share certain characteristics.

- Both signals are interlaced, although the field order depends on the video capture device used.
- Both signals have a 4:3 aspect ratio, but a 16:9 aspect ratio can be accommodated either anamorphically or by using letterboxing.
- Both use nonsquare pixels to display the picture.

Analog standard definition formats include S-VHS, Hi-8, and Beta SP.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Frame size</th>
<th>Frame rates</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>720 x 486</td>
<td>29.97</td>
<td>Interlaced</td>
</tr>
<tr>
<td>PAL</td>
<td>720 x 576</td>
<td>25</td>
<td>Interlaced</td>
</tr>
</tbody>
</table>

Digital standard definition formats include Digital Betacam and the D-1 through D-5 formats. Due to the wide variety of compression ratios and types in the different digital standards, the table below presents more information on these formats.

<table>
<thead>
<tr>
<th>Digital format</th>
<th>Maker</th>
<th>Color sampling</th>
<th>Compression ratio</th>
<th>Compression type</th>
<th>Recorded bit rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Betacam</td>
<td>Sony</td>
<td>4:2:2</td>
<td>2.3:1</td>
<td>DCT</td>
<td>11.9 MB/sec.</td>
</tr>
<tr>
<td>D-1</td>
<td>Sony</td>
<td>4:2:2</td>
<td>Uncompressed</td>
<td>None</td>
<td>21.5 MB/sec.</td>
</tr>
<tr>
<td>D-2</td>
<td>Ampex</td>
<td>4:2:2</td>
<td>Uncompressed</td>
<td>None</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>D-5</td>
<td>Matsushita</td>
<td>4:2:2</td>
<td>Uncompressed</td>
<td>None</td>
<td>27.5 MB/sec.</td>
</tr>
</tbody>
</table>

**Standard Definition DV**

The frame sizes of NTSC DV and NTSC analog video differ. NTSC and PAL standard definition DV video signals are both interlaced, and share a 4:3 aspect ratio using nonsquare pixels.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Frame size</th>
<th>Frame rates</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>720 x 480</td>
<td>29.97</td>
<td>Interlaced</td>
</tr>
<tr>
<td>PAL</td>
<td>720 x 576</td>
<td>25</td>
<td>Interlaced</td>
</tr>
</tbody>
</table>
Standard definition DV formats include DV, DVCAM, DVCPRO25, and DVCPRO50.

<table>
<thead>
<tr>
<th>Digital format</th>
<th>Maker</th>
<th>Color sampling</th>
<th>Compression ratio</th>
<th>Compression type</th>
<th>Recorded bit rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV</td>
<td>Sony</td>
<td>4:1:1</td>
<td>5:1</td>
<td>DV</td>
<td>3.6 MB/sec.</td>
</tr>
<tr>
<td>DVCAM</td>
<td>Sony</td>
<td>4:1:1</td>
<td>5:1</td>
<td>DV</td>
<td>3.6 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO 50</td>
<td>Panasonic</td>
<td>4:2:2</td>
<td>3:3:1</td>
<td>DV</td>
<td>7 MB/sec.</td>
</tr>
</tbody>
</table>

**High Definition Video**

All high definition formats use a nonanamorphic, 16:9 aspect ratio using square pixels, just like a computer display. Despite these similarities, there are many high definition video formats.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Frame size</th>
<th>Frame rates</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>720p</td>
<td>1280 x 720</td>
<td>23.98, 24, 25, 29.97, 59.94, 60</td>
<td>Progressive</td>
</tr>
<tr>
<td>1080p</td>
<td>1920 x 1080</td>
<td>23.98, 24, 25, 29.97, 59.94, 60</td>
<td>Progressive</td>
</tr>
<tr>
<td>1080i</td>
<td>1920 x 1080</td>
<td>25, 29.97, 59.94, 60</td>
<td>Interlaced</td>
</tr>
</tbody>
</table>

The different frame sizes, frame rates, and scanning methods serve different markets, both domestically and internationally. For example, the availability of the 720p format is a result of needing a lower-resolution format, so that current standard definition programming can be blown up more easily. It is also seen as a format suitable for programming that would not benefit from additional resolution, such as local news. For broadcast, bandwidth is a critical issue, and the larger resolution of 1080 video takes up valuable room on the broadcasting spectrum as well as on the available bandwidth of cable and satellite services.

As you can see in the previous table, each high definition standard supports numerous frame rates. These can be divided into two categories:

- Frame rates for film production and post-production
- Frame rates for broadcast video applications
Frame rates intended for broadcast video use can be interlaced, similar to standard definition video on a television, or progressive like a computer display.

<table>
<thead>
<tr>
<th>Frame rate</th>
<th>Video format</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.98</td>
<td>A progressive frame rate intended for HD video transfer to film. 23.98 is rounded up from the actual frame rate of 23.976. This frame rate is useful in post-production since it can be converted easily by hardware to the interlaced 59.94 frame rate for video viewing purposes.</td>
</tr>
<tr>
<td>24</td>
<td>A progressive frame rate intended for HD video transfer to film</td>
</tr>
<tr>
<td>25</td>
<td>Matches the frame rate of PAL video, used for broadcast.</td>
</tr>
<tr>
<td>29.97</td>
<td>Matches the frame rate of NTSC video, used for broadcast. Some manufacturers that refer to a frame rate of 30 fps are actually referring to 29.97 fps.</td>
</tr>
<tr>
<td>50</td>
<td>Doubles the frame rate of PAL, a high-quality frame rate used for broadcast.</td>
</tr>
<tr>
<td>59.94</td>
<td>Doubles the frame rate of 29.97 video. It’s easier for broadcast equipment to down-convert from 59.94 to 29.97 for purposes of standard definition broadcasting.</td>
</tr>
<tr>
<td>60</td>
<td>Doubles the 30 fps (actually 29.97) frame rate corresponding to NTSC video; a higher quality frame rate used for high definition broadcast.</td>
</tr>
</tbody>
</table>

There are two options available for shooting high definition video:

- Sony’s HDCAM format supports 29.97i and 60i. Sony also has a 24p format.
- Panasonic’s high definition format, DVCPRO HD. Don’t confuse this format with DVCPRO 25 and DVCPRO 50, which are both standard definition formats. Panasonic also has a 24p format that offers variable speed using a variable frame rate technology.

Both of these acquisition formats have color sampling of 8 bits per channel. High definition tape decks also exist with color sampling of 16 bits per channel, for film scanning, mastering, and archival purposes.

<table>
<thead>
<tr>
<th>Digital format</th>
<th>Maker</th>
<th>Color sampling</th>
<th>Compression ratio</th>
<th>Compression type</th>
<th>Recorded bit rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDCAM</td>
<td>Sony</td>
<td>3:1:1</td>
<td>7:1:1</td>
<td>DCT</td>
<td>17.5 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>Panasonic</td>
<td>4:2:2</td>
<td>1.7:1</td>
<td>DCT</td>
<td>12.5 MB/sec.</td>
</tr>
</tbody>
</table>
Supported DVCPRO HD Formats
Motion natively supports the following DVCPRO HD formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Motion Easy Setup</th>
<th>Dimensions</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i60</td>
<td>DVCPRO HD - 1080i60</td>
<td>1920 x 1080</td>
<td>Interlaced</td>
</tr>
<tr>
<td>720p60</td>
<td>DVCPRO HD - 720p60</td>
<td>1280 x 720</td>
<td>Progressive</td>
</tr>
<tr>
<td>720p30</td>
<td>DVCPRO HD - 720p30</td>
<td>1280 x 720</td>
<td>Progressive</td>
</tr>
<tr>
<td>720p24</td>
<td>DVCPRO HD - 720p24</td>
<td>1280 x 720</td>
<td>Progressive</td>
</tr>
</tbody>
</table>

Note: Motion also supports additional uncompressed high definition formats using third-party PCI cards. The table above shows only DVCPRO HD formats currently supported by Motion.

A Comparison of Data Rates of Common High Definition and Standard Definition Formats
The table below shows the relative data rates of some commonly used high definition formats. These data rates can be used as a reference for deciding how much hard drive space you may need for the media you want to use in your project.

<table>
<thead>
<tr>
<th>Format</th>
<th>Bits per second (video only)</th>
<th>Bytes per second</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVCPRO HD, 1080i60</td>
<td>100 Mbps</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO HD, 1080i50</td>
<td>100 Mbps</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO HD, 720p60</td>
<td>100 Mbps</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO HD, 720p30</td>
<td>50 Mbps</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO HD, 720p24</td>
<td>40 Mbps</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>DV</td>
<td>25 Mbps</td>
<td>3.6 MB/sec.</td>
</tr>
<tr>
<td>DVCAM</td>
<td>25 Mbps</td>
<td>3.6 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO(25)</td>
<td>25 Mbps</td>
<td>3.6 MB/sec.</td>
</tr>
</tbody>
</table>
Choosing a Frame Rate
Most DVCPRO HD cameras and decks allow two types of video frame rates:
- Integer frame rates such as 60, 30, and 24 fps
- NTSC-related frame rate variants such as 59.94, 29.97, and 23.98 fps

Note: If you are outputting via Final Cut Pro, Motion only supports NTSC-related timebases such as 59.94, 29.97, and 23.98 fps when transferring video between a computer and a DVCPRO HD device via FireWire. Using tapes recorded with whole-number frame rates such as 60 fps or 30 fps is not supported in Motion.

Popular Video Codecs for File Exchange
You can use video compressed with nearly any video codec in Motion—DV or DVCPRO, DVCPRO 50, DVCPRO HD, Uncompressed 8-bit 4:2:2, Animation, Apple M-JPEG, and other third-party codecs. Bear in mind that when you are working on a project in Motion, it is best to use high-quality codecs with a minimum of compression. Highly compressed video files, such as those compressed using the MPEG-4 or Sorenson codec, are probably going to be unsuitable for creating high-quality work.

Note: Motion works in the RGB color space. Any clips you use in Motion that were captured or recompressed using a YCrCb codec, such as DV or Uncompressed 8-bit 4:2:2, are converted to the RGB color space when used in a Motion project. Clips that are exported from Motion using a YCrCb codec are converted back into the YCrCb color space.

Uncompressed 8-Bit and 10-Bit 4:2:2 Video
Video stored using these codecs undergoes no data compression, but some color resampling may occur depending on the source video format. Because compression usually results in video artifacts, using no compression guarantees the highest level of quality. Unfortunately, it also guarantees enormous file sizes.

Note: Uncompressed 8-bit and 10-bit 4:2:2 movies cannot have alpha channels. (Alpha channels define levels of transparency in your movie and are useful if you’re delivering an effects shot for use in someone else’s composition.)

Animation
The Animation codec was developed for computer-generated imagery, which often has large areas of uniform color and little, if any, noise. It is a lossless codec, which means it doesn’t degrade quality or add artifacts to your video when it applies compression.
Video footage, which generally has more grain, noise, and variations of texture and color than animated material, may not be compressed as much with the Animation codec as with other methods. Because some lossless compression is better than none, this codec is used more frequently than Uncompressed.

Note: Animation movies can have alpha channels. This codec is the most common QuickTime format supporting alpha channels.

**DVCPRO HD**
A high definition video format that can be used to capture video digitally from FireWire-enabled DVCPRO HD compatible decks. Don’t confuse this format with DVCPRO 25 or DVCPRO 50, which are both standard definition formats. This format supports a number of frame sizes and frame rates, including a 24p format that offers variable speed via a variable frame rate technology. DVCPRO HD uses 4:2:2 color sampling for high color fidelity, and has a fixed data rate of 12.5 MB/sec.

Note: DVCPRO HD movies cannot have alpha channels.

**DVCPRO 50**
The DVCPRO 50 codec is used to capture video digitally from FireWire-enabled DVCPRO 50-compatible camcorders and decks. Although it’s similar to the DV codec in that DVCPRO 50 is imported as YUV encoded video, it produces considerably higher quality video since it uses less compression. (DVCPRO 50 uses a 3:3:1 compression ratio, versus DV’s 5:1 compression ratio.) DVCPRO 50 also uses 4:2:2 color sampling for high color fidelity, as opposed to DV’s 4:1:1 color sample rate. DVCPRO 50 has a fixed data rate of 7 MB/sec.

Note: DVCPRO 50 movies cannot have alpha channels.

**Apple M-JPEG**
There are two Apple M-JPEG codecs, M-JPEG A and M-JPEG B. These are variable data rate codecs similar to the ones used by video capture cards. If you need to deliver more heavily compressed material to keep files small, consider these codecs. M-JPEG is a lossy codec and results in artifacts in your final video. The severity of these artifacts depends on the data rate you choose.

Several capture and playback cards on the market can play back either M-JPEG A or M-JPEG B in real time without rerendering the material, or at most, doing minimal rerendering. This makes file interchange very fast. Before you use either M-JPEG A or B, consult the manufacturer of the capture card you’re using to find out which one you should use.

Note: Apple M-JPEG movies cannot have alpha channels.
JPEG
JPEG is similar to M-JPEG, except that the compression artifacts can be less severe at similar data rates. JPEG movies may play back in real time on your system, depending on your system's speed and the data rate of the movie.

Note: JPEG movies cannot have alpha channels.

Third-Party Codecs
There are several manufacturers of video-editing solutions, most of whom use different variations of the M-JPEG codec. Many make software-only QuickTime codecs that you can install in your System folder, enabling you to play back movies with little or no rerendering. For more information, contact the manufacturer of the editing system.

Note: Most third-party codecs cannot have alpha channels.

What Is Field Order?
All video displays, whether analog or digital, work by breaking a single frame of video into individual lines of horizontal resolution running across the screen. Standard definition NTSC and PAL are both interlaced video formats, as opposed to high definition video, or video displayed on a computer screen, which are progressive-scanned video formats. With progressive scanning, these lines are drawn one at a time, from the top of the screen to the bottom.

Interlaced video, including NTSC and PAL, works differently. When you record footage with your camcorder, each video frame is broken down into two fields, each containing half of the total lines of resolution in the frame. The first field is recorded, then the second, and both are laid down to tape, one after the other, so that both fields constitute one frame. When you play the tape back, a television monitor displays each recorded frame in two passes, first drawing field 1, then drawing field 2.

Field order refers to the order in which video fields are recorded from your video equipment to your hard disk. If you remember that video fields come one after another in time, as if playing 60 “frames” per second, it becomes a little easier to understand.

There are two options for field order:

- Upper (Field 2 is dominant, so the second field is drawn first.)
- Lower (Field 1 is dominant, so the first field is drawn first.)

Generally, Upper is used by 640 x 480 systems, while Lower is most common in professional 720 x 486 and DV 720 x 480 systems.

It’s important to render digital video with the field order used by your hardware. Because motion continues from one field to the next, it’s crucial that each field plays in the correct order. Because different capture cards handle interlacing differently, choosing the correct field order ensures proper playback.
Using Square or Nonsquare Pixels When Creating Graphics

When you’re preparing to import graphics into Motion, it’s important to be aware of the pixel aspect ratio you’re using and whether your project requires you to work with square or nonsquare pixels.

**Nonsquare pixels:** Use this for standard definition projects in NTSC or PAL.

**Square pixels:** Use this for high definition projects, as well as multimedia video that will be played back only on computers and doesn’t use any captured video footage.

Graphics created on a computer, whether scanned, painted, or rendered, look distorted on a video monitor unless you account for the different pixel aspect ratio. Fortunately, this is easy to do, since every nonsquare video frame size has an equivalent square frame size that you can use to create your graphics.

**To create graphics that look correct when output to video:**

1. In your graphics application, create a frame size that’s the square pixel equivalent of the video frame size you’re using.

   See the chart below for equivalent sizes. For example, if you’re working in DV-PAL with a nonsquare video frame size of 720 x 576, your graphic should have a square pixel frame size of 768 x 576.

2. Create the graphic.

3. Do one of the following:
   - In your graphics program, rescale the graphic from the square frame size used to create it to the nonsquare equivalent used in Motion.
   - Save your image as is.

Within your Motion project, select the object in the Media tab of the project window, open the Media tab in the Inspector, then choose the correct aspect ratio from the Pixel Aspect Ratio pop-up menu.

<table>
<thead>
<tr>
<th>Video format</th>
<th>Nonsquare 4:3 pixel size (Motion)</th>
<th>Aspect ratio</th>
<th>Square pixel size (graphics program)</th>
</tr>
</thead>
<tbody>
<tr>
<td>601-NTSC 4:3</td>
<td>720 x 486</td>
<td>0.9</td>
<td>720 x 547</td>
</tr>
<tr>
<td>601-NTSC 16:9 Anamorphic</td>
<td>720 x 486</td>
<td>1.2</td>
<td>853 x 486</td>
</tr>
<tr>
<td>DV-NTSC 4:3</td>
<td>720 x 480</td>
<td>0.9</td>
<td>720 x 540</td>
</tr>
<tr>
<td>DV-NTSC 16:9 Anamorphic</td>
<td>720 x 480</td>
<td>1.2</td>
<td>853 x 480</td>
</tr>
<tr>
<td>601/DV-PAL 4:3</td>
<td>720 x 576</td>
<td>1.07</td>
<td>768 x 576</td>
</tr>
<tr>
<td>601/DV-PAL 16:9 Anamorphic</td>
<td>720 x 576</td>
<td>1.42</td>
<td>1024 x 576</td>
</tr>
<tr>
<td>720i/p high definition</td>
<td>NA</td>
<td>1.0</td>
<td>1280 x 720</td>
</tr>
<tr>
<td>1080i/p high definition</td>
<td>NA</td>
<td>1.0</td>
<td>1920 x 1080</td>
</tr>
</tbody>
</table>
Working with Standard Definition (SD) Video Monitors and Computer Displays

Standard definition (SD) video monitors differ from computer displays in a significant way (aside from interlacing): computer displays represent images using a grid of square pixels, while video monitors use pixels that are rectangular in shape.

SD NTSC pixels are narrower than computer pixels and SD PAL pixels are wider than computer pixels. As a result, a 720 x 486 pixel image looks different on a computer display than it does on a video monitor. For example, if you capture a clip of video with a globe in the picture, export a frame, and look at this frame in a graphics application, you’ll see something like this:

The Canvas let you display nonsquare pixel video correctly on the computer’s screen using the Correct For Aspect Ratio command in the View pop-up menu above the Canvas.

Note: High definition video uses only square pixels, so it doesn’t show this discrepancy.
Differences in Color Between Computer and Video Graphics

You should also be aware that the range of colors that can be displayed on a broadcast video monitor is much smaller than that which can be displayed on your computer. For this reason, colors that appear bright and clean on NTSC or PAL video can seem duller when viewed on your computer.

If you output graphics images with colors that go outside the “legal” range for video, they will appear oversaturated, and may “bleed” into other parts of the image. This distortion can be easily avoided by controlling the palette of colors you use in your graphics program. As you create the graphics you’ll be outputting to video, resist the temptation to use the brightest and most saturated shades of color available in your paint program.

Using Fonts and Creating Line Art for Video

When creating line art or selecting a font to use for a broadcast video image, you should avoid creating horizontal single-pixel lines, or using fonts that are too thin. Because video is interlaced, single-pixel lines will flicker as the field in which they appear alternates on and off. This results in “buzzing” in your graphics, with the buzzing becoming more pronounced the closer the thin areas in your image are to horizontal.

This can be lessened by adding a bit of blur or anti-aliasing to your image, but the best thing to do is to avoid single-pixel lines altogether when creating graphics for broadcast.

Scaling Imported High-Resolution Graphics

A high-resolution image is useful if you want to pan and zoom in or out of the image, such as a scanned map or photograph. There won’t be any image degradation because you typically won’t have to zoom more than 100 percent.

Scaling video and still images more than 100 percent creates artifacts: individual pixels become noticeable, causing a “stair-stepping” artifact on high-contrast diagonal lines.

Sometimes the frame size of your imported graphic doesn’t match the frame size of your edited sequence. If the frame size of the graphic is too large, only a small part of your image appears within the Canvas. If it’s too small, the background color of the Canvas (usually black) appears behind the graphic.

To scale an imported graphic to match the frame size of a sequence, use the following:

<table>
<thead>
<tr>
<th>Frame size (pixels)</th>
<th>Type of video</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920 x 1080</td>
<td>High definition, 16:9, square pixel</td>
</tr>
<tr>
<td>1280 x 720</td>
<td>High definition, 16:9, square pixel</td>
</tr>
</tbody>
</table>
Creating Graphics for HD Projects
Creating graphics and still images for high definition video projects is the same process as for standard definition video. To determine the image dimensions for your sequence, follow the guidelines below.

<table>
<thead>
<tr>
<th>Frame size (pixels)</th>
<th>Type of video</th>
</tr>
</thead>
<tbody>
<tr>
<td>720 x 486</td>
<td>Standard definition, 4:3, nonsquare pixel for NTSC</td>
</tr>
<tr>
<td>720 x 480</td>
<td>Standard definition DV, 4:3, nonsquare pixel for NTSC</td>
</tr>
<tr>
<td>720 x 576</td>
<td>Standard definition, 4:3, nonsquare pixel for PAL</td>
</tr>
<tr>
<td>640 x 480</td>
<td>Multimedia, 4:3, square pixel</td>
</tr>
<tr>
<td>480 x 360</td>
<td>Multimedia, 4:3, square pixel</td>
</tr>
<tr>
<td>320 x 240</td>
<td>Multimedia, 4:3, square pixel</td>
</tr>
<tr>
<td>240 x 180</td>
<td>Multimedia, 4:3, square pixel</td>
</tr>
<tr>
<td>160 x 120</td>
<td>Multimedia, 4:3, square pixel</td>
</tr>
</tbody>
</table>

Unlike standard definition video formats, which use rectangular pixels, high definition video formats use square pixels. You don't have to worry about adjusting high definition image dimensions before importing your graphics into Motion.
You can add Motion projects directly to sequences in Final Cut Pro and send Final Cut Pro sequence clips directly to a new Timeline in Motion.

This appendix covers the following:
- Using Motion with Final Cut Pro (p. 1217)
- Using Motion Templates in Final Cut Pro (p. 1223)

**Using Motion with Final Cut Pro**

Integration between Motion and Final Cut Pro allows you to:
- *Import Motion projects into Final Cut Pro:* You can add motion graphics created in Motion directly to your Final Cut Pro sequence without rendering.
- *Update embedded Motion projects in Final Cut Pro:* You can immediately see changes to a Motion project in your Final Cut Pro sequence.
- *Send Final Cut Pro clips or sequences to Motion:* You can create new Motion projects based on a selection of clips or a sequence in Final Cut Pro. You can use this feature to sketch a motion graphics sequence in Final Cut Pro and then refine it in Motion. The new Motion project can then be embedded in your Final Cut Pro sequence.

**Note:** Motion can import audio included in a Final Cut Pro project, but audio in a Motion project does not appear in Final Cut Pro.
**Importing a Motion Project into Final Cut Pro**

You can import Motion projects into Final Cut Pro to quickly add motion graphics, title sequences, and animations to your sequence.

**To import a Motion project into Final Cut Pro, do one of the following:**
- Drag the Motion project from the Finder to the Final Cut Pro Browser or Timeline.
- Choose File > Import > Files, then select the Motion project in the dialog that appears and click Choose.

Importing a Motion project into Final Cut Pro creates a *Motion clip* (also called an *embedded Motion project*) that you can edit in the same way as any other clip in your Final Cut Pro project. A Motion clip in Final Cut Pro is linked to the original Motion project stored on your hard disk. Motion clips appear in the Final Cut Pro Browser and Timeline with a `.motn` extension.

Motion clips can play back in real time, although you may have to choose Unlimited RT mode to avoid rendering. For more information, see the *Final Cut Pro User Manual*.

**Important:** In order for a Motion clip to play correctly in Final Cut Pro, all media files (such as movies and still images) used in the original Motion project must be on the same hard disk as the Final Cut Pro project.

**Making Changes to a Motion Clip in Final Cut Pro**

While working in Final Cut Pro, you can quickly make changes to a Motion clip by opening the clip's project file in Motion. After you save the Motion project, any changes you made appear immediately in Final Cut Pro.

**Note:** This feature requires both Final Cut Pro and Motion to be installed on the same computer.

**To open a Motion project from within Final Cut Pro, do one of the following:**
- Select the Motion clip, then choose View > Clip in Editor.
- Control-click a Motion clip, then choose Open in Editor from the shortcut menu.

The Motion project opens in Motion. Once you make changes in Motion and save the project, Final Cut Pro automatically reconnects the Motion clip to the updated project so you can see the changes.

If you do not use the View > Clip in Editor or Open in Editor command in Final Cut Pro to open a Motion project, Final Cut Pro may not automatically reconnect the Motion project if you resave it. In this case, you will have to manually reconnect the Motion clip in Final Cut Pro to its original Motion project file.
To reconnect a Motion clip to an updated Motion project, do one of the following:

- Initiate the Motion project update from within Final Cut Pro by selecting the Motion clip and choosing View > Clip in Editor.
  
  This method informs Final Cut Pro that the Motion project may be updated; as a result, the Motion clip is automatically reconnected when you return from Motion to Final Cut Pro.

- Select the Always Reconnect Externally Modified Files option in the Editing tab of the Final Cut Pro User Preferences window.
  
  This method tells Final Cut Pro to automatically reconnect any modified media and project files when you switch to another application and then switch back to Final Cut Pro.

  **Note:** The Always Reconnect Externally Modified Files checkbox is active by default in Final Cut Pro User Preferences.

**Restrictions When Working with Motion Clips in Final Cut Pro**

When working with Motion projects in Final Cut Pro, keeping the following restrictions and limitations in mind:

- The audio in a Motion project is not imported into Final Cut Pro.
- All video tracks in a Motion project appear as a single layer when imported into Final Cut Pro as a Motion clip.
- The frame size and duration of the Motion clip are determined by the settings in the Motion project.
- The Final Cut Pro Media Manager does not manage source media files used by a Motion clip's project file. You need to manage your media for Motion projects separately from your Final Cut Pro media.

**Sending Final Cut Pro Clips and Sequences to Motion**

Just as you can import Motion projects into Final Cut Pro (where they are embedded as Motion clips), you can also send standard Final Cut Pro clips and sequences to Motion. To do this, use the Send To Motion Project command. This command is useful when you want to:

- Edit a rough motion graphics sequence in Final Cut Pro and then send those clips to Motion for more complex animation
- Use Final Cut Pro to capture media files for use in Motion

Many of the clip parameters you adjust in Final Cut Pro are retained in the resulting Motion project.
Selecting Clips or Sequences to Send to Motion
The Send To Motion Project command behaves slightly differently depending on what you select in Final Cut Pro and where you select it.

- **Browser clips:** When one or more clips are selected in the Final Cut Pro Browser, the Send to Motion Project command sends the clip or clips to a new project in Motion; the Motion Timeline remains empty and the clips appear in the Motion Media tab.

- **Sequence in the Browser:** When a sequence is selected in the Final Cut Pro Browser, the Send to Motion Project command creates a new Motion project with a track and clip layout identical to that of your Final Cut Pro sequence.

- **Clips in a sequence:** When one or more clips in a sequence are selected in the Final Cut Pro Timeline, a new Motion project is created containing only the clips you selected in your Final Cut Pro Timeline. In Motion, the clips retain the same track layout as your original selection. When the Embed Motion Content checkbox is selected in the Export Selection to Motion Project dialog, which allows you to replace your selected sequence clips in Final Cut Pro project in their place.

**Important:** Sending a Motion clip (as opposed to a Final Cut Pro clip) by itself back to Motion results in an empty project. If you want to open a Motion clip in Motion, use the Open in Editor command instead. For more information about working with imported Motion projects, see “Making Changes to a Motion Clip in Final Cut Pro” on page 1218.

**To send clips or sequences from Final Cut Pro to a new Motion project:**
1. In Final Cut Pro, do one of the following:
   - Select one or more clips in the Browser.
   - Select a sequence in the Browser.
   - Select one or more sequence clips in the Timeline.
2. Choose File > Send To > Motion Project.
3. In the dialog that appears:
   a. Choose an export location and enter a name for the new Motion project.
   b. If you want the new Motion project to immediately open in Motion, turn on the Launch Motion checkbox.
   c. If you selected sequence clips in the Timeline, turn on the Embed Motion Content checkbox to replace the selected sequence clips in Final Cut Pro with the Motion project you just created (an embedded Motion clip with the .motn extension). For more information, see “Sending Selected Sequence Clips from Final Cut Pro to Motion” on page 1221.
4. Click Save.
A new Motion project is created. If you selected the Launch Motion option, the new project opens in Motion. For more information about the results of sending different kinds of selections to Motion, see the following sections.

**Sending Browser Clips from Final Cut Pro to Motion**
When you send Browser clips from Final Cut Pro to Motion, a new Motion project is created with an empty Timeline and the media from each selected Final Cut Pro clip displayed in the Motion Media tab. Use this method to quickly import media from Final Cut Pro into an empty Motion project.

**Sending a Browser Sequence from Final Cut Pro to Motion**
When you send a sequence (selected in the Browser) from Final Cut Pro to Motion, each clip in that sequence is placed in a separate layer in a new Motion project (in the Layers tab and Timeline). Use this method to edit one or more layers in Final Cut Pro and then add effects, animation, or text in Motion.

*Important:* Sending a sequence that contains Motion clips from Final Cut Pro to Motion causes gaps to appear in the Motion Timeline where the Motion clips appeared in the sequence.

**Sending Selected Sequence Clips from Final Cut Pro to Motion**
When you send multiple sequence clips (selected in the Timeline) from Final Cut Pro to Motion, each selected clip in that sequence is placed in a separate layer in a new Motion project. Noncontiguous selections are allowed. For example, if you selected sequence clips A, B, and D in Final Cut Pro, but you skipped clip C, the Motion Timeline would also contain media from clips A, B, and D with a gap where clip C was located.

When you send sequence clips to Motion, several things happen:
- Final Cut Pro automatically creates a new sequence containing only the clips you selected. You can verify that there is a new sequence by looking in the Browser.
- The contents of the new sequence are used to create a new Motion project.
- If you choose the Embed Motion Content option in the Export Selection to Motion Project dialog, the new Motion project is imported back into Final Cut Pro, as an embedded Motion clip (with a .motn extension) in the Browser. The selected sequence clips are replaced by the new Motion clip.

**About the Embed Motion Content Option**
The Embed Motion Content option is available only when you send selected sequence clips from the Final Cut Pro Timeline to a new Motion project. This option imports the new Motion project back into Final Cut Pro and replaces your selected sequence clips. In effect, it converts your selection of sequence clips into a Motion clip in a single step. For more information about working with imported Motion projects, see “Making Changes to a Motion Clip in Final Cut Pro” on page 1218.
If you don’t select turn on the Embed Motion Content checkbox, the selected sequence clips are still copied into a new sequence in the Browser, but they are not replaced. Furthermore, the new Motion project is not imported into Final Cut Pro, so your original sequence remains unchanged.

**What Properties Are Exported to Motion?**

When you send sequence clips from the Final Cut Pro Timeline to Motion, the following properties are retained in the exported Motion project.

<table>
<thead>
<tr>
<th>Exported properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video</strong></td>
</tr>
<tr>
<td>• Clips, with In and Out points, placed on the correct Timeline tracks and positions</td>
</tr>
<tr>
<td>• Clip and sequence markers (called <strong>object and project markers</strong> in Motion)</td>
</tr>
<tr>
<td>• Almost all attributes in a clip’s Motion tab, including Basic Motion, Crop, Distort, Opacity, Drop Shadow, and Time Remap. Any linear and smooth Bezier keyframes are also included.</td>
</tr>
<tr>
<td>• Composite (blend) modes</td>
</tr>
<tr>
<td>• The SmoothCam filter. If applied, the filter is converted to the Stabilize behavior with the Smooth method enabled in Motion.</td>
</tr>
<tr>
<td><strong>Audio</strong>¹</td>
</tr>
<tr>
<td>• Media</td>
</tr>
<tr>
<td>• Markers</td>
</tr>
<tr>
<td>• Levels and keyframes</td>
</tr>
</tbody>
</table>

¹The audio exported to Motion is not imported when you bring the Motion project back into Final Cut Pro. The audio is only intended to be used in Motion for playback and markers. For this reason, make sure that you retain the original audio clips in Final Cut Pro.

**Note:** With the exception of the SmoothCam filter, Final Cut Pro does not send filters applied to clips. Also, transitions and generators are not sent.

**Rendering Motion Projects for Use in Final Cut Pro**

If necessary, you can export a Motion project to a QuickTime movie and import it into Final Cut Pro. This method is less flexible than importing Motion projects directly into Final Cut Pro, so you should usually avoid this option. When you export the Motion project, choose the Animation codec for lossless compression and to include an 8-bit alpha channel. The alpha channel makes it easy to composite the QuickTime movie with your footage in Final Cut Pro.

**Important:** When importing a QuickTime movie that has been exported from Motion, set the alpha type for the sequence clip in Final Cut Pro to black.
Using Motion Templates in Final Cut Pro

In Motion, templates are useful when you are creating a number of projects that share elements like text or media. You can use a Motion template as a starting point for project customization. A Motion template used in Final Cut Pro can be used in any number of projects and sequences, and each instance can be customized. In addition, you can make changes to the source Motion template file, and have the changes propagate to all the projects and sequences in Final Cut Pro that use that project.

Template integration between Motion and Final Cut Pro allows you to:

- Create templates in Motion for use in Final Cut Pro. You can create templates in Motion that can be used directly in Final Cut Pro.
- Customize master templates in Final Cut Pro. You can edit master templates into sequences and then customize parameters such as text and video within drop zones. You can globally modify the look of all template clips in your project by editing the original Motion template file.

Terminology for Master Templates

The following definitions provide some shorthand for discussing the behavior of sequences containing clips derived from master templates:

- **Motion template file**: A template file created and saved in Motion. This term refers to the template file stored on disk.
- **Master template**: A Motion template file as it appears in Final Cut Pro. You can view master templates in the Viewer and edit them into a sequence, creating copies called **template clips**.
- **Template clip**: An instance of a master template edited into a sequence or copied into the Browser. Just as normal Final Cut Pro clips refer to QuickTime media files on disk, a template clip refers to a Motion template file on disk. When a Motion template file is changed and saved in Motion, any template clips that refer to the template file are updated.
- **Template parameters**: Special template clip parameters that you can customize directly in Final Cut Pro using the Controls tab of the Viewer. For example, you can modify text or video content in a template clip.

Creating a Template in Motion for Use in Final Cut Pro

You can create templates in Motion that automatically appear in the Effects tab of Final Cut Pro in the Master Templates section. For more detailed information on working with templates in Motion, see “Customizing and Creating New Templates” on page 250. There are two types of objects in a Motion template that can be edited in Final Cut Pro:

- **Drop zone media**: You can replace clips or stills in drop zones in Final Cut Pro.
Text: You can edit the content, Text Size, and Text Tracking of text in template clips in Final Cut Pro.

There are templates that are installed when Motion is installed. These templates already appear in the Effects tab in Final Cut Pro, in the Master Templates bin.

Considerations When Creating Motion Templates for Final Cut Pro
In preparation for creating a project for use as a template, you should keep the following considerations in mind:

- To get the best quality from your template, choose the same aspect ratio, resolution, and frame rate as your destination Final Cut Pro sequence when creating the template in Motion. For more information on Motion project settings, see “Editing Project Properties” on page 197.

- By default, drop zones are named by the media used to create the drop zone, and text objects are named by the content of the text therein. If your project contains a large number of drop zones and text, consider renaming these objects in a way that will help you easily identify the ones you wish to edit in Final Cut Pro. For more information on naming objects in Motion, see “Renaming Groups” on page 247.

- Position text visually as well as with the desired Alignment parameter in the Layout pane of the Text Inspector (Left, Center, or Right), in order to retain the expected visual alignment when the text objects are edited in Final Cut Pro. For more information on text, see “Working with Text” on page 569.

- If adding dissolves or other transitions to a template clip in Final Cut Pro, be sure to allow for this in the template design, by adding sufficient number of extra frames at the beginning or end of the template.

- Final Cut Pro always uses the Best scaling option (in the Video Processing tab) when rendering Motion projects and templates.

- To retain proper text formatting in Final Cut Pro, do not mix different text sizes, fonts, or styles within a single text object.

Important: In order for your template to be loaded into Final Cut Pro as a template, the Motion project must be saved as a template.

Creating Drop Zones in Motion
Media contained within drop zones are the only media objects that can be replaced in master templates in Final Cut Pro.

Using Drop Zones
Drop zones provide a way for template users to intuitively and quickly replace footage in a template. There are two ways to create drop zones. The first is to create a drop zone from scratch, and the second is to convert an existing object into a drop zone.

To create a new drop zone in Motion, do one of the following:
- Choose Object > New Drop Zone (or press Command-Shift-D)
Select an existing object in the canvas, then turn on the Drop Zone checkbox in the Image tab of the Inspector.

The Image tab of the Inspector contains controls to adjust the drop zone:

**Drop Zone:** A checkbox that toggles whether an object is a drop zone.

**Fit:** A pop-up menu where you can choose between three different methods of object placement within the drop zone: Fit, Center, and Stretch.

- **Fit:** Automatically scales the media proportionally to fit the dimensions of the drop zone so that the edges of the clip match the edges of the drop zone. When the aspect ratio of the media and the drop zone do not match, the Fit option crops the media to fit the drop zone region without distortion.

- **Center:** Does not modify the object in any way, but merely centers it in the drop zone. Center uses the original scale of the image: smaller objects appear centered in the drop zone, and objects larger than the drop zone are cropped. If media of a different resolution than the project is used, the new resolution is used without any changes to the Scale parameter.

- **Stretch:** Scales the media to fit the dimensions of the drop zone. If the aspect ratio of the media and the drop zone do not match, the media is distorted to fit the drop zone.

**Clear:** A button that clears the image from the drop zone, replacing it with the default generic placeholder graphic.

**Creating Text in Motion**

The following properties of any text you create in a Motion template can be edited in Final Cut Pro:

- **Text Size**
- **Text Tracking**
- **Content**

If you wish to create text in Motion that cannot be edited in Final Cut Pro, turn off the Publish To FCP checkbox in the Text tab of the Inspector. For more information about text formatting and properties, see “Editing Text Format” on page 585.

**Saving Templates in Motion for use in Final Cut Pro**

Templates are simply Motion files that are saved with certain parameters and options enabled. You can create a new template or use an existing Motion template.

**To save a Motion project as a template:**

1. Choose File > Save as Template.
The Save dialog appears.

Note: It is recommended that you create a new custom theme in which to save your own templates.

1. If you want to create a new theme category for your template, click New Theme, type a name in the New Theme dialog, then click Create.
2. In the Save dialog, type a name for the template.
3. In the Theme pop-up menu, choose a theme category in which to store your template.
4. Choose a template format from the Format pop-up menu.
5. If you want your template to play a preview when it appears in the Template Browser, turn on Create QuickTime Preview.
6. Click Save.

Your new template is saved into the theme category you selected. Customized templates are saved to /Users/username/Library/Application Support/Final Cut Studio/Motion/Templates/, in a folder that corresponds to the name of the theme you’ve selected.

If you wish to manually copy projects from one system to another, copy them to the same location.

Important: Templates do not appear in the Final Cut Pro Template Browser unless the templates are copied to a theme subfolder in /Users/username/Library/Application Support/Final Cut Studio/Motion/Templates/.

When you save a template in Motion, the template immediately appears in the Master Templates bin of the Final Cut Pro Effects tab, in a bin corresponding to the name of the theme in which you saved the template in Motion.

Important: Only projects that are saved as templates appear as master templates in Final Cut Pro.
Master Templates in Final Cut Pro
Master templates can be used in any number of sequences within any number of Final Cut Pro projects. If the Motion template is edited in Motion, any template clip that refers to that Motion template file is updated.

Adding Master Templates to a Sequence
You can add master templates to your sequence from four different locations within Final Cut Pro. Try out the following methods to see which one works best for you.

- **Master Template Browser:** Choose Sequence > Add Master Template to open the Master Template Browser. From this window, you can perform an overwrite, insert, or superimpose edit with a master template directly into your sequence. This method provides the most options for editing a template in your sequence and allows you to see a preview of all the installed templates.

- **Master Templates bin in the Effects tab of the Browser:** Double-click a master template to open it in the Viewer or drag a master template to the current sequence in the Canvas or Timeline. This is the quickest way to add multiple master templates to your sequence in one drag-and-drop operation.

- **Generator pop-up menu in the Viewer:** In the Viewer, choose Master Template from the Generator pop-up menu, then choose a template from the submenu. This method opens a master template in the Viewer, which you can then edit into your sequence.

- **Master Templates submenu within the Effects menu:** Choose Effects > Master Templates and then choose a master template. The template opens in the Viewer, which you can then edit into your sequence.

Template Clips in Final Cut Pro
When you edit a master template into a Final Cut Pro sequence, a template clip is created in the sequence. Each template clip can be adjusted independently, so you can uniquely customize the text and media parameters of each template clip in a sequence.

Working with Template Clips in Final Cut Pro
Because templates saved in Motion automatically appear in the Effects tab in Final Cut Pro, there is no need to specifically import templates into Final Cut Pro. You can edit a template clip just like any other clip in your project.

To open a master template or template clip in the Viewer, do one of the following:

- Select the master template, then choose View > Master Template.

- Control-click a master template and then choose Open in Viewer from the shortcut menu.

- Double-click a master template.

  The master template opens in the Viewer.

You may edit certain properties of template clips in the Controls tab of the Viewer.
To replace the media in a drop zone:
1 Open the clip containing media you wish to replace in the Viewer.
2 Select the Controls tab.
3 Find the media you wish to replace.
4 Drag the new clip into the image well in the Parameters column.
   The new media replaces what was previously in the drop zone.

To change the position of a drop zone:
1 Move the playhead to the clip containing drop zone you wish to move.
2 Double-click the clip in the Timeline.
3 In the Viewer, select the Controls tab.
4 Find the media you wish to move.
5 Click the point control for the drop zone you want to reposition.
   In the Canvas, a red center crosshair appears.
6 Drag the crosshair to reposition the selected drop zone.

To edit the text in a text object:
1 Open the clip containing text you wish to edit in the Viewer.
2 Select the Controls tab.
3 Find the text object you wish to edit.
4 Edit the text in the Parameters tab.

To change the size or tracking of a text object:
1 Open the clip containing media you wish to exchange in the Viewer.
2 Select the Controls tab.
3 Find the text object you wish to exchange.
4 Use the slider or value field to set a new Text Size or Text Tracking value.

Making Changes to a Master Template in Final Cut Pro
While working in Final Cut Pro, you can quickly make changes to template clips in Motion by opening the master template in Motion. After you save the Motion template, any changes you made appear immediately in Final Cut Pro.

Important: When you make changes to a master template, you are editing the master template itself, and not template clips already in Final Cut Pro sequences. Any drop zone media changes already made in template clips remain intact. Customized text content remains the same, but updates made to the text font or style appear in template clips.
To open a master template from within Final Cut Pro, do one of the following:
- Select the master template and then choose View > Master Template in Editor.
- Control-click a master template and then choose Open in Editor from the shortcut menu.

The master template opens in Motion. Once you make changes in Motion and save the project, Final Cut Pro automatically reconnects the master template to the updated project so you can see the changes.

If you do not use the Open in Editor command in Final Cut Pro to open a master template, Final Cut Pro may not automatically reconnect the master template if you resave it. In this case, you will have to manually reconnect the master template in Final Cut Pro to its project file.

To reconnect a master template to an updated Motion project, do one of the following:
- Initiate the master template update from within Final Cut Pro by selecting the master template and choosing View > Clip in Editor. This method informs Final Cut Pro that the master template may be updated, so it is automatically reconnected the next time you switch to Final Cut Pro.
- Select the Always Reconnect Externally Modified Files option in the Editing tab of the Final Cut Pro User Preferences window. This method tells Final Cut Pro to automatically reconnect any modified media and project files when you switch to another application and then switch back to Final Cut Pro.

If you have used a master template in a number of sequences, and you wish to make a change to the master template that is isolated to a single instance—and not universally replace the master template—you can make a copy of the master template.

To open a copy of a master template from within Final Cut Pro, do one of the following:
- Select the master template and then choose View > Copy of Master Template in Editor.
- Control-click a master template and then choose Open Copy in Editor from the shortcut menu.

A copy of the master template opens in Motion. Once you make changes in Motion and save the project, Final Cut Pro automatically reconnects that copy of the master template to the updated project so you can see the changes.
Using Float Precision with Motion Content in Final Cut Pro
When embedding Motion content in Final Cut Pro, you can take advantage of the rendering benefits of Motion’s 16- or 32-bit float rendering modes. To do this, go to your the Video Processing tab of Sequence Preferences in Final Cut Pro and enable “Render all YUV material in high-precision YUV.” Once this is set, Final Cut Pro forces Motion elements in the sequence to render in 32-bit mode.
Using Gestures

If you use a Wacom tablet and pen with your computer system, you can use gestures to navigate within Motion and to perform tasks such as editing, copying and pasting, and so on. Gestures are continuous, uninterrupted patterns that are drawn in the Motion user interface (using your tablet).

Note: The supported tablet for using gestures in Motion is the Wacom Intuos tablet family.

Configuring Gesture Setup
Gestures are enabled by default — but you can change the default gesture input and trigger methods in Motion Preferences. When gestures are enabled, you can choose to use a modifier key (the Control key) or a button on the pen to trigger gesturing.

Before you can use gestures, Handwriting Recognition must be enabled in Mac OS X Ink Preferences. The Ink Preferences can be accessed in Motion Gesture Preferences.

Important: To use gestures, make sure that your Wacom tablet and its current drivers are correctly installed on your computer. For more information, see your tablet’s documentation.

To set up Motion Gesture Preferences:
1 In Motion, choose Motion > Preferences (or press Command-:,).
2 Click Gestures.

The Gestures Preferences pane appears.
Important: Gestures in Motion use the Inkwell technology in the Mac OS X operating system. In order to use gestures, you must first enable Handwriting Recognition in Motion Preferences. If you cannot turn gestures on at this point, or perform the following steps, click Open Ink Preferences and follow the instructions in the section, “To set up Ink Preferences” on the next page. Once you have enabled Handwriting Recognition, complete the following steps.

3 For “Gestures are,” ensure that On is selected.

4 To select a gesture input method, select an option from the Trigger pop-up menu:
   - Choose Pen Button 1 to invoke gestures by pressing the first button (the button closest to the tip) on the pen.
   - Choose Pen Button 2 to invoke gestures by pressing the second button on the pen.
   - Choose Modifier (Ctrl) to invoke gestures by pressing Control.

Gestures in the Air
You can use gestures by swiping just above the tablet, without the tip of the pen actually touching the tablet. This feature is called “Allow gestures in the air.”

Important: To use gestures in the air, you must set one of the pen buttons as the gesture trigger input method, as well as set the pen button 1 to Ignored in the Tool Buttons tab of the Wacom Tablet application. For more information, see “Wacom Settings” on page 1233.

To set up Ink Preferences:
1 In the Gestures pane of Motion Preferences, click Open Ink Preferences. The Ink Preferences appear.
2 For “Handwriting recognition is,” click the On option.
By default, a “whoosh” sound is played when gestures are drawn.

To disable the default gesture sound:
1. Click the Options button in Ink Preferences.
2. In the Ink dialog, turn off “Play sound while writing.”

Wacom Settings
In the Wacom Tablet application, you can create customized tool settings for individual applications. For example, you can disable the pen buttons for use in Motion, but have button 1 set as “Double-Click” for another application.

To customize the pen buttons for a specific application:
1. In your Applications folder, open the Wacom Tablet application.
2. In the Wacom Tablet dialog, click Add Application To List and do one of the following:
   - If Motion is currently open, select it from the “Currently running applications” list.
   - If Motion is not currently open, click the Browse button, navigate to and select Motion, then click Choose.
     Motion appears in the Selected Application field.
3. Select all applicable tablets, then click OK.
4. In the Add Tool To Application dialog, click OK.
   Motion appears in the “Applications with customized tool settings” window.
5. Click the Motion icon, then set your pen tool options in the Tool Buttons tab.
6. To set customized tool settings for another application, follow steps 2–5 for that application.
Using Gestures
The following illustration shows the basic gesture anatomy. The green dot represents the start of the gesture, the blue arrow is the direction of your gesture, and the red dot the end of the gesture. Draw the gesture on the tablet, with your pointer in the Motion Canvas or Timeline.

Modifier Keys
Many gestures have additional functionality when used in combination with a key on the keyboard. In the following tables, if a gesture has an entry in the Modifier keys column, it has additional functionality that is accessed by using a shortcut key. For example, if you have the Control key set as the gesture trigger, and you draw the play forward gesture, the project plays forward from the current time. If you press Control-Shift and draw the play forward gesture, the project plays from the start of the project.

The Motion Gestures
The following tables describe the available Motion gestures and their modifier keys, where applicable.

Note: There is no defined minimum or maximum scale for the gestural input. The tolerance is defined by the Inkwell technology. However, the size at which certain gestures are drawn may affect the result of the gesture. For example, when using the “fit to fill” zoom gesture and you draw a large circle, the zoom amount is small. If you draw a small circle, the zoom is large.

Playback Control Gestures
Use the gestures described in the following table for controlling playback.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Advance one frame.</td>
<td>To advance in increments of 10 frames, press Shift.</td>
</tr>
<tr>
<td></td>
<td>Go back one frame.</td>
<td>To go back in increments of 10 frames, press Shift.</td>
</tr>
</tbody>
</table>
## General Navigation

Use the gestures in the following table for general navigation, such as zooming the Canvas and displaying the different panes in the Motion user interface.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Gesture" /></td>
<td>Play forward at normal speed. • To play from start, press Shift. • To toggle loop, press Option.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Gesture" /></td>
<td>Stop or pause playback.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Gesture" /></td>
<td>Zoom in to the Canvas. • To zoom to the area within the gesture, press Shift. For example, if you draw a small gesture around an area, you get a large zoom. If you draw a large gesture, you get a small zoom. • To position the zoom in at the center of the gesture, press Option.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Gesture" /></td>
<td>Zoom out of the Canvas. To position the zoom out at the center of the gesture, press Option.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Gesture" /></td>
<td>Select the Zoom tool. To zoom in and out of the Canvas, move the pen left or right. The zoom is centered on the area in which the pointer is placed in the Canvas.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Gesture" /></td>
<td>Select the Pan tool.</td>
<td></td>
</tr>
<tr>
<td>Gesture</td>
<td>Description</td>
<td>Modifier keys</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
<tr>
<td><img src="image" alt="Triangle" /></td>
<td>Set the Canvas to Home (100 percent).</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Square" /></td>
<td>Fit the Canvas in the window.</td>
<td>To toggle the Canvas to full-screen mode, press Shift.</td>
</tr>
<tr>
<td><img src="image" alt="Timing" /></td>
<td>Show or hide the Timing pane.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Project" /></td>
<td>Show or hide the Project pane.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Inspector" /></td>
<td>Show or hide the Inspector.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="File" /></td>
<td>Show or hide the File Browser.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Library" /></td>
<td>Show or hide the Library.</td>
<td></td>
</tr>
</tbody>
</table>
**General Commands**
The following table describes the gestures for general commands, such as undo, select, and copy and paste.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Undo gesture" /></td>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Redo gesture" /></td>
<td>Redo</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Delete object gesture" /></td>
<td>Delete the selected object.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Select tool gesture" /></td>
<td>Choose the Select tool. If a Select tool mode is enabled, such as Shear, when the gesture is drawn, the Select mode is enabled.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="HUD-toggle gesture" /></td>
<td>Show and hide the HUD.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Copy gesture" /></td>
<td>Copy</td>
<td></td>
</tr>
</tbody>
</table>
| ![Paste gesture](image) | Paste  
*Note:* The Paste command may be a bit tricky to master. | |
**Timeline Navigation and Editing Gestures**
The following table describes the gestures used for Timeline navigation and editing.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Go to start of play range" /></td>
<td>Go to start of play range.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Go to end of play range" /></td>
<td>Go to end of play range.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Go to the start of the project" /></td>
<td>Go to the start of the project.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Go to the end of the project" /></td>
<td>Go to the end of the project.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Go to start of the currently selected object" /></td>
<td>Go to start of the currently selected object.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Go to end of the currently selected object" /></td>
<td>Go to end of the currently selected object.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Group" /></td>
<td>Group</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Ungroup" /></td>
<td>Ungroup</td>
<td></td>
</tr>
</tbody>
</table>
### Gesture

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Gesture" /></td>
<td>Set a local In point for the currently selected object.</td>
<td>To move the In point to the current playhead position, press Shift.</td>
</tr>
<tr>
<td><img src="image2" alt="Gesture" /></td>
<td>Set a local Out point for the currently selected object.</td>
<td>To move the Out point to the current playhead position, press Shift.</td>
</tr>
<tr>
<td><img src="image3" alt="Gesture" /></td>
<td>Bring the selected object forward in the stack.</td>
<td>To bring an object to the front of the stack, press Shift.</td>
</tr>
<tr>
<td><img src="image4" alt="Gesture" /></td>
<td>Send the selected object backward in the stack.</td>
<td>To send an object to the back of the stack, press Shift.</td>
</tr>
</tbody>
</table>
| ![Gesture](image5) | Add a project marker. | • To edit a project marker, press Shift.  
• To clear a project marker, press Option. |
| ![Gesture](image6) | Add an object marker. | • To edit an object marker, press Shift.  
• To clear an object marker, press Option. |
| ![Gesture](image7) | Set the start of the play range. | To clear the play range, press Option. |
| ![Gesture](image8) | Set the end of the play range. | To clear the end of the play range, press Option. |
Using Motion and After Effects

Adobe After Effects integration
You can import a Motion project directly into an After Effects project, preserving its quality without intermediate rendering of QuickTime movies or image sequences. Because After Effects interprets the Motion project as a movie, any operation that can be applied to a QuickTime movie can be applied to a Motion project.

Once a Motion project is opened in After Effects, you can invoke the Edit Original command from the After Effects timeline to launch Motion and modify a project in Motion. Once the project is modified and saved in Motion, it is automatically updated in After Effects.

Opening Motion projects in After Effects is certified only for After Effects 7, and has not been tested with other versions of After Effects. Motion must be installed on the same computer in order to view, edit, and render Motion projects from After Effects.

To use a Motion project in After Effects:
1 In After Effects, choose File > Import > File.
2 In the Import File dialog, choose All Files from the Enable pop-up menu.
3 Click to select the Motion project you want to import.
4 Choose QuickTime Movie from the Format pop-up menu.
   Important: Steps 1 through 4 must be completed correctly in order for Motion projects to import correctly (or at all).
5 Click Open.
   After Effects should display the Interpret Footage dialog.
6 In this dialog, turn on Premultiplied - Matted With Color.
   All Motion projects, regardless of the background color in the project, use black as the premultiplied color. If this is not already set, click the color well next to the Premultiplied option (in After Effects) to change the color to black.
   Note: You can also click the Guess button in the Interpret Footage dialog (in After Effects).
7 Click OK to import the Motion project.
   The Motion project, identified by the Motion icon, is listed in the After Effects Project window.

8 Drag the project into the Timeline or composition.
   The Motion project is treated like a QuickTime movie. Therefore, it can be composited with other elements, and effects can be added.

   **To modify a Motion project once it has been imported into After Effects:**
   1 In After Effects, select the layer containing the Motion project.
   2 Choose Edit > Edit Original (or press Command-E).
      If not already open, Motion launches and the project is opened for editing.
   3 Modify the Motion project, then choose File > Save.
      Changes to the Motion project are automatically updated in After Effects.

**Additional After Effects Integration Notes**
Any Motion project with a field order set in the Project Properties dialog is automatically rendered with fields in After Effects. To change this, edit the Motion project using the Edit Original command in After Effects, then open the Project Properties dialog in Motion (choose Edit > Project Properties, or press Command-J). In the General tab of the Project Properties dialog, set the Field Order to the desired setting (None/Upper First [Odd]/Lower First [Even]).

Motion blur in After Effects does not affect objects moving within the Motion project. To enable motion blur for elements moving within the Motion project, motion blur must be enabled in Motion. In Motion, choose View > Motion Blur (or press Option-M), then save the project to update it in After Effects.
## Index

2D compositing 15
2D groups
defined 18
rasterization and 708, 709, 772
triggering rasterization 288
2D mode
2D/3D status 68
flattened text 630
switching to 3D mode 70
2D object views 47
2D transforms 264
3D animation
Parameter behaviors and 383
software packages 204
text 1243
3D axis handles 56
3D clone layers 284
3D Compass 46
3D compositing 15
3D effects, simulating 277
3D filter 890
3D grid
preferences 150
turning on or off 48, 174
3D groups
creating 74
defaulting to 149
defined 18
Inspector features 132
lighting parameters 131
masks and 1088
rasterization and 130, 288, 708, 709, 772, 856
soloing and unsoloing 168
3D mode
2D/3D status 68
Align to Motion behavior and 460
animated rotation 281
Attracted To behavior and 462
Attractor behavior and 464
Canvas 54
converting 2D groups to 3D 69
defaulting to 149
Drag behavior and 465

Drift Attracted To behavior and 466
Drift Attractor behavior and 467
Edge Collision behavior and 468
flattened text 630
interpolation settings 1054
isolating 725
keyboard shortcuts 1195
layer order and 341
lighting and 165, 704
manipulating views in 55
Move behavior and 422
new camera settings 165
options 42
Orbit Around behavior and 472
particle emitters 697
preferences 149
Random Motion behavior and 476
render quality 639
Repel behavior and 477
Repel From behavior and 479
replicators and 761, 780, 803
rotating objects 56
splitting camera tracks 341
Spring behavior and 480
switching to 2D mode 70
text animation and 678
text transforms in 572
Throw behavior in 429
tools 46, 55
transforming objects 56
Vortex behavior and 481
Wind behavior and 483
Wriggle behavior and 452
Z axis alignment 166
3D modeling software 309
3D motion paths
adjusting 420
creating 411
text on 631, 637
3D objects
masks and 1090
text layers as 572
views 47
Index
Attach to Emitter parameter 704
Attach To Emitter slider 731
Attack parameter 1144
Attract To image well 480
Attracted To behavior 460
Attractor behavior 462
Audio and audio files 1117–1146
about 213
activating 83
adding to projects 82, 1119
as media files 75
Audio Editor 104
audio sync 144, 327, 1136
audio-only QuickTime movies 1165
balancing 81, 107
channels 1129
clipping 1131
compression algorithms 1118, 1158
cross-fading 1135
cutting, copying and pasting options 83, 1125
defined 80
deleting 1126
displaying in Keyframe Editor 554
displaying in Timeline 89, 328
duplicating 1125
export settings 156, 1155, 1157
exported properties 1222
exporting 1145, 1148, 1165
exporting selections 316
file formats 1118, 1203–1216
file information 81
filtering 82
format 76
importing 82, 83, 1118
keyframes for 1118
keyframing 1134
level meters 108, 1131
Library categories 121, 230
link icon 1123
listing 1124
looping 144, 1138
moving playhead position 106
multichannel 1118
multiple tracks of 82
muting 81, 83
output 81, 1129
panning 1131, 1134
peak indicators 108
peak types 1143
playback controls 105
previewing 1119
QuickTime audio track 1121
rates 76
retiming 1136
revealing source media files 83
Scrub behavior and 457
scrubbing 110, 1133
soloing 83
Soundtrack Pro 83, 1144
Timeline display 323
tracks. See Audio tracks
turning audio on and off 81
unlinking 327
viewing 1124
viewing information 1125
viewing waveforms 1124
Audio Auto Pan behavior 1139
Audio behaviors 1141
about 370, 1139
Audio parameter behavior 431
parameter behaviors 1141
Audio Editor 22, 104–110, 1118, 1124
Add Keyframe command 107
Animation menu 107
controls in 105
current frame field 105
Delete Keyframe command 107
displaying 104
Jump to Start control 105
keyboard shortcuts 1177
keyframe graph 108
level controls 106
level meters 108
Next Keyframe command 107
pan controls 107
Play/Pause control 105
playback controls 105
playhead 106, 109
Previous Keyframe command 107
ruler 109
scrubbing 110
Show in Keyframe Editor command 107
track end time 106
track start time 106
Use Marked Region control 105
zooming 109
Audio Editor icon 37
Audio Fade In/Fade Out behavior 1140
Audio icon 37
Audio parameter behavior 1141
Audio tab 22, 80–83, 1117
adding audio files 82
additional features 83
displaying 81
editing columns 82
filtering 82
keyboard shortcuts 1178
Lock column 81
Mute command 83
Output column 81
Pan column 81
removing files 82
Index

Reveal Source Media command 83
Status column 81
Audio track bar 106
Audio tracks 1126–1139
cutting, copying, and pasting 1125
divider 89
hiding 1127
keyframing 1134
keyframing levels 1134
keyframing panning 1135
level meters 1131
locking 1129
markers 1138
Master track 1130
muting 1128
Pan slider 1131
playing 1127
recording keyframes 1134
renaming 1129
resetting clipping indicators 1131
scrubbing 1133
selecting 1127
setting levels 1128
slipping 1132
soloing 1128
Soundtrack Pro and 1144
syncing with video tracks 1136
trimming 1132, 1133
turning Master track on and off 1130
turning on and off 1126, 1127
Audio/video links 327
Aura filter 914
Autosave 145, 193
Autosave vault 145, 193
Auto-scaling in Keyframe Editor 102, 555
Average behavior 431
Axis pop-up menu 424, 425, 427, 460

B
Back button 111, 118, 200
Back camera view 170
Background (Canvas) 147
Background Color well 239
Background colors 142, 186, 239
Background opacity 186, 239
Background Task List 314
Backgrounds, animated 741–743
Bad TV filter 931
Baking
  behaviors into keyframes 404
  exporting selections 315
Balancing audio 81, 107
Baselines of text 588
Basic 3D filter 890
Basic Motion behaviors 408–430
about 370
examples 484
Fade In/Fade Out 409–410
Grow/Shrink 410–411
Motion Path 411–422
Point At 423–425
Snap Alignment to Motion 425–426
Spin 426–428
Throw 428–430
using with text objects 676
Batch window 1163
Before First Keyframe extrapolation 550
Behavior Applied state 100
Behaviors
  3D animation 678
  about 16, 369
  activating 390
  Add Behavior icon 34
  additive 446
  animated previews 374
  animating parameters 402–405, 514
  animation paths 376
  applying 117, 374, 377, 379, 737, 738, 1064, 1101, 1108
  applying multiple 393
  applying to multiple objects 378
  audio 452, 1139
  baking 404
  Basic Motion behaviors 408–430, 484
  browsing for 373
  Camera behaviors 452
categories of 120
cells and 738
  combining 393
  combining with keyframes 398–402, 515
  converting to keyframes 402, 404
copying and pasting 391
customized 406
defined 16, 18
deleting 379, 407
displaying HUDs 388
duplicating 392
duration 379, 395
enabling and disabling 376, 389
elements of 483–499
filter parameters and 849
folders for 405
generators and 990
groups and 238, 379
icons for 375, 385
image masks and 1108
Inspector display 389
Index

Keyframe Editor and 377, 400
keyframes and 372
keyframing 403, 514
Library categories 228
locating in Library 406
locking 389
masks and 1101
Modifying behaviors 387–389
Motion Tracking behaviors 452
moving to other computers 408
moving to other folders 407
moving to other objects 391
multiplicative behaviors 409
nested 393
Parameter behaviors 380–387, 403, 430–452
parameters and 372
particle emitters and 737, 738
particle scaling 739
particle spinning 739
particle systems and 688, 736
Particles behaviors 452, 738
removing 374, 377, 379
renaming 389
reordering 393
Replicator behaviors 452
replicators and 820, 835, 836
Retiming behaviors 312, 453–458
saving 123, 405–408
Shape behaviors 452
shapes and 1064
sharing 405–408
Simulation behaviors 396–397, 458–483
Stop Parameter behavior 394
template-based projects 252
Text behaviors 452
text objects and 566, 575, 676
text on paths and 635
themes and 119
Timeline and 323, 328, 397
timing of 394
Track Parameter behavior 387
trimming 395
turning on or off 73, 87
types of 370, 1064–1080
vs. keyframes with text 680
Behaviors icon 74
Behaviors tab (Inspector) 131
Behind blend mode 309
Best render quality 49
Bevel filter 869
Bezier animation paths 511
Bezier interpolation 547
Bezier Mask Tool 1183
Bezier Mask tool 33, 1000, 1087
Bezier masks 1092
Bezier splines 1086
animation paths 511
control points 265
defined 999
drawing 1000
drawing freehand shapes 1007
editing control points 1023
shapes 1059
tangent handles 1024
text paths 640
Beziers tool 32, 1000, 1180
Birth rate (emitters) 726
Birth Rate parameter 698, 702
Birth rate randomness 726
Bit depth 184
about 185
export settings 157
media files 76
previewing for float bit depth 52
Bitmaps 210
Black Hole filter 892
Blank projects 182
Blank time 361
Blend Mode submenu commands 168
Blend modes
about 285, 290
adding or subtracting 1097
alpha channels and 307
changing 287
displaying object status 70
effects 294–309
groups and 291
image masks 1107
masks 1006, 1092, 1096
objects and 294
rasterization and 288
replicators and 769, 776
setting for layers 74
text objects 572
Blending particle systems 704
Bloom filter 915
Blue Green Screen filter 921
Blur filters 857–869
Channel Blur 858
Circle Blur 859
Compound Blur 859
Defocus 860
Directional Blur 861
Gaussian Blur 862
Gradient Blur 863
Mix parameter and 862
Movement 864
Prism 865
Radial Blur 866
Soft Focus 867
Variable Blur 867
Zoom Blur 868
Blur Map well  860
Blur on drop shadows  312
BMP format  204
Border filters  869–871
    Bevel  869
    Simple Border  870
    Widescreen  870
Bottom camera view  170
Bounce Strength parameter  468
Bounding boxes
    Edge Collision behavior and  468
    objects  267
text margins  646
Box particles  720
Box replicator shapes  790, 791
Box tool  529
    keyframe editing  101
    manipulating keyframes  544
Breaking tangent handles  1025
Brightness filter  872
Bring Forward command  260
Bring to Front command  260
Broadcast Safe filter  962
Broadcast video  1215
Browser clips (Final Cut Pro)  1221
Browsing
    for files  198, 202
    for filters  842
    for templates  138
Brush color
    paint strokes  1014
    parameters  1015
Brush types  133, 1027
Brushes
    scale  1054
    shape outline options  1046
    shapes  1043, 1044
B-Spline Mask tool  33, 1003, 1087, 1183
B-Spline tool  32, 1003, 1181
B-Splines
    as masks  1002, 1092
    control points  265
    defined  1000
    degrees of curvature  1027
drawing freehand shapes  1007
drawing with  1003
    editing control points  1025
    hiding frames  1059
    paths  640
    shapes  1059
Build Style parameter  793, 802
Bulge filter  892
Bump Map filter  893
Burst particles  718
Burst replicator shapes  787, 801

C
Cache
    LiveFonts  146
    preferences  144
Camera behaviors  370, 452
Camera menu  46, 55
Cameras
    3D mode and  54
    3D views  170
    adding to projects  18, 54, 420
    export settings  157
    facing  1056
    inset views  47
    Inspector features  132
    isolating  69, 74, 86, 631
    New Camera icon  34
    replicators and  804
    resetting  55, 421
    rotating  420
    saving in Library  123
    Timeline display  323
    Toolbar icons  34
Canvas  38–66
    3D grid  48, 150
    3D mode  54
    about  20–22
    animation in  506, 509
    animation paths  511
    background color of  147
    Channels pop-up menu  44
    features of  38–59
    field rendering  50
    frame blending  51
    frame rate  41
    Full Screen mode  29
    Full View area  49
    guides  53, 266
    keyboard shortcuts  1178–1180
    keyframing in  506, 507
    lighting settings  49
    mini-Timeline  21
    Motion Blur settings  51
    moving objects in  267
    pixel color status  40
    playing projects  58
    pointer position  40
    preferences  147
    Project pane  22
    RAM preview  59
    render quality settings  49
    Resolution pop-up menu  43
    rulers  52
    safe zones  266
    shortcut menu  21
    size of  184

Index
Index

Status Bar 39
swapping with Project pane 26
timecode fields 64
transforms in 261, 265
transport controls 21, 58
view options 41
Zoom Level pop-up menu 42
Categories
removing objects or folders from 233
Template Browser 255
Caustics generator 968
CD-ROM footage 204
Ceiling values for audio 1142
Cell height in columns 71
Cell sources
defined 687
objects and 688
Cells (particle)
advanced controls 712
animation parameters 713
applying behaviors to 738
behavior categories 738
cell parameters 735
color modes and 734
creating animations for 711–712
creating images for 711
defined 686
filters applied to 688
generators as sources 993
Inspector features 133
multiple 695
multiple types of 686
parameters 687, 725–733
QuickTime movies and 733
sources 733
Cells (replicators) 755, 758, 764, 783, 805, 814
Cellular generator 969
Channel Blur filter 858, 1113
Channel Mixer filter 872
Channel Swap filter 875
Channels
alpha channels 212
animation channels 543
audio output 1129
blend modes and 307, 1092
combined masks and 1097
image masks and 1105, 1107
manipulating alpha channels with filters 1112
particle emitters and 723
particle systems and 711
source channels 1106
Channels pop-up menu 44
Channels submenu commands 170
Checkerboard generator 969
Cinema layout 24, 322
Circle Blur filter 859
Circle Mask tool 33, 1087, 1182
Circle parameter 414
Circle Screen filter 932
Circle tool 32, 1010, 1180
Circles filter 932
Circular particles 717
Circular replicator elements 787
Circular replicator shapes 791
Clamp At pop-up menu 433
Clamp behavior 432
Clear Curve List button 101
Clearing RAM preview 61
Clipping indicators 1131
Clips
adding multiple 335
analysis 314
importing from Final Cut Pro 1221
template clips 1227
Clock animations 495–499
Clone layers
creating 283
rasterizing and 284
Cloning
layers 75
objects 268
Closed shapes
closing 1059
control points and 1021
creating from open shapes 1021
Closed Spline parameter 414
Closing
mask shapes 1089
projects 195
shapes 1002
windows 25
Clouds generator 970
Codecs 76
alpha channels and 1211
Animation codec 1210
artifacts and 1211–1212
export settings 1157
formats for file exchange 1210–1212
lossless 1210
supported codecs 204
supported file formats 203
table of supported codecs 204
third-party 1212
video quality and 1210–1212
Collapsed image sequences 201, 209
Collapsing
animations 115
dropping objects on collapsed groups 339
groups 247
tracks 91, 325
Collect Media option 192
Collections (fonts) 586
Color Balance filter 876
Color Burn blend mode 297
Color Correction filters 871–890
  Brightness 872
  Channel Mixer 872
  Channel Swap 875
  Color Balance 876
  Color Reduce 877
  Colorize 878
  Contrast 879
  Desaturate 880
  Equalize 881
  Gamma 881
  Gradient Colorize 882
  HSV Adjust 883
  Invert 885
  Levels 885
  Negative 886
  Reduce Banding 886
  Saturate 887
  Sepia 887
  Threshold 888
  Tint 889
  YIQ 890
  YUV Adjust 890
Color Dodge blend mode 300
Color Emboss filter 934
Color Key filter 922
Color keying 921
Color Mode parameter 808
Color Range parameter 814
Color Reduce filter 877
Color Solid generator 971
Color tags 598, 1037
Color wells 127
Colorize filter 878
Colors
  background 142, 186, 239
  bit depth and 185
  blend modes and 290, 294
  broadcast colors 1215
  channels 44, 1105
  color tags 1037
  color wells 127
  computer vs. broadcast video monitors 1215
  distorted or dull 1215
  drop shadows 621
  export settings 157
  generators 971
  gradients 596, 1033, 1035, 1036, 1040
  grids 150
  guide colors 54
  opacity 1037, 1038
  paint strokes 1014, 1049
  particle cells and 734
  particles and 711, 728
  preferences 147
premultiplied 1241
  replicators 808, 813
  shape fills 1009
  shape outlines 1044
  shapes 133, 1031, 1032
  spread 600
  Status Bar information 40
text 133, 573, 591
  Timeline track area 91
Colors icon 36
Colors window 591
Columns (particle emissions) 721
Columns (replicators) 771, 795
Columns of data
  adjusting cell height 71
  adjusting width 71
  editing 71
  hiding 77
  moving 250
  reordering 71
  showing and hiding 250
  sorting 79, 114
Combining behaviors and keyframes 515
Command Editor 1196
Comments in markers 365
Compass 46, 173
Composite edits 332, 334
Compositing 257
  blend modes and 285, 290, 294
  clone layers 283
  composite edits 332
  defined 257
  dragging objects into Timeline 331
  drop shadows and 309
  groups and layer order in 259
  layer and depth order in 130
  object and layer transforms 261
  opacity and 285, 289
  overview 15
  retiming 312
  triggers for rasterizing 288
Compound Blur filter 859
Compression
  artifacts 204
  audio algorithms 1158
  export settings 156, 1157
  media files 76
  particle systems and 712
  quality and 1212
  video file exchange and 1210
Compressor
  Batch window 1163
  exporting projects with 1147
  exporting with 1160–1164
  presets 1164
  Consolidating media 254
Constant color distribution 1034
Constant extrapolation 551
Constant interpolation 547, 596
Content
  adding to Library 232
  Library categories 231
  missing 233
Content Library 139
Continuous color distribution 1034
Continuous interpolation 547, 597, 1143
Contrast filter 879
Control Point tool 1179
Control points
  adding and deleting 1020
  adding to animation paths 511
  adjusting 265, 279
  B-Spline 1025
  converting to Bezier 549
  corner and curve points 1024
  defined 997
  deleting 1022
  displaying 1018, 1059
  editing Bezier points 1023
  keyframing shape control points 1080
  locking or unlocking 1023
  masks 1095
  moving on shapes or masks 1020
  selecting on shapes or masks 1019
  Track Points behavior 1075
Control Points parameter 419
Control Type parameter 437
Controller mode 437
Converting
  behaviors to keyframes 402
  groups to 3D 69
  keyframes to Bezier 549
Coordinate systems 197
Copying
  audio tracks 1125
  behaviors 391, 405–408
  behaviors to other computers 408
  filters 851
  generators 990
  groups 241
  in Timeline 347
  keyframes 541
  layers 241
  layouts 28
  objects in Layers tab 74
  presets to other computers 190
Corner points
  control points 1024
  in shapes 1001
Corner-pinning
  objects 277
  parameters 282
rasterization and 288
Corners on shape outlines 1046
Correct for Aspect Ratio option 48
Counting time 64, 66
Crawl Left text behavior 650
Crawl Right text behavior 652
Create tools 32
Creation dates for media files 76
Crop parameter 227
Crop tool 1179
Cropping
  Inspector vs. Media tab 278
  objects 278
  parameters 282
  particle systems and 705
  rasterization and 288
  replicators and 778
Cross-fading audio 1135
Crystallize filter 934
Current Frame field 64, 66, 90, 105, 356, 528
Current frames, exporting 316
Current Keyframe state 100
Current pixel color 40
Curvature parameter 411, 447, 449
Curve control points 1024
Curved Bezier shapes 1001
Curves 503–563
  about 526, 545
  animation and 504
  auto-scaling and 102
  comparing 527
  creating custom curve sets 98
  custom parameter sets 533
  displaying 102, 349
  displaying modified curves 97
  editing tools 100
  extrapolation methods 551
  first and last keyframes of 512
  interpolation methods 545, 547
  keyframe thinning 559
  locating in Library 537
  managing sets 98
  mini-curve editor 555
  modifying 545, 555
  particle emitters and 713
  related curve sets 532
  replicator animations 821
  saving 536
  setting to snapshots 99
  setting types of 99
  sketching 543
  taking snapshots 538
  Custom behavior 433–435
  Custom layouts
    saving 27
    switching to 28
Index

Custom Speed parameter 420
Custom Traversal parameter 663, 834
Customize icon 36
Customizing
  File Browser 200
  objects 232
  particle effects 750
  particle system emitters 696
  project settings 183
  template-based projects 250
  text styles 567
  Toolbar 35
Cutting
  audio tracks 1125
  objects 346
  objects in Layers tab 74
D
D-1 format 1206, 1210
D-2 format 1206
D-5 format 1206, 1209
Dabs
  animating 1057, 1071
  converting to particles 1057
  defined 1012
  fixed numbers of 1052
  in shape outlines 1044
Dampening oscillation 444
Damping parameter 800
Damping slider 722
Darken blend mode 295
Dashboard. See HUDs
Data rates 76, 1209
Dates 76
Dazzle filter 916
Decaying oscillation 444
Defaults
  project settings 142
  setting 184
Defocus filter 860
Deinterlace filter 962
Delete Keyframe command 107, 130
Deleting
  audio files 83, 1126
  behaviors 374, 377, 379, 407
  caches 146
  categories from Template Browser 255
  color tags 601, 1037
  control points 1020, 1022
  cutting objects 346
  folders 113, 233, 407
  groups 72, 326
  items in nested layers 340
  keyframes 98, 107, 349, 518, 519, 524, 540
  layers 90, 340
layouts 28
markers 364
media files 72, 78, 79, 112, 113
objects 74, 223, 233, 340, 345
presets 153, 1154
project presets 190
replicator source objects 767
replicators 764
text 582
textures 608
themes 119
tracks 340
unused media files 79
Depth
  3D mode replicators 780
  bit depth 184, 185
  export settings 157
  media files 76
  order in compositing 130
Depth slider 469
Desaturate filter 880
Deselecting objects 262
Detaching windows from docked position 26
Dials 126
Difference blend mode 306
Digital Betacam format 1206, 1210
Digital Cinema Desktop Preview 151
Digital rights (protected files) 121, 213, 1205
Direction
  gradients 1032, 1038
  particle emitters 723
  text sequence behaviors 660
Direction pop-up menu 418, 423, 482
Directional blur filter 861
Disabling
  behaviors 376
  keyframes 541
Disc Warp filter 894
Disclosure triangle 92
Disconnecting tracks from contents 355
Displace filter 895
Displaying
  3D Compass 46
  animation paths 45, 509
  applied behaviors 375, 385
  behaviors 72, 87
  collapsed image sequences 201
  color channels 44
  columns in Media tab 77
  control points 1059
  curves 102, 349
  drop zones 318
  effects 68, 72
  filters 87
  groups 242
  hidden objects 262
hidden tools 29
HUDs 136
keyboard shortcuts 1185
Keyframe Editor 528
keyframes 87, 348, 524
layers 68, 242
Layers List view 72
masks 68, 72, 87, 1088
parameters 102
particles 731
rulers 45
source media files 75
tabbed windows 26
timecode or frame numbers 66
tracks in Timeline 94
visibility status in Layers tab 69
window expose commands 317
Displays (computer) 1214
Distortion filters 890–913
  Basic 3D 890
  Black Hole 892
  Bulge 892
  Bump Map 893
  Disc Warp 894
  Displace 895
  Droplet 896
  Earthquake 897
  Fisheye 898
  Flop 899
  Fun House 899
  Glass Block 900
  Glass Distortion 901
  Insect Eye 902
  Mirror 902
  Poke 903
  Refraction 904
  Ring Lens 905
  Ring Warp 905
  Ripple 906
  Scrape 907
  Sphere 908
  Starburst 908
  Stripes 909
  Target 910
  Twirl 910
  Underwater 912
  Wave 912
Distributing
  gradient tags 603, 1038
  objects 268, 269
Dithering 186
Divider 89
Divider line 89, 329
Dock 25
Dolly tool 46, 55
Down-Res to Canvas Size setting 207
Draft render quality 49
Drag behavior 464
Drag parameter 472, 481
Drag slider 460, 462, 464, 466, 467, 476, 477, 478
Dragging
  drag and drop preferences 336
  items onto Layers list 336
  objects into wells 459
Draw order of outlines 1045
Drawing
  Bezier shapes 1000
  B-Splines 1002
  freehand shapes 1007
  gestures 1231
  lines 1007
  masks 1087
  paint strokes 1012
  shape tools 1030
Drift Attracted To behavior 465
Drift Attractor behavior 466
DRM (rights-protected files) 121
Drop delay settings 336
Drop In From Left text behavior 669
Drop menu
  drop delay settings 336
  layered Photoshop files and 217
Drop Menu Delay preference 138
Drop shadows
  about 309
  adjusting 276
  blur amount 312
  HUD controls 311
  particle systems and 704
  replicators and 777
  text 133, 620, 621
Drop zone objects 251
Drop zones 253, 318, 1224, 1228
Droplet filter 896
Dropped frame indicator 64
Duplicating
  audio files 83
  audio tracks 1125
  behaviors 392
  clone layers 283
  color tags 601
  export presets 1153
  layers 75
  layouts 28
  media files 78, 219
  objects 74, 268
  opacity tags 601
  presets 153
Index

project presets 190
projects 192

Duration
behaviors 379, 395
changing 362
default setting 143
end duration 315
filters 854
generators 965
layer preferences 568
media files 76
modifying dynamically 66
particle systems 706
preferences 142
project duration field 65
replicators 778
retiming and setting 186
shortening 350
still images 208
Duration indicators 64
Duration Range slider 458
DV format 1207, 1209
DVCAM format 1207, 1209
DVCPro 100 format 1208
DVCPro 25 format 1207, 1208, 1209
DVCPro 50 format 1207, 1208, 1210, 1211
DVCPro HD formats 1208, 1209, 1211
DVD Alpha Transition markers 366
DVD footage 204
DVD Menu Loop markers 366
Dynamic Guides 45
color of 148
effective use of 266
turning on and off 1017
Dynamic zoom mode 42

E
Earthquake filter 897
Ease In and Ease Out sliders 457
Ease In and Ease Out text sequence controls 659
Ease In interpolation 548
Ease Out interpolation 548
Echo filter 959
Edge Collision behavior 467, 487–490
Edge Work filter 935

Edges
feathering 1006, 1009, 1033
feathering masks 1099
Matte Choker filter and 1114
particles 711
textures 609
Edges filter 936
Edit menu 161, 1170

Edit tool 100, 528
Editing
alpha channels 1097
audio 1144
behaviors 387
Bezier shapes 1023
B-Spline control points 1025
columns of data 71
composite edits 332, 334
copying and pasting 347
curves 545, 553, 555
cut edits 346
deleting objects 345
disconnecting tracks from contents 355
displaying modified curves 97
Dynamic Guides and 1017
exchange edits 333, 334, 348
export presets 1152
filter parameters 847
generators 983
group tracks 351
In or Out points 344
insert edits 332, 334, 347
keyboard shortcuts 1191, 1196
keyframes 100, 102, 348, 521, 538
markers 365
mask keyframes 1104
masks 1088
master templates 1228
mini-Timeline features 61
Motion clips in Final Cut Pro 1218
move edits 342
objects in Timeline 341–356
outlines 617
overlapping objects 354
overwrite edits 333, 334, 348
particle emitter properties 703–710
particle systems 692
presets 154
project presets 190
project properties 197–198
projects after import into After Effects 1242
Ripple Delete edits 346
sequential edits 334, 335
shapes 1008, 1017
slip edits 345
template text 252
template-based behaviors 252
template-based keyframes 252
templates 1228
text 571, 583
text layers 571
text layouts 629
text on paths 643
text paths 639
text styles 590
Index

Textures 609
Transform tools 1018
Trim edits 343, 355
Trimming multiple objects 344
Trimming without changing effects 356
Turning snapping on or off 1017
Types of edits 341

Effects
Applying 117
Displaying 68
Inspector features 125
Library features 115
Organizing 122
Overview 15
Photoshop 210
Pre-made particle systems 690
Timeline controls 87
Toolbar icons 34
Trim edits and 356
Turning on and off 73
Utility window features 110
Elements in replicators 754
Embed Motion Content option 1221
Emission Angle parameter 698
Emission Latitude/Emission Longitude parameter 699, 725
Emission ranges 698, 723
Emitter center point 695
Emitters. See Particle emitters
Empty shapes 1008
Enable/Disable Animation command 107, 130
End caps 1046
End Condition pop-up menu 419
End Condition settings 833
End Offset parameter 397, 447
End points (particle emitters) 723
End times. See Play ranges
End Value parameter 436, 437, 447
Equalize filter 881
Exchange edits 333, 334, 348
Exchanging
media 223
objects 251
Exclusion blend mode 306
Expanding tracks 91, 325
Explosions 707
Exponential behavior 435
Exponential interpolation 548
Export presets 1149
Creating 1153
Deleting 1154
Duplicating 1153
Editing 1152
Image sequences 1151
Motion Preferences 1151
Options 1154
QuickTime movies 1150
Still images 1151
Exporting
Advanced options 1156
Alpha channel information 1151
Audio 156, 1145, 1148, 1165
Baking 315
Compression settings 1157
Compressor 1160–1164
current frames 1149
defining output type 1149
Final Cut Pro movies 1219
Float projects 186
Frame blending settings and 52
Image sequences 1148, 1149
iPod-ready projects 1164
Lighting settings and 49
Motion blur settings and 51
Play ranges 1160
Presets. See Export presets
Projects 1147–1166
QuickTime movies 1148, 1149, 1222
Render quality and 49
Retained properties 1222
Selections 315, 1160
Still images 1148
Templates 1223
Video 1148
Expose commands 317
External video 150
External Video icon 37
Extrapolation
About 550
Constant 551
Converting data to keyframes 553
Defaults 512
Defined 99
Generating keyframes 552
Linear 551
Ping Pong 551
Progressive 552
Repeat 552
Table of methods 551
Extrude filter 937

F
F1–F12 keys 17
Face Camera options 631, 804, 1056
Face parameters 616
Fade In Time and Fade Out Time sliders 409
Fade In/Fade Out audio behavior 1140
Fade In/Fade Out behavior 409–410, 484
Falloff Type pop-up menu 462
Favorites category 124, 232
Favorites folder 121
Favorites menu  122, 169, 231, 405

Feather slider  1006

Feathering
  gradients  1035
  layers with Matte Choker filter  1114
  masks  1006, 1095, 1099
  shape edges  1009, 1031, 1033

Feedback, real-time  17

Field dominance  1212

Field order  186, 1212
  defined  1212
  interlaced video  226
  setting in presets  154

Field rendering  50, 157

File Browser  20, 110–115, 198
  adding folders  113
  collapsing animations  115
  customizing  200
  file stack  112
  Forward and Back buttons  111
  icon  35, 114
  icon view  112, 114
  importing files  111
  importing image sequences  115
  keyboard shortcuts  1187
  list view  112, 114
  moving files  113
  navigation controls  199
  Path pop-up menu  112
  preferences  138
  Preview area  110
  previewing files  111
  Search field  112
  selecting files in  214
  sidebar  199
  sorting columns  114
  File Browser stack  112
  File creation dates  76

File formats. See Audio and audio files, Media files, Video formats

File menu  160, 1169

File Modified dates  76

File size information  76

File stack  112, 199
  browsing  202
  Library  122
  sorting  202

Files
  adding to existing layers  216
  adding to new layers  215
  adding without using  216
  creation dates  76
  organizing  113
  renaming  113
  saving multiple items in Library  124
  templates  1223

See also Audio and audio files, Media files, Project files

Filled shapes  1008

Fills  133
  gradient controls  1040
  particle emitters  720
  shapes  1009, 1031, 1032

Film  186

Film zones
  color of  148
  guides  45
  preferences  148

Filmstrip display  94, 330

Filter icon  74

Filter parameters
  applying behaviors to  849
  keyframing  848

Filtering
  audio files  82
  fonts  586
  keyframe parameters  531
  Layers List view  72
  media file lists  78

Filters
  about  841
  Add Filter icon  34
  adjusting  846
  alpha channels and  1112, 1113
  animating  513
  applying  117, 238, 843, 1063
  applying multiple  844
  behaviors and  849
  Blur filters  857–869
  Border  869–871
  browsing for  842
  categories  120
  Color Correction  871–890
  copying  851
  defined  18
  displaying in Timeline  328
  Distortion  890–913
  duplicating  852
  duration of  854
  enabling  851
  Glow  913–920
  groups and  238
  Image Units category  229
  indicators  845
  keyframing  513, 848
  Keying  920–927, 1108
  layers and  845
  Lens Flare  973
  Library lists of  228
  locking  851
  masks and  1100, 1108
  Matte  927–928
missing  233
moving  851, 852
onscreen controls  848
parameters  847
particle systems and  688, 740
pasting  851
performance and  844, 845
previewing  842
rasterization and  288, 855, 1115
removing  843
renaming  851
reordering  853
replicators and  838
saving in Library  123
shapes and  1063
Sharpen  928–929
slipping in time  855
Stylize  929–953
text objects and  575
third-party  229, 963
Tiling  953–959
Time  959–962
Timeline display  323
timing of  854
trimming  854
turning on or off  73, 87
types of  842
Video  962–963
working with  850–855
Filters tab (Inspector)  131
Final Cut Express  204
Final Cut Pro  1223
    editing Motion clips in  1218
    embedding Motion projects in  1221
    importing movies from  204, 1219
    integrating with Motion  1217
    master templates  1227, 1228
    Motion templates in  1223
    publishing to  590
    rendering and  1222
    restrictions in  1219
    template clips  1227
text properties  1225
    using Motion projects in  1218, 1223
Finding
    groups  248
    layers  248
    Library items  119
    media files  78, 112, 198
    project files  196
    source media files  83
    Fisheye filter  898
    Fit Curves button  554
    Fit Visible Curves in Window button  101
    Fixed Brush Dabs option  1052
    Fixed groups  244
    Fixed Height parameter  132
    Fixed resolution
    filters and  845
    groups and  132, 245
    particle systems and  689
    PDF files  211
    Fixed Resolution parameter  132
    Fixed Width parameter  132
    Flash Frame behavior  453
    Flatten parameter  132
    Flattened groups  18
    Flattened text  630
    Flexible spaces in Toolbar  36
    Flickering  454, 1215
    Float bit depth  52, 157, 184
    Float space  52
    Floor values for audio  1142
    Flop filter  899
    Folders
    adding in File Browser  113
    adding to Library  122
    creating  201, 405
deleting  113, 407
display preferences  138
    moving behaviors to other folders  407
    opening  201
    renaming  113
    Font Browser  576
    Fonts
    about  576
    applying  133, 578
    browsing  579
categories  121
collections  586
families  573, 586
filtering  586
Library categories  230
Library features  115
LiveFonts  121, 146, 233, 681, 682, 683
LiveType  576, 681
    missing  233
    OpenType  576
    PostScript  576
    previewing  576
    themes and  119
    TrueType  576
    Type1  576
typefaces  573
    video and  1215
    Fonts icon  36
    Format pane  584
    Formatting
        text  585
        Formatting text  133
        Forward button  111, 118, 200
Four Corner mode
particle systems and 705
rasterization and 288
replicators and 777
Four Corner parameter 282
Frame blending 51, 157
Frame Blending pop-up menu 313
Frame numbers 66
Frame Offset parameter 456
Frame parameter 1107
Frame Range slider 454
Frame rates
displaying in Canvas 41
DVCPRO HD 1210
export settings 157
high definition video 1207
imported media 227
in presets 154
particles and 694
preferences 144
RAM Preview and 59
setting 186
Frame size
changing 197
imported graphics and 1213, 1215
media files 76
Frames
as shape outlines 1048
counting time 66
current frame information 90
displaying in rulers 92
exporting 316
image masks and 1107
moving forward and backward 65
moving playhead to 90
numbers 66
rasterization frames 709
regions of 359
replicator cells and 814
Freehand Mask tool 33, 1006, 1087
Freeze frames 315, 1137
Frequency (audio) 1142
Frequency parameter 800
Frequency setting for particle emission 722
Frequency slider 448, 451, 475
Friction 464
Front camera view 170
Full resolution 43
Full Screen mode 29
Full screen output 151
Full View area 49
Fun House filter 899
Function keys 17

G
Gamma filter 881
Garbage masks 1109
Gaussian blur filter 862
General Preference pane 137
General tab 184
Generate Keyframes dialog 553
Generating keyframes 552
Generators 965
about 965
adding 966
animating 987
applying behaviors to 990
as particle cell sources 993
categories 120
Caustics 968
Cellular 969
Checkerboard 969
Clouds 970
Color Solid 971
common parameters 967
duration of 965
editing 983
Gradient 972
Grid 972
Image Units category 229
Inspector features 134
Lens Flare 973
Library list of 229
Membrane 975
modifying 983
Noise 976
One Color Ray 976
Op Art 977
saving 988
sharing 990
Soft Gradient 979
Star 980
Stripes 981
Swirly 982
Two Color Ray 983
types of 967
Geometric particles 719
Geometric replicator shapes 789, 801
Geometry
for motion path shapes 417
Inspector controls 279
shape controls 1059
shapes 133
text paths 639, 642
Geometry parameter 416
Gestures 1231–1238
basic usage 1234
configuring 1231
disabling gesture sound 1233
general commands 1237
in the Timeline 1238
in-the-air gestures 158, 1232
modifier keys 1234
navigating with 1235
playback controls 1234
preferences 158, 1231
triggers 158
Glass Block filter 900
Glass Distortion filter 901
Global 3D rendering 725
Gloom filter 917
Glow
adding to text 133
adding to text objects 618
default text glow 619
editing on text objects 619
Glow filter 917
Glow filters 913–920
  Aura 914
  Bloom 915
  Dazzle 916
  Gloom 917
  Glow 917
  Light Rays 918
  Outer Glow 919
  Overdrive 920
Go to end of project button 58
Go to start of project button 58
Go To submenu commands 164
Gradient Blur filter 863
Gradient Colorize filter 882
Gradient editor 1033
  adding colors 600
  adding opacity tags 601
  changing color opacity 601, 1038
  changing color spread 600, 1036
  changing colors 598, 1035
  color tags 1037
  defined 127
  distributing gradient tags 603, 1038
  duplicating colors 601
  moving colors 599, 1036
  opacity tags 1037
  removing color tags 1037
  removing colors 601
  reversing gradient direction 602, 1038
  text objects and 596
Gradient generator 972
Gradient tags 1038
Gradients
  applying parameter behaviors to 605
  as theme elements 118
  blur 597
  categories 120
  color spread 600
  color tags 600
  custom Library icons 604, 1040
  direction of 602
distributing tags 603
Gradient editor 1033
Gradient generator 972
Library category 230
onscreen controls 1040
opacity 597, 1038
opacity tags 1037
paint strokes 1050
particle cells 734
particle colors 729
replicator colors 813
saving to Library 603, 1039
shape fills 1009, 1032
Soft Gradient generator 979
text objects 593
Graphics
  broadcast video and 1215
  computer vs. video 1215
distorted 1213–1214
  filters 841
  high definition video projects and 1216
  high resolution 1215
  line art 1215
  pixels and 1213–1214
  size 711
video output and 1213, 1214
  See also Images, Motion graphics, Still images
Graphics cards 179
Graphics tablets 158, 998, 1013
Gravity behavior 469, 487–490
Grayscale images 185
Grid generator 972
Grids
  3D grids 48, 150
  Canvas 45, 147
effective use of 266
  Grid generator 972
Groups
  3D groups 69
  adding and removing 71, 326, 340
  applying Library elements to 117
  as theme elements 118
  behaviors and 238, 379
  blend modes and 291
collapsing and uncollapsing 247, 339
  creating 90, 240
  creating new layers 337
defined 18
deleting items in 340
displaying or hiding 87, 242
empty 240
filters and 238
fixed size 244
flattened 18

grouping objects 74, 241
Inspector features 132
isolating 74
layer order and 259
Layers tab and 239
locking 246
masking 1087
moving entire 352
moving in tracks 352
moving objects to other groups 338
moving single objects in 352
nested 234, 241, 339
organizing 233, 1060
parameters 280
preferences 149
rasterization and 288, 626, 707, 1115
rasterization indicator 130
rearranging objects in 338
renaming 247
saving in Library 123
searching for 248
slipping objects in tracks 356
Timeline display 323
tracks and 91, 340, 355
transforming 263, 264
trimming 355
turning effects on or off 73, 87
ungrouping 340
Grow/Shrink behavior 410–411, 487
Guides
Canvas 45, 53, 147
changing color of 54
Dynamic Guides 266, 1017
removing from Canvas 53
Guides submenu command 173

H
Half Range checkbox 443
Halftone filter 938
Handles
3D rotation handles 56
displaying in Canvas 45
scale handles 56
tangent handles 1024
turning on or off 1019
Handwriting Recognition 158, 1232
Hard Light blend mode 302
Hard Mix blend mode 305
Hardware requirements 179
Hatched Screen filter 939
HD video
data rates 1209
dvcpro hd formats 1209
formats 1207–1208
frame rates 1207
graphics in 1216
resolution 181
shooting 1208
specifications 1207
HDCAM format 1208
Heads-Up Displays. See HUDs
Height slider 469
Help
onscreen Help 9
supplemental documentation 10
websites 10
Help menu 176, 1177
Hidden objects 262
Hidden tools 29
Hiding
audio tracks 1127
behaviors 87
B-Spline frames 1059
columns in Media tab 77
filters 87
group tracks 91
groups 87, 242
items in Layers tab 68
keyframes 87, 88
layers 87, 242
masks 87, 1088
objects in Layers list 72
portions of particle systems 705
tabbed windows 26
Timeline items 328
Toolbar 38
tracks in Timeline 325
High definition video. See HD video
Highpass filter 940
High-resolution images 205
Hold end condition 315, 1137
Hold Frame behavior 454
Hold Frame parameter 1107
Hold frames 1137
Holdout masks 1110
Holes in objects 1062, 1094, 1098, 1107
HSV Adjust filter 883
HSV color components 40
HUDs 135–136
about 16
compositing and 258
cycling through 389
displaying 136, 388
filter features 847
icons 35
keyboard shortcuts 1187
keyframing with 505, 511
preferences 140
switching between HUDs 136
switching to Inspector 136

Icon view 114, 123, 200
Icon View button 112, 118
Icons
3D scene 48
Timeline display 330
ID parameter 438
Image masks 1104
about 1104
adding 75, 1105
applying behaviors to 1108
applying filters to 1108
blend modes 1107
channels 1105
parameters 1106–1108
text as 613
wrap mode 1107
Image particles 719
Image sequences
about 208
as media files 75
collapsing 201, 209
export presets 1151
exporting 156, 1148, 1149
exporting selections as 316
importing 77, 115, 1221
padding 209
replicator cells and 814
themes and 119
Image Source parameter 791
Image Source well 792
Image units 120
Image Units category 229
Image wells 127, 607
Images
adding to blur maps 860
as media files 75
as replicator sources 791
as shape outlines 1047
blend modes and 290
creating for particle systems 711
down-res to Canvas size 207
duration of 208
filters and 841
high-resolution 205
in outlines 1044
Inspector features 132
particle display options 732
particle emitters 723
pixels and 1213–1214
replicators and 789
scaling to Canvas size 206
size 711
supported file formats 1204
themes and 119
Importing
audio files 82, 83, 213, 1118
Embed Motion Content option 1221
field dominance and 1212
file types supported 203
Final Cut Pro clips into Motion 1219
high resolution graphics 1215
image sequences 1221
large images 121
media files 77, 79, 111
merged layers 217
Motion projects into After Effects 1241
Motion projects into Final Cut Pro 1218
QuickTime files 1212, 1222
retained properties 1222
templates 1223
In and Out points
audio 1136
changing 344
defining 359
In Point command 342
setting for text behaviors 652
See also Play ranges
In Use status 76
Increment pop-up menu 411, 427, 430
Indent filter 941
Inertial, behaviors and 396
Ink preferences 158, 1231, 1232
Insect Eye filter 902
Insert edits 332, 334, 347
Insert mode 331
Insertion points 588
Inset view
features 46
preferences 149
turning on or off 174
Inspector 20, 125–134
Activation checkboxes 127
Add Keyframe command 130
adding keyframes in 518
Animation menu 129, 517
behaviors in 389
Behaviors tab 131
color wells 127
combined behaviors and keyframes in 401
controls in 125
deleting keyframes in 130, 519
dials 126
editing text in 584
enabling or disabling animation 130
Filters tab 131
gradient controls in 279
gradient editor 127
icon 35
image wells 127
keyboard shortcuts 1188
keyframing 505, 516–520
locking 134
navigating to keyframes 130, 519
Object tab 131
parameter selection menu 128
pop-up menus 126
Properties tab 131
Rasterization indicators 130
Reset button 128, 520
resetting parameters 130, 519
Show In Keyframe Editor command 130
sliders 126
Timing controls 313
Tracking Selection pop-up menu 128
value fields 126
value lists 127
value sliders 126
Interface icons 35
Interface preference 138
Interlaced video 1212
defined 152
field order and 186, 1212
Interleaving particles 724
Interpolation
3D rotation channels 807
Bezier 547, 549
changing for gradients 1037
Constant 547
Continuous 547, 1143
defined 96, 503
Ease In 548
Ease Out 548
Exponential 548
gradients 596, 1034
Linear 547
Logarithmic 548
methods of 547
parameters 281
particle cells and 734
setting 546
types of 99
Intersect mode (masks) 1095, 1098, 1108
In-the-air gestures 158
Invert Axis checkbox 425, 460
Invert filter 885
Invert Mask checkbox 1095, 1108
Inverted alpha 44
iPhoto 198, 218
iPods 218, 1119, 1164
Isolate button 69, 73, 86
Isolating
groups 631, 781
layers 631, 781, 1091
objects 74, 86
particle emitters and 725
iTunes
adding audio from 1120
content from 121
importing from 198
importing songs from the Library 218
Music category 213
rights management and 1205
J
Jitter 1015, 1056
Joints in shapes 1046
JPEG format 204, 1212
JPEG-2 format 204
Jumping to start or end of projects 105, 358
Justified text 133, 630
K
Kaleidoscope filter 953
Kaleidotile filter 954
Kerning text 133, 588
Keyboard notes 437
Keyboard shortcuts 1167–1195
3D commands 1195
application 1167
Audio Editor 1177
Audio tab 1178
Canvas 1178–1180
Command Editor 1196
Edit menu 1170
File Browser 1187
File menu commands 1169
general 17, 1167
Help menu 1177
HUDs 1187
Inspector 1188
Keyframe Editor 1188
keyframing 1193
layers 1189
Library 1190
Mark menu 1171
masks 1193
Media tab 1190
Motion menu 1169
Object menu 1173
project controls 1169
shapes 1193
Timeline 1191
Toolbar 1194
transport controls 1184
View menu 1174
Window menu 1176
Keyframe Editor 22, 95–103, 526–555
about 526
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>adding keyframes</td>
<td>540</td>
</tr>
<tr>
<td>animated shapes in</td>
<td>1082</td>
</tr>
<tr>
<td>Animation menu</td>
<td>529</td>
</tr>
<tr>
<td>audio in</td>
<td>101, 554, 1118</td>
</tr>
<tr>
<td>auto-scaling</td>
<td>102, 555</td>
</tr>
<tr>
<td>behaviors in</td>
<td>100, 377</td>
</tr>
<tr>
<td>Box tool</td>
<td>528, 529, 544</td>
</tr>
<tr>
<td>Clear Curve List button</td>
<td>101</td>
</tr>
<tr>
<td>combining keyframes with behaviors</td>
<td>400</td>
</tr>
<tr>
<td>control buttons</td>
<td>101, 553–555</td>
</tr>
<tr>
<td>control points in</td>
<td>538</td>
</tr>
<tr>
<td>Current Keyframe state</td>
<td>100</td>
</tr>
<tr>
<td>curves in</td>
<td>101, 545, 553, 554, 555</td>
</tr>
<tr>
<td>custom parameter sets</td>
<td>533–536</td>
</tr>
<tr>
<td>deleting keyframes</td>
<td>540</td>
</tr>
<tr>
<td>disabling keyframes</td>
<td>541</td>
</tr>
<tr>
<td>displaying</td>
<td>95, 524, 528</td>
</tr>
<tr>
<td>extrapolation methods</td>
<td>550, 551</td>
</tr>
<tr>
<td>filtering</td>
<td>531</td>
</tr>
<tr>
<td>generating keyframes</td>
<td>552</td>
</tr>
<tr>
<td>interpolation methods</td>
<td>546, 547</td>
</tr>
<tr>
<td>keyboard shortcuts</td>
<td>1188</td>
</tr>
<tr>
<td>keyframe graph</td>
<td>102, 108, 506</td>
</tr>
<tr>
<td>Keyframing Active state</td>
<td>100</td>
</tr>
<tr>
<td>locking keyframes</td>
<td>541</td>
</tr>
<tr>
<td>mask keyframes in</td>
<td>1104</td>
</tr>
<tr>
<td>mini-curve editor</td>
<td>555</td>
</tr>
<tr>
<td>No keyframes state</td>
<td>100</td>
</tr>
<tr>
<td>parameter list</td>
<td>96, 529, 531</td>
</tr>
<tr>
<td>particle curves and</td>
<td>713</td>
</tr>
<tr>
<td>parts of</td>
<td>528</td>
</tr>
<tr>
<td>preferences</td>
<td>139</td>
</tr>
<tr>
<td>selection in</td>
<td>527</td>
</tr>
<tr>
<td>Sketch tool</td>
<td>528, 543</td>
</tr>
<tr>
<td>snapping</td>
<td>101, 553</td>
</tr>
<tr>
<td>Take/Show Curve Snapshots setting</td>
<td>102</td>
</tr>
<tr>
<td>tools 100, 528</td>
<td></td>
</tr>
<tr>
<td>zooming in</td>
<td>103</td>
</tr>
<tr>
<td>Keyframe Editor icon</td>
<td>37</td>
</tr>
<tr>
<td>Keyframe graph</td>
<td>102, 108</td>
</tr>
<tr>
<td>Keyframes</td>
<td>503–563</td>
</tr>
<tr>
<td>about 96</td>
<td></td>
</tr>
<tr>
<td>adding 98, 107, 511, 518, 540</td>
<td></td>
</tr>
<tr>
<td>aligning to elements</td>
<td>522</td>
</tr>
<tr>
<td>aligning to markers</td>
<td>523, 524</td>
</tr>
<tr>
<td>animating text parameters</td>
<td>679</td>
</tr>
<tr>
<td>at start and end of curves</td>
<td>512</td>
</tr>
<tr>
<td>audio tracks</td>
<td>107</td>
</tr>
<tr>
<td>combining with behaviors</td>
<td>398–402, 515</td>
</tr>
<tr>
<td>compared to behaviors</td>
<td>372</td>
</tr>
<tr>
<td>converting behaviors to</td>
<td>402, 404</td>
</tr>
<tr>
<td>converting to Bezier</td>
<td>511, 549</td>
</tr>
<tr>
<td>copying and pasting</td>
<td>541</td>
</tr>
<tr>
<td>curve snapshots and</td>
<td>99</td>
</tr>
<tr>
<td>defined 95</td>
<td></td>
</tr>
<tr>
<td>deleting 98, 107, 349, 518, 524, 540</td>
<td></td>
</tr>
<tr>
<td>disabling</td>
<td>541</td>
</tr>
<tr>
<td>displaying or hiding</td>
<td>87, 88, 328, 520</td>
</tr>
<tr>
<td>editing</td>
<td>100, 102, 348, 538</td>
</tr>
<tr>
<td>extrapolation</td>
<td>550</td>
</tr>
<tr>
<td>finding values of</td>
<td>521</td>
</tr>
<tr>
<td>generating</td>
<td>552</td>
</tr>
<tr>
<td>graph 108</td>
<td></td>
</tr>
<tr>
<td>guidelines</td>
<td>1103</td>
</tr>
<tr>
<td>interpolation methods</td>
<td>546, 547</td>
</tr>
<tr>
<td>locking</td>
<td>541</td>
</tr>
<tr>
<td>mini-curve editor</td>
<td>557</td>
</tr>
<tr>
<td>modifying curves</td>
<td>545, 553, 555</td>
</tr>
<tr>
<td>moving</td>
<td>349</td>
</tr>
<tr>
<td>moving playhead to</td>
<td>99, 107, 358, 518</td>
</tr>
<tr>
<td>parameter behaviors</td>
<td>736</td>
</tr>
<tr>
<td>parameters and 372</td>
<td></td>
</tr>
<tr>
<td>particle systems and</td>
<td>736</td>
</tr>
<tr>
<td>recording options</td>
<td>560</td>
</tr>
<tr>
<td>rotoscopying example</td>
<td>1103</td>
</tr>
<tr>
<td>shortcut for adding</td>
<td>518</td>
</tr>
<tr>
<td>status icons for</td>
<td>100</td>
</tr>
<tr>
<td>template-based projects</td>
<td>252</td>
</tr>
<tr>
<td>text and 680</td>
<td></td>
</tr>
<tr>
<td>text parameters</td>
<td>679</td>
</tr>
<tr>
<td>thinning or reducing</td>
<td>99, 531, 559, 561</td>
</tr>
<tr>
<td>Timeline display</td>
<td>323</td>
</tr>
<tr>
<td>transforming</td>
<td>545</td>
</tr>
<tr>
<td>Keyframing</td>
<td>about 503–506</td>
</tr>
<tr>
<td>aligning keyframes with other elements</td>
<td>522</td>
</tr>
<tr>
<td>animating on the fly</td>
<td>557</td>
</tr>
<tr>
<td>animation curves and</td>
<td>504</td>
</tr>
<tr>
<td>Animation menu and</td>
<td>517</td>
</tr>
<tr>
<td>animation paths</td>
<td>511</td>
</tr>
<tr>
<td>audio tracks</td>
<td>1134</td>
</tr>
<tr>
<td>basic techniques</td>
<td>506</td>
</tr>
<tr>
<td>behaviors 403, 514</td>
<td></td>
</tr>
<tr>
<td>Canvas and 506</td>
<td></td>
</tr>
<tr>
<td>editing keyframes</td>
<td>521</td>
</tr>
<tr>
<td>extrapolation methods</td>
<td>551</td>
</tr>
<tr>
<td>filters 513, 848</td>
<td></td>
</tr>
<tr>
<td>HUDs and 511</td>
<td></td>
</tr>
<tr>
<td>Inspector and 516–520</td>
<td></td>
</tr>
<tr>
<td>keyboard shortcuts</td>
<td>1193</td>
</tr>
<tr>
<td>Keyframe Editor and</td>
<td>526–555</td>
</tr>
<tr>
<td>masks 1101</td>
<td></td>
</tr>
<tr>
<td>moving keyframes in time</td>
<td>521</td>
</tr>
<tr>
<td>navigating to keyframes</td>
<td>519</td>
</tr>
<tr>
<td>position 509</td>
<td></td>
</tr>
<tr>
<td>replicator elements</td>
<td>815</td>
</tr>
<tr>
<td>resetting parameters</td>
<td>519</td>
</tr>
<tr>
<td>scaling objects over time</td>
<td>507</td>
</tr>
<tr>
<td>shape control points</td>
<td>1080</td>
</tr>
<tr>
<td>shapes 1080</td>
<td></td>
</tr>
<tr>
<td>thinning 531</td>
<td></td>
</tr>
<tr>
<td>Throw behavior and</td>
<td>429</td>
</tr>
</tbody>
</table>
Timeline and trimming keyframed effects 520–526
Keyframing Active state 100
Keying defined 15
segmenting objects into zones 1112
using multiple keys 1112
Keying filters 920–927
alpha channels and 1112
Blue Green Screen 921
Color Key 922
garbage masks and 1109
holdout masks and 1110
Luma Key 923
masks and 1108
multiple keys 1112
Primatte RT 924
Spill Suppressor 926

Layers
Latitude parameter 428, 725
Laws of inertia 396
Layer order in compositing 130
Layer Order parameter 132
Layer tracks 352, 356
Layered Photoshop files 209, 217
Layers activating 74
adding objects to existing 336
applying Library elements to 117
as theme elements 118
behaviors and 379
blend modes and 74, 287
cloning 75, 283
collapsed 339
creating 337
defined 18
deleting 90, 340
displaying 68, 87, 242
displaying active 318
displaying all 317
duration 568
editing 351
exchanging media 223
filters and 845
grouping 339
groups and layer order 259
hiding 87, 242
image masks and 1104, 1105
isolating 74, 86, 1091
keyboard shortcuts 1189
locking 246
masks and 999, 1087, 1090
moving groups 241
moving objects to other layers 338
nested 241, 339
organizing 233, 1060
particle cells and 687
particle systems and 689
preferences 143
rearranging objects on 259, 338
rearranging tracks 337
replacing objects on 337
replicating 755
saving in Library 123
searching for 248
segmenting objects into keying zones 1112
soloing 74, 243
sorting in Media tab 249
temporary 224
text as 571
textures and 612
Timeline display 85, 323
transforming in Canvas 261
turning effects on or off 73, 87
ungrouping 340
Layers icon 36
Layers list (Timeline) 324, 336
Layers tab 22, 68–75
adding groups 71
additional columns 70
behaviors in 72, 73
Blend Mode column 70
cutting, copying, and pasting options 74
displaying 68
effects in 72
filtering Layers list 72
filters in 73
grouping and ungrouping options 74
masks in 72, 73
Name column 69
Opacity column 70
Preview column 69, 70
removing layers 72
reorganizing objects in 240
Search field 72
selecting objects in 239
Status column 70
turning effects on or off 73
Layout options (text) 133
Layout pane 584
Layouts 23
Alternate 24
Cinema 24
custom 27
deleting 28
duplicating 28
preset 23
renaming 28
saving 27
Standard 23
switching to 28
Layouts submenu command 175
Leading 133
Learning mode 438, 439
Left camera view 170
Lengthening objects 63
Lens Flare filter 973
Level meters 108
Levels
  Audio Editor 106
  for audio tracks 1128
  keyframing 1134
Levels filter 885
Library 20, 115–124
  adding content to 232
  adding elements to projects 116
  Back button 118
  behaviors in 120, 373, 405–407
  content types 120
  curves in 536
  custom particle effects in 750
  customized items in 125, 232, 406, 626
deleting folders 407
  effects in 117, 122
  Favorites in 121, 122, 124
  file stack 122
  filters in 120, 842
  folders in 122
  font browser 579
  fonts and 121
  Forward button 118
  generators in 120, 988
  gradients in 120, 594, 1039, 1040
  icon 35
  icon display 123
  icon view 118, 123
  image units 120
  keyboard shortcuts 1190
  list view 118, 123
  LiveFonts in 121
  media files in 228
  music in 121
  particle emitters in 120, 690
  Path pop-up menu 118
  photos in 121
  playing previews 116
  preferences 138
  presets 128
  replicators in 120, 759, 839
  saving multiple items in 124
  Search field 119
  shape styles in 121
  shapes in 120
  sidebar 118
  subcategories 232
template and preset contents 121
text styles in 121, 625, 626
third-party filters 120
Life
colors of particles and 734
  emitters 727
  particle scaling and spinning behaviors 738
  randomness 727
  shape animation and 1058
Life parameter 698
Light Rays filter 918
Lighten blend mode 298
Lighting 777
  adding 165
  Canvas settings 49
  export settings 157
  Inspector features 132
  parameters 131
  particle emitters and 704
  particle parameters 704
  saving lights in Library 123
  Timeline display 323
  turning on or off 49
Line Art filter 942
Line particles 716
Line Screen filter 943
Line spacing 574
Line spacing (text) 133, 630
Line tool 32, 1010
Linear Burn blend mode 297
Linear color distribution 1034
Linear Dodge blend mode 300
Linear extrapolation 551
Linear gradients 1034
Linear interpolation 547, 597
Linear Light blend mode 304
Linear masks 1092
Linear shapes 1059
Lines
displaying in Canvas 45
  drawing 1007, 1010
  linear shapes 1059
  particle display options 732
  replicator elements 786, 799
Link icon 70, 1123
Link parameter 448, 452
Linked audio and video 327
Linked objects 220, 227
Links
  exchanging media 223
  tangent handles 1025
  unlinking audio and video 327
List view 114, 123, 200
List View button 112, 118
LiveFonts 121
about 681
Index

applying to text objects 682
Library category 230, 567
missing 233
modifying 683
preferences 146
previewing 681
themes and 119
Timing parameters 683
LiveType fonts 576, 681
Local 3D rendering 725
Location parameter 600, 1036
Locking
audio files 81
audio tracks 1129
behaviors 389
control points 1023
filters 851
groups 246
Inspector settings 134
keyframes 541
layers 246
objects 70
parameters 99
shapes 1061
tracks 326
Logarithmic behavior 436
Logarithmic interpolation 548
Longitude (emission) 725
Longitude parameter 428
Loop behavior 454
Loop Duration slider 455, 456
Loop end condition 314, 1137
Looping
audio 144, 1138
clips 350
drawing shape outlines with frames 1048
Loop behavior 454
particle systems and 712
playback 58
replicator elements 827
text sequence behaviors 660
Loops parameter 419
Lossless codecs 1210
Luma Key filter 923
Luminance channels 1105

M
Magnifying view. See Zooming
Make Particles icon 34, 693
Manage Curve Sets dialog 535
Manage Layouts dialog 28
Map Animation parameter 662
Margins
adjusting 581, 647
creating and modifying 646
drawing 580
for text 580, 646
Mark menu 163, 1171
Markers 367
about 362
adding 362, 363
aligning keyframes to 523, 524
audio tracks 1138
deleting 364
editing 365
moving 364
navigating 366
project 92
types of 363
Markers submenu commands 163
Mask Blend mode 1092, 1096, 1097, 1107
Mask icon 73
Mask Source parameter 1106
Mask tools 33
Masks
3D groups and 1088
3D projects and 1090
about 1087
alpha channels and 1087, 1097, 1098, 1112
animation and 1101
applying behaviors to 1101
applying filters to 1100
Bezier masks 1000, 1023
blend modes 1092, 1096, 1097
B-Splines 999, 1002, 1025
closing 1089
combining 1096
compared to shapes 998
control points 279, 1018, 1020, 1023, 1025, 1095
defined 15, 997
displaying 68, 328
drawing and editing 999, 1017, 1088
drawing tools 1087, 1089
editing in Keyframe Editor 1104
feathering 1006, 1095, 1099
finishing 1001, 1004
Freehand Mask tool 1006
garbage masks 1109
handles on 1019
holdout masks 1110
holes in shapes 1062
image masks 75, 1104
Inspector features 133
interlocking 1098
isolating layers for 1091
keyboard shortcuts 1182, 1193
keyframing 1101
keying filters and 1108
locking control points 1023
motion blur 1101
moving control points 1020
multiple keys and 1112
order of 1097
parameters 1092–1095
particle systems and 705
rasterization and 288, 1115
replacing alpha channels 1098
replicators and 782
rotooscoping and 1101, 1102
segmenting objects into zones 1112
selecting control points 1019
shape types 1092
snapping and 1017
tangent handles 1024
text as 613
Timeline display 323
transforming 1104
turning on or off 73, 87
Masks icon 1088
Master templates 1223, 1227
Master track 1130
Matte Choker filter 927, 1114
Matte filters 927–928
Matte Choker 927
Matte Magic 927
Matte Magic filter 927
Max slider 433
Media files
adding to projects 77, 213–217, 219
audio and video rates 76
audio. See Audio and audio files
bit depth 76
browsing 198, 202
collecting 192
compression 76
consolidating 254
cutting, copying, and pasting options 78
deleting 72, 77, 79, 112, 113
duplicating 219
duration 76
exchanging 223
File Browser 110
file formats 1203–1216
file size and date information 76
finding 112, 202
frame size 76
importing 77, 79
In Use status 76
Inspector features 132
Library features 228
linked to objects 214
missing 79
on remote sources 203
online and offline 220, 233
opening 78, 112
organizing 113
preferences 139
previewing 75, 110, 203
properties 225
reconnecting 78, 221
revealing location in Finder 78
revealing source media 75, 220, 248
selecting in File Browser 214
types of 75, 76, 203
unused 79, 196
Media icon 36
Media tab 22
adding and removing files 77
additional features 78
displaying 75
filtering lists 78
hiding and displaying columns 77
keyboard shortcuts 1190
object parameters 225
parameters 225
Reconnect Media command 78
Reveal in Finder feature 78
revealing source objects 248
sorting objects and layers 249
Media tab (Project pane) 75–80
Membrane generator 975
Memory preferences 144
Menus 158–177
Application menu 159
Edit menu 161, 1170
Favorites menu 169
File menu 160, 1169
Help menu 176, 1177
Mark menu 163, 1171
Motion menu 1169
Object menu 165, 1173
View menu 169, 1174
Window menu 174, 1176
Merged layers 217
MIDI behavior 437–439
Learning mode 439
rotation and 439
Min slider 433
Mini-curve editor
about 555
Auto Fit in 557
expanding 556
Minimizing windows 25
Mini-Timeline 21
adding multiple objects to 62
adding objects to 62
changing length 63
dediting in 61
moving objects in time 62
overview 61
slipping objects 63
MinMax filter 944
Mirror filter 902
Index

Mirroring image masks 1107
Missing media files 79
Missing objects 233
Mix parameter 862
Mix To Stereo command 1122
Mixing
audio export 156, 1129
Matte Choker filter effects and particles 724
M-JPEG codec 1211
Modification dates 76
Modified curves 97
Modifying behaviors 387–389
.molo extension 408
Monitors
standard definition (SD) 1214
video output on 151, 152
Monospaced text 589
Motion
onscreen Help 9
opening clips in 1218
supplemental documentation 10
template files 1223
websites 10
workspaces in 19–29
Motion blur 51
After Effects 1242
export settings 157
masks and 1101
particle systems and 692
setting 187
Motion graphics
compositing 257
design tools 14
overview 14
timing tools 15
Motion menu 1169
Motion Path behavior 411–422, 486
3D space and 420
gemetric sources 417
persistent parameters 418
Motion paths, handmade 559
Motion Tracking behaviors 370, 452
Motion-blur blending 313
Mouse devices 17
Move behavior 422–423
Move to Trash command 112
Movement Blur filter 864
Movies
as media files 75
multi-track QuickTime 1121
themes and 119
See also QuickTime
Moving
animating objects 509
audio/video track divider 89
behaviors in Library folders 407
behaviors in Timeline 397
behaviors to other computers 408
behaviors to other objects 391
Canvas 26
colors in gradients 1036
columns of data 250
control points on shapes 1020
drop shadows 312
entire groups 352
files into folders 113
filters 851, 852
keyframes 349, 521
markers 364
masks 1104
move edits 342
objects 352
objects in Canvas 267
objects in mini-Timeline 62
objects to front or back 260
objects up or down in layers 240
overlapping objects 353
particle emitters 703
playhead 65, 90, 99, 106, 107, 357
presets to other computers 190
Project pane 26
projects to other computers 195
regions 360
rulers 53
shapes 1018
shortcuts for 353
through frames 65, 358
to specific keyframes 358
to specific points in Timeline 357
to start or end of projects 358
windows 25
MP3 files 1118
Multi-channel audio files 1118, 1121, 1129
Multi-layered PDF files 212
Multiple selections 340
Multiplicative behaviors 409
Multiply blend mode 296
Multi-track QuickTime 1118, 1121, 1123, 1129
Music 121, 230
Mute Audio button 58
Mute button 1128
Muting audio 81, 83, 1128
N
Names
audio files 81
displaying in Layers tab 69
media files 75
**Index**

- objects in new templates  253
- presets  154
- Navigating
  - file paths  202
  - gestures and 1235
  - in Timeline  357
  - keyboard shortcuts  1184, 1191
  - through frames  65, 358, 528
  - to keyframes  519
  - to markers  366
  - to start or end of projects  358
- Negate behavior  439
- Negative filter  886
- Nested behaviors  393
- Nested groups  18, 234, 241, 247, 339, 340
- Nested layers  241, 247, 339
- Nested objects  234
- Networked disks  203
- New Camera icon  34
- New Light icon  36
- Next camera view  170
- Next frame button  58
- Next Keyframe command  107, 130
- No Keyframes state  100
- Noise Dissolve filter  945
- Noise generator  976
- Noisiness parameter  448
- Noisiness slider  451, 475
- Nondestructive editing  214
- Nonsquare pixels  1213–1214
- Normal blend mode  292, 294
- Note mode  437
- Notes in marker comments  365
- NTSC video  1206
  - aspect ratio and 1213
  - DV vs. analog 1206
  - output 152
  - resolution 181
  - standard definition DV video and 1206
- Number of Arms parameter  785, 787, 801

**O**

- Object blend modes  294
- Object markers  363
- Object menu commands  165, 259, 1173
- Object parameter  424
- Object tab (Inspector)  131
- Object wells
  - attract behaviors  461
  - dragging items into  459
  - drift behaviors and  465
  - orbiting behaviors and  471
  - repel behaviors and  478
- Objects
  - 3D axis handles  56
  - 3D transforms  56
  - 3D view  56
  - adding to layers  336
  - adding to mini-Timeline  62
  - adding to Timeline  331
  - aligning  268
  - anchor points  273
  - applying Library elements to  117
  - arranging  259
  - as cell sources  687, 688
  - blend modes and  294
  - bounding boxes  267
  - cloning  268, 283
  - compositing  257
  - control points  279
  - copying to different layer  241
  - corner-pinning  277
  - cropping  278
  - cutting  346
  - deleting  223, 345
  - distributing  268
  - drop shadows  276
  - dropping into collapsed layers  339
  - exchanging  251
  - geometry controls  279
  - grouping and ungrouping  241
  - hidden  262
  - holes in  1094
  - in tracks  91
  - isolating  74
  - length of  63
  - linked  214, 220
  - locations of  124
  - managing in project  219–222
  - markers  363
  - Media tab and  219
  - moving  62, 352
  - moving to other layers  241, 338
  - moving to playhead  342
  - naming  253, 324
  - offline  214
  - organizing  233
  - parameter behaviors and  382
  - parameters  225, 280
  - restoring after transformations  57
  - rotating  56, 272
  - saving in Library  123
  - scaling  270
  - segmenting into keying zones  1112
  - selecting  239, 261
  - shearing  275
  - shortcuts for moving  353
  - sorting in Media tab  249
  - status of  70
  - transforming  56, 261, 263
Index

Index 1271
types of 131
viewing relationships between 220
Offline media 214, 220, 233
Offset
image masks 1107
Parameter behaviors 397
particle emissions 721
replicator images and 793
replicator shapes 802
shape outlines 1045
text 589
text on paths 641
Offset filter 955
Offset From parameter 456
Offset slider 415, 446, 454
One Color Ray generator 976
Op Art generators 977
Opacity
about 285
animating 512
backgrounds 186
blend modes and 285, 290
colors 1037
direction of 602
displaying object status 70
gradients 597, 601, 1034, 1038
MIDI behavior and 438
opacity tags 601, 1037
paint strokes 1015, 1050
parameters 98, 282
particle cells 734
premultiply alpha settings 157
preserving opacity 289
rasterization and 288
replicators and 769, 813
shapes 1033, 1044, 1062
text objects 572, 614
Wriggle behavior and 452
Opacity parameters 98, 533, 823
Opacity tags 601
Open In QuickTime Player command 112
Open in Viewer command 112
Open shapes
closing 1059
control points and 1021
created from closed shapes 1022
Open Spline parameter 414
OpenEXR format 186
Opening
folders 201
media files 78, 112
Motion clips in Final Cut Pro 1218
projects 194
QuickTime Player 78
recent projects 194
Soundtrack Pro 83
Viewer 78
OpenType fonts 576
Optical flow blending 313
Optical Flow Retiming preferences 146
Orbit Around behavior 396, 470–474, 490–492
Orbit tool 55
Order pop-up menu 1045
Organizing
effects 122
files 113
groups 233
layers 233
projects 191
Orientation 281, 589
Origin parameter 791, 796
Orthogonal views 47
Oscillate behavior 440–443, 495–499
Oscillate Shape behavior 1067
Oscillation, decaying 444
Out Point command 342
Out points
changing 344
defining 359
See also Play ranges
Outer Glow filter 919
Outlined text 133
Outlines
default 617
particle emitters 720
shape controls 1043
shapes 133, 1008, 1031
start and end caps 1046
text objects 616, 617
using as paint strokes 1027
Output
audio 81, 1129
export settings 1155
preferences 150
Overdrive filter 920
Overlapping objects
editing 354
moving 353
Overlay blend mode 301
Overlay pop-up menu 44
Overlays
3D 46
blend modes 301
Canvas item displays 172
Overlays submenu command 172
Overwrite edits 331, 333, 334, 348
P
Padding in image sequences 209
Paint Stroke tool 32, 1014, 1181
Paint strokes
  3D options 1055
  about 1012
  animating 1054
  brush options 1054
  colors 1049
  compared to shapes or masks 998
  controls 1049
  defined 997
  drawing over time 1013
  gradients 1050
  jitter options 1056
  opacity 1050
  parameters 1015
  shape outlines as 1027
  spacing dabs in 1051
  styles 1013
  width 1053
  Write On behavior 1077, 1078, 1079

PAL video
  aspect ratio and 1213
  output 152
  resolution 181
  specifications 1206
  standard definition DV video and 1206

Pan parameter 81
Pan tool 1180
  3D 46
  about 31
  resetting cameras 55
  resetting in Canvas 43

Panning
  audio 1129, 1134
  in Audio Editor 107
  Master pan slider 1131
  Paragraph Layout method 630
  Parallelogram Tile filter 956
  Parameter behaviors 430–452
  3D animation parameters and 383
  about 370
  applying 380–387, 403
  Audio 431, 1141
  Average 431
  changing assignments 384, 386
  Clamp 432
  Custom 433–435
  displaying in Animation menu 386
  Exponential 435
  generators and 990
  gradients and 605
  icon display 385
  Logarithmic 436
  MIDI 437–439
  Negate 439
  Oscillate 440–443
  Quantize 445
  Ramp 446
  Randomize 447, 605
  Rate 449
  replicators and 820, 835
  Reverse 450
  Start and End Offset 397
  Stop 450
  text and 634, 676
  Track 387, 451
  Wriggle 451
  Parameter Selection menus 128

Parameters
  adding to curves 534
  animating behaviors 402–405
  behaviors and 372, 389
  deleting from curves 535
  displaying 102
  drop shadows 312
  duplicating sets 536
  filters and 847
  geometry controls 280
  image masks 1106–1108
  in Keyframe Editor 400
  keyframes and 96, 372, 736
  lists of 98
  locking or unlocking 99
  masks 1092–1095
  paint strokes 1015
  Parameter behaviors 380–387, 403
  particle cells 725–733, 735, 738
  particle emitters 687, 713, 738
  QuickTime movies 733
  replicators 785
  resetting 107
  shapes 1031
  single-cell emitters 725–733
  template parameters 1223

Particle cells. See Cells (particle)

Particle emitters
  3D emitters 699, 708, 724
  3D shapes 715
  additive blend 728
  advanced controls 712
  angles 702, 727
  animating 736
  as theme elements 118
  behaviors and 737, 738
  birth rate 726
  boxes 720
  bursts 718
  circles 717
  color options 728
  creating 693
  customizing 696
  defined 686
Emitted at Points setting 721
filters and 740
frame rates and 695
gamma 719
HUD parameters for 696–700
images 719
in Library 229, 690
initial numbers 726
Inspector features 133
isolating 725
life 727
lines 716
mixing particles 724
modifying properties 703–710
motion blur and 692
multi-cell master controls 715
multiple cells and 695, 698, 714
numbers of points 721
parameters 687, 713, 720
particle size 721
paths of particles 731
patterns 720
points 716
previewing 116, 691
random seed settings 733
randomness 726
range 723
rasterization and 708
rectangles 717
render order 724
resizing effects 700
scale 730
shape options 715
single-cell emitters 714, 725–733
smoke effects 700–702
speed 702, 727
spheres 720
spin 728
spirals 718
text layers and 568
waves 718
Particle library 690
Particle Source parameter 733
Particle systems 685–751
adding 690
advanced controls 712–735
anatomy of 687
animated backgrounds 741–743
animated pixie dust 744–750
animation in 686, 711–712, 736
applying filters to 740
blending 704
color modes and 734
creating 692
creating graphics for 711–712
customizing emitters 696
defined 15
drop shadows 704
drop shadows animations 704
drop shadows examples 707, 741–750
keyframes and curves 713
layer size and 689
Library categories for 690
modifying 692
predictability of 695
pre-made 690
previewing 691
QuickTime movies and 733
saving to Library 123, 750
setting up 689
sources 733
timing 706
vs. replicators 754
Particles 685–751
additive blend setting 728
angles 727
animated 686
behaviors and 737, 738
birth rate 726
cell source objects 688, 733
color 728
converting paint dabs to 1057
display options 731
distribution of 704
generators as cell sources 993
image display 732
life 727
line display 732
Make Particles icon 34
number generated per second 694
particle emitter categories 120
point display 731
pre-made 690
random seed 733
randomness 726, 727, 728
rasterization 707
rendering 724
scaling 730, 739
speed 727
spinning 728, 739
transform controls 703
wireframe display 732
Particles behaviors 370, 404, 452
Pass Through blend mode 291, 308
Paste Exchange command 347
Paste Insert command 347
Paste Into command 361
Paste Overwrite command 347
Paste Special command 347
Pasting audio tracks 1125
behaviors 391
filters 851
in Timeline 347
into regions 361
keyframes 541
objects in Layers tab 74
Path Layout method 630
Path pop-up menu 111, 112, 118, 200
Path Shape pop-up menu 413
Paths
  creating text on paths 634
  displaying 509
  editing path shapes 639
  editing text on 643
  handmade 559
See also Animation paths
Patterns
  creating from source layers 762
  particle emitters 720
Pause control 58, 105
PDF files
  about 210
  fixing resolution of 211
  mixed content in 211
  multi-layered 212
  multi-page 211
Peak indicators 108, 1143
Pen gestures 1232
Pen pressure
  behavior 1064
  settings 1013
  shape controls and 1058
Pen Pressure parameter 1015
Pen pressure pop-up menu 1013
Pen speed behavior 1065
Pen Speed parameter 1016
Pen tilt behavior 1066
Performance
  bit depth and 185
  field rendering and 50
  filmstrip display and 330
  filters and 844, 845
  float bit depth and 52
  motion blur settings and 51
  render quality settings and 49
Perspective Tile filter 956
Perspective view 47, 170
Phase parameter 800
Phase setting (particle emitters) 722
Phase slider 442
Photos 121, 230
Photoshop files
  adding layered files 217
  exporting for 186
  importing 204
  incompatible effects 210
  layered files 209
PICT format 204
Pin Light blend mode 304
Ping Pong behavior 455
Ping Pong extrapolation 551
Ping Pong parameter 659
Ping Pong replicator animation 827
Ping-Pong end condition 315, 1137
Pixel aspect ratio 186, 226, 1213–1214
Pixel color status 40
Pixellate filter 945
Pixels
  bit depth and 185
  exact positions 40
  graphics creation and 1213
  nonsquare 1213–1214
  square 1213–1214
Pixie dust 744–750
Play Audio button 58
Play ranges
  audio files 106
  behaviors 395
  defining 359
  exporting 1160
  indicators 93
  Parameter behaviors 397
  resetting 359
  retiming and 313
Play/Pause control 58, 105
Playback
  audio controls 105, 1127
  gestures for 1234
  looping 350
  playing projects 357
  preferences 138, 143
  reversing 313
Playhead
  illustrated 61
  in Audio Editor 109
  moving in Timeline 357
  moving objects to 342
  moving to audio file positions 106
  moving to keyframes 99, 107
  moving to new time 90
  moving to specific frames 65
  snapping to project markers 64
Playing projects 58
  from start 58
  rendering 59
Plug-ins 139
PNG format 186
Point At behavior 423–425
Point particles 716
Point size 573
Pointer position in Canvas 40
Pointing devices 17
Points
  in shapes 1001
  particle display options 731
Points parameter 790, 793, 802
Points Per Arm parameter 801
Poke filter 903
Pole Axis parameter 472, 482
Polygonal shapes 277
Pop-up color palette 127
Pop-up menus 126
Position parameters 97, 423, 533, 775
Posterize filter 946
PostScript fonts 576
Predictability of particle systems 695
Preferences 137–158
  3D 149
  Alignment 147
  Appearance 140
  Autosave 145
  Background 147
  Cache 144
  Canvas 147
  content library 139
  default project settings 142
  drag and drop settings 336
  editing presets 154
  File Browser 138
  Film Zone 148
  General 137
  gestures 158
  HUDs 140
  Interface 138
  Keyframe Editor 139
  Library 138
  LiveFonts 146
  media files 139
  Optical Flow Retiming 146
  output 150
  Playback control 143
  presets 153
  project level 142
  Safe Zone 148
  Snapping 148
  Startup 137
  Status Bar 141
  Still Images & Layers 143
  templates 139
  Third-Party Plug-ins 139
  Thumbnail preview 140
  Time display 143
  Timeline 140
  Timeline track display 94
  video 150
  Premultiplied alpha channels 157, 212
  Premultiplied colors 1241
  Premultiplied Mix blend mode 309
Preserving opacity 282, 289
Preset pop-up menu 128
Presets
  adding 153
  applying 129
  Compressor 1164
  content in 121
  creating 189, 1153
  creating projects from 182
  customizing 1154
  deleting 153, 1154
  duplicating 153, 190, 1153
  editing 154, 1152
  export 1149
  exporting 155
  gradients 603
  image sequences 1151
  Library features 115
  preferences 153
  QuickTime movies 1150
  replicators 759
  saving 129
  setting as default 190
  still images 1151
  Pressure (pen) 1013
  Preview area 116, 199
  Preview area (File Browser) 110
  Preview icons 138
  Previewing
    audio 1119
    content or effects in Library 116
    files 111
    filters 842
    float bit depth 52
    fonts 586
    generators 966
    media files 75, 200, 203
    particle systems 691
    replicator elements 810
  Previous frame button 58
  Previous Keyframe command 107, 130
  Primatte RT filter 924
  Prism filter 865
  Progressive extrapolation 552
  Progressive-scan video 186, 1212
  project duration field 65
  Project markers
    adding 363
    illustrated 92
    snapping to 62, 64
  Project pane 22, 67–83
  Audio tab 22, 80–83, 1117
  displaying 67
  icon 35
  Layers tab 22, 68–75
  Media tab 22, 75–80
swapping with Canvas 26
switching sides 67
Project Preset Editor 154, 189
Project presets
  copying to other computers 190
  creating 189
  creating new projects from 182
  deleting 190
  editing 190
Project properties
  editing 197–198
  general settings 184
Projects 179
  adding media to 213–217
  archiving 191, 195
  audio in 1119
  autosaving 193
  background color 239
  blank 182
  cameras in 54
  closing 195
  creating 179–235
  creating from presets 182
  custom settings 183
  defined 18
  description 187
  duration 64
  exporting 1147–1166
  frame size 197
  managing 191–196
  managing objects in 219–222
  moving 195
  opening 194
  opening multiple 195
  opening recent 180, 194
  playing 58
  preferences 142
  project files 179
  Project pane 67
  properties 79, 83
  QuickTime audio track 1121
  reverting to auto-saved 145, 193
  saving 191
  saving as templates 254, 1225
  saving duplicates of 192
  saving media files with 192
  scrubbing 61
  searching for 196
  templates 181, 250
  using in Final Cut Pro 1223
Properties
  projects 183
  retaining after export 1222
  Properties tab (Inspector) 131, 280

Q
Quality settings 156
Quantize behavior 445
QuickTime
  about 204
  archiving 196
  audio files 1118
  audio tracks 82, 1121
  audio-only files 1165
  bit depth and 186
  export presets 1150
  exporting movies 156, 1148, 1149
  exporting selections as 316
  field dominance and 1212
  Final Cut Pro and 1222
  mixing different file types 204
  movies as media files 75
  movies as shape outlines 1047
  multi-track files 1118, 1121, 1123
  particle systems and 712, 733
  replicator cells and 814
  Retiming behaviors and 453
  video codecs 1203
QuickTime Player 78

R
Radial Blur filter 866
Radial gradients 1034
Radius in particle emission 721
Radius parameter 791, 801
RAM Preview 59
  clearing RAM preview 61
  float settings and 60
  indicators 60
  previewing entire projects 59
  previewing play ranges 60
  previewing regions 60
  previewing selections 60
RAM Preview submenu commands 165
Ramp behavior 446
Ramp parameter 659
Random Frames slider 453
Random Motion behavior 474
Random parameter 474
Random Seed button 449, 452, 454, 458, 476
Random seed settings
  paint strokes 1057
  particle systems 733
  replicators 812
  text sequence behaviors 660
Random Tile filter 957
Randomize behavior 447, 605
Randomize Shape behavior 1069
Randomness
  paint stroke angles 1055
Index

1278

advanced controls 783
anchor points and 820
animating parameters 804, 815
animation curves 821
animation examples 816
arrangement of 770
as theme elements 118
behaviors and 836
blend modes and 769, 776
box shapes 790, 791
build style 793–794
burst shapes 787, 801
categories 120
cell parameters 783, 805, 814
cells 134, 755, 758
circle shapes 787, 791
colors 813
columns 771, 795
controls 779
creating 762
creating media for 759
cropping 778
customizing 767
drop shadows 777
dynamic parameters 756
elements in 754
filters and 838
Four Corner 777
goemetric shapes 789, 801
gradients and 813
HUD customization 767
HUD parameters 768
image sequences and 814
images as elements 789
Inspector features 134
isolating objects and 781
Library categories 229
Library presets 759
lighting 777
line shapes 786, 799
masks and 782
movies and 814
multiple source objects 764, 805
opacity for multiple sources 769
Parameter behaviors and 820
parameters for 785
persistent parameters 803
previewing 116
properties 771
rasterization and 772
rectangle shapes 786, 791
removing 764
removing source objects from 767
replacing source images 760
rows 771, 795
saving to Library 123, 839
scale 776
sequence control parameters 826
Sequence Replicator behavior 754, 821
shapes 770
shape-specific parameters 790
source objects 758, 764, 791
sphere shapes 790, 791
spiral shapes 788, 801
text layers and 568
timing 778
transforming 775
Traversal option 834
vs. particles 754
wave shapes 788, 799
Reset button 128
Reset Parameter command 130, 584
Resetting
camera view 170, 421
In and Out points 359
parameters 130, 519, 520
Resizing
objects 270
shapes 1018
thumbnails 250
track height 329
windows 25
See also Scaling
Resolution
creating templates for differing 253
export settings 157
high resolution graphics 1215
PDF files 211
resetting in Canvas 43
resolution independence 179
still images 205
video output 152
Resolution submenu commands 171
Retiming
about 312
audio 1136
in Timeline 315, 350–351
Inspector controls 313
preferences 146
Retiming behaviors 453–458
about 371
Flash Frame 453
Hold Frame 454
Loop 454
Ping Pong 455
Replay 455
Reverse 456
Reverse Loop 456
Scrub 456
Set Speed 457
Strobe 457
Index

Stutter 458
vs. timing controls 453
Reveal in Finder command 78, 112
Reveal Source Media command 220, 248
Revealing source media 75, 83, 248
Reverse behavior 450, 456
Reverse Loop behavior 456
Reverse Stacking outlines 1045
Reverse Stacking parameter 803
Reversing gradient direction 1038
playback 313
sort orders 80
Reverting curves to snapshots 538
to auto-saved projects 145, 193
RGB color components 44
RGB color space 204, 1210
RGB images 185
RGBA color components 40
Right camera view 170
Rights-protected files 121
Ring Lens filter 905
Ring Warp filter 905
Ripple Delete edits 346
Ripple filter 906
Rotating
3D rotation channels 281
3D rotation handles 56
Align To Motion behavior and 459
anchor points and 273
cameras 420
masks 1104
MIDI behavior and 439
objects 272
objects in 3D space 56
particle parameters 704
replicator elements 806
shapes 1018
Spin behavior 426
text characters 589
Rotation Axis pop-up menu 425, 460
Rotation handles 270
Rotation parameters 97, 281, 533, 775, 823
Rotational Drag behavior 479
Rotoscoping
about 1101
example of 1102
guidelines 1102, 1103
masks and 1101
Rows (particle emissions) 721
Rows (replicators) 771, 795
Rulers
Audio Editor 109
Canvas 45, 52, 147, 148
changing location of 53
effective use of 266
keyframe graph 103
Timeline 92, 356
turning on and off 52
S
Safe zones 45
color of 148
preferences 148
turning on 266
Sample rates 156
Samples value 188
Saturate filter 887
Save All command 192
Save As command 192
Saving
Autosave 145, 193
behaviors 405–408
curves 536
generators 988
gradients 603, 1039
items in Library 123
layouts 27
media files with projects 192
presets 129
projects 191
replicators 839
text sequence behaviors 675
text styles 625
Scale End parameter 810
Scale Over Life behavior 556, 739
Scale parameter 810, 823
Scale parameters 97, 438, 533, 698
Scale Randomness parameter 810
Scale Rate/Scale To parameter 411
Scale slider 201
Scaling
Auto-scaling 555
high-resolution graphics 1215
imported files 210
keyframing example 507
large images 205, 206
masks 1104
objects 270
parameters 281
particle parameters 704
particles 700, 730
replicator elements 810
replicators 776
text 589
Scrape filter 907
Screen blend mode 299
Scroll Down text behavior 652
Scroll Up text behavior 652
Scrub behavior 456
Scrub filter 960
Scrubbing
  audio 110, 1133
  projects 61
SD (standard-definition) video 1214
Search field 112, 119
Searching
  for layers and objects 248
  for Library items 119
  for media files 112, 198, 202
  for project files 196
SECAM output 152
Select/Transform tool 30, 265, 580, 1179
Selecting
  audio tracks 1127
  control points 1019
  hidden objects 262
  objects 261
  objects in Layers tab 239
  regions 359
  text characters 582
Send Backward command 260
Send to Back command 260
Separators 36
Sepia filter 887
Sequence Paint behavior 997, 1071
Sequence Replicator behavior
  about 754, 821
  custom Traversal option 834
  modifying 828
  Parameter behaviors and 835
  parameters 828
  sequence controls 829
Sequence Text behavior
  about 654, 668
  character animation 648
  customizing 663
  parameters 654, 659
  using 654
Sequencing pop-up menu 826, 829
Sequential edits 334, 335
Sequential mode 331
Server files 203
Set Speed behavior 457
SGI images 204
Shadows
  about 309
  adjusting 276
  blur amount 312
  parameters 282
  particle systems and 704
  rasterization and 288
  text 133
Shape Animation parameter 1101
Shape behaviors 371, 452, 1064–1080
Shape Style parameter 1016
Shape Style pop-up menu 128
Shape styles
  as theme elements 118
  categories 121
  Library category 230
Shape tools 1030
Shape Type pop-up menu 414, 1092
Shapes
  aligning 1061
  animating 1057, 1063
  as theme elements 118
  behaviors 1064, 1064–1080
  Bezier splines 999, 1000, 1001, 1023
  boxes 720
  B-Splines 1002, 1004, 1025
  bursts 718
  categories 120
  circles 717
  closed or open 1002, 1021, 1059
  colors 1009, 1031, 1032
  control points 279, 1018, 1019, 1020, 1023, 1025, 1080
  corners 1046
  creating illustrations 1060
  defined 997
  drawing 999, 1000, 1002, 1007
  editing 1008, 1017, 1023, 1025, 1082
  feathering 1009
  filled or empty 1008, 1032
  filters and 1063
  finishing 1001, 1004
  freehand shapes 1007
  geometry 719, 1059
  gradients 1009, 1033
  handles 1019
  holes in 1062
  HUD 1031
  images 719
  Inspector features 133
  keyboard shortcuts 1193
  Keyframe Editor and 1082
  keyframing 1080
  Library category 230
  lines 716, 1007, 1010
  locking 1023, 1061
  moving control points 1020
  opacity 1033, 1044
  organizing with groups and layers 1060
  oscillating 1067
  outlines 1008, 1027, 1043
  particle emitter parameters 715
  particle emitter parameters 715
  paint strokes 997, 1012, 1027, 1079
  parameters 1031–1033
  points 716
  polygonal 277

Index
Index

rectangles 717, 1010
replicators 770, 785
saving in Library 123
selecting control points 1019
shape tools 1030
snapping 1017
spheres 720
spirals 718
styles 1031
tangent handles 1024
transforming 1018
transparency 1062
types of 1059
vs. masks 998
waves 718
Sharing. See Copying
Sharpen filter 928
Sharpen filters 928–929
Sharpen 928
Unsharp Mask 929
Shear parameters 97, 533, 775
Shearing
masks 1104
objects 275
parameters 281
particle parameters 704
shapes 1018
Shortening objects 63
Show Audio Waveform button 101
Show Behaviors button 391
Show Collapsed Image Sequences button 199
Show in Keyframe Editor command 107, 130
Show Inspector submenu commands 175
Show Overlays option 44
Show Tooltips preference 138
Shuffle Order parameter 803
Shutter angle 188
Sidebar 111, 118, 199
Silhouette Alpha blend mode 308
Silhouette blend mode 308
Silhouette Luma blend mode 308
Simple Border filter 870
Simulation behaviors 458–483
about 371
Align To Motion 459
Attracted To 460
Attractor 462
baking and 404
controlling 396–397
Drag 464
Drift Attracted To 465
Drift Attractor 466
Edge Collision 467
Gravity 469
object wells and 459
Orbit Around 470–474
Random Motion 474
Repel 476
Repel From 478
replicators and 837
Rotational Drag 479
Spring 479
text and 676, 678
Vortex 480, 492–495
Wind 482
Size parameter 791
Sketch tool 100, 528, 543
Skewing shapes 277
Slanting text 588
Sliders 126
Slipping
audio tracks 1132
filters 855
in mini-Timeline 63
objects 345, 356
Slit Scan filter 948
Slit Tunnel filter 949
Slowing playback 350, 1137
Smoke effect 700–702
Smoothing parameter 1016
Snap Alignment to Motion behavior 425–426
Snapping
effective use of 266
keyframes in Keyframe Editor 553
objects in Timeline 344
objects to project markers 62
playhead to project markers 64
preferences 148
turning on or off 1017
Snapping button 101
Snapshots of curves 99, 538
Soft focus filter 867
Soft Gradient generator 979, 993
Soft Light blend mode 302
Softness of text 615
Soloing
audio 81, 83, 1128
layers 74, 243
Sorting
audio files 82
columns of data 79, 114
file stack 202
media file lists 78
objects in Layers list 72
objects in Media tab 249
theme elements 119
Sound files. See Audio and audio files, Media files
Sound. See Audio and audio files
Soundtrack Pro 83, 213, 1144
Source Channel pop-up menu 1106
Source channels in image masks 1107
Source media files
displaying 75
reconnecting 78
revealing 83
Spaces
  in file names 156
  in Toolbar 36, 37
Spacing
  kerning 588
  paint strokes 1015, 1051
  shape outlines 1045
  text line spacing 574
Special effects. See Effects
Speed
  adjusting 350
  audio 1136
  emitter randomness 727
  particle emission 702, 727
  pen speed 1016, 1058, 1065
  Set Speed behavior 457
  shape animation and 1058
  text sequence behaviors 673
  Type On behavior 667
  Speed controls 313
  Speed parameter 698
  Speed pop-up menu 418, 423, 424
  Speed slider 442, 457
Spelling
  584
  Spelling submenu commands 162
Sphere filter 908
Spherical particles 720
Spherical replicator shapes 790, 791
Spill Suppressor filter 926, 1110
Spin
  emitter settings 728
  randomness 728
  shape animation and 1058
Spin behavior 426–428, 485, 837
Spin Over Life behavior 556, 739
Spin randomness 728
Spin Rate/Spin To parameter 427
Spiral particles 718
Spiral replicator shapes 801
Spiral shapes 722, 788
Splines
  defined 999
  See also B-Splines, Bezier splines
Splitting tracks 341
Spotlight 196
Spread settings 833
Spring behavior 479
Spring Tension slider 460, 480
Square pixels 1213–1214
Standard definition DV 1207
Standard definition video
  data rates 1209
  formats 1206
monitors and displays 1214
NTSC video 1206
PAL video 1206
  specifications 1207
  standard definition DV 1207
Standard layout 23
Star generator 980, 990
Start caps 1046
Start From pop-up menu 455
Start Offset parameter 397, 447
Start Offset slider 409, 436, 437, 443, 449, 452
Start points (particle emitters) 723
Start Time slider 455
Start Timecode setting 186
Start times. See Play ranges
Start Value parameter 436, 437, 447
Startup preferences 137
Static generators 967
Status Bar 39, 141
Stencil Alpha blend mode 307
Stencil blend mode 308
Stencil Luma blend mode 307
Stencil mask parameter 1108
Step Size slider 445
Stereo mixing 1159
Still images
  about 204
  export presets 1151
  exporting 156, 1148, 1149
  high definition video projects and 1216
  in particle systems 711
  preferences 143
  supported file formats 1204
Stop behavior 450
Stop Parameter behavior 394
Straight alpha channels 212
Stretch mask parameter 1108
Stripes filter 909
Stripes generator 981
Strobe behavior 457
Strobe Duration slider 458
Strobe filter 960
Strokes on shapes 133
Stutter Amount slider 458
Stutter behavior 458
Style pane 584, 590, 1032
Style Preset pop-up menu 128
Styles
  paint strokes 1013
  shapes 133, 1031
  text styles 133, 584, 590
Stylize filters 929–953
Add Noise 930
Bad TV 931
Circle Screen 932
Index

Circles 932
Color Emboss 934
Crystallize 934
Edge Work 935
Edges 936
Extrude 937
Halftone 938
Hatched Screen 939
Highpass 940
Indent 941
Line Art 942
Line Screen 943
MinMax 944
Noise Dissolve 945
Pixelate 945
Posterize 946
Relief 947
Slit Scan 948
Slit Tunnel 949
Texture Screen 950
Vectorize Color 951
Vignette 952
Wavy Screen 953
Stylus and tablet drawing 998
Subcategories 232
Subtract mode 294, 1094, 1097, 1107
Support website 11
Surround audio 1121, 1123
Surround sound mixing 1129, 1159
Swirly generator 982
Switching
  between 2D and 3D mode 70
  between Canvas and Project pane 67
  between Full Screen mode or normal mode 29
  between HUDs 136
  between layouts 28
  between transform tools 265
  fonts 578
  Project pane and Canvas 26
Syncing audio 1136
Synthesizers 437

Text
  3D animation 639, 678
  3D paths and 631, 637
  3D transform tools and 572
  about 566
  adding to projects 569, 580, 582
  alignment 574, 630
  all caps 589
  animating 584, 589, 610, 644, 678
  as source for particles and replicators 568
  baseline 588
  behaviors and 567, 575, 634, 676
  blend modes 572
  color 573, 591
  creating 569
  custom style icons 626
  customizing in templates 252
  deleting 582
  drop shadows 620, 621
  duration preferences 568
  editing 571, 584, 585, 590, 596, 609, 617, 619,
  629, 643
  families 573, 586
  filters and 575, 612
  fonts 573, 576, 579, 586
  Format pane 585
  formatting 133, 584, 585
  glowing 618, 619
  Gradient editor 596
  gradients 593, 594, 596, 603
  HUD controls 571, 576
  insertion point 588
  Inspector and 132, 574, 584
  justification 630

Tables 158, 998, 1013, 1231, 1233
Tabs
  detaching 26
  reattaching 26
  reordering 26
  showing and hiding 26
Take/Show Curve Snapshots setting 102
Tangent handles 1024
Target filter 910
Task List 314
Technical support 11
Template Browser 181

adding categories 255
deleting categories 255
deleting templates from 255
organizing templates in 255
Template Browser icon 37
Template clips 1223, 1227, 1228

Templates
  browsing 138, 181
  content in 121
  creating 252, 1223
  creating new projects from 181
  customizing 250
  drop zones 253, 1224, 1228
  editing 1228
  master templates 1223, 1227
  media files for 254
  organizing in Template Browser 255
  preferences 139
  reusing objects from 252
  saving projects as 254, 1225
  themes 254, 1226
  using in Final Cut Pro 1223

Support website 11
Surround audio 1121, 1123
Surround sound mixing 1129, 1159
Tabbed window drawing 998
Tabbed window drawing 998
Tabs 158, 998, 1013, 1231, 1233
Tabs
  detaching 26
  reattaching 26
  reordering 26
  showing and hiding 26
Take/Show Curve Snapshots setting 102
Tangent handles 1024
Target filter 910
Task List 314
Technical support 11
Template Browser 181
Adding categories 255
Deleting categories 255
Deleting templates from 255
Organizing templates in 255
Template Browser icon 37
Template clips 1223, 1227, 1228
Templates
  browsing 138, 181
  content in 121
  creating 252, 1223
  creating new projects from 181
  customizing 250
  drop zones 253, 1224, 1228
  editing 1228
  master templates 1223, 1227
  media files for 254
  organizing in Template Browser 255
  preferences 139
  reusing objects from 252
  saving projects as 254, 1225
  themes 254, 1226
  using in Final Cut Pro 1223

Text
  3D animation 639, 678
  3D paths and 631, 637
  3D transform tools and 572
  about 566
  adding to projects 569, 580, 582
  alignment 574, 630
  all caps 589
  animating 584, 589, 610, 644, 678
  as source for particles and replicators 568
  baseline 588
  behaviors and 567, 575, 634, 676
  blend modes 572
  color 573, 591
  creating 569
  custom style icons 626
  customizing in templates 252
  deleting 582
  drop shadows 620, 621
  duration preferences 568
  editing 571, 584, 585, 590, 596, 609, 617, 619,
  629, 643
  families 573, 586
  filters and 575, 612
  fonts 573, 576, 579, 586
  Format pane 585
  formatting 133, 584, 585
  glowing 618, 619
  Gradient editor 596
  gradients 593, 594, 596, 603
  HUD controls 571, 576
  insertion point 588
  Inspector and 132, 574, 584
  justification 630

Index

1283
Index

replacing in text 607
sources with applied filters 612
text fills 606
text styles 133
Theme pop-up menu 118
Themes
adding to templates 254, 1226
available items for 118
creating 119
deleting 119
managing content in 119
Thinning keyframes 99, 531, 559, 561
Third-party codecs 1212
Third-party filters 963
Third-party plug-ins 139
Threshold filter 888
Throw behavior 428–430, 837
Throw Velocity/Throw Distance parameters 430
Thumbnails
Layers tab 69
media files 75
preferences 140
resizing 250
Timeline display 94, 330
TIFF format 186, 204
Tile filter 958
Tile offset emitter settings 722
Tile Offset parameter 796
Tiling filters 953–959
Kaleidoscope 953
Kaleidotile 954
Offset 955
Parallelogram Tile 956
Perspective Tile 956
Random Tile 957
Tile 958
Triangle Tile 959
Tiling image masks 1107
Time
counting 66
display preferences 143
inserting 361
Time filters 959–962
Echo 959
Scrub 960
Strobe 960
Trails 961
Widetime 962
Timecode
adjusting 65
displaying 66, 92
start timecode 186
Timecode fields 64
adjusting timecode 65
counting time 66
current frame 64
displaying timecode or frame numbers 66
duration 64
modifying dynamically 66
Timeline 22, 85–95
about 321, 322
adding objects to 331, 336
animation in 520
audio in 89, 328
audio/video elements 327
audio/video links 327
behaviors in 87, 328, 395, 397
collapsing and expanding layers 92
collapsing and expanding tracks 325
Composite edits 332, 334
copying and pasting 347
deleting layers 90
deleting objects 340, 345, 524
disconnecting tracks from contents 355
displaying 87, 322, 328
divider 89
drag and drop preferences 336
duration in 362
editing audio/video separately 327
editing methods 341, 351
editing objects 341–356
effects controls 87
Exchange edits 333, 334
filters in 87, 328
frames in 92, 358
gestures for 1238
group tracks 351, 352
groups in 90, 326, 339
icon mode 330
In or Out points 344
Insert edits 332, 334
inserting time 361
jumping to start or end 358
keyboard shortcuts 1191
keyframes in 328, 348, 505, 521, 522, 524
keyframing 520–526
layers in 90, 92, 328, 336, 337
layers in layers 339
layers list 85, 90, 324, 336
locking tracks 326
markers 362, 363, 366, 367
masks in 87, 328
mini-Timeline 61
moving objects in 342, 352, 397, 521
moving objects to other layers 338
moving objects to playback 342
moving playback 90
multiple clips in 335
multi-selecting tracks 340
navigating in 357, 358, 366
nesting layers 339
Overwrite edits 333, 334
play ranges in 94, 359
playing projects 357
preferences 140
rearranging objects 338
regions 359
renaming objects 324
replacing objects in layers 337
retiming in 315, 350–351
ruler 92, 356
Sequential edits 334, 335
slip edits 345, 356
splitting tracks 341
thumbnails in 94, 330
timecode in 92
Timeline tab 85
track area 91
track display settings 89, 325, 328, 330
track height 329
track order 337
tracks 325
trimming objects 343, 344, 395, 525
turning items on or off 87
ungrouping 340
zooming 93, 94, 328
Timeline icon 37
Timing
behavior adjustments 394
filters 854
media object parameters 227
particle systems 706
replicators 778
retiming 312
tools 15
vs. retiming behaviors 453
Timing Icon 322
Timing pane 84–110
Audio Editor 22
displaying 84
Keyframe Editor 22, 95–99
Timeline 22, 85
Timing Pane icon 35
Tint filter 889
Title animation 484–487
Title-safe boundaries 148, 266
Tool groups 29–35
ToolBar 29–38
adding controls to 35
additional icons for customization 36
customizing 35
flexible spaces in 36
hiding 38
icon and text view 38
icon only view 38
keyboard shortcuts 1194
removing controls from 35
separators 36
spaces in 36
switching between text and icon view 37
text only view 38
tool groups 29–35
Tooltips preference 138
Top view 170, 421
Track behavior 451
Track Parameter behavior 387
Track Points behavior 1075
Tracking in text 574, 588
Tracking Selection pop-up menu 128
Tracking text behavior 665, 666
Tracks
active 347
balancing audio 107
collapsing and expanding 325
deleting 340
disconnecting from contents 355
display options 94
enabling and disabling 325
height of 89, 328, 329
importing multiple tracks of audio 82, 1121
locking 326
Master track 1130
moving divider 89
moving groups as single objects 352
order of 337
selecting multiple 340
splitting 341
start and end times 106
Timeline display 91, 330
Trails filter 961
Transferring. See Copying
Transform controls 30, 270
Transforms
about 264
anchor point changes 273
applying to masks 1104
control point adjustments 279
corner-pinning 277
cropping 278
defined 261
drop shadows 276, 311
geometry controls 279
groups 264
keyboard shortcuts 1178
keyframes 545
multiple objects 263
objects and layers 263
objects in 3D space 56
particle parameters 703
replicators 775
rotating 272
scaling 270
shape editing 1018

Index
Index

shearing 275
switching modes 265
text layers and 571
Transition slider 424
Transparency
  about opacity 285
  blend modes and 285
  channel display 44
  colors 1038
  image masks 1104
  object status 70
  opacity parameters 98, 282
  opacity tags in gradients 1037
  particle cells 734
  premultiply alpha settings 157
  preserving opacity 289
  shapes 1062
Transport controls 21, 58, 1184
Traversal pop-up menu 659
Traversal settings 833, 834
Triangle Tile filter 959
Triggers 158, 774
Trim edits 343, 355, 356
Trimming
  audio tracks 1132
  behaviors 395
  changing In or Out points 344
  filters 854
  in group track 355
  keyframed effects 525
  multiple objects 344
  without changing effects 356
TrueType fonts 576
TV signals 152
Twirl filter 910
Twists parameter 801
Twists setting (particle emitters) 722
Two Color Ray generator 983
Type Layout method 570, 630
Type On controls 632
Type On text behavior 667
Type1 fonts 576
Typefaces 573, 587

U
Uncompressed video 1210
Underwater filter 912
Ungrouping objects 74, 340
Unit Size settings 830
Unsharp Mask filter 929
Unsolo submenu commands 168
Unused media 79, 196, 216
Use Marked Region control 105

Utility window 20, 110–134
  Inspector 125
  Library 115

V
Value fields 126
Value lists 127
Value parameter 438
Value sliders 126
Variable Blur filter 867
Vectorize Color filter 951
Velocity slider 483
Vid Rate 76
Video
  audio sync 144, 327, 1136
  export settings 156, 1148, 1154
  exported properties 1222
  exporting selections 316
  file formats 1203–1216
  fonts and 1215
  interfaced 1212
  line art and 1215
  output 150, 151, 152
  particle systems and 712
  track divider 89
  unlinking 327
Video cards 179
Video codecs
  alpha channels and 1211
  QuickTime 1203
  third-party 1212
Video filters 962–963
  Broadcast Safe 962
  Deinterlace 962
Video formats
  codecs for file exchange 1210–1212
  high-definition video 1207
  standard definition DV 1207
  standard definition video 1206
  supported 1206–1210
  uncompressed 1210
Video monitors 1214
Video/Audio presets 156
View menu 169, 1174
View pop-up menu 44
View tools 30
Vignette filter 952
Vivid Light blend mode 303
Volume for audio tracks 1128, 1131
Vortex behavior 480, 490–495

W
Wacom tablets 1231, 1233
Walk Camera tool 31
Water simulation 968
Index

WAV files 1118
Wave filter 912
Wave parameter 415
Wave particles 718
Wave replicator shapes 799
Wave Shape pop-up menu 441
Wave shapes 722, 788
Waveforms 554, 1124
Wavy Screen filter 953
Websites 10
Welcome Screen 137, 180
Widescreen filter 870
Widetime filter 962
Width
  columns 71
  paint strokes 1014, 1053
  shape outlines 1031, 1045
Width parameter 1015
Width slider 469
Wind behavior 482
Window layouts 23
Window menu 174, 1176
Window Size slider 431
Windows
  closing 25
  expose commands 317
  minimizing 25
  moving 25
  resizing simultaneously 25
  switching 26
  tabbed window behavior 26
Wireframes 732
Workspaces
  3D mode 54
  Motion 19
Wrap Around parameter 641
Wrap Mode parameter 1107
Wriggle behavior 451
Wriggle Offset slider 451
Wriggle Shape behavior 1075
Write On behavior 1077, 1078, 1079
Write On parameter 1016
Write On Shape behavior 1013
Y
YCrCb color space 204, 1210
YIQ Adjust filter 890
YUV Adjust filter 890
YUV files 49
Z
Z axis
  aligning 166
  Orbit Around behavior 473
  rotating around 425
  spinning around 426
Zoom Blur filter 888
Zoom Level submenu commands 169
Zoom slider 93, 328
Zoom Time View button 93
Zoom Time View submenu commands 169
Zoom tool 31, 1180
Zoom/Scroll control 328
Zooming
  dynamic zoom mode 42
  in Audio Editor 109
  in Canvas 42
  in Keyframe Editor 103
  in Timeline 93, 328
  resetting levels on 43